
 
 
 

 

Using Windows 10 & 
Microsoft® Office 2016 
 

Computing Fundamentals 

Key Applications 

Living Online 

July 2016 
© CCI Learning Solutions Inc. 

uploaded to shabakaty by : Eng Ahmed
ahmed_alfars_iraq@hotmail.com



Preface About This Courseware 
 

 

ii  7500-1 v1.00 © CCI Learning Solutions Inc. 

  

Internet and Computing Core Certification Guide 
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This courseware is copyrighted and all rights are reserved by CCI Learning Solutions Inc. No part of this publication may be 
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CCI Learning Solutions, Canada: 1-800-668-1669. 

The information in this courseware is distributed on an “as is” basis, without warranty. While every precaution has been taken in 
the preparation of this courseware, neither the author nor CCI Learning Solutions Inc. shall have any liability to any person or 
entity with respect to any liability, loss, or damage caused or alleged to be caused directly or indirectly by the instructions 
contained in this courseware or by the computer software and hardware products described therein. 
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 Copyright © 2016 CCI Learning Solutions Inc.  

 ISBN: 978-1-55332-463-8 

 All rights reserved.  

 Printed in Canada.  

 CCI Courseware#: 7500-1  

Any brand name or product mentioned in this publication is a trademark or registered trademark of their respective companies 
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Working With the Data Files 
The exercises in this courseware require you to use the data files provided for the book. Follow the 
instructions shown to download the data files for this courseware. 

1. Launch your browser and navigate to the CCI Web site location http://www.ccilearning.com/data. 

2. Enter: 7500 in the Courseware # box and click Find Data. 

3. Click Run in the File Download – Security Warning window. (Alternatively, you can choose to Save the 
file to a location on your computer.) 

4. In the Internet Explorer – Security Warning window click Run again. 

5. In the WinZip Self-Extractor dialog box, use the Browse button to specify the Windows Desktop as the 
location to unzip the file and then click Unzip. 

 The 7500 Student Files folder containing the required student work files has now been downloaded to 
your desktop. It is recommended that you rename the folder using your own name before starting the 
exercises in this courseware. You can reinstall and use the work files as many times as you like.

http://www.ccilearning.com/data
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Course Description 
This courseware is designed to illustrate what it means to be digitally literate, and to demonstrate what can 
be accomplished using a computer. The participant will progress to using popular software application 
programs to process typical documents found in a business or school environment. Participants are also 
introduced to what the Internet is and what makes it so popular for communicating and sharing information 
with others. 

This courseware is targeted towards people who are new to computers or who have had limited exposure to 
a computer prior to taking this course. The intent of this courseware is to impart knowledge and skill sets 
that a participant can apply to tasks he/she may want to perform using a computing device. 

Note: To recognize some of the components that make up a computer, it is preferable to have access to 
these actual components, wherever possible. 

Course Series 
This courseware is a composite of three different modules targeting specific skill sets: 

• Computing Fundamentals 

• Key Applications 

• Living Online 

The IC3 Global Standard 5 (GS5) courseware contains exercises that students can use to learn each of the 
topics and features discussed.   

Teacher Resources are available and are produced specifically to assist a teacher in preparing to deliver the 
course using the CCI materials. Contact your coordinator or administrator, or call your CCI Account Manager 
for information on how to access these resources. 

Course Prerequisites 
This courseware was designed to provide the essential skills for computer literacy, using application programs 
commonly found in school and business environments. It is intended for those who have not used a web 
browser, word processor, spreadsheet, presentation, database or email program previously, or for those who 
have minimal experience. Some familiarity with using a mouse and keyboard can be helpful.  

System Requirements 
This courseware was developed using specific software and hardware configurations. In order to complete 
this courseware, you will require the following minimum requirements: 

Hardware Requirements 
• 1GHz or faster 32-bit (x86) or 64-bit (x64) processor  
• 4GB RAM 
• DirectX 10 or later graphics card with WDDM 1.0 driver 
• 1280 800 screen resolution 
• A hard drive 1GB of free space  
• Ethernet port or wireless adapter for Internet access  
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Note: Internet access is required to perform many of the hands-on exercises. 

• Mouse or other compatible pointing device 
• 101 enhanced keyboard 

• A headset with a microphone for each student for performing conference call and video conferencing 
exercises 

• An integrated (or connected) web cam for each student for performing video conferencing exercises  

• Printer (must have access rights to print) 

Software Requirements 

• Microsoft® Windows 10 Professional (Note: Each student should have a user account with administrative 
privileges or access to an account name and password that will supply sufficient rights for installing 
software and adjusting hardware settings.) 

• Microsoft® Office 2016 Professional  

• Windows® Internet Explorer 11.0, and Microsoft Edge (Note: Google Chrome will be installed as part of 
Lesson 5.) 

The objectives outlined in each lesson can be achieved by properly using the material and exercises in this 
courseware, and by paying close attention to your teacher. You should not hesitate to ask questions if you 
have problems in working through the material. To help you understand how some tasks or actions are 
performed in a business environment, CCI builds many of the exercises around a fictional company named 
Tolano. 

All software programs used in this courseware are large and powerful programs, with more features than you 
can master in a single course. This courseware presents a tremendous amount of material in a simple, easy-
to-learn format. You should read ahead during the course; you should also reread regularly. This will increase 
your retention of important concepts and skills, and will help you cope with the size and power of these 
programs as you continue to learn. 

Classroom Setup 
The explanations in this courseware are based on the default settings established during the installation of 
the Microsoft Windows 10 and Microsoft Office 2016 programs on a networked computer. Your computer 
(or the computers in the classroom lab) may be configured differently. If so, please check with your teacher 
(where applicable), or consult the appropriate User’s Guide to change the setup. 

If you are using another version of Word, Excel, or PowerPoint, or a different office suite such as Open Office 
or Google Docs, you will find that all of the concepts are the same; there may however be differences in some 
of the steps required to accomplish the task. 

To assist with the learning process, CCI has designed exercises for a variety of business and personal activities. 
All names of people referenced in the exercises are fictional and created for the purpose of the CCI Learning 
Solutions only. 
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Course Design 
This courseware was developed for instructor-led training and will assist you during class. Together with 
comprehensive instructional text and objectives checklists, this courseware provides easy-to-follow hands-
on lab exercises and a glossary of course-specific terms.  

This course book is organized in the following manner: 

  Internet and Computing 
Core Certification Guide 

 

 Table of Contents 

 Lessons 

 

 Lesson Objectives 

 Narrative Text 

 
 Graphics 

 Tips and Tricks 

 Notes 

 Exercises 

 
 Graphics 

 Tips and Tricks 

 Notes 

 Lesson Summary 

 Lesson Review 

 Appendices 

 
 Courseware Mapping 
 Glossary of Terms 

 Index  

When you return to your home or office, you will find this course book to be a valuable resource for reviewing 
exercises and applying the skills you have learned. Each lesson concludes with questions that review the 
material. Lesson review questions are provided as a study resource only and in no way guarantee a passing 
score on a certification exam. Appendices in the back of this course book provide additional information. 
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Course Objectives 
Computing Fundamentals 

The Computing Fundamentals exam covers subjects needed for a foundational understanding of computing, 
including knowledge and use of computer hardware, software, and operating systems. In this module you 
will: 
• Learn about the features and functions of modern operating systems and access various operating 

system features and settings. 
• Examine different types of computers and learn about various types of computer hardware. 
• Learn about connectors and ports. 
• Learn about telephone, data, and cellular networks and about service subscription and contract 

requirements. 
• Learn how to configure and use voice mail and how to manage mobile data usage. 

• Use Windows File Explorer to find, move, open, and manage files; and navigate a directory and follow 
a path. 

• Learn about various ways to share files with other users. 
• Install and configure software and Windows apps. 
• Use messaging applications. 
• Create and use cloud accounts. 

• Identify the need for security and describe risks presented by malware, social engineering, and phishing 
exploits. 

• Learn methods for protecting yourself against risks. 
• Understand why, how, and when to back up your data. 

• Learn basic troubleshooting techniques. 

Key Applications 
The Key Applications exam includes questions covering three applications (word processing, spreadsheet, 
and presentation,) and includes questions on common features of all applications and questions on basic 
database concepts and uses.  In this module you will: 

• Learn about a wide variety of apps and applications and identify which types are best suited for particular 
tasks. 

• Use an app store and install, delete, and recover apps. 
• Examine the common features shared between the applications in Microsoft Office 2016 and  explore 

basic techniques for working in an Office application. 

• Learn some of the basic skills required to create simple documents (including letters, reports, and a 
brochure) using Word. 

• Be introduced to the basic skills for working with a spreadsheet application, including how to enter and 
format text and formulas, navigate and manage worksheets, filter and sort data, create and modify charts 
and set printing options. 

• Learn basic database concepts and learn how databases are used on the World Wide Web. 

• Learn basic skills for working with an application designed to manage presentations, set up 
presentations, and create and edit slides that include text, images, charts, tables, or multimedia. 
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Living Online 
The Living Online exam covers aspects of working in a networked environment and on the Internet. The exam 
includes questions on basic knowledge of the Internet, skills in specific applications such as electronic mail 
software and web browsers, skills required to find and evaluate information, and understanding issues related 
to using the Internet being at work, home or school. In the module you will: 

• Learn about the nature of the Internet and about the role and function of web browsers 

• Learn about how web sites are organized, identify common web page elements, and learn how to 
perform basic tasks using a web browser. 

• Conduct research and evaluate the information you find on the Internet. 

• Learn about and use various digital communication technologies 

• Use electronic mail and calendaring and work with contacts. 

• Examine the practices of good digital citizenship and online safety, and learn to manage your online 
identity. 

• Recognize and learn to avoid health risks associated with computing. 

Conventions and Graphics 
The following conventions are used in CCI learning materials. 

File Names or Folder 
Names 

File names or database field names are indicated in italic font style. 

Exercise Text  Content to be entered by the student during an exercise appears in Consolas font.  

Procedures  Procedures and commands you are instructed to activate are indicated in bold font 
style.  

Features or Command 
Options  

Menu options and features are listed in the left hand column and corresponding 
descriptions are in the right hand column. 

Numbered objective from the IC3 GS5 exam being covered in the topic is indicated in bold text. Refer to the 
Appendix for a complete listing of exam objectives. 

Notes and Tips point out exceptions or special circumstances that you may find when working with a 
particular procedure, when there may be another way to perform a task, or as a reminder on how to 
complete the task. 

 

Exercise  
Exercise graphics signal the start of step-by-step, hands-on exercises or other activities.  
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Computing Fundamentals 
 
 

Lesson 1: Operating Systems  
Lesson Objectives 
In this lesson, you will learn about the features and functions of modern operating systems. You will also learn 
how to start the computer and how to access various features of the operating system.  Upon completion of this 
lesson, you will be familiar with: 

 the function of an operating system 

 popular desktop operating systems 

 user accounts and profiles 

 power on and power off procedures 

 power options 

 using the Start button 

 navigating the Windows Desktop 

 using the taskbar 

 accessing the Settings app 

 accessing the Control Panel 

 customizing the Windows Desktop 

 the features of mobile operating systems 

 operating system updates 

 

What is an Operating System? 
Throughout this course, you will learn about using computers. A computer is essentially a collection of 
electrical and mechanical parts referred to as hardware. Each hardware part performs its own function, and 
in order for all the parts to work together, they must be able to communicate. Instead of communicating 
directly with one another, the various components communicate via an operating system. 

• The operating system (or OS) is a computer program.  

• A program is a sequence of instructions that guides the computer through the performance of a specific 
task or sequence of tasks.  

• The individual lines of instruction are referred to as code.  

• The term software refers to any program that makes a computer run – including operating systems and 
application programs. 

Note: Software developers write source code for their programs in a human-readable format. In order to 
prepare a program to be installed and used on a computer, the source code is converted into an 
executable format through a process called compiling. Compiling changes source code into machine code.   

Every computer requires an operating system in order to function. Think of an operating system as the central 
manager of communication, coordination, and control.  
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Application programs, on the other hand, allow you to be productive – to create documents or complete 
specific tasks such as creating a budget, removing red-eye from a photograph, searching the Internet or 
scheduling a meeting.  

Application programs use the operating system to control the hardware functions of the computer, and you, 
as a computer user, interact with the operating system whenever you log on to the computer, or type on the 
keyboard, tap on a touchscreen, or use an application program such as an email program or a word processor. 

It works like this: 

 
As you work in an application program, the program interacts with the operating system behind the scenes. 

The operating system: 
• manages hardware devices, and 
• controls communication among hardware devices, and 
• controls communication between application programs and hardware devices, and 

• manages files stored on the computer. 

Evolution of the Modern OS Interface 
Since the early days of personal computing, operating systems have evolved from simple monochrome text 
screens to full-color point-and-click (or tap) interfaces.  

An interface is a point where two systems (or people, or networks, or devices) meet and exchange 
information. Anytime you use a computer, join a network, or plug in a device, you communicate with it 
through an interface. 

Today’s modern operating systems communicate with you through a graphical user interface (GUI), or 
“gooey.” A GUI lets you use menus and clickable buttons or icons to start programs, move files, or perform 
other tasks. This makes it easy for users to work with the operating system and get things done.  

Proprietary and Open-Source Operating Systems 
Software is sold and/or distributed with a particular type of software license. When you purchase a program, 
you are purchasing the right to use it. The ways in which you can legally use it are defined by the license that 
comes with it.  

Proprietary Software 
Most commercial software programs are proprietary. That is, they are owned by an individual or a company, 
usually the person or company that created it. The owner sells an executable copy of the software to users 
for use on their own systems, and includes a license with the program. The owner also controls how the 
software can be used, if and how the source code can be inspected and/or modified, and under which 
conditions (if any) it can be redistributed.  



Operating Systems Lesson 1 
 

 

7500-1 v1.00 © CCI Learning Solutions Inc.  3 

Additionally, most commercial software is closed-source. The software is released only in a compiled form 
and the source code is not released or made available. (However, sometimes vendors will release sections of 
the source code to third-party developers who create enhancement routines or add-ons.) 

When you install software you must agree to the terms of the end user license agreement (EULA). In most 
cases the license agreement is quite restrictive. For example, the license determines the number of systems 
on which you can install the software, and it usually prohibits you from copying and distributing the software 
to other users. You are also restricted from attempting to de-compile or reverse-engineer the code back into 
a human-readable format. You are restricted from making changes of any kind to the software.  

All versions (including mobile versions) and editions of Windows, Mac OS X and UNIX are proprietary. 

Open-Source Software 
In contrast to the restrictive licensing terms of proprietary programs, an open-source software license makes 
the source code of the software freely available. Users are permitted to study, change, and distribute the 
software to anyone for any purpose.  

Most open-source software is distributed freely without charge, although open-source software does not 
necessarily need to be free. It is considered open-source because the source code is freely available. 

Linux, FreeBSD, Open BSD, and ReactOS are examples of open-source operating systems. Mobile operating 
systems based on Linux (for example, various versions of Android) are open-source, but are often bundled 
with a substantial amount of proprietary software as well.   

Desktop Operating Systems 
There are many types of operating systems in wide use today because there are many types of devices. In 
this course, you will focus on desktop operating systems and mobile operating systems. 

A desktop operating system is one that is used on desktop and laptop computers. A desktop operating 
system is a large and robust program. It offers many features, and provides a great deal of power and control 
over how the computer runs.   

Operating System Versions and Editions 
Operating systems are released in various versions and editions. An operating system version refers to the 
specific code base that was used to develop the operating system. For example, Windows 7 and Windows 8 
are different versions of the Windows operating system.  An operating system edition determines which 
features are available. For example, various versions of the Windows operating system are released in varying 
editions such as Home, Professional, or Enterprise. 

Popular Desktop Operating Systems 
Today, you can choose from several operating systems. You might like Windows, while your friend prefers 
Mac OS X, and your teacher or colleague likes Linux.  

Almost all operating systems include a Desktop which is the screen that opens once you log on and are ready 
to begin working. Operating system Desktops usually include colorful backgrounds, icons or buttons for 
accessing commands, and a status bar to show which programs are open and running. The Desktop is the 
central place from which a user interacts with the computer. 
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Some of the most popular operating systems include: 

Windows 
Windows operating systems are designed by Microsoft. Recent versions are: 

• Microsoft Windows 10  

• Microsoft Windows 8  

• Microsoft Windows 7  

The Windows 8 and Windows 7 Desktops are shown here: 

  
You will see the Windows 10 Desktop later in this lesson. 

Mac OS X 
Mac OS X is designed by Apple for Macintosh computers. Recent versions are: 

• Version 10.9 – Maverick 

• Version 10.10 – Yosemite 

• Version 10.11 – El Capitan 

The Mac OS X Yosemite and Maverick Desktops are shown here: 

  

Linux 
Linux is a free and open-source operating system. You can find Linux installed on supercomputers – such as 
those used by Google and NASA. But it is also installed on millions of home and business computers. Because 
anyone who uses Linux can modify it, it is very popular with programmers. 

Versions of Linux are called distributions – or “distros” for short. Some popular distros are: 

• Knoppix 

• Ubuntu 

• Gentoo 
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The Knoppix and Ubuntu Desktops are shown here: 

  

UNIX 
UNIX was one of the earliest operating systems and was first designed for use on large mainframe computers 
and servers. Modern versions are available for desktop systems, and include a GUI; however, the GUI is 
separate from the operating system. 

Common Operating System Features 
Objective 1-3.5  

No matter which operating system you use, certain features are common among all of them. 

User Accounts  
In addition to managing communication, devices, and file storage, an operating 
system keeps track of who is using the computer. This is accomplished through user 
accounts.  

You can think of an account as a special area on the computer where you can work and keep your files, 
separate from other users. For example, an entire family can share a Windows PC, and each family member 
would have a distinct account with his or her own user name, password, and account settings. 

An account name (and usually a password) is associated with each account. Before you can run programs, 
open files or use the computer to accomplish any type of work, you must log on using a valid user account.  

When you first power on a Windows computer, one of two things can happen:  

• If you are the only user on the computer and your user account does not require a password, then you 
will be automatically logged on to your account and the Desktop appears. 

• If you are using a computer on which multiple user accounts have been set up, or if your user account 
requires a password, then Windows displays an icon and account name for each user account and you 
must log on to your account by clicking your account icon and entering your password. 

Account Types 
Operating systems allow for the creation of different types of user accounts. In Windows, there are two 
readily-available account types: standard user accounts and administrator accounts. 
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Administrator 
account 

Enables you to make changes to the system that will affect other users. Administrators can 
change security settings, install and uninstall software and hardware, and create or make 
changes to other user accounts on the system. 

Standard user 
account 

Enables you to use most of the capabilities of the computer. You can use most programs 
that are installed on the computer and change settings that affect your user account. 
However, you can't install or uninstall some software and hardware, you can't delete files 
that are required for the computer to work, you can’t access other users' files stored on the 
computer, and you can't change settings that affect other users or the security of the 
computer. 

Each type of account has a specific level of permission associated with it. Permissions are rules associated 
with objects on a computer, such as files, folders and settings. Permissions determine whether you can access 
an object and what you can do with it. Everyone has permission to read/write (create, edit, view or print) files 
for their own account; however, only someone with an Administrator account can see files created by other 
users on the system. 

An administrator account is created automatically when Windows is installed on a computer. If you are using 
your own computer, the account you create the first time you start up your computer is an administrator 
account. You can then create additional administrator and standard user accounts. 

If you use a computer at your school or office, the system administrator will likely have already created an 
account for you. Your account may be an administrator account or a standard user account. 

Note: Computers you use in a school, library, or workplace are usually part of a computer domain. A 
domain is a network of computer systems that are controlled by a network administrator. Your ability to 
perform certain tasks (such as installing software, changing your password, or installing updates) on a 
domain system can be tightly controlled by the administrator, regardless of your account type.  

Account Options 
It is considered best practice to protect your computer and documents if you are going to be away from the 
system for any length of time. Two recommended practices are signing out of your account, or locking your 
computer whenever you are away so that other people passing by cannot see or access any of your files.  

You can perform either of these tasks by clicking your user icon in the Start menu, and then selecting the 
desired option. 

If you select Lock, Windows displays an image on the monitor and you 
must enter the logon password before you can resume working. Locking 
the system is different than logging off (signing out). When you lock the 
system, all your programs and files remain open and ready so you can 
resume working quickly.  

If you select Sign out, all your programs and files are closed and you return to the Windows log on screen. 

User Profiles 
Each user account is associated with a profile. A profile is a collection of settings that make the computer 
look and function in a particular manner. A profile includes settings for elements such as the Desktop 
background, lock screen, screen saver, pointer preferences, date and time format, and so on.  
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When you log on to a user account, the settings in the associated profile are loaded and affect what is 
displayed on the Desktop. 

When you make customizations, such as changing the Desktop background or applying a sound scheme, 
those changes are saved in your profile so that the next time you log on to your account, all of your 
customizations are in effect. You will customize your profile later in this lesson. 

Built-In Power Off Procedures 
Powering on and powering off a computer are two different processes. When you first power on (start) the 
computer, you press the power button. The computer runs a set of self-diagnostic programs to ensure that 
critical hardware is working properly, and then it loads the operating system into memory. Once the 
operating system is loaded, you are either logged on to your account automatically or you log on manually. 

Although you simply press the power button to turn the system on, you should never simply press the power 
button to turn the system off. You should always use the operating system's Power Off or Shut Down option. 
This option ensures that any changes you have made to the system are properly saved, and that any 
temporary files, which are no longer needed, are deleted.  

Starting a Windows Computer  
On many desktop computers, the power switch is located at the front or top of the 
system case. The most commonly used icon for a power button is shown here. 

Do not try to feel for the power button the first time you want to start the computer – locate it visually. 

1. Turn on devices that are connected to the computer (such as the monitor, speakers and printer) first. 

2. Press the power button on the computer to turn it on. 

The computer performs a start-up test and then loads the operating system files into memory. This process 
is also referred to as booting. 

When the operating system is loaded, Windows will display either a Welcome screen followed by the Desktop, 
or a logon screen from which you must select your account (and perhaps enter your password). After you 
log on to your account, the Desktop displays. 

Powering Off a Windows Computer  
When you are done working, you should save your work, close any open programs, and then power off the 
system. 

Each operating system includes built-in power-off procedures which you 
should use to ensure that files and programs are closed and that internal 
services are properly exited before the electrical power is cut off. In 
Windows 10, various options are presented in the Power menu. 

To properly power off a Windows 10 computer: 

1. Click the Start button then click Power to display the Power menu. 

2. In the Power menu, click Shut down to power off the system. The computer closes all files and programs, 
closes the operating system and turns off the power completely. 

Note: In Linux, the power off options are named: halt, power off, reboot, and shutdown. In Mac OS X, the 
options are named: sleep, restart, and shut down. 
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Understanding Windows Power Options 
Objective 1-2.6  

Power options affect the way your computer uses energy. Because we are often called away from our 
computers for various periods of time which fall inside our “regular working hours,” most operating systems 
provide options for reducing the amount of power the system uses. For example, if you take an hour for 
lunch, you can use one of the power options on your computer to conserve power without having to shut 
the system off. 

Reducing power consumption is good for the environment, and it prolongs battery life on a system that is 
running on battery power. 

Windows 10 provides several power options from which to choose. These options include: 

Sleep Clicking Sleep leaves the computer on, but puts it into a mode where it uses less power than 
when it is awake. The screen turns off and often the computer fan stops. Windows puts your 
work into memory. Sleep mode is similar to pausing a DVD movie. It is useful when you won’t 
be using your computer for a short period of time. 
When you wake the computer, the screen will look exactly as it did when you put the system to 
sleep. On some systems you can wake the computer by moving the mouse or pressing a key 
on the keyboard; on others, you must press the Power button. On a desktop computer, the 
Sleep command may be listed as Standby. 

Hibernate This option is found on laptops only. When you click Hibernate, the computer writes your open 
files and programs to a storage location and then turns off the system. Hibernate mode uses 
no power. Hibernate mode is useful if you will not be using your laptop for an extended period 
of time, but you do not want to close your documents. 
When you press the power button on a laptop in hibernation, the system starts back up and 
puts your files and programs back into memory. You can start working again right where you 
left off. 
By default, the Hibernate option does not appear in the Power menu, but you can customize 
the operating system to include this option. 

Shut Down The computer closes all files and programs, closes the operating system and turns off the 
power. 

Restart Windows closes all open files and programs, exits the operating system and restarts the 
computer without turning off the power. Sometimes when a computer starts to behave 
strangely or seems to get “lost” or “stuck” restarting it will make it run properly again. Restarting 
clears the memory and reloads the operating system, but does not cause the computer to 
perform the start-up tests again. 

 

Exercise 1-1: On, In, Out, and Off 
In this exercise, you will turn on the computer to start the operating system. You will also log on to Windows 
and explore various power options. If you require assistance finding objects on the screen, ask your teacher 
for help. Navigating the Desktop will be covered in detail later in this lesson. For now, you will simply explore 
power options. 

1. Identify where the power buttons are located on the computer and monitor. 
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2. Turn on the monitor, then press the power button to turn on the computer. 

3. Watch the monitor to see the messages that display. 

4. If a Windows logon screen appears, click the icon for your user account and enter your password to log 
on to Windows. When you have successfully logged on to Windows, the Desktop displays. 

5. Click the Start button in the lower left corner of the Desktop to open the Start menu.  

 
6. In the Start menu, click Power to view the power menu, then click Sleep to put the computer to sleep. 

The screen either goes dark or displays a picture or the log on screen. 

7. Press a key on the keyboard or press the power button to wake the computer. Depending on how the 
computer has been set up, you may need to click the icon for your user account and/or enter your 
password to return to the Desktop; otherwise you will be returned to the Desktop immediately. 

8. Click the Start button to open the Start menu. 

9. Click Power, then click Restart. Windows shuts down and then starts again without performing the 
startup tests that run when you first power on the computer. 

10. When the log on screen displays, click the icon for your user account and enter your password to access 
the Desktop. 

11. Click the Start button, click your user icon at the top of the Start menu, then click Sign out to log out of 
Windows and display the log on screen.  

12. Click the icon for your user account and enter your password to return to the Desktop. 

13. Click the Start button, click Power, then click Shut down to power off the system. 

14. Press the power button on the computer to start the system. 

15. Log on to Windows. 

Looking at the Windows 10 Desktop 
The Windows Desktop is the main screen on which program windows, icons, menus, and dialog boxes appear.  

Your Windows 10 Desktop should look similar to the following screen. You will notice several objects or icons 
on the Desktop: these vary from one system to another, depending on how the computer is configured. 



Lesson 1 Operating Systems 
 

 

10  7500-1 v1.00 © CCI Learning Solutions Inc. 

 
The Desktop includes several types of objects that you use to move around and get work done. 

Desktop icons The “shortcuts” you can click to open frequently used programs, folders, or files. 

Mouse pointer The arrow that follows the movement of the mouse (or touchpad) and highlights icons on 
the screen when you point to them. 

Start button 
 

Click to start programs, open documents, find items on your computer, and get help. You 
also use the Start button to power down the system. 

Taskbar The long horizontal bar at the bottom of the screen that includes three main sections: the 
Start button and search box; the middle section (which displays the buttons for open 
programs and files); and the notification area (which includes a clock and icons that 
communicate the status of certain programs and settings). The taskbar is an integral part 
of Windows’ multitasking feature. 

Navigating Around the Desktop 
Using a Pointing Device 

You use a pointing device such as a mouse or the touchpad to move the mouse pointer: 

• To select an item, move the mouse pointer (arrow) over top the item and then click the left mouse button 
once; this is called a single-click. 

• To activate an item, point the arrow at the item and then press the left mouse button twice quickly; this 
is called a double-click. 

• To display a shortcut menu with more options, point the arrow at the item and then click the right mouse 
button once; this is called a right-click. 

Using the Keyboard 
A number of features can be accessed through the keyboard. For example, press the WINDOWS button to 
open the Start menu, press ESC to cancel an action, or press TAB to move to the next field in a dialog box. 

  

Mouse 
pointer 

Desktop 
 

Taskbar Start 
 

Search box 
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Using a Touch Screen  
If you have a touch screen device, you can: 

• Tap to open, select, or activate an item; similar to a single-click. 

• Double-tap to open a file or folder; similar to a double-click. 

• Press and hold (long press) to show information or open a short-cut menu; similar to a right-click. 

Note: Windows 10 has been designed to work with touch screen devices as well as it works with a 
traditional mouse and keyboard, and provides the ability for the user to work in Tablet mode. In this 
course, however, you will use a mouse and keyboard. 

Using the Start Button and Start Menu 
To work in Windows 10, you begin at the Start menu. To open the Start menu, you can: 

• Click the Start button, or 

• Press the WINDOWS key. 

The Windows 10 Start menu includes a classic pop-up menu on the left, and a panel of application shortcuts 
called “tiles” in the middle.  

 
Your user account icon (and name) display at the top left of the Start menu. Click your user name to access 
commands to lock the screen, sign out, or change your account settings.  

Along the left side of the Start menu are shortcuts to the most used and most common programs, apps, and 
settings. Click an item to launch the program or access the setting. Some items display a right-facing arrow. 
Click the arrow to open a sub-menu of application-specific tasks or items.  

Click All apps at the bottom of the Start menu to see all your apps and programs. 
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Click an app or program from this panel to launch it. Some items display a 
down-facing arrow. Click the arrow to open a sub-menu of tools or options. To 
return to the main Start menu, click Back at the bottom of the All apps pane. 

You can also right-click the Start button to display a shortcut menu to various 
commands and features. 

In the middle of the Start menu, tiles represent apps and programs. The tiles 
are movable and sizable. You can drag new tiles in from the All apps pane. Click 
a tile to launch an app or a program. You can also right-click a tile or an item 
in the left pane to access additional options which allow you to pin or unpin 
the item in the Start menu or task bar. 

About Apps and Application Programs 
Both apps and application programs are software and both can be installed on 
various computing devices. An application program is software designed to 
perform a variety of functions, whereas an app is software designed to perform 
a single function.  

Application programs are large and usually require a fair deal of system 
resources (such as RAM and processing power). They are designed to be used 
with a mouse and keyboard. Apps are small, and light-weight and are designed 
primarily for use on mobile touch-screen devices. 

Windows 10 refers to application programs as “Desktop apps.” For example, “OneNote 2016 Desktop app” 
refers to the installed application program, while “OneNote” refers to the app designed for the touch screen 
interface. 

You will learn about apps and application programs throughout this course. 

Search Box/Cortana 
Just to the right of the Start button is the search box.  

 
Click in the search box and begin typing. Windows will display topics and 
file names that match what you type.  

When you first use Windows 10 the search box may display a circle icon and 
the text “Ask me anything.” 

 
These elements are part of Cortana, the Windows 10 personal assistant. If 
you click in the box, the Cortana feature will open for initial setup. To use 
Cortana, you must sign into the system with a personal Microsoft account.  

You can click Not interested to turn the feature off. For this course, you will 
not use Cortana. 
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Using the Taskbar 
The taskbar appears at the bottom of the Windows Desktop (although you can move it to either side or to 
the top of the window).  

 
It includes the items described below: 

Taskbar 
buttons 

A button displays in the taskbar for each open application program, for some built-in 
Windows applications (such as Microsoft Edge or File Explorer), and for any applications 
which you have “pinned” to the taskbar. Click a taskbar button to activate a program or 
window. 

Task View 

 

Task view is a new view in Windows 10 that shows small windows of all your running 
applications in the middle of the screen and displays a command for creating virtual 
Desktops. 

Notification 
area 

Displays the time and date and provides quick access to items such as the volume control 
or a wireless network connection. It can also display information about the status of the 
power level of a laptop battery or whether operating system updates are available. You can 
also control which icons are visible.  

Action Center 

 

Click this button to open the Windows Action Center. 

Show Desktop 

  

Point at this button to make all open windows transparent so you can see the Desktop for 
a moment, or click it to instantly minimize all open windows on the Desktop. You can restore 
all the windows to their previous state by clicking it again. 

Task View 
New in Windows 10, Task View shows small windows of your running applications and a New desktop icon.  

 

Notification area 

Show 
Desktop Action 

Center 

Task View

Taskbar buttons 
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You can click a window to bring that particular application to the front of your screen, or you can point the 
mouse pointer over a window to display a Close button . Click the Close button to close the application. 

You can also click New desktop to create a virtual Desktop. In computing, the word virtual refers to the way 
a particular component or environment appears to a user. For example, a virtual Desktop is a software 
implementation of a physical Desktop – it does not exist physically, but you can use it (and organize your 
work on it) as if it did exist physically. 

Click the virtual Desktop to bring it front and center. 
You can launch different applications on this Desktop 
and then alternate between your open Desktops to 
keep your workspace uncluttered. You can create as 
many virtual Desktops as you like, and you can move 
applications between Desktops.  

When you are finished working with a virtual Desktop, display Task View, point the 
mouse pointer over the Desktop you want to close to display a Close button.  

 Click, the Close button to close the Desktop. 

Action Center 
When you click the Action Center button in the notification area, the Windows 10 Action Center opens as a 
sidebar.  

You can read and respond to (or clear) notifications, access system 
settings through the Settings app, or turn specific features such as 
Bluetooth or Airplane mode on or off. Appointments and alerts you set 
in Windows calendar also appear here.  

The buttons that appear in the Action Center are called Quick Actions, 
and you can control which quick Action buttons display by configuring 
the notification settings. 

Key Fact: You can also display the Action Center by pressing 
WINDOWS+A or by swiping in from the right on a touch screen.  

Taskbar Buttons 
When you open a program, an underlined button for that application 
appears in the taskbar as a visual clue that the program is running. If 
you point the mouse pointer over a taskbar button, Windows displays 
a preview window for each file that is open within that application. 
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Exercise 1-2: Exploring the Start menu and Taskbar 
In this exercise, you will explore areas of the Desktop, Start menu, and taskbar. 

1. If necessary, start the computer and log into Windows. 

2. When the Desktop appears, put your hand on the mouse and then slide the mouse along your desk and 
observe that the mouse pointer follows the movements you make with the mouse.  

3. On the keyboard, press WINDOWS to open the Start menu. 

4. On the keyboard, press ESC to close the Start menu. 

5. Click the Start button to open the Start menu again. 

6. Click in the search box. If the box displays elements of the Cortana personal assistant, click Not 
interested, then click the Start button again. Otherwise, proceed to Step 7. 

7. In the search box, type: notepad. Notice that a list of possible matches for the term you typed displays at 
the top of the menu. 

 
8. At (or near) the top of the menu, click Notepad Desktop app to open the Notepad application window 

on the Desktop. 

9. Click the Close button at the upper right corner of the Notepad window to close the application.  

10. Click Start, then click All apps to display the All apps pane, then click Calculator to open the calculator 
app. Notice that the calculator displays inside its own window. All programs run inside their own 
dedicated windows. Notice that a button for the calculator app now displays in the taskbar. 

11. In the taskbar, click the File Explorer button (it looks like a yellow file folder) to open a File Explorer 
window. You use File Explorer to view and manage files on your computer.  
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12. Click the Show Desktop button at the right edge of the taskbar to make the open windows invisible and 
display only the Desktop. 

13. In the taskbar, point the mouse pointer over the Calculator button to display a preview window of the 
app. 

14. In the taskbar, point the mouse pointer over the File Explorer button to display a preview window of 
the File Explorer application. 

15. Move the mouse pointer into the File Explorer preview window until the Close button displays, then click 
the Close button to close File Explorer. 

16. In the taskbar, click the Calculator button to display the Calculator app on the Desktop again. 

17. Click the Close button in the Calculator app window to close it. 

18. Right-click the time in the notification area and look at the items on the shortcut menu. 

 
19. Click in an empty area of the Desktop to close the shortcut menu. 

20. Click the time in the notification area to open the calendar. 
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21. At the bottom of the calendar, click Date and time settings to open a window of date and time settings 
in the Settings app. 

 
22. Close the window.  

23. In the taskbar, click the Action Center button to open the Action Center. 

24. Press ESC to close the action center. 

Global and Profile-Specific Settings 
Objective 1-3.2, 1-3.8 

 Operating systems are highly customizable, allowing you to create the type of environment you like to work 
in. Some settings are global, meaning they affect all user accounts on the system. Generally, global settings 
are related to hardware. For example, settings that affect screen resolution, power management options, date 
and time settings, installed printers, or whether to require a password when waking the computer are global 
settings.  

Profile-specific settings are settings tied to an individual user’s profile. These affect only one user account on 
the system. Items such as background pictures, screen savers, themes and sound schemes, or whether to 
display file name extensions in File Explorer are examples of profile-specific settings. 

There are two main areas from which you can access settings.  

The Settings App 
You can configure several commonly-accessed settings through the Windows 10 Settings app. Click Start, 
and then Settings to open the main window of the Settings app. 
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From this window, you can browse the categories or use the search box at the upper right corner to find 
what you are looking for, including advanced options on specific pages in the Control Panel. 

Note: You can also right-click on the Desktop and click either Display settings or Personalize to open 
specific settings windows in the Settings app. 

The Windows Control Panel 
The Control Panel is the area in Windows where you can access features to customize settings for devices on 
your system.  

You can access the Control Panel by: 

• Right-clicking Start, then clicking Control Panel in the shortcut menu; or   

• selecting an advanced feature in the Settings app. 
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The default view for Control Panel topics is Category view. The categories are described below: 

System and Security Provides options for firewall settings, power options and file history (backups). 

Network and Internet Set up or modify how your system connects to a network or the Internet, and to 
share files with others. 

Hardware and Sound Set up or modify devices such as printers, speakers and monitors. 

Programs Provides access to system management tasks such as installing and uninstalling 
programs. 

User Accounts Provides options for setting the computer up to be used by more than one 
person. 

Appearance and 
Personalization 

Customize your screen with screen savers, desktop backgrounds, and so on.  

Clock, Language, and 
Region 

Change the format of dates, times, currency, or numbers to reflect regional 
standards or languages. 

Ease of Access Provides options for changing accessibility specifications, such as turning on voice 
recognition or altering visual displays. 

Clicking a category opens a particular page or window in the Control Panel, and each screen provides links 
to other pages. Click various links to drill down to the command or feature you want to access. 

Note that in the preceding figure, a small down-facing arrow displays to the right of the word Category. This 
arrow denotes that a drop-down list or drop-down menu is available. When you click the arrow, a list opens 
and drops down on the screen, allowing you to click an option. 

You can use this drop-down menu to change the display in the Control Panel 
from Category to view either Large icons or Small icons. The Large icon view is 
shown in the following figure. 

 
When you drill down to a page where you configure settings, you can use the various menu options on the 
page. The following figure shows a portion of the Power Options > System Settings page in the Control 
Panel. This figure features three other types of menu options used in Windows. 
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Radio buttons Force a user to select one option out of a group of options. When you select a radio 
button, any previously selected radio button within the same group is automatically 
unselected. 

Check boxes Allow users to turn one or more option choices on or off. 

Command buttons Enable a user to either save (and apply) or abandon configuration setting choices. For 
example, after you select the options you want to enable, you would click Save changes 
to keep your changes, or you could click Cancel to discard the changes you made. 

Dialog Boxes 
In Windows, you often specify settings through dialog boxes. A dialog box is a window that displays on top 
of all other windows. It is designed to accept user input, and it remains open until you close it. The following 
figure shows a typical Windows dialog box. This dialog box includes several tabs on which you can specify 
settings. Notice that the tab shown in the figure includes 
radio buttons, check boxes and command buttons. 

You cannot access any other items on the Desktop or in a 
program while a dialog box is open. 

  

Radio 
buttons 

Command buttons 

Check 
boxes 
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Changing Global Settings 
Objective 1-3.3 

You can use the Control Panel or the Settings app to customize many operating system settings, including 
global settings.  

Some features, specifically those that affect how the computer functions or those that can affect other users, 
may not display in the Control Panel if you are using a system that belongs to a company or school domain.  

Note that even if you have the ability to change certain settings, the options may not be readily available in 
the Control Panel. However, you can make these options available by clicking a link that says Change settings 
that are currently unavailable. 

 

Changing the Screen Resolution 
Screen resolution refers to the degree of clarity with which text and images appear. Screen resolution is 
measured by the number of pixels (or dots) the screen can accommodate, and the measurements are given 
as width by height. For example, a resolution of 1024 x 768 displays 1024 pixels horizontally on the screen 
and 768 pixels vertically. 

Most displays work best at their maximum resolution setting, and most systems are automatically set to use 
the highest resolution setting. However, you have the ability to adjust the resolution. If you reduce the 
resolution (for example, if you change it from 1024 x 768 to 800 x 600), items displayed on the screen will 
appear bigger but you may not be able to see all the items on the screen.  

The screen resolution is a global hardware setting (it affects all user accounts on the PC). You can access the 
resolution setting on the Advanced Display Settings window in the Settings app: 

 
You can also access it from the Display > Screen Resolution page in the Control Panel.   
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Changing Password Protection 
By default, Windows 10 systems are configured to require a user to re-enter the log on password when 
waking the system from sleep. However, you can reconfigure this option through the Accounts window of 
the Settings app. 

 
Alternately, you can change this setting on the Power Options > System Settings page of the Control Panel. 

Changing Power Management Options 
Hibernate mode, which is available on laptops, is not included in the Power menu by default. You can 
however, specify to add this option to the Power menu through the Power Options > System Settings page 
in the Control Panel as well. 

Exercise 1-3: Working with global settings 
In this exercise, you will examine global settings that affect power options and password protection.  

Note: Depending on how your system is configured, you may not have the ability to change certain 
settings. In such cases, simply read along. 

1. Right-click Start, then click Control Panel. 

2. At the top right, click the arrow for View by and click Category, if necessary. Then click Hardware and 
Sound. 



Operating Systems Lesson 1 
 

 

7500-1 v1.00 © CCI Learning Solutions Inc.  23 

3. Under Power Options, click Change what the power buttons do. 

4. At the top of the window, click Change settings that are currently unavailable. 

5. In the Password protection on wakeup section, click the Don’t require a password radio button. Notice 
that when you click this option, the option above it (Require a password) becomes de-selected.  

6. At the bottom of the window, in the Shutdown settings section, select the check box for Hibernate. (This 
option will be listed only if you are using a laptop. If you are using a desktop PC, skip to Step 7). 

7. Click Save changes. 

8. Close the Control Panel by clicking its Close button. 

9. Click Start to open the Start menu. 

10. Click Power. If you selected the Hibernate check box in Step 6, the Hibernate option now appears in the 
menu. 

11. In the Power menu, click Sleep to put your PC to sleep. 

12. Press the power button to wake your computer. Notice that you do not have to enter your password to 
resume working right where you left off. 

Now, return your system to its original setting. 

13. Right-click Start, then click Control Panel, Hardware and Sound. 

14. Under Power Options, click Change what the power buttons do. 

15. At the top of the window, click Change settings that are currently unavailable. 

16. In the Password protection on wakeup section, click the Require a password (recommended) radio 
button. 

17. At the bottom of the window, in the Shutdown settings section, clear the check box for Hibernate. If 
applicable.  

18. Click Save changes, then close the Control Panel by clicking its Close button. 

Customizing Profile-Specific Settings 
Objective 1-3.3 

Profile-specific settings allow you to customize the look and feel of your PC to make your working 
environment truly yours. Changes that you make to these settings are saved with your profile and do not 
affect other users on the same computer. 

Customizing the Desktop Display 
You can customize your Desktop by changing the background picture, configuring a screen saver, changing 
window colors, applying themes and configuring sounds. 

To access these customization settings through the Settings app, use one of the following options: 

• Click Start, Settings, Personalization; or 

• right-click an empty area on the Desktop, then click Personalize 
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You can use the tabs within the Settings app window to make your customizations. A few of the links for 
advanced settings take you to an appropriate page in the Control Panel. 

To access these customization settings directly through the Control Panel: 

• Right-click Start, then click Control Panel, Appearance and Personalization, Personalization. 

  
In Windows 10, a theme is a combination of pictures, colors and sounds. Each theme includes a Desktop 
background, a window border color, sounds and a screensaver. 

My Themes Themes you have customized, saved or downloaded. When you make changes to a 
theme, the new settings appear in this section as an unsaved theme. 
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Windows Default 
Themes 

Themes that are included with Windows 10. The Windows 10 and Flower themes include 
a Desktop background slide show. You can go online to Microsoft.com to browse, 
download and install additional themes. 

Installed Themes Themes that are created by computer manufacturers or non-Microsoft providers. Not 
every system includes installed themes. 

High Contrast 
Themes 

Themes that are designed to improve computer performance or to make items easier 
to see. These themes do not include transparency effects. 

Click any theme to select it. For the selected theme, you can change the window color, sounds and screen 
saver settings. Simply click the theme component at the bottom of the Personalization window to access the 
configuration settings. 

To customize the Desktop: 

• Use the Desktop Background option to display the Background tab of the Personalization window in 
the Settings app. (This window is shown in a preceding figure.) You can select one of the pictures shown 
in the window, or you can browse to a different location on your computer and select a saved picture to 
display on the Desktop. 

• Use the Color option to display the Colors tab of the Personalization window in the Settings app. Click 
a color square to specify an accent color. You can also tell Windows to automatically select an accent 
color based on colors in your background picture.  

  
• Use the Sounds option to apply a specific sound scheme to the theme. The sound scheme determines 

which sounds play when particular Windows events (such as closing a program or minimizing a window) 
occur. 
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• Use the Screen Saver option to select and apply a screen saver. If the screen saver includes configurable 

options, you can set those too. 
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Exercise 1-4: Customizing the Desktop 
In this exercise, you will customize the Desktop and configure and apply a screen saver. 

1. Close any open screen elements, if necessary, then right-click an empty area on the Desktop, and click 
Personalize in the shortcut menu to open the Background tab of the Personalization window in the 
Settings app. The Background setting should currently be set to Picture. 

2. Click the drop-down arrow for the Background setting, then click Solid color. Notice that the display in 
the Preview area changes to reflect the current selection. 

3. Click a color square in the Background colors section and observe the effects in the Preview area.  

4. Display the Background drop-list again and click Slideshow. Notice that options for choosing a picture 
album and setting a time interval for changing the background picture become available in the window. 

5. Display the Background drop-down list once more and click Picture. 

6. In the Choose your picture section, click an image that you want to use as your Desktop background. 

7. In the left pane of the window, click Colors to display the Colors tab. You can use this tab to select an 
accent color for the tiles and menu options that display in the Start menu. 

8. Click a color square for the color you would like to use as your accent color. 

9. Scroll to the bottom of the window to view the remaining options. You can specify to show your accent 
color on the Start button, taskbar, action center and in the title bars of individual windows. You can also 
specify whether to make the Start menu, taskbar and action center transparent. 

10. In the left pane of the window, click Lock screen. The lock screen is the image that displays when you 
lock your system, or when you wake your computer and you require a password upon waking. The 
available settings are Windows Spotlight (which features changing images chosen by Microsoft), picture 
(which lets you select a picture that does not change), or slide show (which allows you to specify a folder 
on your computer where you have images that can be used for a lock screen slide show). 

11. In the left pane of the window, click Themes to open the Themes tab, then in the right pane, click Theme 
settings to open the Personalization page in the Control Panel. 

12. At the bottom of the page, click Screen Saver to open the Screen Saver Settings dialog box. 

13. Display the Screen saver drop-down list, then click Ribbons. A preview of the Ribbons screen saver 
should display at the top of the dialog box.  

14. Ensure that the Wait time is 1 minute, click Apply, and then click OK. 

15. Do not touch your mouse or keyboard for at least 1 minute so that you can view the screen saver.  

16. Once the screen saver displays, move your mouse slightly and notice that the screen saver disappears.  

17. Change the Wait time to 20 minutes. 

18. Close the Control Panel. 

19. Close the Settings app. 
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Mobile Operating Systems 
Smart phones (and some tablets) use mobile operating systems. Mobile operating systems are optimized for 
touch screen technology, small screen size, fast file transfer, and accessing cellular networks. Even though 
they run on small devices and are streamlined so that they do not use excessive battery power or system 
resources, they can accomplish an amazing array of tasks including phone calling, video calling, streaming 
audio and video, Internet browsing, texting, connecting to Wi-Fi, and pairing with Bluetooth devices. Some 
of the most widely-installed mobile operating systems are: 

• Android – is from Google, is based on Linux and is open-source. Android releases are named for sweet 
confections; for example, version 4.3 is Jelly Bean, 4.4 is KitKat, 5.x is Lollipop, and 6.x is Marshmallow. 
Releases prior to 2.0 were used exclusively on mobile phones. Android 2.x releases are used on phones 
and some tablets. Android version 3.0 is used on tablets only. At the time of this writing, the current 
Android version is 6.0. It has the largest install base in the world and runs on phones manufactured by a 
wide variety of vendors including Samsung, HTC, Google, Sony, Motorola and LG. 

• iOS (previously known as iPhone OS) – is from Apple. It is closed-source and proprietary and is derived 
from OS X. The Apple iPhone, iPod Touch, iPad, and second-generation Apple TV all use iOS. The more 
recent versions allow for the installation of third-party applications. In previous versions, you had to “jail 
break” your phone in order to install third-party apps. iOS smart phones are developed by Apple and 
manufactured primarily by Apple partners, such as Foxconn. 

• Windows 10 Mobile (formerly called Windows Phone) – is from Microsoft. It is closed-source and 
proprietary and it is integrated with Microsoft services such as OneDrive and Office, Xbox Music, Xbox 
Video, Xbox Live and Bing. It is also integrated with non-Microsoft services such as Facebook and Google 
accounts. Most Windows phone devices are made by Nokia, HTC and Samsung. 

• BlackBerry 10 – is from BlackBerry and is closed-source and proprietary.  It runs only on phones and 
tablets manufactured by BlackBerry. 

Touch Screen Navigation on Mobile OS 
Various phones and mobile operating systems recognize specific actions and gestures for navigating and 
performing tasks on a touch screen. Generally, you can use the following motions and gestures to interact 
with a smart phone or tablet: 

• Tap (lightly tap items with your finger tip) 

– Tap keys on the onscreen keyboard to enter characters and text 

– Tap an item to select it 

– Tap an app icon to launch an application 

• Touch and Hold (touch an item with your finger and maintain contact) 

– Touch and hold a widget to move  

– Touch and hold a field to display a pop-up menu of options 

• Swipe or Slide (lightly drag your finger vertically or horizontally across the screen) 

– Swipe the screen to unlock a device 

– Swipe the screen to scroll through Home screen options or menu options 
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• Drag (touch and hold on an item, and then move it to a new location) 
– Drag a shortcut to add it to a Home screen 

– Drag a widget to place it in a new location on a Home screen 

• Pinch and Spread (pinch the screen using your thumb and forefinger, or spread by moving your fingers 
apart) 
– Pinch or spread to zoom in or out while viewing a picture or a web page 

– Pinch or spread to zoom in or out while taking a picture 

Power On / Off 
To turn on a smart phone or tablet, press and hold the power button until the device starts up. On most 
phones the power key is also the lock key – you can press it to lock the device. 

The first time you turn on your device, a welcome screen displays and you are guided through the basic steps 
required to set up your phone (such as choosing a default language, connecting to a Wi-Fi network, setting 
up accounts associated with the device, and so on). 

To turn the phone off, press and hold the power/lock button until the device 
options menu displays, then tap the power off option. The figure to the right 
shows the options on an Android phone. 

The Options menu allows you to put the device into one of several modes. You 
can turn the phone off, restart it, put it into airplane mode (in this mode the 
phone disconnects from all networks and turns off features for phone calling 
and Wi-Fi access) or put it into emergency mode (this mode is designed to 
conserve battery power by disabling apps and functions that use a lot of power; 
however, you can still send messages, use contacts, and make emergency calls.) 

Lock Screen 
Mobile operating systems on smart phones and tablets typically use a gesture-
based lock screen. A lock screen on a mobile device is similar to the lock screen in Windows – this screen 
displays until the user performs the required gesture, or enters the correct information (similar to entering 

your user account password in Windows). The following figure shows an Android 
lock screen. Notice that there are no shortcut icons displayed on the lock screen; 
you must unlock it before you can access any of the device’s features. 

Lock screens protect your devices from unintended access (that is, you can’t 
accidentally launch an app or make a call while the phone is in your pocket or 
purse), and can also protect your phone from illicit access by others. Until you 
unlock the phone, there is very little you can do with it.  

By default, most phones lock automatically when the screen times out. You can 
also manually lock your phone at any time by pressing the power/lock key. 
Generally, a mobile operating system can use the following lock screen types: 

• Swipe – unlock the phone by swiping the screen. This option provides no 
security. 
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• Pattern – you create a pattern by dragging your finger across a grid of dots, and you re-enter that 
pattern to unlock the phone. This is considered a medium-level security setting. 

• PIN – set and then enter a personal identification number (PIN) of at least four digits. This option 
provides medium to high security. 

• Password – you create a password for unlocking the screen. This option provides high security. 

• Fingerprint – you can use fingerprint recognition to unlock the screen. This option provides medium to 
high security. 

• None – you can set your phone to never use a lock screen. 

If you choose one of the secure lock screen options, you can also specify whether to show or hide content 
and notifications on the lock screen. 

It is always a good practice to lock your phone. Smart phones often contain a lot of private information, such 
as account numbers and electronic ID cards and more. Locking the phone can help prevent illicit use even if 
your phone is stolen.  

The Home Screen 
Instead of featuring a Desktop as the place from which to launch programs and perform other tasks, mobile 
operating systems are designed around a Home screen. (Some mobile operating systems refer to the Home 
screen as the Start screen.)  

The Home screen displays links or shortcuts (in the form of icons or buttons) to applications, settings, 
features, and notifications, and generally display as much status information as possible within a very small 
space.  

Home screens differ from one mobile operating system to the next, but for the most part the Home screen 
consists of a grid of shortcuts that can be arranged over multiple pages. The following figure shows the 
Home screen on an Android phone. 
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The Home screen shown in the preceding figure includes the following features: 

Notification 
icons 

Displays new messages and emails notification, information about available software 
updates, and so on. 

Status icons Displays information about the state of the phone hardware, including signal strength, 
battery level, the current time, and so on. 

Status bar Bar across the top of the phone that displays the status icons (on the right side) and 
notification icons (on the left side). 

App shortcuts Shortcuts to installed apps. Tap once to launch the app. 

App folder Several apps can be grouped into a folder. 

Widget Self-contained application (not a shortcut) that runs on the Home screen. There are 
widgets for clocks, calendars, Internet bookmarks, stock prices, weather, and even those 
that display the number of unread messages in your email Inbox. 

Home screen 
indicator 

Indicates which Home screen is currently displayed. In the preceding figure, there are 
three Home screen pages (indicated by the three icons). The first Home screen page is 
currently displayed. You can tap an indicator icon to move to that Home screen page, or 
swipe left or right to access the various Home screen pages. 

Dock An area along the bottom edge of the screen (in the figure, the dock contains icons for 
Phone, Contacts, Chrome, Messages, and Apps) which displays on all Home screen pages.  

Apps screen Allows quick access to all the installed apps, including the Settings app.  

The Home screen is highly customizable; you can add wallpapers, apply themes, add apps and widgets, create 
folders, affect the display of the date and time, and so on.  

The Mobile Settings App 
The Settings app provides access to basic device settings for a smart phone or tablet. In most mobile 
operating systems, the icon for the Settings app is a gear (or set of gears). Tap the Settings app icon to 
display the main settings page, which allows you to configure several elements of the phone hardware and 
the operating system. The arrangement of the settings may differ from one mobile operating system to 
another, but for the most part you will find settings that affect: 

• Wireless and cellular network connections 

• Phone hardware (for example, sounds and notifications, storage, battery) 

• Personalization settings (themes, wall paper, accounts, and so on) 

• System settings (such as date and time, accessibility settings, OS version and system updates) 

Notice that these are the same types of settings that you can configure in a desktop operating system.   

Virtual Personal Assistants 
Many mobile operating systems include virtual personal assistants, which are voice-activated services that 
use a natural language user interface to answer questions, make recommendations and perform actions by 
delegating requests to a set of web services. You speak natural language voice requests and commands in 
order to operate your smart phone and its apps.  
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For example, you can say, “OK Google, show me some maps of Mesa, Arizona.” Or you can say, “Siri, remind 
me to take the turkey out of the freezer tonight at 8pm.” 

In order for the virtual assistants to work, they need access to items such as your location, contacts, voice 
input, browser history (a history of web sites you have visited), search history, calendar details, information 
from text messages and email messages, and so on. The first time you launch the assistant, you will be 
prompted to allow access. Note that most of these functions and services require a connection to either a 
Wi-Fi or a cellular network. 

Popular virtual assistants include: 

• Siri – from Apple. Siri is integrated with services such as Yelp, OpenTable, Google Maps, Taxi Magic, 
MovieTickets.com, and so on. Siri is turned on by default. To talk to Siri, hold the Home button until you 
hear a prompt and then ask Siri a question or ask Siri to perform a task, such as emailing or texting.  

• Google Now – from Android. You activate Google Now by tapping the microphone in the Google widget 
or by saying, “Okay, Google.” You can use Google Now to search the Internet, set alarms, make calls, 
take a picture, set reminders and more. 

• Cortana – from Windows. You must turn Cortana on in order to use the feature. Once it is turned on, 
Cortana asks questions to learn what is important to you, and you can tell Cortana what name you want 
her to call you. Microsoft collects and uses information obtained through Cortana to improve 
personalized speech and speech recognition services. 

• BlackBerry Assistant – from BlackBerry. You can tap the icon or activate the assistant by voice. 
BlackBerry Assistant displays icons for common tasks, and as you use it, it customizes which tasks it 
displays. 

Operating System Updates 
Objective 1-3.1 

Operating systems are routinely updated for the purposes of increasing security, fixing bugs and adapting 
to new hardware and technology standards. Updates can be released in various forms. These include: 

• Patches – a patch is a file of programming code that is inserted into an existing program to fix a known 
problem, or bug. Patches are designed to provide an immediate solution to a particular programming 
problem. Patches are intended to be only temporary solutions until problems can be permanently 
repaired. 

• Updates – an update is a file or collection of software tools that resolves security issues and improves 
performance. Updates are released when necessary. 

• Service Packs – a service pack is a collection of updates that is typically released after enough updates 
have accumulated to warrant the release. Service packs typically contain all previous updates, which 
include security patches, bug fixes, and new features. 

Microsoft provides updates for the Windows operating system (and web browser) through a service called 
Windows Updates. The updates can be downloaded from the Windows Update web site. Apple provides 
updates in the Mac App Store and on the Apple Support Downloads site. 
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There are different kinds of updates. Security updates or critical updates protect against security 
vulnerabilities and viruses and spyware. Other updates correct errors that are not related to security, or they 
enhance functionality and improve performance. 

Automatic Updating – Previous Versions of Windows 
The Windows Update web site was first made live when Windows 95 was launched, and users would check 
the web site and manually download and install updates. Since that time, Microsoft has continually made the 
update process more streamlined and automated.  

In Windows 7, Windows 8 and Windows 8.1, Windows Update is a service that continuously checks for 
updates automatically. Users can configure the service to run in one of three ways: You can automatically 
check for and install the latest updates. You can also set Windows Update to check for and download updates 
and then alert you that updates are ready to be installed. You can even set it not to check for updates at all. 
Users can also manually check for (and install) available updates at any time. 

Update Categories 
Users can configure the Windows Update service by specifying actions for different categories of updates. 
Updates are categorized based on their importance. There are three categories for updates: 

• Important – these updates include security and critical updates. 

• Recommended – these updates include software updates and new or improved features. Depending on 
how you set up Windows Updates, recommended updates can be shown together with important 
updates, or with optional updates. 

• Optional – these updates include software that you can install manually, such as new or trial Microsoft 
software or optional device drivers from Microsoft partners. 

Windows 7 and 8 users often configure their systems to automatically install critical updates and then decide 
whether to install feature updates on a case by case basis 

Automatic Updating – Windows 10 
In Windows 10, Windows Update automatically downloads and installs that latest updates, drivers and 
patches released by Microsoft.  

On a Windows 10 system, Windows Update will automatically download and install important and critical 
updates by default. Optional updates and updates that require you to accept new terms of use are 
downloaded, and then Windows Update will let you know that these are ready to be installed. 

Windows 10 does not allow you to selectively install updates; you can choose only whether your computer 
will reboot automatically to install updates when the system is inactive, or whether you prefer to be notified 
to schedule a reboot.  

Manually Checking for Updates 
Microsoft releases important updates every second Tuesday once per month. However, updates can be 
released at any time. You can manually check for and install these updates by opening the Settings app and 
clicking Update & security. Windows Update is the first tab in the Update & Security window. 
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The current status of the system is shown in the right pane. In the preceding figure, the current status is “Your 
device is up to date.” Notice that the message also shows when Windows Update last checked for available 
updates. 

Click Check for updates to have Windows Update check for, download, and install any available updates. 

Exercise 1-5: Checking your update status 
In this exercise, you will see when updates were last installed. 

1. Click Start, then click Settings to open the Settings app. 

2. Click the Update & security category. 

3. Ensure that the Windows Update tab is selected in the left pane. When was the last time Windows Update 
checked for updates?  

4. At this point, you could click Check for updates to have Windows Update check again for updates right 
now. In this exercise, however, we will not check for updates. 

5. Close the Settings app. 

Benefits and Drawbacks of Automatic Updating 
Keeping your system updated ensures that you have the latest security schemes and technologies as well as 
the latest features.  

However, not all updates are necessary, and at times, updates can cause unexpected conflicts and even 
failures. This is especially true in workplace or school settings where computer systems must often interact 
with old hardware or old applications.  

Updating a Mobile Operating System 
When mobile phone manufacturers create updates for their devices, they decide when those updates will be 
pushed out to their customer base. Users will see a notification on their devices that an update is available 
and ready to be installed. You can also check manually for updates. 
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To look for updates for your Android phone: 

1. Connect to Wi-Fi.  

2. Tap Settings (or if necessary, tap Apps, then 
tap Settings). 

3. Tap System updates. 

4. Tap Check for new system update. 

To look for updates for your iPhone: 

1. Connect to Wi-Fi. 

2. Tap Settings > General > Software Update. 

3. Tap Download and Install. 

 

Note: It is always a good idea to back up your personal data before installing an update. You will learn how 
to back up your mobile data in an upcoming lesson. 

Lesson Summary 
In this lesson, you learned about the features and functions of modern operating systems. You also learned how 
to start the computer and how to access various features of the operating system. You should now be familiar 
with: 

 the function of an operating system 

 popular desktop operating systems 

 user accounts and profiles 

 power on and power off procedures 

 power options 

 using the Start button 

 navigating the Windows Desktop 

 using the taskbar 

 accessing the Settings app 

 accessing the Control Panel 

 customizing the Windows Desktop 

 the features of mobile operating systems 

 operating system updates 

 

Review Questions 
1. The ability for different people to use the same computer is made possible through: 

a. Open-source software  c. User accounts 
b. Desktop elements   d. Settings app 

2. Which of the following is the collection of stored settings that ensure your customizations are in effect 
whenever you log on? 

a. Your user profile   c. Your lock screen 
b. Your domain   d. Your permission level 

3. Kelly has several documents open on her laptop, and is working concurrently in each one. She is about 
to leave for several hours to attend an off-site social function, but will return to her documents later in 
the day. Which option below would save the most power and still ensure that she can pick up right where 
she left off? 

a. Hibernating the laptop.  c. Shutting down the laptop. 
b. Putting the laptop to sleep. d. Displaying the lock screen. 
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4. From which of the following areas in Windows 10 can you access Desktop customization settings? 

a. Desktop drop-down list  c. Calculator app 
b. Desktop Customization wizard d. Control Panel 

5. Which of the following Windows dialog box features allows you to select several options? 

a. Drop-down lists   c. Check boxes 
b. Radio buttons   d. Command buttons 

6. Which of the following is an example of a global setting on a Windows system? 

a. Desktop background picture c. Accent color 
b. Screen resolution   d. Screen saver 

7. Which mobile operating system feature helps you avoid accidentally placing a call or taking a picture? 

a. Virtual personal assistant  c. Dock 
b. Pinch gesture   d. Lock screen 

8. Which of the following is a function of the operating system? 

a. To compose and send email. 
b. To edit photographs and other high-resolution images. 
c. To control communication and manage files. 
d. All of these are operating system functions. 

9. What is the best way to shut down a computer? 

a. Press the power button on the computer case. 
b. Click Start, Power, Shut down, then let the process complete. 
c. Press CTRL+ALT+DEL twice. 
d. Press ESC. 

10. What is a service pack? 
a. A collection of software updates. 
b. A form of spyware. 
c. A power mode designed to provide emergency power during a power outage. 
d. A collection of Desktop backgrounds, sounds and themes that you can find online and then 

download and install on your system. 
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Computing Fundamentals 
 
 

Lesson 2: Hardware 
Lesson Objectives 
In this lesson, you will look at different types of computers, learn about various types of computer hardware and 
examine ways to connect devices. On completion you should be familiar with: 

 the relationships among hardware device drivers, 
firmware, and platforms 

 common measurements used in computing 

 standard internal computer components 

 memory and storage  

 identifying different types of computers 

 keyboards, microphones and touch screens 

 typical smart phone hardware 

 Windows power plans 

 connecting peripheral devices 

 wireless connection technologies 

 

What Makes Hardware Tick? 
Objective 1-2.7, 1-2.8 

As you learned in another lesson, a computer is a collection of electrical and mechanical parts referred to as 
hardware. Hardware are the pieces you can see and touch; hardware performs the physical work of the 
computer. 

Software programs (including operating systems, application programs, and device drivers) control the 
hardware and make it useful, and within the device itself, firmware provides basic functionality.  

Device Drivers  
Operating systems use small programs called device drivers to communicate with installed hardware devices. 
Device drivers are software that allows your computer to communicate with and control the devices 
connected to it. Device drivers actually control the hardware, and the operating system communicates with 
the device drivers. Without drivers, devices will not function properly. 

Device drivers are developed and released by hardware manufacturers. For any given piece of hardware, 
device drivers are developed for use on a specific operating system (and usually, a specific version of that 
operating system). Many devices include drivers for numerous operating systems. For example, if you 
purchase a printer, the printer most likely will ship with drivers for Windows and Mac OS X. 

Some devices include drivers that will work on only one operating system. For example, a particular wireless 
network adapter may work on Windows 7, Windows 8, and Windows 8.1, but not support Mac OS X or Linux. 
Always read the product labeling before purchasing hardware to make sure that it is compatible with your 
operating system.   
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Operating systems generally include drivers for various devices that you may want to connect. These generic 
drivers will provide basic functionality, but in order to utilize the full features of a device, you should install 
the drivers that ship with the device, or download and install drivers from the manufacturer’s web site. As 
you update your programs and your operating system over the course of time, you should check periodically 
for driver updates. 

Firmware 
Firmware is built-in programmable logic (software) that is embedded in a piece of hardware and controls 
how the device functions. Firmware is device-specific: it is developed for one particular model and release of 
a device. 

The firmware on a smart phone, for example, is the code needed to control the phone hardware itself and 
run the base operating system. Firmware, however, is separate from the operating system. For example, you 
may be running the Android version 5.1.1 (Lollipop) mobile operating system on your phone, and be running 
firmware build number G920VVRU48OK7. 

Smart phone manufacturers decide which phones will receive an update, and send the update to the various 
mobile network providers (for example, T-Mobile, Verizon, Vodafone, and so on) who sell their phones. The 
mobile provider can then add network-specific elements (such as branding or provider-specific features) and 
test the updates to ensure the best user experience. At the proper time (as determined by the mobile 
provider) the firmware update is pushed out to the devices that are part of their cellular network. 

Different mobile providers push out firmware updates at different times. For example, if you and your Aunt 
Mary both own a Samsung Galaxy S5 and you are on the Verizon network and she is on the T-Mobile network, 
she might receive a firmware update in October, but you might not receive it until March. 

Platform 
Software applications (and mobile apps) run on a hardware device within an environment created by the 
operating system. This environment is referred to as the platform. The platform is an interface between the 
application (or app) and the operating system, and is what makes it possible for apps to run on a device.  

Think of a platform as a foundation. The operating system (and device drivers and firmware) work together 
to control the basic functionality of the hardware. An application sits on top of this foundation (which is 
already in control of the hardware). The application performs its own special functions and then sends specific 
requests to the operating system to make sure that the necessary hardware tasks are performed. The 
functionality and syntax of these requests is built into the platform. 

About the Numbers 
Before we examine different types of hardware and how various devices compare to one another, you must 
understand how speed and storage capacity are measured. 

All the measurements revolve around the binary digit or bit. A bit is the smallest unit of data a computer can 
understand. A bit can have one of two values: a 0 or a 1. Bits are grouped in sequences of 0s and 1s to 
represent data.  
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A group of eight bits is called a byte. The smallest unit of data humans can understand is represented by one 
alphanumeric character (‘a’ to ‘z’, or 0 to 9); an alphanumeric character requires a full byte of space in either 
the computer memory or a storage device. 

Measuring Capacity 
Storage capacity (that is, the amount of space available to store data either on disk or in memory) is measured 
in bytes. Because a byte represents such a small amount of data, these capacities are measured in thousands, 
millions, billions and trillions of bytes. Notice that a byte is indicated by a capital “B” in the abbreviation. The 
following table shows standard capacity measurements: 

Measurement Abbreviation Equal to … 

Bit  A single binary digit 

Byte B Eight bits 

Kilobyte KB 1,024 bytes (a thousand bytes) 

Megabyte MB 1,024 KB (a million bytes) 

Gigabyte GB 1,024 MB (a billion bytes) 

Terabyte TB 1,024 GB (a trillion bytes) 

Petabyte PB 1,024 GB (a quadrillion bytes) 

Measuring Frequency 
Inside every computer is at least one microprocessor. The microprocessor is a silicon chip that performs 
calculations and logical operations in the computer. The microprocessor is also referred to as the Central 
Processing Unit (CPU) or simply as the processor. 

The CPU controls everything that happens in the computer. All the hardware, all the memory and all the 
software send information to and receive commands from the CPU. 

Different CPUs process information and instructions at different speeds, and processor speed is measured in 
units called hertz. Silicon chips oscillate (or cycle) when electrical current passes through them. One hertz is 
equal to 1 cycle (or oscillation) per second. Because processor chips are very fast, this measurement is 
commonly used with the prefixes shown in the following table. 

Measurement Abbreviation Multiplies by Equal to … 

Hertz Hz  1 cycle per second 

Kilohertz KHz One thousand 1,000 cycles per second 

Megahertz MHz One million 1,000,000 cycles per second 

Gigahertz GHz One billion 1,000,000,000 cycle per second 

Terahertz THz One trillion 1,000000,000,000 cycles per second 

Faster processors give better performance than slower ones, so the higher the hertz, the more powerful the 
processor. 
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Most desktop systems available today include processors with speeds between 3 and 4 GHz. Most laptops 
include processors in the 2 GHz to 3GHz range. When you purchase a computer you will find the processor 
speed listed in the product description. 

Measuring Bandwidth 
Network connections (for example, those in a cellular network or in an IP network such as the Internet) move 
data from one location to another at a particular volume per unit of time. The measurement of this volume 
is called bandwidth, and it is expressed in bits per second (bps).  

Synonyms for bandwidth include: capacity, bit rate, transfer speed, data transfer rate, and throughput. As 
with storage capacities, bandwidth is usually expressed in terms of thousands, millions, and even billions of 
bits per second, as shown in the following table. 

Measurement Equal to … 

bps Bits per second 

Kbps Thousand bits per second 

Mbps Million bits per second 

Gbps Billion bits per second 

The greater the bandwidth, the greater the capacity for transferring data, and the greater the network 
performance. 

Exercise 2-1: Comparing measurements 
For each selection of two measurements, circle the one that is larger. 

932,000  bytes or 3 MB 

4,000,000  KB or 2.8 GB 

145,000  KB or 200 MB 

8,000,000,000  bytes or 900 MB 

3,020  MB or 2 GB 

The Basics – What’s Inside? 
Regardless of whether your computer is a large desktop tower or an ultra-portable tablet, the basic 
“anatomy” is the same. Every computer includes at least: 

• a system board – this is a printed circuit board that contains most of the computer's circuitry and 
provides pathways for communication among all the components and connected devices. Internal 
components are seated on or otherwise attached to the system board. It also provides ports for 
connecting external devices, such as a mouse, speakers, a charger, and so on.  

• one or more processors – the silicon chips that control the hardware components and manage the flow 
of data and instructions 

• input devices – these allow you to send information to the computer. Examples include a keyboard, or 
touchscreen. 
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• output devices – these allow the computer to send information to you. Examples include a monitor, or 
a display screen. 

• storage devices – these include memory chips and other storage media 

• a power supply – converts AC current from a wall outlet into low-voltage DC power for the components. 
In portable devices, the DC power is stored in a rechargeable battery.   

In the next several sections, you will examine some of these internal components. 

Memory and Storage 
Objective 1-2.2 

In order to run programs and create and use files, a computer needs both memory and storage space. Every 
file used by a computer has a specific byte size, and there must be sufficient memory to “hold” the file when 
it is in use, and sufficient storage space to store the file when it is not in use. 

Random Access Memory (RAM)w 
For a computer to process information, it must include a certain amount of installed system memory. This 
type of memory is also called Random Access Memory (RAM).  

RAM is used for the temporary storage of information. Data and programs are read into memory from a 
storage location and then passed from memory to the CPU. Without RAM, a computer could not run 
programs or be used to create or edit files. 

Note: RAM can store data only while the computer is on. Any information stored in RAM “vanishes” when 
the computer is turned off. When you close a program or save and close a file, the information is cleared 
from memory, and the memory becomes available to store other information. 

Physically, memory consists of chips located inside the system unit. The number of memory chips in the 
computer and the capacity of each chip determine the amount of available memory.  

How Much RAM Do You Need? 
All software (including operating systems) requires RAM, and lists the minimum amount required to run the 
program successfully. Some programs use very little memory (for example, Notepad can run with less than 
1MB of memory), while some programs require significant amounts. For example, Adobe Photoshop requires 
a minimum of 2GB (although 8GB is recommended); AutoCAD 2016 requires a minimum of 4GB (8GB is 
recommended). 

Determining how much RAM you will need depends on which programs you want to run. The general rule 
of thumb is, the more RAM, the better.  

Every time you launch a program or open a file, you use RAM. The more files or programs you have running, 
the more RAM you are using. Having sufficient (or better still, more than sufficient) memory keeps the system 
performing at top speed, and gives you the ability to run several application programs simultaneously, and/or 
to have multiple browser windows open without experiencing a slowdown in performance.  
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Storage  
A computer loads software programs into RAM while you are working; however, the software programs must 
be stored on the computer when they are not in use. Additionally, any files that you create using a software 
program must also be stored if you want to be able to retrieve them in the future. 

Local and Remote Storage Locations 
Programs and user files are saved to storage devices. These devices can be internal (inside the computer) or 
external (storage devices attached to your computer). All internal storage devices, and all external devices 
attached directly to your computer are considered local storage locations. 

You can also save your files to remote storage locations. Folders on other computers in your network, or 
folders in a cloud storage server are examples of remote locations. 

How Much Storage Do You Need? 
All software (including operating systems) requires storage space, and lists the minimum amount required 
to install the program. Some programs are quite large. Windows 10, for example can require up to 20GB of 
storage space. Determining how much space you need depends on which programs you want to install, and 
(perhaps more importantly) on the anticipated size and number of the user files you plan to store. 

Different types of files require different amounts of storage space. For example, word processing documents 
(even long ones) are relatively small files. However, they increase in size if you add media such as images or 
audio/video. Image files can be large depending on the file format. Audio files can be quite large, and video 
files can be tremendous – for example, a 60-second video saved in Blu-ray format might be 420MB, while a 
60-minute video could be 25GB. 

If you plan to store and edit videos or high-resolution photographs on your system, you should be sure to 
purchase a system with sufficient storage, or you can quickly use up your internal storage space. 

The more storage space you have, the less stringent you have to be regarding which files to save.  

Common Storage Devices 
Commonly-used storage devices include hard disks, external drives, flash drives and memory cards. 

Hard Disks 

The term “hard disk” and “hard drive” are used to refer to a central storage location inside a computer. Hard 
disks are the primary storage location for both data and programs. Software programs must be installed on 
a hard disk before you can use them. The operating system must also be installed on a hard disk. 

Some computers use magnetic hard disk drives (HDDs), which include moving parts. A magnetic hard drive 
stores data on platters, which are metal or plastic disks that are coated with magnetic material. A motor spins 
the platters around a spindle, while read/write heads (small recording/playback devices) hover close to the 
surface of the platters and read or write data to the magnetic coating. 

Some computers use solid state drives (SSDs), which do not have any moving parts. A solid state drive stores 
data on a set of interconnected flash memory chips that save the data even when the power is off. 

Flash memory chips can be installed directly on the system board, installed on a card that plugs into the 
system board, or housed inside a 2.5-inch box that fits into the slot where you would otherwise install a 
magnetic hard disk drive.  
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External Drives 

External drives are hard drives contained in a case and attached to a 
computer with a cord as a peripheral device. External drives provide 
extra storage capacity for user documents, pictures, video, etc. You do 
not, however, install software on external drives. 

Flash Memory Storage in Tablets and Phones 

Because flash memory chips (the technology used in solid state drives) can be installed directly on the system 
board, this type of storage is used in tablets and smartphones. Most portable devices include onboard 
storage memory.  

Flash Drives 

Flash drives (also called jump drives or thumb drives) are portable mass storage devices that use flash 
memory chips.  

Flash drives are small (averaging between 2½” (60mm) and 2¾” (70mm) long and around ½” (16mm) to ¾” 
(20mm) wide), weigh less than 1 oz. (28g) and can store gigabytes of information. They are durable and 
reliable because they do not contain moving parts and can last for several years. 

While the technology is basically the same, the flash memory chips used in a USB thumb drive are slower 
and less reliable than those used in solid state drives. That is the reason solid state drives cost more than 
thumb drives of the same capacity. 

Secure Digital Cards (SD cards)  

SD cards are small, high-capacity flash memory storage devices. You use an SD 
card in the same way you would use a flash drive – insert it into the designated 
slot on your device. A card reader/writer is integrated into the device that uses 
the SD card. You can write (store) data on the card, and then retrieve (read) it. You can also pop the card out 
of one device and insert it into a reader on another device for the purpose of transferring files from one 
device to another. SD cards are popular storage devices for digital cameras, camcorders, cell phones, tablets, 
MP3 players, and GPS systems. 

Optical Discs and Drives 

Optical disc drives are designed to read Compact Discs (CDs) and Digital Versatile/Video Discs (DVDs). The 
drive spins the disc and a laser reads the data stored on the disc.  

A CD-ROM (Compact Disc Read Only Memory) or DVD-ROM drive is similar to 
a player in an audio/video entertainment system. The information is written (or 
burned) onto the surface and retrieved with a laser beam and you can only read 
the data. 

An optical writer drive, also known as a burner drive, uses special software which 
allows you to “burn” or write data onto a disc.  

New desktop systems are usually equipped with at least one optical drive, usually a DVD optical drive or a 
CD/DVD optical writer drive. Laptops used to include an optical drive, but more and more often newer models 
do not. You can, however, use an external optical drive that connects to the laptop through a USB cable. 
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Identifying Types of Computers 
Objectives 1-1.3, 1-2.1, 1-2.12, 1-2.13 

Computers are integrated into our daily lives and are available in a wide variety of forms and types. What 
comes to mind when you think of the word computer – a room-sized supercomputer performing millions of 
complex calculations for space exploration and satellite launches? A bank of mainframes supporting 
hundreds of thousands of simultaneous monetary transactions? Or do you think of the CPU tower sitting on 
your desk, or perhaps a laptop instead? What about a tablet or a smartphone? What about embedded system 
chips controlling functions in robotized assembly lines or in airliner fuel systems or in medical imaging 
equipment? All of these are examples of computers.  

In this course, you will focus your attention on the computers readily found in offices, schools and homes. 
They are the familiar devices you see and touch every day. Some types of computers are better suited to 
certain tasks than are others, but as technology advances and the market responds to the way people use 
devices, the lines that distinguish one device from another become less clear.  

 

Servers 
In contrast to the other types of computers (desktops, laptops, tablets, and smart phones) which are used for 
personal computing, servers are used to support other computers for business purposes. 

A server is a computer that provides files or services to other systems on a network. For example, a server 
may provide email services, or host a web site, or store databases or documents for everyone in a school or 
business, or provide telecommunications or transaction services. A server runs an operating system designed 
specifically for use on a server. Examples of common server operating systems include Windows Server 2012, 
Mac OS X Server, or Linux Server. 

Servers also run special software for providing services. A web server may run Apache Web Server or IIS 
(Internet Information Server) for hosting and serving web pages; a database server may run Microsoft SQL 
Server; an email server may run Microsoft Exchange Server, and so on. These programs are very different 
from the end-user productivity software you may be used to using because servers are not used for personal 
computing.  

Systems marketed for use as servers are built differently than standard PCs; they are designed to be highly 
reliable and must have a low failure rate. Processor power, memory and hard drive size are the main selling 
points. Servers must be able to run continually, and are shut down or restarted only when software or 
hardware upgrades are being installed. For this reason, they often include redundant power supplies 

Because of their increased power, server systems are considerably more expensive than desktop systems. 

To provide a baseline for a comparison, imagine that you are writing a novel destined for the best seller 
list. As you read about each device, consider how convenient and/or comfortable you might be using 
that particular device to work on your story. 
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Common Configurations 
Servers come in three basic designs or “form factors”: 

• Tower servers – look like desktop PCs. These were the original 
model and they require individual monitors, keyboards, 
network cards and cabling. Usually found in small businesses 
where perhaps only one or two servers are required. 

• Rack servers – designed to be installed into a framework 
called a rack, which contains multiple slots into which servers 
can be inserted. The server is secured into the rack system using mounting screws. The rack system 
enables you to stack multiple servers vertically. These are often accessed via a network connection from 
a central control station that includes a monitor and keyboard. When required, however, you can also 
connect a monitor and keyboard to a server in a rack. Rack servers are usually found in data centers 
housing three to twenty-four servers. (The preceding image shows rack servers in a data center.) 

• Blade servers – are stripped down servers designed to minimize power consumption and to take up 
very little physical space. This type of server must be inserted into a blade enclosure which can hold 
multiple blade servers, and which provides electrical power, cooling, and networking connections. Blade 
servers are accessed via a network connection from a central control station, and are generally found in 
data centers housing more than twenty-four servers. 

Generally Used By 
The people who perform work on server systems are generally IT staff, web designers who upload finished 
web pages, scripts, and other elements to a web server, or database administrators who maintain large 
databases of customer and product information on dedicated database servers. 

 

Desktop Computers 
Desktop computers are designed to sit on or beneath a desk. They are fairly large, although many are 
available in compact configurations so that they require less space.  

Desktop computers come in two basic designs: 

• Macs – produced by Apple. These machines feature a sleek design in which the monitor and processing 
unit are housed within the same case. Only Apple produces the Mac. Macs are designed to run the Mac 
OS X operating system. 

• PCs – produced originally by IBM, and later produced by several manufacturers. Traditionally, in a 
desktop PC, the processing unit is housed within a case, and an external monitor, keyboard, and mouse 
are attached with cables. The fully assembled combination is sometimes referred to as a work station. 
(Today, there are also some all-in-one units available.) You can use a wide variety of operating systems 
on a PC, but by far the one most commonly installed on a PC is the Windows operating system. 

Both Macs and PCs are available in a wide variety of types and configurations (including desktop models, 
laptops, servers, and touch screen devices). 

Since servers are not used for personal computing, you would not use one to work on your best-seller. 
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Desktop computers are stable and powerful and most include ample storage space (500GB – 1TB on average), 
a fair amount of installed memory (4GB - 8GB on average), the ability to read data stored on a wide variety 
of storage media, and the ability to play music and video. They include several USB ports for connecting 
external devices, and may include one or more slots for reading and writing to SD cards. Many are equipped 
with powerful video and sound cards. They usually include a network port for a wired network connection, 
and many include built-in wireless networking ability as well. 

They are also easily upgradeable – you can pop open the case to access the internal components and there 
is generally enough “working room” to easily replace or upgrade components such as a video, audio, or 
network card. You can also easily add more storage space. 

Common Set-up 
A typical desktop setup includes the PC on or under the desk and a keyboard and mouse either on the desk 
or on a pull-out tray 4-5 inches below the desktop. The keyboard and mouse may be wired or wireless. Most 
people use large flat-screen computer monitors or TVs that can accept PC input; these large displays  allow 
you to easily work with large spreadsheets, drafting programs or graphics editing programs.  

Users often attach speakers for playing sound, and some even opt for a “surround-sound” setup with high 
quality speakers and separate sub-woofer for extra bass. Depending on your sound card and the available 
space, you have quite a bit of freedom in setting up your system. 

 

Disadvantages  
The primary disadvantage of a desktop system is that it is not portable because it must always be plugged 
in to an electrical outlet while you are using it. You can, of course, move them from one location to another; 
however, this requires time to “tear down” the workstation at one location and set it up again (plug in the 
monitor, mouse, and keyboard) at the new location.  

Generally Used By 
Traditionally, people who work at one dedicated desk for the duration of the workday (for example, office 
workers, secretaries, accountants) have used desktop systems. However, as portable computers have become 
more powerful and less expensive, many workers now use laptop systems as their primary computing device. 

Windows compatible Desktop 
iMac Desktop 

A desktop system can be a comfortable place for long work periods and is usually the most 
accommodating for working extensively with documents. When you are working on that novel, a desktop 
might be just the place for you. 
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More and more often in the workplace, only those who require significant memory, processing power, video 
resolution or storage space use desktop systems, while the rest of the employees use laptops for their day-
to-day work. For example, people who use design software (such as AutoCAD or Autodesk Revit) or photo 
and video editing software (such as Adobe Photoshop or Adobe Premier) are more likely to use desktop 
systems.  

Laptop (or Notebook) Computers  
Laptop (or notebook) computers are designed to be portable. They are small and light enough to sit on your 
lap. They are also self-contained; everything you need (display, keyboard, camera, speakers, pointing device) 
is included in one unit.  

Laptops run the same operating systems as their desktop counterparts, and include the same internal 
components such as a hard drive and installed memory. Laptops also include a rechargeable battery that is 
charged from an AC adapter. 

 
Laptops are very popular with students and business people alike because of their portability. For example, 
students can bring a laptop to class and take notes, then take it home to do homework and other 
assignments.  

Aside from their portability, laptops are popular because: 

• They are available in PC and Mac models. 

• They are powerful enough to run most productivity and entertainment software. That is, they can run 
Office and play movies and stream audio, just as well as a desktop system. This makes them well-suited 
for the needs of most users.  

• They usually include built-in wireless networking capability. 

• In some cases, the power consumption is considered a “greener” alternative to desktops.  

• You can purchase a number of accessories to enhance your laptop computing experience and make it 
more like a desktop computing experience. For example, you can connect to a larger monitor, add an 
external full-size keyboard with a number pad, or connect a mouse if you don’t like using the built-in 
touchpad. 

Disadvantages 
• They generally are not as robust as desktop systems; they come with less storage space, less memory 

and lower-power graphics cards. This can make them poorly suited for running specialized software like 
graphics manipulation and video-editing programs that require extra computing or graphics power. 
However, high-end models can be well suited to running larger programs. 

• Laptops generally have a shorter lifespan than their desktop counterparts. 

Windows Laptop 
Apple MacBook 
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• Laptops include many of the same internal components as desktop systems, but these are typically 
integrated into the system board. If an integrated component such as a video or audio card fails, it cannot 
be replaced. You would need to replace the entire system board – and it is easier and often less expensive 
to purchase a new laptop. 

• Because of the extremely tight working space, it is also a complicated process to replace a failed 
component that is non-integrated. Repairs or component upgrades must usually be handled by 
professionals. 

• For many, laptops are not as comfortable to use as desktop systems.  

– The keyboards are smaller and more compact and many do not include a numeric keypad. 

– On some models the touch pad is very sensitive and users may find that the cursor “jumps around” 
on the screen while they are typing because their wrists make contact with the touch pad. 

– Many users prefer using a mouse over using a laptop touch pad. 

Common Configurations 
While some people actually use a laptop on their laps, sometimes while seated by the pool, many work seated 
at a desk and use a laptop in place of a desktop system.  

Typically, to make the laptop more comfortable to use, and to make it seem more like a desktop system, 
users often attach a separate full-sized keyboard and a mouse.  

Laptops range in size from 17 inches to as small as 11 inches, and for some users, the screen is too small for 
comfortable viewing. For this reason, many users attach an external monitor to their laptop systems. They 
can choose to duplicate the display from the laptop screen onto the external monitor, or they can choose to 
extend the display, thereby using the external monitor for “extra screen space.” For example, you can view a 
Word document on the laptop screen, and view an Excel workbook on the external monitor at the same time. 

Users who connect to external monitors, keyboards and mouse devices at work and then disconnect and 
take the laptop home at night often invest in docking stations. A docking station is a device that provides a 
simplified way of “plugging in” to peripheral devices. You attach the monitor, mouse, keyboard, speakers, 
and so on to the ports on the docking station where the cables can remain plugged in. You can then “dock” 
or connect the laptop to the docking station. Because the station is already connected to the peripheral 
devices, the laptop has “instant” access to all the attached devices without the need for fumbling with cables. 
At the end of the day, you simply “undock” or disconnect the laptop from the docking station and can be on 
your way. 

It is also quite common to connect an external monitor or projector to a laptop for the purpose of delivering 
a presentation to an audience. The user can run and control the slide show from the laptop (and view 
speaking notes and the like on the laptop screen) while projecting only the presentation to the large screen 
that faces the audience.  

 

Regardless of which configuration you use, a laptop might also be a good choice for working on that 
novel. They usually run the same software programs as their desktop counterparts, provide ample 
storage space, and include good integrated tools for working in long documents and typing text. Their 
portability also allows you to select an inspiring location in which to work. 
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Chromebooks 
A Chromebook is a specialized laptop designed primarily to run cloud-based applications instead of 
programs that are installed on the hard drive. Instead of running the Windows or Mac OS X operating system, 
these portables run the Chrome OS operating system, which is easy on system resources and streamlined for 
accessing the Internet. They can be set up in minutes and will boot up in two to three seconds (much faster 
than Windows or Mac operating systems).  

The devices themselves are lightweight, durable, and draw less power than their standard counterparts. A 
Chromebook battery generally provides 7 to 9 hours of continuous use before needing to be recharged. A 
Chromebook also provides a full size screen (11.6 inches up to 15 inches), built-in keyboard, and fairly 
powerful processors. Although designed for running cloud-based applications, they include provisions for 
working offline too.  

Chromebooks are considerably less expensive than standard laptops, and are being deployed widely for use 
in high school, middle school, and even elementary school classrooms. Their use is not limited to classrooms, 
however; anyone who can accomplish what they need to do using web-based/cloud-based applications can 
benefit from using a Chromebook. 

Tablets 
A tablet is a portable computer small enough to hold in your hands. The computer circuitry, a battery, and a 
flat touch screen display are all rolled into a single hand-held device. Tablets come with a microphone, 
speakers, and sensors that let the tablet “sense” which direction is up. All tablets have “touch screen” 
capability, enabling you to use your finger or a specialized pen called a stylus to touch an item on the screen 
to select it. You move your finger or stylus around the screen as you would a mouse, and you can "type" 
input using an onscreen virtual keyboard instead of using a physical keyboard.  

Often, tablets include physical buttons for powering on and adjusting the volume, and may include a USB 
port for charging the tablet and for data transfer. All include at least one camera (many provide a front-facing 
and a rear-facing camera), and provide an option for connecting devices such as headphones or external 
speakers.  

Instead of hard drives, tablets use onboard flash memory for data storage and usually include a slot for 
removable storage devices, such as SD cards.  

Two types of operating systems are used in tablets – desktop-based and mobile-based.  

• Tablets that run a desktop-based operating system are thicker and heavier than the other type. They 
require more cooling and they have a shorter battery life. However, they also have more connection 
ports and can run applications such as the Microsoft Office suite in addition to mobile apps. They also 
feature the familiar desktop operating system interface. 

• Tablets that run a mobile-based operating system are lighter, run cooler, and offer much longer battery 
life. However, these tablets run only mobile apps. (Mobile-based operating systems are also used on 
smart phones.) Instead of a desktop interface, mobile-based operating systems feature a “Home” screen 
from which users tap an icon for the app they want to run.  

Tablets are light, ultra-portable, and well-suited for entertainment and online activities. Most feature high-
resolution high-definition screens and fast wireless networking capabilities. Many come Bluetooth-enabled 
so that you can use external speakers without connecting them through a standard audio port. Popular 
models include the Apple iPad, Samsung Galaxy, or Windows Surface. 
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2-in-1s 

Tablets have become so popular that many laptops now offer tablet-style features. These 2 in 1 “convertible” 
devices are laptops with special touch-screen displays that you can fold all the way back (360 degrees) so 
that you can use the laptop like a tablet. 

Such devices offer the power, comfort, and document-editing capability of a laptop with the high-definition, 
high-speed streaming, touch screen capabilities of a tablet. 

Smart Phones 
Smart phones are hand-held devices that combine the features of a standard cell phone with those of a 
personal computer. They are widely used by people of all ages for a wide variety of purposes. You can use 
them to make calls, send text messages, download music or electronic books from the web, take pictures or 
video, check your email, browse the Internet, access cloud storage, open and edit documents, use GPS 
navigation, make mobile payments and watch movies – all in the palm of your hand. 

 
Unlike traditional cell phones, smart phones allow users to install, configure, and run a tremendous variety 
of application programs called apps. They run mobile operating systems and are highly customizable. 

Smart phones come complete with built-in cameras, video cameras, system memory and support for memory 
cards for storing data, and include software for organizing appointments and contact lists, or for writing 
notes. Most models incorporate touch screen technology as well as the option to connect to a desktop or 
laptop computer and synchronize files (such as photos, music files or contact lists).  

You will learn more about smart phone hardware later in this lesson. 

Exercise 2-2: Selecting the right device 
For each scenario described below, select the most practical device to use from the options shown in the 
parentheses. 

1. Dan is in line at the airport waiting to go through Customs. He has three suitcases with him. Which device 
would he most likely use to check his email while is he standing in line? (desktop, laptop, smart phone)  

2. Jamey has to edit three large video files. Which device will she use? (server, desktop, tablet)  

3. Mariette needs to make 127 e-books available for download to students at her school. What will she 
use? (server, laptop, smart phone)  

4. Iain and his six-year-old sister are waiting for their mom at the dentist’s office. Which device did Iain 
bring with him so that his sister could watch a movie? (server, desktop, tablet) 

Working on your novel on a tablet might be a little more taxing than using a desktop or laptop. The 
screens are smaller and use different illumination technologies, and your eyes may become fatigued if 
you read documents on them for a long stretch of time. Even though you can attach an external 
keyboard, most people do not use their tablets in this fashion. Depending upon the operating system 
and the storage space, you might not even be able to open a large Word document on your tablet.  
 

While you can open email attachments and read documents on a smart phone, you would probably not 
want to spend a lot of time doing so. Even though you can install the Microsoft Word app on a smart 
phone and use it to edit your document, it would probably become a tiring experience after a relatively 
short time. Additionally, internal storage space on a smart phone is limited. 
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Keyboards, Mice, and Touch Screens 
Objective 1-2.14 

Users interact with a computer through input and output devices. An input device allows you to send 
information to the computer; output devices display (or otherwise send) information from the computer to you.  

Keyboards and pointing devices are basic input devices. Monitors, printers, and speakers are basic output 
devices. Touch screens serve as both input and output devices because you can touch the screen to input 
information, and the screen displays the output. 

Keyboards 
The keyboard is the primary tool for sending information to the computer. You use it to enter data or to run 
commands in an application. Keyboards can by physical or virtual. In computing, a virtual device is one that 
does not physically exist, but is made to appear and act as if it exists by software. Virtual keyboards (and dial 
pads) are presented on screen in touch screen devices; the user “types” or dials by tapping the virtual keys 
that appear on the screen. 

Physical keyboards can be external devices that connect to a computer, or they can be integrated into a 
system.  

They come in many sizes and configurations. Some are ergonomically designed to protect against repetitive 
strain injuries such as carpal tunnel syndrome. Many include buttons for enhancing your multimedia 
experience.  

 
The preceding figure shows a standard Windows keyboard, which includes the following types of keys: 

Key Type Used for  

Typewriter keys Use these keys to type text and enter commands. 

Modifier/ 
Extender keys 

These keys are used in combination with other keys as shortcuts to commands, menus 
or functions. On a Windows keyboard, these include the WINDOWS key, the ALT key 
and the CTRL key. On a Mac keyboard, these include the COMMAND key, the OPTION 
key and the CONTROL key. 

Escape Numeric 
Keypad 

Cursor 
Movement 

Alt Control 

Windows 

Function 
Keys 
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Function keys These are located across the top of the keyboard and are labeled F1 through F12. Each 
application program assigns a special meaning or function to each key, generally to 
provide a shortcut for commonly used commands. 

Cursor 
movement/ 
numeric keypad 

This keypad is located at the far right of the keyboard, and can be toggled on and off 
by pressing the NUMLOCK key in the pad. When the toggle light is on, the pad becomes 
a calculator or numeric pad; when off, the pad becomes an arrow or cursor movement 
pad. Not all laptops include a numeric keypad – to type numbers, you use the top row 
of typewriter keys. 

Connections 
Keyboards are connected to desktop systems using a USB connection. This connection can be wired or 
wireless. Although a keyboard is integrated into laptops, you can also connect a separate keyboard via USB. 

You can also purchase Bluetooth keyboards which connect to a system using Bluetooth technology. Most 
laptops, tablets and smart phones support Bluetooth. 

Some tablets include special connections that allow you to use them with detachable physical keyboards 
designed specifically for the tablet. In some models, the keyboard is part of a tablet case that doubles as a 
stand so that you can set up the tablet as a viewing screen to work on a document or to watch streaming 
media. 

Pointing Devices  
A pointing device enables you to select or activate items on the screen by placing the pointer arrow on the 
item and performing the required action; for example, you can click to select a file or click and drag to select 
text. Pointing devices come in many forms but the traditional pointing device is a mouse. 

Mouse  
A mouse moves the pointer around on the monitor. Sliding or dragging the mouse across a flat surface such 
as a desk or a mouse pad causes the mouse pointer on the screen to mirror the movement. The traditional 
mouse used a ball that rotated to initiate this movement as you moved the mouse device on the desk. Newer 
mouse models use an optical light or diode technology to move the pointer on the screen. A trackball has a 
ball on the side where your thumb rests; you rotate the ball to move the pointer. 

A mouse usually has two buttons that are used to select and activate features on the screen. Items can be 
selected using a single mouse click, or activated using a double-click. You can display a shortcut menu using 
a right-click. Additionally, the following actions are available: 

Left Drag Press and hold the left mouse button as you move the mouse to move or select multiple items 
on the screen. 

Right Drag Press and hold the right mouse button as you move the mouse to move or copy items. On 
release of the mouse button, a shortcut menu appears with further options. 

Scroll Wheel Roll the wheel between the buttons to scroll through the contents on the screen. Most 
software applications will zoom in or out when you press the CTRL key while rolling the scroll 
wheel. 
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Thumb Button An additional button on the side of the device where your thumb would rest. This can be 
set to perform specific tasks, such as starting a program or working as an alternate CTRL 
key. 

To use the mouse pointer to select items, grasp the mouse with your palm down and your index finger gently 
resting on the first button. As you slide the mouse flat along the desk, the mouse pointer will move in the 
same direction on the screen. If you run out of space on the desk, lift the mouse and place it in a new position 
on the desk, and continue moving. 

To cancel any option, click the left button anywhere on the screen away from the item being selected. 

Mouse devices are available in the traditional (wired) style or as wireless devices. The traditional mouse has 
a cord that extends from the base of the mouse to a USB port on the computer. A wireless mouse includes a 
separate connector that plugs into the computer and recognizes the commands from the mouse. A Bluetooth 
mouse does not require a separate connector. All wireless varieties require batteries, whereas a traditional 
mouse needs only to be plugged into a computer.  

Touchpad 
A touchpad device enables you to use your finger to move the mouse pointer around on the screen. This is 
common on a laptop, although these devices can be purchased separately for use with a desktop computer. 
A touchpad has two buttons that work in the same manner as the left and right buttons on a mouse. 

• To move the mouse pointer around on the screen, place your finger anywhere on the touchpad and then 
glide it around the touchpad in the direction you want to move the mouse pointer. 

• To select an item, position the mouse pointer over the item and then tap the touchpad once or click the 
left button below the touchpad. 

• To activate an item, position the mouse pointer over the item and then tap the touchpad twice in quick 
succession or double-click the left button below the touchpad. 

• To drag an item, position the mouse pointer over the item, press CTRL, and then glide your finger on the 
touchpad to the required location. 

• To display a shortcut menu, position the mouse pointer over the item and then click the right button 
below the touchpad. 

Stylus 
A stylus is an input device that looks similar to a pen and can be used instead of your finger to select or 
activate an item on a touch screen. Press the stylus lightly on the option on the screen you want to select or 
activate. For example, on a smart phone or a tablet you may use the stylus to “dial” the digits of a phone 
number, start an application, or write text. Depending on the system and the programs available for that 
device, you can also use the stylus to draw shapes or diagrams. 

Pointing devices of this type are typically designed in a pen format but are also available in various designs 
and can also be referred to as a digital writer. 

Touch Screens 
A touch screen is a display device that allows you to interact with a computing device by touching areas on 
the screen. Tablets and smart phones rely on touch screens for receiving user input. These devices present 
virtual keyboards and dial pads to the user, and the user “types” by tapping the appropriate on-screen keys. 
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Some laptops feature touch screen displays, and you can also purchase standalone monitors with touch 
screen functionality. 

Typically, you interact with a touch screen using your finger or a stylus. You can move your finger or the 
stylus around on the screen as you would a mouse, and you can touch or tap an item on the screen to select 
it. Touch screens detect where your finger or stylus is touching the screen, and translate your on-screen 
actions into key presses or mouse actions. They work well enough to be popular; however, they do not 
provide the same fine control and precision that you can achieve using a mouse and keyboard.  

Limitations 
Entering text by “typing” on a touch screen is time-consuming and can become uncomfortable after working 
for a while. Often it is difficult to select text, and it can be frustrating looking for commands on a touch screen 
when you may be accustomed to using keyboard short cuts to accomplish certain tasks. 

Because touch screens are typically found on smaller devices, it may be difficult to select the specific objects 
or keys you want. For example, it can be difficult to type text accurately because the keyboard keys are close 
together, or it can be difficult to select a particular tab in a browser session when you have multiple tabs 
open. 

Typical Smart Phone Hardware 
While there are a vast variety of models, smart phones generally have a similar structure to one another, and 
function in the same way, regardless of manufacturer or model. The following figure (taken from the Samsung 
Galaxy S6 User Manual) points out the typical hardware found on a smart phone. 

  

There are only four physical buttons on this smart phone – the Volume Up and Volume Down buttons, the 
Home button, and the Power/Lock button. All the other “buttons,” icons, shortcuts, and settings are 
represented on the touch screen. 

Proximity and 
light sensors 

Earpiece 
Status light Front camera 

Power/ 
Lock key 

Recent apps Back 
Home/Finger Scanner key 

Volume keys 

Microphone Infrared transmitter 

Flash Rear camera 
Heart rate sensor 

SIM Tray 

Speaker 
Microphone 

Headset jack 
USB charger/ 
Accessory port 
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The Recent apps and Back buttons, which are not part of the Home screen, are also virtual (touch screen) 
buttons that appear near the bottom of the phone. These are shown in the following figure: 

 

The proximity and light sensors allow the phone to detech whether you are holding your phone near your 
face. Many phones respond to the proximity of your face by turning on the screen. 

Subscriber Identity Module (SIM) 
Mobile phones use one of two technologies for connecting to a cellular network – GSM (Global System for 
Mobile communication) or CDMA (Code Division for Multiple Access).  

GSM phones all contain a Subscriber Identity Module (SIM) card which identifies the phone to the carrier 
(cellular provider). CDMA phones are identified to the carrier through information that is “hard-wired” into 
the handset. 

The SIM card is a small circuit board that contains a chip encoded with requisite details, including the phone 
number, voice plan, data plan, security data, billing and account information. The SIM identifies your phone 
to the carrier’s network. A GSM phone must have a SIM card installed in order to connect to the network. 

SIMs are easily accessible and you can take them out of one phone and pop them into another (asumming 
that the SIM is compatible), and use that other phone as if it were yours. Your phone number, voice plan, 
data plan and so on become instantly available on the “new” phone. 

Smart Phone Keyboard / Dial Pad 
Smart phones make extensive use of virtual onscreen keyboards and dial pads. The 
following figure shows a typical onscreen dial pad. 

Smart phone touch screen keyboards (typically used for entering information and 
for creating text and email messages) are presented in a series of screens. For 
example, the figure to the right shows the touch screen keyboard on an Android 
phone. 

  

Tap the SHIFT key  to alternate between 
upper and lower case keyboards.  

Tap the BACKSPACE key  to delete 
characters to left of the cursor. Tap the 

LINEFEED key  to move to the next line. 

Back Recent apps 
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Tap the SYMBOL key  to view symbols. 

Tap 1/2 key  to view the second set of 

symbols or the 2/2 key to go back to the 
first set. 

Tap the ATTACH key to open a menu that 
will allow you to add an attachment. 

 

Tap the SMILEY key  to display a palette of emoticons. 

Tap the SEND key  to send a completed message. 

Power Plans 
Objective 1-2.6 

Every computer has a power supply that converts the AC power from an outlet into DC power that the 
computer can use. The computer receives power using a power cord that is plugged into a standard electrical 
outlet. All portable computing devices include an internal or additional battery that allows you to use the 
computer without plugging it into an electrical outlet.  

In Lesson 1, you learned how to manually put your computer into sleep or hibernation mode. In this section, 
you will learn how to use Windows power plans to specify how power is used. Power plans primarily affect 
battery life in laptops; however, using them on your desktop system can help you conserve energy and take 
a “greener” approach to computing. 

Working with Power Plan Settings  
You can easily change a power plan’s settings. The operating system allows you to customize how much 
power is used for specific tasks. That is, you can configure and apply power plans that will automatically turn 
off the display and put a computer into sleep after a specified amount of time. 

A Windows power plan is a collection of hardware and system settings that manage how your computer uses 
power. Power plans will automatically adjust the screen brightness, turn off the display, or put the computer 
to sleep after a specified amount of time. Advanced settings in a power plan may also turn off the wireless 
networking card or hard disk after a certain period of inactivity.  

To access power plans, open the Control Panel, then click Hardware and Sound.  

 
To view all configurable options, click Power Options. Be aware that if you are connected to a domain or do 
not have full administrative rights, some options may be restricted to you. You will then need to work with 
your network administrator to assist with the power options. 
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Windows includes three customizable built-in power plans: 

• Balanced – provides full performance when you need it and saves power during periods of inactivity. 

• Power saver – saves power by reducing screen brightness and system performance. You might use this 
plan to get the most from a single battery charge.  

• High performance – this plan maximizes screen brightness and may increase system performance. This 
plan uses a lot more energy than the other plans, and will put a strain on a laptop battery.  

Many laptops also include an installed power plan from the computer manufacturer. For example, the 
preceding figure shows that the computer also includes a built-in power plan by Dell, the manufacturer.  

To view or change the settings for a power plan, click Change plan settings to open the Edit Settings window.  

 
If you are working on a laptop, you can specify when to take actions when the computer is running on battery 
power and when it is plugged in. You can also adjust the brightness of the display. 

If you are working on a desktop system, you may see options only for turning off the display and putting the 
computer to sleep. 

Click Change advanced power settings to open the Power Options dialog box. 
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To choose what the power buttons do or what happens when you close the lid of the laptop, click the Choose 
what the power buttons do or Choose what closing the lid does option from the panel at the left of the 
main Power Options window. Options set here determine what happens with the power for Standby/Sleep, 
Hibernation, or Shut Down mode. 

 

Exercise 2-3: Examining power plan settings 
In this exercise, you will examine power plan settings. 

1. Right-click Start, then click Control Panel. 

2. Click Hardware and Sound, then click Power Options. 

3. If necessary, click the arrow for Show additional plans. 

4. Review the power plans on your system. Is there a plan from the computer manufacturer? 
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5. Click Change plan settings for the Power saver plan. 

6. Display a few of the drop-down lists to see the available settings, but do not change any settings. 

7. Click Change advanced power settings to open the Power Options dialog box. 

8. Scroll through the box to examine the settings categories. 

9. Double-click an item to view its options. 

10. Click Cancel to close the Power Options dialog box. 

11. Click Cancel to exit the Edit Plan Settings page. 

12. Close the Control Panel. 

Connecting Peripherals 
Objective 1-2.3, 1-2.4 

Peripheral devices are connected to a computer system by a cable or by using wireless technology.  

Cables are attached to the devices at one end, and the “free” end is terminated in a specialized connector 
designed to attach to the system unit through a special socket called a port. Most computer systems include 
(at least some of) the following ports: 

• Video ports – these allow you to connect monitors, projectors, and even televisions to the computer for 
the purpose of displaying output.  

• Network ports – these allow your computer to connect to various networks. 

• Audio ports – deliver sound from the sound card to external speakers or headphones. These ports are 
sometimes called jacks. 

• Universal Serial Bus (USB) ports– these allow you to attach a wide variety of devices (printers, scanners, 
cameras, flash drives, keyboards, mouse devices, and so on) to the computer. Because USB ports also 
deliver electrical power, they can be used to power peripheral devices or to re-charge the batteries of 
connected devices. 

Video Ports and Connectors 
Video ports allow you to connect a monitor, projector, or television to a computer in order to display video 
output. Most desktop systems include at least two video ports. High performance systems and gaming 
systems often include more. Standard computer video ports include: 

• Video Graphics Adapter (VGA) 

• Digital Video Interface (DVI) 

• High-Definition Multimedia Interface (HDMI) 

An HDMI port and cable are shown here. 
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To attach a monitor, check the ports on the computer and the ports on the monitor and use an appropriate 
cable. That is, use a VGA cable if you will be using VGA ports, or an HDMI cable if you will be using HDMI. 
Insert each connector firmly into the appropriate port on the computer and on the monitor.  

If your monitor’s input ports do not match any of the video output ports on your computer, you can use an 
adapter to convert signals from one format to another.  

Laptops, tablets, and phones all incorporate the display (monitor) into the device itself. However, most 
laptops and some tablets include video out ports that allow you to send output to a second display device. 
Tablets often include mini display ports, which require a mini version of one of the standard video connectors, 
and you can purchase specialized video cables that include a mini connector on one end and a standard size 
connector on the other. You can also use a standard video cable with a standard-to-mini connection adapter. 

Note: Many smartphones and high-end tablets include screen casting software, which enables you to 
wirelessly project your device’s screen to a suitably-equipped display device. 

Monitors 
The monitor is an output device that enables you to view information the computer displays. All monitors 
include a power switch and a power cord, as well as brightness and contrast controls to adjust the screen 
image. Most include two types of video input ports. 

Monitors come in a wide variety of sizes, resolutions, and types; the larger the screen, the larger the image 
will be on the screen and the more expensive the monitor will be. Resolution, or the monitor’s ability to 
display images, is a measurement based on particular mathematical levels of sharpness and clarity, and is 
also a factor in the price. Some monitors include touch screen technology. 

Connecting a Second Display Device 
Physically connecting a second display device to a laptop or desktop system is a simple matter of connecting 
the correct video cable. After the physical connection is in place, the operating system detects the second 
display. You can then configure the appropriate settings for how you want to use the additional display. In 
Windows 10, you can use the Settings app or the Control Panel. 

In the following figure, the Display window of the Settings app show two display devices are connected to 
the system.  

 
If you connect a second display and it does not appear in this window, click Detect to force the operating 
system to re-examine its current connections. Once the second display appears in the window, you can 
proceed. 
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If you click Identify, Windows will display a number “1” on the first display, and a number “2” on the second 
one so that you know precisely which display each number refers to. 

Scroll further down to access the Multiple displays drop-down list.  

 
The choices include: 

• Duplicate these displays – this option sends the same output to monitor 1 and monitor 2.  

• Extend these displays – this option allows you to show different output on each monitor. For example, 
you can look at your email on monitor 1, and work on a spreadsheet on monitor 2. Or you can display a 
large spreadsheet across both monitors.  

• Show only on 1 – this option shows output only on the monitor designated as number 1. Monitor 2 
goes blank. 

• Show only on 2 – this option shows output only on the monitor designated as number 2. Monitor 1 
goes blank. 

When you have configured your desired settings, click Apply and then close the Settings app. 

You can access these same settings on the Screen Resolution page in the Control Panel. 
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Network Ports and Connectors 
A network port on a computer allows you to connect to a local area network (LAN) using a network cable. 
The port (technically an RJ-45 jack) is known by several names, including: Ethernet port, network port, and 
LAN port. An Ethernet port (which looks like an over-sized telephone jack) and an Ethernet cable are shown 
in the following figure. 

  
A network port allows you to connect to a wired network using a network cable (also called an Ethernet 
cable). You connect one end of the cable into the port on your computer, and the other end into a LAN port 
in a wall jack or into a LAN port on a networking device such as a network switch or network router.  

Audio Ports and Connectors 
Dedicated audio ports on a computer sound card allow you to connect audio devices, such as speakers, 
headphones, or microphones to your computer.  

A typical sound card for a desktop system includes 3.5mm audio ports called “jacks” for various types of 
audio devices and game adapters (joysticks). Audio jacks may be marked with an icon, or are identified by 
color coding: 

• Pink – Microphone 

• Light blue – Line In (for example, a tape player or CD player) 

• Lime green – Line Out (speakers or headphones) 

Laptops, tablets, and smart phones include one 3.5mm audio jack. You can connect 
headphones, ear buds, or external speakers using a wire connected to the device or 
using a standard auxiliary “aux” cord. The male connector is shown here: 

Note: Many audio devices such as headsets, speakers and microphones can also be attached to a 
computer through a USB connection, or a wireless Bluetooth connection. 

Microphones 
Microphones allow you to record sounds and convert them into a digital format for use on the computer. 
Specialized software can even recognize your voice as you speak into a microphone and convert what you 
say into text characters that appear on the screen. Specialized software of this type is very beneficial for users 
with special needs. 

Microphones are not usually included with a desktop computer, but you can purchase microphones that will 
connect to an audio port on the computer’s sound card or through a USB port. You can also purchase 
headsets with an integrated microphone. Most laptops include a built-in microphone, and tablets and phones 
include a built-in microphone as well. 
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Speakers 
Speakers play sounds saved as digital files on the computer. Desktop systems require external speakers in 
order for you to hear the sounds being played back by the sound card. Standard desktop speakers come 
with a 3.5mm audio jack that you plug into the sound card (or into a headphone jack). External speakers 
require power and include a power cord which must be plugged into an AC outlet.  

There are also a wide number of USB speakers available. These receive both signals and power from the USB 
port. 

Note: It is also possible to purchase a monitor that includes built-in speakers. In order to hear sound 
through the monitor speakers, the monitor must be connected to the desktop via an HDMI connection.  

Laptops, tablets, and phones include internally integrated speakers. Newer smart phones and tablets feature 
high-quality speakers suitable for playing music and videos. Older laptops, however, are not known for their 
high-quality sound systems, and many users attach external speakers or headphones to their laptops. These 
can be connected through a headphone jack, or via a USB port or by using Bluetooth or infrared connections.  

 

USB Ports and Connectors 
Universal Serial Bus (USB) connections make it possible to connect a wide array of peripheral devices to a 
computer. USB is used for mass storage (such as in flash drives), and for connecting human interface devices 
(such as mice, keyboards, joysticks, tablets, etc.). Because it also delivers power, it is used as a charging 
standard for devices with re-chargeable batteries. The following figure shows two USB 3.0 ports. 

 
The USB standard has been in use for several years, with versions 2.0 and 3.0 in widespread use today, and 
version 3.1 (Generation 1 and 2) breaking onto the scene.  

• Version 2.0 can transfer data at a top speed of 480Mbps. The usual color coding for USB 2.0 ports and 
connectors is black or white. 

• Version 3.0 (called SuperSpeed USB) has a theoretical top speed of 5Gbps (although this speed is seldom 
realized in real-world use).  Version 3.1 Generation 1 is almost identical to USB 3.0, except that it supports 
new connectors. The usual color coding for USB 3.0 ports and connectors is blue. 

• Version 3.1 Generation 2 promises speeds of up to 10Gbps. The usual color coding for USB 3.1 ports and 
connectors is teal blue. 
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Most desktop systems sold today include several USB 2.0 and 3.0 ports.  

Laptops generally include only 2 or 3 USB ports. If you want to connect several USB devices to a laptop, you 
can increase the number of available ports by connecting a USB hub. The hub uses one USB port on the 
computer, and provides, four, six, or eight open ports for connecting devices. 

Connector Types 
As portable devices have become smaller, the USB standard has adopted different sized connectors. Type-A 
connectors are the flat rectangular connectors you are probably most familiar with. Mini and Micro 
connectors are commonly found on devices with a slim profile. If your device ships with a USB cable, it will 
include the correct connector type.  

USB Flash Drives 
A USB flash drive is a flash memory data storage device integrated with a 
USB connector. The drive consists of a small circuit board and a standard 
type-A USB connector, tucked inside a plastic or rubberized case. The 
connector may include a protective cap, or may retract into the case. 

The USB mass storage standard used by flash drives is supported by modern operating systems such as 
Windows, Mac OS X, and Linux. Flash drives with USB 2.0 support can store more data and transfer data 
faster than optical drives, and they are easier to use. When you plug the drive into a USB port, the operating 
system automatically recognizes it and assigns it a drive letter. 

It is recommended that you right-click the drive icon and click Eject before removing a flash drive. You should 
also ensure that the activity light on the flash drive itself is not blinking when you remove the drive. Removing 
the flash drive while the activity light is blinking may cause the data to be lost or damaged. 

Printers 
Printers convert what is on the screen into printed pages. All applications allow you to choose different print 
options, such as landscape or portrait orientation, paper size, and manual or automatic feed. 

In the not-too-distant past, printers connected to computers using dedicated printer ports and print cables. 
Today, printers are connected using USB connections or network connections. 

To connect a printer directly to your computer, you use a USB cable. Windows comes pre-loaded with 
hundreds of drivers for various printers, and will automatically load drivers when it detects that a printer is 
connected. The following figures show Windows detecting a USB device, and installing the drivers. 
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When connecting a printer, you should always read the manufacturer documentation before making any 
connections. Often printers ship with a “quick start” flyer and a software installation DVD. In many cases, you 
will be directed to run the installation program on the DVD before you connect the printer to the system. 
Installing the manufacturer's drivers first ensures that Windows does not install and use a generic device 
driver for the printer instead of using the feature-rich drivers supplied by the manufacturer. Once a printer is 
connected, you should always print a test page to be sure it is functioning properly. 

Installed printers (that is, printers that your computer can send print output to) are listed in the Printers & 
scanners window of the Settings app, in the Printers section of the Devices and Printers page in the Control 
Panel, and in the Print menu of installed applications programs. For example, the following figure shows 
available printers in the Print dialog box in the Notepad application. 

Simply select the printer in the Print dialog 
box in order to connect to it. Note that in 
many cases, you will find entries such as 
Microsoft Print to PDF, Microsoft XPS 
Document Writer, or Send to OneNote in the 
printers list. Even though these are not 
hardware print devices, you can send print 
output to them.  

In addition to sending output to a printer 
directly attached to your computer, you can send output to a shared printer attached to another computer, 
or you can send output to a printer that is attached directly to a network. You will explore these types of 
connections in an upcoming lesson. 

Exercise 2-4: Viewing installed printers 
In this exercise, you will view the printers installed your computer.  

1. Click Start, then click Settings to open the Settings app. 

2. Click Devices, then in the left pane click Printers & scanners if necessary. The installed printers and 
scanners display in the right pane. How many are installed? Are all of them in your immediate vicinity? 
Are there any options listed that are not hardware print devices? 

3. Scroll to the bottom of the window, then click Devices and printers to open the Devices and printers 
page of the Control Panel. It may take a moment for the page to populate because Windows polls all 
connected devices each time you open this page. 

4. Do you see the same devices as you saw in the Settings app? The printer marked with a green check 
mark is currently set as the default printer.  

5. Close the Control Panel and close the Settings app window. 

6. Click Start, type: notepad, then click Notepad Desktop app at the top of the start menu to open the 
Notepad application. 

7. In the Notepad window, type: This is a printer test.  

8. In the Notepad window, click File, then click Print to open the Print dialog box. Do you see the same 
printers listed here as you did in the Control Panel? 
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9. If your teacher says it is okay to print, click Print, otherwise click Cancel. 

10. Click the Close button in the Notepad window and click Don’t Save to discard your changes. 

Digital Cameras 
Digital cameras encode images and video into digital files that are stored and can later be edited and played 
back. Files are stored on an SD card. 

Many digital cameras can connect directly to a computer for the purpose of transferring captured images 
and video. 

USB is the most commonly used connection for this type of file transfer. When you connect a camera to a PC 
via USB, the camera’s internal storage system is treated as an accessible storage location. The PC will assign 
it a drive letter, and you can navigate it as you would any storage device.  

Newer cameras also commonly include wireless capabilities and can use Wi-Fi or Bluetooth or infrared 
connections to transfer pictures and video to a PC or to smart phones. Smart phones can use cellular networks 
to transfer and share photos, and many mobile operating systems provide for automatic uploading to cloud 
storage.  

Another alternative for transferring image and video files from a camera to a computer is to remove the SD 
card from the camera and insert it into a card reader slot on the computer. In this manner, you are using the 
SD card like a flash drive. 

Wireless Connection Technologies 
Objective 1-2.7 

Wireless connections use radio waves and free space instead of physical wires or cables. The short-range 
wireless connections discussed in this section (Bluetooth and infrared) are used to connect devices (such as 
computers and phones) to accessories (such as headsets, mice, keyboards, and so on.) These technologies 
are not related to Wi-Fi. Wi-Fi connections will be discussed in an upcoming lesson. 

Bluetooth 
Bluetooth is a wireless technology used to allow devices (such as computers and phones) to work with 
Bluetooth-enabled accessories (such as headsets, mice, keyboards, and so on). 

Bluetooth devices and accessories must be “paired” with each other before they can communicate. You can 
pair devices by following these steps: 

1. Turn Bluetooth ON on your device. (Bluetooth requires quite a bit of energy, and accordingly, most 
people keep Bluetooth turned off on their battery-powered devices until they need it.) 

2. Put your accessory into discovery mode; this allows your accessory to broadcast its availability and other 
Bluetooth devices within range can discover it. The specific steps required to change to discovery mode 
depend on the accessory. On many accessories, you hold down a button for several seconds until a light 
starts flashing. A device will remain discoverable for only a few minutes in order to save power. 

3. On the device that you want to connect the accessory to, view the Bluetooth settings screen to see a list 
of nearby devices that are in discovery mode. (This screen also shows accessories that are already paired 
to the device.) 
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4. Pair the devices by selecting the accessory in the list. You may be prompted to enter a PIN code to pair 
the devices. The required code will be displayed on the device’s screen. For example, if you are pairing 
your phone with your computer, you will see a PIN on the phone’s screen and you will type it into your 
computer. After Bluetooth devices are paired they should automatically see each other and communicate 
when they are both powered on and have Bluetooth enabled. 

Note: Bluetooth is also commonly used to enable hands-free phone calling by using a car’s stereo system 
to make or receive calls without touching the phone, and to transfer files between devices that are in close 
proximity to each other. 

Compatibility Considerations 
It is important to understand that devices and accessories must be compatible. In other words, just because 
a device and an accessory are Bluetooth-enabled, it does not necessarily mean that they will work together.  

For example, iPads and iPhones support an array of Bluetooth accessories such as headsets, remote controls, 
and keyboards; however, they do not support Bluetooth mice.  

Infrared 
Infrared wireless (or IR wireless) technology uses a beam of invisible light to transmit information. The 
sending and receiving devices must both contain infrared ports, and must be within fairly close proximity (for 
example, in the same room) in order for a connection to succeed. 

Infrared technology is used in TV remotes, cordless microphones, wireless mice, cameras and audio devices.  
Infrared transmitters on smart phones allow you to use your smart phone as a TV or Set Top Box remote 
control. 

Lesson Summary 
In this lesson, you learned about various types of computers and computer hardware, and you examined ways to 
connect devices. You should now be familiar with: 

 the relationships among hardware device drivers, 
firmware, and platforms 

 common measurements used in computing 

 standard internal computer components 

 memory and storage  

 identifying different types of computers 

 keyboards, microphones and touch screens 

 typical smart phone hardware 

 Windows power plans 

 connecting peripheral devices 

 wireless connection technologies 

Review Questions 
1. Which internal component performs calculations and logical operations? 

a. Microprocessor c. System board 
b. RAM chips d. Power supply 
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2. Why is RAM used for temporary storage? 

a. It is not big enough to be used for permanent storage. 
b. It disappears when the computer is turned off. 
c. It is too slow to be used for permanent storage. 
d. It wears out after a few uses. 

3. Which of the following is likely to have the greatest internal storage capacity? 

a. Chromebook c. Server 
b. Tablet d. Smart phone 

4. Which of the following is a disadvantage of using a desktop PC? 

a. It is not portable. 
b. It probably does not have a lot of storage capacity. 
c. It probably does not have a lot of RAM. 
d. All of these are disadvantages of using a desktop PC. 

5. Which of the following is a disadvantage of using a touch screen keyboard? 

a. It becomes uncomfortable after a period of time. 
b. It does not include symbols. 
c. It does not include numbers. 
d. All of these are disadvantages of using a touch screen keyboard. 

6. Madge is going to connect a printer to her laptop computer. Which type of port is she likely to use? 

a. A video port c. A USB port 
b. An audio port d. There is no way to tell 

7. Adam stores video files on a 1TB hard disk. Which computing device is he most likely using? 

a. A desktop c. A Chromebook 
b. A tablet d. A smart phone 

8. Which piece of smart phone hardware identifies a GSM phone to its carrier network? 

a. The lock screen c. The SIM card 
b. The widget d. The infrared transmitter 

9. Gary is going to connect an external monitor to his laptop. Which of the following ports is he most likely 
to use? 

a. Ethernet port c. USB port 
b. HDMI port d. Line In port 

10. Harlene wants to pair her Bluetooth headset to her laptop. Which of the following is a step she must 
take? 

a. Connect the headset to a USB port. 
b. Change power plan on her laptop to High Performance. 
c. Put the headset into discovery mode. 
d. Turn off the wireless networking card because it interferes with Bluetooth. 
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Lesson 3: Networks and 
Mobile Devices 
Lesson Objectives 
In this lesson, you will examine different types of networks, explore subscription and contract costs, and examine 
connection technologies and hardware. You will also learn how to configure and use voice mail and how to 
manage mobile data usage. On completion you should be familiar with: 

 the benefits of networking 

 basic data network concepts 

 how to obtain Internet service 

 broadband technologies and speeds 

 LAN hardware and addressing 

 Ethernet connections 

 Wi-Fi connections and wireless security 

 basic cellular network concepts 

 how to obtain cellular service 

 how smart phones and tablets connect to the Internet 

 basic telephone network concepts 

 how to configure and use voice mail 

What is a Network? 
There are networks all around us – transportation networks, cellular networks, data networks, cable television 
networks, and the telephone network. At its very simplest definition, a network is a system for moving objects 
or information. 

In computing, a network is simply an arrangement of computers (and additional computing devices) that are 
connected in such a way that they can communicate and share information. Individual networks can also be 
connected to other networks, and this practice is referred to as internetworking.  

A network can consist of two or three computers in a single room, while an internetwork can consist of 
millions of computers connected across the globe. 

Infrastructure Is Everything 
Networking technologies have been in a state of constant development and improvement since the late 
1960s. However, networking becomes practical and desirable and adopted into widespread use only when 
the proper infrastructure is in place. 
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Infrastructure is the basic underlying physical structure or framework needed for the operation of a service 
or an enterprise. In the case of networking, infrastructure is the hardware that supports high-speed 
communications and data transfer. Infrastructure is millions of miles of fiber-optic cable, high-powered cell 
relay towers dotting the landscape, over a thousand communication satellites in orbit around the earth, high-
speed routers and servers and exchange points strategically positioned along the Internet, and consumer 
devices capable of participating in modern networks. 

It has taken over fifty years and billions of dollars to build the infrastructure that our modern networks rely 
on today. And today, modern networking technologies and networks evolve and expand at an amazing rate 
because now (finally) there is sufficient infrastructure in place to support that type of growth. 

Connectedness is Key 
In this lesson, you will learn about different types of networks. Even though these networks are distinct from 
one another, they also inter-connect with each other. Cellular networks, the telephone network, and the 
Internet all inter-connect, and since our private (within our homes or schools or businesses) networks and 
computers and computing devices tap into these large networks, we are all inter-connected.  

Why Network? 
Networks are in wide use today because they are practical and useful. They enable users to share many 
things, including: 

• Files – for example, Betty can create and store a file on her computer, and her fellow network user Barney 
can open and work with Betty’s file without having to obtain a copy of the file.  

• Resources – printers and scanners are commonly shared on a network. An entire office can share one or 
two printers, eliminating the need to purchase and attach a printer to each computer. 

• Internet connections – networks within a home or office allow several users to share an Internet 
connection. 

Internet Connection Sharing 
Multiple computers in your home or office can share an Internet connection – but what about all those other 
familiar Internet-enabled devices we use daily? Smart phones, tablets, video game consoles, Blu-ray players 
and widescreen TVs all connect to the Internet as well. All these devices can share in that single Internet 
connection too. 

For this reason, even a single person living alone can benefit from creating a small home network that is 
connected to the Internet. With a simple home network, you can: 

• Stream audio and video to various devices. 

• Share stored media (such as audio files, or photographs) among your devices. 

• Share and backup files (including documents, pictures, scans, and so on.) 

• Play games online. 

Even though your devices are sharing a connection, each device can access the Internet independently. That 
means, the laptop in the kitchen might be surfing the Internet, while a tablet in the next room is streaming a 
video, and the Xbox 360 in the living room is being used for multi-player gaming. 
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About Streaming and Downloading 
Before getting too far into our networking discussion, you should have a clear understanding of the 
difference between streaming and downloading. When most people talk about downloading and streaming 
they are usually talking about audio and video files accessed through sites like YouTube or Netflix, or songs 
and movies that they have purchased from an online store.  

Downloading is the process of copying a file (any type of file) from a server on the Internet to your device. 
When you download a file, you can access it (play it) any time you like, even when you do not have an Internet 
connection.   

Downloading, however, takes time. Video files can be quite large, and high-definition (HD) or ultra-high 
definition (UHD) movies border on tremendous, weighing in at several gigabytes. Depending on your Internet 
connection, files of this size can take hours to download. You also must have sufficient storage space on your 
device for the downloaded file.  

Streaming is the process of having a file delivered to your device in a constant and steady stream. Streaming 
is like listening to a song on the radio – you can listen to it as soon as the stream starts (no waiting), but once 
the song is over, the task is complete. The file is not copied to (and stored) on your device. That is, you cannot 
save streamed content. Streaming requires an Internet connection.  

Basic Network Technology 
Objective 1-3.11 

Home networks, school networks, business networks, and even the Internet are data networks. They transport 
data from one location (computing device) to another. This data is prepared for transport through a process 
called packetization – that is, the data is broken down into multiple pieces called packets. These individual 
packets are sent across the network, and when they arrive at their destination, they are re-assembled into 
their original form. 

TCP/IP 
The mechanism that controls the process of breaking data down into packets, sending it across the network, 
and re-assembling it when it reaches its destination is a networking protocol called Transmission Control 
Protocol/Internet Protocol or TCP/IP. 

Don’t let the word protocol intimidate you. A protocol is simply a set of rules that enable devices to 
communicate with one another in an agreed-upon manner. 

All major operating systems (Windows, Mac OS X, Linux and UNIX) use TCP/IP as their networking protocol. 
TCP/IP is the international standard protocol for both local and wide area networking, and it is the networking 
protocol used on the Internet.  

LANs and WANs 
There are two basic types of networks relevant to our discussion – local area networks (LANs) and wide area 
networks (WANs).  

Local Area Networks (LANs) 
A local area network (LAN) is a private, local set-up. Your home network, or a small office or school network 
is a LAN. LANs are private networks. LANs come in different sizes, but are generally confined to one 
geographic location. 
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Wide Area Networks (WANs)  
Wide area networks (WANs) are networks that connect computers in multiple locations using communication 
lines owned by a public carrier (such as the phone company or an Internet Service Provider). 

For example, XYZ Company might own a LAN in their Boston office and a LAN in their Philadelphia office. In 
order to connect these two LANs, XYZ Company might lease high-speed lines from the phone company. Or, 
XYZ Company might use the Internet to connect their two LANs. 

Whenever LANs are connected to one another using the lines of a public carrier, a WAN is formed. The 
Internet is the largest WAN in the world – it connects individuals and networks from around the world to one 
another using public communication lines. WANs are public networks.  

IP Addresses 
In order for the computers connected to a network to communicate with one another, each computer 
requires a unique address. This address is called an Internet Protocol (IP) address. Each computer on the local 
network (and each computer on the Internet) has an IP address that distinguishes it from all other computers 
on the network. 

A typical LAN IP address looks like this: 
 192.168.1.104 

On the Internet, each web site has its own IP address which is associated with an easy to remember text 
address called a URL. For example, the URL www.yahoo.com is associated with the IP address 98.138.252.30. 

IPv4 and IPv6 
There are two versions of Internet Protocol (IP)—version 4 (IPv4) and version 6 (IPv6). IPv4 is used 
predominantly in North America and Europe, while IPv6 is used in Asia and other countries. Because the 
number of available IPv4 addresses is rapidly running out, support for IPv6 (even in countries where IPv4 is 
currently used) is a requirement.  

IPv4 addresses are written in decimal form as a series of four decimal numbers, separated by periods. The 
LAN IP address shown previously is an IPv4 address. 

IPv6 addresses are written in hexadecimal form as a series of 8 hexadecimal numbers separated by colons. A 
typical IPv6 address looks like this:  
 805B:2D9D:DC28:0000:0000:FC57:D4C8:1FFF 

Since 2011, all major operating systems for personal computers and servers include built-in support for IPv6. 
Cellular providers use IPv6 addresses in all their 4G networks, which means that all cell phones (and other 
computing devices) with 4G capability, operate using IPv6 addressing (with optional support for IPv4). 

Finding Your IP Address 
If you are having connection difficulties and need to request help from your IT department or from your ISP, 
you may need to find your IP address. 

An easy way to find your computer’s private IP address is to use a command line tool called ipconfig. This 
tool (run within a command prompt window), displays a wealth of information about your system’s network 
settings. The following figure shows a computer that has two network connections – one is a wired (Ethernet) 
connection, and the other is a wireless (Wi-Fi) connection. 
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You can also view your IP address from the Windows Network and Sharing Center. Right-click Start, Control 
Panel, then click View network status and tasks to open the Network and Sharing Center. Your 
connection(s) display in the right side of the screen. 

 

Click a connection to open a connection status dialog box.  

 
Click the Details button to view specifics about the connection, including the IP address.  

 

  

IP address 

IP address 

Ethernet Wi-Fi 
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Exercise 3-1: Finding your IP address 
In this exercise, you will view your IP address. 

1. Click Start, and click Control Panel. Then click View network status and tasks to open the Network 
and Sharing Center. Your connection(s) will be listed in the right side of the window, under the View your 
active networks heading. 

2. Click your connection to open a connection status dialog box. 

3. Click the Details button to view your IP address. Write down your IP address. 

4. Click Close twice to close the open dialog boxes. 

5. Close the Control Panel. 

6. As a class, list your IP addresses on the board. Are they similar to one another?  

Obtaining Internet Service 
Objective 1-2.11 

Accessing the Internet from your school or office is easy because the Internet service is already running, and 
you can access it either through Ethernet or Wi-Fi. However, at some point, someone at your school or office 
had to decide which service to purchase, and then arrange to have it set up. 

If you want to add Internet service to your home, you will need to decide which type of service you want, 
how fast you need that service to be, and how much you would be willing to pay for it. 

Service Providers 
If you want to access the Internet from within your home, you must obtain Internet service from an Internet 
Service Provider (ISP). An ISP is a company that provides Internet connections to the public for a fee. Typical 
service providers include: 

• phone companies 

• cable TV companies 

• satellite TV companies 

These telecommunications companies provide an Internet connection, usually for a monthly subscription 
rate, and generally through a broadband connection. 

The term “broadband” is used to describe a fast Internet connection (technically, at speeds of 1.544 Mbps or 
higher). A broadband connection is considered a permanent network connection. That is, a broadband 
connection is always “on.” (This is in contrast to old-style dial-up connections, which require a user to 
establish a connection each time he or she wants to access the network. Dial-up connections are very slow 
and are no longer in wide use.)  
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Typical broadband technologies in wide use today include:  

• Digital Subscriber Line (DSL) – provided by the phone company. This service runs over copper 
telephone wiring and provides speeds of up to 3Mbps. You must live a certain distance from a phone 
company switch in order to use DSL, and for this reason, the service is not available in all areas. Most 
providers offer DSL service of $30-$50 USD per month, and may offer special “package” rates for 
combining with landline phone service. 

• Broadband Cable – provided by cable TV companies. This service runs over the copper coaxial cable 
that is part of the cable TV (CATAV) system. Cable provides speeds up to 30Mbps, depending on the 
provider, and monthly subscription rates hover between $30-$50 USD. Many providers offer discounts 
for subscribing to multiple services such as cable TV, Internet, and Internet-based phone services. 
Subscribers in the same neighborhood share a connection with their neighbors, and often experience a 
slowdown in service when other subscribers connect to the network. 

• Fiber Optic Service (FiOS) – provided by several telecom companies (such as Verizon FiOS, AT&T and 
CenturyLink). This technology runs over fiber optic cable. This service is also called Fiber to the Home 
(FTTH) and is just starting to become available. FiOS offers speeds of 3Mbps up to 50Mbps, and pricing 
from $30 USD to up to about $100 USD per month, depending on the provider and the package. In your 
home, the fiber optic line connects to an optical network terminal (ONT), which can split the signal to 
provide services for Internet, television and telephone. (The function of the ONT is the same as the 
function of a broadband modem.) 

• Satellite Internet – this technology is provided by satellite communications providers such as 
HughesNet and ViaSat, Inc. This technology involves three satellite dishes; one at the service provider’s 
hub, one in space, and one attached to your home. Wireless signals are sent from the ISP to outer space 
to you; or from you to outer space to the ISP. Satellite providers offer speeds from 5Mbps to 15Mbps, 
and cost from $50 USD to $100 USD per month depending on which tier of service you choose.  

– Satellite connections are useful if you live in an area where you do not have another broadband 
choice. However, satellite connections do not support VPN and satellite plans must adhere to a 
monthly data allowance. If you exceed the monthly allowance (for example, if you stream a lot of 
HD video), the provider will slow down your service.  

Blurred Lines 
At one time, there was a clear-cut distinction between service providers; you got phone service from the 
phone company, and television service from the cable company, and so on.  

Today, however, partnerships among TV, Internet and phone providers makes it possible to bundle services 
that provide one-stop-shopping. For example, you can purchase television, Internet and phone services from 
DirecTV (a satellite television provider), or from Cox Communications (a cable TV provider), or from 
CenturyLink (a phone company). 

Which Service Should You Use? 
It would be great to be able to simply purchase the fastest Internet service available. However, Internet service 
can be expensive, and sometimes you need to find a balance between what you want and what you need. 
Additionally, not all types of services may be available in your area.  
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In order to make an intelligent choice about finding a suitable Internet service package, you should 
understand a few things about broadband speeds, and about determining how much speed you actually 
need. 

Upload Speed and Download Speed 
The terms uploading and downloading refer to the process of sending information from your computer to a 
server (uploading), and the process of receiving information from a server (downloading). Most users 
download much more information than they upload. Accordingly, most service providers offer service with 
two speeds: 

• Downstream (download) – Data moves downstream as it reaches you from a web server. When your 
browser loads a web page, or when you stream a movie to your laptop, you are downloading. 
Downstream services are usually tremendously faster than upstream services. 

• Upstream (upload) – Data moves upstream when you send or upload information. When you enter a 
URL into your browser address bar or you fill in and then submit an online form, you are uploading. 

Typical Broadband Speeds 
Broadband providers advertise their top download speed with the words “up to.” This is because the top 
speed is almost never experienced by subscribers. Even though each broadband technology is defined by a 
specification that lists its top speed, that speed is theoretical, meaning, if all network conditions were perfect, 
the technology could operate at the cited top speed. 

Several factors affect network performance. The conditions of the wires in your neighborhood affect the 
speed, as does the network equipment you are using in your home. If you subscribe to a shared service, such 
as broadband cable or satellite, you will experience slower network response time when more subscribers 
access the network.  

The following table summarizes typical broadband speeds and general monthly subscription costs. 
Remember that pricing can vary widely and that you can often achieve more affordable rates if you bundle 
services. 

Technology Speeds Pricing Comments 

DSL Up to 3Mbps $30-$50USD per month Not available in all areas 

Cable Up to 30Mbps $30-$50USD per month Shared service 

FiOS 3Mbps – 50Mbps $30-$100USD per month Not widely available 

Satellite 5Mbps – 15Mbps $50-$100USD per month Data allowance enforced by provider 

How Much Speed Do You Need? 
Determining how much speed you need is really about considering what you want to do. Do you want to 
play online games? Do you want to stream audio and watch streaming HD video through Netflix and Hulu? 
Or are you more the type to send a few emails and play Solitaire and Mine Sweeper? 

If you want to stream HD movies from Netflix, for example, Netflix recommends that you use a 5Mbps 
connection for a good quality 1080-pixel stream. This amount of bandwidth is sufficient for one user; 
however, if you have multiple users streaming video to different devices, then you need more. If you want to 
stream ultra-high-definition (UHD) videos, then you need a 25Mbps connection. 
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The Federal Communications Commission (FCC) in the United States suggests that a 10Mbps – 25Mbps 
connection is reasonable for households that stream video. If you are a heavy data user, you may want to 
increase your connection to 50Mbps. 

Choosing a Provider 
When it is time to choose a provider, there are several things you can do to ensure you make a good choice: 

• Determine your service requirements. If you know how much bandwidth you really need, you know which 
services you can rule out. For example, if you don’t plan to simultaneously stream three UHD movies to 
three separate devices in your house, then you probably don’t need to pay the extra money for a FiOS 
connection. 

• Find out which services are available in your area.  
• Do some homework: 

– Look at various provider web sites to view their pricing plans, or call and talk to a representative.  
– Investigate whether bundling different types of services can save you money. 

– Most plans are on a subscription basis, but some may have contract requirements. That is, you may 
be required to maintain service for a set amount of time (such as a year or two years), and may have 
to pay a fee for breaking the contract early. 

– Watch for data caps – a data cap is a limit on monthly broadband usage. While satellite providers 
have capped usage for quite a while, some cable and DSL providers have begun imposing caps 
(some as low as 50GB per month) on their plans. If you stream a lot of video, you may exceed the 
cap, and you may be charged an overage fee. 

Testing Your Connection Speed 
Once you have subscribed to a broadband Internet service, you can check the speed of your connection at 
any time. Most providers maintain tools on their web sites that test and report connection speed. You can 
also go to a third party connection speed testing site such as speedtest.xfinity.com or testmy.net.  

 

Exercise 3-2: Testing your Internet connection 
In this exercise, you will test your connection speed.  

1. In the taskbar, click  (Microsoft Edge) to open the Microsoft Edge browser. 

2. In the Search or enter web address box, type: testmy.net and press ENTER to navigate to the Testmy.net 
Internet speed test web site.  
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3. Near the top-right of the web page, click Test My Internet+ to reveal the test options. You can test your 
download speed, your upload speed, or both. 

4. Click Combined to test both upload and download speed, then let the test run. It may take a few minutes. 

5. What is your download speed? What is your upload speed? Are they significantly different from one 
another? 

6. If time permits, click the Result Details tab and the Understanding the Results tabs. 

7. Close your browser. 

Connecting the Internet to Your LAN 
Objective 1-2.11, 1-3.11 

Regardless of the technology used to get the Internet connection to your premises, the setup inside your 
home is pretty standard: you use a modem to connect to the service provider’s network.  

Broadband Modems 
A broadband modem converts the incoming signal (from your phone line, cable line, fiber optic line, or 
satellite dish) into a digital signal that can be sent to a computer (if you do not have a home network), or to 
a broadband router (if you have set up a home network).  

The modem is the place where the private LAN connects to the public WAN. The modem is a connection 
point which has two sides or “faces.” 

 

The WAN side of the modem faces your provider’s network. The LAN side of the modem faces your private 
network, and you connect your LAN systems to the modem using Ethernet cable.  

In many implementations, a modem includes only a single Ethernet port, which allows you to connect only 
one computer system to the Internet service. 

However, in other implementations, a modem may also include wireless functionality – allowing other 
systems within your LAN to connect. Sometimes these devices are referred to as wireless gateways. These 
types of modems include built-in routing functions (and are actually modem/router combinations). You will 
learn about this type of functionality in the next section. 

Broadband Routers 
If your broadband modem provides only a single Ethernet port (and does not support wireless connections), 
and you want to share your Internet connection among multiple systems in your LAN, then you must add a 
broadband router to your network.  

Modem 
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Most broadband routers include at least four Ethernet ports for wired connections, and they have built-in 
wireless functionality, allowing additional systems to connect wirelessly. In setups where you use a broadband 
router, you would plug the router into the Ethernet port on the modem, and then connect the computer 
systems to the router. 

 
Notice that in this configuration, the router comes between the modem (which provides the link to the public 
network – the Internet) and the computer systems/devices on the private LAN. Part of a router’s function is 
to connect different networks. 

Broadband routers come in wired-only and wired/wireless versions. Wired-only routers function as a hub for 
the devices in your wired network but cannot provide services for wireless devices.  

Wireless routers, on the other hand, combine a wired network router with a wireless access point. These 
devices include four or more Ethernet ports for wired connections, and they have a built-in Wi-Fi 
transmitter/receiver, which enable them to serve as wireless access points to the network for wireless devices. 

Public and Private IP Addresses 
There are two types of IP addresses. A public IP address (also called an Internet-addressable address) is one 
that will be unique on the Internet. You must use a public IP address to participate on the Internet. 

A private IP address is one that is used within the LAN. There are three ranges of IPv4 addresses that are 
reserved for private use. The most commonly-used range is 192.168.0.0 to 192.168.255.255. 

Private addresses within a LAN must be unique – but only within the LAN itself. That means, any network can 
use these addresses. Systems within your private LAN may use the exact same addresses as those in your 
next-door neighbor’s private LAN without causing any problem because these are not the addresses that 
your network actually uses to access the Internet.  

I Have a Private Address – How do I Connect to the Internet? 
When you purchase Internet service from an ISP, you get one Internet-addressable (public) IP address 
included with the purchased service. The Internet service comes into your home through your broadband 
modem or modem/router combination.  

Remember that broadband modems/routers have two faces. One face connects to the Internet and the other 
face connects to your private LAN. The broadband modem/router also has two IP addresses: one for the 
external or wide area network (WAN) Internet connection, and one for local devices to connect to across the 
local area network (LAN). 

On the WAN side, the modem/router gets the public WAN-IP address when it connects to the ISP. (You can 
find your public IP address by visiting a Web-based IP address lookup service, such as 
WhatIsMyIPAddress.com.) 

On the LAN side, the modem/router performs several functions, including (but not limited to) the following: 

• It assigns private network addresses to the systems connected to it (usually 192.168.1.x), thus establishing 
an internal LAN. 

Router 



Lesson 3 Networks and Mobile Devices 
 

 

80  7500-1 v1.00 © CCI Learning Solutions Inc. 

• It uses a technology called network address translation (NAT) to replace the private IP address used by 
a system on the LAN with the Internet-addressable IP address that was provided with the purchase of 
Internet service. 

Private network addresses are also commonly used inside corporate LANs. A corporation may lease several 
public IP addresses that can be used on the Internet, and then translate private network addresses into public 
ones when Internet access is required. Network address translation occurs in the same way as it does on a 
home network, although a corporate LAN might use different hardware (proxy servers, firewalls, etc.).   

Viewing Your Public IP Address 
If you want to view the public IP addresses your system uses while on the Internet, there are several web sites 
that will report your IP address to you. For example, you can visit http://get-site-ip.com or you can visit 
www.myipaddress.com.  

 

Exercise 3-3: Viewing your public IP address 
In this exercise, you will view your public IP address. 

1. Open a browser and navigate to www.myipaddress.com. 

2. What is your public IP address?  

3. Compare your results with your classmates. Do you all have the same public IP address? 

4. Close your browser. 

Important Points about IP Addresses 
These are the important things to understand about IP addresses: 

• An IP address is not permanent; IP addresses are assigned to computers on the network for a specified 
period of time. In other words, an IP address is leased to a computer. If you were to move a computer 
from one network to another, its IP address would change. 

• An IP address provides information about the computer it is leased to and about the network that the 
computer is participating in. 

• A computer must have an IP address to connect to the Internet. 

• An IP address must be unique within the network. When a system is connected to the Internet, its IP 
address must be unique on the Internet. 

Wired Connections – Ethernet 
Objective 1-2.4, 1-2.9, 1-2.10, 1-2.11 

A wired connection to a LAN is called an Ethernet connection because it uses a networking cable called an 
Ethernet cable. Using a wired connection provides the fastest, and most secure connection possible within 
the LAN. 

http://www.myipaddress.com/
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Ethernet Standards and Cables 
Ethernet is a network-cabling protocol for transmitting data across a LAN. You use Ethernet cables to connect 
computers and other devices to wired connection points in your network, such as LAN ports in a wall plate, 
or on a router.  

An Ethernet connection can transmit data at one of three standard speeds: 
• Gigabit Ethernet moves data at 1Gbps 
• Fast Ethernet moves data at 100Mbps 
• 10Base-T Ethernet moves data at 10Mbps  

Except for the older 10-Mbps Ethernet standard, Ethernet networks are faster than most wireless networks, 
and they are more stable (because you do not have to worry about signal interference), and more secure 
(because the signals are not sent through the air where they can be intercepted).  

Ethernet connections are recommended for transmitting important and sensitive data. They are also ideal for 
high-volume streaming, such as streaming high-definition video from the Internet. 

Cables  
Ethernet cables are manufactured in different numbered grades or categories. Each cable grade is referred 
to by its category and number, for example, Category 5 or “Cat” 5. Ethernet cables can reliably transmit 
signals over a cable length of about 300 feet (100 meters). If you need to cover more distance, you can use 
two cables with an Ethernet switch in between them. The following cables are most commonly used: 

• Cat 5 – supports data transfer at 10Mbps, and 100Mbps 

• Cat 5e – supports data transfer at 10Mbps, 100Mbps, and 1Gbps 

• Cat 6 – supports data transfer at 10Mbps, 100Mbps, 1Gbps, and 10Gbps 

• Cat 6a – same as Cat 6 but designed for reduced signal interference 

Network Interface Card (NIC) 
In order to make an Ethernet connection between your computer and your home, school, or company wired 
LAN, your computer must include a network interface card (NIC). A NIC sends and receives data back and 
forth between your computer and the network, and it includes its own Ethernet port.  

NICs are manufactured to support various data transfer rates, such as 10Mbps, 100Mbps, and 1Gbps. The 
faster NICs are backward-compatible meaning that they can slow down to match the speed of other 
equipment on the network.  

Note: The speed of a single network connection is only as fast as its slowest link. This means that if you 
have 50Mbps Internet service, a high-speed router and Cat 5e cable, but your NIC is an ancient 10Mbps 
version, your connection speed will be 10Mbps.  

A NIC may be built into a device (as it is in most desktop computers and some laptops), or it can be added 
to a device (either internally or externally). 

• You can add an internal NIC to a desktop system by 
opening the case and inserting the NIC into a slot 
on the system board. 
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• You can add an external NIC to a computer by 
connecting one to an available USB port. 

 
Connecting to the wired network is as easy as plugging in the cable. Most devices you connect via Ethernet 
automatically detect the network connection and will perform any necessary configuration (such as obtaining 
an IP address) automatically. 

When you use a wired connection, a wired network icon  will display in the Windows 10 taskbar. 

Advantages and Disadvantages of Wired Connections 
On the plus side, wired connections are faster than wireless connections, they are secure, and they are reliable. 
Wired connections are ideal for handling a large volume of traffic. 

The main drawbacks to using wired connections are that they require cabling – and cabling can get messy 
and can get in the way. Stringing cables across the middle of the floor is never a good idea because you can 
trip over them and pull them out of their connection ports. This makes it necessary to run cables behind walls 
or under the carpet, or through the attic. These are tasks most home owners are reluctant to undertake on 
their own.  

Additionally, wired connections are not portable. For example, if you must connect your laptop to a port on 
the router in your living room, you will not be able to take your laptop to another room or out to the patio 
to work if you want to maintain your network connection. 

In short, Ethernet connections are not convenient. 

When Should You Use an Ethernet Connection? 
Although Ethernet connections are not convenient, there are times when using this type of connection makes 
sense: 
• If your computer (or other Internet-enabled device) does not include wireless capability, then the only 

way you can participate in a network is to use a wired connection. Even if the router is a wireless router, 
it will still have Ethernet ports on the back.  

• If you require the fastest speed possible, wired connections are faster. A Gigabit Ethernet connection is 
more than twice as fast as the fastest wireless connection. This makes wired connections a good choice 
for: 

– Streaming video – if you want to stream HD videos to your Internet-enabled wide screen TV, a wired 
connection will give you better performance. 

– Downloading or uploading large files, such as digital photos, or video files. 
– Playing high-performance real-time online games. 

• If you require guaranteed reliability, wired connections are not subject to the type of interference that 
wireless signals encounter. 

• If you require security for transmitting sensitive and/or private information, wired connections are secure. 
Even though you can take steps to secure a wireless network, they are inherently insecure, and financial 
institutions and large corporations usually do not allow wireless connections in their networks.  
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Exercise 3-4: Examining your network connection 
In this exercise you will locate the hardware that connects your system to the Internet, and view your data 
transfer speed. 

First, determine whether you use an Ethernet connection. 

1. If the physical location of your computer permits, try to locate your network interface card (NIC). Ask 
your teacher for assistance if necessary. Does your system use a wired connection for networking? 

2. If your connection uses a wire, where does the wire connect to the network? Is there a box with 
connection ports near your desk? Do you plug into a wall jack?  

 If your computer uses a wireless adapter and connects wirelessly, can you see the wireless broadband 
router or modem? If not, how far away do you think it might be located? 

3. If your computer uses a wired connection, look at your NIC. Does it include a light that flashes on and 
off periodically? Most NICs include an indicator light to let you know that the device is sending and 
receiving data. 

Next, examine the properties of your connection. 

4. Right-click the network icon in the Windows taskbar, then click Open Network and Sharing Center. 
Your connection(s) will be listed in the right side of the window, under the View your active networks 
heading. 

5. Click your connection to open a connection status dialog box. Your current connection speed is listed in 
the dialog box. 

6. What is the speed of your network connection? 

7. Close any open dialog boxes, then close the Control Panel. 

Adding a Shared Printer to the Wired LAN 
Within a LAN, a shared printer is one that is directly connected to one of the computers in the LAN. For 
example, if you have a printer connected via USB to your desktop PC, you can share that printer with the 
other computers on the LAN, regardless of whether those other computers connect via Ethernet or via Wi-Fi. 

Any computer on the LAN that shares a resource, such as a connected printer, or a file storage location, is 
referred to as a host.  

Sharing a printer is a simple matter of enabling printer sharing on the host computer. To activate printer 
sharing in Windows 10, navigate to the Network and Sharing Center, then click the Change advanced 
sharing settings link. 
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The advanced sharing page provides access to different network profiles on your computer. Click the arrow 
to display the options for the Private network profile. Scroll to the File and printer sharing section and select 
Turn on file and printer sharing. 

 
Click the Save changes button at the bottom of the dialog box to save the settings. 

Next, navigate to the Control Panel home page, then click View devices and printers to open the Devices 
and Printers page, which allows you to view and configure the devices connected to your computer. Right-
click the printer you want to share, then click Printer properties to open the printer Properties dialog box. 
Click the Sharing tab, then click the Share this printer check box. 

 
When you elect to share a printer, you may choose to install additional printer drivers on your system. Doing 
so makes the drivers available to other users who want to connect to your printer. Click Apply, and then click 
OK to save your settings.  

You should understand that when you share a printer, other computers connect to that printer through your 
computer. Your computer must be turned on and logged in to the network in order for anyone else to use 
the printer. 

You can clear the Share this printer check box at any time to stop sharing the printer. 
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Connecting to a Shared Printer  
To connect to a shared printer, open the Devices and Printers page of the Control Panel and click Add a 
printer. Windows will look for printers on the network. Select the printer to which you want to connect, then 
click Next. Windows connects to the printer and installs the required drivers. When a successful connection 
is made, Windows displays a success message, allows you to specify this printer as your default printer, and 
gives you the option of printing a test page. 

 
Click Finish. 

Once you have successfully connected to a shared printer, the printer will appear in the Print dialog box in 
any application that you use.  

 

Disconnecting a Shared Printer  
To disconnect a printer (that is, to remove it as an option on your PC), open the Devices and Printers page, 
click the printer you want to remove, click Remove device in the in the toolbar at the top of the page, then 
confirm that you want to remove the printer by clicking Yes. 

Wireless Connections – Wi-Fi  
Objective 1-2.5, 1-2.9, 1-2.10, 1-2.11 

Wireless networking is a form of networking wherein systems use their Wi-Fi capability to send and receive 
radio transmissions over the air instead of over wired cabling. Wireless networking occurs in two distinct 
modes: 

• Ad-hoc – systems communicate with one another directly using their Wi-Fi capability. This mode is highly 
insecure, and it does not provide access to the Internet. 
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• Infrastructure – systems connect to the network through a wireless router (or access point), and 
communicate with each other and with other systems on a wired Ethernet network through the router. 
This mode of communication can be secured, and it provides Internet access. 

Most modern broadband routers include wireless capability, which means they can be used to create wireless 
networks. These are infrastructure mode networks: all wireless devices that join the network communicate 
with the router, not directly with one another. 

Because the router is also a central connection point in the LAN, this type of network is called a Wireless LAN 
(WLAN). Devices connected to the WLAN can communicate (through the router) with one another and with 
systems that are connected to the LAN via Ethernet.  

Additionally, because the router is connected to the broadband modem, the WLAN has access to the Internet.   

Adapters, Signals and Bands 
Devices that participate on WLANs must include a wireless adapter, which is the device that transmits and 
receives the radio signals. When you power on a wireless device, it picks up signals from all the wireless 
networks within the vicinity and displays the name of each available network. 

Most handheld devices like smart phones and tablets have a wireless adapter built in. 
For computers and laptops that do not contain one, you can either install one in a slot 
on the system board, or you can connect one through a USB port.  

A USB wireless adapter looks almost like a flash drive.  

Devices on WLANs use one of two different radio frequency bands: the 2.4GHz band or the 5GHz band. The 
2.4GHZ band is also used by many other types of wireless devices (such as cordless phones and baby 
monitors), and these devices can sometimes cause interference with WLAN signals. 

Radio signals also weaken as they get farther away from the transmitter. As you move near the edge of a 
transmission range, your wireless networking connection will get slower. Objects (such as walls or floors) 
through which a signal must pass can also reduce its range. 

Wireless Standards  
Wi-Fi (short for wireless fidelity) is the consumer-friendly name we use to refer to a family of standards for 
wireless equipment and transmission technologies. These standards are part of the 802.11 wireless 
networking standard.  

There are several Wi-Fi standards, and each offers a different level of performance.  

Wi-Fi Standard Top Speed Frequency Band 

802.11a 54Mbps  5-GHz  

802.11b 11Mbps 2.4-GHz  

802.11g 54Mbps 2.4-GHz  

802.11n 450Mbps 2.4-GHz and 5-GHz  

802.11ac 1.3Gbps 5-GHz  
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Wireless equipment that is compatible with multiple Wi-Fi standards is often identified by multiple suffixes. 
For example, you might see a laptop ad that includes the spec “802.11b/g/n wireless.” This means that the 
built-in Wi-Fi adapter will work with 802.11b, 802.11g, and 802.11n.  

As is the case with advertised broadband speeds, the top speeds are theoretical maximum rates. The 
throughput rates you experience will be lower than the maximum rates. 

Wireless Security 
Because wireless networks use radio waves to send and receive information, they are susceptible to 
eavesdropping, interception, and unauthorized access. For this reason, it is highly recommended that you 
secure your wireless transmissions and use secure wireless networks whenever possible. 

Wireless transmissions are secured using the following mechanisms: 

Wired Equivalent 
Privacy (WEP) 
64-bit 

The was the first security mechanism available for wireless networks. It does not offer 
strong protection and today is considered obsolete. However, some very old wireless 
hardware will not support more advanced security schemes, and so WEP is the only 
option. 

Wi-Fi Protected 
Access (WPA) 

This was the first phase of improved wireless security and it works with many older 
wireless devices.  

Wi-Fi Protected 
Access 2 (WPA2) 

WPA2 provides the most secure wireless transmissions, but it requires modern wireless 
equipment. All new wireless networking hardware supports WPA2 (and some older 
hardware supports it as well). 

You should always use the strongest level of wireless security supported by your wireless hardware.  

Whenever you connect to a secure wireless network, you must provide a passkey (also called a pass phrase 
or a network security key). This is the wireless equivalent of a password.  

When Should You Use Wireless Connections? 
The beauty of wireless connections is that they are so convenient – there is no cable to string through a room 
or route behind a desk, and wireless connections allow you to work anywhere you like – on the sofa, in your 
bedroom, or out in the back yard (assuming the signal is strong enough). In most instances, using a wireless 
connection is a matter of choice. 

The only time you might find yourself forced to use a wireless connection is when you have a device that 
includes wireless capability, but does not include an Ethernet port, and does not include a connection port 
(such as a USB) port where you can attach an external NIC. Most tablets fit this description. 

Connecting Your Computer to a WLAN 
Your wireless adapter will scan the area for nearby wireless networks. In Windows 10, available wireless 
networks display in a pop-up window when you click the available networks icon  in the taskbar. 
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Click a network to select it, and then click the Connect button to connect to 
the network.  

 

If the network is secured, you will be 
prompted to enter the passkey 
(network security key). 

 

Type the network security key in the box, then click Next to have your system authenticate with the wireless 
router. When you have successfully connected to a wireless network, the network icon in the taskbar displays 
like this: . 

Once you connect to a WLAN, Windows keeps the settings and configures the connection to connect 
automatically whenever the network is in range. You will not be prompted to enter the passkey again, unless 
the network administrator changes the passkey, or you specifically tell Windows to forget the connection 
settings. 

To connect to a WLAN on a Mac, follow these steps: 

1. Click the Wi-Fi symbol on the toolbar at the top of the screen to display a list of available networks. 

2. Select your network from the list. 

3. When prompted, enter the passkey for your network, and click OK. 

Connecting Your Handheld Device to a WLAN 
Tablets and smart phones include a built-in wireless adapter that allows them to connect to a Wi-Fi network 
when one is in range. Connecting your device is as easy as turning Wi-Fi on, selecting the desired network in 
the list of available networks, and then entering the appropriate passkey if the network is secured. 

Public Wi-Fi hotspots are generally not secured, which means that you can connect to them without entering 
a passkey. Complimentary wireless service at a hotel often requires a passkey, which is provided to you by 
the hotel staff when you check in. 

To connect an Android device, follow these steps: 

1. Tap Apps, tap Settings, then tap Wi-Fi. The available networks should display on your screen. (Secure 
networks display a lock icon . You must enter a passkey to connect to a secure network.) 

2. Tap the network you want to connect to and enter the passkey if prompted. 

3. After you type the passkey, tap Connect. 
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Once you have been authenticated, “Connected” displays below the network name.  

To connect an iOS device, follow these steps: 

1. From your Home screen, go to Settings > Wi-Fi. 

2. Turn on Wi-Fi. Your device will automatically search for available Wi-Fi networks. Secure networks display 
a lock icon . 

3. Tap the name of the Wi-Fi network that you want to join and enter the passkey if prompted. 

4. Tap Join. 

After you join the network, you'll see a check mark next to the network and Wi-Fi connected indicator 
in the upper-left corner of the display. 

 
Smart phones and tablets remember your WLAN connections and their associated security keys. The next 
time the same WLAN is in range, your handheld device will be able to connect automatically. 

Wi-Fi Protected Setup (WPS) 
Most wireless routers include setup capability through Wi-Fi Protected Setup (WPS). WPS is a wireless 
networking standard that used to connect wireless devices to your WLAN by pressing a button on the router.  

The WPS button is usually designated by two opposite-facing arrows, such as the 
ones shown in this image.  

WPS works only on WLANs that use WPA or WPA2 for security. Both the router and 
the device must be WPS-enabled for the process to work. 

Press the WPS button on the router, and then press the WPS button on the device. They identify each other 
and make all necessary configuration settings automatically. This is especially useful for adding devices such 
as network printers to a WLAN – it is not always a straight-forward process to advance through the 
configuration screens on a printer in order to enter a WLAN passkey. WPS makes the process fast and easy. 

Adding a Network Printer to the WLAN 
Unlike a shared printer (which is directly connected to a host computer on the network), a network printer is 
connected to the router. All systems on the network can connect to the network printer through the router. 
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In order to be set up as a network printer, the printer itself must include either a wireless adapter or an 
Ethernet port (or both). Most printers sold today have wireless capability built in.  

With most newer printers, the setup is very simple: you take the new printer out of the box, turn it on and 
perform the normal first-time setup steps such as removing any internal packaging and inserting ink or toner, 
and then wait for the printer to automatically detect and connect to the WLAN. 

Some older printers may require that you first connect via USB to one of the network computers and run an 
installation utility, and enter the printer’s IP address and enter the network security password. If both your 
printer and your router support WPS, then you can press the WPS button on the router and press the WPS 
button on the printer and wait for them to establish a connection automatically. Once the printer has 
successfully joined the WLAN, you can disconnect the USB cable. 

Connecting to a Network Printer 
Once the printer has joined the wireless network, it should appear as a printing option for all computers on 
the network. 

For some older models, it may be necessary to manually install the drivers that shipped with the printer on 
each computer that will use the printer. 

Cellular Networks 
Objective 1-1.1, 1-2.10 

Cellular networks carry voice, text, and digital data through the transmitting and receiving of radio frequency 
(RF) signals. At its heart, a mobile phone is a two-way radio, and it sends and receives signals as it moves 
through a network of transmitters and receivers. Think of all the cell towers you see as you travel to and from 
work or school each day. These towers are part of the cellular network infrastructure. Cellular carriers (or 
providers) own and operate these towers and the networks they form. 

Each cellular network is divided into thousands of overlapping geographic areas 
called cells. You can think of it as a mesh of hexagonal cells (like honeycomb). 
Each cell has its own base station at the center and the cells overlap at the edges 
to ensure that users always remain within range of a base station.  

This layout makes it possible to maintain a call as you travel out of one cell and 
into another.  

The base station at the center of each cell acts as a network hub only for that cell – not for the entire network. 
Radio signals transmitted by a phone are received by the base station, where they are then re-transmitted 
from the base station to another mobile phone. The base stations are connected to one another and calls 
are automatically transferred from one base station to another as callers move between cells.  

Each base station is also connected to the landline telephone network, and can relay mobile calls to landline 
phones. Cellular networks are also connected to the Internet at various points where different large networks 
exchange traffic, enabling you to access the Internet on your smart phone through your cellular provider. 
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Cellular Generations – All About the G’s 
In almost any discussion about mobile phones, you hear “G.” G stands for generation. Mobile phone 
technology is continually evolving as more cell towers and relay stations are put into place (providing the 
required infrastructure to support newer standards and faster speeds) and as more sophisticated phones are 
developed and put into widespread use. 

Modern generation cellular networks are: 

• 3G – third generation. 3G networks transfer data at up to 2Mbps (almost as fast as DSL), which makes it 
practical to use a mobile phone to surf the Internet and use web-based applications. 3G is considered 
the minimum requirement for using a smart phone today. That is, if you want to use your smart phone 
for anything other than voice calls and text messages, you must be on a 3G network. 

• 4G – fourth generation. Things start to get a little sticky here. The 4G standard promises speeds in excess 
of 1Gbps when you are stationary and 100Mbps when you are highly mobile (such as when you are using 
your phone while traveling in a car). However, at the time of the release of the 4G specification, these 
speeds were unheard of. At the time of this writing, there are no true 4G cellular networks. 

• LTE / 4G LTE – fourth generation. LTE stands for Long Term Evolution. LTE devices were originally 
marketed as 4G technology, but they delivered nowhere near the promised 4G speeds. They are, 
however, significantly faster than 3G, and the telecommunications governing body (the International 
Telecommunication Union or ITU), determined that LTE products could be marketed as “4G.”  LTE is the 
fastest cellular technology currently available, and the average speed of today’s 4G LTE networks in the 
USA is around 24Mbps (nearly as fast as cable), which is fast enough to stream audio and video and give 
a satisfactory user experience. Note that 4G LTE coverage is available in large metropolitan areas, but 
outside the coverage area, a 4G LTE phone falls back to 3G. 

Cellular Carriers 
A cellular carrier is a cell phone company that provides cellular service to mobile phone users. In the USA, 
the four biggest cell carriers are AT&T, Sprint, T-Mobile, and Verizon. There are, of course, numerous others 
in the states, and worldwide there are over 30 large carriers who each service hundreds of thousands of 
subscribers. 

A carrier uses either the Global System for Communication (GSM) radio system or the Code Division Multiple 
Access (CDMA) radio system for its cellular network. These systems differ in technology, but offer the same 
services. 

Carrier Types 
There are different types of cell carriers: 

• GSM Carriers – these cell companies use GSM networks, and their phones identify with the carrier 
network through the use of a SIM card. This makes it easy for users to swap GSM phones and retain their 
phone number and account information. AT&T and T-Mobile are GSM carriers. 

• CDMA Carriers – these cell companies use CDMA networks, and CDMA phones use an ESN (Electronic 
Serial Number) to identify with the carrier network. If a user wants to change to another CDMA phone, 
he or she must contact the carrier and perform an ESN change. Sprint and Verizon are CDMA carriers. 
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• Pre-Paid Carriers – these are carriers that charge an up-front fee for services, and are run by either a 
CDMA or GSM carrier, or by a third party carrier who “piggybacks” services off a major carrier network. 
TracFone is a well-known pre-paid carrier. Popular pre-paid carriers in the US include Cricket, Virgin 
Mobile, and Straight Talk Wireless. 

Note that GSM and CDMA are not inter-operable. Most phones designed to work on one type of network 
cannot operate on the other. Some newer phones include circuitry that will accommodate crossover. For 
example, this could allow you to use a CDMA network in the US and also connect to a GSM network while 
you are traveling in Canada.  

Network Coverage 
One of the factors you might take into consideration when trying to decide which carrier to use is network 
coverage. Different carriers have different coverage areas, depending on how (and where) they have built 
their cell tower infrastructure.  

Coverage area is important for service. That is, you can’t get service on your cell network if there are none of 
your carrier’s cell towers in the area. Now, cell carriers make arrangements with each other so that when you 
wander outside of your carrier’s cell coverage area, you can obtain service on another carrier’s network. 
However, you will have to pay a special fee called a roaming charge whenever this happens. 

Do some research when you are selecting a carrier. Most of them show coverage maps on their web sites 
and in their advertising materials.  

How Cellular Service Differs from Internet Service 
In these days when you can make phone calls over the Internet, and surf the Internet on your phone, you 
may ask how cellular service differs from Internet service. The primary difference is a matter of mobility: 

• Internet service comes to your home (or school or office) and that is where it stays. You may connect to 
it from different areas of your house or office or campus, but the service comes to your premises at one 
location, and you must be on the premises to use it. For all intents and purposes, Internet service is 
stationary. 

• Cellular service, by its very design, travels with you and is available anywhere your provider has a cell 
network. When you wander outside of your carrier’s cell coverage area, your phone can roam and use 
services from another carrier. Cellular service is truly mobile. 

Obtaining Cell Service 
Objective 1-1.1 

When you want to purchase cell service, you are faced with a dizzying number of options. Do you want to 
sign a contract or go month-to-month? What type of service plan do you need? Will you use add-on services? 
Let’s explore some of the options. 

Contract Services 
Large cell providers usually provide coverage on a contract basis and require you to honor the contract (that 
is, to continue paying for service) for a specific length of time, usually 24 months.  
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Contracts are per line of service. That is, if you want service for two phones (one for you, and one for your 
significant other), you must purchase two lines of service and therefore sign two contracts – one for each 
line. When you open a new line of service, you often have to pay an activation fee.  

Early Termination Fee 
If you cancel a contract before the 24-month period has been reached, you are required to pay a substantial 
early termination fee.  

In one carrier’s plan, for example, if you cancel any time during the first seven months of the contract, the 
early termination fee is $350 USD. The fee is reduced by $10 per month between months 8-18, reduced by 
$20 per month between months 19-23, and reduced $60 in the final month of the contract term.  

Benefits of Contracts 
The benefit to signing a contract for service is that carriers often make the latest model phones available at 
little or no up-front cost to you when you sign up for a line of service. The cost of the phone is then rolled 
into the monthly service charge; however, carriers generally apply discounts to your contract so that you pay 
a substantially reduced price for your phone.  

Additionally, once the contract period ends for a particular line of service, you are free to upgrade to a new 
phone (again, for little or no up-front cost and at a substantial discount) as long as you renew the line of 
service contract for another 24 months. 

Contracts Vary Widely 
Carriers offer widely different contract plans. It is important to do a little homework and investigate what is 
available. Get clear answers on contract terms and conditions before you sign any paperwork. 

Pre-Paid Services 
Pre-paid carriers provide cellular service on a month-to-month basis and do not require users to sign a 
contract that obligates them to continue to pay for service for a certain number of months.  

Pre-paid plans are good for people with no credit history (or with poor credit history) because no credit check 
is required. There is usually no activation fee required either. Additionally, you may find a pre-paid plan 
attractive because: 

• There are no overage fees – you buy your minutes, and when you use them up, you cannot make any 
more calls (except for emergency services calls) or send/receive any more texts until you purchase more 
minutes. 

• Leftover minutes from one month (usually) roll over to the next month. You should check the details of 
your plan carefully to see how leftover minutes are handled. 

• If you use a cell phone only occasionally, you do not need to purchase a large quantity of minutes. You 
should, however, check to see if there is a time limit imposed on unused minutes. For example, do unused 
minutes expire after 3 months? 

Some carriers offer pre-paid plans that offer unlimited minutes. On these types of plan, you pay a set amount 
every month on a month-to-month basis instead of buying minutes as you need them.  
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Cellular Service Plans 
Because cellular service provides for voice, text and data, service plans include these three elements in their 
pricing points, depending on which plan you choose. Generally, these are referred to as: 

• Talk – refers to sending and receiving voice calls. Some plans allot a certain number of free talk minutes 
per month, and then charge a specific amount per minute for every minute that exceeds the allotted 
number of minutes. Other plans allow for an unlimited number of voice calls every month. 

• Text – refers to the sending and receiving of text messages (SMS) and picture and video messages 
(MMS). Some plans allow for a certain number of text messages per month, and charge a fee for each 
text message that exceeds the allotment. Other plans allow for unlimited text messaging every month. 

• Data – refers to information that you upload and download to and from the Internet. This includes app 
updates, notifications, GPS information, as well as email, uploading or downloading large files, streaming 
audio and streaming video. Most carriers provide several options for data plans, each allowing a certain 
amount of data (measured in GB) per month for a per-month fee. If you download more than your 
allotment, you will be charged for each additional GB of data. Some carriers also offer plans that allow 
for unlimited data usage. 

Note: If you use a basic cell phone as opposed to a smart phone, you are not required to purchase a data 
plan. However, if you use a smart phone, you must buy a data plan as part of your service package, unless 
you sign up for a “Wi-Fi Only” smart phone plan. On this type of plan, you will pay for ANY and ALL data 
that you download over the cellular network. 

You can purchase a plan for each phone, or you can purchase one of many family plans that allows all the 
lines of service on a particular account to share plan minutes, text and data. 

Most carriers offer plans for smart phones, basic phones, and data devices such as cellular-enabled tablets. 
These devices can access the cellular network (because they have their own line of service) but cannot be 
used to make phone calls. 

Plan Add-Ons 
Many carriers also offer add-on features that you can purchase for each line of service, including international 
calling plans, extra data, insurance plans that protect against theft and damage, and the ability to use your 
phone as a mobile hotspot. 

Cellular Devices 
Objective 1-1.2, 1-1.3 

Cellular devices connect to your carrier’s cellular network. Each device must be recognized by the carrier 
network (either through a SIM card or an ESN number programmed into the device). 

Devices include basic cell phones, smart phones, and cellular-enabled tablets.  
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Smart Phones 
We have already discussed smart phones to a certain extent in a previous lesson. In this lesson, the thing to 
consider about smart phones is that they are designed to keep you connected – 24/7. An average user installs 
and enables apps on a smart phone that broadcast location and GPS information, receive notifications night 
and day from email and Instagram and Facebook, look for Wi-Fi networks, look for Bluetooth devices and so 
on. They are active devices, and usually need to be recharged every night. 

We use them for doing work. We use them for communication. We use them to “carry” our insurance cards 
and coupons and address books and phone books. We use them for entertainment. We use them for social 
activities like taking pictures and video. We use them for shopping, and we use them to pay at the cash 
register.  

It can be argued that smart phones are more like computers with voice call capability than they are like 
phones with computing capability. They are complex, expensive, and, if we are not vigilant, they can consume 
enormous quantities of our time precisely because they keep us connected. They bring an endless stream of 
information to our hands and sometimes they are difficult to put down. They can make it difficult for us to 
disengage. 

Basic Cell Phone 
The basic cell phone (think of the old model flip phone) is designed primarily for making and receiving voice 
calls. The call quality is sometimes better than what you can find on a smart phone. The basic phone is also 
less expensive, more durable (they can survive quite a few falls without becoming unusable or cracking a 
screen), and a single charge can last from three days to a week. 

Additionally, they are smaller than smart phones, simple to use because you need only flip it open to answer 
it, and flip it closed to hang up., and secure because they cannot be used to store a lot of personal information 
(like banking account and credit card information) the way smart phones can. 

Although you can use a basic phone to access the Internet, the functionality is quite limited since they are 
not designed with large color displays and touch screen capability. To check your email, you can use the 
phone’s built-in email client (if it has one) or you can use a web browser and navigate to a web-based email 
site such as Gmail, Yahoo, or Hotmail.  

For people who do not wish to be connected all the time, a basic phone is a viable choice.  

Cellular-Enabled Tablets 
A cellular-enabled tablet looks and feels like a standard tablet, and it can even connect to Wi-Fi just like a 
“regular” tablet. But it has the extra capability of connecting to your carrier’s cellular network.  

A cellular-enabled tablet includes a SIM (or is programmed with an ESN) so that it can connect to the carrier 
network. To use a cellular-enabled tablet you must purchase a separate line of service for the tablet and a 
data plan. In some cases, you may be able to share a data plan between your tablet and your phone; it 
depends on your carrier. The tablet will be assigned a phone number for identification purposes (although 
you won’t be able to use it to make voice calls). 

Cellular-enabled tablets run a mobile operating system, such as Android or iOS, and can run the same apps 
they run while they are using Wi-Fi.  
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Having a tablet with cell service allows you to use the tablet for Internet-related tasks anywhere – you are no 
longer limited to areas where you can get a Wi-Fi signal. And most cell tablets have LTE capabilities, which 
makes them ideal for streaming movies and music. 

Mobile Data 
When a smart phone, cell phone, or cellular-enabled tablet access the Internet using the cell carrier’s network, 
all data that is uploaded and downloaded is referred to as mobile data. Any time you download an app, look 
at your email, surf the Internet, or check up on friends on Facebook, you are using mobile data.  

Cell carriers allow you only so much mobile data per month, as dictated by the terms of your data plan. If 
you go over your limit, you have to pay a fairly hefty price for the overage. For example, on the Verizon 
network, you must pay $15 USD for each GB of data over your allowance – and whether it is a full GB or not, 
you pay for the entire GB. If you are more than 1GB over, then you pay $30, and so on.  

Mobile data can be very expensive (even though it is the same data that you can access on Wi-Fi for no 
charge).  

Note: On some plans, if you exceed your data allowance, your carrier will slow down your connection 
speed for the remainder of the month, and you may not be able to use all of your phone’s features, like 
visual voice mail. 

Enabling Wi-Fi on your Mobile Device 
Smart phones and tablets have built-in Wi-Fi capability, and on many smart phones, Wi-Fi is turned on by 
default. This is convenient because Wi-Fi is faster than 3G data connections. When you perform Internet-
related tasks over Wi-Fi, the uploading and downloading of files takes place through the WLAN instead of 
through mobile data. That is, tasks performed over Wi-Fi do not impact your data plan allowances. 

Using Wi-Fi whenever possible makes a lot of sense, especially if you consume a lot of online media. Viewing 
photos on web pages and streaming music and video will quickly eat up your available data. If you use your 
phone or tablet to watch a lot of streaming movies or television shows, it is much more cost-effective to use 
Wi-Fi. 

If there is no available Wi-Fi, then the phone switches to the cellular data network. 

To enable Wi-Fi on your Android device: 
1. Tap Apps, then tap Settings, then tap Wi-Fi. 
2. Tap the button at the top of the screen to toggle Wi-Fi on. 

3. Select and connect to a WLAN. 

To enable Wi-Fi on your iOS device: 
1. Tap Settings, then tap Wi-Fi. 
2. Tap the button at the top of the screen to toggle Wi-Fi on. 
3. Select and connect to a WLAN. 



Networks and Mobile Devices Lesson 3 
 

 

7500-1 v1.00 © CCI Learning Solutions Inc.  97 

Turning Off Mobile Data 
Additionally, smart phones and cellular-enabled tablets measure your data 
usage and include mobile data settings. This figure shows the Data usage screen 
on an Android phone. Notice that you can enable or disable settings to limit 
mobile data usage and to generate alerts concerning mobile data usage. 

You can temporarily turn off mobile data to prevent apps from using the cellular 
network to send or receive data. Turning off mobile data forces data services like 
email, web browsing and push notifications to use Wi-Fi.  

You can also scroll down the page and view the amount of data used by each 
app. 

To turn off mobile data on your Android device: 

1. Tap Apps, tap Settings, then tap Data usage. 

2. Tap the Mobile data button to turn mobile data off. 

3. Confirm that you want to turn off mobile data by tapping OK. 

To turn off mobile data on your iOS device: 

1. Tap Settings, then tap Cellular. 

2. Tap the Cellular Data button to turn mobile data off. 

  

Exercise 3-5: Viewing your mobile data usage 
In this optional exercise, you will view your mobile data usage on your smart phone or tablet. Note that you 
can perform the steps of this exercise only if you have a smart phone or cellular-enabled tablet. 

1. On your mobile device, open the Settings menu and then view your mobile data usage. Do you use more 
or less mobile data than you expected? 

2. If possible, view the amount of data used by each app. Which ones use the most data? Which use the 
least? 

3. What are some ways you can limit or control your mobile data consumption? 

Hard-Wired Phones 
Objective 1-1.4 

A hard-wired phone (or “landline” phone) is connected to a telephone jack in the wall using a standard 
telephone line (copper wiring). The telephone jack is connected to a local telephone switch, which is 
connected to the rest of the telephone network. The phone may be fixed or cordless. (A cordless phone is 
different than a mobile phone – a cordless phone handset sends and receives wireless signals from the 
cordless phone base station, but the base station itself is connected by a wire to a telephone jack.) 
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For a set monthly service fee, you can call anyone in your calling area without additional charge. Calls outside 
your local calling area are considered long-distance and usually incur an extra charge based on the duration 
of the call.  

Advantages and Disadvantages  
Landline phones require voltage for ringing and dialing, and this power is delivered from the telephone 
network through the phone line itself. For this reason, you can use a landline phone to place a call even 
during a power outage. VoIP phones, which use the Internet, are dependent upon routers and modems 
(which all require AC power). You cannot use a VoIP phone during a power outage. 

Another advantage of landline service is that the service is extremely reliable and provides excellent sound 
quality. In fact, landlines are so reliable, residential and business alarm systems are tied in to a landline and 
place a call to the alarm company and/or to emergency services when a break-in is detected. 

An obvious limitation of a landline phone is that the service is not portable. The phone must be connected 
to the telephone jack.  

Private Branch Exchange (PBX) 
To save money on leasing public telephone lines for each employee, many businesses lease a few lines from 
the phone company for making out-going calls, and use a private branch exchange (PBX) to manage internal 
calls among their telephones. A PBX is a private telephone switch; it allows businesses to create their own 
internal telephone-numbering scheme and to keep all internal calls separate from the telephone network. 

Businesses can also save money on phone lines using an IP version of a PBX; this is called an IP PBX and 
performs the same functions as a PBX, except that it is designed to work with IP phones. 

If your business, school, or organization uses a PBX, then you (may): 

• Use short code dialing (that is, you dial only the extension) to reach anyone within your office or campus 

• Dial an access code (such 9 or 0) to access an outside line to make a call outside your office or campus 

Business Telephones 
Because businesses typically use more advanced phone features than home users, business phones have a 
different design and appearance from residential phones.  

The buttons and specific key press sequences for performing certain tasks differ from one make and model 
to another, but for the most part you can perform the following functions by taking the described actions: 

• Put a call on hold – press the Hold button. When you are ready to resume the call, press the Hold button 
again. 

• Transfer a call – On most business phones you can transfer a call by selecting the line you want to 
transfer, pressing the Transfer button (this puts the caller on hold), waiting for a dial tone and then dialing 
an internal extension. You would then wait for the party to answer, then press Transfer again, and then 
hang up.) 

On phones that do not include a Transfer button, you press the Flash button, wait for a recall dial tone 
(3 beeps and then a dial tone), dial the number to which you want to transfer the call, wait for the party 
to answer, and then hang up. If the person you are trying to reach does not answer, you can press the 
Flash button again to return to the caller. 
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• Create a conference call – a conference call involves at least three parties. While you are on an active 
call, press the Conference button, dial the number of a party you want to add to the call, then press 
Conference again so that all three of you can converse on the call. 

Voice Mail 
Objective 1-1.4 

A voicemail system is a centralized system used in businesses for sending, storing, and retrieving audio 
messages. Residential and cell phone service plans also often include voice mail capabilities. 

In a business phone system, each extension is usually linked to a voice mailbox. When a party calls a number 
and the line is not answered or is busy, the call is sent over to the voice mailbox. The caller will hear a greeting 
message previously recorded by the user. This message can give instructions to the caller to leave a voice 
message, or may provide other options, such as paging the user or being transferred to another extension 
or to a receptionist. 

Voice mail systems also provide notifications to the user to alert them when they have received new voice 
mail messages. Most systems provide multiple ways for users to check their voice mail, including accessing 
the voice mailbox through a PC, or from a landline phone or even a mobile phone. 

Configuring Your Voice Mail 
Voice mail systems guide you through a menu of options and choices. Listen to the voice prompts and follow 
the instructions. At various points you will be asked to record information, after which you are usually given 
the options to keep your recording, or to discard and record again. You indicate your choice by pressing a 
specific key on the dial pad, for example, you might be instructed to press 1 to keep your recording, or 2 to 
discard it and record again. 

The first time you configure your voice mail, you may be prompted to state your name slowly and clearly, 
and to create and confirm a PIN code that you will use later to access your messages, and configure your 
greeting messages. 

Follow the voice prompts to record a general greeting, and any supplemental greetings, such as an out of 
office message. The voice mail configuration program will guide you through setting up greeting messages 
and turning specific ones on or off. 

A suitable business voice mail greeting should include the following information: 

• Your name, department, and company name 

• A brief apology that you cannot take a call right now 

• An invitation to leave a message 

• An indication of when the caller can expect a return call 

• Any additional options that might be available to a customer, such as your web site address or the name 
and number of an associate within your company. 

Retrieving Your Messages 
Most phones show a notification when you have new, unheard voice mail messages. On some phones, a red 
light illuminates, on others a voice mail message icon displays. 
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You may need to dial a specific number, or press a button to call the voice mail system. You may then be 
required to enter a PIN to access your messages. 

Follow the voice prompts to play your messages. After you have listened to a message you are usually given 
the option to erase the message or save it in the message archive. You can retrieve and replay archived 
messages at any time.  

Voice Mail on Your Mobile Phone 
Cellular plans also include voice mail. The voice mail phone number is usually included in the default list of 
contacts. You can access your voice mail through the Contacts list or by dialing the number directly. (Often, 
this is a shortcut number, such as *86.) 

As with business phone systems, the voice mail system on a mobile phone uses voice prompts to guide you 
through the menu options. The first time you call the voice mail system, you will be prompted to create and 
confirm a numeric password, and to record a greeting. 

If a caller cannot reach you on your mobile phone, he or she is sent to your voice mailbox. However, if you 
have not set up your voice mailbox, the caller will be informed that the mailbox has not been set up, and the 
caller will be unable to leave you a voice mail message. 

Many cellular providers offer a form of visual voice mail, which lets you see and manipulate your voice mail 
messages on the screen. However, there is often a monthly fee associated with using visual voice mail. 

Personal or Business 
Obviously, a voice mail greeting for a personal phone number can be less formal than one that you use for 
a business number. However, if you use your mobile phone for both business and personal calls, you should 
ensure that your greeting is suitable for both types of callers.  

Retrieving Messages 
Your mobile phone will display an icon when you have new, unheard voice messages waiting for you. You 
must call the voice mail system and log in (enter your password) to access your mailbox. You can play your 
unheard messages, discard them, or archive them. You can also record greetings, and configure pager 
settings from within the voice mail system. 

Mailbox Full 
If you receive a high quantity of voice mail messages and do not clear out your voice mailbox, the mailbox 
will become full and callers will not be able to leave new messages. The mailbox will remain full until you 
listen to and clear out the existing messages. 

Leaving a Clear Voice Mail Message 
Many people freeze up when prompted to leave a voice mail message (especially when making a business 
call), and hang up the phone instead! A little preparation can help alleviate this issue. 

Before you place your call, prepare in advance a sentence or two that summarizes the nature and purpose of 
your call. A clear and understandable voice mail message is much more likely to get a response than one 
that rambles on and on.  
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Additionally, plan to include the following items in your voice mail message: 

• Identify yourself by first and last name, and if appropriate, state the name of your company. 

• State the number (or numbers) at which you can be reached, and if appropriate, during which time 
frames. You might also provide your email address if you are willing to accept a response via email. 

• Mention the date and time you are calling. 

• Briefly describe the nature and purpose of your call. 

• Ask the person to call you back at their earliest convenience (or in whatever time frame is required). 

• Repeat the number at which you can be reached. 

• Thank them for their time. 

It is not difficult to leave a clear, concise message, and it is usually greatly appreciated. 

Lesson Summary 
In this lesson, you examined different types of networks, explored subscription and contract costs, examined 
connection technologies and hardware. You also learned how to configure and use voice mail and how to manage 
mobile data usage. You should now be familiar with: 

 the benefits of networking 

 basic data network concepts 

 how to obtain Internet service 

 broadband technologies and speeds 

 LAN hardware and addressing 

 Ethernet connections 

 Wi-Fi connections and wireless security 

 basic cellular network concepts 

 how to obtain cellular service 

 how smart phones and tablets connect to the Internet 

 basic telephone network concepts 

 how to configure and use voice mail 

Review Questions 
1. Which protocol is required to access the Internet? 

a. 802.11a c. 802.11ac 
b. TCP/IP d. TKIP 

2. Which of the following is an example of a private network? 

a. The Internet. 
b. The telephone network. 
c. Your carrier’s cell network. 
d. Your company’s LAN. 

3. Which of the following broadband technologies is the fastest? 

a. DSL  c. Broadband cable 
b. Satellite d. 3G cellular 
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4. Ann’s cable modem has only one Ethernet port and does not support wireless connections. What must 
she add to her network in order to share her Internet connection with her laptop, tablet and smart 
phone? 

a. A wireless broadband router. c. An optical network terminal. 
b. A network printer. d. A satellite dish. 

5. How fast is Fast Ethernet? 

a. 10 Mbps c. 1,000 Mbps 
b. 100 Mbps d. 10,000 Mbps 

6. Which two frequency bands are used by wireless LANs? 

a. The 88MHz band and the 206MHz band. 
b. The 800MHz band and the 1.2GHz band. 
c. The 2.4GHz band and the 5GHz band. 
d. The 54MHz band and the 300GHz band. 

7. Which Wi-Fi standard is the fastest? 

a. 802.11a c. 802.11g 
b. 802.11ac d. 802.11n 

8. Which wireless standard simplifies the process of adding a device to a WLAN? 

a. WPA c. WEP 
b. WPA2 d. WPS 

9. Which cellular network is fastest? 

a. 1G  c. 3G 
b. 2G  d. LTE 

10. Sue made a big bowl of popcorn and is planning to stream four hours of Disney movies to her cell-
enabled tablet. Why has she opted to use Wi-Fi for her movie night? 

a. Wi-Fi gives a clearer picture. 
b. Using Wi-Fi won’t impact her data plan. 
c. Wi-Fi provides for true surround-sound. 
d. No special reason; Sue is just being whimsical. 
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Computing Fundamentals 
 
 

Lesson 4: File Management  
Lesson Objectives 
In this lesson, you will learn to use Windows File Explorer to find, move, open, and manage files. You will work 
with windows, learn about default locations, learn about file types and file permissions. Upon completion of this 
lesson, you should be able to: 

 navigate a directory and follow paths 

 understand rights and permissions 

 use File Explorer 

 work with windows 

 recognize different types of files 

 work with files and folders 

 find files 

 work with the Recycle Bin 

 describe default file locations 

 share pictures on a smart phone 

 manage electronic media 

 share files with other users 

 zip and unzip files 

Understanding Folders and Directory 
Structure 
Objective 1-3.6 

Computers are designed to store and manage information. In order to do that successfully, they must provide 
a logical storage methodology and an interface that allows a user to see and work with the stored data. 

All computer storage devices are arranged into a logical, hierarchical structure that makes it possible to store 
and retrieve data. It does not matter if you are working with a hard disk inside your PC, a flash drive connected 
to a USB port on your laptop, an SD card inserted into a card reader slot, or a storage location on a server 
somewhere in cyberspace – all storage locations can be traced through a logical, hierarchical path.  

Drive Letters 
On a personal computer, each storage device (or location) is referred to by a drive letter. This applies to 
internal storage devices, mapped network folders, and externally connected storage devices as well.  

The hard drive in a PC is drive C. This is where the operating system and application programs are installed.  
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Note: In the early days of personal computing, the letters A and B were reserved 
for disk drives that accommodated removable storage media called floppy disks. 
Hard drives did not become available until sometime later, and when they did, 
the letter C became the standard drive letter for hard disk drives. 

When you write a designation for a drive letter, you follow the letter with a colon (:). For example, you would 
write C: to refer to drive C.  

Additional Internal Storage Devices 
Computers can accommodate multiple internal storage devices, and each is assigned a drive letter when it is 
installed. Usually, the next available alphabet letter is used. Consider the following examples: 

• if your PC has two hard drives: the primary hard drive is drive C and the secondary hard drive is drive D. 

• if your PC has one hard drive and an internal DVD drive, the hard drive is drive C and the DVD drive is 
drive D. 

• if your PC has two hard drives and a DVD drive, the primary hard drive is drive C, the secondary hard 
drive is drive D, and the DVD drive is drive E. 

The drive designation of an internal storage device does not change unless you manually change it.  

Mapped Network Locations 
If you have access to shared network locations, you can create 
shortcuts to these locations by “mapping” a particular location and 
assigning it a drive letter. The process of drive mapping is simply a 
matter of tracing the path to a particular network location and telling 
the operating system that you want to refer to this location using a 
particular drive letter. The process is manual, and you can select 
whichever available letter you want to use.  

The following figure shows a graphical representation of a PC with one 
internal hard drive (C:), and two mapped network locations (H: and L:).  

Connected Storage Devices 
When you connect an external storage device to your PC (for example, through a USB port or an SD card 
slot), the operating system automatically assigns the next available drive letter to that device. The following 
figure shows a PC with one hard drive, two mapped network drives, and two connected flash drives (D: and 
F:) and an inserted SD card (E:).  

 
Because external storage devices are constantly connected and then disconnected, drive designations for 
these devices are assigned each time a device is connected. A particular flash drive may be drive E on Monday, 
and drive G on Wednesday, depending on whether other external devices are connected on Wednesday 
before the flash drive is connected.  
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Folders and Subfolders 
You can store files in the root folder of a drive; however, it is more efficient to store files in folders. A folder 
is a container for files and provides a method for organizing information; it’s something like a hanging folder 
in a file cabinet within which you can organize other folders and files. A subfolder is simply a folder contained 
within another folder, and the terms folder and subfolder are often used interchangeably.  

A folder that you create is represented by a yellow icon that looks like a file folder . You can create folders 
using Windows or an application program.  

Additionally, Windows provides a feature called libraries to help you access files quickly. A library is a 
collection of items, such as files and folders, assembled from various locations and presented in one central 
location.  A library looks and acts like a folder, and they are often referred to as folders. For example, the 
Documents library is often called the “Documents folder.” The libraries in Windows 10 are: Camera Roll, 
Documents, Music, Pictures, Saved Pictures, and Videos.   

Directories and Paths 
The organization of files and folders on a disk is called a directory or a directory tree. The highest level of any 
directory on a disk is the root folder, or root directory. The root directory is always represented by the drive 
letter and a colon, followed by a backslash (\). For example, the root directory of the hard drive is represented 
as C:\. 

Every file on a computer is stored in a particular location on a disk, and that location is described by its path. 
A path indicates the exact route to follow to get to the location of a file. When you write a path, you separate 
each folder level with a backslash. 

Consider the directory structure shown at the right:  

• The structure shows the Documents library with two folders: one called 7500 
Student Files, and another called Annual Reports.  

• The Annual Reports folder contains two subfolders; one called 2015 and one 
called 2016.  

• Stored within the 2016 folder are four files named: Balance Sheet, Budget 
2016, ComputerSales, and Meeting Minutes 4-26-16.  

If you were to verbally describe how to find the Balance Sheet file, you could say, "Go to Documents, then 
Annual Reports, then the Balance Sheet document is inside the 2016 folder."    

If you were to write your description of how to find the file in "path notation", it would appear as follows: 
Documents\Annual Reports\2016\Balance Sheet. 

Connecting “Smart” Devices 
Objective 1-3.6 

When you connect a smart device to a PC, the device appears as a location/folder. A smart device is one that 
includes its own operating system. Smart phones, tablets, and eReaders are examples of smart devices. You 
can connect a smart device to your PC using a USB cable, usually for the purpose of copying or moving files 
from the device to your computer. 
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Once the device is connected, you can navigate its internal storage system just as you can a folder within 
your PC. The following figure shows part of the internal storage system of an Android tablet (identified as 
QMV7B) connected to a PC. 

 

File and Folder Permissions  
Objective 1-3.6, 1-3.10 

File permissions are rules that determine whether you can access a file and what you can do with it. Let’s 
begin our discussion by defining two basic file permissions: 

Read You can view the names of files and folders on the network, view the contents of files, and execute 
application program files. 

Write You can view the names and contents of files and folders, and can create new files and folders, 
modify the contents of files, and delete files and folders. 

As a standard user, you can create, edit, view or print files for your 
own user account. You cannot, however, work with files and 
folders created by another user on the system. In fact, you will 
not be able to access folders stored under another user’s profile 
– if you try to navigate to another user’s folder, the operating 
system denies you access. 

Only a user with an Administrator account can work with files stored under another user’s profile. 

Additionally, the operating system may restrict you from saving or altering files in certain locations. For 
example, if you want to paste a file into the root directory of the hard drive, administrator level privileges are 
required. 

Network Access 
If you work on a network, for example at your school or within your organization, there may be areas of the 
network that you cannot access. The network administrator controls which users can access specific network 
resources, such as printers, or servers, or files stored in network folders. One of the primary job roles of a 
network administrator to protect an organization’s assets. This is generally accomplished by providing the 
least amount of access privileges required for users to perform their daily tasks.  
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For example, a user in data entry who spends all day entering customer orders into the company database 
does not require access to the company web server, except perhaps to request web pages on the company 
intranet. The web server administrator on the other hand, requires access to the web server, but does not 
require access to confidential documents handled by the Human Resources department. 

By restricting access to resources or folders that contain sensitive information, network administrators keep 
the organization’s data secure. 

If you need to access files stored in a specific network location, the network administrator will set specific 
permissions for those files that control what you can do with them. For example, you might have access to a 
document in a network folder, but even though you can read the document, you might not have permissions 
to make changes to it. 

Additionally, you may be able to view the contents of some network folders, but not be able to create or save 
files to those folders. There might also be some folders that you cannot access at all. 

If you need to work in a specific file or folder stored in a network location, but do not currently have sufficient 
permissions, you should contact the network administrator so that he or she can adjust your rights 
accordingly. 

Understanding Local and Remote Locations 
In terms of computing, a local location is a drive or folder on a storage location within the computer or 
immediately attached to the computer (for example, a folder on a connected flash drive or an SD card).  

A remote location is one that you access over a network (either wired or wireless). Computers you connect to 
over the Internet, storage locations in the cloud, and shared network folders on your organization’s LAN or 
on another computer in your private LAN or Windows Homegroup are all examples of remote locations. 

Using File Explorer 
Objective 1-3.3 

The graphical representations of locations, directories and files that you have seen so far in this lesson are 
part of the interface of File Explorer. File Explorer is the file management interface of Microsoft Windows. It 
provides a GUI for accessing and working with files. 

Like any other task you perform on your PC, every interaction you have with File Explorer takes place inside 
one or more windows. You use different types of windows depending on what you are doing, but all windows 
share similar features.  

To open File Explorer:  

• click the File Explorer icon  in the taskbar; or  

• click Start, then click File Explorer; or  

• double-click a folder on the Desktop; or 

• press WINDOWS+E. 
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The following figure shows a typical File Explorer window. 

 

Control Menu Click to display options to restore, move, size, minimize, maximize, or close the window. 

Quick Access 
Toolbar 

Contains buttons for frequently used commands. By default, it displays the Properties, 
New Folder, and Customize Quick Access Toolbar buttons. However, you can add the 
Undo, Redo, Delete, and Rename commands to the toolbar. You can also specify to show 
the toolbar below the ribbon. 

Title Bar In File Explorer, the title bar displays the name of the currently selected folder. In an 
application window, the title bar displays the name of the application and the name of 
the active file. 

Control Buttons Change the way currently open windows are displayed, as follows: 

•  (Minimize) Temporarily closes the window, replacing it as a button on the 
taskbar. Click the button on the taskbar to open or restore the window. 

•  (Maximize) Displays the window full screen. 

•  (Restore Down) Restores the window to the size it was before it was maximized. 

•  (Close) Closes the window.  

File Menu Displays options for working in the current folder. For example, you can open another 
window that shows the contents of the current folder, or you can open a command 
prompt window or a Power Shell Tools window. You can also open a dialog box that 
allows you to configure options for the current folder. 

  

Control 
Menu 

Quick Access 
Toolbar 

Title Bar 

Control Buttons 
Address Bar 

Contents Pane 

Navigation Pane 

Split Bar 

Status Bar 

Ribbon Tabs 

Expand/Minimize 
Ribbon 

Help 

View 
Buttons 

Navigation 
Buttons 

Search Box Previous Locations 

Refresh 
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Ribbon Tabs File Explorer windows include ribbons for working with files. When you click on a tab, the 
ribbon expands to display the available commands. When you click a command on the 
ribbon, the ribbon minimizes again. The File Explorer ribbon tabs are: 
• The Home tab includes commands for copying, moving, and renaming files.  
• The Share tab includes commands for emailing, printing, sharing, or compressing files.  
• The View tab includes commands for changing the display of the contents in the 

current folder.  
Some ribbons are contextual and, when appropriate, display on a Manage tab. For 
example, if you are working in a folder that contains image files, the Manage tab appears 
and displays a Picture Tools ribbon which includes commands for rotating images, setting 
an image as a background, or displaying images in a slide show.  

Expand or 
Minimize the 
Ribbon 

Click  (Expand the Ribbon) to expand the ribbon and keep it expanded, even after you 

click a command. When the ribbon is expanded, this button changes to  (Minimize the 
Ribbon), which you can click to minimize the ribbon at any time.  

Help Click  to open the browser to a page of Help topics related to using Windows 10 File 
Explorer. 

Navigation 
Buttons 

Use  (Back) or  (Forward) to navigate back and forth among previous views of files 
and folders. 

Click  (Recent Locations) to display a list of locations recently visited in File Explorer. 
Click a location in the list to jump to it. 

Click  (Up One Level) to move up one level in the path. 

Address Bar Indicates the current location and facilitates quick and easy navigation. This feature allows 
you to click the name of any folder visible in the path so that you can go to that folder, or 
click the arrow that appears next to any item and see other items at the same level in the 
folder hierarchy. The Address Bar is also known as the Breadcrumb Bar. 

Previous 
Locations 

Click  at the right end of the path to open a drop-down list of previously visited 
locations. Click a location in the list to jump to it. 

Refresh Click  to refresh the display in the Contents pane. 

Search Box Use this box to search for a file for folder within the current folder (and its subfolders).  

Navigation Pane Displays drives and folders in a tree view. Click a drive or folder in the Navigation pane to 
view its contents in the Contents pane. The contents of the Navigation pane are 
commonly called the Folder list. 

Contents Pane Displays the contents of the drive or folder currently selected in the Navigation pane. 
Double-click a file or folder in the Contents pane to open it. 

Split Bar The split bar separates the Navigation pane from the Contents pane. Click and drag the 
split bar to show more or less of the Navigation pane. 

Status Bar Displays properties or details about the item(s) currently selected in the Contents pane. 

View Buttons Affects the display in the Contents pane. Click  to view details about each file or folder; 
or click  to view thumbnails of each file or folder. 
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Exercise 4-1: Viewing File Explorer windows 
In this exercise, you will practice working with File Explorer windows. 

1. In the Window taskbar, click the File Explorer icon.  

2. Click the Maximize button at the top right corner of the window. 

3. Click the Minimize button. The File Explorer window disappears from the screen. Notice that the File 
Explorer icon now displays with a line beneath it, indicating that it is a button. You can access the File 
Explorer window from its taskbar button. 

4. Click the File Explorer button on the taskbar to redisplay the maximized File Explorer window. 

5. Click the Restore Down button at the top right corner of the window to reduce its size. 

6. In the Navigation pane, under the Quick Access heading, click Desktop to view the contents of the 
Desktop in the Contents pane. (It is okay if only the 7500 Student Files folder displays in the File Explorer 
window.) 

7. At the bottom right corner of the Contents pane, click each of the two view buttons to compare the 
views. Ensure that thumbnails are displayed before proceeding to the next step. 

8. Click the View tab to display the ribbon, then in the Layout group, click List. Now the names of the files 
and folders display in a list. Notice that the ribbon minimized as soon as you clicked a command. 

9. Click the Close button to close the File Explorer window. The window is removed from the screen, and 
the File Explorer button in the taskbar becomes an icon (without an underline) once again.  

Moving a Window  
You can move a window anywhere on the desktop using the mouse or keyboard. 

• Position the mouse pointer anywhere on the title bar and then drag the window to a new location.  

• With the keyboard, press ALT+SPACEBAR to open the control menu. Press the 
DOWN ARROW key to select the Move command and press ENTER to put the 
window into move mode. Using the arrow direction keys, move the window to 
the new location and then press ENTER again to exit move mode.  

Maximized windows cannot be moved because they occupy the entire screen. You 
can only move a restored (that is, not maximized) window. 

Sizing a Window  
On occasion you may want to change the size of the window so that you can see more or less of the 
information inside it, or so that you can view that information in multiple windows. You can use the mouse 
or the keyboard to size a window. 

• Position the mouse pointer anywhere on the border (side) to be sized. When you see the mouse cursor 
change to a  (vertical double-headed arrow) for the top or bottom border, or  (horizontal double-
headed arrow) for the left or right border, drag the mouse to the desired size.  
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• To size the vertical and horizontal sides at the same time, position the mouse cursor on any corner of 
the window, and then drag to the desired size for the window when you see  or  (diagonal double-
headed arrow). Some windows are set to a specific size and cannot be altered.  

• With the keyboard, press ALT+SPACEBAR to activate the control menu. Press the DOWN ARROW key to 
select the Size command and press ENTER. Using the appropriate arrow direction key for the side you 
want to size, press that direction key until the window is the size you want, and then press ENTER to exit 
resize mode. You will need to repeat this action for every side to be sized. 

Using Scroll Bars 
If a window is too small to display all its contents, scroll bars will automatically appear vertically on the right 
side of a window, and/or horizontally at the bottom. 

A scroll bar consists of three parts: an arrow button at each end of the scroll bar, 
a scroll box, and the scroll area. The scroll box is also called a thumb or an 
elevator. The position of the scroll box within the scroll area provides an 
approximate gauge of where the information currently displayed in the window 
is in relation to the entire window’s contents. 

Use one of the following methods to move around with the scroll bars: 

• Click in the lighter shaded area above or below the scroll box to display the previous or subsequent 
screen of information.  

• Click the arrow at either end of the vertical scroll bar once to display a line of information in that direction.  

• Click the arrow at either end of the horizontal scroll bar once to display a column of information in that 
direction.  

• Click and hold down the mouse button on the arrow at either end of the scroll bar to have the screen 
scroll in that direction.  

• Drag the scroll box to a specific area in the scroll area to move directly to that location. Depending on 
the program, you may also see a tip showing where the cursor will be placed when you release the mouse 
button. 

Exercise 4-2: Moving and sizing windows 
In this exercise, you will move a window around the screen and resize it. 

1. Click the File Explorer icon in the taskbar. 

2. If the window appears full screen, click the Restore Down button. 

3. Position the mouse pointer in the title bar of the window, then click and drag the window to a new 
position on the desktop. 

4. Practice moving the window around to several different locations. 

5. Move the mouse pointer to the right edge of the window and hold the mouse over the border until the 
pointer changes to a horizontal double-headed arrow. 

6. Drag the border to approximately one inch (2.5 cm) from the right side of the screen. 

7. Move the mouse pointer to the lower right corner of the window and drag the corner of the window 
until the window is approximately half the current size. 

Scroll Box 
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8. Resize the window to approximately the size it was originally. 

9. Click Close to close the File Explorer window. 

Working with Files and Folders 
Objective 1-2.9, 1-3.6, 1-3.8, 1-3.9 

A file is created using a specific program; the type of program determines what type of file it is. 

Application File This type of file includes very detailed instructions for the microprocessor on what tasks 
to perform (such as read, write, calculate) and is usually stored in a folder named for that 
program, which in turn resides in the Program Files folder on your hard drive. 

Data File This type of file contains information you have entered and saved in one of the 
applications you have on your computer. For example, you might have created a budget 
file in Excel, a letter file in Word, a database in Access, and so on. These files can be stored 
anywhere. 

System File This type of file also contains detailed instructions for the microprocessor on what tasks 
to perform, except that they are part of the operating system. Many of these files are 
hidden to protect them from being changed or deleted. 

Regardless of the file type, all files appear with an icon that includes a symbol 
of the associated program. Shown are examples of icons that appear beside an 
application file (Excel), a data file (Excel workbook), and a system file (Windows). 

Files or folders can be saved and displayed anywhere in Windows, including on the Desktop for quick access. 
Consider the following when viewing files or folders: 

  

An icon similar to one of these indicates that a data file or folder is saved in this location. 
If a file is a data file, the miniature icon in the upper left corner represents the program 
needed to view or modify the document. The text below the icon is the file or folder name. 
If you delete a file or folder icon, you will delete the actual file or folder. 

  

A similar icon with a small arrow at the lower left corner represents a shortcut to the 
location where this data file or folder is saved. The arrow indicates that the icon is a 
shortcut only. If you delete a shortcut icon from the desktop, only the shortcut is deleted 
not the actual file. 

 

An icon with a program symbol on it indicates that it is a shortcut to an application 
program file. If you delete the icon, you are deleting only the shortcut, not the actual file 
that starts the program. 

Creating Folders 
You can create folders at any level, including directly on the Windows Desktop. To create a folder, use one 
of the following methods: 

• In a File Explorer window, click  in the Quick Access toolbar, or 

• right-click the location (drive or folder) for the new folder in the Folders list, click New, and then click 
Folder, or 

• right-click a blank area of the Contents pane, click New, and then click Folder. 



File Management Lesson 4 
 

 

7500-1 v1.00 © CCI Learning Solutions Inc.  113 

Windows creates the new folder and waits for you to give it a name. Type a name for the 
folder and press ENTER.  

Navigate to the location for the new folder before executing the New Folder command. The Address bar 
displays the path or current location as a reminder. 

 

Windows does not restrict where you create folders, or whether another folder shares the same name in 
another location. It is recommended, however, that you keep folder names unique to prevent accidental 
deletion or replacement of files and folders. You can rename or move any file or folder to another location, 
as appropriate. 

Renaming a Folder 
The name of a folder can be as long or short as required (up to 255 characters), although with longer names, 
the entire name may not be visible in certain views. 

To change a folder’s name, use one of the following methods: 

• Click the folder icon to select it and then press F2 to activate the Edit mode, or  

• click the folder icon, then click inside the folder name to activate the Edit mode, or 

• right-click the folder and then click Rename from the shortcut menu, or 

• click the folder icon to select it and then on the Home tab, in the Organize group click Rename. 

Whenever you see the folder name highlighted as shown here, you are in Edit mode. Once 
the name is highlighted, you can type in a new name for the folder. Alternatively, you can 
use the mouse pointer or arrow keys to move the cursor to the exact location in the folder 
name where you would like to insert or delete characters.  

Creating a Shortcut to a Folder 
To create a shortcut to a folder, use one of the following methods: 

• Right-click a blank area on the Desktop, click New, and then click Shortcut, or 

• in File Explorer, navigate to a folder or library if necessary, right-click a blank area of the Contents pane 
and then click New, and then click Shortcut. 

Windows launches a wizard to help you create the shortcut.  
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Click Browse to open the Browse for Files or Folders dialog box.  

 
Click locations and folders in the dialog box until you work your way to the folder you want to set as the 
target of your shortcut. 

 
Click OK to set the shortcut target. Click Next in the wizard, type a name for your shortcut, then click Finish. 

Exercise 4-3: Working with folders 
In this exercise, you will create, and rename folders and, create shortcuts to folders.  

Note: The following exercise requires that you have downloaded the student data files. If you have not 
already done so, please follow the data file instructions in the Preface before proceeding. 

1. On the Desktop, double-click the 7500 Student Files folder. 

2. In the Contents pane, double-click File Mgmt. You are now viewing the files for this lesson. 

3. Click New folder in the Quick Access toolbar to create a new item near the top of the Contents pane. 

4. Type your first and last name for the new folder and press ENTER. 

5. Double-click your new folder to view the contents (it should be empty). 

Now, create some subfolders within your folder. 

6. In the Contents pane, right-click to display the shortcut menu, click New, and then click Folder. 

7. Type: Personal and press ENTER. You have created a new folder that resides within the folder with your 
name in the File Mgmt folder. 
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8. Move up one level by clicking File Mgmt in the Address bar, as shown in the following: 

 
 You should now be looking at the contents of the File Mgmt folder. You can use the path in the Address 

bar to help you navigate quickly to a specific location. 

9. Double-click the folder with your name once again to move back down one level. 

10. In the Contents pane, right-click, click New, and then Folder.  

11. Type: Worksheets as the name of the new folder and press ENTER. 

12. Repeat steps 10 and 11 to create the Documents, Misc, and Slide Shows folders. When you are finished, 
your folders should display as shown: 

 

Tip: When adding new folders, be sure to right-click in a blank area of the Contents 
pane. If necessary, make the window larger to show a blank area. 

 

Now, try renaming a folder. 

13. In the Contents pane in the File Explorer window, right-click the Documents folder, then click Rename 
in the shortcut menu. 

14. Type: Docs and press ENTER. The folder is renamed. 

Now, try creating a shortcut on the Desktop that will take you to the Personal folder inside the folder with 
your name.  

15. In the Navigation pane in the File Explorer window, under This PC, click Desktop. The desktop contents 
display in the Contents pane. 

16. Right-click in a blank area of the Contents pane, click New, and click Shortcut. 

17. Click the Browse button. 

18. In the Browse for Files or Folders dialog box, click This PC, then click Desktop, then click 7500 Student 
Files, then click File Mgmt, then click <your name>, then click Personal and click OK to set the target 
for the shortcut. 

19. In the Create Shortcut wizard, click Next. 

20. Type: JustMe in the Type a name for this shortcut box, to specify a new name for the shortcut. 

21. Click Finish. Windows creates the shortcut on the Desktop.  

22. Minimize the File Explorer window. 

23. On the Desktop, double-click the JustMe shortcut. Windows opens a new File Explorer window and 
shows the contents of the 7500 Student Files\File Mgmt\<your name\Personal folder. 

24. Close all open File Explorer windows. 
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Working with Folders and Folder Options 
You can change the appearance of the folder to suit your preferences by changing its properties. You can 
also change the way you view folders and files, and display file types or extensions. 

Changing Folder Options 
To change the properties for a folder, select the folder then click the File menu and then Options to open 
the Folder Options dialog box. (Note that sometimes this menu item displays as Change folder and search 
options and at other times it displays as Options.) The Folder Options dialog box includes three tabs. The 
General tab (shown in the following figure) includes three sections: 

 

Open File Explorer to 
Allows you to specify a default location to display within File 
Explorer when you first launch it. You can choose Quick 
access (default) or This PC. 

Browse folders 
Specifies whether each folder will open in the same window, 
or in a different window so you can switch between the 
windows. 

Click items as follows 
Provides options on whether to use a single- or double-click 
to open items. 

Privacy 
Allows you to specify whether you want to show recently 
used files and folders in the Quick access section. 

 Changing the View 
There are different ways to display information for files and folders. Occasionally, you may want to sort files 
in a specific order, or see more information for files and folders. Select the view options using one of the 
following methods: 

• Click an option in the Layout section of the View 
ribbon; or 

 

 

• right-click in a blank area of the Contents pane 
and then click View: 
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Available views are: 

Extra Large Icons 

Shows files and folders as very large icons, which can be 
helpful for visually impaired users; file and folder names 
display below the icon. 

 

Large Icons 
Displays files and folders as large icons with file or folder 
names below the icon. This is helpful when you want to 
preview the contents of picture files and have not turned 
on the Preview pane. 

 

Medium Icons 
Displays files and folders as medium-sized icons with the 
names below the icons, and is helpful when you want an 
overview of folders or files in a certain location. 

 

Small Icons  
Lists files and folders as smaller icons with the names 
displayed to the right. Contents are sorted alphabetically in 
multiple columns from left to right.  

 

List  
Displays the contents of a folder as a list of names preceded 
by small icons. Contents are sorted alphabetically from top 
to bottom in multiple columns starting with the left-most 
column. This view is useful if your folder contains many files 
and you want to scan the list for a file name.  

Details  
Lists the contents of the open folder and provides detailed 
information about the files and folders inside it, including 
name, type, size, and date modified. 
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Tiles 
Displays files and folders as medium-sized icons with the 
file names to the right of the icon. The file format and file 
size also display. 

 
 

Content 
Displays any properties or reference information about the 
contents of the file. 

 

You can click the Sort by button in the View tab to arrange files by Name, Date 
modified, Type, Size, Date created, Authors, Categories, Tags or Title. You can 
specify Ascending or Descending order. 

Additionally, whenever you can see the column headings in the Contents pane, 
you can use them to sort the contents or to manipulate the view further, as follows: 

• To adjust the width of a column, position the mouse pointer over the vertical 
line at the right edge of the column you want to adjust; the mouse pointer 
changes to display . Click and drag to the left or right to make the column 
narrower or wider. 

• To sort the contents by item type, click the Type column heading. An  up-
facing arrow symbol indicates the items are sorted in ascending order (that is, 
A–Z or 0–9); a  down-facing arrow symbol indicates the items are sorted in 
descending order (that is, Z–A or 9–0). 

Exercise 4-4: Working with views 
In this exercise, you will use different views in File Explorer. 

First, you will change the location that is displayed automatically when File Explorer launches. 

1. Click the File Explorer icon in the taskbar to open File Explorer. By default, File Explorer opens to show 
Quick access. (Windows keeps track of your recently used files and folders and adds them to the Quick 
access list.) You can, however, specify that you want File Explorer to open to This PC. 

2. In the File Explorer window, click the File menu, then click Change folder and search options. 

3. At the top of the General tab of the Folder Options dialog box, display the Open File Explorer to drop-
down list and click This PC. 

4. Click Apply, then click OK. 

5. Close and then re-open File Explorer. Now, File Explorer opens to This PC. 

Now, use a shortcut to open a folder in File Explorer. 

6. Close the File Explorer window again. 

7. On the Desktop, double-click the JustMe shortcut to display the folder in File Explorer. 

8. In the Address bar, click File Mgmt to jump to that folder. 
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Now, try some different views. 

9. Right-click a blank area in the Contents pane, point to View, then click Tiles to display the contents of 
the folder as tiles. 

10. Click the View tab, then in the Layout section, click List. 

11. Click the View tab, then in the Layout section, click Details. 

12. Click the Date modified column heading to sort the contents by date. 

13. Click the Type column heading to sort the contents by file type. 

14. Try changing the view a few more times to see what you like.  

15. Make Name the last heading sort and List the last view style you apply. 

Understanding File Types and File Name Extensions 
A file name extension is a suffix added to the base name of a computer file, and separated from the base 
name by a dot (.). Operating systems and application programs use file name extensions to recognize the 
format of a file and to identify which program created the file and which program may be used to open the 
file successfully. 

Most operating systems automatically recognize common file name extensions, and associate particular 
application programs with particular extensions. These associations make it possible for you to double-click 
a file to open it. The operating system launches the necessary application and then opens the file within the 
application.  

Additionally, Windows displays an application icon to the left of the file name, indicating which application 
is associated with the file type. In general, the icon is a visual reminder of the software program used to 
create or access the file. If Windows displays a generic file icon, then it does not know which application to 
use to open the file. In most cases, this is because you do not have an application installed that is capable of 
opening and editing the specific type of file. 

There are thousands of file types and applications. The following sections introduce a few of the most 
common types, and the applications often associated with them. 

Audio Files 
Audio files are generally produced using specialized applications, but can be played through freely available 
applications called "players." Common audio players include Windows Media Player, Windows 10 Groove 
music app, Winamp2, Winamp3, and iTunes. When you double-click an audio file, the associated player opens 
and begins playback of the file. Common audio types include: 

.aiff Audio Interchange File Format – developed by Apple Computer, but most browsers can play AIFF 
files. 

.mp3 or 

.m4a 
Motion Picture Experts Group MPEG – requires a player application such as iTunes, Apple QuickTime 
or Windows Media Player. 

.wav Waveform Audio File Format – this is the native sound format for Windows. Most browsers include 
built-in support for WAV files. This is also the format used on audio CDs. 

.wma Windows Media Audio – developed by Microsoft, this format produces much smaller files than the 
.wav format.  
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Video Files 
Video files are generally produced using specialized applications, but can be played through freely available 
applications called "players." Common video players include Windows Media Player, the Windows 10 Movies 
& TV app, and Apple QuickTime. When you double-click a video file, the associated player opens and begins 
playback of the file. Commonly-used video file formats include: 

.avi Audio Video Interleave – standard video files for Windows. AVI files play in Internet Explorer 
through the Windows Media Player. Apple QuickTime player can also open this format. 

.mov or .qt Standard video formats for Apple QuickTime movies, and the native format for Macintosh 
operating systems. Opens with Apple QuickTime player. 

.mpg, .mpeg, 
and .mp4 

Motion Picture Experts Group – standard format for video files on the Internet. Opens with 
MP4 players, Windows Media Player and Apple QuickTime player. 

.swf Animation file created with Adobe Flash and played in web browsers through the Flash Player 
plug-in. 

.wmv Windows Media Video – a compressed video file format originally designed for Internet 
streaming applications. 

Note that not all media types are compatible with all players. For example, if you download a movie clip and 
then receive an error message when you try to play it back, it may be due to the fact that the player does not 
support that particular video format. You can look online to find which player is required and then download 
and install it. 

Graphics Files 
Graphics files are images. Many graphics formats are supported in web browsers and most operating systems 
include built-in graphics viewers. Graphics can be imported to a system from a digital camera or scanner, or 
can be created on a computer using a dedicated graphics creation and manipulation program such as 
Microsoft Paint, Paintshop Pro or Adobe Illustrator. When you double-click a graphics file, the image displays 
in either a dedicated graphics editing program, or in a viewer. If the file is not supported, Windows will 
prompt you to select an application to use to open the file. Common graphics formats include: 

.gif Graphics Interchange Format – graphics format used for line drawings and illustrations. 

.jpg or .jpeg Joint Photographic Experts Group – graphics format used for photographs and complex 
graphics. 

.png Portable Network Graphics – graphics format commonly used on web pages. 

.tif or .tiff Tagged Image File Format – graphics format commonly used for desktop publishing and 
medical imaging. 

Document Files 
Document files can be created using specialized applications, such as those found in the Microsoft Office 
suite, in OpenOffice, or in web apps such as those you can access on Google Drive or OneDrive. Some formats 
can be opened and edited in simple text editors such as Notepad. Some formats, such as PDF and RTF, are 
designed to be cross-platform compatible. That is, you can open them on Windows systems or Apple 
systems, or UNIX systems. Double-clicking a document file opens it in an application that can support it (if 
one is installed on the system).  
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Document file formats include: 

.asc ASCII – a standard text format for all computers, regardless of operating system. 

.doc The default document format for Microsoft Word (prior to version 2007) or Windows 
WordPad. 

.docx The default document format for Microsoft Word 2007 and above. 

.htm or .html Hypertext Markup Language – the document format used in web pages and supported by all 
web browsers. 

.one The default format for Microsoft OneNote 

.pdf Portable Document Format – document format supported on all operating systems through 
the use of the Adobe Reader plug-in. A full version of Adobe Acrobat is required to edit a PDF 
file. Microsoft Office files and documents created in Google Drive can be saved to PDF format 
to make them cross-platform compatible. 

.ppt or .pptx The default presentation formats for Microsoft PowerPoint. 

.rtf Rich Text Format – a document format that supports text and images. This format is supported 
by most word processing applications across many operating systems. 

.txt or .text Document format that supports plain text only, without formatting. Double-clicking a .txt file 
on a Windows system will open the file in either NotePad or WordPad. 

.xls or .xlsx The default spreadsheet formats for Microsoft Excel. 

Executable Files 
Executable files are files that launch a program or procedure. Take great care when opening executable files 
that you receive via email or that you download from web sites with which you are not familiar. When you 
open an executable file, your PC can automatically run any number of operations without your explicit 
approval. Executable file formats include: 

.bat Batch file – found on old DOS systems. 

.cgi Common Gateway Interface – script file used to generate web content. 

.cmd Windows command file. 

.com DOS command file. 

.dll Dynamic Link Library – these files are not executables, but are libraries of code that are referred or 
called by executable programs. 

.exe Windows executable program; these files are typically self-extracting compressed files. 

.msi Windows installer file – these executables are used to automate software installation on Windows 
systems. 

.vbs Visual Basic – script files created in the Visual Basic programming language. VBS scripts have been 
used to spread viruses. 
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Archive/Compressed File Formats 
Archives are compressed file formats. Used primarily on the Internet, the compressed file format reduces the 
amount of time necessary to download a file. Archives can contain any type of file – images, documents, 
executables, and so on. A compression utility is required to compress and decompress the files. Archived file 
formats include: 

.bz or .bz2 Archive files used by the Bzip/Bunzip application. 

.rar A compression standard that is platform-neutral (can be used on various operating systems). 
On UNIX systems, the RAR application is used. On Windows systems, the WinRAR application 
is used. 

.tar Compressed file used on UNIX systems. 

.zip Compressed file used by the PKZIP and WinZip applications. 
 

Exercise 4-5: Recognizing file types 
In this exercise, you will match the file type with an appropriate software program that could be used to view 
or edit the file. 

a.       .docx ---------- _________ iTunes 

b.       .swf  _________ WinZip 

c.       .pptx  _________ Internet Explorer 

d.       .jpg  _________ Windows Media Player 

e.       .mp3  _________ Word 

f.       .avi  _________ PowerPoint 

g.       .htm  _________ Photoshop 

h.       .zip  _________ Flash Player  

Windows 10 and File Extensions 
Windows automatically recognizes common file name extensions, and associates particular application 
programs with particular extensions. For example, if you are using a file management tool such as File 
Explorer, and you double-click a file with a .pdf file name extension, Windows will try to open the file in 
Adobe Reader, which is the program used to read PDF files. The operating system launches the necessary 
application and then opens the file within the application.  

If you try to open a file for which there is no associated application installed, Windows displays a window 
similar to the one shown: 

Click More apps to display a list of installed apps.  

In some cases, you can choose a program that is already 
installed on the computer to try and open the file. If you cannot 
find an application that will successfully open the file, you can 
search in the Windows store for a suitable app. 
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Viewing the File Extensions 
To keep things simple and keep the display uncluttered, you may want to hide file name extensions in file 
Explorer. Displaying file name extensions can be useful, however. For example, you can display extensions to 
show which picture files use the .jpg, .gif, or .tiff format.  

Viewing file extensions is also useful for differentiating between two files with the same name but different 
file formats, such as .xlsx versus .csv. Both of these file types can be opened in a spreadsheet program such 
as Microsoft Excel. However, a .csv file is not a native Excel file type and will not appear in a list of available 
files when you try to open a file from within Excel.  

By viewing the file name extension of audio or video files, you can quickly identify which program you can 
use to open the file. Another good reason for displaying the file types is to help you easily identify executable 
files. These files are used to launch a program (or other code that will carry out commands). You should take 
care before launching any executable file. While in most cases these files launch legitimate programs, they 
can also be used to install a virus on your computer. 

To display the file extensions at all times, open a File Explorer window, click the File menu, then click Change 
folder and search options to open the Folder Options dialog box. Click the View tab and in the Advanced 
settings list, uncheck Hide extensions for known file types. 

When you need to see hidden files, you can uncheck the Hide protected operating system files 
(Recommended) option. Important files such as system files or the data file for your email program are 
hidden to prevent them from being deleted or changed inadvertently. Protected system files may be 
displayed when a technical support person is working on your computer and needs to view them; it is 
recommended that you hide the system files once he/she has finished. 

Selecting Files and Folders 
Before performing any actions such as copying, moving, or deleting, you must select the file or folder. 
Consider the following traditional methods of selecting files or folders. These methods work in all versions 
of Windows: 

• To select one file or folder, click it.  

• To select all files and folders within a location, click the Home tab, and click Select all in the ribbon or 
press CTRL+A. 

• To select multiple files or folders that are consecutive, point to the first file or folder in the list, press and 
hold the SHIFT key, and then point to the last file or folder in the list. 

• To select files using the lasso method, point at the right of the first file or folder to be selected, then click 
and drag up or down to select the rest of the files or folders in the selection. A box will appear as 
confirmation of the selection, along with the files or folders being highlighted.  

• To select multiple files or folders that are non-consecutive, point to the first file or folder to be selected, 
press and hold the CTRL key, and then point at each file or folder to be selected. 

• At any time as files or folders are selected, if you need to change any part of the selection, use either the 
SHIFT or CTRL key to deselect specific parts of the selection. 

To de-select or turn off the selection of files or folders, click anywhere away from the selection. 

Note that in Windows 10, items in File Explorer display a check box when you point at them and display a 
check in the check box when they are selected.  
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This allows you to select a file, point at another item to display its check box, and then click in the check box 
to select that additional file without de-selecting the previously-selected file. 

 

Exercise 4-6: Selecting files 
In this exercise, you will use different methods to select files. 

1. Ensure the File Mgmt folder is active. The contents should be sorted by name and displayed in a list 
format. 

2. Click the View tab, click the Sort by button, then click Type to rearrange the files. Files are sorted 
alphabetically from top to bottom first by type, and then by file name.  

3. In the Contents pane, point the mouse pointer at the logo file and click to select it. 

4. Press and hold SHIFT, then click the Letter to Joan Woods file. This action selects all the files between 
the logo file and the Letter to Joan Woods file. 

5. Click in a blank area of the Contents pane to de-select the files. 

Now select files in random order. 

6. Click the Letter to Joan Woods file, press and hold CTRL, and then click the History of the Internet 
file. Now two non-adjacent files are selected. 

7. Click in a blank area to de-select the files. 

Now use the item check boxes. 

8. Click the View tab again, and if necessary, in the Show/hide group, select the check box for Item check 
boxes. 

9. Point the mouse pointer at the Budget 2016 file to make its check box visible, then click its check box to 
select the file. 

10. Point the mouse pointer at the News with RSS file to make its check box visible, then click its check box. 
Now two non-adjacent files are selected. 

11. Click in a blank area to de-select the files. 

Now try the lasso technique to select files. 

12. If necessary, resize the window so that the files display in two columns. Position the mouse pointer over 
a blank space to the right of one of the files in the second column, and then press the left mouse button 
as you drag up and slightly to the left until you have selected four files in the second column. When the 
files are selected, release the mouse button. 

13. Click anywhere away from the selected files to de-select them. 

Now select all the contents in this location. 

14. Press CTRL+A. 

15. Click anywhere away from the selection to de-select the list. 
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Copying and Moving Files and Folders 
Files or folders may be copied or moved from one drive location to another, from one folder to another, or 
to the desktop. Use the Folders list to view the hierarchical structure of the folders and subfolders, and to 
quickly navigate between the different folders or drives. 

Copying Files or Folders 
When you copy a file or folder, the original remains in the source location and a copy is placed in the 
destination location.  

To copy a file or folder, first select it and then use one of the following methods: 

• Click the Home tab, then click Copy in the ribbon, navigate to the new location, click the Home tab 
again if necessary and then click Paste in the ribbon, or  

• press CTRL+C, move to the new location and then press CTRL+V, or 

• right-click the selection and then click Copy, navigate to the new location, right-click and then click 
Paste, or 

• if you are copying files from one drive to another, Windows will automatically copy the selection as you 
drag the selection to the new location, or 

• if you are copying files in the same drive, press CTRL as you drag the selected file or folder to the new 
location. 

As Windows copies the files from the source location to the destination location, it will check to see if there 
are files with the same name already in the destination location. If so, you will see a message similar to the 
screen shown: 

 
Always double-check whether you want the new file to be copied over the existing file. You can choose to 
replace the file in the destination, skip the file that is present in both locations, or compare information. If 
you elect to compare information, Windows 
will display information pertinent to file size 
and date of last update.  
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Click the check box for the file you want to keep. If you elect to keep both copies (by selecting the check 
boxes for both files) Windows will create a file with a number at the end of the filename to indicate that it is 
a copy. In this example, the original file will be named Balance Sheet.xlsx and the copy in the same location 
will be named Balance Sheet (2).xlsx 

Exercise 4-7: Copying files 
In this exercise, you will use the copy and paste features to copy files. 

1. Ensure you are viewing the contents of the File Mgmt folder. 

2. Press CTRL+A to select everything in the folder. 

3. Now press and hold CTRL and click the folder with your name in order to de-select it. Now everything 
except the folder with your name is selected. 

4. Click the Home tab, then in the Clipboard group, click Copy. 

5. In the Contents pane, double-click the folder with your name to open it. 

6. Click the Home tab, then in the Clipboard group, click Paste to paste the copied files from the student 
files folder to your folder. 

Moving Files or Folders 
When you move a file or folder, it is cut (deleted) from its original location and copied into the destination 
location. When you move a folder, all the contents within that folder (subfolders and files) move as well. 

After selecting the files or folders to move, use one of the following methods: 

• Click the Home tab, and then click Cut in the ribbon, move to the new location, click the Home tab again 
if necessary, and then click Paste, or  

• press CTRL+X, move to the new location and then press CTRL+V, or  

• right-click the selection and then click Cut, move to the new location, right-click and then click Paste, or 

• drag the selected files or folders to the new location on the same drive. For different drives, Windows 
will automatically copy the selection unless you press the SHIFT key as you drag. 

If after completing the move action the file or folder is not in the location you intended, it is possible you 
may have moved the file or folder to the folder above or below the one you wanted. Click in the folder on 
either side to see if the file or folder is there, then move it into the appropriate location. 

Exercise 4-8: Moving files 
In this exercise, you will move files to various locations. 

1. Ensure you are in your folder.  

2. Change the view to Details, and sort the files by the Type column. 

3. Select all the Microsoft Word files and then press CTRL+X to cut them from the current location. 

4. In the Contents pane, double-click the Docs folder to open it, then press CTRL+V to paste the copied 
files into this location. 

5. Click your folder in the Address bar. 
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6. Repeat steps 3-5 moving the Microsoft Excel files into the Worksheets folder. 

7. Select the Microsoft PowerPoint files, then drag the selected files into the Slide Shows folder. 

8. Move the remaining files into the Misc folder. 

Suppose you want to move your folder to another location, such as the Desktop. 

9. Click File Mgmt in the Address bar to move up one level. If necessary, click your folder to select it, then 
drag to the left so that it hovers over Desktop in the Navigation pane. 

 
10. Release the mouse button when Desktop is highlighted, as shown in the preceding figure. You have 

successfully moved your folder to the Desktop. 

Now move your folder back to where it was. 

11. In the Navigation pane, click the Desktop folder, then in the Contents pane, click your folder to select it. 

12. Press CTRL+X to cut it and remove it from the Desktop. 

13. In the Contents pane, double-click 7500 Student Files, then double-click File Mgmt, then press CTRL+V 
to paste your folder back into its original location. 

Renaming Files 
As with folders you can rename a file to make it more descriptive using the Edit mode. 

To activate the Rename feature use one of the following methods: 

• Select the file and then press F2, or 

• select the file and then click once in the file name, or 

• right-click the file and then click Rename. 

Remember the two limitations of file and folder naming conventions: a maximum of 255 characters; and the 
following characters \ / : * ? ” < > | cannot be used in the file or folder name. 

Be very careful not to rename any program files or folders, or the application program may not be able to 
find them. 

Exercise 4-9: Renaming files 
In this exercise, you will copy and then rename a file. 

1. In the File Explorer window, navigate to the File Mgmt folder.  

2. Right-click the Letter to Joan Woods file, then click Copy.  

3. Right-click in an empty area of the Contents pane, then click Paste to paste the file into the current 
folder. Windows pastes the file and adds “- Copy” to the end of the file name. 

4. Right-click Letter to Joan Woods – Copy, then click Rename to enter edit mode. 

5. Type: Letter from <your name> and press ENTER to rename the file.  
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Searching for Files 
You can use two methods for finding files and folders on your system. You can use the Windows Search 
box/Cortana feature, or you can search from within File Explorer. 

Using Windows Search Box/Cortana  
The Windows Search box is located in the Windows taskbar, just 
to the right of the Start button. When you use the Windows 
Search box, Windows displays results from your system and the 
Internet. You can use the Search box to find help, apps, files, 
images, settings, and so on. 

Click in the box and begin typing a search term. Windows will 
display suggestions and answers to your questions in a panel 
that appears above the search box. 

Notice that the results in the previous figure are grouped by 
installed apps, store apps, settings, documents, and web. 
Windows will group the results it gathers depending on what it 
finds. Simply click on a result to access it. 

You can also press the WINDOWS key and begin typing to use 
the Windows Search box. 

Note: On a Mac, you can use the built-in Spotlight feature by 
clicking the Spotlight icon or by pressing 
COMMAND+SPACEBAR. 

Searching within File Explorer 
When you search from within File Explorer, you limit the scope of the search to the current folder and any 
subfolders below it in the directory hierarchy. Windows will not search folders outside the given path, nor 
will it search the Internet. 

Click in the Search box within a File Explorer window and begin typing a search term. As you type, documents 
that match the search term display in the window.  

 
Windows lists all files that include the search term in the file name and that include the search term within 
the file contents. For example, in the preceding figure, the three Excel files contain the word “budget” in the 
file name. The word document includes the word budget somewhere within the document text. 
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Additionally, the Search Tools ribbon becomes available and you can use it to fine-tune your search. 

 
Notice that you can specify whether to include subfolders, or whether to filter the 
results by a variety of characteristics, such as the date the file was modified, or the 
approximate file size. 

Windows also keeps track of your search history, allowing you to perform a previous 
search again. You can also clear the search history. 

Exercise 4-10: Finding files 
In this exercise, you will search for files. 

1. Ensure that you are viewing your folder in the File Explorer window. 

2. Click in the Search box in the top-right corner of the window and type: budget. Windows displays four 
files that match the search term.  

Now, refine your search. 

3. Click the Search tab if necessary, then in the Refine group, click Size, then click Tiny (0 - 10KB). Now, 
no files display. 

4. Click the Search tab if necessary, then in the Refine group, click Size, then click Small (10 – 100KB). 
Now the four files are listed again. 

 Clear the search criteria and begin a new search. 

5. Click in the Search field and click  at the right end of the search box to clear the search field, then 
click the Search tab if necessary and in the Refine group, click Other properties, click Tags, then type: 
vintage. Now the US Sailor picture displays in the results list. 

6. Click  to clear the search criteria. 

Begin a new search and change the search scope. 

7. Click in the Search field and type: sale. Several results are listed.  

8. In the Search tab, in the Location group, click Current folder. Now, no results are listed. 

9. Clear the Search field. 

10. On the Search tab, in the Options group, click Recent searches, then click Clear search history. 

11. Close the File Explorer window. 
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Looking at the Recycle Bin 
The Recycle Bin is a temporary storage area for files and folders that you delete from the local hard disk. Files 
and folders deleted from an external disk (such as a flash drive, SD card, or virtual storage device) or from a 
network drive are permanently deleted and cannot be restored from the Recycle Bin. 

The Recycle Bin has an icon on the desktop for easy access, but is also accessible from File Explorer. Two 
icons are used to represent the Recycle Bin: 

 

Indicates there are files in the Recycle Bin that can 
be restored or the Recycle Bin can be emptied. 

 

Indicates the Recycle Bin is 
empty. 

If the computer is shared by multiple users, a separate Recycle Bin exists for each user account on the 
computer. 

To permanently delete a file and bypass the Recycle Bin, press and hold the SHIFT key while deleting the file. 

Deleting Files and Folders  
When you no longer need files or folders, you can delete them. 

Always check the contents of a folder before you delete the entire folder. This is especially crucial if the folder 
is stored on a network drive or external disk, as these are not moved to the Recycle Bin. 

To delete a file or folder, select the file or folder and then use one of the following methods: 

• Click the Home tab, and then click Delete, or 

• select the file or folder and then press DELETE, or 

• right-click and click Delete, or 

• drag the item to the Recycle Bin icon on the Desktop. 

Restoring a File or Folder  
You can restore a deleted file or folder to its original location. Double-click the Recycle Bin on the Desktop 
to open it.  

 
You can restore only an entire folder (including all its contents), not individual items that were deleted with 
the folder. 
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To restore a file or folder from the Recycle Bin, use one of the following methods: 

• Select one or more files or folders to be restored, click the Manage tab, and then click Restore the 
selected items, or  

• if you want to restore all items, click the Manage tab, and then click Restore all items, or  

• right-click the selected files or folders, and then click Restore. 

Emptying the Recycle Bin 
Deleted files remain in the Recycle Bin until you empty it or it becomes full; in the latter case, Windows will 
automatically delete older files and folders to free up space for new items. When a file or folder is deleted 
from the Recycle Bin, it is permanently deleted. 

To empty the Recycle Bin, use one of the following methods: 

• Double-click the Recycle Bin on the desktop to open it, click the Manage tab, and then click Empty 
Recycle Bin, or 

• right-click in a blank area of the Recycle Bin window and click Empty Recycle Bin, or 

• right-click the Recycle Bin icon on the desktop and then click Empty Recycle Bin. 

Use this option only when you are sure that you will not want to restore anything from the Recycle Bin. 

Exercise 4-11: Using the Recycle Bin 
In this exercise, you will delete files and folders and work with the Recycle Bin. 

First, you will delete a file and a folder. 

1. Ensure that you are viewing your folder in the File Explorer window. 

2. Open the Misc folder, select the IC3 Web Site file, then press DELETE to delete the file and move it to the 
Recycle Bin. 

3. Move up one level to your folder, then right-click the Misc folder and click Delete in the shortcut menu 
to delete the folder and move it to the Recycle Bin. 

Now, restore the folder. 

4. On the Desktop, double-click the Recycle Bin icon to open the Recycle Bin. 

5. Select the Misc folder, then click the Manage tab and click Restore the selected items. The Misc folder 
is restored to its previous location. 

6. Close the Recycle Bin, then in the File Explorer window, navigate to your folder if necessary to verify that 
the Misc folder has been restored. 

7. In the Address bar, click File Mgmt to move up one level. 

Next you will delete your folder and the Desktop shortcut and then empty the Recycle Bin. 

8. Right-click your folder, then click Delete. Your folder is deleted and moved to the Recycle Bin. 

9. On the Desktop, right-click the JustMe shortcut, then click Delete. Your shortcut is deleted and moved 
to the Recycle Bin. 

10. On the Desktop, right-click the Recycle Bin, then click Empty Recycle Bin. Click Yes to confirm that you 
want to permanently delete the contents of the Recycle Bin. 

11. Close the File Explorer window.  
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Understanding Default Locations 
Objective 1-3.7, 1-3.9 

Although Windows provides tools to help you locate files on your system, it is helpful to understand that 
different types of files have default locations to which they are saved, depending on the program that you 
are using.  

Generally, it is not difficult to locate documents you are creating because you purposefully save them to a 
specific folder when you create them. But have you ever scanned a picture and wondered where it went? 
Have you downloaded a user manual from the Internet and then you could not find it? Have you taken a 
picture with your integrated laptop or tablet or phone camera and then been unable to find it? 

Scanners  
A scanner is a device that converts a printed page into an electronic format. Most modern all-in-one printers 
include a scanning function that allows you to scan one or more pages and then save them as image files or 
as PDF documents.  

Some scanners include optical character recognition (OCR) functionality which allows the scanner to convert 
the scanned image into editable electronic text and save that editable text as a document. Many also include 
functionality that will allow you to scan one or more pages, save the output as an email attachment, and then 
send the email message. 

Most scanners automatically create a folder for all scanned output within your PC’s Pictures folder. Each time 
you scan a page using the scanner’s software, the scanner creates a subfolder within its own folder and names 
that new subfolder with the current date. Generic, sequentially-numbered file names are assigned to all 
scanned files. In the following figure, the MP Navigator EX folder and its dated subfolder (and its files) were 
created by a Canon scanner.  

 
If you use the Windows Fax and Scan utility included in Windows 10, scanned images are automatically saved 
to the Documents\Scanned Documents folder. 

Web Site Items 
Any file that you copy from the Internet and save to your computer is saved in the Downloads folder, 
regardless of whether it is an image file, a document, a user manual, or an executable file. In certain situations, 
you will be prompted to save a file you want to download and you can specify where you want to save the 
file.  

However, if you save a file or image from the Internet and are then unable to find it, check the Downloads 
folder.   
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Pictures 
Windows uses the Pictures folder and subfolders for saving picture files. Certain actions save image files in 
specific default locations. For example: 

• When you use the Windows 10 Camera app to take pictures on your laptop, those pictures are saved 
automatically in the Pictures\Camera Roll folder. 

• If you take screen shots using the WINDOWS+PRINT SCREEN command, these are saved in the 
Pictures\Screenshots folder. 

• If you take screen shots using the Windows Snipping tool, these are saved in the Pictures folder.  

Additionally, if you use the Windows 10 Photos app to import pictures from a digital camera to your PC (via 
a USB cable), these are imported by default into the Pictures folder as well.  

Keep in mind that these are default locations. In many situations, you can specify a different location in which 
to save your pictures. However, if you take some action that results in the saving of a picture file and you 
don’t pay attention to where it is saved, you can check these default locations first.  

Pictures on Smart Phones 
We all love to take pictures (or even shoot video) using our smart phones – and once we grab that fantastic 
shot we want to share it with our friends and family. Usually, we want to share it right then and there.  

Fortunately, smart phone apps make it easy to point, click and share.  

Photos that you take with your smart phone are stored in a picture gallery. When you access the picture 
gallery, you can click any picture to view it full screen. Tap the picture to make the picture options visible. 
The following figure shows options for a photo taken on an Android phone: 

 

The icons at the bottom of the screen allow you to adjust, share, edit, or 
delete the photo. To share the photo, tap the Share icon to bring up a 
menu of apps you can use to share the picture. 

     
There are a wide variety of apps you can use to share pictures. Apps that 
appear as sharing options depend on the apps you have installed on your 
device and on the types of accounts you have – for example, social media 
accounts, email accounts, and so on.  

When you use an app to share a photo (or other type of file), the app handles the transfer and will prompt you 
to enter any necessary information. For example, if you want to send a photo via email (which you can do as 
long as you have an email account configured on your phone), you will be prompted to enter the name or 
address of your recipient. You can type a brief message and then click Send to send your picture on its way. 

Notice also that you can send the file to a variety of cloud locations (such as Google Drive, Instagram, or 
Facebook). Simply tap the appropriate app icon, and then confirm that you want to proceed. 
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Using Hardware to Share Photos 
You can also share photos with other users using hardware methods for transfer. You can: 

• Save your photos to an SD card, remove the card and give it to another user. 

• Connect to a PC using a USB cable, navigate the phone’s directory structure and then copy the desired 
photos. Most smart phones store photos in the DCIM\Camera folder. (DCIM stands for Digital Camera 
Images.) 

• Use Bluetooth sharing if both devices support it. Put both devices into discovery mode, then when your 
phone detects the device to which you want to send your picture, tap the device in the list of detected 
devices and tap the send command. Your recipient will need to accept the file transfer. 

Managing Electronic Media  
Objective 1-3.6 

Electronic media (or digital media) refers to media that is stored and played or viewed electronically. Music, 
movies and books are widely available in electronic format, and you play these formats within a player app 
designed for the content. 

That is, you play movies on your Windows 10 laptop in a movie player app such as 5KPlayer or Movies & TV 
player for Windows 10. (On a Mac or iPad, you might use iMovie.) You play music on that same laptop in a 
music app such as Groove Music. You read eBooks on an eReader (such as Kindle, Nook, Kobo, or Sony 
Reader) or on a device on which an appropriate app has been installed. 

These players and player apps are designed to handle digital content that is freely available and re-
distributable as well as content that is protected by digital rights management (DRM) software. DRM is 
designed to prevent the unauthorized use, or redistribution of the media to which it is applied. DRM restricts 
the way you can copy content that you have purchased. 

For this reason, you cannot directly manage digital media using File Explorer or other computer file 
management utilities.  

In many cases, you cannot even see the digital content using File Explorer; you need to access and manage 
your titles using the player or player app. 

Consider the following pair of figures. The background image shows eight eBooks that are downloaded to the 
PC and read using the Kindle app. The foreground image shows the storage location for the books that have 
been downloaded to the PC. The recognizable titles are for free books (and are stored in MOBI format). The 
others are for books which were purchased for the Kindle, and they are saved in a format which supports DRM.  
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Of the 16 files shown, can you tell which one is for the Wireless Networking book? The app knows how to 
interpret the file names and supporting information and display it in a way that is meaningful to you. 

Let us go one step further and compare a partial listing of eBooks on an Amazon Kindle Fire (the figure in 
the background) to a file listing of the internal storage directory on the same Kindle Fire (the figure in the 
foreground). Do you think you could find a particular book by title? 

 
Players and player apps are essential tools for working with and managing digital media. Most include built-
in search features that help you find just the file you want. 

Sharing Files 
Objective 1-3.6, 1-5.1 

The available methods for sharing files have evolved over the years. Shortly, we will examine sharing files in 
the cloud. In this section, we will review a few “old school” methods for sharing files which are still used today. 

Removable Media 
Perhaps the oldest method of sharing files with other users to is copy them to removable media (such as a 
USB flash drive) and then deliver the media to someone else, who can then plug in the drive and copy the 
requisite files from the drive on to their own system. 

Public Folders  
Although standard users cannot see files created by other users on a given PC, you can place files that you 
want to share into one of several public folders located in: This PC\OS (C:)\Users\Public.  

All users on a computer system have access to the public 
folders. 

If you want to make some of your files available to other 
user accounts on the computer, save or copy them into one 
of the public folders. 
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Shared Folders  
If you want to share a file or folder only with a specific user (and not everyone else on the system), you can 
do so by setting the sharing properties for that file or folder. 

In File Explorer, right-click the file or folder you want to share, click Properties to open the Properties dialog 
box, then click the Sharing tab.  

 
Click the Share button to access a screen where you can enter the names of users with whom you want to 
share.  

 
Type the user’s name and click Add to add the user to the list of people who have access to the shared file. 

If applicable, click the Permission Level arrow to adjust the permissions you want to extend to the other 
user. The default permission level is Read, but you can change it to Read/Write if you want the user to have 
the ability to edit your files or add or delete the contents of a shared folder. 

Click the Share button to enable the new settings. Then click Done. 
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The user with whom you shared your file or folder will be able to navigate to and access your shared file or 
folder using File Explorer the next time he or she logs on to the system. 

If you want to share a file or folder with another user on the same network (but not a different user account 
on the same system), you can copy the share link that displays in the box and paste it into an email message 
and send it to the person with whom you want to share your file or folder. As long as that user is on the same 
network as you, he or she can simply click the link and access your file or folder. 

Conversely, you can stop sharing a file or folder with a specific user (or with all users) by removing that user’s 
name from the share properties, or by turning off sharing. 

Note: You must be logged on with an Administrator account to enable sharing. If you try to enable sharing 
while logged on with a standard user account, you will be prompted to enter an administrator user name 
and password to enable sharing. 

Network Shares 
Another way to share files or folders is to place them in a network share. A network share (also called a 
network drive or a network folder) is simply a location on a server that is available over a network. Network 
shares are used within the private confines of a LAN. Network administrators often set up shares so that 
students or employees can access files that are stored in a central location. 

As you learned earlier, the network administrator controls who can access what, and what they can do with 
it once they access it.  

Email Attachments 
It is easy and convenient to share files with other users by sending those files as attachments to an email 
message.  

All email programs (whether locally installed or web-based) enable you to attach and send files with a 
message. As you are composing a new message, you can click an attachment button (or icon) and a dialog 
box will open which you can use to navigate to and select one or more files you want to attach to your email 
message. The specific name of the dialog box varies from one email client to the next, but all of them function 
in the same way. 
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• When you attach a file to an email message in Gmail, for example, you use the Choose File to Upload 
dialog box.  

• In Outlook.com you use the Open dialog box, and in the Outlook Desktop app, you use the Insert File 
dialog box. 

  
When you receive a file as an email attachment, you can save the attachment to your computer and then 
access it using File Explorer. 

Limitations on Email Attachments 
While sending all the files you want to share as email attachments might seem like an easy solution, there 
are certain limitations to using email for sharing files. 

• Many email programs limit the size of file attachments – email must traverse networks, and very large 
files cause network congestion and can slow network performance. They also occupy a lot of space on 
email servers.  

– The maximum attachment size in Gmail is 25MB, in Outlook the limit is 20MB and in Yahoo the limit 
is 25MB. 

– Even if your particular email service allows very large attachments, your intended recipient’s email 
service might not. 

– If you need to send many files, it might be best to send them in a series of email messages to avoid 
hitting the file size limit. You might also want to consider “zipping” the files into a compressed 
format. (We will discuss this in the next section.) 

• Many email providers and network administrators restrict certain types of file attachments: 
– Executable files (.exe, .bat, .cmd, .com, and so on), script files, and various file types related to 

programming have been used to harbor computer viruses and other types of malicious code. 
Messages that contain files of these types will be rejected.  

– Database files (.mdb) cannot be sent as email attachments either. 

– Documents that contain macros are also commonly rejected. 

• In most cases you cannot get around the file type restriction by zipping the files into a compressed 
format; however, you may be able to send your file as an attachment if you manually change the file 
name extension. (Your recipient will need to change it back to the correct extension after saving the file 
to his or her system.)  
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Compressing Files  
When you need to reduce the size of one or more files, you can use a file compression utility. Compressing 
one or more files is also referred to as zipping, much like when you stuff a tote bag as full as possible and 
then press everything down to make it fit prior to zipping (closing) the bag. 

Some files are larger than others, simply by the nature of the type of file. For example, video files are usually 
very large and should be converted to a compressed format (such as .avi) so they can be shared. Music files 
in .wav format are generally converted to .mp3 format to make them smaller for sharing. Picture files with a 
.tif or .bmp file type tend to be large in size and are compressed to a .png or .jpg format. The image, audio 
and video files you encounter on the Internet are already in a compressed format, which reduces the time 
required to download them to the temporary storage folders on your hard drive utilized by your web browser.  

You are probably already familiar with popular "zip" programs that compress text and images. WinZip and 
PKZIP are third-party utilities that have been used to easily and successfully compress and un-compress files 
for decades, and a built-in zip utility has been included with Windows since Windows XP. 

Zipped files are also called archives. Computers running Windows, Mac OS X, Linux and UNIX can handle 
zipped archive files.  

To compress (zip) a file or folder: 

1. Locate the file or folder that you want to compress. 

2. Right-click the file or folder, point to Send to, and then click Compressed (zipped) folder. 

 
To extract (unzip) compressed files and folders: 

1. Locate the compressed folder from which you want to extract files or folders. 

2. To extract a single file or folder, double-click the compressed folder to open it. Then drag the file or 
folder from the compressed folder to a new location, or 

 To extract the entire contents of the compressed folder, right-click the folder, click Extract All, specify a 
destination folder for the extracted files, then click Extract. 
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Note that some types of files, such as JPEG image files, are already highly compressed. If you compress 
several JPEG pictures into a folder, the total size of the folder will be about the same as the original collection 
of pictures. 

Exercise 4-12: Zipping and extracting files 
In this exercise, you will zip files and unzip files in File Explorer. 

Zip the Excel files into a compressed (zipped) archive. 

1. Open File Explorer and navigate to the 7500 Student Files\File Mgmt folder. 

2. Adjust the view to display Details, then sort the files by Type. 

3. Select all the Microsoft Excel Worksheet files. The status bar indicates that six items are selected, and 
that the total file size is around 71KB. 

4. Right-click the selected files, then click Send to, then click Compressed (zipped) folder. Windows 
creates a compressed archive folder and highlights the suggested name so that you can rename it.  

5. Type: Money, then press ENTER. Note that the status bar indicates the zipped archive is around 48KB. 

Now extract the files into their own folder. 

6. The Compressed Folder Tools ribbon should be displayed. Click the Extract tab if necessary, click the 
Extract all button in the ribbon, then in the wizard, click the Extract button. Windows creates a new 
Money folder and extracts the compressed files into it. 

7. If necessary, double-click the Money folder to view the extracted files.  

8. Close File Explorer. 

Exercise 4-13: Using Gmail to email attachments 
Gmail is a free web-based email service hosted by Google.  

In this exercise, you will create a Gmail account, and use Gmail to share files by sending them as email 
attachments. You will only send and receive messages with attachments in this exercise. You will learn more 
about email features in the Living Online module. 

For this exercise, we will use the Internet Explorer web browser, so we will begin by adding a tile for the 
Internet Explorer desktop app to the Start menu.  

1. Click Start, click All apps, then scroll the menu and click Windows Accessories to open the Accessories 
group. Notice that Internet Explorer is listed here. Internet Explorer is a desktop app (remember, in 
Windows 10 a desktop app is an installed application).  

2. Right-click Internet Explorer and then click Pin to Start. The Internet Explorer desktop app is added as 
a tile in the middle portion of the Start menu. 

3. In the middle portion of the Start menu, click the Internet Explorer tile to open the browser. If you are 
prompted to set up Internet Explorer 11, select Use recommended security and compatibility settings, 
and then click OK. If any add-in notifications pop up, do not enable them. 

  



File Management Lesson 4 
 

 

7500-1 v1.00 © CCI Learning Solutions Inc.  141 

Now, create a Gmail account. 

4. Click in the browser address bar, type: www.gmail.com, then press ENTER. The browser displays the 
Google accounts page which provides options for signing in or creating a new account. 

5. If you already have a Gmail account, sign in and skip to Step 11. Otherwise, click the Create an account 
link to access the Create your Google Account page. 

 
6. Fill in the fields in the form in order to create a Gmail account. You must select a user name that no one 

else is using. Ask your teacher for help if necessary. Ensure you record your Gmail address and password. 

7. In the Default homepage section, clear the Set Google as my default homepage check box. 

8. In the Prove you’re not a robot section, enter the text that you see in the image in the text box displayed 
below the image.  

9. Set your location if necessary, select the I agree to the Google Terms of Service and Privacy Policy 
check box, then click Next step. Google displays a welcome page. 

10. Click Continue to Gmail to access your Gmail account page. A series of introductory slides may display. 
You can click Next on each slide to view them all, or click the close button at the top-right corner of a 
slide to exit the introductory material. Your Inbox should include a welcome message. 

11. At the top of the page, you may see the message that Gmail works better with Chrome and an option 
button that says “Get Chrome now.” We will not be using Chrome in this lesson. Click No, not interested.  

12. You may also see an account setup progress indicator in the middle of your screen. Click the Close 
button in the upper-right corner to dismiss it. Also, dismiss the tip that appears concerning how to 
resume setting up Gmail. 
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13. The modern Gmail Inbox is divided into three tabs – Primary, Social, and Promotions. Ensure that you 

are on the Primary tab. A welcome message from Andy from Google should appear in your Inbox. 

Now, find an exercise partner and send an email message with a file attachment. 

14. Exchange Gmail addresses with a person sitting near you. For the sake of this exercise, this person will 
be your partner. 

15. Click the Compose button to open a New Message window. 

16. In the New Message window, in the To field type your partner’s Gmail address. 

17. In the New Message window, click in the Subject field and type: A file for you. 

18. Click in the empty space below the Subject field and type: Please look this over and tell me what 
you think. Thank you!  

19. In the toolbar at the bottom of the new message window, click the Attach files button to open the 
Choose File to Upload dialog box. (If a window opens asking you to try inserting files using Google Drive, 
click Maybe next time.) 

20. Navigate to the 7500 Student Files\File Mgmt folder, click the Letter from <your name> file then click 
the Open button to add the file as an attachment to the email message. 

 
21. Click Send to send the message. 

Now, retrieve the file attachment you received. 

22. When you receive the message from your partner, click it to open it. 
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23. Position the mouse pointer over the letter attachment. Notice that three icons appear. You can download 
the file, save it to Google Drive, or edit it in Google Docs.  

 
24. Within the attachment, click the Download button, then in the notification bar that appears at the 

bottom of the browser window, click Save.  

 
25. When the file has been successfully downloaded, the notification bar presents different options.  

 
26. Click Open folder. File Explorer opens to show the file in its current location. Notice that the file was 

automatically saved in your Downloads folder. 

27. Close the File Explorer window. 

28. At the top of the Gmail window, click your account icon (usually a blue circle with the first letter of your 
email address), then click Sign out.  

29. Close your browser. 

Lesson Summary 
In this lesson, you learned to use Windows File Explorer to find, move, open, and manage files. You worked with 
windows, learned about default locations, and learned about file types and file permissions. You should now be 
able to: 

 navigate a directory and follow paths 

 understand rights and permissions 

 use File Explorer 

 work with windows 

 recognize different types of files 

 work with files and folders 

 find files 

 work with the Recycle Bin 

 describe default file locations 

 share pictures on a smart phone 

 manage electronic media 

 share files with other users 

 zip and unzip files 
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Review Questions 
1. Which letter is commonly used to refer to the storage device where the operating system is installed on 

a computer? 

a. A   c. C 

b. B   d. D 

2. What happens when you connect a flash drive to a USB port on your computer? 

a. The operating system assigns the next available drive letter to that device. 

b. You are asked to download and install a device driver to handle USB drives. 

c. The operating system asks you which drive letter to assign to the device. 

d. A shortcut to the device is automatically created and added to your Desktop. 

3. What do you call the organization of files and folders on a disk? 

a. Directory or directory tree c. File management 

b. Path   d. Root directory 

4. When you connect your smart phone to your PC using a USB cable, what can you do? 

a. Navigate the device’s internal storage system. 

b. Assign the smart phone a drive letter. 

c. Organize the installed apps on the phone. 

d. Install a mobile operating system update on the phone from your PC. 

5. Who can work with files stored under another user’s profile? 

a. A user with an Administrator account. 

b. A standard user with Read permissions. 

c. A standard user with Write permissions. 

d. A standard user with Read/Write permissions. 

6. Which are the four control buttons you can use to adjust the display of a window on the screen? 

a. Minimize, Maximize, Restore Down, Close 

b. Help, Minimize, Maximize, Close 

c. Program Icon, Minimize, Maximize, Close 

d. Help, Program Icon, Restore Down, Close 

7. Which method would you use to move a window? 

a. Click in the title bar for the window and drag to a new location. 

b. Click at the left or right border of the window and drag to a new location. 

c. Click at the top or bottom border of the window and drag to a new location. 

d. Click in the title bar for the window and press ENTER. 
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8. How can you identify which program you might need to modify a file? 

a. From the icon at the left of a file name. 

b. From the name of the file. 

c. From the arrow at the lower left corner of the file name. 

d. From the folder icon at the left of a file name. 

9. Which key can you use to edit or rename a file or folder? 

a. F2   c. F1 

b. F4   d. F9 

10. What do you call the suffix added to the base name of a computer file? 

a. File name extension 

b. Program application 

c. File name path 

d. Operating system identifier 

11. Which is the default setting for viewing file extensions in File Explorer? 

a. Hide the file name extensions. 

b. Show the file name extensions. 

12. Before you can perform any action on a file or folder, what must you do? 

a. Select the file or folder. 

b. Log into the computer again. 

c. Start File Explorer twice. 

d. Create a shortcut for the file or folder. 

13. Once a file or folder has been selected, which keyboard shortcut can you use to move it from its original 
location? 

a. Press CTRL+X. c. Press CTRL+V. 

b. Press CTRL+C. d. Press CTRL+W. 

14. Which character cannot be used as part of a file name? 

a. \   c.  , 

b. .   d. - 

15. When you use the Windows Search box/Cortana to search for a feature, where do the results appear? 

a. In the panel above the search box. 

b. In a new search window. 

c. Within File Explorer. 

d. In a text file. 

16. Which feature allows a scanner to convert a scanned image into editable electronic text? 

a. OCR c.  GSM 

b. PDF  d. SCR 
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17. By default, in which folder are items you copy from the Internet stored? 

a. Downloads c. Desktop 

b. Documents d. Libraries 

18. Which folder does Windows 10 use as the default folder for images? 

a. Pictures c. Scanned Documents 

b. Quick access d. Documents 

19. What does digital rights management software do? 

a. Prevents unauthorized use or redistribution of media. 

b. Allows you copy content that has been purchased. 

c. Enables others to download the digital content from your device. 

d. Enables you to manage digital media using File Explorer. 

20. Which folder would you use to make certain files available to all other user accounts on your computer? 

a. Public b. Shared 

21. Which of the following file types can be sent as an attachment? 

a. .png c. .bat 

b. .exe  d.  .mdb 

22. Why might you want to use the Send to Compressed (zipped) folder command before sending four 
pictures to a friend via email? 

a. You need to reduce the size of the picture files for email purposes. 

b. It’s faster to send one file instead of sending four files in the one email. 

c. The friend has a web-based email program. 

d. The picture files are stored on the cloud. 
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Computing Fundamentals 
 
 

Lesson 5: Software 
Lesson Objectives 
In this lesson you will learn how to obtain, install, manage and configure software. You will also install and manage 
Windows apps and use messaging applications. Upon completion of this lesson, you should be able to: 

 describe the benefits of software 

 install, uninstall, repair and update apps and applications 

 set software preferences 

 work with Windows apps 

 use messaging applications 

Why Use Software? 
Objective 1-1.3 

While hardware is what makes our computers powerful and capable machines, it is software (programs) that 
makes our computing devices useful.  The operating system provides an interface with the hardware itself, 
and software programs are what we use to get work done.  

Software programs enable us to produce documents and charts; solve complex equations; calculate rocket 
trajectory; make online purchases; edit digital movies; decode the human genome; and so on. Additionally, 
light-weight apps can keep us on schedule, remind us of appointments, or help us find our way to a location 
when construction crews block our familiar path. Software and apps keep us productive and empowered. 

 
Locally-Installed vs. Cloud-Based Software 

Locally-installed software is installed on a device and runs directly on that device. These programs are 
designed to work with specific operating systems and with hardware that meets certain minimum 
requirements. 

Cloud-based software on the other hand runs on a dedicated server (not on your computer) and is designed 
to be accessed over the Internet. You will learn about cloud-based software in an upcoming lesson.  

In this lesson, you will work with locally-installed software. 

Important Info: Apps and Applications 
These are terms that describe the software we use to accomplish various tasks. The terms are used 
loosely, making it difficult to distinguish an app from an application. In this lesson, applications (or 
application software) are complex programs you install from removable media or from the Internet.  
Apps are small, light-weight programs you obtain from an app store. In Microsoft’s terminology, 
applications are “Desktop Apps,” and the light-weight programs are “Windows Apps.” 



Lesson 5 Software 
 

 

148  7500-1 v1.00 © CCI Learning Solutions Inc. 

Obtaining Software 
Objective 1-2.8 

In the not too distant past, there was only one way to obtain software for your computer – you went to the 
store and purchased the software which came packaged with the installable program code on removable 
media such as CD or DVD (or even floppy disks) and usually a booklet with instructions on how to install and 
use the program.  

Today, you have many options for obtaining and installing software. You can: 

• purchase a packaged version at a retail store and install using removable media 

• purchase a license online (usually with a credit card), and then download and install the program 

• lease software on a subscription basis 

• download and install apps from an app store 

When you purchase a software program, you are purchasing a license to install and use that program on 
your device. Some licenses allow for installation on one device only, while others allow for installation on 
multiple devices. It is your responsibility to ensure that you are complying with the licensing rules. 

The cost of software often includes future updates to the program. 

Platform Considerations 
Locally-installed programs are generally released in platform-specific versions. In computing, a platform is 
the environment within which a specific piece of software is designed to run. The operating system, installed 
drivers and hardware create the platform.  

That means, if you want to install a program on your PC, you must find the version of the software that is 
designed to run in your operating system. For example, you can install the Microsoft Office suite on your 
Windows machine, but you would not be able to install the same version on a Mac; you must purchase Office 
for Mac if you want to install it on your Mac. It is up to the software vendor to decide which operating systems 
will be supported, so you may or may not be able to find a version of the software you want for your particular 
operating system. 

Additionally, because microprocessors are designed in 32-bit and 64-bit architectures, operating systems 
come in 32-bit and 64-bit versions. A 32-bit version of Windows will run on a system with either a 32-bit or 
a 64-bit processor, but it cannot run 64-bit versions of application software. If you are using a 32-bit version 
of Windows, you will need to install 32-bit versions of application software.  

System Requirements  
System requirements identify the type of hardware (and operating system version) required to successfully 
run a program. All software, whether operating system software or application program software, is designed 
to work with hardware that can be expected to function at a specific speed and capacity. The software vendor 
lists these expectations so you can determine whether your computer is compatible and meets (and hopefully 
exceeds) all the requirements before purchasing the program.  

System requirements always appear on the software package if you purchase it in a retail store; if you 
purchase a license or other electronic means such as downloading from the software vendor’s web site, the 
system requirements are listed on the site, usually before you click the Download or Purchase button. 
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A system requirements checklist may appear similar to the following:  

 

If you are unsure of the type of hardware installed in your computer, check with a technical specialist before 
purchasing software. 

On a Windows 10 system you can right-click Start, then click System to view the system properties on the 
System page in the Control Panel. 

 
Notice that the displayed properties indicate the speed of the processor, the operation system version and 
the amount of RAM.  

Managing Software 
Objective 1-3.12 

Once you decide which application program you want to use, you will need to purchase the program and 
then install it on the hard disk of your computer before you can use it. Once a program has been installed, it 
can be removed (uninstalled), modified, repaired, or reinstalled as required. 

Note that a software license generally allows you to make a backup or copy of the original installation 
program. For example, you are allowed to make a copy of the installation DVD for backup purposes. You 
may even want to use the backup copy to install the software so that you can keep the original media intact 
and store it in a safe location. Software can be costly and it makes sense to protect your investment. 
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If you are downloading software from the Internet, always save it (if you are given the option) to a designated 
location such as the desktop and scan it for viruses prior to installing it. It is rare that software from a 
reputable vendor will have problems; however, if you download software from a site that is not the vendor’s 
official web site, there could be spyware or viruses included in the download file. 

Installing a New Program 
You can install programs from a number of different locations such as a network drive, an optical drive, a 
USB drive, or the Internet. How you purchase the software will determine the installation process. 

One of the more traditional methods for installation is installing from optical media. You insert the installation 
CD or DVD and the process either begins automatically, or you can launch the process yourself. Another 
“tried-and-true” method is to purchase software over the Internet, and then download and run the 
installation program.  

A more modern method for installing software is to stream the installation files from a server. For example, 
Microsoft has been using a setup and installation technology called “Click-to-Run” or “C2R Installer” for 
delivering Office setup files since Microsoft Office 2010. This type of installer streams Office setup files from 
Microsoft servers to your system, which allows you to start using Office even before the entire Office suite is 
installed on the system.  

Regardless of the method of installation, most installation routines lead you step by step through the 
installation process. For example, the following sequence of screens shows the installation process for an 
open-source application called Notepad++: 
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To advance through each stage of the installation process, click Next. When the installation is complete, click 
Finish to close the installer.  

User Account Control (UAC) 
The User Account Control (UAC) is a feature in 
Windows that issues notices (called elevation 
prompts) when a program is about to make a change 
that requires administrator-level permissions. For 
example, if you are logged in with an administrator 
account, the UAC displays the following prompt 
when you install a program. 

Click Yes to proceed with the installation. 

If you are logged in as a standard user and try to install software, the UAC will prompt you to enter the user 
name and password for an administrator account. 

 
Entering an administrator user name and password in this UAC prompt has the same effect as clicking Yes in 
UAC prompt that displays when you are logged in as an administrator. 
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EULA and Registration 
Once the installation process begins, you will be asked to agree to an End User License Agreement (EULA); 
depending on the vendor, this may appear in a separate screen or it may be a link you should click in order 
to read the contents of the agreement. Typically, you agree not to make illegal copies of the software to 
distribute to others, and you agree not to hold the software vendor liable for any damage or expenses that 
may occur from misuse or improper use of the software, such as putting incorrect entries into an income tax 
preparation program which results in an audit by the tax collector. 

When the installation is complete, you will usually be asked to register or activate your copy of the program. 
Performing this last step ensures that you will be notified of any updates to the program. It also usually 
provides the option to call technical support should you require technical assistance.  

Exercise 5-1: Installing software 
In this exercise, you will install a program called Notepad++ which is designed to help programmers (coders) 
create and keep track of their code. You will also install the Google Chrome browser. This exercise assumes 
you have sufficient rights to install software on your system. If not, please read the steps to gain some 
familiarity with installing and uninstalling programs on your system or watch a demonstration provided by 
your teacher. 

First, view some simple web page code in the standard Notepad text editor. 

1. In File Explorer, navigate to the 7500 Student Files\Software folder. 

2. Right-click the hello-world document, click Open with, then click Notepad to open the document in the 
Notepad editor. The document contains some simple HTML code for a web page. 

3. Close the Notepad application. 

Now start the installer for Notepad++. 

4. In File Explorer, double-click npp.6.9.1.Installer to start the installation program. 

5. In the UAC, click Yes to allow the installer to make changes to the system (or enter an administrator user 
name and password.) 

6. Select your language, then click OK to display the first screen of the setup wizard. 

7. Click Next. 

8. Read the EULA, then click I Agree. 

9. Click Next twice.  

10. Select the Create Shortcut on Desktop check box, then click Install. 

11. Click Finish. Notepad++ opens and displays release notes pertinent to the current version in a document 
called change log.  

12. Press CTRL+W to close the change log document. 

Now, view the web page code in Notepad++. 

13. In the Notepad++ window, click File, Open, navigate to the 7500 Student Files\Software folder, then 
double-click hello-world. Notice that this editor displays tags in blue and numbers each line of code. 

14. Press CTRL+W to close the hello-world document. 
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15. Close the Notepad++ application window. 

Now, install the free Google Chrome browser. 

16. Open the Internet Explorer browser, click in the Address bar and type: www.google.com/chrome/browser 
and press ENTER to navigate to the download page for the Chrome browser. 

17. Click Download Chrome. 

18. Read the Terms of Service, clear the Set Google Chrome as my default browser check box, then click 
Accept and Install. Click Run if prompted. 

19. Click Yes in the UAC (or enter an administrator user name and password) if prompted. The Chrome 
browser installs and then opens. 

 
20. Close the Chrome browser. 

21. Close the Internet Explorer browser. 

Uninstalling Programs 
You can uninstall a program when you no longer need it. Usually, the best way to uninstall a program is to 
use the Uninstall a program command on the Programs and Features page in the Control Panel.  

 
Once you select the program you want to uninstall, click the Uninstall/Change button in Control Panel, then 
follow the prompts in the uninstall routine as they appear onscreen. 
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Alternatively, you can use the program's uninstall option (if one is included). Most antivirus applications are 
best uninstalled using the included uninstall routine. Either of these options helps ensure that the program 
is properly and completely removed from the system.  

You should never simply delete program files using File Explorer. When you install a program, configuration 
information is added to the Windows Registry so that the operating system will identify this program. The 
Windows Registry is an operating system database that stores settings for installed applications. If you delete 
program files improperly, the obsolete configuration information is left behind in the Registry. This can lead 
to problems with other software programs or if you try to reinstall this program at a later date, or if you try 
to upgrade this program with a new version. 

Exercise 5-2: Uninstalling an application 
In this exercise, you will uninstall Notepad++. 

1. Right-click Start, then click Control Panel.  

2. With the Control Panel options displayed in Category view, click Uninstall a program beneath the 
Programs heading. 

3. Scroll in the list until you see the Notepad++ program and then click to select it. 

4. Click the Uninstall/Change button in the blue toolbar above the listed programs. 

5. If prompted, click Yes in the UAC (or enter an administrator user name and password.) 

6. Click OK in the Installer Language box. 

7. Click Uninstall to begin the uninstallation. 

8. When the Uninstallation Complete message displays, click Close. Notepad++ no longer displays in the 
Control Panel. 

9. Close the Control Panel. 

Repairing Software 
Sometimes an installed application program stops working correctly. Sometimes restarting the program will 
fix the problem. If that does not work, you can try repairing it.  

The Microsoft Office suite includes a repair utility that you can access through the Programs and Features 
page in the Control Panel. Click the suite in the list box and then click Change to access the repair tool.  
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You can specify: 

• Quick Repair – this runs faster but only detects and then replaces 
corrupted files. 

• Online Repair – does an uninstall and complete reinstall but 
takes longer. 

Click an option, then click Repair.  

The following series of screens shows a repair in progress. 

 
 

 

When the repair operation has completed, click Close to exit the utility. Be aware that you may need to restart 
the system after running a repair routine. 

Reinstalling a Program 
Sometimes, a program may not work correctly (or at all) after installation, or it may work for a while and then 
stop working. If a repair is not available for the application, you can try uninstalling and then reinstalling the 
program.  

Most vendors allow you download and install or reinstall a program on the same system numerous times 
without any fees. Generally, once you have paid for a software program, you can reinstall it as often as 
needed.  

Sometimes, Windows detects that a program is running improperly, or detects that a program has been 
installed improperly. In such cases, Windows will display the Program Compatibility Assistant, which may give 
you the option to reinstall or to verify that the program has been installed correctly. 

You can also check online user groups, knowledge bases, blog sites and forums to see if other users have 
experienced similar problems and you may find solutions there.  
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Updating Software 
When you register your copy (license) of a software program, you become entitled to receive notification 
about updates or upgrades as they become available.  

• You may receive a CD or other media that you can use to install the upgrade in much the same way as 
you installed the program initially. 

• You may receive an email with a link to the web site where you can download the update to your system. 
Click the link to access and download installation files for the update. 

Many programs are designed to automatically check online for updates and to display alert messages to 
indicate when a new update is ready for download and installation. Microsoft and Adobe provide this type 
of service for their products. Usually, a pop-up box displays in the Notification area of the taskbar informing 
you of an update's availability. You can usually click the box to read more information about the update, or 
click the X at the top right corner of the box to close the notification and delay any action.  

You can also check manually for updates by: 

• clicking a command, button, or link in the program. (Usually this option links you to the vendor’s web 
site; once you are connected to the site, a check for updates begins and a list of update options is 
displayed. You can then choose what you want to install.) 

• accessing the Help menu within the program and clicking a command that displays information about 
the application, including the version number. Vendors often include a check for updates link with this 
information. If updates are available, you can then follow the instructions to update the program. 

Often, you can simply install an update and it will integrate itself into the program. However, sometimes an 
update is so different from the previous version that you will be directed to uninstall the old version, and 
then install the new one.  

Always register your software to ensure you receive notices about available updates.  

Configuring Software 
Objective 1-3.4 

Most application software allows you to adjust the working environment to suit your working style and 
preferences. For example, the programs in the Microsoft Office suite are highly customizable, allowing you 
to change the appearance and arrangement of toolbars and menus, and allowing you to configure settings 
for default program behaviors. 

Customizing Toolbars 
Within the applications of the Microsoft Office suite, a Quick Access toolbar and series of ribbon tabs display 
across the top of the application window. The following figure shows the top of the Microsoft OneNote 
application window.  
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As you click each ribbon tab, a series of commands becomes visible on screen, allowing you to perform tasks 
such as copying, pasting, formatting, and so on. The Quick Access toolbar contains shortcuts to commonly-
used commands.  

At the right end of the Quick Access toolbar is the  (Customize Quick Access Toolbar) button. Click it to 
open a menu of commands that you can add to the Quick Access toolbar with a single click. 

 
Commands that appear in the menu can be toggled on or off the Quick Access toolbar. Commands that are 
currently on the toolbar display a check mark within the menu. 

Specifying Program Defaults 
In computing, a default setting is a preselected option used by a computer program when no alternative is 
specified by the user. Default settings within application programs control (among other things) items such 
as file save locations, print settings, the color of the application window, or the typeface of the font.  

In Microsoft Office applications, you access these settings on the File tab of the ribbon. The File tab displays 
the Office Backstage view, which is the view you use for file and program management tasks. The following 
figure shows the Backstage view in OneNote.  

Notice the series of headings: Info, New, Open, Print, Share, Export, Send, Account, Options, and Feedback. 
These are tabs within the Backstage view, and each provides access to different commands and settings.  

  

Ribbon tabs 

Quick Access Toolbar 
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When you click the Options tab, you open the Options dialog box. 

 

The Options dialog box also contains several tabs: General, Display, Proofing, Save & Backup, Send to 
OneNote, Audio & Video, Language, Advanced, Customize Ribbon, Quick Access Toolbar, Add-ins, and Trust 
Center. These provide access to various settings that control how the program functions on your system.  

For example, you can use the General tab to set a default font for all new pages you create in OneNote. Or 
you can use the Save & Backup tab to specify how often to back up your OneNote notebooks. 

   
Different commands and settings are available in different programs in the Office suite; however, these 
settings are always accessed through the tabs of the Options dialog box. 

Exercise 5-3: Setting software preferences 
In this exercise, you will open Microsoft Word and explore some of the available customizations. 

First, customize the Quick Access toolbar. 

1. Open File Explorer, navigate to the 7500 Student Files\Software folder, then double-click Customizations 
to open this document in Microsoft Word.  
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2. In the Quick Access toolbar, click Customize Quick Access Toolbar, then in the menu, click Quick Print 
to add a button to the Quick Access toolbar that sends a document to the default printer with a single 
click. 

3. In the Quick Access toolbar, click Customize Quick Access Toolbar, then in the menu, click Print 
Preview and Print to add another button to the toolbar. This one opens the Print tab in Backstage view, 
allowing you to specify what to print, and which printer to print on. 

4. In the Quick Access toolbar, click Print Preview and Print to preview the document, then at the top of 
the Backstage tabs, click the Back button to return to the document. 

Now, return the Quick Access toolbar to its original configuration. 

5. In the Quick Access toolbar, click Customize Quick Access Toolbar, then in the menu, click Print 
Preview and Print to remove the button.  

6. In the Quick Access toolbar, click Customize Quick Access Toolbar, then in the menu, click Quick Print 
to remove the button.  

Now, explore some of the options you can set for the application. 

7. In the ribbon, click File to open Backstage view, then in the Backstage tabs, click Options to open the 
Options dialog box.  

8. Click each of the tabs in the Options dialog box, read the available settings and note the type of settings 
you can configure for Microsoft Word. How customizable do you think this application is? 

9. When you have finished examining the tabs, click Cancel to close the dialog box.  

10. Close the Microsoft Word application window. 

Working with Windows Apps 
Objective 1-2.8, 1-3.12, 1-6.5 

In addition to using application software on your system, you can also use apps that you obtain from an app 
store. Per our definition at the beginning of this lesson, apps are small and light-weight programs. They are 
generally optimized for use on a touch-screen interface.  

Operating System App Stores 
An app store is a digital platform for distributing software. Just like full-featured application programs, apps 
are written for specific operating systems such as iOS, Mac OS X, Windows, or Android. For this reason, 
different platforms utilize different apps stores.  

An app for accessing the appropriate app store is usually built in to the operating system. For example, the 
Windows Store app is built into Windows 10, while the Mac App Store app is built into OS X v10.6.6 or later. 

Windows Store  
Windows 10 comes with built-in apps including OneNote, Mail, Groove Music, Movies & TV, Photos, Camera, 
Games, People, Maps, Calendar, Money, and Alarms, but you can get more at the Windows Store. Click the 

 (Store) icon in the taskbar to open the Store app and browse the store. 

If you want to download and install apps, you will need to sign in with a Microsoft account.  
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What is a Microsoft Account? 
A Microsoft account is an ID composed of an email address and password. You use a Microsoft account to 
log in to Microsoft web sites and services, such as Hotmail, Xbox Live, Outlook.com and OneDrive. A Microsoft 
account also gives you access to apps and games from the Windows Store, and lets you see your settings 
and personal files across multiple Windows 10 devices. 

If you use an email address to sign in to Outlook.com, Hotmail, Windows 10 Mobile (or Windows Phone 8), 
or Xbox LIVE, then you already have a Microsoft account. If not, then you can create a free Microsoft account.  

Exercise 5-4: Creating a Microsoft Account 
In this exercise, you will create a Microsoft account. If you already have a Microsoft account, skip this exercise. 

1. Open the Internet Explorer browser and navigate to https://account.microsoft.com.  

2. Click Sign in, then below the Sign in button, to the right of No account?, click Create one! 

3. Enter your Hotmail or outlook.com email address and password, or click the Get a new email address 
link to create a new account/email address. Fill out the rest of the form (ask your teacher for help if you 
need to), then tap or click Create account. Your Microsoft account is created and you are signed in. (If 
prompted, do not let the browser save your password.) 

4. Be sure to record your Microsoft ID. 

5. Click your user icon in the upper-right corner of the window, then click Sign out. 

6. Close your browser. 

Signing in to Store 
Once you have created a Microsoft account, you can use your ID to sign into the Store app. Click Store in 
the taskbar to open the store app, then click  Sign In  at the upper-right corner of the store window to 
open the Sign In menu. 

 

In the menu, click Sign In to open the Choose an account screen.  

 

 

 
Click Cortana if you want to use your personal Microsoft account. (If you have 
a Microsoft account associated with your school or business and you want to 
use that account instead, click the Work or school account option.) 
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Enter your Microsoft ID, then click Sign in. Windows will prompt you to use this account to sign in to your 
device. Signing in to your computer or device using a Microsoft account enables you to sync settings across 
your devices. However, in this course, you will not use your Microsoft account for signing on to your 
computer.  

 
To sign only into the Store app using your Microsoft account, click Sign in to just this app instead. 

Your account icon displays as  when you are signed in. 

Exercise 5-5: Signing into the Store App 
In this exercise, you will sign into the Store app with your Microsoft account.  

1. In the taskbar, click Store to open the Store app. 

2. In the upper-right corner of the window, click Sign In, then in the menu, click Sign In. 
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3. In the Choose an account screen, click Cortana. 

4. Enter your Microsoft ID and click Sign in. 

5. Click Sign in to just this app instead. You are now signed into the Store app. 

6. Minimize the Store window. 

Finding an App in the Store 
The Windows Store is your gateway to apps, games, music and TV and movies. Top picks or featured items 
are presented on the first page; and you can click or tap options that allow you to browse by category. The 
following figure shows some of the categories for apps: 

 
When you click a Category here the results show in the window, and a panel along the left side allows you 
to refine which apps are displayed in the window.  

 
In addition to browsing the categories, you can type the name of a 
specific app in the Search bar and search for it. The Store will display the 
best matches. 
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Downloading and Installing an App  
When you find an app that you are interested in, click or tap it to open its detail page. The detail page lists 
(among other things) ratings and reviews, the price of the app (if any) and similar apps.  

 
Click the price (or “Free”) to begin downloading the app. Windows will download the app and acquire a 
license for it automatically. When the download is complete, the app will display an Install button. Click it to 
install the app.  

When the installation is complete, the app will display an Open 
button. 

You can click Open to launch the app from within the Store. Note 
that some apps require you to accept certain terms and conditions, 
and some will ask for permission to access particular features (such 
as a built-in camera, or your location information) before they open 
for the first time. Once you have accepted the terms and granted 
appropriate permissions, the app will run. 

You can launch an installed app at any time from the Start menu: click Start, click All apps, then click or tap 
the app to launch it. 

Exercise 5-6: Obtaining Windows Apps 
In this exercise, you will explore the Windows Store and download and install a Windows app. 

1. Restore the Store window. 

2. At the top of the window, click Apps to see the top apps. 

3. Scroll to the bottom of the page, then in the Categories, click News & weather to view news and weather 
apps. 

4. In the Refine panel, click Best-rated. 
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5. In the Refine panel, click New and rising. 

6. In the Refine panel, click the X to the right of News & weather to remove the category filter. 

7. In the Refine panel, scroll the category list and click Productivity to view productivity apps.  

8. Near the top of the window, click in the search box and type: color note. The Store app displays a few 
apps that might be what you are looking for. 

9. In the search results list, click Ephemeral Notes to open the detail page for this particular app. 

10. In the description area, click More to read a little more, then click Less to close up the description.  

11. Read the ratings and then scroll to the bottom of the page to read about the app’s approximate size. 

12. Scroll back up and click Free to begin downloading the app from the Store. Notice that Windows 
automatically downloads the app, and acquires a license for it. Notice that the app displays the text: You 
own this product and you can install it on this device. 

13. Click Install. When the installation is complete, minimize the Store window. 

14. Click Start, click All apps, then click Ephemeral Notes in the Start menu. The app opens in its own 
window. 

15. At the top of the app window, click the menu icon  then click … App commands. An Add icon appears 
at the bottom of the app window. 

16. Click Add to create a new, untitled note. 

17. Type: check out this new app! 

18. At the top of app window, click menu then click … App commands and click Delete to remove the note. 

19. Close the app window. 

Deleting an App 
Apps can be easily removed from your PC. Click Start, All apps, then right-click the app in the Start menu and 
click Uninstall. Confirm that you want to uninstall and Windows removes the app.  

 

 

Recovering a Deleted App 
If you accidentally delete an app, or if you delete it on purpose and then change your mind, you can recover 
the app without having to pay for it again and without having to download it again. 

Sign into the Windows Store, if necessary, and search for the app you deleted. When you click its detail page, 
the app will display the message: You own this product and you can install it on this device. The Install button 
will also display in the app, allowing you to install it once again. 
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Signing out of the Store 
If you are using a shared computer, you should sign out of the Windows store. To do so, click the Sign in 
icon, then click your account at the top of the menu to open the Account window. In the Account window, 
click your account name to make the Sign out link visible. Click Sign out. 

 

Exercise 5-7: Removing Windows Apps 
In this exercise, you will delete the app you installed previously. 

Delete your app from the Start menu. 

1. Click Start, then click All apps. 

2. Locate the Ephemeral Notes app, then right-click it in the Start menu and click Uninstall. 

3. Click the Uninstall button to confirm, then click away from the Start menu.  

Ensure that it has been removed. 

4. Click Start and All apps and look for the Ephemeral Notes app. The app is uninstalled. 

5. Close the Start menu. 

Search for the app in the Store. 

6. Restore the Store window. 

7. Use the Search box to find the Ephemeral Notes app, and click it to open the detail page. Notice that 
the app displays an Install button. 

Sign out of the Store. 

8. In the Store window, click the Sign in icon, then in the menu, click your account to open the Account 
window. 

9. In the Account window, click your account name to make the Sign out link visible, then click Sign out.  

10. Close the Windows Store. 

Messaging Applications  
Objective 1-1.3, 1-1.5 

Although personal computing might have begun as a means toward increased productivity, social behavior 
(connecting with others) has always been part of the evolving process. Message boards, forums, email, and 
chat rooms have existed since the early days of the modern Internet. We have always wanted, it seems, to be 
able to use our computers to communicate with each other. 
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On the cellular side of things, it seems we have always wanted the ability to use our phones for more than 
simple communication. We want them to entertain us, and allow us to work, and allow us to share files and 
photos, and video, and more.  

And today we have choices. We can work on a hand held or on a desktop. And we can communicate from 
either place as well. Messaging apps keep us in communication, no matter where we are.  

Text Messaging 
Text messages (or “texts”) are short strings of text sent over a cellular provider's network using a protocol 
called Short Message Service (SMS). Text messages are created and sent from cellular phones (or other similar 
mobile devices). As the name of the protocol implies, the number of characters allowed per message is limited 
(about 100 to 200 characters per message, depending on the service provider). The original SMS protocol 
allowed for a maximum of 160 characters. You can send a text message to one person or to many people. 
The figure shows five text messages that form a conversation. 

In addition to Short Message Service, many cellular providers offer Multimedia Messaging Service (MMS), 
which provides a standard way to send messages that include multimedia content to and from mobile phones 
or other suitably equipped mobile devices. 

This service allows users to send photographs and video to other users, as well as mobile updates such as 
breaking news or weather updates. As with plain text messaging, you can send multimedia messages to one 
or more people, but the speed for sending and receiving may be slower depending on the size of the message 
or the speed of your cellular provider’s network. 

Text messaging can be useful when no other forms of communication are available or when the intended 
recipient cannot be reached through a phone call. For example, you can text your boss (who might be at a 
concert) to let her know that you will be coming into work later than usual tomorrow. 

In order to send a text message, you must know the cell phone number of the person you want to text. It is 
easiest if you enter that person into your Contacts list in your phone.  

To send a text, open the messaging application on your phone or tablet, specify one or more contacts who 
will receive the message, type your message, and then tap the Send button. If your recipient’s phone is turned 
off at the time that you send your text message, he or she will receive the message the next time the phone 
is powered on. 

Depending on your cellular text plan, you may be limited to the number of 
text messages you can send and receive before you start incurring charges. 
This is especially relevant with pre-paid plans.  

Additionally, most providers charge fees for sending/receiving texts to people 
who live in other countries. For example, if you live in the United States and 
you travel to Canada and use your mobile phone to send text messages, you 
will likely find fees assessed on your next mobile bill. Be sure that you 
understand the terms and conditions of your cellular contract and know in 
advance how much international messages will cost. Many providers offer 
special international text packages (for a set fee) that allow for international 
texting.  
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Most mobile devices come with text messaging apps preinstalled. If you use Android, Google Hangouts is 
the default for messaging with other Android users. If you use iOS, the Messages app is built in. However, 
not all messaging apps play nicely with others. That is, you may run into difficulty sending/receiving messages 
to users on platforms other than your own. Happily, there are thousands and thousands of apps that can be 
downloaded to a smart phone – including those that make cross-platform messaging fun and easy. 

Non-SMS Messaging Apps 
There are many messaging apps today that bypass your cellular carrier’s SMS and MMS service, and use Wi-Fi 
or mobile data instead. Exchanges between users who have the same app installed are free. These include: 

• WhatsApp – a cross-platform messaging system that supports Android, iOS, Windows 10 Mobile and 
BlackBerry devices. You can send individual and group text, photo, and voice/video messages using 
mobile data or Wi-Fi. Messages to any other WhatsApp user are free. 

• Viber – supports Android, iOS, Windows 10 Mobile and BlackBerry, and includes desktop clients for 
Windows and OS X, allowing you to send, receive, and manage messages on your computer as well as 
on your mobile device. All exchanges with other Viber users are free. 

• Facebook Messenger – allows you to connect with any other Facebook user (there are over one billion 
active Facebook users) for free, bypassing traditional SMS and MMS channels. The app supports iOS, 
Android, and BlackBerry and also includes a Windows desktop client that allows you to use your 
computer for messaging instead of your phone. 

Chat 
Many social networking sites (such as Facebook or Google+) include built-in “chat” or “messenger” features, 
and accordingly, most instant messaging clients allow you to connect to and exchange messages with the 
people you know on social networks. 

Additionally, many instant messaging and chat clients are associated with online services, such as a web-
based email account (such as a Gmail or Outlook.com account). This association allows you to log into your 
email account and launch the web-based chat feature from within your mailbox. 

You can type text, copy and paste hyperlinks into messages, and send picture files with your chat messages. 
Gmail chat even lets you draw and send freehand images with your chat messages. You can also send chat 
messages to a contact who is not currently online. Your recipient will see the message the next time he or 
she signs in. In this way, a chat service is similar to email; you can send messages to people who are not 
currently online. 

Using Gmail Chat 
Gmail includes built-in chat features that you can use, and chat sessions take place on the Google Hangouts 
platform. The chat “roster” appears on the left side of the page below your name. In order to engage in “real 
time” chat, you and the person with whom you want to chat must be logged into Gmail. A green circle in the 
chat roster indicates that a contact is logged in. (If your intended recipient is not logged in, you can send a 
message to your offline contact, and that message will be seen the next time he or she signs in). 

The roster stores previous chat sessions, and you can click one to open it and pick up a conversation where 
you left off. 
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If you have not used Gmail chat before, the chat roster will be empty. To start a new chat, click the 

 (Search) button and type the name or email address of the person you want to chat with. The first time 
you chat with a particular contact through Gmail, you will need to send a chat invitation. 

Depending upon the other person’s prior activity on Google, various options may be presented when you 
try to open your first chat session, and you may need to investigate icons on the screen in order to invite 
that person to chat with you. 

In the following figure, Fred has searched for cciethyl@gmail.com. When he clicks her contact info in the 
search results, he is prompted to send an invitation. 

 

 

Fred can simply click Send Invite to invite Ethyl to chat with him on 
Google Hangouts. He will receive confirmation that the invitation 
was sent, and then he must wait for Ethyl to accept the invitation. 

In the meantime, Ethyl will see a notification in her chat roster that Fred has sent a 
message.  

When she clicks the notification, the invitation displays in the lower-right corner of 
the Gmail window. When she clicks Accept, they can begin chatting. 

 

 

To use the chat window, click in the Send 
a message box, type your message, then 
press ENTER. 

As new messages are sent and received, 
previous messages scroll up in the 
window 
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Exercise 5-8: Using Gmail chat 
For this exercise, your teacher should divide the class into teams of two. The other person on your team will 
be your partner. Decide who will be Student A and who will be Student B. In this exercise, you will use the 
Gmail chat feature to chat with your partner. 

This exercise assumes that you have installed the Google Chrome web browser, as Gmail is designed to work 
best with Chrome. You can use Internet Explorer or Microsoft Edge, however you may need to adjust the 
steps. For example, you will need to navigate to the Gmail sign-in page; these browsers will not display a 
Gmail link in the upper-right area of the window. 

1. Double-click the Google Chrome shortcut on the Desktop to open the Chrome browser. Click the Gmail 
link that displays in the upper-right region of the browser window to access the Gmail sign in page. Sign 
into Gmail. You should be looking at your Gmail Inbox. 

2. Student A: Click the search button that appears to the right of your name in the chat roster to open the 
search box. 

3. Student A: Enter your partner’s email address into the search box, and click his or her contact info in the 
search results.  

4. Student A: When the chat invitation displays at the lower-right corner of the window, click Send Invite. 
You should see a confirmation that your invitation was sent. You must now wait for your partner to 
accept the invitation. 

5. Student B: When you see a notification in your chat roster that your partner has sent you a message, 
click the notification to open the invitation. 

6. Student B: In the invitation, click Accept.  

7. Student A: Click in the Send a message box, type a brief message, then press ENTER. Your message 
appears in your chat window and in your partner’s chat window. 

8. Student B: Type a response, then press ENTER. 

9. Everyone: Exchange several messages. 

10. Everyone: Close the chat window. 

11. Student B: In your chat roster, click the conversation with your partner to re-open the chat window. 
Notice that the entire thread of the conversation is preserved. 

12. Student B: Type and send a new message to your partner.  

13. Student A: Click the conversation with your partner in your chat roster. Notice that when the window 
opens, the new message from your partner displays at the bottom of the window.  

14. Everyone: When you are finished using Gmail chat, close the chat window, sign out of Gmail and close 
your browser. 
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Instant Messaging 
Sometimes referred to as IM, this type of electronic communication allows two or more participants to 
"converse" with one another in real time by typing messages in the window of an instant messaging program. 
Instant messaging programs such as Skype, ICQ, or Yahoo! Messenger enable people to chat with each other, 
regardless of where they are located. For example, two participants may be working on different floors of the 
same office building, and they can type messages back and forth to one another as a means of real-time 
communication.  

Most instant messaging programs allow for group conversations, so our two participants could easily add in 
a third participant who might be working in an office across town. Instant messaging is a very useful means 
of communication to use when an answer is needed quickly. 

In order to use an instant messaging program, you must create an account with a username and password. 
In the early days of instant messaging, you were required to download and install the program in order to 
use it. Today, most instant messaging clients include a web-based version, allowing you to sign in and use 
the program from any computer (regardless of whether the client is installed on the computer you are using).  

Using Skype 
Skype comes in both business and consumer versions. Skype for Business lets you add up to 250 people to 
an online meeting and is integrated into Microsoft Office apps, allowing you to schedule online meetings 
from Outlook. It costs $2 per month per user. Skype for consumers is free. 

Because Microsoft owns Skype, you can sign into Skype using a Microsoft account, and you can open instant 
messaging sessions from your Outlook.com inbox and exchange messages with your contacts as long as you 
and your contact have Skype accounts.  

You can also create a Skype account independent of a Microsoft account, and you can log in to Skype using 
your Skype name. 

 
You can download and install the Skype for Windows client from the Skype web site, and then sign in to the 
service. 
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Exercise 5-9: Creating an account & installing Skype 
In this exercise, you will sign up for a Skype account, and then download and install Skype for Windows. 

First, create a Skype account. 

1. Open the Internet Explorer browser and navigate to: https;//login.skype.com.  

2. Click Create new account to access an online form for creating a Skype account. 

3. Fill in the required fields along with the security code requirement at the bottom of the page. Then click 
I agree - Continue. You should now be viewing your Skype account page, which includes a welcome 
message with your first name. Your account has been created.  

4. Be sure to record your Skype name and password. 

Next, download and install the Skype client. 

Note: Your teacher may have already installed Skype on the classroom systems. If that is the case, press the 
Windows key on your keyboard, type: Skype, then click Skype for Desktop in the Search results pane to 
open the Skype sign-in window, and then skip to Step 12. 

5. In the welcome page, click Download Skype for Windows. (Notice that you can elect to download 
Skype for other devices – there are versions for PCs, mobile phones, tablets, home phones, television, 
Xbox, etc.). 

6. In the message bar that appears across the bottom of the window, click Save. 

 
7. When the message bar changes, click Run. 

 
8. Click Yes in the User Account Control dialog box to allow the program to be installed. (Or enter an 

administrator user name and password.) 

9. When prompted, select your language, then click I agree – next. 

10. You can elect to install Skype Click to Call, which is a browser add-in that allows you to click phone 
numbers on web pages in order to automatically place a call. For now, clear the Install Skype Click to 
Call check box, then click Continue. 
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11. You can elect to make Bing your default search engine and make MSN your home page. Clear the check 
boxes for these options, then click Continue. It may take a few moments for the installation to proceed, 
after which the sign-in screen appears. 

Sign in to Skype. 

12. Click in the Skype name, email or mobile box and type your Skype name, click in the Password box and 
enter your password, then click Sign in.  

13. If this is the first time you are signing into Skype, or if you have signed in before but have not configured 
your account, you will be presented with a series of configuration dialog boxes. Click Continue to 
proceed with the configuration. 

14. Click Test sound to make sure you can hear. 

 
15. Speak to check your microphone. 

 
16. You can use the Video drop-down list to select a camera. Make sure you can see yourself in the video 

area. 

17. Click Continue. You are prompted to add a profile picture. A profile picture displays next to your name 
when you are in an instant messaging session or anytime you are engaged in communication and your 
video is turned off. A profile picture can also help your friends locate you in the Skype directory. You can 
use a web cam or integrated camera to take a picture, or used a stored image file. You can add a profile 
picture now, or later. 

18. Click Add later. The final setup screen displays: 

 
19. Click Start using Skype to view the Skype home screen. 

20. Minimize the Skype window, and close the browser. 
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Adding Contacts 
To send instant messages in Skype, you need to add people to your Contact list.  

In the menu bar in the Skype window, click Contacts, point to Add Contact, then click Search Skype 
Directory to open the Search field. Enter the Skype name (or email address or mobile number) of the person 
you want to add then click the Search Skype button. The results display below the Search field.  

  

In the Search results, click the contact you want to add. The contact information displays in the central pane 
in the Skype window along with information about whether this person is in your Contacts list. 

 

Click Add to Contacts to open an invitation. You must invite your 
intended contact before you can add him or her to your Contacts 
list. 

 

Notice that you can replace the boilerplate text with a message 
of your own. Click Send to send the invitation. A received 
invitation (shown in the figure) will appear in your recipient’s 
Recent tab. 

 
 

When you receive an invitation, click it to open it in the 
Skype window. 

Click Accept to share your contact details. Once you accept, 
you are added to the requestor’s Contacts list, and that 
person is added to yours. You can now exchange messages. 
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Exercise 5-10: Adding Skype contacts 
In this exercise, you will add your partner as a contact in Skype. Decide who on your team will be Student A 
and who will be Student B. 

1. Everyone: Restore the Skype window. 

2. Student A: In the Skype menu bar, click Contacts, point to Add Contact, then click Search Skype 
Directory to open the Search field. 

3. Student A: Enter the Skype name of your partner, then click the Search Skype button.  

4. Student A: In the Search results, click your partner’s Skype name. The contact information displays in 
the central pane in the Skype window. 

5. Student A: Click Add to Contacts to open an invitation, then click Send to send the invitation. 

6. Student B: After a few moments, you should receive the invitation your partner sent. If necessary, click 
the Recent tab to view your new communications. The pending request should appear in the Recent 
pane. 

7. Student B: Click Accept to share your contact details. You are now added to your partner’s Contacts list, 
and your partner is added to yours. You can now exchange messages.  

8. Everyone: Minimize the Skype window.  

Exchanging Instant Messages with Skype 
You use the message area at the bottom of the Skype window to communicate with your contacts.  

 

Click in the box, type your message and press ENTER or click (or tap) the  (Send) button.  As with Gmail 
chat, as messages are sent and received, they scroll up in the message window. 

 
Notice the via Skype setting above the message box. You can send SMS (text messages) to mobiles from 
Skype if you have Skype Credit. Click via Skype and change the selection to SMS. If your contact has not 
saved a mobile phone number in their profile, you'll see the option to enter one. Select the country from the 
drop-down, type the phone number and click the checkmark. 
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Type your text message into the message box and click the Send icon. You'll see the  icon next to your 
message when it's been delivered successfully.  

You are not limited to sending simple text messages with Skype; you can use Skype to send images, 
document files, videos, contact cards, and emoticons and Mojis. (Mojis are short video clips you can use to 
express yourself.) 

If the  (More) icon displays in the message area, click it to access the additional tool buttons: 

Send image  

Send file  

Send Video Message  
Send contacts  

Insert emoticon or Moji  

When you send a file or image through Skype, you use the Send File to dialog box to navigate to and select 
the file you want to include with your message, similar to inserting an attachment to an email message.  

The first time you are sent a file, you must specifically accept the file before it will be downloaded to your 
system. You accept the file by clicking the download file icon that appears in the Conversation window. A 
download file icon for an Excel workbook is shown in the following figure. 

 
When you accept the first file through Skype, you can then specify whether you want to receive files 
automatically when they are sent to you.  

 
Although sending files over Skype is safe, you may still want to make a decision on a case by case basis, 
depending on who is sending you a file. Additionally, when you accept files on a case by case basis, you can 
specify where you want to save them. 

Be very careful not to share or give out passwords or credit card numbers in an instant message. Exchanges 
made through instant messaging programs travel across the Internet, and these communications are not 
always secure.  
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Exercise 5-11: Exchanging messages in Skype 
In this exercise, you will use Skype to exchange instant messages and files with your partner. Be sure your 
partner is included in your Contacts list. If not, add your partner to the list before beginning the exercise. 
Decide who will be Student A, and who will be Student B.  

1. Restore the Skype window. 

2. Student A: Click the screen name for Student B in your Contacts list, then click in the Conversation box, 
type a short message and press ENTER.  

3. Student B: Your partner’s screen name should appear highlighted in your Contacts list because your 
partner has just sent you a message. Click your partner’s name to view the conversation if necessary. 
Click in the Conversation box, type a reply and then press ENTER.  

4. Exchange a few messages back and forth. 

Now use Skype to send a file. 

5. Student A: Click the Send file button at the bottom of the window (or the More button to expand the 
menu options if necessary) to open the Send file to ... dialog box. Navigate to the 7500 Student 
Files/Software folder, then double-click Budget 2016 to send the file to your partner.  

6. Students B: Click the download file icon in the Conversation window to download the file. 

7. Student B: Click No, thanks to specify that you do not want to receive files automatically. You are now 
asked whether you want to accept this specific file. Click OK. The Save dialog box opens, allowing you 
to specify where you want to save the file. Navigate to the desktop, then click Save. Once the file has 
finished downloading, the file icon displays in the Conversation window.  

  
8. Student B: Double-click the file icon in the Conversation window. The spreadsheet file opens in Excel. 

You can open files directly from the Conversation window.  

9. Student B: Close Excel. 

10. Student B: Right-click the file icon in the Conversation window, then click Show in folder. Skype keeps 
track of where you save your received files. 

11. Student B: Close the File Explorer window. 

Now, send a photo through Skype. 

12. Student B: Click the Send image button at the bottom of the window (or the More button to expand 
the menu options if necessary) to open the Send file to ... dialog box. By default, the current location is 
the Pictures folder. Navigate to the 7500 Student Files/Software folder, then double-click wild violet to 
send the file to your partner.  

13. Student A: Click the image in the Conversation window to open it in Windows Photo Viewer. Close the 
photo viewer window. 
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14. Student A: Right-click the image in the Conversation window, then click Save As to open the Save dialog 
box.  

15. Student A: Navigate to the desktop, then click Save to save the picture file on the desktop. 

16. Everyone: Click Skype in the Menu bar, then click Sign Out.  

17. Everyone: Right-click the Skype button in the taskbar, then click Quit Skype, then click Quit to confirm. 

Lesson Summary 
In this lesson, you learned to obtain, install, manage and configure software. You also installed and managed 
Windows apps and used messaging applications. You should now be able to: 

 describe the benefits of software 

 install, uninstall, repair and update apps and applications 

 set software preferences 

 work with Windows apps 

 use messaging applications 

Review Questions 
1. Which of the following is true of locally-installed software? 

a. It is installed and runs directly on your device. 
b. It is streamed to your device whenever you use it. 
c. It is hosted in the cloud. 
d. It is automatically updated. 

2. Which of the following defines what you can do with the software you have purchased? 
a. An End User License Agreement (EULA). 
b. The Software Assurance Agreement Services (SAAS) regulation. 
c. The Windows Registry. 
d. The Fair Use Act. 

3. What is the best way to remove a software program from your system? 
a. Use the Uninstall a program command in the Control Panel. 
b. Delete any files related to the software using File Explorer. 
c. Remove the app from the Start menu and tiles. 
d. Use a third-party program to uninstall the program. 

4. Why should you register your software when you install it? 
a. To ensure you receive notification of available updates. 
b. To ensure that you receive marketing materials from the software vendor. 
c. All users are required by law to register any and all installed software. 
d. To ensure that you can get a free version of the next major upgrade. 
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5. If you need to repair a Microsoft Office program, which option completely uninstalls and then reinstalls 
the software? 
a. Quick Repair 
b. Online Repair 
c. Neither option uninstalls and then reinstalls. 
d. Both options uninstall and then reinstall; one is just faster than the other. 

6. Which of the following is an example of configuring an application program? 
a. Setting a default save location and customizing toolbar buttons. 

b. Making an adjustment in the Control Panel that tells the operating system to run the program in 
compatibility mode so that the application works smoothly. 

c. Making an edit to the Windows Registry so the application starts immediately after the Desktop 
displays. 

d. Using your Microsoft ID to log in to your computer instead of using a local log in account. 

7. What do you need to do before you can download or install apps from the Windows Store? 
a. Sign in with a Microsoft Account. 
b. Update your operating system. 
c. Open an Outlook.com email account. 
d. Create an account on the Windows Store. 

8. What was the original size limit for messages sent via SMS? 
a. 160 characters c. 160 KB 
b. 16 KB d. 16 MB 

9. Which of the following is true regarding Gmail chat? 
a. Chat sessions take place on Google Hangouts. 
b. You cannot use the chat feature from within Gmail. 
c. You must download and install the G-Chat desktop client before you can use Gmail chat. 
d. Messages that you send in Gmail chat are limited to 160 characters. 

10. Which of the following items can you send in a Skype instant message? 
a. You can send all of these items via Skype. 
b Document files and images. 
c. Video messages. 
d. Contact cards and Mojis. 
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Computing Fundamentals 
 
 

Lesson 6: Cloud Computing 
Lesson Objectives 
In this lesson, you will learn about cloud computing. Upon completion of this lesson, you should be able to: 

 understand the benefits and characteristics of cloud 
computing 

 create and use cloud accounts to store, manage, and 
share files 

 describe different types of cloud applications 

 configure mobile notifications 

Cloud Computing Concepts 
Objective 1-6.1, 1-6.2, 1-6.3, 1-6.4, 1-6.5 

Cloud computing is a phrase that is used today to refer to a number of different scenarios in which a 
computing resource, such as a storage location or software, is delivered as a service over the Internet. 

Note: Historically, the Internet has been represented in all manner of diagrams as a cloud. (A cloud is 
remote – off in the distance somewhere – and its contents are generally unknown.) The word “cloud” today 
refers to almost any type of computing that takes place over the Internet.  

In networking, there are client systems (those systems which request services and access to resources) and 
there are server systems (those systems that supply services and grant access to resources). In order to 
maintain a network on their own premises, organizations typically invest thousands and thousands of dollars 
in server systems, server software, and trained IT staff.  

However, because high-speed broadband connections are available almost everywhere, network resources 
and functionality can be delivered quite efficiently and inexpensively over the Internet. Accordingly, 
companies such as Google, Apple, Microsoft and countless others successfully provide hosted services to 
millions of users. 

A hosted service is provided by a server located outside your own network. That is, for example, instead of 
maintaining its own email server, a company can pay for email services hosted on a Microsoft server.  Or, 
instead of maintaining its own file server, a company can pay for file storage locations hosted on a Google 
server. For a monthly fee (subscription) companies can carry on business using modern software and 
hardware without having to purchase and maintain the necessary resources.  

  



Lesson 6 Cloud Computing 
 

 

180  7500-1 v1.00 © CCI Learning Solutions Inc. 

There are three basic models for hosted services: 

Software as a Service (SaaS) – this is the most commonly used model. SaaS is a software delivery model in 
which applications are hosted by a provider and made available to customers over a network connection. 
Many web applications are delivered in this way: Gmail and Office 365 are examples of consumer-targeted 
SaaS. Many organizations use accounting, invoicing, sales, learning management, and customer relationship 
management (CRM) software through SaaS. 

Infrastructure as a Service (IaaS) – virtualized computing resources (such as server space, storage space, 
network connections and pools of IP addresses) can be leased and accessed as services.  

Platform as a Service (PaaS) – an extension of IaaS, PaaS provides developers with environments in which 
to build applications. PaaS models include the software and configurations required to create the platform 
on which developers can create apps and the platforms on which clients would access those apps.  

Benefits of Cloud Computing 
Cloud computing provides several benefits for individuals and organizations alike. These benefits include: 

• Reduced hardware costs – in order to use hosted services, you need an Internet connection and a 
browser. Organizations can distribute lower-end PCs, laptops or Chromebooks to their workforce and 
the employees can remain productive. 

• The latest versions – when you subscribe to a hosted solution for software, you always get the latest 
version of the software when you sign in. This is much easier than updating your software each time a 
security update or feature enhancement becomes available. 

• 24/7 access – hosted services are always available as long as you have access to a live Internet connection. 
That means, you can sign in any time from any place on any device that can access the Internet. The only 
time a hosted service is not available is when there is a problem at the provider’s end. Hosting providers, 
however, aim to be available 99.999 percent of the time. This type of availability (called “five nines”) 
equates to less than 5.26 minutes per year of downtime. 

• Scalable storage capacity – cloud services are associated with cloud storage space. That is, you have 
access to a certain amount of open storage space on a hosted server. Often, the first several gigabytes 
of space are free, but you can lease additional storage capacity as your needs change. 

• Local access to user files – most hosted services make provision for storing a local, synchronized copy of 
all your user files stored in the cloud. This ensures that you have access to the latest version of your files 
even when Internet service may not be available. (Once Internet service is restored, synchronization can 
resume and changes you made to the local copy will be uploaded to the cloud storage location.) 

• Built-in backup – hosted service providers back up their servers continuously. Storing your files on a 
hosted server is perhaps the safest method of backup available to consumers. 

• High security – hosted service providers maintain an ultra-high level of security on their systems. As long 
as you keep your account and password private, your data is safe and secure in a cloud location. 

Accessing Hosted Services  
To access a hosted service, you open an app and sign in to the service. Sometimes, you sign in using a local 
app (that is, an app which you download and install on your device) and sometimes you sign in using a web 
app (which is an app that runs in a browser). 
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One of the things that makes cloud computing so appealing is the ability to access your hosted services 
(storage, software, and so on) from a variety of platforms and devices. No matter which device you to use to 
access your hosted services, the interface looks similar whether it is presented in an application window or a 
browser window on a PC, or in an app window on a mobile device. You can use various types of apps: 

Desktop apps – present the user interface within an application window and generally provide the most 
complete feature set.  

Browser apps (web apps) – present the user interface inside a browser window and may include a little less 
functionality than the desktop version of the app. Usually, these provide enough functionality to keep users 
productive. 

Tablet apps – present the user interface inside an environment designed to harness the features of the tablet 
(touchscreen interface and fairly large screen size). You would probably access a service through a tablet app 
to check on information, or to make quick, small modifications. 

Smart Phone apps – present the user interface inside a relatively small app window. The interface is stream-
lined and scaled down to offer the most important features.  

In most cases, once you sign in through an app, the app will remember your sign in information, making it 
faster and easier to access the service the next time. 

Connectedness is Key  
Perhaps the most key component of cloud computing is the ability to connect multiple devices to a single 
account. That is, by downloading and launching the appropriate apps, you can connect your PC, laptop, 
phone and tablet to the same cloud account and set your devices to automatically synchronize or “sync” with 
the cloud. When devices are synced with a cloud folder, the same data is contained in both locations. 

This means, for example, that you can configure your smart phone to automatically upload pictures and video 
to a cloud account. The same pictures and video that reside on the smart phone are contained in the cloud 
location as well. Not only does this provide an automatic backup of your personal files – it also gives other 
connected devices access to those files. For instance, you can take a video on your smart phone and then 
play it on your laptop. 

You can use cloud computing to keep all your devices connected and synchronized with one another, and 
to stay connected with your data any time and from practically any location. 

Cloud Accounts 
Objective 1-5.1, 1-6.1, 1-6.3 

Remember that in cloud computing, resources and services are hosted off-site; they are hosted in the cloud 
(on a server somewhere on the Internet). In order to access these hosted resources and services you need an 
Internet connection and a cloud account.  

All cloud-related services (software, web apps and storage space) are associated with a particular cloud 
account. For example, a Google account includes Gmail, storage space on Google Drive, and access to Google 
web apps such as Maps, Calendar, YouTube, the Google Play Store, Google Hangouts and more. You can 
create one account that is linked to all the related services. Additionally, you can connect several devices to 
your account and download and install the associated apps onto those devices. You can also share files 
among all your devices using your cloud account. 
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You must create a cloud account before you can use cloud technology. Once you sign in to your account, 
you can access the services and files associated with it.  

Most hosting providers offer both consumer and business-grade hosting solutions, and in many cases, 
consumer solutions are offered free of charge. Consumer accounts generally provide the same basic features 
(regardless of the provider): 

• Cloud storage space 

• Apps to connect multiple devices to your account 

• Apps to keep all your devices synchronized 

• Provision for offline access 

• The ability to share files through web links 

• The ability to upload and download files to your storage location 

• Automatic backup features 

• Automatic photo and video uploading features 

• Web apps to work with documents and folders 

• Ability to collaborate on files 

Cloud Account Management 
As you can imagine, there are many facets to cloud accounts, and accordingly, most provide a central place 
from which you can manage your account. In Google, this central location is the My Account page. 

 
From this page you can manage your account and sign in settings, track your log in activity, control connected 
devices, edit your personal information, add account recovery information, see how much of your allotted 
storage space you are using, set your account preferences, and more. 

To access the My Account page (or any of the Google services) log into a Google service (such as Gmail), 
click the  (Apps) icon in the upper right corner of the window to open the Google Apps menu, and click 
My Account. You can also log in at: https://accounts.google.com to sign in to the My Account page. 

https://accounts.google.com/
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Exercise 6-1: Managing your Google account 
In this exercise, you will explore options associated with your Google account.  

Note: This exercise assumes that you created a Gmail account and installed the Chrome web browser as 
directed in the previous lesson. If you have not done so already, do so before proceeding. 

1. Open the Chrome browser and navigate to https://accounts.google.com. Enter your Gmail address in 
the box provided, click Next, and then enter your password and click Sign in. (If the page already displays 
your email address, click in the password box, enter your password, and click Sign in.) 

2. You should be on the My Account page. If you are not, click the Google apps icon, then click My 
Account. 

3. Under Personal info & privacy, click Activity controls and scroll the page. Did you have any idea that 
you could maintain and research your browsing and search history, your location history, your video 
watching history and your video searching history? Did you know you could use voice controls and access 
information stored on your devices? 

4. Under Account preferences at the left side of the page, click Your Google Drive storage to view 
information on how much of your free cloud storage you are using. 

5. Under Sign in & security, click Device activity & notifications to see a list of devices you have used to 
sign in to your account (and when). 

6. Spend several minutes exploring the links on this page. Take note of all the facets of your account that 
you can control, but do not change any settings at this time.  

7. When you are finished, click the My Account link at the upper-left area of the window to return to the 
main My Account page.  

8. Minimize the browser window. 

Cloud Storage on Google Drive 
Cloud storage is safe, secure, and accessible from anywhere on any device with an Internet connection. 
Different providers offer varying amounts of free storage, and all provide options for purchasing additional 
storage.  

The cloud storage associated with a Google account is (interchangeably) called “Google Drive” or simply, 
“Drive.” Drive currently provides 15GB of free storage.  

Accessing Your Cloud Drive 
To access Google Drive, sign in to your Google account, click the Google apps icon to display the Google 
Apps menu, then click Drive. The first time you access Google Drive, you may be greeted by introductory 
information. 
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You can click the Close button in the upper-right corner of the introductory PDF to close it, or you can click 

 to view the introductory information, then click the Take me to Drive button to exit the PDF slide show. 

Uploading Content  
Because Drive is a cloud location, you copy content into it by uploading files. Uploading is the process of 
moving data from your device, across a network, to a server.  

Note: Drive includes integrated web apps which you can use to create content directly in the cloud. You 
will use these in an upcoming lesson in the Key Applications module. 

You can use the built-in commands to upload files and folders. To upload one or more files, click NEW, File 
upload and use the Open dialog box to select file(s) to upload. To upload an entire folder, click NEW, Folder 
upload, then navigate to and select the folder using the Browse for Folder dialog box.  

 

 

If you prefer, you can drag and drop files from File Explorer into the Drive window.  

Working with Content on Drive  
A command bar displays at the top of the Drive window. 
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You can use the buttons on the command bar to change the view. You can display items in a list or grid view; 
sort by various properties; display details about specific files and folders, or about your recent activity on 
Drive; and access the Settings page for Drive. 

When you select a file or folder in Drive, a toolbar displays in the command bar. 

 
Use the buttons on the toolbar to generate a link for sharing; share a file with 
specific people; preview a file; or remove a file from Drive.  

You can also click the  (More actions) button to access a menu of other 
options. 

Organizing Content on Google Drive 
The “root” folder on Google Drive is named My Drive. You can create folders in 
My Drive and move files into the folders just as you can in File Explorer. Click the 
NEW button, then click Folder. Type a name for the new folder, then press ENTER. 
You can then drag and drop files into the folders you create. 

 
You can also use the Move to command to organize your content.  

 

Right-click a file, or select a file and click More actions, then select the 
Move to command to open a dialog box you can use to move files into 
(or out of) folders. 
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Downloading Content 
To copy files from Drive to your computer, you download them. Downloading is the process of copying 
content from a server, across a network, to your device. To download content from Drive, select the file(s) 
you want to download, click More actions, then click Download. In Chrome, a button will appear at the 
bottom of the window when the download is complete. 

 
Files are automatically saved in the Downloads folder. Click the button to open the file. Click the arrow at the 
right of the button to access options for opening the file, specifying to always open that particular file type 
when downloading, or showing the file in its current folder location. 

Note: If you are using Internet Explorer instead of Google Chrome, use the buttons in the notification bar 
that appears at the bottom of the window to specify whether you want to open or save the file, and to 
specify a location for saving the file. 

Exercise 6-2: Working with content on Drive 
In this exercise, you will upload, organize, and download content on Drive. 

1. Restore the browser window. You should be signed in to your Google account. 

2. Click the Google apps icon, then click Drive. Chrome opens a new tab and displays your My Drive 
storage area. 

3. If necessary, view the introductory information, then click the Take me to Drive button to exit the PDF 
slide show. 

4. If a Get notifications on your computer message displays, close it. 

First, upload files using the built-in commands. 

5. Click the NEW button at the top of the left pane, then click File upload to open the Open dialog box. 

6. In the dialog box, navigate to the 7500 Student Files\Cloud Data folder, select the first six items displayed, 
then click Open to upload those six items to Drive.  

7. Click the Close button in the 6 uploads complete window to dismiss the message. 

8. Click My Drive at the top of the window, then click Upload files to open the Open dialog box again. 

9. In the Cloud Data folder, double-click Mobile Devices Info to upload the document to Drive. 

10. Close the upload complete window. 

Next, drag and drop a file into Drive. 

11. If the Chrome window is maximized, click the Restore Down button. Then in File Explorer, navigate to 
the 7500 Student Files\Cloud Data folder. 

12. Restore the File Explorer window if it is maximized, then position the two windows so that you can see 
the contents of both on your screen. 

13. In the File Explorer window, click the RockBand file, then drag it into an empty area in the Drive window, 
and release the mouse button. The file is uploaded to Drive. 
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14. Close the upload complete window, then maximize the Drive window. 

Now, create a folder for the slide shows and move a file into it. 

15. Click NEW, then click Folder, type: Slides, then press ENTER. You have created a folder on Drive. 

16. Click the Embedding Fonts file, drag it over the Slides folder, then release the mouse button. You have 
moved the file into the Slides folder. 

17. Double-click the Slides folder to move into it. The presentation file is here. 

Now move the presentation file back to the My Drive location. 

18. Click the Embedding Fonts file, click the More actions button, then click Move to. A dialog box opens 
that shows the file’s current position in the Slides folder. 

19. Click the Back arrow that displays to the left of Slides to change the displayed location to My Drive, then 
click the Move here button. The file is moved back to the My Drive location. 

20. Click My Drive in the path that displays at the top of the window to move back out to the My Drive 
location. 

Delete the Slides folder. 

21. Click the Slides folder to select it, then in the toolbar at the top of the window, click Remove. The Slides 
folder is removed. 

Now download a file. 

22. Click Animals.xlsx in My Drive, click the More actions button, then click Download. A button with the 
file name displays in the lower left corner of the window when the download is complete. 

23. Click the Animals.xlsx button to open the file in Excel. 

24. Close Excel. 

25. Minimize the browser window. 

Apps for a Local Folder 
Like most other cloud storage services, Drive includes an app that you can download and install on your PC 
that adds a local Google Drive folder to your File Explorer window. This folder is linked to your My Drive 
location, and is set for automatic synchronization. 

This means that you can simply drag files into the local Google Drive folder on your PC and those files will 
be automatically uploaded to your My Drive folder.  

You can download apps for your phone and tablet too, which will allow you to get to your files easily from 
any device. You can also configure these devices to automatically upload files (such as photos) to My Drive. 

You can download and install the app right from the Google Drive window in your browser. The installation 
process may add shortcuts for Google Docs, Google Drive, Google Sheets, and Google Slides to your Desktop. 
Once you receive a message that the installation is complete, you finish setting up Drive for PC by launching 
the Google Drive app. You are greeted by a welcome wizard that will guide you through the setup process.  

Google Drive also adds an icon to the notification area in the taskbar. You can click it to see synchronization 
status and to access your Google Drive folder. 
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The default location for your Drive folder is: This PC\OS (C:)\Users\<your name>\Google Drive. You may also 
be able to access your Drive folder from the Quick access area of File Explorer. 

 

Exercise 6-3: Using Drive for PC 
In this exercise, you will install the Drive for PC app, then drag files into the local folder to see that they are 
automatically uploaded to My Drive in the cloud. 

Note: You must be logged on with an administrator account to install apps. If you are logged on as a 
standard user, you will be prompted to enter a user name and password for an administrator account. Ask 
your teacher for assistance if necessary. 

First, you will download and install the app. 

1. Restore the browser window. 

2. In My Drive, in the left pane, click Get Drive for PC to go to the download page. 

3. On the download page, click Download for PC, read the terms of service, then click Accept and Install. 
Chrome displays a googledrivesync.exe button in the lower-left corner of the window. Click it to begin 
the installation. 
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4. If prompted, click Yes in the UAC (or enter an administrator user name and password), wait as the app 
downloads and installs itself, then click the Close button in the Installation complete message. 

5. Minimize the browser window, then click Start, then click All apps. The newly installed Google Drive app 
should appear at the top of the Start menu. Click Google Drive and wait a few moments to see the 
welcome message. 

6. Click Get Started, then sign in using your Gmail address and password, and click Next as required to 
make your way through the introductory information. When you reach the end, click Done. File Explorer 
opens to show you the contents of your local Google Drive folder. 

7. Click the Google Drive icon in the notification area of the taskbar. (If the icon does not display, click the 
Show hidden icons button, then click the Google Drive icon in the gallery that appears.) A panel 
appears showing the synchronization status and file contents of your local drive folder and your My Drive 
cloud folder. 

Now, add a file to the local folder to have it automatically uploaded to My Drive. 

8. In File Explorer, navigate to the 7500 Student Files\Software folder (from the previous lesson), then copy 
the npp.6.9.1.Installer executable file.  

9. Paste the copied file into your local Google Drive folder, and display the synchronization status by 
clicking the icon in the notification area. You should be able to watch as the file is uploaded.  

10. Restore the browser window. Close the tab for the download page if necessary. You should be looking 
at your My Drive page. You should see the executable file in your My Drive folder. Press F5 to refresh the 
view if necessary. 

11. Sign out of Gmail, then close the browser. 

12. Close any open File Explorer windows. 

Sharing Cloud Files  
A key advantage of using cloud storage is the ability to share files without having to send them. This makes 
collaboration with classmates or coworkers easy and convenient. You might have noticed that it took a little 
while to upload the Notepad++ executable file, because it is 4MB in size. Many files (such as audio and video 
files) are considerably larger, making them problematic to send as email attachments. Additionally, 
executables and certain other types of files (such as databases) are blocked as file attachments in most email 
programs. 

However, if you wanted to share this executable with another user, you could send a sharing link to that user. 
A sharing link is a hyperlink you can send in the body of an email message. The recipient clicks the link and 
can access the file or folder on your cloud drive that you want to share.  

You can share Google Drive files and folders with people and specify whether they can view, edit, or comment 
on them. You can specify three levels of access: 

• Can edit – others can make changes to your file and share the file with others. This is the default setting 
when you share a file with specific people. 

• Can comment – others can view and comment on a file but not make changes. Note that you cannot 
comment on a folder. 
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• Can view – others can open a file but not change it or comment on it. This is the default setting for link 
sharing. 

To share with specific people: 

1. Select the file you want to share, then at the top of the window click  (Share). 

  
2. Under People, type the email address of the person you want to share with. A text box opens below the 

address box, allowing you to type a note. 

3. To change the access level, click the down arrow beside the Can edit box and make a selection. 

4. Click Send. The person you shared the file with will get an email letting him or her know that you have 
shared a file or folder.  

  
 The recipient can click the link in the email message to open the location where the file is stored on your 

cloud drive. From there, he or she can access options to open the file, download the file, share the file, 
and so on. 

 To share more than one file, move the files you want to share into a folder and then share the folder. 

To share using a sharing link: 

You can share a file with multiple people without typing in their individual email addresses in My Drive by 
creating a link that allows anyone (who has the link) to open the file. 

1. Select the file you want to share, then at the top of the window click  (Get shareable link). 
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2. When the green light is on, and the shareable link is selected and underlined, it can be copied to the 

Windows clipboard. Press CTRL+C to copy it. 

3. Paste the link into an email (or into a chat message or text message) and send it to whomever you like. 
The documents will be “read only” unless the person is signed into a Google account. 

 To stop sharing, select the file again, click Get shareable link, and click the green light to toggle sharing 
off. 

To share a file or folder publicly: 

When you share files or folders publicly, anyone on the Internet can search for and access your file. 

1. Select the file you want to share, then at the top of the window click  (Share). 

2. In the top right of the Share with others box, click Get shareable link. 

 
3. Click the down arrow next to Anyone with the link can view, then click More. 
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4. Select On – Public on the web, then click Save. 

  
5. Specify the level of access you want to grant, click Save, then click Done. 

Google Drive Mobile Apps 
You can download and install Google Drive mobile apps for Android and iOS. Installing the apps and signing 
in on your mobile device keeps devices synchronized.  

You can enable automatic uploading of photos and videos that you take on your device by turning Auto 
Backup on. Photos are automatically uploaded to My Drive\Google Photos. 

Microsoft OneDrive 
Objective 1-6.1, 1-6.3 

OneDrive is a cloud storage location as well as a site that provides built-in online office web apps which you 
can use to create, edit, share and collaborate on documents. In the following sections, you will use the cloud 
storage and productivity apps. 

Cloud Storage on OneDrive 
OneDrive provides 5GB of free storage space. Because OneDrive is hosted by Microsoft, a local OneDrive 
folder is automatically available in File Explorer in Windows 10.  

In the cloud, you can access your OneDrive location by navigating to https://onedrive.live.com, and signing 
in with your Microsoft account. 
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The default location is named Files. You can use the items in the left pane for navigation, just as you do in 
File Explorer.  

Uploading, Organizing, and Downloading Content  
A command bar displays across the top of the content area in the OneDrive window. 

 
As you select files or folders, different commands become available on the command bar. You work with 
content in OneDrive in much the same way as you do in Google Drive: 

• To create a new file or folder, click New, then click the appropriate option in the drop-down menu. 

• To upload files, click Upload to open the Choose a File to Upload dialog box. Navigate to and select the 
files you want to upload, then click the Open button. You can also drag and drop files from File Explorer 
into the OneDrive window. 

• To change the view in the OneDrive window, use the buttons at the right end of the command bar. You 
can display items as thumbnails or in a list view; sort by various properties; and display details about 
specific files and folders, or about your recent activity on OneDrive. 

• To select a file, point the mouse pointer at the file until a small circle appears in the upper-right corner, 
then click the circle. The circle turns blue and a white check mark displays inside it  to indicate the file 
is selected. 

• To download a file from OneDrive, select the file, then click Download, then use the buttons in the 
notification bar that appears at the bottom of the window to specify whether you want to open or save 
the file, and to specify a location for saving the file. 

• To delete a file or folder, select it, and then click Delete in the command bar. 

• To move a file, select it and then drag it into a folder. 

• To open a file in its appropriate web app (if available), click the file.  

• To access other options for working with a selected file, click the  Other things you can do with the 
selected items button to display a menu of available options. 



Lesson 6 Cloud Computing 
 

 

194  7500-1 v1.00 © CCI Learning Solutions Inc. 

The Local OneDrive folder 
A local OneDrive folder is built into Windows 10. Add files to the local folder so that you can access them 
from the cloud, and from other devices and still have them on your PC. 

The first time you access the local OneDrive folder in File Explorer you are prompted to set up OneDrive by 
signing in.  

 
Enter the email address associated with your Microsoft account, then click the Sign in button. Enter your 
password when prompted, and click Sign in again.  

The default location for your OneDrive folder is C:\Users\<your name>\OneDrive, but you can change it if 
you want to.  

 
Click Next to continue. 
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The default configuration is to sync all files and folders in OneDrive; however, you can specify to sync only 
particular folders if you want to.  

  
Click Next. 

  
Click Open my OneDrive folder to access the local folder. (Note that OneDrive may launch a browser and 
display a Getting Started presentation which you can click through.) 



Lesson 6 Cloud Computing 
 

 

196  7500-1 v1.00 © CCI Learning Solutions Inc. 

 
Once you have signed in and configured the options, OneDrive will automatically upload and synchronize 
files between your computer and your OneDrive folder in the cloud.  

Exercise 6-4: Using OneDrive for storage 
In this exercise, you will sign into OneDrive, upload files, and activate the local OneDrive folder.  

1. Open the Internet Explorer browser and navigate to https://onedrive.live.com.  

2. Click Sign in, enter the email address associated with your Microsoft account, click Next, enter your 
password, then click Sign in. You are taken to your OneDrive Files folder. You may see a Welcome 
message. If so, click the close button. Your OneDrive folder should include a getting started file, a 
Documents folder, and a Pictures folder. 

Upload a file: 

3. At the top click Upload. The Choose a File to Upload dialog box opens.  

4. In the Choose a File to Upload dialog box, navigate to the 7500 Student Files\Cloud Data folder, then 
click Yard Sale and click Open. The file is uploaded to OneDrive and appears in the browser window. 
(You may need to refresh the screen by clicking F5 in order to see the uploaded file.) 

 
Move the file into the Documents folder. 
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5. Hold the mouse pointer over the Yard Sale document to display a small circle in the upper-right corner, 
then click the circle to select the file. Notice that several options become available at the top of the 
window. 

6. Drag the selected file onto the Documents folder, then release the mouse button.   

Move the file back again. 

7. Click the Documents folder to move into it. 

8. Select the Yard Sale file, then drag it onto Files in the path that displays at the top of the window, then 
release the mouse button. 

9. Click Files in the path to move back out to the Files folder. 

Download a file. 

10. Select the Yard Sale file, then click Download in the command bar. 

11. In the notification bar that appears at the bottom of the window, click the arrow for Save, and select 
Save as to open the Save As dialog box. 

12. In the Save As dialog box, navigate to the Desktop, then click the Save button to save the file to the 
Desktop. 

13. In the OneDrive window, close the notification that the download has completed. 

Delete a file. 

14. Select Yard Sale if necessary, then click Delete in the Command bar.  

Upload files into the Documents folder. 

15. Click the Documents folder to move into it. 

16. Click Upload, then in the Choose a File to Upload dialog box, navigate to the Student Files\Cloud Data 
folder, select the first seven files that display in the list, then click Open to upload the files. 

17. Minimize the browser window. 

Set up your local OneDrive folder. 

18. Open a File Explorer window and click OneDrive in the Navigation pane. If prompted, sign in with your 
Microsoft account (email address and password), and click Next to make your way through the setup 
screens. When the final screen displays, click Open my OneDrive folder. (If your browser opens to 
display the Getting Started presentation, minimize it.) 

19. Within the OneDrive folder, double-click Documents. The seven files you uploaded online are here. 

Now drag a file into the local OneDrive folder and see it online: 

20. In File Explorer, navigate to the 7500 Student Files\Cloud Data folder, and click the logo file to select it. 

21. Drag and drop the selected file onto the OneDrive\Documents folder, then release the mouse button. A 
copy of the logo file is added to the local OneDrive folder. 

22. Restore the browser window. You should see the logo file; if you do not, refresh the browser window. 
The logo file was automatically uploaded to your OneDrive folder in the cloud.  
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Delete another file in the cloud. 

23. Select the logo file, then click Delete in the command bar.  

24. Minimize the browser window, then check the local OneDrive\Documents folder. The logo file is deleted 
from this location as well.  

25. Close File Explorer. 

26. Minimize the browser window. 

OneDrive Web Apps 
Web apps are applications that run on the World Wide Web. These apps do not run directly on a device and 
are not installed; instead, they are accessed over the Internet and provide some of the same functionality as 
installed versions of the software. Microsoft calls these apps “Office Online.” 

With only a browser and an Internet connection you can use online versions of Microsoft Excel, OneNote, 
PowerPoint and Word to read, edit, and create documents, even if you do not have the Microsoft Office suite 
installed on your computer.  

You can click the  (Apps) icon to view all the services that are integrated with your Microsoft account: 

Click one of the online apps to open a new browser tab and 
access templates for specific types of documents.  

 

 

 

 

 

You can also create and work with web apps directly within OneDrive. Click New to display a menu of 
document types that you can create: 

 
Click the app that you want to use to create a new document. As you work in your document, all changes are 
automatically saved to OneDrive. 
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Integration with Desktop Apps 
Even though you can use the office online apps without having the Office suite installed on your system, 
these apps are designed to integrate seamlessly with a locally installed version of Office. Each Office online 
app provides a command that allows you to open your document in an installed Desktop version of the 
application, where you can continue your work. When you save your document, your changes are saved to 
OneDrive. 

Sharing Documents on OneDrive 
As you can with documents on Google Drive, you can share documents on OneDrive by specifying people to 
share with or by generating sharing links. 

When you select Get a link, you generate a sharing link 
that you can copy and paste into email messages, chat 
windows and text messages. These links can be 
forwarded to other users. 

When you select Email, you send an email message 
with a sharing link to specific recipients. The recipient 
must be logged in to the email service in order to access the shared file. OneDrive will authenticate anyone 
trying to access the shared file. 

To share via email, select the file, click Share in the command bar. (You can adjust the permissions by clicking 
the arrow to the right of Anyone with this link can edit this item and clearing the Allow editing check box.)  

Click Email. Enter your recipient’s email address and an optional message, then click the Share button.  

 
When your recipient receives your email message, he or she can click View in OneDrive to open the shared 
document on your OneDrive folder. 
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Exercise 6-5: Using OneDrive office apps 
In this exercise, you will use OneDrive office apps. You will work with your partner from previous lessons. 
Exchange email addresses with your partner in preparation for this exercise. 

1. Restore the Internet Explorer browser window.  

Begin by creating a new word processing document. 

2. Click New, then click Word document to open a new word processing document named Document1 in 
Word Online.  

3. Type: My name is and type your first name. 

4. Press ENTER twice to insert a blank line. 

5. Type one or two sentences about yourself. 

6. Double-click your name, then in the toolbar, click the  Underline button. 

7. At the top of the window, click Document1 to open the field so that you can rename the file.  

8. Select the Document1 text, type: Something About Me, then press ENTER to rename the document. 

9. Close the browser tab for the Something About Me document to return to the OneDrive window. Notice 
that the new file is visible in the folder. 

Now, create a new spreadsheet. 

10. Click New, then click Excel workbook to open a tab with a new, blank worksheet. The rectangle with 
the border around it shows that the current position of the cursor is cell A1. 

11. Type: Calculus, then press ENTER. Excel Online enters the text in cell A1, and moves the cursor to cell 
A2. 

12. Type: Political Studies 1, then press ENTER.  

13. Type: English Poets, then press ENTER. 

14. Type: Business Systems, then press ENTER. 

15. Close the browser tab for the worksheet. OneDrive saves the changes and displays the new worksheet 
as Book1 in the Documents folder. 

16. Right-click the Book1 worksheet, then click Rename in the shortcut menu to open the Rename window. 

 
17. Type: My Classes, then press ENTER to rename the worksheet.  

18. Click My Classes.xlsx to open the worksheet again. Notice that all your changes have been saved. 

Now open the document in the Excel desktop app. 
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19. Click the Edit in Excel command. If you encounter a security warning, click Yes to confirm that you want 
to open the document. The workbook opens in the Excel desktop app. 

20. In cell A5, type: Chemistry, then press ENTER. 

21. Press CTRL+S to save the workbook. 

22. Close the Excel application window. 

23. Close any open message windows. The Excel Online window refreshes. Notice that the changes you made 
in the desktop app are reflected in the workbook in Excel Online. 

24. Close the My Classes browser tab to return to the OneDrive page. 

Now, share a file with your partner. 

25. Select the Something About Me document, then click Share in the command bar.  

26. Click Email, then type your partner’s email address (the one associated with his or her Microsoft account). 

27. Click in the text box below the email address box, and type: Here is some personal information about 
me. Please do not share it with anyone. Thanks! 

28. Click Share to send your message. 

Access a shared document on your partner’s OneDrive folder. 

29. Click the Apps icon to view your Microsoft services, then click Mail to access your Microsoft Inbox. You 
should see an email message from your partner. 

30. Click the email message to open it, then within the email message, click View in OneDrive. Your partner’s 
document should display on your screen in a new browser tab. 

31. At the top of the window, click Edit Document, then click Edit in Browser to open your partner’s 
document in Word Online. 

32. Click at the end of the text your partner has written, press ENTER, and then type a sentence in response. 

33. Close the Something About Me browser tab. 

34. Close the browser tab with the open sharing message. You should be looking at your OneDrive 
Files\Documents folder. 

35. Click Something About Me to open the document in Word Online. You should see the text that your 
partner added to your document. 

36. Close the Something About Me browser tab. 

37. Click the account icon at the upper-right corner of the window, then click Sign out to sign out of 
OneDrive. 

38. Close any open Internet Explorer browser tabs. 

Examine your local copy. 

39. Open a File Explorer window, then navigate to your local OneDrive\Documents folder and double-click 
Something About Me to open the document in Word. Notice that this copy includes the text your 
partner added to your document. Your local OneDrive folder is synced to your OneDrive folder in the 
cloud. 

40. Close the Word application window, then close File Explorer. 
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OneDrive Mobile Apps 
You can download and install OneDrive mobile apps for Android, iOS and Windows 10 Mobile. Installing the 
apps and signing in on your mobile device keeps devices synchronized, and enables automatic uploading of 
photos and videos that you take on your device.  

Photos are automatically uploaded to the OneDrive\Camera roll folder. 

iCloud 
Objective 1-6.3 

Hosted by Apple, iCloud is integrated with iTunes and other Apple services that are linked to your Apple ID. 
iCloud connects you and all your Apple devices (iPad, iPhone, iPod touch, and your Mac) and services. 
Advanced sharing features allow you to share photos, videos, documents, and iTunes Store, App Store, and 
iBooks Store purchases. 

 
When you set up iCloud on your iOS devices and your Mac, you always have the latest version of your 
important documents, photos, notes and contacts on whatever device you’re using.  

You can also install iCloud on your iOS devices. iCloud automatically backs up your iOS device daily over 
Wi-Fi when your device is turned on, unlocked, and connected to a power source. You can also use your 
iCloud backup to restore your iOS device or to set up a new device. 

Pages, Numbers, and Keynote are Apple web apps that you can use to create and work with content in your 
web browser. 

iCloud Drive is the associated cloud storage location.  
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Use the icons at the top of the window to create new folders, upload, download, or delete files. You can also 
drag and drop files into the iCloud Drive window. 5GB of storage space is associated with iCloud Drive. 

A local iCloud folder is built into Mac OS X and iOS devices and becomes available when you set up an iCloud 
account. Drag and drop files into the local folder so that they will be automatically uploaded to iCloud Drive. 

iCloud for Windows 
If you own iOS devices, but use a Windows PC, you can download and install the iCloud for Windows app on 
your PC, which will create folders that will sync with your iOS devices. Your photos, videos, mail, files, and 
bookmarks will then be accessible on all of your devices. iCloud stores your content and automatically keeps 
it up to date on your iPhone, iPad, iPod touch, Mac, and PC. 

Web-Only Access 
iCloud is designed to work primarily within the Apple universe; however, if you do not have an iOS device or 
a Mac, you can still get web-only access to create and share documents using Pages, Numbers, and Keynote 
by signing into iCloud. 1GB of storage space is associated with a free account.  

Go to www.icloud.com, and use one of your existing email addresses to create an account if you do not have 
an iCloud.com address or an Apple ID. 

 

http://www.icloud.com/
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Click Don’t have an Apple ID? Create yours now. 

 
Fill out the form, making sure you scroll to the bottom.  

Select security questions and answers, deselect check boxes for any email items you do not want to receive, 
then click Continue. Apple will send an Apple ID email verification message to the email address you used 
to create your account. It may take a few minutes for the email message to arrive. When it arrives, open the 
message, then enter the code in the verification screen that displays, and click Continue once again. Agree 
to the terms and conditions. 

Log in using the email address and password, then on the welcome page click Start using iCloud.  

If you have web-only access linked to a free iCloud account, the features are a little more primitive. You drag 
and drop files into the iCloud window with certain limitations: 

• in the Pages folder, you can drag and drop Pages, TXT, and Word files 

• in the Numbers folder, you can drag and drop Numbers, CSV and Excel files 

• in the Keynote folder, you can drag and drop Keynote and PowerPoint files 

Dropbox 
Objective 1-6.3 

Hosted by Dropbox, Inc., Dropbox is a popular cloud storage provider. As with the other types of cloud 
storage, you can store any type of file you want in Dropbox. You can upload and download content in the 
web interface, and you can download and install the desktop app which creates a local folder on your hard 
drive. 

Syncing is automatic between the local folder and the cloud location, and if you install and configure the app 
on your other devices and sign in, then content is synced across all your devices.  

You can share the files stored in Dropbox in the cloud by creating and distributing sharing links via email, 
text messages, or chat. You can also download and install mobile apps for Android and iOS. 
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To create a free Dropbox account, go to www.dropbox.com and fill in your name, email address and 
password, agree to the Dropbox terms, and then click the Sign up for free button. The account is set up for 
you and you are prompted to download and install the Dropbox app.  

Download the app and then run the installer.  

When the Dropbox Setup window displays, enter your email address and password, and click Sign In.  

  
When the setup is complete, click the Open my Dropbox button to reach the Welcome screen. Click Get 
Started to view some introductory information; click Next to advance through all the screens, then click 
Finish to open your local Dropbox folder in File Explorer. 

 
Drag files here for automatic upload to Dropbox in the cloud. 

When you are working in Dropbox.com in your web browser, you can drag and drop files into the browser 
window, or use the buttons in the web interface to upload, download and work with files and folders.  

http://www.dropbox.com/
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The local Dropbox folder provides offline access, so even if you are not connected to the Internet you can 
work on your files and save them to your Dropbox folder. The next time you are online, your changes will be 
synced to the cloud and across all your devices. 

Dropbox includes a 30-day version history; in case you accidentally delete a file or want to restore a previous 
version. It also features automatic photo uploading from your Camera roll folder to Dropbox.  

Other Types of Cloud-Based Applications 
Objective 1-6.4, 1-6.5 

The cloud offers much more than simple online storage and online productivity apps. Some of the most 
widely-used enterprise-level apps include Learning Management System (LMS) apps and Customer 
Relationship Management (CRM) apps.   

Learning Management System (LMS) 
A Learning Management Systems (LMS) is a software application designed to deliver electronic training 
courses (also called eLearning), track student progress, and generate performance reports. It is essentially an 
engine that powers eLearning.  

An LMS lets you create content and organize it into courses, deliver the content (as training) online, enroll 
students, and monitor and assess student performance. 

The most common implementation of an LMS includes two parts: 

Server component – this is the part that performs the core functions (creates, manages, and delivers courses, 
keeps track of users and their progress, and so on.) 

User interface component – this is the part that runs inside the browser and it is the interface through which 
administrators, teachers and students interact with the LMS. 

When organizations and schools use an LMS to deliver training, each student can study the material online 
at their own pace. The student signs in to the LMS through a web browser, and reads and interacts with the 
training material within the browser. Student progress data (lessons read, quiz and exam scores) is stored on 
the server.  
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The interface usually includes built-in communication tools such as email, chat and discussion boards. 
Students can post assignments, chat with each other and send messages to their teachers. While these tools 
are accessed through the browser, they are hosted on the server. 

The integrated monitoring and reporting tools that keep track of each student’s progress are also hosted on 
the server, and facilitators access these tools through the browser.  

In an LMS, most of the application is hosted on a server. Users may need to download and install a sign-in 
tool on their local systems to enable quick access; but generally, that access is made through a web browser. 

Customer Relationship Management (CRM) Software 
Customer relationship management (CRM) is the practice of managing and analyzing interactions with 
customers. The goal of CRM is to improve business relationships with customers, thereby increasing customer 
retention and helping to drive sales growth.  

CRM software applications capture customer information across different points of contact, such as the 
company’s web site, telephone calls, live chat sessions, direct mailings, marketing materials and social media. 
The captured information is consolidated and stored in a CRM database. Sales and marketing staff can then 
access the database to view detailed information on customers' personal information, purchase history, 
buying preferences and so on. 

CRM software can also be used to record customer interactions with staff (over email, phone calls, or social 
media for example). It can also automate certain processes. For example, as a sales prospect is entered into 
the system, the system might automatically send out marketing materials (via email or social media), with 
the goal of turning the sales lead into a customer. 

Popular CRM application vendors include: 

Salesforce.com – offers a completely cloud-based CRM product.  

Oracle – Oracle Corporation has long been known for its sophisticated relational database products, and 
they offer several cloud-based CRM products.  

Workfront (formerly AtTask) – offers cloud-based CRM Marketing applications and project management 
solutions. 

Traditional CRM implementations were locally hosted on the premises; but modern implementations are 
cloud-based. This keeps the customer data secure, and it enables employees to access the information from 
anywhere – thus enabling a mobile or telecommuter workforce. 

Who Uses CRM Software? 
Almost any business that wants to show their customers that they are a priority can benefit from using CRM 
software. However, specifically likely users would be: 

• Any business with a sales team. 

• Any business with a marketing team. 

• Any business that generates quotes or invoices. 

Essentially, any business with customers is a candidate for CRM. 
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Benefits of Using CRM Software 
Benefits of using CRM software include: 

• Increased efficiency – many CRM platforms have the ability to integrate with other business tools, such 
as marketing automation tools. 

• Better use of customer data – CRM systems are designed to capture and store data. Their built-in tools 
allow for data analysis and reporting. 

• Collaboration – cloud-based CRM platforms allow employees in multiple departments to more 
effectively manage their customer relationships and to see “the big picture” at any time. 

• A better customer experience – because CRM systems allow a company to recognize the needs and 
preferences of their individual customers, companies can interact more meaningfully with their 
customers at the right times. This leads to better sales and higher customer satisfaction. 

Mobile Notifications 
Objective 1.6.1, 1.6.2 

So many apps that we use on our desktop and laptop machines have corresponding mobile apps that allow 
us to stay connected with our data and our contacts no matter where we are (or what time it is). When you 
work on your desktop or laptop, visual and audio notifications alert you when you receive messages or when 
the scheduled time for an upcoming appointment is approaching.  

Notifications are updates about certain types of activity – including postings by our friends on social networks, 
new instant messages we have received, new email messages hitting our Inbox, or reminders for upcoming 
meetings we have scheduled on our calendars.  

When you put mobile apps (such as Gmail, or Skype) on your phone, you can configure your device to vibrate 
and play a sound and display a visual cue when there is activity. For example, your device can notify you 
when you receive a new Gmail email message.  

Many mobile apps are configured by default to notify you when there is activity. And for the most part, this 
is good. However, there may be times when you do not want to be interrupted by notifications. Fortunately, 
you can control notifications through your app’s settings, or through your device’s mobile operating system. 

Configuring Notifications in the App 
Most apps include notification settings that you can configure. For example, the Gmail app allows you to 
configure how you want to be notified in addition to whether you want to receive notifications. 

To configure Gmail notifications on Android: 

1. Open the Gmail app. 

2. Tap the Menu key (3 bars icon) in the top left corner. 

3. Scroll to and tap Settings. 

4. Tap your email account. 

5. If you want to turn notifications off, clear the Notifications check box. If you want to fine tune 
notifications, proceed to step 6. 
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6. Tap the Inbox sound & vibrate option. 

Configure the available check boxes to specify whether to include vibration and whether you want to be 
notified when each new message arrives. 

To configure Gmail notifications on iOS:  

1. Launch the Gmail app. 

2. Tap the Menu key. 

3. Tap Settings. 

  
 In the Notifications section, configure the available settings. 

Configuring Notifications through Mobile OS 
Mobile operating systems include configurable settings that control how apps run on your mobile device, 
including whether to allow or block notifications from a particular app.  

In Android, these settings can be accessed through the Application Manager: 

1. On the Home screen, tap Apps. 

2. Tap Settings. 

3. Tap Applications. 

4. Tap Application manager. 
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5. Scroll the list of apps, then tap the app you want to configure. 

  
 Click Notifications, move the Allow notifications slider on or off. Depending on the app, you may be 

able to turn off particular types of notifications (such as sounds or notifications that appear on the lock 
screen) as opposed to turning all notifications off for the app.   

On iOS, you can use the Notifications Center to turn notifications on or off for a particular app. To access 
these settings on iOS: 

1. Tap Settings. 

2. Tap Notifications. 

3. Find and tap the app you want to configure. 

Move the Allow Notifications slider on or off. Depending on the app, you 
may be able to turn off particular types of notifications (such as sounds or 
notifications that appear on the lock screen) as opposed to turning all 
notifications off for the app.  

Lesson Summary 
In this lesson, you learned about cloud computing. You should now be able to: 

 understand the benefits and characteristics of cloud 
computing 

 create and use cloud accounts to store, manage, 
and share files 

 describe different types of cloud applications 

 configure mobile notification 

Review Questions 
1. Which of the following is an example of cloud computing? 

a. Using Gmail. 
b. Using your laptop on an airplane. 
c. Using Wi-Fi to connect to a network printer. 
d. All of these are examples of cloud computing. 
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2. Which of the following is a benefit of cloud computing? 
a. The ability to make a backup copy of your cloud computing software. 
b. The reliability of locally installed applications. 
c. Reduced hardware costs.  
d. This refers to the number of backups the service will create for your data. 

3. Which type of app generally provides the most complete feature set? 
a. Desktop apps. 
b. Browser apps. 
c. Tablet apps. 
d. Smart phone apps. 

4. Which of the following is a feature found in most cloud accounts? 
a. Automatic backup. 
b. Cloud storage space. 
c. Apps to connect multiple devices to your account. 
d. All of these are features found in most cloud accounts. 

5. How can you upload content to Google Drive? 
a. Click New, File upload. 
b. Click New, Folder upload. 
c. Drag files into the Drive window. 
d. You can use any of these methods to upload files to Google Drive. 

6. How can you download content from Google Drive? 
a. Drag files from Drive into File Explorer. 
b. Select a file, click More actions, then click Download. 

c. Create folder called Local in Drive, then move files into the folder; they will be automatically 
downloaded. 

d. You can use any of these methods to download files from Google Drive. 

7. Which of the following is true concerning a local Google Drive folder? 
a. The app for creating a local folder is built into Windows 10. 
b. You create the folder in File Explorer, then configure it to sync with your My Drive location. 
c. It is set for automatic synchronization with your My Drive location. 
d. The app for creating a local folder is built into iOS. 

8. Which of the following are levels of access you can set for files that you share on Google Drive? 
a. Can delete, Can edit, and Can comment. 
b. Can edit, Can comment, and Can view. 
c. Can share, Can edit, and Can view. 
d. Can copy, Can download, and Can comment. 
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9. How do you create a local OneDrive folder on a Windows 10 PC? 
a. A local OneDrive folder is built in. 
b. Download and install an app from OneDrive.com. 
c. Download and install an app from Playstore. 
d. Create the folder in File Explorer, then configure it to sync with your OneDrive location. 

10. When working in Excel Online, how do you save your changes? 
a. Click the Save button. 
b. Press CTRL+S. 
c. As you work, all your changes are automatically saved. 
d. You cannot save documents in Excel Online. 

11. Which of the following types of files can you upload to the Pages folder on iCloud Drive? 
a. CSV and Excel files. 
b. TXT and Word files. 
c. Keynote and PowerPoint files. 
d. You cannot upload documents to iCloud Drive. 

12. How can you upload a file to your Dropbox storage location? 
a. Drag the file into your local Dropbox folder. 
b. Right-click the file in File Explorer, then click Send to Dropbox. 
c. Email the file as an attachment to <your name>@dropbox.com. 
d. You can use any of these methods to upload a file to Dropbox. 

13. What are the two major components of a Learning Management System (LMS)? 
a. A content component and an assessment component. 
b. An email component and a content component. 
c. A server component and a user interface component. 
d. An assessment component and an email component. 

14. Which of the following is at the heart of a Customer Relationship Management (CRM) application? 
a. A database. 
b. An email server. 
c. An integrated chat feature. 
d. A trend analysis tool. 

15. How can you configure Gmail notifications on your smart phone? 
a. Through the Gmail app’s settings. 
b. Through a third-party “handler” app. 

c. You cannot configure the notifications, but you can turn them off through the mobile operating 
system. 

d. Through settings that you access on Google Drive. 
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Lesson 7: Security and 
Maintenance 
Lesson Objectives 
In this lesson, you will learn about the need for computer security, how to identify risks and how to combat them. 
You will also learn how to back up and restore files, and to reset devices. You will also learn about the basics of 
troubleshooting. On completion you should be able to: 
 explain the need for security 

 describe how to keep your user name and 
password safe 

 describe the risks presented by viruses, worms, 
Trojans, and malware 

 describe the risks associated with network 
connections 

 protect your information when using public 
computers 

 describe the risks presented by social engineering 
and phishing 

 describe methods for protecting against risks 

 explain how and why to back up and restore your 
data and your settings 

 explain how to reset personal devices to their 
factory settings 

 describe basic troubleshooting techniques 
 understand basic troubleshooting techniques 

The Need for Security  
As soon as you connect a computer to a network, you expose that system, and the information stored on it, 
to the potential risks associated with networking. The information stored on a networked computer can, in 
theory, be accessed by any computer connected to the network. If the network provides Internet access, the 
risk increases.  

Hackers (people who try to gain unauthorized access to computer systems) employ many different methods 
to obtain what they want. In response, you must take steps to protect your computer and its data.  

User Names and Passwords 
Objective 1-7.1 

Your user name and password protect your account from unauthorized access. Remember that your user 
account is associated with specific rights and permissions – both on your local system and on your school or 
organization’s network. Most attacks against networks occur when unauthorized people guess or steal a user 
identity that is recognized by the system. By keeping your user name and password confidential, you help to 
protect your personal data and the data on the network.  
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Passwords protect your accounts. You should take the following steps to create a strong password: 
• Use a minimum of six characters (sometimes a standard is set up by your school or organization); eight 

or more characters is even better, with 15 characters considered the most secure.  
• Include a mixture of numbers, letters, symbols and capital letters.  
• Select a password that will be easy for you to remember, but difficult for someone else to guess. 

• Avoid using the names of people close to you such as members of your family, or the names of your 
pets. People who know you well enough can try to guess your password using these names first. 

• Avoid using variations of your name or including your name, address, or birthdate in your password.  

• Avoid using a variation of a password that may be easy to guess, such as Password-Jan, Password-Feb, 
password001, password_003, DrewJ12, DrewF12, pa$$w0rd, and so on. 

Keeping Your Account Safe 
Your account protects your files and your reputation. If you allow someone else to log on with your account, 
you can be held responsible for actions performed under your account name. For example, if someone sends 
threatening email from your account, recipients will think the messages came from you. If someone deletes 
important files on the network using your account, that activity will be traced back to you as well.  

In order to keep your account secure, you should protect your user name and password and keep them to 
yourself. Follow these guidelines: 
• Never share your account information.  
• If you accidentally share your logon information, change it immediately. 

• Do not “hide” your password near your computer. For example, tucking a sticky note under your 
keyboard or in a desk drawer is not secure. Do not keep password “cheat sheets.” 

• Do not use the same password for all your accounts – if someone guesses your password, they would 
have access to multiple accounts. 

Changing Your Password 
It is good practice to change your password periodically.  

To change your Windows 10 password: 

1. Click Start, then click Settings. 

2. Click Accounts, then click Sign-in options.  

3. Under Password, click Change. 

4. Type your old password, then click Next. 

5. Type your new password, type your new password again as a confirmation, enter a password hint, then 
click Next. 

6. Click Finish. 

Often, if you are a member of a domain network, you will be required to change your password at regular 
intervals. If you are using a domain account, use these steps to change your logon password: 

1. Press CTRL+ALT+DELETE. 

2. Click Change a password.  

3. Type your old password, type your new password, type your new password again as a confirmation, then 
press ENTER.  
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Locking the System 
Ideally, you should log off your system if you are going to be away from it for any period of time. This practice 
protects your computer and your documents. However, a more convenient option is to lock the system while 
you are away.  

When you lock the system, all your programs and files remain open and ready so you can resume working 
quickly. Windows displays an image on the monitor and you must enter the logon password before you can 
resume working. 

To lock the system, click Start, click your account icon in the upper right corner of the Start menu, then click 
Lock.  

Identifying Risks 
Objective 1-7.2, 1-7.4 

You should be aware of the potential risks you face when you connect to a network or to the Internet. These 
risks include becoming “infected” with computer viruses and Trojan horses; these are programs designed 
with the specific intent of harming computer systems. You should understand how to detect and remove 
malicious code on your system before it harms your computer, your data, or data on the network to which 
you connect. 

Viruses 
A virus is a malicious program designed to take control of system operations, and damage or destroy data. 
Viruses are loaded onto your computer without your knowledge and run without your consent. All computer 
viruses are human made and are often designed to spread to other computer users through networks or 
email address books.  

Viruses can be transferred via email attachments, program or file downloads, and by using infected disks, 
CDs, or flash drives. If you pass an infected drive to a co-worker, that co-worker's system can also be infected. 
Similarly, a colleague might inadvertently send you an email attachment infected by a virus. If you attempt 
to open or print the file, the virus will engage. Email attachments have long been a favorite way to spread 
viruses. 

A virus can: 

• Display harmless messages on the screen. 

• Use all available memory, thereby slowing or halting all other processes. 

• Corrupt or destroy data files. 

• Erase the contents of an entire hard disk. 

Worms 
A worm is a self-replicating program that consumes system and network resources. The difference between 
a worm and a virus is that a worm automatically spreads from one computer to another, whereas a virus 
requires some form of action; for example, a user must pass an infected disk to someone else, or must forward 
an infected email message. 

A worm can reside in active memory and replicate on the network. Worms can spread to all computers 
connected to a network and are commonly spread over the Internet via email attachments.  
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Trojans 
A Trojan (or Trojan horse) is a program designed to allow a hacker remote access to a target computer 
system. The code for a Trojan is hidden inside seemingly harmless applications, such as games. Trojans are 
installed on the target system when the user runs the infected application. Unlike worms and viruses, Trojans 
do not replicate themselves or copy themselves to other files and disks.  

Once installed on the target system, the Trojan can allow a hacker to take control of the target system, steal 
information, install other software (including viruses), download or upload files, or crash the system.  

Trojans can be accidentally installed through software downloads (for example, a Trojan might be hidden in 
a software application downloaded from a network), through Web sites containing active content (that is, in 
the form of an ActiveX control), or through an email attachment.  

Malware (Spyware / Adware) 
Spyware is a software application that is secretly placed on your system and gathers personal or private 
information without your consent or knowledge. 

Adware is a software application that automatically displays or downloads advertisements.  

Many Internet-based applications contain spyware. Companies with both good and bad reputations have 
included spyware code in their software. Spyware can also be placed on your system by a virus or by an 
application downloaded from the Internet.  

Once installed, spyware monitors your activity on the Internet and conveys the information to the spyware 
originator. The originator can then gather Web site usage, email and even password information from your 
system, then use it for advertising purposes or malicious activities.  

Spyware can consume memory resources and network bandwidth. Spyware has the ability to: 

• Scan files on hard drives. 

• Read cookies.  

• Monitor keystrokes. 

• Install other spyware applications. 

• Change the default home page in Web browsers. 

• Automatically send information to the spyware developer. 

A cookie is a small text file placed on your computer by a Web server. Although cookies themselves are not 
dangerous, they can be used to store user names and passwords if you click "Yes" when your browser asks 
you if you want to store this information. Cookies also track browser activities, such as sites you visit and 
options you select.  

In a normal Internet transaction, cookies are read only by the server that placed them on your system; 
however, a hacker who gains physical access to your system or successfully installs spyware can steal your 
cookies, and with them, any stored user names and passwords. 

You can download and install freeware spyware/adware applications, or you can use Windows Defender to 
monitor your system for spyware. Anti-spyware applications are discussed later in this lesson. 
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Network Connections 
Any time you join a network, you open your system up to possible connections from other systems 
participating on the same network. Infected systems and/or would-be hackers connected to the network 
always present a risk. 

Wired Connections 
Generally speaking, if you connect to a wired network within your school or business, you are pretty safe. 
Network administrators take great pains to ensure that all company/school systems are routinely scanned 
for infection, and all users must log on to the network using a valid user name and password. 

However, the same guarantee is not in place when you plug into a public wired network. For example, some 
hotels still provide Ethernet connections for Internet access to their guests. There is no way to guarantee that 
every hotel guest who connects is an honest and upstanding citizen (who would never dream of trying to 
hack into someone else’s system or who would never consider trying to unleash a virus); nor is there a way 
to guarantee that everyone connecting to the network is using up-to-date antivirus software. You connect 
at your own risk. 

Wireless Connections 
These same risks apply to Wi-Fi connections. Anyone can join a Wi-Fi network provided by a public hotspot. 
Even if you connect to a secured network (one that requires a pass phrase) provided by a hotel for example, 
you still do not know who else is on the network. No one can guarantee that all the systems connected are 
virus-free, and no one can guarantee that there is not a hacker lurking in the background waiting to find a 
system he or she can exploit. 

Participating in ad-hoc networks (those which do not use an access point) is dangerous. Wireless systems 
connect directly to one another in an ad-hoc network; there is no access point at the center to relay signals 
among the participants. There is also no authentication required. That means anyone within range can 
connect – with or without your knowledge. 

Mitigating Risks 
Whenever you connect to a public network, always identify the network to the operating system as a Public 
network (as opposed to a Work or Home network). Windows automatically limits incoming connections from 
a public network while still allowing you access to the Internet. 

If you use Wi-Fi, always connect to an infrastructure network. Avoid participating in ad-hoc networks. 

Using Public Computers 
The risks associated with using public computers (such as those found in a library) have to do with protecting 
your privacy and your personal accounts. Remember that anyone who has physical access to a public 
computer can access any information stored on it.  

Because you do not “log on” to a public computer, all activity is performed under one open account. That 
means search history, cookies, and any other information that is stored on the computer is accessible. 
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For this reason, you should take the following steps to ensure your safety when you use a public computer. 

Log out of online accounts – if you log into an online account (for example, a banking account or a credit 
card account, or even a social media account) and then walk away without logging out, anyone who comes 
along behind you can access those accounts and take action within those accounts because you are still 
logged in. You are leaving yourself wide open to both monetary theft and identify theft.  

Clear caches and cookies – browsers store information (such as browsing history and search history) in 
storage locations called caches (pronounced “cashes”) which are located on the hard disk. Browsers also store 
cookies (small text files that contain information pertaining to web site activity) from sites that you visit. These 
entries are stored in plain text, so anyone can navigate to and view them. If you want your online activity to 
remain private, use the built-in features in your browser to clear these entries. (You will learn how to work 
with browsers in the Living Online module.) Also, do not allow the browser to store your passwords for online 
sites/accounts.  

Log out of the operating system – if you use a shared computer at school or at work that requires a personal 
log on, always log out when you are finished. Logging out prevents other users from using your account to 
access personal files stored under your profile. Additionally, logging out prevents an unauthorized user from 
gaining illicit access to the network. 

Social Engineering 
Social engineering is the practice of tricking users into giving out passwords or other types of access 
information. Social engineers pose as fellow employees or classmates, technical consultants or cleaning staff, 
in order to gain the trust of real employees or students.  

Social engineers count on people's desire to be helpful. For example, a social engineer may wait near a 
secured door that requires a smartcard for access and wait until a legitimate employee is about to enter. The 
social engineer could then approach the door carrying an armload of boxes. Out of courtesy, the real 
employee may then hold the door open so the social engineer can enter. 

Social engineers also attempt to imitate a legitimate user by confusing a switchboard operator or a security 
guard. In several instances, a social engineer has called a company, posing as the systems manager. After 
explaining that he had accidentally locked himself out of the computer, he convinced someone in the 
company to change administrative access according to his instructions. All the social engineer then had to 
do was log on to the machine, and he had full administrative access. 

Typical targets of the social engineering strategy include anyone who has access to information about 
systems they do not use, including secretaries, janitors, some administrators and even security staff. 

Reducing the Risk of Social Engineering 
The best way to guard against becoming a victim of social engineering is to recognize common social 
engineering practices. Following is a brief list of social engineering strategies: 

• Posing as a technician and using that implied authority to cause employees to divulge information, to 
make configuration changes to servers, or to obtain sensitive information. 

• Confusing or intimidating an employee or guard into allowing physical access to a building. 

• Sending official-looking email messages to all employees with instructions that cause them to reveal 
sensitive information. 
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Phishing 
Phishing is the process of trying to gather sensitive information such as a password, or credit card details 
from an unsuspecting victim by pretending to be a trustworthy entity. Typically, a phisher sends a legitimate-
looking email message that appears to come from a legitimate source, such as your bank or credit card 
company.  

The email message generally includes a false alert and instructs you to take a particular action. For example, 
you might receive an email message alerting you that suspicious activity has been detected on your credit 
card account. The email will include a link and directions that instruct you to click the link to visit the web site 
where you will be expected to enter account-specific information. When you click the link, you are taken to 
a fraudulent web site made to look just like the legitimate site. When you update your personal information 
(such as password, credit card or bank account numbers) on the fraudulent web site, the phisher captures 
your information and can then use it for malicious purposes, including identity theft. 

To protect yourself against phishing: 

• Enable the anti-phishing features in your browsers. 

• Check an unknown site manually. (In Internet Explorer, click Tools, point to Safety, then click Check This 
Website.)  

• Avoid clicking links in email messages. If a message appears to have come from a bank, credit card 
company or government agency, call the organization directly to discuss the email message. Often you 
will be informing the genuine company that a fraud scheme is in place so they can send appropriate 
notices to their clients. 

• Before logging in to a secure site, check the Address bar to be sure the address starts with the legitimate 
site name.  

Exercise 7-1: Recognizing risks 
In this exercise, you will review two scenarios and identify the risks represented by each. 

1. Consider the following scenario: 

 Alan is the new receptionist at XYZ Company. Most of the management staff has been at an offsite 
meeting all day and it is already 4 PM. The phone rings and the conversation proceeds as follows: 

Alan: "Dream Pages LLC, this is Alan, can I help you?" 

Caller: "Alan! Great. Hey, this is Jim from IT. We've been stuck offsite all day, and it looks like we may be 
here several more hours, and I really need to finish getting all the email accounts moved over to the 
new server. I can do it remotely, but I left my notes at the office. I can get your account moved over, 
but I need your user name and password to do it." 

Alan: "You're in the IT department?" 

Caller: "Yes, Alan, this is Jim from IT. I’m in charge of the email server." 

Alan: "Sorry, I'm still new here …" 

Caller: "Oh, hey, no worries, Alan. Anyway, I can get your account moved over if you could just give me 
the user name and password. Yours is the last one I need to move, and it would save me a trip all 
the way back to the office. Can you help me out?" 
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Alan: "Oh, okay."  

Alan then gives his user name and password to "Jim." Jim thanks him and says that was all he needed to 
know. And then the call ends. 

2. What type of attack is illustrated in this scenario? 

3. What do you think has taken place? 

4. Consider the following scenario: 

 Minerva is a student. She was disturbed to receive an email message from her bank informing her that 
several customer accounts had recently been compromised. The message assured her, however, that 
account numbers were being changed to protect the customers. The message included a link to the 
fraud prevention page of the bank’s web site. Once there, she would be instructed on how to verify her 
old information and activate her new account. 

 Minerva clicked the link and read all the information on the fraud prevention page of the bank’s web 
site. The page included a web form for verifying old information and a link to activate her new account 
number. It also included contact phone numbers for speaking with bank agents who were available to 
answer any questions. The form required her to enter her old account number, her date of birth and the 
last four digits of her social security number. 

 Instead of filling out the form, Minerva opened a new browser page, entered the URL for the main page 
of her bank web site, located a contact phone number and called the bank. She noticed that the contact 
number was very similar to the one on the "fraud prevention page," but it was not the same number. 

5. What type of attack is illustrated in this scenario? 

6. Why do you think Minerva did not use the phone number listed on the fraud prevention page? 

Protecting Yourself 
Objective 1-7.3, 1-7.5, 1-7.6, 1-7.7, 1-7.8 

Although there are certain risks associated with computing, there are also several tools and practices 
designed to keep you, your computer, and your information safe. 

Antivirus Software 
An easy way to protect against viruses is to use antivirus software to scan your computer for known viruses, 
and to eliminate any viruses that are discovered. Antivirus applications generally include options for 
automatically scanning email attachments as they are delivered to your Inbox, scanning downloaded files, 
and scanning scripts that are executed within installed browsers. Most antivirus applications include anti-
spyware components as well. 

You can manually start a scan on your system, and you can schedule regular scans using the application’s 
settings. The following figure shows the scan settings page for avast! antivirus. 
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As soon as you install antivirus software, scan the computer for any possible viruses that could already be 
resident. You should also schedule regular system scans. 

Additionally, you should subscribe immediately for automatic updates (or notices of updates) for the virus 
definition files and updates for the program.  

All versions of antivirus software include free and frequent updates to the virus definition files that enable 
the program to recognize and remove the latest viruses. You can configure the software for automatic 
updates through the application’s settings. 

Always keep your antivirus program updated. 

It is generally a good practice to scan the system again after updates are installed.  

Avoiding Viruses 
Conducting regularly scheduled scans, keeping your software up to date, and enabling automatic scans of 
email and downloaded files will go a long way toward keeping your system virus-free. Others steps you can 
take to avoid infection include:  

• Saving and then scanning all files you download from the Internet (before running or opening them). 

• Scanning removable media (CD, DVD, or flash drive) before copying or opening files contained on the 
media. 

• If you share files with other people using portable devices, scan any files you plan to give to others to 
ensure you do not inadvertently pass a virus on to them. 

• Always configure your antivirus application to scan all incoming and outgoing email messages. 

• Always scan email attachments before opening them (even if they come from people you know). 
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• Be suspicious of any unexpected attachments you receive with email or instant message transmissions. 
If you receive an attachment that you did not expect or do not recognize: 

– Do not open the attachment. 

– Try to contact the message sender (using a method other than email) and determine whether the 
attachment is legitimate. 

– If you are unable to contact the sender or the sender is unaware of the attachment, delete the 
attachment from the message. 

– Open your Deleted Items folder and delete the attachment from it to permanently remove the 
attachment from your system. 

The best protection is prevention; however, you should understand that most viruses can be removed without 
causing permanent damage to your system. 

Removing Viruses 
When an antivirus program is running, it will scan the files you select; when it finds a virus or threat, it will 
give you the option to quarantine or remove the threat. 

• If you elect to quarantine the infected files, the antivirus program will place the infected file in a 
quarantined or vault area where it cannot infect other files. Quarantined files can usually be deleted at 
any time.  

• If you elect to remove the file, the antivirus program will permanently delete this file from your system. 
You usually do not need to do anything else. 

• If the antivirus finds a virus that cannot be removed, it will still quarantine the infected file. You may be 
able to find a removal tool for this virus on the antivirus program's web site. Generally, you will need to 
download a file and then follow the instructions for removing the virus from your system. Alternatively, 
you may need to research how to remove the infected file manually. 

It bears repeating that it is extremely important to keep antivirus software up to date and configured to 
automatically download updates. It is equally important to keep the email scanner and resident scanner 
portions of the application turned on. Regular system scans are recommended, and these can be scheduled. 
You can also manually start a scan at any time. 

Firewalls 
A firewall is a security barrier that filters and controls the flow of information coming into and out of a private 
network. Firewalls protect systems from unauthorized access by filtering the information that comes through 
the Internet connection into your LAN or computer system. If an incoming packet of information is flagged 
by the firewall filters, it is not allowed through. In this way, firewalls prevent dangerous network traffic from 
coming into the LAN. 

The filters used by firewalls are simply sets of rules that 
define and control which type of traffic to allow and which 
type of traffic to block. 

In an organization, a network administrator can set up 
and implement security rules on a firewall that control how employees connect to web sites, whether instant 
messaging applications are allowed, whether files are allowed to leave the company over the network and 
so on. 
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A firewall protects your network from malicious activity coming from outside your network, and provides a 
"door" through which people can communicate between a secured network (the LAN) and the open, 
unsecured Internet. A network firewall is placed between a LAN and the Internet. 

A firewall can be a dedicated computer system, a specialized firewall appliance, or it can be implemented on 
a networking device such as a router. In a home or small office networking environment where a broadband 
router is used, a firewall is usually built into the broadband router. 

Note: Firewalls keep private data private. They do not, however, encrypt data nor do they protect against 
viruses. 

Desktop Firewalls 
Firewalls can also be implemented through software. Also known as personal firewalls, desktop firewalls offer 
protection for an individual system instead of an entire network. Tools such as Norton 360 or AVG can detect 
and respond to attacks on a computer system. 

Desktop firewalls offer many firewall features, such as inspection of all incoming transmissions for security 
threats. When a firewall is used in conjunction with antivirus software, a personal computer is secure, provided 
that the user updates these applications frequently. 

Many operating systems include built-in (native) desktop firewall software. Windows, for example, includes 
Windows Firewall which is enabled by default. Mac OS X also ships with a built-in firewall, which you can 
enable from the Security & Privacy tab in System Settings. 

Firewall Challenges 
Firewalls can present challenges to network users. Sometimes firewall settings block access to particular web 
sites, or block streaming audio or video from coming into a network. If your corporate system is behind a 
firewall and you have difficulty connecting to specific Internet sites or services, you may need to contact a 
network administrator, who can then adjust the firewall configuration.  

You may also learn, however, that the service or web site you want to access conflicts with your organization's 
security policy. 

Monitoring Software 
Most network administrators protect their networks through network monitoring software. These programs 
track and record network activity such as user logons, server performance and network traffic conditions. If 
logon events are tracked, then any time you log on to a network system, that activity is recorded in a server 
log. If a hacker logs on using your account, and manages to damage the network, the electronic trail may 
lead to you. If you suspect that your account has been compromised, contact the network administrator 
immediately so you can change your user name and password. 

In some organizations, administrators take monitoring to a whole other level by installing PC surveillance 
software. Software of this type records all PC activity, allowing the administrator to capture your keystrokes, 
view screenshots, and see your email, instant message conversations, and web activity.  

Remember that computers in your school or workplace are not your private property; accordingly, any activity 
you perform on those computers may not be private. 
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Conducting Safe E-Commerce Transactions 
How safe you feel conducting transactions such as banking or making a purchase online will determine how 
much e-commerce (electronic commerce) or online shopping you do. Many web sites have taken appropriate 
steps to ensure their customers’ security, but there are additional steps you can take to protect yourself.  

Be Selective 
If you want to shop online, shop from companies that have a good reputation and are well known for 
providing: 

• good customer service 

• reliable delivery 

• a fair and easy return policy 

Choose e-commerce sites carefully. Legitimate e-commerce sites will display links to their privacy policy and 
terms and conditions statements on their web pages. Read these statements and be sure that you understand 
the conditions or requirements you will be subject to should you decide to do business with the vendor.  

Exercise Skepticism 
If a company offers a deal that seems too good to be true, research that deal. Take the same precautions you 
would take if someone made that offer offline—would you give a large sum of money to a person without 
researching the product or service they are selling?  

If the company is not known to you, be sure to research it before purchasing anything online. Call the contact 
numbers listed on the site, look for a client list or for customer references/reviews, and research them with 
organizations that track good and bad reports about companies, such as the Better Business Bureau (BBB). 

Always Use Secured Transactions 
While you are browsing the Internet, the Address bar in your browser uses the Hypertext Transfer Protocol 
(http). This protocol is used for normal web site activity, such as browsing and navigating. It is not a secure 
protocol. 

 
However, anytime you exchange personal information with a web server – such as when you set up an 
account, or enter financial information – a secure protocol should be used. To conduct secure transactions 
over the Internet, web servers use Hypertext Transfer Protocol Secure (https). This is a secure version of http; 
it encrypts all exchanges between your computer and the web server. 

 
The https protocol and a lock icon in the Address bar indicate that you are in a secure area of the vendor’s 
web site and that transactions can be conducted safely. Web transactions are secured using encryption, which 
is the process of converting data into an unreadable form. Click the lock icon to view details pertaining to 
the security of the connection. 
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The web server proves its identity to the browser through a digital certificate. A digital certificate is a small 
file that provides the identity of an individual or company over the Internet. A trusted third party, called a 
certificate authority (CA), is responsible for verifying the legitimacy of the digital certificate. You can view 
details about the digital certificate by clicking an option presented in the web browser. 

Always look for the https protocol and the lock icon to ensure that you are conducting secure transactions 
over the Internet. Other symbols that may display on the page indicating that you can trust the vendor are 
nice to look at but do not guarantee that transactions are secure. Your browser has built-in features to let 
you know when transactions are secure. Use them. 

Exercise 7-2: Using secure connections 
In this exercise, you will use secure connections and view digital certificates. 

1. Open the Google Chrome web browser and navigate to www.amazon.com. Click the Hello Sign in Your 
Account link near the top right corner. 

2. Look at the URL in the Address bar and notice that the protocol is https, indicating a secure connection. 

3. Click the lock icon in the browser address bar, then read the information that displays in a drop-down 
message. Your connection to the site is private.  

4. Click Details in the drop down message to view details about the security of the connection in a pane 
that opens on the right edge of the browser window. 

5. Click the View certificate button to view details about the digital certificate. 

6. Click the various tabs in the Certificate dialog box, then close the dialog box. 

7. Close the Chrome browser. 

8. Open the Internet Explorer browser and navigate to www.amazon.com.  

9. Notice the use of the https protocol in the Address bar. Click the lock icon and read the information that 
displays in the drop-down message, then click View certificates. 

10. Close the Certificate dialog box, then close the Internet Explorer browser. 

Virtual Private Networks (VPNs) 
Network administrators put a lot of effort into blocking unauthorized connections from the outside into the 
LAN. However, they must also provide a method for allowing authorized connections from the outside. 
Connecting from outside the network is known as remote access. 
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Security is an especially important component of remote access because communication across a public 
network (such as the Internet) is vulnerable to interception or eavesdropping. For this reason, remote access 
methods must provide for authentication and encryption. Authentication is the process of confirming the 
identity of a user or computer system. Encryption is the process of converting data into an unreadable form 
of text, which then requires a decryption key in order to be read.  

In the past, remote access was provided through remote access servers, modems and dedicated phone lines. 
In most modern networks, however, access is obtained using a virtual private network (VPN) connection. 

A VPN is an encrypted connection between two computers. VPNs allow secure, private communications 
across long distances using the Internet as the pathway for communication instead of using a dedicated 
private line. 

VPNs make it possible for telecommuters and traveling/remote employees to establish a secure connection 
to the company network from outside the company premises. VPNs also make it possible for a company with 
several satellite offices to establish secure connections between all their locations. 

Using VPN 
Telecommuters, remote employees, and traveling employees use VPN to connect to their company networks 
from the outside.  

In order for a network to support VPN connections, a VPN server must be set up to receive incoming 
connections. Any user who wants to make a VPN connection from a remote location (for example, from home 
or from a hotel room) must install and then launch VPN client software to open a connection with the VPN 
server.  

Users must log on using a valid user name and password, just as if they were logging on to the network from 
inside the corporate office. 

Backup and Restore 
Objective 1-4.1, 1-4.2, 1-4.3 

A computing device is useful only if the data it contains is valid and accessible. An easy way to protect data 
is to schedule regular backups. A backup is a duplicate copy of a program, a disk, or data, made either for 
archiving purposes or for safeguarding files from loss if the active copy is damaged or destroyed.  

Backups should be written on a storage medium other than the source of the backup. That is, if you are 
backing up your hard drive, do not create the backup on the same hard drive. Instead, choose a location such 
as a different internal hard drive, an external hard drive, a flash drive, CD or DVD, or a network location (such 
as a network server hard disk) or a cloud location (such as OneDrive). 

Keeping a current backup of all your important files is essential to ensuring that your data can be recovered 
in the event of a failure or loss. Windows includes built-in features that make it easy and convenient to back 
up both system data and your personal files.  

Backing Up Your Personal Files 
The operating system, drivers, personalization settings, apps and other software can be re-installed on a 
computer fairly easily should they become damaged or accidentally deleted. Your personal files on the other 
hand cannot be easily replaced or re-created. 
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Your personal files are your documents, your photos, videos, downloads and so on. Think of how long it took 
you to create and refine your Office files. Think of the old photos you may have scanned and saved on your 
disk, or the new wedding or graduation day videos you might have transferred to and even edited on your 
computer. Would it be easy to replace these if something happened to your hard drive? 

Your personal files are the most important items to back up on your computer. You have choices on how 
you want to back up your personal files, including: 

Copying files to cloud storage – this is as easy as dragging important files to your local OneDrive, Drive, 
Dropbox or iCloud folder. You have already learned how to back up files using cloud storage. 

Using File History in Windows 10 – this feature configures Windows 10 to automatically create an hourly 
backup of your personal files whenever the destination media (for example, an external hard drive or a flash 
drive) is connected to the PC.  

Using Windows Backup and Restore – this is a feature from Windows 7 that configures Windows to 
automatically create a weekly backup of all important files on the computer; this includes your personal files 
and the files saved in the default Windows folders (these are operating system files, settings, registry entries 
and so on) used by the operating system. Backup and Restore requires significant storage space. 

File History 
The File History feature is the main backup tool in Windows 10 for backing up your personal files. Additionally, 
it automatically stores a version history of your files, allowing you to restore previous versions of a file if 
needed.  

To use File History, configure it once, and keep the selected backup media connected. To configure the 
feature, connect an external drive, open the Settings app and then click Update & security to open the 
Update & Security window. In the left pane of the window, click Backup. 

 

 

Click Add a drive, then select an external drive in the Select a drive window. The Automatically back up my 
files option will appear and will be automatically turned on. Windows will back up your files to the drive 
whenever you connect it to your computer. 
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Click More options to view the Backup Options page.  

Use the settings on this page to control how often to backup up, and how often to keep backup files. You 
can create a backup immediately by clicking the Back up now button, and you can specify which folders 
under your user profile to include in the backup. By default, these folders include: Desktop, Documents, 
Downloads, Music, Pictures, Videos and more. You can add or exclude folders as required. 

Windows Backup and Restore 
You can use Windows Backup and Restore to back up the entire system or only the files and folders you 
select. You can allow Windows to choose what to back up or you can select the individual folders, libraries 
and drives that you want to back up. By default, backups are created on a regular schedule. You can change 
the schedule, and you can create a backup manually at any time. Once you set up Windows Backup, Windows 
keeps track of the files and folders that are new or modified and adds them to your backup (assuming that 
your specified backup storage media is connected to the system at the time of the scheduled backup). 

If you have never used Windows Backup before, you need to set it up first by following the steps in the 
wizard. Open the Control Panel and navigate to System and Security, click Backup and Restore (Windows 
7) page, then click Set up backup.  

 
Select the destination for the backup file, then click Next. By default, Windows will back up data saved in 
libraries, on the Desktop, and in default Windows folders. Windows will also create a system image, which 
can be used to restore your computer if it stops working. Click Next if you want to accept the default settings, 
or click Let me choose to specify custom settings.  
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You are given an opportunity to review the current backup settings.  

 
Click Change schedule if you want to adjust the backup schedule. By default, Windows runs a backup every 
Sunday at 7:00 PM. However, you can configure Windows to run a daily, weekly, or monthly backup. You can 
also specify not to schedule any further backups. 

Click Save settings and run backup to create a backup.  

Restoring Personal Files 
If you accidentally delete a file that you need, or if one of your files becomes corrupted, you can easily restore 
it to your hard drive from the saved backup media. 

• If you backed up using OneDrive, simply copy the required files or folders from the OneDrive folder and 
paste them to your hard drive using File Explorer. 

• If you backed up using File History, open the Settings app, click Update & security, click Backup in the 
left pane, click More options, scroll to the bottom of the window and click Restore files from a current 
backup. Select the files or folders you want, then click the green button to restore them to your 
computer. 
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• If you backed up using Backup and Restore, open the Control Panel and navigate to System and 
Security, click Backup and Restore (Windows 7) page, then click the Restore my files button to open 
the Restore Files window. Use the Browse for files and Browse for folders buttons to select the specific 
files and folders you want to restore.  

  
 When you have selected all the files and folders you want to restore, click Next. Specify whether you 

want to restore the files to their original location or to a different location, then click Restore. When the 
restoration is complete, click Finish. 

Secure Backups  
As an individual user, you may not give much thought to backing up. You have complete control over how 
often you back up your files, or whether you even back them up at all. However, the people responsible for 
protecting an organization’s data must adhere to well-defined (and usually quite stringent) backup policies 
and procedures. 

Businesses which handle other peoples’ personal information (for example, financial information or medical 
information) are required by law to maintain and secure backups for a requisite number of years. That is, the 
data must remain accessible, and it must be protected from unauthorized access. 

Maintaining secure backups requires compliance with at least the following rules: 

• The backups should be redundant. That is, there should be more than one copy of any given backup. 

• At least one copy of the backup should be stored off-site. Storing backups in another physical location 
ensures that if disaster (such as an earthquake or a fire) strikes and a company’s computers are destroyed 
along with any backups that are stored on the premises, there is still a copy of the backup data that is 
safe. 

• Off-site storage locations must be secure. That is, only authorized personnel (those with a key or a 
passcode) should be able to physically access the backup media. 

• Backups should be encrypted. Encryption prevents unauthorized users from using any information they 
manage to intercept or steal, because without the decryption key, the data is unreadable. 

• Backups should be verified. This means that someone should check the backup media to be sure that 
the information copied to it is accessible and complete. 



Security and Maintenance Lesson 7 
 

 

7500-1 v1.00 © CCI Learning Solutions Inc.  231 

There are many government regulations pertaining to protecting people’s private information. Companies 
take these regulations very seriously.  

Backing Up PC System Files and Settings 
System files are vital to the function of the operating system, and they can become corrupt over time. 
Additionally, system settings can become damaged or misconfigured as software, updates, drivers, and apps 
are installed. System file corruption or misconfiguration can lead to problems using your computer. For 
example, some applications may stop working, or the system might start freezing up, or some hardware may 
cease to function. In some cases, you may not be able to boot up at all. 

Windows includes several built-in tools you can use to back up system files. You can use the backup to 
recover damaged files or to reverse misconfigurations. These tools include: 

• system restore points 

• system image files  

Even if you are not experienced enough to use these advanced tools to recover or repair your computer on 
your own, system file backups are an invaluable tool in the hands of a technical specialist who can use them 
to restore your system for you.  

System Restore Points 
A restore point is a saved snapshot of your computer’s Windows system files, program files, and Windows 
registry settings at a specific point in time. User files are not included in a restore point. Restore points are 
named and stored by their creation date. 

 
System Restore is a protection feature built into Windows; however, it must be enabled before any restore 
points can be created. To ensure that this protection feature is enabled on your Windows 10 system: 

1. Click in the taskbar search box, then type: restore. 

2. Click Create a restore point in the Start menu to open the System Protection tab in the System 
Properties dialog box.  

3. Click your hard drive in the Available Drives list box. If On displays in the Protection column, then the 
feature is enabled.  

4. If protection is turned off for your hard drive, click Configure. 

5. Click Turn on system protection. 

6. Drag the Max Usage slider to about the 5% point (between the first two tick marks on the scale). This 
reserves a portion of the hard disk for storage of restore points. 
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7. Click Apply, then click OK. 

8. Click OK once more to close the System Properties dialog box. 

When it is enabled, System Restore automatically creates restore points on your system once per week, and 
before major system events, such as installing a program or a device driver, or installing operating system 
updates.  

You can also manually create a restore point at any time. To manually create a restore point: 

1. Click in the taskbar search box, then type: restore. 

2. Click Create a restore point in the Start menu to open the System Protection tab in the System 
Properties dialog box.  

3. Click Create. 

4. Type a name for the restore point, then click Create. 

5. When the message that a restore point was successfully created appears, click Close, then click OK. 

When you restore from a restore point, System Restore restores the system files, program files, and registry 
settings from the restore point to your computer. This effectively “rolls back” your system to a previous state. 
This is useful when unexpected problems occur. For example, after an update, you may discover that you 
can’t launch certain programs, or maybe when you try to access the Internet your system freezes. If you use 
System Restore and select a restore point that was created before you installed the update, this can restore 
your system files to the previous state before any problem occurred. 

You may want to ask a technical specialist to guide you through rolling back your system to a restore point. 
However, the steps are: 

1. Click in the taskbar search box, then type: restore. 

2. Click Create a restore point in the Start menu to open the System Protection tab in the System 
Properties dialog box.  

3. Click System Restore, then click Next to display a list of saved restore points. The most recently created 
restore points appear at the top of the list. You can select the Show more restore points check box to 
view older restore points. 

4. Select the restore point you want to roll back to, then click Next. 

5. Click Finish and follow the prompts that appear.  

System Image / Repair Disc 
A system image is an exact image of a hard drive; it includes Windows and your system settings, programs, 
and files. You can use a system image to restore the contents of your computer (to the state it was in when 
you created the image) if your hard drive or computer ever stops working. When you restore your computer 
from a system image, it is a complete restoration; you cannot choose individual items to restore, and all your 
current programs, system settings and files are replaced. 

When you create a backup using Windows Backup and Restore, Windows creates a system image. When the 
image is created, you are given the option to create a repair disc, which you can use to boot your computer 
and begin the process of re-creating your system from an image.  
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You can also create a system image at any time by following these steps: 

1. Connect an external hard drive or other removable media with a large storage capacity. 

2. Click in the taskbar search box, then type: backup. 

3. Click Backup and Restore (Windows 7) Control panel in the Start menu to open the Backup and 
Restore (Windows 7) page in the Control Panel.  

4. Click the Create a system image link. 

5. Select the media on which to create the image, then click Next. 

6. Confirm the settings, then click Start backup. 

A technical specialist can guide you through the process of recovering your system from an image file; or 
you can provide the image file media to the specialist if he or she will be making repairs. 

Backing Up Your Mobile Data 
It is always a good idea to back up your personal data (such as contacts, saved text messages, and photos) 
on your mobile devices. You can use a USB cable and copy the data to your PC (this is the old school method), 
or you can use the phone’s built-in backup utilities and associated cloud storage. You can also turn on 
automatic backup so that your data is continually backed up. 

Android 
Android phones are connected to a Google account and Google can automate and streamline the backup 
process.  

1. Go to Settings, Personal, Backup and reset. 

2. Turn on both Back up my data and Automatic restore.  

3. Ensure that your backup account is set to your Gmail account.  

Turning these options on ensures that your personal data (including application data, Wi-Fi passwords, 
bookmarks and other settings) are always backed up and can easily be restored. 

iPhone/iOS 
Devices running iOS (including iPhones, iPads and iPod touch devices) can be backed up using iCloud or 
iTunes. iCloud stores backups in the cloud, while iTunes stores backups on your Mac or PC. 

To make a backup using iCloud: 

1. Connect to a Wi-Fi network. 

2. Tap Settings, iCloud, Backup. 

3. Make sure iCloud Backup is turned on. 

4. Tap Back Up Now. 

To make a backup using iTunes: 

1. Open iTunes and connect your device to your computer. 

2. Save content that you downloaded from the iTunes Store or App Store by clicking File, Devices, Transfer 
Purchases. 

3. To create your backup, click Back Up Now. 
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Using Factory Reset Options for PC 
When you use a factory reset option on your device, you are resetting the device to the state it was in when 
it came out of the factory – clean, new, ready to be set up. Sometimes, you may want to reset a device 
because it is running slowly or improperly and you just want to start over, from scratch. Other times, you will 
want to reset a device that you are getting ready to donate or gift to another person.  

Always create a backup of your personal files before resetting your device. 

Windows 10 Refresh and Reset 
The Refresh and Reset options (available in Windows 8 and later) enable you to restore the Windows 
operating system to a default configuration without having to reinstall the operating system from a DVD or 
USB drive.  

• Refreshing a PC gives you a fresh installation of Windows without deleting your personal files (pictures, 
documents, videos, and so on), your personalization settings, or apps that you installed from the 
Windows store. Applications that you installed from installation media or from the Internet will be 
removed however. If you are experiencing problems with your computer (for example, the computer 
freezes or applications will not load), performing a refresh may resolve the issue. 

• Resetting a PC gives you a fresh installation of Windows and preserves nothing. It is just like formatting 
the hard disk and starting over with a fresh installation of the operating system. All your personal files, 
personalization settings, apps and applications will be removed, and your PC settings will be changed 
back to their defaults. Use the Reset option to set your computer back to its factory default state. This 
option also allows you to fully clean the drive, which is considered best practice if you want to donate 
the PC because it makes it difficult for other people to recover the files you have removed. 

To refresh or reset your Windows 10 PC: 

1. Click Start, Settings, Update & security. 

2. In the left panel, click Recovery, then under Reset this PC, click Get started. 

3. In the Choose an option box, select either Keep my files or Remove everything.  

Resetting Mobile Devices 
Mobile devices include a factory reset feature that restores the device to the state it was in when it left the 
factory. Resetting removes your personal files, any apps that you installed, and any customizations you may 
have added, such as personal accounts, ringtones, screen savers, network passwords, and so on.  

Resetting your phone or tablet may be necessary for troubleshooting purposes; although most people use 
this option only when they are planning to donate or gift their mobile device. Remember that if you use a 
GSM mobile device, the installed SIM card includes your personal account information. Always remove the 
SIM card before donating or giving your phone to someone else. 

Always back up your personal files before resetting. 
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Android 
Depending on the version of Android you are using, you may find that in addition to an option for performing 
a factory data reset, you can use options for resetting only the phone settings (for example, ringtones or Do 
Not Disturb settings); or for resetting only the network settings (such as those for Wi-Fi, Bluetooth and mobile 
data). 

To restore your Android device to its factory settings.  

1. Go to Settings, Personal, Backup and reset. 

2. Tap Factory data reset.  

3. Tap Reset Phone.  

If your smartphone or tablet has expandable storage, the menu may ask if you'd like to wipe the external 
memory card, which is not really necessary since you can pop the card out of the slot. 

iPhone/iOS 
In iOS 7 and up, a security feature called Activation Lock requires the Apple ID used to set up the phone 
initially in order to reset it. If you do not disable Activation Lock, the next person who gets your iPhone won't 
be able to use it. You can disable Activation Lock by turning off iCloud/Find My iPhone.  

To turn off iCloud/Find My iPhone: 

1. Go to Settings. 

2. Tap iCloud. 

3. Scroll to the bottom of the screen and tap Sign Out. Enter your Apple ID /iCloud password if prompted. 

To restore your iOS device to its factory settings: 

1. Go to Settings. 

2. Tap General. 

3. Tap Reset. 

4. Tap Erase All Content and Settings and enter your passcode if prompted. 

5. Tap Erase to proceed. 

Note: Industry experts recommend that you encrypt your phone’s (or tablet’s) data before resetting if you 
plan to sell or give your phone away. Encrypting the data before resetting ensures any personal data left 
behind will be unusable, even for people with advanced technical know-how. 

Troubleshooting 
Objective 1-3.13 

Troubleshooting is a systematic approach to solving a problem. Essentially, it is an organized process of trial 
and error. You may need to try several different approaches before you can narrow down and find a solution, 
and generally, you use a process of elimination. This means you make a list of things that could be causing 
the problem and then test them out one by one to eliminate them as the cause. 

Here are some general troubleshooting tips: 

• Write down your steps. This will help you remember exactly what you've done and prevent you from 
testing the same possible causes again. 
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• Take detailed notes about any error messages you see, writing down as much information as possible. 
Or, you can use the Snipping tool built into Windows to take a screen capture of the error message. 
Having a record of the error messages can help you research them online or describe them to a 
professional who is trying to help you resolve your issue.  

Is it Hardware or Software? 
Often, the first step in troubleshooting is determining whether your issue is caused by hardware or software. 
It is not always easy to determine which might be causing a particular issue because software and hardware 
are designed to work together.  

However, the points you consider for each and the items you check off your list as part of your process of 
elimination are different for hardware and software. 

Hardware 
The hardware you will troubleshoot is often large and self-contained. For example, you might troubleshoot 
issues with your printer, or a monitor, or a mouse or keyboard. These devices usually include switches, 
indicator lights, and connection ports which are easily examined.  

To investigate possible hardware issues, begin with the obvious: 
• Is there power? 

– Is the hardware device plugged in? 
– If it is plugged in to a surge protector, is the surge protector switched on? 
– Is the device powered on? 

• If the device uses batteries, are the batteries installed? 
– If batteries are installed, do they still have a sufficient charge? 

• Is there a good connection? 
– If the device is connected to your computer by a cable, is the cable securely connected to both your 

device and the computer? 
– If the device and your computer are securely connected, is the cable damaged? 
– If you are using a wireless connection, is the wireless receiver connected?  
– If you are using a wireless mouse or keyboard, do they have good batteries and are they turned on? 

• Are there easily observable issues with the hardware device that need to be addressed before the device 
will function? For example, if you suddenly find that you cannot print a document, and you have already 
determined that the printer is plugged in and powered on, is there paper loaded? Is there a paper jam? 
Is the printer out of ink? Are there any error messages displayed on the information panel on the printer? 

Software 
Software issues are sometimes a little more difficult to track down. However, symptoms of a software issue 
are applications that stop running correctly, applications that freeze, or applications that won’t start. Software 
issues can also cause the computer to freeze or not boot up correctly. Things to consider when you run across 
issues like these include: 

• Did you install an update recently? Sometimes operating system updates can cause errors with an 
application program. The next questions to ask yourself are: 

– Does closing and then restarting the application solve the problem? 
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– Does restarting the computer and relaunching the application solve the problem? 

– Is the application up to date? Can you find and install updates for it? 

– Can you run the application program in compatibility mode? 

• If your system freezes up consistently or will not boot correctly after installing an update, could rolling 
back the update using a restore point resolve the issue? 

• Could your system be infected with a virus? Run a virus scan to ensure that an infection is not interfering 
with your application programs. 

Troubleshooting Connection Issues 
Another common cause for troubleshooting is network connection issues. Your system might be humming 
along just fine, and then all of a sudden you can no longer connect to the Internet. There are a few things 
you can check and try before calling the IT staff at work or school, or before calling your ISP if you are 
experiencing network problems at home. 

• Check your IP address using either the ipconfig command line tool or the Windows Network and Sharing 
Center. Remember that most LAN IP addresses resemble the following: 192.168.1.103.  

– If your IP address begins with 169.254, or if your IP address displays as 0.0.0.0, then your system has 
not received a valid IP address from the broadband router on your home network (or from a server 
on your school or work network). These devices provide IP addresses for all systems connecting to 
the network. 

– If your system did not receive a valid IP address, first ensure that the Ethernet cable is securely 
connected (if not, disconnect and then reconnect it).  

– If this does not resolve the issue, then try turning the broadband router off for 20 seconds, and then 
start it up again. Once the router is fully up and running, restart your computer. Your computer 
should receive a new IP address from the router, and you may then be able to connect to the Internet.  

• If your system has a valid IP address, but you cannot connect to the Internet, you may need to restart 
your broadband modem. Sometimes, your ISP will send software updates to their users’ modems, and 
often the modem requires a restart.  

– Turn the modem and the broadband router off for one minute. 

– Restart the modem. Once the modem is up and running, restart the router. 

– Once both the modem and router have been restarted, restart your computer once more.  

• If restarting your networking equipment does not resolve the issue, call your ISP. They may be 
experiencing a service outage, or they may be able to help you troubleshoot the issue over the phone. 

– If you do call your ISP, be prepared to provide information to the technical specialist such as your 
current IP address, and your connection speed. Remember that you view your network connections 
in the Network and Sharing Center, and that you can click your connection to view its details, such 
as the connection speed and the IP address. 

• If you have trouble connecting to your Wi-Fi network, check the following: 

– Is your wireless adapter turned on? Sometimes, wireless adapters are turned off by a device in order 
to save battery power. 

– Has the Wi-Fi network password changed? Network administrators sometimes change the Wi-Fi 
password if they suspect that the old password has been compromised. 
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– Are you close enough to the Wi-Fi hotspot? WLAN devices have a limited range, especially if they 
are using older WLAN standards such as 802.11b or 802.11g. 

Don’t be discouraged if troubleshooting takes a while. It is a process, and the more practice you get, the 
better you will become.  

Lesson Summary 
In this lesson, you learned about the need for computer security, how to identify risks and how to combat them. 
You also learned how to back up and restore files, and to reset devices, and you learned about the basics of 
troubleshooting. You should now be able to: 

 explain the need for security 

 describe how to keep your user name and 
password safe 

 describe the risks presented by viruses, worms, 
Trojans, and malware 

 describe the risks associated with network 
connections 

 protect your information when using public 
computers 

 describe the risks presented by social engineering 
and phishing 

 describe methods for protecting against risks 

 explain how and why to back up and restore your 
data and your settings 

 explain how to reset personal devices to their 
factory settings 

 describe basic troubleshooting techniques 

 understand basic troubleshooting techniques 

Review Questions 
1. Which of the following passwords is the most secure? 

a. NeXt-Chg9917A c. Nextchg9917 
b. PaSW0rd d. pA$$word003 

2. How do you access the Lock command using the Start menu? 
a. Click the Start button, click your user account name and then click Lock. 
b. Click Start, click Power, and then click Lock. 
c. Click Start, click Shutdown and then click Lock. 
d. You can only access the Lock command from the Power Options page in the Control Panel. 

3. Eduardo’s computer started to display strange error messages, and then everything in his Documents 
folder was erased. Eduardo was probably the victim of a:  
a. Virus 
b. System misconfiguration 
c. Spyware application 
d. Phishing exploit 

4. A hacker can gain remote access to your computer through: 
a. A Trojan  c. A virus 
b. A worm  d. Adware 
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5. Which software application automatically downloads advertisements? 
a. Adware  c. Desktop firewall 
b. Spyware  d. Monitoring software 

6. Which of the following is not dangerous but can be used to store a user name and password? 
a. Cookie  c. Adware 
b. Spyware  d. Trojan 

7. Claudia is connecting to a Wi-Fi network at the airport. How, should she identify this Wi-Fi network to 
her operating system? 
a. As a Public network.  c. As a Home network. 
b. As a Work network.  d. As a Private network. 

8. When using a public computer, what else should you do aside from logging out of your online accounts? 
a. Clear caches and cookies. 
b. Restart the computer. 
c. Turn the computer power off. 
d. Lock the system.  

9. What do you call the practice of tricking people into giving you unauthorized access to a building or to 
a computer system? 
a. Social engineering  c. Spyware 
b. Hacking  d. Phishing 

10. Which of the following can you use to remove viruses from your computer? 
a. Antivirus software 
b. A desktop firewall 
c. Network monitoring software 
d. A hardware firewall 

11. Which of the following prevents potentially dangerous network traffic from coming into the LAN? 
a. A firewall  c. A browser cache 
b. Antivirus software  d. A modem 

12. Which of the following is designed to track and record network activities? 
a. Monitoring software  c. Login accounts 
b. Firewalls  d. Backup software 

13. Which protocol indicates you are on a secure web site for e-commerce transactions? 
a. HTTPS  c. FTP 
b. HTTP  d. SMTP 

14. Katarina is traveling and must connect securely to her company’s network in order to retrieve several 
sensitive documents. How should she make this connection? 
a. Use VPN. 
b. Use a Wi-Fi hot spot. 
c. Use her web browser. 
d. Use her web browser and type in https as the protocol. 
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15. Lee is creating a backup of his Documents folder. Which of the following locations is suitable for storing 
his backup? 
a. An external hard drive. 
b. The Desktop. 
c. On the Desktop of another user profile saved on the system. 
d. Any of these is a suitable place for storing the backup. 

16. In Windows 10 you can choose to back up personal files by copying files to cloud storage, or by using 
File History. What is the third method? 
a. Using Windows Backup and Restore 
b. Creating a restore point 
c. Using the Refresh This PC command. 
d. Using the Reset This PC command. 

17. When you create a system restore point, which files are not included? 
a. User files 
b. Program files 
c. Registry settings 
d. Operating system files 

18. Which of the following can be used to perform an iPhone backup? 
a. iCloud  c. Google Drive 
b. Dropbox  d. OneDrive 

19. If your computer tends to freeze when you start an application, what type of issue might you need to 
troubleshoot? 
a. A software issue. 
b. A hardware issue. 
c. A network connectivity issue. 
d. An invalid user name issue. 

20. Ann has been using the same Wi-Fi network all day. She took a break to go swimming. This evening, 
however, she is unable to connect. Which of the following items should she check as a possible cause? 
a. Her wireless card may no longer be turned on. 
b. The wireless router no longer supports the wireless standard she is using. 
c. She has entered the wrong user name and password when logging on to her system. 
d. The WLAN has become unsecured and will not allow her to connect. 
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Key Applications 
 
 

Lesson 8: Apps and 
Applications 
Lesson Objectives 
In this lesson, you will learn about the wide variety of apps and applications that are available to make you 
productive. Upon completion, you will be able to: 

 describe the difference between apps and 
applications 

 identify various types of application software and 
the tasks for which they are suited 

 understand and use web apps 

 use an app store to browse and find apps 

 install, delete and recover apps 

 describe the strengths and weaknesses of apps 
and applications 

Understanding Apps and Applications 
Apps, web apps, online apps, applications … all these terms describe software that we use to accomplish 
various types of tasks. However, it can be difficult to define precisely what each term refers to for the simple 
reason that users, vendors, and advertisers use the terms very loosely. Often, the terms overlap and two or 
more terms may refer to the same thing. 

For the purpose of our discussion, applications (or application software) are complex programs designed to 
be used with a mouse and keyboard. They require a fair amount of system resources and they perform a 
wide range of functions. A web browser is an example of an application program; you can use it to navigate 
the web, download files, play videos, send and receive email, chat with friends, check the weather, look up 
directions, print a map, perform banking transactions, make online purchases, and the list goes on and on.  

Apps, on the other hand, are small and light-weight; they are designed to be used on touch screen devices 
such as tablets and smart phones, and their functionality is much more focused. That is, an app does one 
main thing, and does it well. Consider the apps you may have on your smart phone. Many of these apps 
perform the individual tasks that you can accomplish in a web browser: stocks, maps, YouTube, weather, 
messaging, and so on.  

While it may be tempting to draw a line in the sand and say that apps run on mobile devices, and application 
programs run on desktops and laptops we must bear in mind that there are applications that run on mobile 
operating system platforms, and there are apps that run on desktop operating system platforms.  

A better distinction might be found in what we, as users, expect from each.  
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Application Programs 
Objective 2-6.2 

Software is introduced in Computing Fundamentals, including how to obtain, install, and manage application 
programs. An application program must be compatible with your hardware and operating system, and 
programs have specific requirements for processor power, video resolution, and memory. But how do you 
decide which application programs you should use? 

Application programs vary in price from free to almost obscenely expensive. Deciding where to invest your 
money is not always an easy task. Understanding the different types of application programs available can 
help you get a clear grasp on what is available, and subsequently, what will meet your individual needs. 

In this lesson, we will examine different types of productivity programs. A productivity program is one that is 
dedicated to producing information, such as documents, presentations, worksheets, databases, charts, 
graphs, digital images, web sites, electronic music or digital video. Different types of programs are suited for 
different types of tasks.  

It is important to select the appropriate software program for the task at hand. Many programs share a 
number of features; to choose the one that best suits your needs, you must look closely at what you want to 
accomplish. Make a list of all the tasks you need to perform, and check off items as you compare. 

Word Processing 
A word processing application enables you to create, edit, save, format and print documents. Most word 
processing programs also allow you to insert pictures and other objects. You can use a word processing 
application to create letters, memos, invoices, faxes, articles, and sometimes basic Web pages, newsletters, 
forms, brochures, or flyers.  

The following examples of documents you can produce with word processing programs include a letter, a 
newsletter, and a flyer. 
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Popular word processing applications include: 

Microsoft Word – by Microsoft. Word is a word processing application that you can use to type and format 
text and images for a variety of documents. Advanced features help you create tables, indices, and outlines. 

Word Perfect – by Corel. Word Perfect was one of the first highly successful word processors for DOS and 
Windows based systems, and it has also been available for a wide variety of operating systems.   

Pages for Mac – by Apple. Pages for Mac is a powerful word processor that you can use to create documents 
on Mac and on iOS devices. Design tools allow you to create charts, tables, bi-directional text and more. 

Desktop Publishing 
A desktop publishing (DTP) program enables you to manipulate large amounts of text and graphics that 
require a specialized page layout or structure, and then send the finished product to be printed by a 
dedicated printing service. In general, when you need to print professional documents that cannot be 
handled with a word processor, a desktop publishing application is suitable. For instance, to create a 9.5”x6” 
(24cm x 15cm) booklet with 10 pages would require you to use a booklet layout that allows content to appear 
in the proper order as the separate pages of the booklet are printed. You might also use a desktop publishing 
application to create a multi-color magazine or newspaper.  

Most desktop publishing programs contain the same features and functions available in a word processing 
program but are more flexible for manipulating items such as pictures, drawn objects, or long documents. 

Some popular desktop publishing programs include: 

Microsoft Publisher – produced by Microsoft and included in some Microsoft Office suites, Publisher is an 
easy to use, lightweight alternative to professional layout software such as Adobe InDesign or QuarkXPress, 
and is well suited for home users and small businesses. It includes typography tools and a large selection of 
templates.   

Adobe InDesign – produced by Adobe Systems. InDesign can be used to create posters, flyers, brochures, 
magazines, newspapers, and books. InDesign can also publish content suitable for tablet devices in 
conjunction with Adobe Digital Publishing Suite. 

QuarkXPress – released by Quark, Inc. Individual designers and large publishing houses use QuarkXPress to 
produce a variety of layouts, from single-page flyers to multimedia projects for magazines, catalogs and 
newspapers. 

Scribus – released under the GNU General Public 
License as free software. Scribus is a page layout 
program for Linux, FreeBSD, PC-BSD, NetBSD, 
OpenBSD, Solaris, OpenIndiana, Debian 
GNU/Hurd, Mac OS X, OS/2 Warp 4, 
eComStation, Haiku and Windows. 

The figure shows a layout for a multi-page 
booklet in a desktop publishing application. 
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Spreadsheets 
Spreadsheet programs perform mathematical calculations, help you analyze data, and produce graphs, charts, 
and diagrams. If you need to track numbers or analyze information for trends or patterns, a spreadsheet is a 
good choice.  

Spreadsheets provide the ability to sort, find or filter information, and are very useful for managing and 
manipulating large amounts of data. You can use spreadsheets to analyze and present information such as 
expenses, assignment or report marks, financial forecasts, cash flow and so on, as shown in the following: 

 
Popular spreadsheet programs include: 

Microsoft Excel – by Microsoft. Excel is part of the Microsoft Office suite. It is a spreadsheet application that 
runs on Windows, Mac OS X, Android, and iOS. It features calculation, graphing tools, pivot tables, and a 
macro programming language called Visual Basic for Applications. 

Quattro Pro – by Corel. Quattro Pro is a spreadsheet program sold by Corel, and often packaged as part of 
the WordPerfect Office suite. It was originally designed for DOS systems, but runs on Windows. Historically, 
Quattro Pro used keyboard commands close to those in Lotus 1-2-3. It is commonly said to have been the 
first program to use tabbed worksheets. 

Graphic Design and Image Editing 
Graphic design is the process of communicating through visual elements such as typography, color, space, 
and images. Graphic designers use various methods to create and combine words, symbols, and images to 
create a visual representation of ideas and messages.  

Graphic design software is used to create page layouts, logos, branding, posters, billboards, web site graphics 
and more. The creative use of images, as well image editing, is considered part of graphic design. Popular 
graphic design/image editing applications include: 

Adobe Illustrator – by Adobe Systems. Illustrator is a program used to create vector images. A vector image 
is an image generated by a mathematical algorithm, as opposed to a pixel-based image, which is composed 
of individual pixels. Vector images scale smoothly to various sizes, and are used to create logos and other 
items which must maintain a high quality appearance when printed or displayed at any size.  
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Adobe Photoshop – by Adobe Systems. Photoshop is used to modify images like graphics or photos that 
were created with a camera or an image creation program. Photoshop images are pixel-based, and you can 
use Photoshop to create raster graphics and bitmap images. These images do not scale as well as vector 
images, but they work well for projects in which images will remain at a fixed size. Photoshop is often used 
to create/edit web site graphics and photos because it includes numerous built-in filters, special effects and 
tools. 

Microsoft Paint / Fresh Paint – by Microsoft.  Paint is a simple computer graphics program that has been 
included with all versions of Microsoft Windows. You can use it to draw or paint bitmapped images and save 
them in various file formats. Fresh Paint is an upgraded version that was released with Windows 8. You can 
download Fresh Paint from the Windows Store. 

Web Development 
Although you can create web pages and web sites using only a text editor, Web development programs 
automate much of the process and help you keep your images, pages, and other elements organized and 
accessible. Most web development tools provide a WYSIWYG (what-you-see-is-what-you-get) environment 
and write and apply the appropriate web markup code automatically as users apply formats and styles with 
a toolbar.  

These applications allow you to layout pages, insert text and images, add hyperlinks and alternative text, use 
styles in cascading styles sheets, link to databases, and insert audio and video clips. Most also include tools 
that help you develop apps for mobile operating systems.  

The following figure shows a web page in a web development editor: 

 
Popular web development packages include: 

Adobe Dreamweaver – by Adobe Systems. Dreamweaver is a software program for designing web pages, 
and is a full featured HTML web and programming editor. Dreamweaver supports multiple web and 
programming languages and enables users to develop web sites and mobile applications.  

Microsoft Visual Studio – by Microsoft. Visual Studio is a complete set of development tools for building 
ASP.NET Web applications, XML Web Services, desktop applications, and mobile applications.  

Microsoft Web Matrix – by Microsoft. Web Matrix is a free, cloud-connected website builder and HTML 
editor for Windows. It includes built -in templates, coding, customization, and publishing capabilities all in 
one place. 
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Video Editing 
Video editing refers to the process of manipulating video images. Decades ago, video editing was performed 
on expensive video editing machines; but video editing software is now widely available for personal 
computers. You use a video editing application to cut (trim) segments, re-sequence clips, and add transitions, 
special effects or captions. The following figure shows the free Easy Movie Maker app for Windows 10. 

 
Popular video editing applications include: 

Adobe Premier Pro – by Adobe Systems. Premier Pro is a timeline-based video editing software application 
that runs on Mac and Windows. It supports a wide variety of video and audio file formats, and is integrated 
with other applications in the Adobe Creative suite. 

Sony Vegas Pro – by Sony Creative Software. Vegas Pro features real-time multitrack video and audio editing 
and allows you to add complex effects such as surround sound. Up to version 10, Vegas Pro runs on Windows 
7, Windows 8, and Windows 10. 

iMovie – by Apple. iMovie is a video editing application that runs on OS X. It imports video footage from 
video cameras via USB or FireWire, or it can import video and photo files from a hard drive. Once you import, 
you can edit photos and video clips, add titles and themes, make color corrections, and add music. It includes 
video enhancement tools that let you add transitions such as fades and slides.  

Presentation 
Presentation programs allow you to share information in the form of a slide show. These types of applications 
include a slide editor that allows you to create and add text to slides, as well as features that allow you to 
insert and manipulate graphic images. They also include a built-in slide show system for presenting your 
content. 

Most presentation applications allow you to add text, formatting, charts, diagrams, tables, images and even 
sound and video clips to slides. You can also add special effects such as animations, and apply different types 
of transitions as you move from one slide to another in a slide show. 
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The following is a sample of files you can create with a presentation program including an award certificate, 
and part of a presentation shown in slide sorter view. 

 

Popular presentation applications include: 

Microsoft PowerPoint – by Microsoft. Part of the Office Suite, PowerPoint is a slide show presentation 
program that allows you to create slides and presentations, embed images, audio and video, create speaker 
notes and print audience handouts. It is integrated with other applications in the office suite, allowing you 
to create tables and spreadsheets from within the application. 

Keynote for Mac – by Apple. Keynote is Apple’s equivalent to Microsoft PowerPoint. Like PowerPoint, it 
includes integrated chart and table tools, and allows you to add transitions and special effects. It also includes 
graphics tools and templates. 

Web Apps 
Objective 2-6.1 

Web apps are applications (both the lightweight and the more complex variety) that run on the World Wide 
Web. These apps do not run directly on a device nor do they require installation; they are accessed over the 
Internet and provide some of the same functionality as installed versions of the software. For example, with 
only a browser and an Internet connection you can use web app versions of Microsoft Excel, OneNote, 
PowerPoint and Word to read, edit, and create documents.  

Microsoft calls their web apps “online apps,” and some users refer to web apps as software as a service (SaaS) 
because the functionality of an installed software program is delivered to you over the Internet as a service 
via your web browser. 

Because web apps run inside a browser, they are platform-independent. That is, the same web app will run 
in a browser on an iOS device or a browser on an Android device, or a browser on a Windows desktop or a 
browser on a Mac OS X laptop. 

Files that you create or modify with web apps are stored in the cloud. Because web apps are delivered online, 
as opposed to being installed locally, they are associated with an account that is also linked to the cloud 
storage location. As long as your account is active (in good standing), you can access and use the associated 
web apps. If your account is canceled or closed, you will no longer be able to access the apps or the content 
that may be stored online. 
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Microsoft OneDrive is discussed in Computing Fundamentals; another well-known and widely used platform 
for web apps is Google Drive. 

Google Drive 
Google provides a suite of productivity apps that are linked to its online storage service, Google Drive. These 
productivity apps are:   

Google Docs – an online word processor that lets you create and format text documents and collaborate 
with other people in real time. 

Google Sheets – an online spreadsheet app that lets you create and format spreadsheets and simultaneously 
work with other people. 

Google Slides – an online presentation app that lets you create and edit slides, and insert images and video. 

You can create these documents directly from within Google Drive, or you can upload documents from a 
device, convert them to an appropriate format and continue to edit them online. You can also download 
documents from Google Drive to your device, and can select from several formats. 

Log in to your Google account, click the  (Google apps) icon at the upper-right corner of the browser 
window to display the Google Apps menu, then click Drive to view your online storage drive.  

 
To use the integrated productivity apps, click NEW. The productivity apps appear at the bottom of the menu. 

 
Click the app that you want to use to create a new document. As you work in your document, all changes are 
automatically saved to Drive. 
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Exercise 8-1: Using web apps on Google Drive 
In this exercise, you will use web apps on Google Drive. 

1. Open your browser, navigate to www.gmail.com and log in to your Gmail account. (If you did not create 
a Gmail account as directed in Lesson 5 of Computing Fundamentals, do so now if you want to proceed 
with this exercise.) 

2. At the upper-right corner of the browser window, click the Google apps icon to open the menu, then in 
the menu, click the Drive icon to access Google Drive. If necessary, close the welcome message. 

 Begin by creating a new word processing document. 

3. Click New, then click Google Docs to open a new word processing document. (If you are prompted to 
try out voice typing, click No Thanks.) 

4. Type: My name is and type your first name. 

5. Press ENTER twice to insert a blank line. 

6. Type one or two sentences about yourself. 

7. Double-click your name, then in the toolbar, click the  (Bold) button. 

8. In the browser window, click the My Drive – Google Drive tab. Notice that the untitled document is 
saved to Google Drive and displays in your My Drive folder.  

Now create a new presentation. 

9. Near the top of the My Drive – Google Drive window, click the arrow for My Drive, then in the menu, 
click Google Slides to open a new blank presentation. 

10. In the menu bar, click File, then click Rename to select the text Untitled presentation at the top of the 
window. Type: Digital Lit, then press ENTER to rename the presentation. 

11. Drag the scroll bar in the Themes panel at the right side of the window, then click the Plum theme to 
apply it to the presentation. 

12. In the slide, click the placeholder called Click to add title, then type: Digital Literacy to enter a title. 

13. In the slide, click the placeholder called Click to add subtitle, then type: Skills for Today and Tomorrow. 

 Notice that as you add text to the slide in the middle pane of the window, the text also appears in the 
slide thumbnail at the left pane. This pane is the navigation pane; you can use it to navigate among your 
slides.  

14. At the left edge of the toolbar is the  (New Slide) button. Click the arrow for the New Slide button 
to display a gallery of slide layouts, then click Title and body to add a new slide with the selected layout.  

15. In the new slide, click the placeholder called Click to add title, then type: Word Processors. 

16. In the browser window, click the Close button for the Digital Lit – Google Slides tab to close your 
presentation, then click the Untitled document – Google Docs tab to view your document again. 

17. Above the menu bar, click in the box that reads Untitled document so that you can rename the 
document. Google Docs may suggest the first line of text in the document as a file name.  

18. Type: About Me, then press ENTER to rename the document. 
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19. Close the About Me – Google Docs tab. Your Drive window should resemble the one shown in the 
following figure. 

  
20. Close the Drive tab, sign out of Gmail, then close your browser. 

Local Apps 
Objective 2-6.1, 2-6.2 

In contrast to web apps, local apps are installed on a device and run directly on that device. As such, they are 
designed to run on specific devices, and are written for specific operating systems such as iOS, Mac OS X, 
Windows, or Android. 

While you can use apps on a desktop PC (discussed in Computing Fundamentals), most people interact with 
apps on their tablets and smart phones. These mobile apps are specifically designed to run on hand held 
devices with small touch screen interfaces. They optimize the appearance of displayed data even on the small 
screen, and they are often capable of synchronizing files between devices (such as a smart phone and a 
desktop system). 

Most mobile devices are sold with several apps included as pre-installed software. For example, most smart 
phones already include a web browser, email client, calendar, mapping program, and an app for buying music 
or other media. They also include an app that takes you to the device’s app store, where you can obtain more 
apps. 

App Stores 
An app store is a digital platform for distributing software. A user accesses the app store and can browse the 
available titles, select an app, and then download the app.  

Because apps that run on devices are platform-specific, different platforms utilize different app stores: 

App Store Name Platform Notes and Devices 

Google Play Store 
(or simply, Play 
Store) 

Android The Play Store is operated by Google. Android phones and Google TV 
devices include access to the Play Store, and many also include access to 
the Amazon Appstore as well. 

App Store iOS The App Store is operated by Apple. Apps can be downloaded directly to 
iOS devices such as iPhone, iPod Touch and iPad tablet. 

On your desktop, you can access apps via iTunes.  
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Windows Store Windows This app store is operated by Microsoft. You can get apps for your Surface 
Pro or Windows 10 (or Windows 8.0/8.1) desktop here. 

Appstore for 
Android (via 
Amazon) 

Android This is an app store for Android devices, operated by Amazon.com. 
Amazon devices, such as the Kindle Fire include access to the Amazon 
Appstore (instead of access to Google Play). BlackBerry 10.3 devices also 
include access.  

BlackBerry World BlackBerry This is an app store for BlackBerry devices.  

In most cases, the app for accessing your default app store will be pre-installed on your device.  

Accounts and Access 
Many apps are tied to accounts you have created for particular services. If you want to use the Facebook app, 
you need an associated Facebook account. If you want to use a Microsoft Office app, you need to have a 
Microsoft account to use the basic features; if you want to use all the features of the app, you need an Office 
365 subscription.  

As you install an app, you will be prompted to enter any requisite account information. Thereafter, you can 
simply tap the app icon and be automatically logged in to your account. 

Additionally, many apps require access to various settings and services on your device in order to provide 
full performance. In most cases, the apps will “ask” for access when you install them or when you start using 
them. Typical areas of access include: 
• contacts list 
• location 
• phone  
• SMS 
• photos and media files 
• camera 

• microphone 
• Wi-Fi connection 
• device ID 
• storage 
• calendar 

 

Browsing an App Store 
An app store is organized like many online stores – top picks or featured items may be presented on the first 
page; however, you can usually tap an option that will allow you to browse by category. 
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Apps may be categorized by function or genre, by the device for which each was designed, or by the 
operating system each will run on. Different app stores display different categories, and many apps may 
appear in more than one category.  

App genres are loosely grouped into those described in the following sections.  

Productivity/Communication Apps 
Productivity apps are programs that allow you to get work done; you can use them to create documents and 
other files, or you can use them to communicate with co-workers, classmates, team members and so on.  

     

The following are just a few examples of the many productivity and communication apps available. 

Gmail – use this app to log in to Gmail and access your mail box(es), messages, shared documents, social 
network notifications, and whatever else you have connected to your Gmail account.  

Google Hangouts – use this app to log into Google Hangouts. Google Hangouts is a unified communications 
service that lets you participate in text messaging, voice and video chats. Contacts, saved conversations and 
other items from your account are synced to your device.  
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LINE – use this app to log into LINE. LINE is a communications application that lets you exchange texts, 
images, video and audio, and conduct free phone calls and video conferences. 

Skype – use this app to log into Skype. You use Skype to exchange texts, images, video and audio, and 
conduct free phone calls and video conferences. 

Pages – this is a word processing app developed for iPhone, iPad, and iPod Touch. It runs on the OS X and 
iOS operating systems. 

Office Mobile – these are mobile Microsoft Office apps that allow you to access, view and edit Word, Excel 
and PowerPoint documents on your phone or tablet. This app is free, but you must have a Microsoft account 
(Microsoft ID) in order to sign in and use the app. 

Word – this mobile app brings Microsoft Word to your mobile device. The app is free; but you must have a 
Microsoft ID to use the basic features. If you want to use the advanced features, then you must have an Office 
365 subscription (which is not free). There are similar apps for Excel and PowerPoint. 

Content Apps 
Content apps aggregate (group together) news and information and present them to you on your device 
whenever you launch the app. These types of apps often use your location information, your social media 
accounts, and track your online activity to bring you information that is relevant to you.  

    

A few examples include: 

CNN – brings news headlines, alerts and stories to your mobile device.  

Fox News – also brings news headlines, stories and video clips to your device. 

Google – displays local weather and traffic conditions and news headlines. 

New York Times – brings content from the New York Times newspaper to your device. This is a paid 
subscription app. 

WikiPedia Mobile – use this app to view Wikipedia articles on your phone or tablet. Apps are available for 
Android, iOS, Windows, and FireFox OS. 

iTunesU – use this app to access complete educational courses from universities and other schools. You can 
also use this app to access free educational content right on your iPad, iPhone or iPod Touch. 

Creativity Apps 
Creativity apps are those that allow you to be creative or to use tools in a creative manner. This is a very loose 
category, and depending on your app store, you may be able to find these apps in the games or editing, or 
tools categories. 

   

A few examples include: 

Afterlight – this is an image editing app that is available for iOS, Android and Windows. You can shoot and 
edit images with this photo editor app.  
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Draw Something – this app is a game in which players take turns drawing a picture to represent the guess-
word for his/her partner to guess. Correct guesses earn one to three coins. Coins can be used to purchase 
more shades of color for creating drawings, or to purchase “bombs”, which can be used to skip 
advertisements between rounds of play. The free version includes ads; the standard version allows a player 
to obtain bombs in exchange for watching advertisements, and a “pro” version was developed for iPad which 
offers unlimited bombs. 

Smart Tools – this app lets you use your smart phone as various types of tools, such as a level, a flashlight, 
a ruler, magnetic field detector, and so on.  

Social Media Apps 
Social media (or social networking) sites are web sites you can join to connect with people and share pictures, 
video, or text about yourself, your interests, your thoughts and so on.  

   

Examples of social media apps include: 

Facebook – use this app to log in to your Facebook account and view your page and other people’s pages, 
to post comments, view notifications, and so on.  

Twitter – use this app to log into your Twitter account. You use Twitter to send and read short 140-character 
messages called "tweets". Registered users can read and post tweets, and unregistered users can only read 
them.  

Instagram - Instagram is a social networking app designed for sharing photos and videos from a 
smartphone. Everyone who creates an account has a profile and a news feed, and when you post a photo or 
video, it will be displayed on your profile. People who follow you will see your posts in their own newsfeeds, 
just as you will see the posts of people you choose to follow.  

Audio Apps 
Audio apps facilitate the streaming and playing of audio content on your device. Some apps play stored 
content, while others enable you to stream audio content. 

    

When you stream an audio file, your device receives a constant flow of data from the source location and 
can begin to play back the file almost immediately. (In contrast, when you download a file, you make a copy 
of it and store it on your device. You can download audio and video files and then play them back later, after 
the copying process is complete. Downloading, however, can take a long time depending on your bandwidth 
and on the size of the file.) Streaming an audio file is like listening to the radio; it does not store a copy of 
the file on your device.  

Example audio apps include: 

Audible – provides spoken audio entertainment through digital audiobooks, radio, and TV programs and 
audio versions of magazines and newspapers. The app is free, although you will have to pay for content.  
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iTunes Music – use this app to access Apple’s streaming music catalog and stream songs to your device. 
This is a paid subscription app.  

Pandora – use this app to stream “radio station style” music from Pandora’s servers. You create “custom 
radio stations” by selecting genres of music, artists, albums and even specific songs. This app has free and 
premium paid subscriptions versions. The free versions include ads.  

Spotify – use this app to stream music from a library of over 20,000 songs. There are free and subscription-
based versions of the app, and both include a radio feature that creates a random playlist of songs chosen 
based on specified genres and decades. The free version includes ads. Some artists do not allow their songs 
to be offered through Spotify.  

Video Apps 
Use video apps to stream video content on your device. Many of the video apps described here can be used 
on a wide variety of devices, including desktop PCs, tablets, phones, game consoles, and Internet-enabled 
televisions (smart TVs).  

     

Be aware that streaming video over 3G or 4G/LTE networks can use up your monthly cellular data plan 
allowance very quickly. It is recommended that you use Wi-Fi if you want to stream video – especially high 
definition video. 

Example video apps include: 

Hulu – use this app to stream TV shows, clips, movies and other streaming media from Hulu.com. There are 
a limited number of free shows you can stream, and there are two subscription levels (limited commercials 
and no commercials) that provide access to all the available content for a monthly fee. Hulu is offered only 
to users in Japan, the United States and its overseas territories.  

Netflix – use this app to stream movies and TV shows. Although it started as a DVD rental company, Netflix 
also offers Internet video-streaming service to users in over 40 countries. Netflix also offers original television 
shows, and releases all episodes at once. There are three subscription plans: 

• the basic plan allows you to watch Netflix on one screen at a time in standard definition video quality.  

• The middle plan allows you to watch on two screens at a time and high definition is available.  

• The premium plan allows you to watch on up to four screens at a time and both high and ultra-high 
definition are available (assuming you have sufficient Internet bandwidth).  

UStream.tv – use this app to watch and broadcast live video from your iPhone, iPad or Android phone. You 
can use UStream to broadcast on 3G, 4G/LTE and Wi-Fi networks. A wide variety of membership plans are 
available. The basic plan is free, and professional broadcasting plans can cost up to $999USD/month.  

WatchESPN – use this app to watch live games and studio shows with 24/7 access to ESPN, ESPN2, ESPN3, 
ESPNU, and other ESPN-related networks. The app is free and runs on Android and iOS; it also runs on 
Windows and Mac OS X. You must have a subscription to ESPN with a participating video provider or affiliated 
TV/Internet service provider. 
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YouTube – use this app to view, rate, share, upload and comment on videos on the YouTube web site, which 
is a video sharing web site. You can subscribe to various YouTube channels and view content for free. You 
can also pay a subscription fee for YouTube Red, which gives you advertising-free access to videos. The app 
lets you browse recommendations, see the latest from your favorite channels and look up videos you have 
liked and watched previously, all from within the app. 

Searching in the App Store 
In addition to browsing the categories, you can type the name of a specific app in the Search bar and search 
for it. The app store will display the best matches. 

 

 

As you view the items in the app store, you will notice that many apps are free, but for some, there is a 
charge.  

The price is usually displayed in the vicinity of the rating. 

Obtaining an App 
Obtaining an app is a matter of finding the one you want and tapping it to install it.  

Open the app store on your device, and browse the categories, or if you know the name of the particular app 
you want, search for it using the Search bar. 

When the app appears in the list, tap it to open its detail page. 

Notice that you can view the average rating, the 
number of downloads, and possibly see a list of 
similar apps. In some cases, you can tap a link to read 
more about the app.  

Click Install to download and install the app. When 
the installation is complete, the app will display an 
Open button. 
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Tap Open to launch the app. 

 

Some apps require you to accept certain terms and 
conditions. 

 
Some apps will ask for permission to access 
particular features before they open for the first time. 

Once you have accepted the terms and granted 
appropriate permissions, the app will run. 

 

Paid Apps 
The procedure for installing a paid app is essentially the same as installing a free app, except that you must 
also enter payment information.  

Instead of an Install button, the app’s detail page displays a price button. Tap the price and follow the screen 
prompt. 

 
 

You will be prompted to enter payment information or enter a code that can be redeemed to complete your 
purchase.  

 
The options that display will vary depending on your device 
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In-App Purchases 
In-app purchases are purchases made from within a mobile app. Many free apps include options for in-app 
purchases. Typically, you would make an in-app purchase in order to access special content or unlock certain 
features, or to turn off advertisements, or obtain virtual money or special powers in a game. When you make 
an in-app purchase, the purchasing process is completed directly from within the app and it may be as quick 
and easy as tapping an icon, depending on how you have configured your device. 

You can configure settings on your mobile device that make in-app purchase streamlined or force you to 
enter a password. If you want the process to be automatic, you must make sure that your payment 
information is up to date. 

However, if you configure your device to ask for a password, it is much less likely that you will be surprised 
by accidental or unwanted purchases.  

Authenticating Purchases 
Requiring authentication for all purchases requires that you enter a password any and every time you (or 
someone else using your device) begin to make an in-app purchase. 

On Android devices, you can protect against accidental or unwanted purchases 
by turning on Authentication: 

1. Open the Google Play Store app. 

2. Touch the menu icon, then tap Settings. 

3. Touch Require authentication for purchases. 

4. Choose a setting 

5. Follow the on-screen instructions (for example, you may be asked to enter 
your Google password), then click OK. 

To protect against accidental or unwanted in-app purchases on your iPhone, you can add restrictions to 
protect your iTunes Store account: 

1. Go to Settings > General > Restrictions. 

2. Tap Enable Restrictions. 

3. Enter a Restrictions passcode that you'll remember and confirm your passcode. You should choose a 
passcode that's different from the passcode you use to unlock your device. 

 After you tap Enable Restrictions, you'll see what's allowed on your device. To prevent only in-app 
purchases, turn off In-App Purchases.  

If you want to disable purchasing completely, turn off iTunes Store, iBooks Store, Installing Apps, and In-App 
Purchases. 

Deleting an App 
If you do not want to use an app any longer, you can uninstall it from your device. 

To delete an app on an Android device: 

1. Open the Google Play Store app. 

2. Touch the menu icon, then tap My apps & games. 
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3. On the Installed tab, touch any app labeled “Installed” to open the options. 

4. Tap Uninstall to remove it, and confirm the deletion if prompted. 

5. Close the Google Play Store app. 

To uninstall an app on an iPhone or iPad: 

1. Start your device and go to the Home screen. 

2. Find the icon for the app you want to delete. 

3. Press and hold the icon until all of the phone’s icons begin to jiggle. This causes each icon to display a 
small “x” at the upper-left corner. (Apps that come pre-installed on iPhone or iPad cannot be deleted, 
and will not display the x.). 

4. Tap the x for the app you want to remove, and confirm that you want to delete the app and its data. 

Recovering a Deleted App 
If you accidentally delete an app, or if you delete it on purpose and then change your mind, you can recover 
the app without having to pay for it again. 

On Android: 

1. Open the Play Store. 

2. On the Play Store home page, click the Menu 
button. 

3. Tap My apps & games. This displays a list of 
apps in two tabs – the Installed tab, and the All 
tab. 

4. Tap the All tab and view the list of apps. Apps 
that are currently installed will display either the 
word “Installed” or the word “Update.” Apps that 
you have deleted will display either the word 
“Free” or the word “Purchased.” 

 
5. To recover an app, tap it in the list, then click the 

Install button to re-install it on your device. 

On iOS: 

1. Open the App Store. 

2. Tap Updates from the menu at the bottom. 

3. Tap Purchased. This displays a list of apps in two 
tabs – the All tab and the Not on This iPhone tab. 

4. Tap the Not on This iPhone tab and view the list 
of apps.  

  
5. Find the app that you want to recover, then tap 

on the cloud icon to reinstall it. 
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Note that you can also search for the app on the App Store and download and install it again. When you 
download an app that you have already paid for, you will not be charged again. 

Exercise 8-2: Working with mobile apps 
In this exercise, you will browse an app store, install, launch, and then delete an app on your mobile device.  

Note: This exercise assumes that you have a mobile device and sufficient rights to install free apps. 

1. On your mobile device, access the Home screen. 

2. Tap Apps if necessary, then access your device’s default app store. List a few of the apps that appear at 
the top of the screen.   

3. Describe how the apps are organized. 

4. Find and tap a button that will allow you to view apps by category. Are there several categories available? 
Are your surprised by how many there are? 

5. At the top of the screen, click in the Search box and type: dictionary, then tap the Search button. Are 
there many dictionary apps available for your device? Are there more than simple dictionaries listed? 

6. Tap one of the free apps to view its detail page. How many times has the app been downloaded? What 
other information about the app can you see? 

7. Install the free app and give it access to some of your device’s features. How long does it take to 
download the app? 

8. When the Open button displays, tap it to launch the app. 

9. Spend a little time in the app. (If the app includes in-app purchases, be careful to avoid making any 
accidental purchases.) Does the app include advertising? 

10. Evaluate the app: Is it easy to use? Is it useful? 

11. Close the app (by tapping its Close button) and return to the Home screen. Did the app add its icon to 
your Home screen? 

12. Use the steps appropriate for your device in the Deleting an App section of this lesson to uninstall the 
newly added app. 

Limitations 
Objective 2-6.3 

Apps and application software can bring the power to get things done right to your fingertips. They enable 
you to create and work with a wide variety of documents and files on various devices and from various 
locations. 

However, it is important to remember that apps and applications are designed for specific hardware and 
specific operating systems. Accordingly, you may not be able to find a specific app in your app store. For 
example, even though the Amazon Kindle Fire runs the Android operating system, there is not (as of the time 
of this writing) an app for the Chrome web browser that is supported on the Kindle. Instead, Kindle offers its 
own web browser named Silk. 

If you cannot find a specific app, you can usually find comparable ones – most app stores group similar apps 
near one another.  



Apps and Applications Lesson 8 
 

 

7500-1 v1.00 © CCI Learning Solutions Inc.  261 

In cases where an app is available only for specific versions of a mobile operating system, you may be able 
to upgrade the operating system on your device if upgrades are available, and then install the desired app. 

Keep in mind also that an installed app must work with the hardware on your device. You may install a full-
featured photo editing app on your phone, but if your phone has a low-quality camera, your photos will only 
be as good as the hardware allows.  

Lesson Summary 
In this lesson, you learned about the wide variety of options you have when choosing apps and applications. You 
should now be able to: 

 describe the difference between apps and 
applications 

 identify various types of application software and 
the tasks for which they are suited 

 understand and use web apps 

 use an app store to browse and find apps 

 install, delete and recover apps 

 describe the strengths and weaknesses of apps and 
applications 

Review Questions 
1. Which type of program is designed to be used on touch screen devices such as a tablet? 

a. Application programs b. Apps 

2. What is a productivity program dedicated to? 

a. Producing information 
b. Keeping track of files or folders 
c. Recording the amount of time you spend online 
d. Tracking items you search for 

3. What do some users refer to web apps as? 
a. Shareware  c. Software as a Service 
b. Add-ware  d. Freeware 

4. Which term properly describes a web app that will run in a browser on any computing device regardless 
of the operating system being used? 
a. Compatible  c. Productivity programs 
b. Platform-independent d. Cloud based 

5. What is a digital platform for distributing software called? 
a. Downloading  c. App store 
b. E-commerce  d. Vendor Cart 

6. What do you need to have before you can use the Facebook app? 
a. Facebook account   c. Apple account 
b. Microsoft account  d. Google account 
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7. Which of the following is an example of a productivity/communication app? 
a. Twitter  c. CNN 
b. Skype  d. iTunes 

8. What kind of app groups news and information, presenting them on the device when you launch the 
app? 
a. Productivity/Communication  c. Audio 
b. Social Media    d. Content 

9. What type of app is the Smart Tools app? 
a. Content    c. Creativity 
b. Productivity/Communication  d. Social Media 

10. Which program best represents what you can do on a social media or social networking site? 
a. Netflix c. Instagram 
b. Google d. iTunes 

11. What is it called when your device receives a constant flow of data from a source location and then plays 
the file instantly? 
a. Downloading c. Uploading 
b. Streaming d. Flowing 

12. Which of the following apps can stream video to your device? 
a. Hulu c. iTunes 
b. Spotify d. Facebook 

13. Which option should you use when you want to obtain an app? 
a. Install b. Open 

14. How can you access special content or unlock certain features in an app? 
a. Make an in-app purchase. 
b. Buy the full version of the app in the app store. 
c. Download a cheat sheet from another user. 
d. Purchase the special content from the vendor’s web site. 

15. Lucy wants to put the Hoop-de-Doo app on her BlackBerry, but she cannot find it in the BlackBerry World 
app store. What is the most likely reason for this? 
a. Lucy has not finished paying for her BlackBerry phone. 
b. Lucy does not have a Hoop-de-Doo account. 
c. The app is not compatible with the BlackBerry operating system. 
d. Lucy has required authentication for all her in-app purchases. 
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Key Applications 
 
 

Lesson 9: Using Microsoft Word 
Lesson Objectives 
This lesson introduces how to use a desktop application, specifically Microsoft Word, to create simple documents. 
You will also be introduced to common features you will find in other desktop applications. Upon completion of 
this lesson, you will be able to: 
 start and exit Microsoft Word 
 identify some common screen elements 
 create, save, and open documents 
 change view options for documents 
 insert, select, modify, and format text 
 manipulate text using common features 
 use the ruler to create, modify or delete tab settings 
 change margins, paper size, or the orientation 

 insert or remove page breaks 
 insert or remove page numbers 
 apply column formats 
 use find and replace 
 print and preview documents 
 insert pictures or multimedia files 
 work with tables 
 track changes made in documents 

Identifying Common Features 
Every computing device follows specific standards for how an app or application works; this is often set by 
the operating system installed on the device. For instance, every touch-screen device allows you to use a 
finger and tap to access the program or a feature such as playing a song. It also enables you to use your 
index finger and the thumb to “pinch” in or out to zoom in or out on the screen. An Apple device such as the 
MacBook displays icons at the top left corner of the program window to minimize, maximize, restore down, 
or close a program. A Windows device also has icons to minimize, maximize, restore down, or close a 
program; the difference is that these icons are located at the top right corner of the program window.  

You will find as you begin using various devices (whether they are mobile or desktop models), that there are 
a number of common elements on the screen and that there are common methods for performing specific 
tasks. Many of these common elements appear in the same location on the screen; for example, the first two 
tabs of the ribbon in any Microsoft Office program are the File and Home tabs. Other tabs in the ribbon are 
program-specific. 

Among application programs, and often within the operating system as well, you can use common methods 
to perform actions such as copying, moving, and pasting items, selecting items, navigating the interface, 
formatting or enhancing the look of text, and printing. Additionally, the same keyboard shortcuts are 
assigned by default in many programs for accessing these common features. For instance, press CTRL+C to 
copy a selection or press CTRL+A to select all items in the document. 
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These common features are demonstrated throughout this course, beginning with Microsoft Word. As you 
progress through the lessons, you will come to see that they are relatively universal.  

Starting an Application 
To start an application installed on a Windows 10 device: 

1. Click the Start button at the lower left corner of the taskbar. 

2. Click the All Apps command. 

3. Scroll in the list and click the menu item for the application you want. For example, to start Word, click 
Word 2016. 

Hint: If the system has been set up to display icons on the taskbar for the Microsoft Office programs, click 
the  icon to start Word. 

Exiting an Application 
To exit or close an application installed on a Windows 10 device, click the  (Close) button at the top right 
corner of the application window. 

Hint: If the system has been set up to display icons on the taskbar for the Microsoft Office programs, point 

at the  icon and click the  (Close) button for this preview window. 

Understanding the Backstage View 
When you first start an Office 2016 application, the program will display a startup screen of available 
templates to help you get started quickly. A template is a boiler plate that already contains elements, such as 
sample text, and format settings. Office programs include templates for a wide variety of documents. The 
startup screen is one of the tabs (the New tab) in the Office Backstage view. 
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You use the startup screen to indicate the type of document you want to work with. You can choose to create 
a blank new document (or workbook, or presentation) by clicking the first template listed in the gallery or 
you can click one of the other templates to create a document that includes pre-configured elements.  

You can access the other elements of the Backstage view from the startup screen by clicking the Open Other 
Documents link.  

Use the Backstage view to create, open, save, print and manage your files. The commands and options 
available here are related to things you can do with the entire file itself. For example, you can display 
information about the file, create a new file or open an existing file, assign a password, save a file with a 
different name, print or share the file with others. 

You access the appropriate commands on the various tabs of the Backstage view. These tabs are: Info, New, 
Open, Save, Save As, History, Print, Share, Export, Close and Account. The New tab is the startup screen. 

Looking at the Edit Screen 
Microsoft Word is one of the most popular word processing programs used for creating various types of 
documents, from a short letter or memo to an annual report or brochures. 

Once you start Word and choose a new blank document, the screen appears similar to the following: 

 

File Tab – Click this tab to open the Backstage view to manage files.  

Quick Access Toolbar – Gain quick access to frequently used commands.  

Title Bar – Indicates which file and program is currently displayed in the window. 

Minimize/Maximize/Restore Down/Close – Affect the size of the application window on the screen.  

Ribbon Tabs – Click a tab to access commands to complete a specific type of task. 

Insertion Point 

Status Bar View Buttons 

Zoom Slider 

File Tab 
Quick Access Toolbar Ribbon Tabs 

Min/Restore/Max/Close 
Ribbon Display Options Title Bar Tell 
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Tell Me – A Help option where you can type keywords about a particular type of task and view information 
from the Word Help system on how to complete that task. 

Insertion Point – The flashing bar on the screen that indicates your current position in the document; 
commonly referred to as the cursor. 

Status Bar – Find information about the document currently displayed, such as which page or slide you are 
viewing, or the total number of pages, or whether an error condition exists.  

View Buttons – Click to quickly change between the different document views available in the application. 

Zoom Slider – Click the buttons to zoom in or out in increments of 10%, or drag the slider button to a 
specific zoom percentage.  

Accessing Commands and Features 
Many features and conventions shown here in Word are consistent across all programs in the Office suite.  

Using ScreenTips 
Use ScreenTips to help identify buttons or elements on the tabs 
of the ribbon and on the screen. To view a ScreenTip, position 
the mouse pointer over the item. A tip displays the name of 
the button or feature and sometimes a brief description of its 
purpose. In some cases, the ScreenTip will provide a keyboard 
shortcut as an alternative way to activate the feature. 

Using the Quick Access Toolbar 
The Quick Access toolbar is located above the File tab and includes buttons for frequently used commands. 
By default, this toolbar includes the Save, Undo, and Redo buttons. (If you have a touch screen device, it may 
also include a Touch/Mouse Mode button as seen in the following image). You can customize the Quick 
Access toolbar to include additional commands you want to access quickly, such as opening a new blank 
document, printing a document, or running a spell check. 

 
When you point at or click a button on the Quick Access Toolbar, it will appear with a different background 
color.  

Using the Ribbon 
The ribbon helps you quickly find the command buttons you require to complete a task. Command buttons 
are grouped logically on each tab, with each tab relating to a type of activity, such as inserting pictures into 
a document. Some tabs appear only when they are applicable as when a picture or table is inserted into the 
document. 

 
• A command button is active when it appears with a different color background, as seen with the Align 

Left button in the previous image. 
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• A command button with an arrow provides two choices:  

– click the command button to activate this option with the current settings; 
or 

– click the arrow to display a drop-down menu with more options for that 
command.   

Each tab on the ribbon includes groups of related commands; for example, the Home 
tab includes a Font group that includes buttons for formatting text characters, while 
the Insert tab includes an Illustrations group from which you can select different 
types of media to insert into a document. 

If a group includes a feature with a scroll bar or scroll buttons, click 
the  More button below the bottom scroll button to display a 
full list or gallery of choices for that feature. For example, you can 
click the More button in the Styles group on the Home tab of the 
ribbon to display a full gallery of document styles as shown here. 

When you position the mouse pointer over an option in a gallery, 
the program displays a live preview of how the selected item will 
appear if you apply that option. You can turn off the preview option 
in File, Options if you prefer. 

Some groups on the ribbon include a Dialog box launcher button 
at the lower right of the group. Click the dialog box launcher to 

open the corresponding dialog box, task pane or window associated with the feature you want to apply. For 
example, click the dialog box launcher in the Paragraph group on the Home tab to open the Paragraph dialog 
box. Click the dialog box launcher in the Clipboard group on the Home tab to open the Clipboard task pane. 

  
 Dialog Box Task Pane 
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Controlling the Display of the Ribbon 
The ribbon can be hidden or minimized temporarily to make more space on screen for the document, 
worksheet, or slide you are working with. To minimize the ribbon: 

• Double-click a tab, or 

• Click  (Collapse the Ribbon) on the far right of the ribbon. 

To redisplay the ribbon, click the  (Ribbon Display Options) button 
at the top right of the screen and then select the display type from the 
menu. You can also double-click a ribbon tab to display the ribbon again. 

Entering and Editing Text 
Objective 2-1.6, 2-2.5 

Typing involves using the keyboard to input or enter text seen on the screen. 

Editing includes actions such as inserting and deleting single characters, words, or multiple lines of text, 
correcting typographical errors, and inserting or deleting blank lines between paragraphs. 

The following are basic concepts related to typing and editing text: 

• You can type or insert text at the insertion point in any location you want. The insertion point will move 
to the right as you type. To move the insertion point to another location in the document, click at that 
location. 

• To remove text, use the BACKSPACE key to delete characters to the left of the insertion point; or press 
DELETE to delete characters to the right of the insertion point. 

• Press ENTER only when you want to end a paragraph or to add a blank line. 

These basic concepts are applicable to all word processing programs, regardless of the software vendor. A 
major benefit of word processing programs is that they allow you to focus on creating the content. For 
example, a feature called word wrap enables you to type continuously; the program will automatically move 
the insertion point to the next line as you reach the right margin. You need to press ENTER only when you 
want to start a new line. 

Using the Rulers 
The Rulers help you identify where to position text – vertically or horizontally. To turn the ruler on or off, on 
the View tab, in the Show group, click Ruler. 

 
The ruler uses the default measurement for your location (we use inches as our measurement). You can 
change the unit of measurement in the Display area of the Advanced category in Word Options. You can 
select from inches, centimeters, millimeters, points, or picas. 
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Selecting Text 
Selecting or highlighting text tells Word exactly which portions of text you want to change. Once text has 
been selected, the selection remains in place until you de-select it; this allows you to apply multiple actions 
to that selection. The only exception is when you delete or replace the selection with new text. 

If you inadvertently make the wrong selection or you wish to remove the selection, click anywhere in the 
document window or press any arrow direction key to de-select, and then begin the selection procedure 
again.  

You can select text using the mouse or keyboard, and occasionally you may want to use a combination of 
mouse and keyboard to select larger pieces of text. 

Selecting Consecutive Text 
To select text using the mouse, position the mouse pointer at the beginning of the text to be selected and 
then drag to highlight the text. 

Hint: To select text using the keyboard, position the insertion point, hold down SHIFT, and then press the 
arrow keys to move the insertion point to highlight the text. Release SHIFT when the text is highlighted. 

• To select a word, double-click the word.  

• To select a sentence, hold CTRL and click anywhere in the sentence.  

• To select a paragraph, triple-click anywhere in that paragraph. 

• To select the entire document, on the Home tab, in the Editing group, click Select and then click Select 
All; or press CTRL+A. 

Selecting Non-Consecutive Text 
To select multiple pieces of text in different areas of the document, you must select the first piece of text and 
then press and hold CTRL as you select the next piece of text.  

Managing Files 
Objective 2-1.2, 2-1.9, 2-1.10, 2-2.4, 2-2.10, 2-2.11 

As noted previously, it is important to understand file management so you can save and open documents. 
The concepts learned in working with files in an operating system can be applied here when determining 
where to save files or where to find files to open to the screen. 

Saving Documents 
It is important to save your documents frequently as you work on them. This ensures that if an unexpected 
problem arises, such as a power outage, you will have a recently-saved version of your work and not be 
forced to recreate all of it. You can save files to any location on the local drive, a network drive, or a portable 
media device such as a USB flash drive. Once you have saved a file, you can retrieve or open it from any of 
these locations. You can have multiple documents open on the screen, including new documents that you 
have not saved yet. 

To save a document, click the File tab and then click Save or Save As. 
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Key Fact: You can also click the  (Save) button on the Quick Access toolbar; or press CTRL+S to quickly 
save the document. 

To save an existing document with a different name, use Save As in the File tab. 

The first time you save a document, the Backstage view opens with the Save As tab selected. The first panel 
displays the available locations for saving your document (these locations are associated with your Microsoft 
or network account).  

 
The second panel provides you options regarding the file name and file type. It will also display a list of 
commonly-accessed folders (for example, Documents, or Pictures). These folders vary based on the location 
currently selected in the first panel. For instance, the first screen in the following images displays what appears 
if you are using OneDrive, the online storage location provided by Microsoft; the second image displays 
folders available in the Documents folder on the local drive. 

  
Notice how the location is clearly identified at the top of the second panel, thereby giving you the option to 
click the arrow before the location name if you want to move to another location. You can also click More 
options (below the file type) to open the Save As dialog box, from which you can navigate to any location. 

Drives or 
locations to save 

  

File name 

Save as type 

Up One Current 
Level Folder 

Folders or documents  Date created 
in current folder or modified 
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Click Save to save the document. 

How often you save a document depends on how much work you put into it. If you make a large number of 
changes, save the document frequently as you work to preserve your changes. If you see a message from 
Word prompting you to save a document, this means Word recognizes something has changed in the 
document since it was last saved. If you’re not sure whether you should save the document again, err on the 
side of caution and save it with a different name than the original.  

Understanding Word and File Types  
By default, Word automatically assigns a .docx extension to the end of the file name; however, you can save 
a Word document in other file formats.  

Word, like most word processing applications, can handle several document types. This allows you to create 
a file in one program and save it to a format readable by other programs. For example, if you create a file in 
Word and need to share the file with someone who does not have Word, but has an application that supports 
any of these listed file types, you can save your document to the type you have in common and then 
successfully share the file. 

File types commonly associated with word processing programs include: 

• Word Document (.docx) – this is the file type associated with Microsoft Word 2007 and later. This is the 
default format for Word 2016. 

• Word Document (.doc) – this is the file type associated with Microsoft Word versions prior to 2007. Many 
word processing programs can open files with a .doc extension. 

• Plain Text (.txt) – a text file that can be read on any operating system. This format does not include 
formatting of any kind, nor does it include tables or images. 

• Rich Text Format (.rtf) – a text file that preserves font and paragraph formatting and can include 
embedded images. 

  



Lesson 9 Using Microsoft Word 
 

 

272  7500-1 v1.00 © CCI Learning Solutions Inc. 

• Portable Document Format (.pdf) – a file format developed by Adobe Systems that allows you to view 
documents (with formatting and images) on any operating system. 

• Publisher Document File (.pub) – the default file format used in Microsoft Publisher. This type of file 
includes layout information and can include formatting, graphics, hyperlinks, charts and other types of 
objects. 

To save a Word document as a different file type, click the arrow for the Save as type field (the field below 
the file name field) to display a list of available file formats. 

 

Starting a New Document 
Each time you start Word, the Backstage view appears where you can easily create a new blank document, 
choose from a variety of built-in templates that will help you lay out particular types of documents (such as 
invitations, meeting agendas, or business memos), or open an existing document. 
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• To create a new blank document, in Backstage, click New and then click Blank document from the list 
of documents. 

Key Fact: You can also press CTRL+N to quickly create a new blank document. This shortcut can be used in 
all Office applications. 

• To choose from the variety of pre-designed templates for a new document, click one of the templates 
displayed, and click Create. 

Each time you create a new document, a document number will automatically appear in the title bar. For 
example, if you have three new Word documents open and you create another new one, Word will assign it 
the number “4” and the title bar will display “Document4.” Document numbering resets back to Document1 
each time you start a new session of Word. Use this generic name as a reminder that you have not yet saved 
the file with a descriptive and memorable name. 

Closing a Document 
Once you have finished editing a document, close the document to clear the screen and memory; this enables 
you to start or open another document without old documents cluttering up your screen.  

To close a document, click the File tab and then Close. 

Key Fact: You can also press CTRL+W or CTRL+F4 to close a document quickly. This shortcut can be used 
in all Office applications. 

To close the Word application, click  (Close). 

Opening a Document  
Once a file is saved, you can open it from wherever it is located; the document is presented on the screen for 
further processing. You can open as many documents as needed; only the amount of available memory on 
your system limits the number of documents you can have open simultaneously.  

Use one of the following methods to open a document: 

• Click the File tab, click Open, and then click the file name from the list of Recent documents; or 

  
• click the File tab, click Open, click the location where the file or its folder is located and click Browse to 

select the file using the Open dialog box. 



Lesson 9 Using Microsoft Word 
 

 

274  7500-1 v1.00 © CCI Learning Solutions Inc. 

  
Key Fact: You can also press CTRL+O or CTRL+F12 and then navigate to where the file is located. This can 
be used with all Office applications. 

Read-only Mode and Protected View 
The Read only attribute can help prevent others from making changes to a document. There are two methods 
you can use to apply this attribute to a document from within Word. 

Any time you open a document that comes to your computer over the Internet (for example, as an email 
attachment), Word opens the document in Protected View. Protected View automatically applies the read-
only attribute to the file until you specify otherwise, thereby protecting you from content that may potentially 
contain viruses, malware, or other items that can be harmful to your computer. 

You can identify a file that is in Protected View the moment you open it. When the file is opened, Word 
displays a message below the ribbon similar to the following: 
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You can click Enable Editing to open the document for editing, or you can choose to keep working in 
Protected View to protect your computer or to ensure that you do not inadvertently make changes to the 
file while you are viewing it.  

A file opened in Protected View is in read-only mode; you will not be able to do anything other than read 
the file until you click Enable Editing. When you view the properties for this file in Backstage, the following 
screen displays: 

  
Notice that Word reminds you that you are still in Protected View. You can then choose to view more 
information about this mode, or choose another action.  

You can manually open a file in Protected View using an option in the Open 
dialog box. Click File and Open, then click Browse to open the Open dialog box. 
Navigate to the file, click it to select it, then click the arrow for the Open button 
and click Open in Protected View. 

Notice that you can also choose to open the file in read-only format if you do 
not want to inadvertently make changes to the document. If you select this 

option, Word will prompt you to save the file with a different name, thereby keeping the original file intact. 

Opening or Saving with the Read-Only Option 
The Read-only option can be applied to a document when you open it or when you save it. 

To open a document as read-only, display the Open dialog box, select the file to open, then click the arrow 
for the Open button, then choose the Open Read-Only command. 

To save a document with the read-only feature, use a method to save 
the document that will display the Save as dialog box. Then click the 
arrow next to the Tools command and click General Options. 

Once you click the Read-only recommended option, you can click OK 
and then click Save. Anyone who opens this document is then notified 
that the file is read only and can only be saved with a different name 
than the original. 
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Exercise 9-1: Blog Entry 
In this exercise you will create a new document and then save it in different file formats for use in other 
programs. 

1. Start Microsoft Word, if necessary, click Blank document and then type the following text, pressing 
ENTER whenever you see the ¶ symbol (make corrections using the BACKSPACE or DELETE key): 
Welcome to My First Blog!¶ 

I have always wanted a place where I can freely express my opinions or comment on 
things I find fascinating or intriguing.¶ 

I will try to ensure my blog entries are fun and interesting for everyone who decides 
to follow me. I will also try to blog on a regular basis and will welcome all 
comments as we can learn a lot from each other.¶ 

2. On the Quick Access Toolbar, click Save. 

3. Click This PC in the center pane and click the arrow next to the Documents folder in the second panel. 

  
4. Click the Desktop folder, click the 7500-Student-Files folder (or navigate to the location where the data 

files for this courseware are located) and click the Word folder. 

  
5. Click in the filename field, type: My First Blog - Student (use your own name or initials in the place of 

“Student”) and press ENTER. 
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 The document has now been saved. You can also confirm the document has been saved by looking at 
the title bar which should now show My First Blog - Student - Word. 

Now create a new blank document and then create a new document based on a template provided by 
Microsoft. 

6. Press CTRL+N to create a new document. 

 A new blank document displays on the screen (the Document# will vary depending on how often you 
press CTRL+N before or during this exercise). 

7. Click File and click New. 

8. Click the Blog post template. 

  
 Use this window to see a preview and description of the template. You can decide if you would like to 

use this template to create a new document. Notice how this template for a blog entry is already 
formatted with commonly-used styles for this type of document. 

9. Click Create. 

 Depending on whether someone has created a blog report previously, you may see a message that 
prompts you to register on a blog site when you create a new document based on this type of template. 
The template includes placeholders in which you can enter your personal information. These 
placeholders are field codes. For the purpose of this exercise, click Register Later. 

10. Click in the [Enter Post Title Here] field code and type: Global Warming. 

 Notice how Word automatically replaced the existing text with the new text when you clicked the field 
code.  

11. Click in the blank line below the horizontal line, and type the following: 
A lot of people have been talking about this topic for years now – some claim 
global warming is happening and increasing significantly every year, while 
others claim it is a huge scam. How many of us truly know what global warming is 
and what is really changing in the world?¶ 

12. Press CTRL+S to save the document. 

13. Click This PC and then navigate to click the Word folder as directed in step #4. Click in the filename 
field, type: Global Warming Blog - Student and click Save. 

Suppose you are asked to save a copy of this file in a different file format so the file can be adjusted by 
someone with an old version of Word. 
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14. Click File and click Save As. Ensure This PC is selected and then click the Word folder if necessary. 

15. In the file name field, adjust the file name to Global Warming Blog (old Word) – Student, click the arrow 
for the Save as type field and click Word 97-2003 Document. Click Save. 

  
16. Click Continue to have Word maintain the compatibility check when saving the file. 

 Notice how the title bar in Word reflects the compatible file format: 

  
Suppose you have been asked to save this file in a format that can be inserted into a web design program 
such as Adobe Dreamweaver or given to someone who may need the text to be compatible with the HTML 
language used for web pages. 

17. Click File, click Save As, change the file name to Global Warming Blog (web) – Student, then click the 
arrow for the Save as type field. Scroll in the list and click Web Page (*.htm, *.html) and click Save. 
Notice that the file retains its formatting: the heading is bold and in a large font; there is a horizontal 
rule across the page, and then your blog post paragraph is displayed underneath. 

Suppose now that you have been asked to save this file again as a plain text file so that if there are problems 
with the HTML code created by Word, the web master can import text from the plain text file. Plain text files 
do not include any formatting. 

18. Click File, click Save As, change the name of the file to Global Warming Blog (plain) – Student, and then 
click the arrow for the Save as type field. Scroll in the list and click Plain Text (*.txt) and click Save. 
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19. Click OK to allow Word to convert the file to plain text. 

Now try working with basic file management tools. 

20. Click the Close button at the top right corner of the current document window and click Don’t Save if 
prompted to save the changes. 

 The document should no longer be visible on the screen. 

21. Using the Windows taskbar, point at the Word icon to display the preview windows for each document. 
Move to the one with the new blank document and click the Close button in the preview window to 
close this document. 

22. Click inside the first blog document, then press CTRL+W to close the document.  

 The Word application window remains open with no open documents. 

 The screen should now display with a grey background (depending on your color scheme). 

23. Click the File tab, then click Open to display the Open tab of the Backstage view. 

 The list in the right pane shows the Word documents you recently worked on under the Today title. If 
there are any other recently used documents on this computer, they will display below the list of 
documents for today also. 

24. Click My First Blog - Student. 

 This document opens and displays on the screen. 

25. Click the File tab and click Open. 

Notice that there are four documents listed for the Global 
Warming Blog files; also notice the icon at the left of the file that 
identifies the file format of the document. 

 

 

26. Click the Global Warming Blog (old Word) file with the outlined Word icon – this is the document you 
saved in Word 97-2003 format. Click Register Later, if necessary. 

27. Press CTRL+O, and in the Recent list for Today, click the Global Warming Blog (web) file with the 
Internet Explorer icon at the left (this should be the HTML version). If prompted with the message to 
register on a blog, click Register Later to continue. 

 This file will appear similar to the Word version. However, an HTML file saved in Word may not always 
render perfectly in a web design program or inside a web browser. This is why a web designer may ask 
you for the file in plain text so he/she can format the page from scratch. Let’s look at this page in a web 
browser. 

28. In the taskbar, click the File Explorer icon, navigate to the Word folder in the 7500-Student-Files folder, 
then double-click the HTML version of this document to open it a web browser. Does it look exactly the 
same as it does in Word or can you see subtle differences? The more complex the formatting, the more 
opportunities there are for unexpected results in the web browser. 
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29. In the taskbar, point at the Word icon and click inside any one of the open documents to return to the 
Word window. 

30. Press CTRL+O, and in the Recent list for Today, click the Global Warming Blog (plain) file with 
horizontal lines, but no application icon. (This is the plain text file.) 

31. When prompted, click OK to allow Word to convert the file to plain text. Notice that plain text includes 
no formatting, and no graphic elements. 

   
Now try opening a file created by someone else. 

32. Press CTRL+O, click This PC, and click the path that shows where the student data files are located at 
the top of the list. 

33. In the Open dialog box, click Newsletter A01, then click Open.  

34. On the Windows taskbar, point at the Word icon and click the My First Blog – Student preview window 
to switch to this document. 

35. Click File, click Save As and then click More Options. Click the arrow next to the Tools command and 
then click General Options. 

36. Click Read-only recommended and click OK. Click Save. 

37. Close the open Word documents, but leave the application window open. 

38. Open the My First Blog – Student document. Word alerts you that the author has suggested that you 
open it in read-only mode. 

  
39. Click Yes to open the document in read-only mode. 

40. Close all documents without saving. 

41. Close the web browser and close the File Explorer window. 

Manipulating Text 
Objective 2-1.1, 2-1.7, 2-1.8, 2-1.11 

Editing is the process of adding, deleting, or changing text. In many cases, you will select text before you edit 
it. Be careful when making changes to selected text. The moment you press a key or click an option, all the 
selected text is affected. 



Using Microsoft Word Lesson 9 
 

 

7500-1 v1.00 © CCI Learning Solutions Inc.  281 

Customizing the View 
On occasion you may need to change the view to see more or less of the 
document before you can select the piece of text. You can adjust how a 
document displays by selecting the appropriate option using the View tab. 

Read Mode  – Useful for reading a document, as pages are adapted to the size 
of your monitor for easy reading. A series of buttons you can use in Read mode appears across the top of 
the screen. This view displays automatically when you are viewing a Word file sent as an attachment in email. 

Print Layout – Displays file contents as if you sent the document to the printer, and this is the only view in 
which the vertical ruler displays. 

Web Layout – Adjusts text and other elements, such as pictures, to show how the document will look as a 
Web page. 

Outline – Collapses a document to display headings to assist you in organizing content flow. 

Draft – Displays the document to the full width of the screen with only the horizontal ruler visible. 

To switch between the commonly used views, click one of the view buttons at 
the lower right corner of the status bar. 

Adjusting the Zoom 
The ability to enlarge the text display can be very useful when you are working with a small font size, whereas 
the ability to reduce the zoom display is useful when you are working with landscape or horizontal 
orientation. 

To adjust the zoom display, click an option from the zoom area on the status bar. 

 
Click the Zoom level button to open the Zoom dialog box if you want to choose a specific zoom percentage 
or the number of pages to show.  

 

Zoom Out 

Zoom slider 

Zoom In 

Zoom level 

Read Print Web 
Mode Layout Layout 
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You can set the zoom percentage anywhere from 10% to 500%, or you can have Word automatically adjust 
the magnification to view the entire width of the page of text on screen. When changing the view, the position 
of the insertion point will determine the zoom area. 

Keep in mind that the Zoom feature controls only the screen display. The amount of text that displays when 
you change the zoom percentage is based on the display settings and size of your monitor. Changing the 
magnification level has no effect on the size of the text or images when it is printed. 

Using Undo 
Any time you perform an action and then need to reverse the action (such as adding, deleting, or formatting 
text) on the Quick Access toolbar, click  (Undo) to undo the last action or command performed. 

Key Fact: You can also press CTRL+Z to undo the last action. This works in all Office applications. 

You can also click the arrow for the Undo button to display a list of the last 100 
consecutive actions performed. You can undo sequential actions only. For example, 
in the illustration at the right, to undo the Estimated Sales 2017 text, you must also 
undo the two actions before this action. 

The Undo command cannot be used to reverse certain actions, such as saving a file or printing a file. 
Generally, the Undo feature cannot be used on any commands accessed through the File tab. 

Using Repeat or Redo 
If you change your mind after undoing an action, you can redo the action by clicking the  (Redo) button 
on the Quick Access toolbar. This key will appear in color once there is an action to undo or redo. 

If you want Word to repeat the last action, on the Quick Access toolbar click  (Repeat). You can repeat 
this action anywhere in the document simply by clicking in the next location and clicking Repeat. For instance, 
you changed the spacing for a paragraph and would like to use the same spacing on other paragraphs on 
page 2. You can repeat the spacing change action as many times as you need until you perform a different 
action.  

Key Fact: You can also press CTRL+Y to redo the last action, or press F4 to repeat the last action. This 
works in all Office applications. 

Using Cut, Copy, and Paste  
Occasionally you may want to insert text into a document from another document, or from another location 
in the current document. Word uses the Clipboard to temporarily store any cut or copied items such as text 
or graphics. You can then paste these items into place wherever you choose. The main difference in using 
Cut and Copy is that the cut command actually removes the selection from its original spot and pastes or 
places it in a new location; using the Copy command makes a copy of the selection, leaving the original intact 
and pastes the copy in the new location. 

• To cut or move an item, select the item first and then on the Home tab, in the Clipboard group, click 
. 

• To copy an item, first select the item and then on the Home tab, in the Clipboard group, click . 

• To paste an item, first place the insertion point where you want to paste the item and then on the Home 
tab, in the Clipboard group, click Paste. 
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Key Fact: You can also press CTRL+X to cut an item, CTRL+C to copy an item, or CTRL+V to paste the item. 
These keys are commonly used in other applications. 

Once you paste an item, the  (Paste Options) button appears at the bottom right of the pasted item 
with choices for pasting the selected item. For example, you can specify to match the formatting in the 
destination area, keep the source formatting, or paste only text, if text and graphics were copied. 

Using the Office Clipboard 
While the traditional Windows Clipboard offers the ability to store only one item, 
Office offers the ability to store and retrieve up to 24 items. It also shows you the 
contents of the Clipboard, along with an icon representing the software program 
that was used to create each item. 

To display the Clipboard task pane, on the Home tab, in the Clipboard group, 
click the Clipboard dialog box launcher. 

You can collect items from any programs (up to the maximum of 24 items) and 
then paste them into one or more documents. As you collect new items, previous 
items accumulated on the Clipboard will be replaced by the newer items.  

To paste one item into the current location in the document, click that item on 
the Clipboard. 

Point at an item on the Clipboard to display a drop-down arrow at the right of 
the item; click that arrow to display a menu: use Delete to delete only this item 
from the Clipboard; or use Paste to paste only this item into the current location. 

Understanding Drag and Drop  
Once text is selected, you can quickly move text by dragging it to the new location and then dropping or 
releasing the mouse button to place the text. As you drag selected text, the mouse cursor will display as ; 
use this as a reminder that you are dragging text.  

Hint: It is recommended that you use drag and drop when you need to move text a small distance in the 
document. 

Exercise 9-2: Basic Edits 
In this exercise you will practice using the zoom buttons, apply different views, open a file in protected mode, 
and copy and paste text. 

1. Click File, click Open, ensure This PC is selected in the first column and Word is selected in the Recent 
Folders. Click TEC Employee List to open this file. 

2. Click the  button on the zoom bar at the lower right corner of the screen. 

 The magnification level of the document content increases by 10%. Remember that changing the zoom 
affects only the display, not the actual size of the characters when the document is printed. 

3. Click the  button two more times. 

4. Click the Zoom level button to open the Zoom dialog box and then change the Percent to 75 and click 
OK. 
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5. Click the  (Read Mode) button and notice how the view now changes for you. 

6. Click the View menu to see what options are available to you while in this view. 

  
7. Click Edit Document to exit this view mode. 

8. Close the document without saving it. 

Now try opening a document that was sent previously as an attachment from the New York office. As it is an 
original file sent from Marketing, you want to protect it from any possible changes so you will open it using 
Protected View. 

9. Click File and then click Open if necessary, the click Browse to open the Open dialog box. 

10. From the student data files, select TEC Corporate Profile and click the arrow for Open. Then click Open 
in Protected View. 

 The warning prompt should appear across the top of the document, indicating that this document is 
now in protected view, preventing any changes being made to the file.  

11. Click File and read the information in Backstage, indicating the file has been protected from any changes 
until you enable editing. 

12. Click the Save tab in the panel in the left. You cannot save the file because saving is disabled in Protected 
View.  

  
13. In the message box, click Enable Saving to save the document. 

 Notice that the warning prompt about the protected view mode no longer appears. 

14. Click File and click Close. 

In this part of the exercise, you will copy information from one document and paste it into a new document. 

15. Press CTRL+N to create a new blank document. Type: Estimated Sales 2017 and press ENTER. 

16. Click File and then click Open. Navigate to the student data files location, select Sales Figures 2016 and 
click Open. 

17. Move the cursor to the beginning of the table, starting with the text Popular Tours. 
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18. Click and drag to highlight the figures in the entire table and then on the Home tab, in the Clipboard 
group, click Copy. 

19. Switch to the new document and in the blank line below the title, on the Home tab, in the Clipboard 
group, click Paste. 

 The table of figures has been copied from one document to another. 

20. On the Quick Access toolbar, click the Undo button. 

 The pasted item is cleared, giving you the option to redo the paste (that is, to reverse the last action). 

21. On the Home tab, in the Clipboard group, click Paste once more. 

 The information is pasted into the document again, and in fact, you could paste this information into 
other areas of the same document or to another document, as needed. 

22. Save the new document in the 7500-Student-Files\Word folder as: Estimated Sales 2017 - Student and 
then close it. 

23. Close all other documents without saving. 

Applying Formatting  
Objective 2-2.1, 2-2.3, 2-2.5 

Formatting refers to any process that alters the appearance or position of text or other objects in the 
document. Word provides a number of formatting options that can be applied within a document for all 
types of objects; accordingly, be careful with the number of formatting options you apply, considering who 
your audience is and how they will view the message in the document. For example, if you apply the All Caps, 
Bold, Italic, and Superscript formats to a sentence, it can be very distracting and difficult to read. 

• You can apply formatting to text as you type it or after you have typed it. It can be easier and faster to 
wait until all the text in your document has been typed and edited before you format it. You need only 
remember that you must select the existing text before you can apply formatting to it. 

• You can turn most formatting features on and off by clicking the appropriate button on the ribbon or 
Mini toolbar. When a feature is active, it appears in a different color from the other buttons. An arrow 
beside a button indicates that you can select additional options for the feature. 

• When you want to remove all formatting from selected text, on the Home tab, in the Font group, click 
 (Clear Formatting). 

Enhancing Text Characters 
Character formatting refers to any feature that changes the appearance of characters on the screen and in 
print. You can control the following aspects of character formatting: 
Font – Describes the typeface of characters on the screen and in print such as Courier New or Bradley. 

Font Size – Refers to the height of the characters (as characters get taller, they also grow wider.) 

Character Formatting – Refers to the special stylized variations applied to plain characters to make them 
stand out from other text. They include bold, italics, and various kinds of underlines. 

Effects – Apply special effects to the text, such as strikethrough, superscript or subscript, shadow, SMALL CAPS, and 
so on. 
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There are several ways to apply formatting to selected text characters: 

• The quickest method is to click the appropriate formatting button from the Font group on the Home 
tab. 

  
• As you select text for formatting, you will see the Mini toolbar appear; it contains buttons for applying 

specific, common features for formatting characters and paragraphs. 

   

Enhancing Paragraphs 
Word provides a number of tools that allow you to change an entire paragraph to best suit the message in 
your document. Many of the following items will affect the amount of vertical white space between lines of 
text and paragraphs. Several of these tools can also assist you in maintaining consistency in order to produce 
a professional-looking document. 

Aligning Text 
Alignment refers to the way the left and right edges of a paragraph line up horizontally on the page. You can 
easily change the alignment in your document using one of the following four options in the Paragraph 
group on the Home tab 

Align Left – Aligns text to the left margin with a ragged or uneven edge on the right side of the text. 

Center – Aligns text between the left and right margins to an imaginary line down 
the middle of the page. 

Align Right – Aligns text to the right margin with a ragged or uneven edge on the 
left side of the text. 

Justify – Aligns text so the left and right edges of the text are flush with the margins 
and each line of text is evenly spaced out between the margins, except for the last line of each paragraph. 

Changing Line Spacing 
Line spacing refers to the amount of space between lines of typed text, measured from the baseline of one 
line to the baseline of the next. Word automatically adjusts the amount of space between lines according to 
the size of the characters being used. However, you can also specify that line spacing be set to an exact 
measurement. 

It’s important to note that a precise line spacing setting will not adjust to accommodate larger text if the font 
size is changed. It’s also important to note that, if you decrease line spacing too much, the lines of text may 
overwrite each other, or the text may not display. 

Key Fact: You can also enhance text using 
keyboard shortcuts such as CTRL+B for bold, 
CTRL+I for italic, or CTRL+U for underline. 

Align Left Align Right 

Center Justify 
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To set or change the line spacing, on the Home tab, in the Paragraph group, 
click  (Line and Paragraph Spacing). 

Setting Paragraph Spacing 
Paragraph spacing refers to the amount of space between paragraphs of text. 
Although it is possible to create extra space between paragraphs by pressing 
ENTER to insert blank lines, most published documents are set to insert a 
specific amount of space between paragraphs. This enables you to set spacing 
slightly smaller than a full line, which then reduces the amount of white space 
on a page and ensures consistency throughout a document. 

To set or change the paragraph spacing, click the Layout tab, in 
the Paragraph group, set the spacing as required: 

Exercise 9-3: Basic Formatting 
In this exercise, you will apply basic formatting features in a document. 

1. Click File, click Open, ensure This PC is selected as the location, and open the Word folder. Double-click 
the Budget Memo file. 

2. Double-click the word To in the first line and then click Bold in the Font group of the Home tab. 

Hint: If the Mini toolbar appears when you select the text, click the Bold button in the toolbar. 

3. Select the entire Re: line of text and click Bold once more. 

4. In the second paragraph starting with In planning …, select the 3% text. On the Home tab, in the Font 
group, click the down arrow for the Font color and click Green in the Standard Colors row. 

5. With the text still selected, press CTRL+B to add bold to the text. 

6. Select the four paragraphs of the memo and then on the Home tab, in the Paragraph group, click the 
down arrow for Line Spacing. Click 1.0. 

 Notice the line spacing has reduced while the spacing between the paragraphs remains unchanged. 

7. With the four paragraphs still selected, click the Layout tab and in the Paragraph group, click the 
increment button for After and change this to 12pt. This increases the spacing between paragraphs. 

8. Save this document as Budget Memo – Student and then close it. 

Understanding Tab Settings 
Setting tabs or tab stops is similar to aligning text; the difference is that setting tabs allows you to align 
information at specific intervals across the page so that text is lined up in columns. 

Use appropriate tab alignment characters to match the type of data that will be entered. For instance, you 
can use a right tab to line up whole integer numbers, but would probably want to use a decimal tab to line 
up values with decimal places. 
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Click in the Tab Selector box to choose the alignment type; a ScreenTip appears defining each symbol and 
how it will align your tabbed columns: 

 
Left – Aligns text at the tab setting with characters shifting right as you type; this is the default setting. 

Center – Centers text along an imaginary line down from the tab setting, with characters shifting evenly to 
the left and right as you type. 
Right – Aligns all text along the right edge of the tab setting with characters shifting left as you type. 
Bar – Displays a small vertical line as a separator between the previous and next column of information. 
Decimal – Aligns to the left of the decimal point until you type the decimal point, then text shifts to the right 
of the decimal point. 

In order to use tabs for aligning text, you need to do two things: 

1. Define the position of the tab “stops” on the page.  

2. Use the TAB key when entering text.  

To insert a tab setting, select an alignment type from the Tab Selector box, then click on the horizontal ruler 
at the measurement for this tab stop. Once all tab stops are set on the ruler, begin typing the text for the 
report. 

Pressing the TAB key tells Word to “move the insertion point to the text tab stop position on this line”. You 
can then continue entering text (how the text flows at the new position will depend on the type of tab being 
used). Pressing TAB again will move the insertion point to the position of the next tab stop on the line, and 
so on. When you have entered the desired text at the last of your tab stop positions on the line, press ENTER 
to start a new paragraph. Press TAB to move to the position of your first tab stop in the next paragraph, and 
so on. 

When you need to edit a tab setting that is currently applied to existing text, be sure to select the text first; 
otherwise, the revised tab setting is applied only to the current line. For example, to adjust a tab setting for 
a list of 10 names, select the 10 lines of text and then drag the tab character to its new location on the ruler. 

Consider the following tips regarding setting tabs: 

• Click the Tab Selector box until the desired tab alignment character displays and then click in the ruler 
where the tab stop is to be placed.  

• The items in the Tab Selector box cycle through each time you click the box; if you go pass the alignment 
option you want, click until the desired character appears.  

• When placing a tab stop on the ruler, position the pointer close to the measurement mark in the bottom 
half of the ruler. A vertical dash line will appear to verify the tab stop as you click in the ruler to set the 
tab stop. 

• To remove a tab stop, click the tab character on the ruler and drag it up or down off the ruler.  

Key Fact: To clear all the current tabs at once press CTRL+Q. 

• To adjust the position of a tab stop, click the tab character on the ruler and drag it to the new position. 

Bar Tab 
Tab Selector 
Box Left Tab Center Tab Right Tab Decimal Tab 
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Exercise 9-4: Coffee Sales 
In this exercise you will create a simple sales report by setting tabs on the ruler. 

1. Create a new document and save it as Coffee Sales – Student. 

2. Click the View tab, and in the Show group, check that the ruler is on; if it is off, click the option.  

3. Type: Coffee Sales as the title and press ENTER. 

4. At the far left of the ruler, click the Tab Selector until you see the Right Tab alignment character appear. 
Then click at 2.5”, 3.5”, 4.5”, and 5.5”.  

5. Press TAB and type: Q1. Press TAB, type: Q2, press TAB, type: Q3, press TAB and type: Q4. Press ENTER. 

6. Type: Arabica and press TAB. Type: 4558, press TAB, type: 4905, press TAB, type: 4201, press TAB, type: 
4013 and press ENTER. 

7. Type: Espresso and press TAB. Type: 2895, press TAB, type: 3595, press TAB, type: 2572, press TAB, type: 
2218 and press ENTER. 

8. Save and close this document. 

Formatting the Document 
Objective 2-2.2, 2-2.5 

There are several options you can use to alter the way pages are laid out for different types of documents. 
Options include, for example, setting the margins to print differently for odd and even pages or changing 
the paper size in order to print an envelope. These options can be quickly selected from the Layout tab. 

 

Changing the Paper Size 
The default paper size is determined by the Language and Regional settings for your system (the following 
example is set for English US which uses 8½" by 11" or standard Letter size in this region); you can change 
this for any document using the Layout tab. To change the paper size for a document, on the Layout tab, in 
the Page Setup group, click Size and then select the required size from the list. 

Changing the Orientation 
Orientation refers to the way the document will print on the page. Portrait refers to a vertical 
orientation, while Landscape refers to a horizontal orientation. To change the orientation for 
a document, on the Layout tab, in the Page Setup group, click Orientation, then select an 
option. 

Changing Margins 
Margins determine the amount of space between the edge of the paper and the area where the text is 
printed. You can adjust the margin settings for the entire document or for specific parts of the document. 
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The boundaries for the top and bottom margins are easy to see; they appear as the divider line 
between the lighter (inside margins) and darker (outside margins) shades on the ruler. When 
you position the mouse pointer at the margin point on the vertical and horizontal rulers, a 
ScreenTip appears similar to those shown at the right. 

 

The margin boundaries for the left and right margins appear on the top ruler, although the 
indent markers may obscure the left margin markers. You can access the left margin marker by 
pointing precisely between the Left Indent and First Line Indent markers. You can access the 
right margin marker by pointing above the Right Indent marker. 

 
 

 
• To change your margins, on the Layout tab, in the Page Setup group, click Margins; or 

  
• to adjust the margins using the ruler, point the mouse pointer at the margin and, when the appropriate 

arrow appears, drag to the measurement you want for the margin. 

Left Margin Marker Right Margin Marker 

Top Margin Marker 
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Adding Page Numbers 
You can add page numbers to a document at any time. Page numbers can be inserted at any position on the 
page, though they are usually placed in the header or footer. To insert page numbers into your document, 
on the Insert tab, in the Header & Footer group, click Page Number. 

Top of Page – Displays possible positions from a gallery of top-of-page 
numbering options. 

Bottom of Page – Displays possible positions from a gallery of bottom-of-page 
numbering options. 

Page Margins – Displays possible positions from a gallery of margin numbering 
options. 

Current Position – Displays numbering options (page number only, page # of #, and so on) to apply to the 
current page number location. 

Format Page Numbers – Displays various numbering styles (1, 2, 3; i, ii, iii), as well as the option to begin 
numbering at a digit other than the number 1. 
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Applying Columns 
Word allows you to set up newspaper-style columns wherein text from the bottom of one column flows to 
the top of the next; this makes it an ideal layout for documents such as newsletters and reports. The number 
of columns you create depends on factors such as paper size and orientation, font size, and document layout 
(for example, for print or the Web), as well as the column width and margins you choose. 

You can apply columns to text before or after you type. You may find it easier to type 
and edit the text first, and then apply multiple columns formatting.  

To create columns, on the Layout tab, in the Page Setup group, click Columns. 

If you want to end the flow of text at the bottom of one column, insert a column break 
and force text to the top of the next column. To insert a column break, press 
CTRL+SHIFT+ENTER. 

Note that when you change the column layout of a document, the entire document 
changes unless you specify otherwise. To change the column layout for only a portion 
of the document, select that portion of text and make the appropriate column layout 
change. Word automatically inserts the appropriate breaks for this selection. 

Exercise 9-5: Recipe 
In this exercise, you will change some settings for a document that improve the readability of the recipes. 

1. Open the Recipe file and save as Recipe - Student. 

2. Click the Layout tab and in the Page Setup group, click Orientation and then click Landscape. 

3. In the Page Setup group, click Columns and then click Two. 

4. Select the Quick and Easy Recipes title and in the Page Setup group, click Columns and click One. 

 The main title should now be on a separate line and its single column spans across the width of the 
document. 

5. Click at the beginning of Recipe #15 and press CTRL+SHIFT+ENTER to insert a column break. 
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 Notice the recipe titles now line up at the top of each column. 

6. Select the main title, click the Home tab and in the Font group, click Bold. Click the down arrow for the 
Font Size and click 16. In the Paragraph group, click Center. 

7. Select the Recipe #11 text. Apply bold and change the font size to 14pt. Repeat this step for the Recipe 
#15 text. 

8. Bold the title of Recipe #11, change the font size to 12pt and change the font color to blue. 

9. Bold the title of Recipe #15, change the font size to 12pt and change the font color to green. 

10. Click the Insert tab and in the Header & Footer group, click Page Number. Click Bottom of Page and 
then click Circle. 

11. On the Design tab of the Header & Footer Tools ribbon, click Close Header and Footer. 

12. Save and close the document. 

Preparing the Document for Printing 
Objective 2-1.3, 2-1.5, 2-2.6, 2-2.7 

Before distributing your document to others, always take a moment to look over the document to correct 
any spelling, grammatical, or contextual errors, and to remove any repetitive text. This helps to ensure your 
document represents you and your company/school in a professional manner. 

Proofing the Document 
Word provides tools to automate proofing and also displays visual hints if it encounters an item that should 
be reviewed.  

 Red wavy lines indicate the word is not recognized in either the current or custom Word dictionary. 

 Blue wavy lines indicate grammatical or structural errors or a potential contextual error. 

The Spelling and Grammar feature provides options to help you check for spelling and grammatical errors, 
such as the ability to create custom dictionaries for special terms you may use in your work. The spelling 
portion checks for incorrect spelling, duplicate words, and occurrences of incorrect capitalization. The 
grammar portion detects sentences with grammatical errors or weak writing style, based on widely accepted 
standards in the language (English only) overall as well as some regional variations (such as American versus 
British English). 

In Word, the Spelling and Grammar feature works in the background to check for mistakes as you type. This 
enables you to correct mistakes immediately. However, you can still run a spelling and grammar check when 
you are finished creating the document. 

To run a Spelling and Grammar check, on the Review tab, in the Proofing group, click Spelling & Grammar. 

Key Fact: You can also press F7 to begin a spell check of the entire document. This works in all Office 
applications. 
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When Word finds the first misspelled word in the document, it displays the item in the Spelling and Grammar 
pane at the top. You click an option to specify how you want to proceed: 
Ignore – Ignores this occurrence of this spelling but continues to search for other occurrences of this spelling. 

Ignore All – Ignores all occurrences of this spelling; this might apply to a person’s name or some technical 
jargon. 

Add – Adds this spelling to your custom dictionary. In addition to providing a regular dictionary, Word allows 
you to build a custom dictionary so that it will not identify as misspelled words names, jargon, slang, or 
regional spellings you use often. 

Suggestions – Displays a list of alternatives for the misspelled word. If the correct word is in the list, click it 
and then click Change, or Change All, or double-click the word to change it immediately. 
Change – Changes this occurrence with the selected word in the suggestions box. 

Change All – Changes all words with this spelling with the selected word in the suggestions box. 

Near the bottom of the pane is a definition of the word, if applicable, and a list of words that can be used in 
place of this word. This is helpful if you find yourself repeating the word several times on a page. The types 
of words that appear will depend on the type of word, (that is, if it is a noun, verb or adjective). If you have 
sound available on your device, you can also click the speaker icon to hear the pronunciation of the word. 

Grammatical or contextual errors appear in the Grammar pane as the grammar checker encounters them. 
Grammatical errors occur when Word has detected a structural error in the text such as too many spaces, 
incorrect or missing punctuation, incorrect verb tense, or passive versus active voice in the sentence. 

Contextual error refers to words that have the same sound but different spellings and meanings depending 
on the context. Some words that often give rise to contextual errors include: 
• there (refers to a place), their (possessive form), or they’re (contraction for they are) 
• its (possessive form) and it’s (contraction for it is) 
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• where (refers to a location), ware (goods or services), and wear (attire or clothing) 
• write (use a tool to scribe ideas) and right (direction or suitability) 

• allot (to distribute) and a lot (quantity) 

Contextual errors, as with spelling or grammar errors, appear in at the top of the Spelling and Grammar pane. 

Suggestions – Provides a list of suggestions as to how to fix this error. 
Ignore – Ignores this occurrence but continues to find other occurrences of the same grammatical error. 
Change – Changes the error identified in the top box with the highlighted option in the Suggestions box. 

In the lower half of the pane you will see an explanation as to why the text was marked as an error; the text 
in this box changes to reflect the grammatical error identified. 

Finding and Replacing Items 
You can use the Find feature to locate occurrences of specific words, phrases, symbols, codes, formatting, or 
any combination of these items in your document. You might use the Find feature as a quick way to find a 
word you think you may have misspelled or to refer back to a particular piece of information. Once you’ve 
found what you’re looking for, you can replace it, check for other occurrences, or continue working with your 
document. 

To activate the Find feature, press CTRL+F to display the Navigation pane. 

With the Navigation pane, you need only enter the text you want to find in 
the Search field and press ENTER, or click  (Search for more things) to 
have Word search your document. Word lists any matches it finds in the 
Navigation pane as summaries where you can see some of the text around 
the found occurrence to determine if this is an item you want to view or 
change. When you click a result in the list, Word moves the insertion point 
to that document location so you can make a change, if needed. If there 
are a large number of results, use the  buttons to scroll up and down in the list to find the item you 
want to review. 

Each time you activate the Find feature within any given Word session, Word will display the last search 
criteria entered. When you exit Word, all the boxes in the Find and Replace dialog box will clear.  

To immediately clear the search field, click the  (Stop searching) button. 

Replacing Items 
To activate the Replace feature, on the Home tab, in the Editing group, click Replace. 

Key Fact: You can also press CTRL+H to open the Find and Replace dialog box. 
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If you searched for an item prior to activating Replace, the search criteria displays in the Find what field. You 
can then enter what the replacement text should be in the Replace with field. 
More – Display other options that can be applied to narrow the search. 
Replace – Replace this one occurrence. 
Replace All – Replace all occurrences. 
Find Next – Find the next occurrence to determine whether it should be replaced. 
Cancel – Cancel or close this feature. 

Printing the Document 
The Print feature enables you to preview the document as it will appear when printed. This gives you an 
opportunity to review the document before you print or distribute it to discover if there are problems with 
the appearance or layout. You can also use some of the print options to adjust or change the margins or 
orientation, or display one or more pages at a time prior to printing. 

To preview or print a document, click the File tab and click Print. 

Key Fact: Press CTRL+P to display the print options in Backstage. This works for all Office applications. 

 
Use the options in the first panel to control what prints, how it will print, and where it will print. 
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Print – Print the document with the settings currently shown. 
Copies – Enables you to specify the number of copies to be printed. 

Printer – Select a printer from the list of installed printers. Use the Printer 
Properties link to choose options for how the output is printed, such as 
single- or double-sided, or black-and-white or color. Some options in the 
properties for your printer may be available in specific print options. 

Settings – Select how much of the document or which specific pages or 
items to print.  

– Alternatively, use the  field to enter 
specific pages to print: 
# - #  Print from one page to another, inclusive (for example 5-7) 
#,#,#  Print only the following pages (for example 3,7,10) 
- #  Print from page 1 to a specific page (for example 1-6) 

# - Print from a specific page to the end of the document (for 
example 13- ) 

Print Sides – Specify whether to print on one or both sides of each sheet 
of paper. 

Collated – If printing multiple copies, choose how each page is printed, 
for example complete copies of the full document, or copies of each page 
individually (which must then be collated into full documents). 

Orientation – Choose which orientation should be used for printing this document. 

Paper Size – Choose the paper size to use for printing this document. 

Margins – Choose the margins to apply when printing this document. 

Pages per Sheet – Select the number of pages to print per sheet. 

Use the options at the bottom of the second panel to move among pages in the document, to adjust the 
zoom level, or to zoom into the page.  

 

Exercise 9-6: Newsletter 
In this exercise, you will look at different options to proof and review the document prior to sending it to 
print. 

1. Open the Newsletter A01 and save it as Newsletter A01 – Student. 

2. Press F7 to spell check the entire document. 

3. Read the information in the Grammar pane to see what Microsoft considers to be wrong in the 
document. Then click Change. 

4. Read the description of the next error and click Change. 

5. Click OK when prompted that the spell check is complete. 

6. Press CTRL+F to display the Navigation pane. Type: vendor in the search field and press ENTER. 

 There should be two results highlighted in yellow for you to peruse, as needed. 

7. Close the Navigation pane and press CTRL+H to display the Find and Replace dialog box. 
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8. Click in the Replace with field, type: partner and then click Replace All. 

 You have now replaced the two occurrences of vendor with the word, partner.  

9. Click Yes if prompted to continue searching from the beginning of the document, and click OK to close 
the message box. Then close the Find and Replace dialog box. 

10. Save and close this document and then open the TEC Employee List from your data files location. 

 This document has multiple pages consisting of one column of data. 

11. Press CTRL+A to select all the text. Click the Layout tab and in the Page Setup group, click Columns and 
then click Three. 

12. Select the title of the report and change this to one column only. 

13. Move to the bottom of column three where the Sydney title is and at the beginning of this text, press 
CTRL+SHIFT+ENTER to force it to the top of the next page. 

14. Save the file as TEC Employee List – Student, click File and then click Print. 

15. At the far right bottom of the screen, click the + button on the zoom slider to increase the view of the 
document. Then click the arrow at the left of the page number to return to Page 1. 

16. Click Print All Pages. Click Print Current Page and then click the Print button. 

17. Save and close the document. 

Working with Pictures  
Objective 2-7.1, 2-7.2 

You can add pictures to any document from sources such as digital photographs, graphics files, scanned 
images, or you can go online to find pictures on the Office.com site. Word provides the facility to insert 
picture files in a wide variety of file formats; some commonly used formats are Windows Metafile (*.wmf), 
JPEG File Interchangeable format (*.jpg, *jpeg), Portable Network Graphics (*.png), Windows Bitmap (*.bmp), 
or Graphics Interchange format (*.gif). 

To insert a picture, position the mouse pointer in the document where you want the picture to be placed, 
and then on the Insert tab, in the Illustrations group, click Picture. 
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Word displays a dialog box which you use to select the picture file, similar to opening a text file. Navigate to 
where the picture file is located, select it and then insert it into the document. 

You can also search online for pictures; position the mouse pointer where you want the graphic to be placed, 
and then on the Insert tab, in the Illustrations group, click Online Pictures. 

 

Once you enter the search criteria, you can click the  or press ENTER to begin the search.  

 
The number and variety of pictures that appear will vary. By default, the search results are images covered 
under the Creative Commons license. If you want to view as many pictures as possible that match the search 
criteria, click the down arrow at the right of the CC Only field and click All Images. 

Note: It is your responsibility to ensure you are not violating copyright laws when you insert images 
returned in the search results page. 
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You can point at an image to show some properties about the picture, specifically where this picture is located 
and who may own the picture, as seen in the following: 

 
To insert the image, click the checkbox at the top left of the image and then click Insert. 

If there is more than one image on the search results page that you would like to insert into the document, 
click each image you want to use. The images will be inserted into the current cursor location, and can then 
be moved to other parts of the document. 

You can also narrow the search by choosing one of the links below the search field if you have specific 
requirements such as the size of the image. 

 
To search for another category of pictures, delete the text in the search field and enter the new search criteria. 

Fun Fact: You can insert pictures using both these methods in all Office applications. 

Manipulating Objects 
Any picture you insert into a document will appear with eight handles when it 
is selected in the document, as shown in the following image. Handles are the 
small circles or squares that appear around the perimeter of the picture; they 
confirm that the object has been selected and that you can now make changes 
to it. These handles may vary in appearance but always appear around the 
selected picture. 
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You can insert pictures into a document as inline objects (the default setting) or as floating objects. 

• An inline object acts as a text character in a paragraph. 

• A floating object can be placed anywhere (it floats) in the document. 

Regardless of which way you insert a picture initially, you will be able to switch from inline to floating or vice 
versa, using the Wrap Text feature from the Format tab of the Picture Tools ribbon. 

Fun Fact: You must select a picture (display its handles), before you can manipulate it in any Office 
application.  

Moving a Picture  
The drag-and-drop method is the easiest way to move a picture. However, take note of whether the picture 
is inline or floating before you try to move it, as this determines how and where you can move the picture: 

• If it is an inline object, the mouse pointer displays as  when you drag it. 

• If it is a floating object, the mouse pointer displays as  and when you drag the picture, it changes to . 

Sizing a Picture  
When you insert a picture into a document, it appears at its original size, or the largest size that the page will 
accommodate. You can resize or scale the picture to any proportions you want. You use the same methods 
to size a picture whether it is inline or floating. 

You can use the handles to size a picture: 

• Vertically, by dragging the  middle horizontal handle at the top or bottom edge in or out. 

• Horizontally, by dragging the  middle vertical handle at the left or right edge in or out. 

• On two adjacent sides at once, by dragging one of the  corner handles in or out. 

If you want to ensure that your resized picture remains in proportion, press SHIFT before you drag the 
appropriate handle. 

Wrapping Text Around a Picture 
Wrapping styles affect the way the text flows around pictures and change the way pictures are positioned in 
relation to the surrounding text.  

By default, the picture wrapping style is In Line with Text, which places the inline graphic at the insertion point 
on a line of text in the document. The graphic then moves with the text, as if it 
were a text character.  

Changing the wrapping style enables the picture to “float” or be positioned 
anywhere in the document.  

To change the text wrapping style for a picture object, select the picture and then 
on the Format tab of Picture Tools, in the Arrange group, click Wrap Text to 
choose the appropriate text wrapping style. 

Each text wrapping style provides a different effect for the picture and the text in 
the document. Use the previews to see which text wrap style is suitable for the 
picture and the document. You can also use a combination of these methods to 
achieve the desired effect. 
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Cropping a Picture  
Cropping refers to the ability to “cut off” certain portions of the picture. Using this feature, you can crop 
pictures horizontally (at the top or bottom) or vertically (at the sides); for more precise cropping, you must 
use a dedicated graphics program. 

• To crop the top or bottom of the picture, drag the top or bottom crop handle when you see . 

• To crop the left or right side of the picture, drag the left or right crop handle when you see . 

• To adjust two adjacent sides of a picture, drag one of the corner crop handles when you see . 

Note: The mouse cursor displays the appropriate direction based on the side you are cropping. 

Exercise 9-7: Newsletter with Pictures 
In this exercise, you will add pictures to a document and then manipulate the graphics. This exercise uses 
pictures available from CC web sites. The number and types of pictures will vary based on changes made by 
web sites; focus should be on the task such as sizing, moving, or cropping. 

1. Open the Newsletter A01 file and save it as Newsletter A01 with pictures - Student. 

2. Delete the New Office text below the What’s New heading. 

3. Click the Insert tab and in the Illustrations group, click Online Pictures. 

4. Click in the search field, type: announcements and press ENTER. 

5. Scroll through the pictures and the click the checkbox for the picture similar to the following: 

  
6. Click Insert to insert the picture into the document. With the picture selected, click the top right handle 

and drag inward to make the picture approximately 1” in height. 

7. Under Picture Tools, click the Format tab in the Arrange group, click Wrap Text and click Square. 

8. Position the mouse cursor anywhere inside the picture and drag it so that the top of the paragraph aligns 
with the top of the picture, as shown here: 

   
9. Ensure the picture is still selected, and then on the Format tab, in the Size group, click Crop. 

10. Using the crop handles around the picture, try to crop out as much of the white space around the picture 
as possible, similar to the figure shown below, then click outside the image. 
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11. At the end of the With more resources … paragraph, press ENTER to create a blank line. 

12. Click in this blank line, then click the Insert tab, and in the Illustrations group, click Pictures. 

13. Navigate to the Word folder in the student data files, if not there already, and then double-click the 
balloons picture. 

 The picture should fill the width of the page. If you were actually creating this newsletter, you would 
continue to add or modify pictures. For the purpose of this exercise, you will stop working on this 
document. 

14. Save and close the document. 

Using Tables 
Objective 2-2.5, 2-2.9 

Use the Table feature to arrange columns of text and numbers, group paragraphs side by side, or create 
forms. The following figure shows a table. 

 
When working with a table, you are working with cells within the table (the intersection between a column 
and a row). You can create a table before or after you type the text. 

You can enter text, numbers or graphics into each cell. Text longer than the width of the cell will automatically 
wrap to the next line in the same cell.  

Use the  (Table Selector) to select the entire table; it appears at the top left corner of a table when your 
cursor is in or near the table. 

Once you create a table, the Table Tools ribbon appears providing further options for the design or layout 
of the table. The Insertion point must be somewhere in the table before this ribbon displays. 

Inserting a Table  
To insert a table, use one of the following methods: 
• On the Insert tab, in the Tables group, click Table.  

Table Selector Column 

Row 

Cell 
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In the drop-down menu, position your mouse pointer over the box in the 
upper left corner and begin dragging across, down, or diagonally over the 
grid to specify the number of columns and rows you want. As you drag, Word 
will display the number of columns and rows for reference in the title area of 
this list. Use this feature to create a table of up to 10 columns by 8 rows. 

• If you need a table larger than 8×10, use the Insert Table feature. You can also use this feature to display 
a dialog box with more options: 

 

Table size – Enter the number of columns and rows by typing the number 
into the box or using the incremental buttons. 

AutoFit behavior – Select options for specifying an exact cell size or 
adjusting cell size to accommodate contents. 

Remember dimensions for new tables – Remember the options you’ve 
selected and use them as the default settings for all new tables you create. 
You can adjust column widths or row heights as needed after the table is 
created. 

Once you create a table layout, Word places the insertion point in the first cell of the table for you to begin 
typing. You can use the following methods to move within a table using the keyboard: 

• Press ENTER to add more lines of text in the same cell. This will increase the row height. 

• Press the TAB key to move to the next cell, or press SHIFT+TAB to move to the previous cell. 

Formatting Text in the Table 
You can format the text in a table in the same manner as you format regular text. You can also apply 
formatting options to the entire table or to parts of it. 

You may find it easier to format or adjust items once there is text in the table, especially if there are large 
pieces of text. Having the text in the cells will help you determine the best width for columns, styles for 
headings and titles, and so on. 

Inserting & Deleting Rows/Columns/Cells  
You can insert additional rows and columns into a table after you have created it.  

• To insert a single row or column, position the mouse pointer where you 
want the new row or column inserted. Under Table Tools, on the Layout tab, in the Rows & Columns 
group, click the appropriate option. 

• To delete cells, rows, columns, or an entire table, position the mouse pointer in the cell, row or column 
to be deleted. Then under Table Tools, on the Layout tab, in the Rows & Columns group, click the arrow 
for Delete and then select the appropriate option. 
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Adjusting the Width or Height  
You can adjust the width of each column, the height of each row, and the overall alignment of your table. 
You can also evenly space selected rows or columns in a table. 

To adjust the column width or row height: 

• place the mouse pointer on a vertical line on either side of the column to adjust and, when you see , 

drag left or right to the desired column width; or 

• place the mouse pointer on a horizontal line for the row to adjust and, when you see , drag up or 

down to the desired row height. 

To distribute the width for each column or height of each row evenly, under Table Tools, on the Layout tab, 
in the Cell Size group, click  or . 

Merging and Splitting Cells 
Table cells can be merged to create a single cell, or a cell can be split into multiple columns or rows. Merging 
cells is particularly useful when creating a title row for your table.  

• To merge cells, select the cells and then under Table Tools, on the Layout tab, in the Merge group, click 
Merge Cells. 

• To split a cell into multiple cells, select the cell and then under Table Tools, on the Layout tab, in the 
Merge group, click Split Cells. Specify the appropriate number of columns and rows, then click OK. 

  

Exercise 9-8: Expenses 
In this exercise you will create a simple table to record some expenses for the new office. You will then format 
the table. 

1. Press CTRL+N to create a new blank document. Type: Office Expenses for the title and press ENTER. Then 
click the Insert tab, and in the Tables group, click Table. 

2. Starting at the top left box in the grid, drag over to select 4 columns and then down to select 5 rows. 
When the correct number of columns and rows has been selected, click to insert the new table into the 
document. 

  
3. With the insertion point in the first box (cell) at the top left corner of the new table, type: Expenses and 

then press TAB. 
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4. Type: Actual and press TAB. Type: Quote and press TAB. Type: Budget for the last column and press TAB. 

 The insertion point should now be in the first cell of the second row. 

5. Enter text for the rest of the table as shown: 

  
6. At the end of the 3000, press TAB. 

 You have just inserted a new row in the table for another expense item. 

7. Type: Parking, press TAB, type: 200, press TAB, type: 150, press TAB, and type: 400. 

8. Save the file as First Month Expenses - Student. 

Now try changing the appearance of the table data by using simple formatting attributes. 

9. Click to select all the cells in the first row and then click  on the Mini toolbar. 

10. Move the cursor to above the Actual column. When you see , click and drag to select the three columns 
(Actual to Budget). 

11. On the Home tab, in the Paragraph group, click Align Right. 

  
12. Position the mouse cursor on the vertical line between the Expenses and Actual columns. When you see 

, click and drag the line approximately five characters to the right. 

 The width of the Actual column is now smaller than the other two columns. This allows for longer text 
entries in the Expenses column, as required. 

13. Ensure all three columns are selected and then under Table Tools, click the Layout tab and in the Cell 
Size group, click Distribute Columns to resize the selected columns evenly. 

  
14. Save the document and then close it. 
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Tracking Changes 
Objective 2-1.4, 2-2.8 

When you want others to review a document and yet still want to maintain control over the final changes, 
distribute copies to others with the Track Changes feature activated. The Track Changes feature "keeps track" 
of edits made by other people and highlights them for you when you review the documents after others 
have made their changes. You can also track your own changes in a document as Word will highlight the 
changes using colors set up in the Advanced Options command of the Track Changes options.  

To turn on (or off) Track Changes, on the Review tab, in the Tracking group, click Track Changes. 

To control how much of the tracking information is visible on the screen, on the Review tab, in the Tracking 
group, click the arrow for Display for Review and click an option. 

In a document that contains tracked changes, you can use the commands in the 
Changes group on the Review tab to move from one change or comment to the next. 
At each tracked change, you can specify whether to accept or reject the change. You 
can also click Next to bypass this change and move onto the next change for review.  

Word will move to the next change or comment once you accept or reject a change: 

• To accept a change, click the change and then on the Review tab, in the Changes group, click Accept or 
Accept and Move to Next. 

• To accept all changes in the document, click the arrow for Accept and then Accept All Changes or 
Accept All Changes and Stop Tracking. 

• To reject a change, click the change and then Reject or Reject and Move to Next 

• To reject all changes in the document, click the arrow for Reject and then Reject All Changes or Reject 
All Changes and Stop Tracking. 

Exercise 9-9: Track Changes 
In this exercise, you will work with a document marked with tracked changes. 

1. Open the Resume for Elinor Eng document and save it as Resume for Elinor Eng (reviewed) - Student. 

2. In the Tracking group, click the arrow for Display for Review and then click All Markup, if necessary. 

3. Take a few moments to review the changes that are marked in the document and how they appear in 
the document. 

4. Click the Review tab and in the Tracking group, click Track Changes to turn it on.  

5. In the Changes group, click Next to have Word highlight the first change for you. 

6. In the Changes group, click Accept to accept the text entered (Expert). Word makes the change and then 
moves to the next tracked change. 

7. In the Changes group, click Accept four times for the additional text in the Office Manager position.  

8. Click anywhere in the Part-time studies text and then click the Layout tab. In the Paragraph group, click 
in the Before field and type: 3, then press ENTER. 

9. Return to the Review tab, then click Next and then accept the two new lines in the Education area as 
well as the formatting change you made earlier. 
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10. Click at the beginning of the England text, type: Nepal, (include the comma) and add a space if necessary, 
and then at the end of the Denmark text, type: , Italy (include the comma). 

11. In the Tracking group, click Track Changes to turn the feature off. 

12. In the Changes group, click the arrow for Accept, then click Accept All Changes to accept the remaining 
changes in the document. 

13. Save and close the document. 

Lesson Summary 
This lesson introduced you to Microsoft Word, where you learned how to create simple documents, and how to 
manipulate the content for a professional look and layout. You should now be able to: 
 start and exit Microsoft Word 
 identify some common screen elements 
 create, save, and open documents 
 change view options for documents 
 insert, select, modify, and format text 
 manipulate text using common features 
 use the ruler to create, modify or delete tab settings 
 change margins, paper size, or the orientation 

 insert or remove page breaks 
 insert or remove page numbers 
 apply column formats 
 use find and replace 
 print and preview documents 
 insert pictures or multimedia files 
 work with tables 
 track changes made in documents 

Review Questions 
1. What is the view that appears when you start any Microsoft Office program? 

a. File menu c. Backstage 
b. New file  d. Views 

2. Which option would you click on the ribbon to display a gallery of choices? 
a. More button 
b. Dialog box launcher button 
c. Customize Quick Access Toolbar button 
d. Ribbon Display Options button 

3. Which ribbon tab contains the option to turn the ruler on or off? 
a. Home c. Review 
b. Insert d. View 

4. Which key can you press to select both a word in one paragraph and a heading of text on the next page? 
a. ALT c. SHIFT 
b. CTRL d. F8 

5. Which field would you use to change the file format so the document is compatible with Word 2000? 
a. File type field c. More options 
b. Filename field d. Save button 
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6. Which view mode appears when you open a document sent as an attachment? 
a. Read Mode c. Web 
b. Print Layout d. Draft 

7. When will Word automatically open a document in Protected Mode? 
a. When you open a document created by someone else. 
b. When you open a document that was attached and sent via email. 
c. When you open a document from a cloud storage location. 
d. When you open a document saved on a jump drive. 

8. What is the main difference between the Cut and Copy commands? 
a. Cut can only be used once whereas you can copy as many items as you need. 
b. You can only cut or move items using the drag and drop method. 
c. Cut moves an item from its original location; Copy makes a copy of the original item. 
d. Nothing; they work in the same manner. 

9. You just changed the spacing after a paragraph to 10pt and would like this spacing on two other 
paragraphs on page 3 of the document. Which option would you use? 

a. Redo  b. Repeat 

10. What must you do before applying formatting to existing text in a document? 
a. You must select the existing text. 
b. You must display the Font and Paragraph dialog boxes. 
c. You must save the document. 
d. You must have a new blank document open on the screen. 

11. Why might you want to use various tab characters when working with a financial report? 
a. To ensure the tab settings remain in place as you press Tab. 
b. To align values based on the type of data to be entered. 
c. To show these can be used in any type of report. 
d. To specify the number of columns for data. 

12. Which print orientation uses a horizontal layout? 
a. Portrait b. Landscape 

13. How can you identify the margins on the horizontal or vertical ruler? 
a. The margins are the darker areas of either rulers. 
b. A thick dark line separates where the margins begin. 
c. A thick white line separates where the margins begin. 
d. The margin areas only appear when you are in Print Layout view. 

14. When Word automatically inserts a page number, where is it inserted? 
a. On a blank line below the last line of text on a page. 
b. At the far right side in the right margin. 
c. In a header or footer. 
d. In a text box at the top left corner of the first page only. 
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15. What keyboard shortcut can you use to create a column break? 
a. CTRL+ENTER 
b. SHIFT+ENTER 
c. CTRL+ALT+ENTER 
d. CTRL+SHIFT+ENTER 

16. Which option displays the Navigation pane to find an item? 
a. CTRL+D c. CTRL+H 
b. CTRL+F d. CTRL+N 

17. How can you recognize a spelling error in a Word file? 
a. The noted error appears with a green wavy line. 
b. The noted error appears with a blue wavy line. 
c. The noted error appears with a purple wavy line. 
d. The noted error appears with a red wavy line. 

18. Which keyboard shortcut displays the Print options in the Backstage view for all Office applications? 
a. CTRL+A c. CTRL+P 
b. CTRL+R d. CTRL+V 

19. How can you identify that an image or object has been selected for manipulation? 
a. It displays handles around its perimeter. 
b. It displays in a darker shadow. 
c. A circular handle appears across the top of the image or object. 
d. A four-headed arrow appears when you point the cursor at the image/object. 

20. How can you crop a picture in Word? 
a. Horizontally only. 
b. Vertically only. 
c. Horizontally and vertically. 
d. You cannot crop a picture in Word. 

21. What is the intersection of a row and a column in a table called? 
a. Text box c. Box 
b. Cell d. Active cell 

22. How can you select an entire table quickly? 
a. Click the Tab Selector.  c. Press CTRL+A. 
b. Click in the Selection Bar. d. Click the Table Selector. 

23. How would you turn off the Track Changes feature when you are finished with the feature? 
a. Click the Track Changes button again. 
b. Press ESC. 
c. Press ENTER. 
d. Click Accept All Changes. 
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Key Applications 
 
 

Lesson 10: 
Using Microsoft Excel 
Lesson Objectives 
This lesson introduces you to how to use a spreadsheet application to create simple reports such as budgets, or 
cash flows. Upon completion of this lesson, you should be able to: 

 understand basic terminology or concepts for 
spreadsheets 

 create a new blank worksheet or use a template to 
create a new worksheet 

 enter or edit data in a worksheet 

 open, close or save workbooks 

 select cells for a variety of purposes 

 copy and move data 

 change the column width or row height 

 create simple formulas and use common built-in 
functions  

 format the data in a worksheet to enhance it 

 work with charts 

 sort or filter information in a worksheet 

 work with tables 

 preview and print a report 

Looking at the Excel Screen 
Objective 2-3.1, 2-3.6 

As with any Office application, when you first start the program, you see the Backstage view: 
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You can select a template for creating a new workbook, or click the Open Other Workbooks link to access 
the Open tab in the Backstage view. As you work in Excel, recently used files will display in the left pane of 
the startup screen. A new, blank workbook is shown in the following figure. 

 
Name Box – Look here for the address of the active cell. For example, if the Name box displays A21, this 
indicates the active cell is where column A and row 21 intersect. 

Insert Function – Open a dialog box that will help you choose and insert a built-in function. 

Formula Bar – View the contents of the active cell. Under certain circumstances, you can use this bar to 
create or edit entries in the worksheet. 

Select All – Click to select all the cells in the worksheet. 

Active Cell – Indicates the current cell with the thick border around the cell. 

Column Headings – The sequential letters at the top of each column enable you to identify columns. 

Row Headings – The sequential numbers on the left side of each row enable you to identify rows. 

Tab Scrolling – Use these arrows to navigate between the worksheets in the workbook. 

Sheet Tab – The name of the current or active worksheet on screen. 

Scroll Bars – Use these to move horizontally or vertically within the current or active worksheet. 

Worksheets are used whenever you need a report or document that tracks numerical information. Typical 
reports include budgets, cash flow analysis reports, revenue and expense reports, financial reports, an 
inventory analysis, or a document tracking data such as employee vacation time or student grades. 

Understanding Basic Terminology 
• An Excel file is called a workbook and a workbook contains one or more individual worksheets. For 

instance, a file named AM 2015 Figures could contain a worksheet that shows a summary of the 
company’s revenue and expenses, another worksheet with quarterly summaries, and a worksheet that 
shows business expenses, and so on.  

Name 
Box 

Insert 
Function 

Formula 
Bar 

Tab 
Scrolling 

Row Headings 

Column Headings Active Cell 

Sheet 
Tab Scroll Bars 

Select 
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• A worksheet contains rows numbered from 1 to 1,048,576, and columns assigned with letters or letter 
combinations from A to Z, then AA to ZZ, then AAA to AZZ, and so on up to XFD.  

• A cell is the intersection of a row and a column and can contain one single value (text or number), or 
formula. For instance, cell B5 is the “box” that you will find when you follow down column B to row 5. 

– Each cell has its own address, or a reference you can use to find it within a worksheet. 

– The active cell is the cell currently displayed with a thick border, such as cell A1 in the previous 
picture. 

Entering Data in the Worksheet 
You should always try to organize the information on a worksheet in a way that will be clear to you and to 
anyone else who may be using or analyzing the content. Include appropriate labels and descriptions in your 
reports so your audience understands what they are viewing.  

You can insert three types of data into worksheet cells: 

Labels – Text entries appear in the cells exactly as you enter them; default to left align. 

Values – Numeric values; default to right aligned. 

Formulas – Composed of cell references, arithmetic operators, and functions (calculation commands) that 
perform operations on data. 

Entering Text or Labels 
To enter information, click a cell to select it and then type the entry. Use the BACKSPACE key or DELETE key 
to correct any input errors. When you finish typing, press ENTER to move to the next cell below, or press TAB 
to move to the next cell to the right. You can also click another cell or press any arrow key to accept the input 
in the current cell. 

The following image is an example of how to organize your data so that you can clearly see its purpose: 

  
When entering information, consider the following: 

• You can enter or edit data directly in the active cell, or use the Formula bar for long data entries. 

• Labels can be up to 32,767 characters long. 

• If a label is longer than the width of the cell, it will display past the column border as long as the adjoining 
cell to the right is empty. Entries in adjoining cells cut off the display at the column border. The long text 
label may not be visible, but it is still completely contained in the cell in which it was entered. 

• You can easily change the appearance and alignment of any entry in any cell. 

• The maximum length of formula contents is 8,192 characters. 
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Entering Numbers or Dates 
Numbers are constant values such as dollars and percentages; by default, they align to the right side of a 
cell. If you enter characters other than numbers, Excel treats the entire entry as a label. Excel displays values 
with no formatting, allowing you to format them yourself. 

When entering dates, you can enter them in a numeric form such as 2-26-05 or as text, Month day, year). 
When entering dates, note the following: 

• The default format of the date value is m-d-yy, although you can change this using the Region and 
Language settings in the Control Panel. 

• The date value does not have to be the full day, month, and year. It can be just the day and month 
(formatted mmm-dd), or the month and year (formatted mmm-yyyy). 

Moving Around the Worksheet 
You can move around the cells of a worksheet using the following methods: 

Scroll Bars – Click the arrow buttons at either end of a scroll bar to move one row or column at a time. Click 
and drag the scroll box to display another location in the worksheet. 

LEFT, RIGHT, UP, or DOWN – Press a direction key to move one cell at a time. 

HOME – Moves to column A in the current row. 

CTRL+HOME – Moves to cell A1. 

CTRL+END – Moves to the last cell with data in your report. 

CTRL+G or F5 – Displays the Go To dialog box which you can use to move quickly to a cell address.  

You can also use the horizontal or vertical scroll bar to move to other areas of the worksheet. As you begin 
to work with multiple worksheets, you can use the arrows at the far left below the worksheet to navigate to 
these sheets; alternatively, you can click the sheet tab for the sheet you want to view. 

Managing Workbooks 
Objective 2-3.11, 2-3.12 

Basic file management tasks, such as saving a file, opening a file, creating a new file, or closing a file are 
similar across all applications in the Office suite. 

Creating a New Blank Workbook 
When you start Excel, the Backstage view appears and you can choose to create a new workbook or open an 
existing one. If you create a new blank workbook, it is automatically named Book1. Each time you create a 
new workbook during the same session, Excel will number it sequentially as Book2, Book3, and so on. When 
you exit Excel and start a new session later, the numbering begins at 1. 

To create a new blank workbook in Backstage, click New, and double-click Blank workbook. 

Key Fact: You can also press CTRL+N to create a new blank workbook, or a new blank document type in 
any Office application. 
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Creating a New Workbook from a Template 
To create a new workbook using a template, click the File tab, and click New. 

 
Click a template to open a larger view of the template contents. 

 

Click Create to create a new workbook based on the selected template. Alternatively, click the arrow at either 
side of the template to view other templates in the list on either side of this template. To exit the preview, 
click the  at the top right corner of the preview window. 

Each new workbook you create using a template displays the name of the template plus a number (for 
example, Working budget1) as a reminder that this is a new file that should be saved with a different name, 
preferably one that describes the type of data in the workbook. 
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Saving Workbooks 
To use a workbook again, you must save it. It is a good practice to save your work frequently during a session, 
especially if the workbook is large, or if you are using a process you have not tried before. 

To save the changes made to an existing file, click the File tab and then Save. 

Key Fact: You can also click  (Save) on the Quick Access toolbar, or press CTRL+S to quickly save the 
file. This is common to all Office applications. 

To save the changes made to an existing file and save it with a new name or in a different file format, click 
the File tab and then click Save As. 

The first time you save a file, you will always see the Save As options so that you can give the new workbook 
a distinct name and select the location where it will be stored, such as a folder on the hard drive, on a network 
or online drive, or on a portable media drive.  

 
You can choose the location by clicking the appropriate designation. Once the location is selected, the right 
pane changes to display a list of recently accessed folders in which to save files.  

From this screen you will click to select a folder to store the new file. Type the name in the File name field 
and click Save (or press ENTER). File names can be up to 255 characters in length.   

The default file type given to an Excel file is .xlsx, although you can save it in different file formats using the 
options in the Save as type field (the field that displays below the file name field).  

Up One Current 
Level Folder 

File name 

Save as 
 

Folders or files in Date created 
current folder or modified  

Drives or 
locations to save 
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If you need to save a workbook in a different format, click the arrow for the Save as type field to select the 
format you want; for example, you could save the file in a PDF form so no one can make changes to the 
workbook, or save the file in a previous version of Excel to make the file compatible for someone who does 
not have the same version as you. 

Using Excel and Other Spreadsheet File Types 
In addition to working with its own native file types, Excel can open files produced in earlier versions of Excel 
(such as .xls and .xlt files), and it can import files created in Microsoft Access, as well as output generated by 
SQL queries.  

Excel also supports the more generic file types associated with spreadsheet data. These types include: 

• Comma Separated Values (.csv) – these are text files wherein the data is laid out in a columnar format, 
and the contents of each column are separated by a comma. 

• Tab delimited files (.tsv) – these are text files wherein the data is laid out in a columnar format, and the 
contents of each column are separated by a tab character. 

These files can be used by many spreadsheet programs, and you can open these types of files directly in 
Excel, or you can import the data.  

Opening Workbooks 
To work with an existing workbook, you have to open it. You can have multiple workbooks open in Excel at 
the same time, but only one (the one that is currently displayed on the screen) can be the active workbook 
at any given time. 

To open a file, use one of the following methods: 

• Click the File tab, click Open, click the location for the file, and then the folder where the file can be 
found, or click Browse to use the Open dialog box. Select the file and click Open; or 

• click the File tab, and click a file from the list of Recent Workbooks displayed in the right pane. These 
are grouped by the date the file was last accessed. 

Key Fact: You can also press CTRL+O to display the Open dialog box. 
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As you learned in a previous lesson, all applications in the Office suite automatically open files received over 
the Internet in Protected Mode. You should understand that Protected Mode and Read-Only mode work the 
same in Excel as they do in Word. 

Closing Workbooks 
When you are finished working with the current workbook, save the changes and then close the workbook 
to protect it from accidental changes. Closing files also frees up system resources for other files. When you 
close a workbook, Excel displays any other open workbooks or a blank background screen if no workbooks 
are open. 

To close a workbook, click the File tab and click Close. 

Key Fact: You can also press CTRL+W or CTRL+F4 to close the workbook, or click the Close button to shut 
down the application. These work in any Office application. 

Exercise 10-1: Create New 
In this exercise you will create new workbooks and enter data in one of them. You will also save some of the 
new files for future use. 

1. Start Microsoft Excel, if necessary. Click Blank workbook to create a new workbook. 

 Excel displays the new blank workbook that contains a blank worksheet. 

2. Press CTRL+N to quickly create another new blank workbook. 

 This new workbook should show Book2 in the title bar (the number may vary depending on how many 
times you pressed the shortcut key). Notice that the active cell is A1 – it should be highlighted with a 
darker border around it and both column A and row 1 change color because these contain the cell that 
is currently active. As you click in different cells, the column heading and row number will change color 
accordingly. 

3. In cell A1 of Book2, type: <Your Name> - Bank Reconciliation and press ENTER. 

 The cursor should now be in cell A2 (you are still in column A but now in row 2). 

4. Type: Date and press TAB to go to cell B2. 

5. Type: Item and press TAB to move to cell C2. Type: Cash In.  

6. Press TAB to move to cell D2, type: Cash Out, press TAB to go to E2, type: Balance, and press ENTER. 

 This time the cursor is in cell A3. 

7. Press TAB to go to cell B3, type: Cash in Bank, press TAB to move to cell C3, type: 525 and press ENTER. 

8. In cell A4, type: Jan 1 and press TAB. Continue entering the information as shown: 

  
9. On the Quick Access Toolbar, click Save. 
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10. Click This PC in the middle pane and click the arrow at the left of Documents. Navigate to the Excel 
folder in the student data files, then in the file name field, type: Bank Reconciliation - Student (use 
your name or initials in place of “Student”) and click Save. 

11. Click in cell B1 and type in today’s date using the mmm dd, yyyy format, for example, May 11, 2016 and 
press ENTER. 

 You should notice the title text has been cut off by the date. This is an example of why you want to watch 
where you are entering data and how it affects areas in the report.  

12. Save the workbook again. 

Now create a new workbook using a template. 

13. Click the File tab and then click New. 

14. Scroll in the list and then click Simple monthly budget. Click Create. 

 Notice how Excel created a new copy of this file for you using a similar name (Simple monthly budget1) 
to remind you of which template you used. If you were planning to use this form, you could click each 
field to enter the appropriate information. For the purpose of this demonstration, you will just save it. 

15. Press CTRL+S to save this file. Click This PC and navigate to the Excel folder in the student data files. 

16. Click in the filename field, type: Simple monthly budget - Student and press ENTER. 

17. Press CTRL+N to create a new blank workbook. 

 You now have at least four workbooks open (the number will depend on the number of times you created 
a blank workbook or a new document from a template).  

18. Point at the Excel icon on the Windows taskbar and you should have at least four preview windows 
displayed. 

19. Click the Bank Reconciliation - Student file. 

 This file is now the active workbook on the screen. 

20. Point at the Excel icon and then click the blank workbook created in step 17. 

21. Close this workbook by pressing CTRL+W. 

22. Then press CTRL+W to close all other workbooks. 

Now try opening a file. 

23. Click File and then click Open. 

 There should be at least two files in the list of files most recently accessed. 

24. Click Bank Reconciliation – Student from the list. 

25. Press CTRL+O and click Simple monthly budget – Student. 

26. Click File, click Open, and click This PC. Ensure you are viewing the contents of the Excel folder, then 
click Tour Prices to open this file. 

Now save this file in another format so you can send it to someone who is using an earlier version of Excel. 

27. Click File, click Save As. Click the arrow for the Save as type field and then click Excel 97-2003 
Workbook (*.xls). Click Save. 
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 The file has been saved in this format and will also display a different icon at the left of this file name 
than the Excel 2016 file. 

  
Open a file that has been saved with Protected View. 

28. Click File, click Open, and click This PC. If necessary, click Excel, and then click Eco Cruises to open this 
file. 

 Notice the warning bar across the top of the file informing you that this file is in protected view mode. 

29. Press CTRL+W as necessary to close all open files. 

Manipulating the Contents 
Objective 2-1.1, 2-1.7, 2-3.1, 2-3.2, 2-3.3, 2-3.9 

The easiest way to change cell contents is to type the new content, press ENTER and have Excel replace the 
old information with the new entry. To correct errors as you type, press BACKSPACE or DELETE prior to 
pressing ENTER or moving to another cell. 

If you want to add, delete, or change less than the entire contents of the cell, you can activate Excel’s Edit 
mode by pressing F2 or double-clicking on the cell; Excel will display the insertion point and you can proceed 
in one of the following ways: 
• Select the text in the cell, type the replacement text, and press ENTER to exit the Edit mode; or 

• use the DELETE key to remove any unwanted characters from the cell contents. 

Selecting Cells 
Prior to performing an action, you must indicate what range or part of the worksheet to affect with that 
action. A range can be a single cell, several cells, or the entire worksheet. Selected cells remain selected or 
highlighted until you click a cell or press an arrow key. The selected range appears in reverse color to the 
cells. The active cell in the selected range appears in normal color. You can select individual cells or any range 
of cells as follows: 
Single cell – Click the cell. 
Extend the selection – Click the first cell and drag to the end of the required range; or click the first cell, 
hold the SHIFT key, and click the end cell in the range. 
Entire row – Click the row header when you see the . 
Entire column – Click the column header when you see the . 
Entire worksheet – Click the Select All button. 

Non-adjacent cells, columns, or rows – Click the cell, column, or row, hold the CTRL key, then click to select 
the next cell, column, or row. 
Multiple rows – Click the first row number and drag for the number of rows to select. 

Multiple columns – Click the first column letter and drag for the number of columns to select. 
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The following figure shows numerous selected ranges within a worksheet. 

 

Using Undo or Repeat 
Excel includes an Undo function that enables you to undo commands executed in the worksheet. 

Excel can undo up to a maximum of 100 recently-used commands; this “undo history” displays when you 
click the arrow beside the  (Undo) button. The Undo command can be performed only in the reverse 
sequence of the changes made to the worksheet; you cannot reverse the changes in a sequence of your 
choosing. Undo does not work for some commands such as saving the file. 

If you need to reverse an undo, you can redo or repeat it. The Repeat function is available only if one or more 
commands were undone. To display the repeat history, click the arrow beside the  (Repeat) button. Like 
the Undo command, these last 100 commands must be performed in the reverse sequence of the actions 
that were undone. 

Copying and Moving Data 
Excel enables you to copy or move cell contents from a different part of the same worksheet, another 
worksheet in the same workbook, or a worksheet in a different workbook. The command buttons and 
shortcut keys are the same as they are Word. 

Cut – Removes the contents of a cell or a range of cells to the Office Clipboard. 

Copy – Copies the contents of a cell or a range of cells to the Office Clipboard. 

Paste – Pastes any or all contents from the Office Clipboard into one or more cell locations. 

Key Fact: You can press CTRL+C for copy, CTRL+X for cut and CTRL+ V for paste in any Office application. 

Before you can activate the copy or cut command, you must select a range of cells. Once you activate either 
the cut or copy command, a marquee (moving dotted rectangle) will appear around the selection, identifying 
what will be cut or copied.  To cancel the marquee, press ESC. 

You can then use Paste to place the cut or copied item into the new location; alternatively you can press 
ENTER to paste the item and turn off the marquee at the same time. 
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Using the Office Clipboard 
You can cut or copy more than one cell range, and keep up to 24 cell ranges in 
the Office Clipboard at one time. You can then paste any or all these items in any 
sequence. When you cut or copy the 25th item, the first one in the list will 
disappear, making room for this new entry. 

Activate the commands for cut, copy, and paste using the Home tab, in the 
Clipboard group, or with the keyboard shortcuts. Display the Office Clipboard at 
any time by clicking the Clipboard dialog box launcher in the Clipboard group of 
the Home tab. 

As with all Office applications, the Office Clipboard can contain cut or copied 
items from any application, including a non-Office application. 

Paste All – Paste all items in the same order they were collected into the current 
location on the worksheet. 

Clear All – Clear the Office Clipboard of all entries. 

Options – Set how the Office Clipboard works. 

Changing the Column Widths 
You can adjust column widths to display more characters. When a text entry in a cell is longer than the width 
of the column, Excel displays the text by overflowing the entry into the cells 
to the right, if they are empty. If the cell to the right contains information, 
the text is truncated or “cut off” at the column boundary.  

If the width is not wide enough to display all the digits of a numeric or date value, Excel displays # symbols. 
If you increase the width of the column sufficiently, the value will be shown in standard format using any 
assigned cell formatting.  

 
Column widths can be set between zero and 255 characters. When you change a column width, the stored 
contents of the cells do not change, only the number of the characters displayed. 

To change the width of a column, on the Home tab, in the Cells group, click Format, and then Column Width. 

Type a value in the Column width box and click OK or press ENTER. 

Hint: You can also point the mouse pointer on the line at the right edge of the 
column header to be adjusted, and when you see , click and drag to the 
required width for the column. 
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Adjusting the Row Height 
When you need to adjust the row height so the row is smaller or larger than others in the worksheet, on the 
Home tab, in the Cells group, click Format, and then Row Height. 

Type a value in the Row height box and click OK or press ENTER. 

Hint: You can also point at the bottom edge of the row header to be adjusted, and 
when you see , click and drag to the height required. 

Manipulating Rows, Columns, or Cells 
Insert new rows, columns, or cells when you need to add information or separate parts of the worksheet. 
Delete rows, columns, or cells of data that you do not need in the worksheet. 

Inserting Rows, Columns, or Cells 
You can insert a new row above the current row, and a new column to the left of the current column. You 
can insert one or more rows or columns at the same time. 

You can also insert cells in specific areas of the worksheet; use caution when 
activating this option as it can alter the structure of your worksheet. On the Home 
tab, in the Cells group, click the arrow for Insert to select the item to be inserted. 

Be careful using these commands as they affect the entire worksheet and may affect 
areas of the worksheet you are not viewing on the screen. For example, if you want 
to insert a row but only have one cell in the row selected, click the arrow for the Insert command to insert 
the row; do not click the Insert command on its own as Excel will insert a cell in the current cursor location 
only for that one column.  

Hint: Click the row heading or column heading where you want to insert a new row or column. Then press 
CTRL++ on the Numeric Keypad. 

Deleting Rows, Columns, or Cells 
You can delete one or several rows or columns, or shift cells over in place of deleted 
cells. Deleting the contents of a cell affects only the contents, not the structure of 
the worksheet. Deleting a cell affects the structure of the worksheet. On the Home 
tab, in the Cells group, click the arrow for Delete to select the item to be deleted. 

Hint: Click the row heading or column heading where you want to delete. Then 
press CTRL+– on the Numeric Keypad. 

Be careful when deleting entire rows or columns to ensure you do not accidentally 
delete valuable data not currently displayed on the screen. 

Exercise 10-2: Bank Reconciliation 
In this exercise you will complete a workbook by adding similar entries into cells of a worksheet as well as 
adjust the column widths to make the report comprehensive. 

1. Click File, click Open, and click the Bank Reconciliation - Student file to open it. 

2. Click File, click Save As, and in the File name field, type: Bank Reconciliation adjusted - Student as 
the new name and then click Save. 
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3. Click B1 and press DELETE. Then on the Quick Access Toolbar, click Undo. 

 The date should be back in the report. 

4. On the Quick Access Toolbar, click Redo to remove the date again. 

5. On the Home tab, in the Clipboard group, click the Clipboard dialog box launcher button. 

6. Select cells B4 and C4 which contain the payday information. Then on the Home tab, in the Clipboard 
group, click Copy. 

 Notice how the Office Clipboard now shows an entry for the contents of this cell range. You should also 
notice the marquee around cells B4 and C4, reminding you this is the original source for the copy action. 

7. Click in cell B8 and then click the entry in the Clipboard. 

  
 You have just successfully copied and pasted an entry from one cell range to another (the marquee no 

longer appears around the original source).  

8. Click in cell A8, type: Jan 15 and press ENTER. 

9. In cell A9, type: Gas, press TAB twice, type: 53.45 and press ENTER. The information has been entered 
into the wrong cells. 

10. Select cells A9 to C9, and press CTRL+X to cut the information. 

11. Click in cell B9, and press CTRL+V to paste this entry into this location. 

12. Click the  on the Office Clipboard. Then save the workbook. 

Now try adjusting the worksheet to improve the readability of the report. 

13. Place the cursor between the column heading for B and C. You should see the  icon appear between 
the column headers. 

14. Click and drag to the right to increase the size of column B.  

 Notice as you drag that Excel displays a small ScreenTip indicating the width of the column, such as 
12.14.  

15. Release the mouse when you see the 12.71 or 13.00 measurement. 

Now insert a blank row to place some room between the title of the report and the column headings. 

16. Click the row 2 heading. On the Home tab, in the Cells group, click Insert. 

 Excel automatically inserted a row as a result of selecting the entire row before selecting the command; 
Excel can recognize what or where you want to apply a feature. 

17. Save the workbook. 
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Creating Simple Formulas 
Objective 2-3.5 

A formula is a calculation using numbers (or other data) in a cell or from other cells. It can be as simple as a 
single cell or it can be as complex as required in a large worksheet of one workbook that may be linked to 
other workbooks. Using a formula to calculate values enables you to focus on the data and allow Excel to 
automatically recalculate the results if the data changes. 

To begin a formula in any cell, you must enter = (equals symbol). Depending on the formula, this is usually 
followed by a cell address, a mathematical operand, and then another cell address, as seen in the following: 

 =B3*F16 

• You can enter a cell address into a formula by typing it directly into the cell, or by clicking on the cells to 
be included.  

• The cell into which you enter a formula will display the result of the formula; the formula itself will be 
visible in the Formula bar. 

Excel calculates formulas in “natural order”: exponents first, then multiplication and division, and then 
addition and subtraction. This order can be altered by inserting parentheses or brackets around portions of 
the formula; Excel will calculate the portions inside parentheses before calculating the other items in the 
formula. 

The following symbols are used in Excel to represent standard mathematical operators: 

 * Multiplication + Addition 

 / Division -  Subtraction 

Cells containing formulas can be copied to other cells. If these formulas contain cell references, Excel will 
automatically adjust the cell references when you paste the formulas into a new location.  

Using Common Built-In Functions 
Excel provides over 300 built-in functions for mathematical and data operations. Functions accept numbers, 
values, and cell references as arguments within parentheses, following this format: 

 =FUNCTION(numbers or values or cell references) 

Some common functions you will use include: 

=SUM – Calculates the sum of the values in the range of specified cells. 

=AVERAGE – Calculates an average of the values in the specified cells (totals the range and divides the total 
by the number of entries). 

=MIN – Displays the minimum value in the range of specified cells. 

=MAX – Displays the maximum value in the range of specified cells. 

=COUNT – Counts the number of values within the specified range. 

Cell ranges in a function should be indicated as follows: 
 <first cell address>:<last cell address>  E4:G6 
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You can specify a range by typing the cell reference directly or by using the “point-to” method, where you 
use the mouse to click and drag to select the cell range. The latter method allows you to visually identify the 
cell range, which reduces the chance that you will enter incorrect cell references. 

Be sure to verify that you have selected the correct cell range for the function. If there is even one blank cell 
between cells, the range may not include all cells. 

Using Absolute and Relative Addresses 
Most formulas entered into an Excel worksheet refer to cell addresses which are relative. If you copy a formula 
with a relative cell address and paste it to another cell, Excel will automatically adjust the cell references in 
the pasted cell to reflect the new location. For example, suppose you have a formula that adds three rows 
together within one column; you can copy this formula to another column to add the same three rows in the 
new column. The cell addresses used in the formula are relative to the column in which you place the formula. 

An absolute cell address refers to an exact or fixed location on the worksheet. 

To change a relative cell address to an absolute (fixed) cell address in a formula or function: 

• Type a dollar sign before the row number and/or column letter; or 

• press F4 once you enter the cell address. 

Exercise 10-3: Bank Reconciliation Formulas 
In this exercise, you will enter a few simple formulas using math operators. 

1. Ensure the Bank Reconciliation adjusted – Student file is open and save it as Bank Reconciliation with 
formulas - Student. 

2. Click in cell E4. Type: =C4 and press ENTER. 

 You successfully entered a simple formula into cell F4 that inserts the contents of cell C4 as the starting 
formula. 

3. In cell E5, type: =C5+E4 and press ENTER. 

 Excel now displays the total of the starting balance plus the amount of the new cash. 

4. Click in cell C4 and type: 725. Press ENTER. 

 Notice how the formula updates to accommodate the new value. You can see how using a formula saves 
you the time of having to change the data if you had entered it manually. 

5. Click in cell E6 and type: = to start the formula. Click cell E5, type: - (dash or minus sign), click cell D6 
and press ENTER. 

  
 Notice how this time you clicked the cells for the formula instead of typing the cell addresses manually.  
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6. Click cell E6 and press CTRL+C. Then select cells E7:E8 and press ENTER. 

  
 Excel has copied the formula in cell E6 and adjusted the cell addresses for the next two rows. This is an 

example of relative cell referencing. 

7. In cell E9, type: =E8+C9 and press ENTER. 

 If you were to continue with the report, you would continue to enter data to indicate the cash going into 
and out of the bank account, inserting formulas as applicable to calculate the changes. 

8. Save and close the report. 

Now try using functions in a worksheet to show totals for the pricing set on tours for the upcoming year. 

9. Open the Tour Prices file and save as Tour Prices - Student. 

10. Click the column heading for Column C, drag across to Column G, then release the mouse button. 
Columns C through G are now selected. 

11.  In the Home tab, in the Cells group, click Format, then click Column Width to open the Column Width 
dialog box. Type: 11 and then press ENTER to change the width of the selected columns to 11. 

12. Click in cell G5. Then on the Home tab, in the Editing group, click AutoSum. 

  
 Excel now identifies the cells you may want to sum or total. If these are correct, you need only accept 

the suggested cell range. If you need to change the range of cells, click to select the cells you want to 
be included in the formula. 

13. Press ENTER to accept the formula in this cell and move the cursor to the next cell below. 

You will now insert formulas to total the remaining tours.  

14. Click in cell G5 again and then on the Home tab, in the Clipboard group, click Copy. Excel copies the 
formula to the clipboard. 

15. Click cell G6 and drag down to cell G15. Press ENTER. 
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 Excel pastes the formula into the remaining cells. 

16. Click cell G6 to see how the formula appears. 

 You should notice that the cell references for the AutoSum range have adjusted to reflect the total for 
this row instead. That is, the range is B6:F6 for row 6, but it will be B7:F7 for row 7 and so on. 

17. Save the worksheet. 

Suppose there is now a possibility that you may have to raise the tour prices by 25% to cover varying 
exchange rates. 

18. Click cell A20, type: Exchange Rate as the label and press TAB. In cell B20, type: 1.25 as the rate and 
press ENTER. 

19. Click cell I5. Type: = and then click cell G5. 

20. Type: * to insert a multiplication operator and then click cell B20. Press ENTER to accept the formula. 

21. Copy the results of this cell down to the cell I15. 

  
 You should notice that the remaining cells have no results in them from the copying of the original 

formula. This is because Excel uses relative cell addressing by default. What we need to do is set the 
appropriate cell in the original formula to be static or absolute so the new rate will be calculated correctly 
in the remaining cells. 
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22. Click in cell I5 and then click in the Formula bar to activate the Edit mode. With the cursor at the end of 
the B20 cell address reference, press F4. 

  
23. Press ENTER to accept this change.  

 You have specified that cell B20 is an absolute cell address. Neither the row nor the column will be 
adjusted as you copy and paste. 

24. Copy this formula down to cell I15. 

  
25. Click in several of the cells to look at the formula, and notice how the first cell changed to recognize the 

value but the cell with the Exchange Rate stayed constant. 

26. Save and close the workbook. 

What Does Formatting Mean? 
Objective 2-3.9, 2-3.10 

Formatting refers to changing the appearance of data to draw attention to parts of the worksheet, or to make 
the data easier to read. Formatting does not affect any underlying values. 

• You can format a cell or range of cells at any time, either before or after you enter the data.  

• A cell remains formatted until you clear the format or reformat the cell.  

• When you enter new data in the cell, Excel will display it in the existing format.  

• When you copy or fill a cell, you copy its format along with the cell contents. 

To apply formatting, on the Home tab, click the command to apply formatting from the appropriate group. 

 
Excel provides other methods to access formatting options such as keyboard shortcuts or the Mini toolbar; 
the following demonstrates the most commonly used method to access these formatting options. 

Hint: You can also press CTRL+1 to display the Format Cells dialog box for further options on formatting 
various elements of the worksheet. 
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Formatting Numbers and Decimal Digits 
When you enter numbers, Excel displays them exactly as you entered them except 
for any trailing zeros. Also, numbers larger than the width of the cell will display in 
scientific notation format. 

• To format selected cells that contain values, on the Home tab, in the Number 
group, click the arrow for Number Format, and click the format required, or 

• click one of the commonly-used number format buttons in the Number group 
of the Home tab. 

  

Changing Cell Alignment 
Alignment refers to the position of data within a cell. You can align cell contents horizontally (column width) 
and vertically (row height).  

• By default, new values entered into a worksheet use the General alignment option: numbers and dates 
automatically right-align, while text labels automatically left-align. 

• Use Merge & Center to center a text label across several cells. 
You can also wrap text in a cell or rotate it at a specific angle.  

– To split cells that were merged using Merge & Center, click 
the arrow on the Merge & Center button, then click 
Unmerge Cells. 

To change the alignment for selected cells, on the Home tab, in the 
Alignment group, click the alignment option required. 

Changing Fonts and Sizes 
A font is a typeface or text style. Changing fonts alters the way text and numbers appear.  

Note: Keep the number of fonts in a worksheet to one or two, as the 
appearance of too many font styles can be distracting. 

To format selected cells, on the Home tab, in the Font group, click the desired 
format. 

Applying Cell Borders 
Borders separate groups of data to improve legibility, especially when the worksheet contains a large volume 
of numbers. This feature enables you to draw lines around any or all edges of a cell or range of cells. You can 
choose presets, line thickness, color/style options, and location of borders. 

Accounting 
Number Comma 
Format Style 

Percent 
Style 

Vertical Alignment 
Options 

Horizontal Alignment 
Options 
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To apply a border to a cell, on the Home tab in the Font group, click the arrow for  (Borders) and click 
the side you want to apply a border; alternatively, click More Borders to apply other formatting options for 
the borders from within the Border tab of the Format Cells dialog box.  

  

Applying Colors and Patterns 
The Fill option sets the background color and pattern for a cell. Patterns and colors draw attention to certain 
parts of your worksheet, and can act as a visual divider of information. 

Patterns and colors are different features. Patterns can make it harder to read the data than using a solid 
color; whenever possible, avoid dark colors and dense patterns that can obscure the information in the cells. 

To apply a color or pattern to a cell, on the Home tab, in the Font group, click the arrow for  (Fill Color). 

Exercise 10-4: Balance Sheet 
In this exercise, you will format different parts of the worksheet to emphasize values and text. 

1. Open the Balance Sheet file and save it as Balance Sheet - Student. 

2. Select cells A1 to C1. Then on the Home tab, in the Alignment group, click Merge & Center. 

3. Repeat step 2 for cells A2 to C2 and A3 to C3. 

  

4. Select the three cells and on the Home tab, in the Font group, click . 

5. Click the arrow for Font Size and change this to 14. 
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6. Click cell B5 and drag to cell C5. Press CTRL and then click cells A6, A11, A13, A16, A18, A21 and A23, 
then release CTRL. 

7. Press CTRL+B to add bold to all these cells. 

8. Select cells B7 to C10, press CTRL and select cells B14 to C15 and also cells B19 to C20. 

9. On the Home tab in the Number group, click . 

  
10. Click cells B11 to C11, press CTRL, then click B16 to C16, B21 to C21, and B23 to C23. 

11. On the Home tab, in the Number group, click . 

  
 You have successfully applied two different number styles to the report to reflect the different types of 

data, such as list items versus total values. 

12. Select cells B11 to C11 and then B23 to C23. On the Home tab in the Number group, click the Number 
dialog box launcher. 

13. Click the Font tab. Click the arrow for the Underline option and click Double. In the field to the right, 
change the color to a dark red. Click OK. 
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14. Select cells B5 to B23. Then on the Home tab, in the Font group, click the arrow for the Fill Color button 

and then click White, Background 1, Darker 5%. 

15. Click anywhere away from the selected cell range to view the fill. 

  
 When choosing a background color, try to choose one that does not make the values difficult to read or 

that emphasizes the wrong items or areas of the worksheet. On occasion you may find you need to 
adjust the colors accordingly. 

16. Save and close the workbook. 

Working with Charts 
Objective 2-3.7 

A chart is a pictorial representation of data in a worksheet. A chart can be a more descriptive way of 
representing your data, as it can clearly illustrate trends or patterns in the data. 
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You can create a chart by selecting data from the worksheet, and then select the type of chart to insert into 
the worksheet. Once you have created the chart, you can save it with the workbook. 

 
To create a chart, select the cell range(s) for the chart in the worksheet and then, on the Insert tab, in the 
Charts group, click the chart type. 

 
Once the chart has been created, it will reflect any patterns or trends in the worksheet data and show that 
information in a picture format. Remember that the chart is created based on the cells you select prior to 
activating the chart feature; if the data in the chart does not match your analysis of the data, you will need 
to check the series used in the chart (both the items being charted and any time intervals).  

You can also try changing the chart type to one that will better reflect the type of data you are trying to 
illustrate. For example, a line chart can show a significant increase in product sales at a glance better than a 
bar chart would, while a pie chart may do a better job of contrasting sales figures for a product during a 
specified period. A pie chart can emphasize the total revenue of each location for the year as it compares the 
values as a whole. A column or bar chart can display the same information as a comparison or ranking in a 
side-by-side format. 

When a chart is on screen, you can select it to display the Chart Tools ribbon, which consists of two tabs with 
additional options for modifying or customizing the chart. 

Selecting Chart Types 
As noted previously, the type of chart you select will depend on what you are trying to show. Line charts are 
better for trends, bar charts are better for volume, and pie charts are best for showing portions of a total. 

  

Vertical Horizontal 
Axis/Series Axis/Series 

Chart Title 

Legend 
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Excel provides a variety of chart types and several subtypes within each major type: 

 
Column – Compares values over time or categories in a vertical presentation. 
Line – Compares continuous trends. 
Pie – Compares series that make up a whole. 
Bar – Compares values over time or categories in a horizontal presentation. 
Area – Compares a continuous change in volume. 
X Y (Scatter) – Determines data patterns. 
Stock – Displays high-low-close data; requires at least three sets of data. 
Surface – Displays trends in values with a three-dimensional presentation and a continuous surface. 

Radar – Determines patterns or trends with points matched up by lines. 

You can create any of these charts in two-dimensional or three-dimensional form; the latter can be more 
interesting to look at, but may be more difficult to interpret. Alternatively, if you would like a recommendation 
for a chart type to use, click the Recommended Charts tab to review samples of how your data will appear 
in each chart type. 
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To change the chart type, click the chart and then under Chart Tools, on the Design tab, in the Type group, 
click Change Chart Type. 

Changing the Chart Layout  
Excel generates a chart using standard defaults. Modify the layout to create exactly the look you want. Use 
commands on the Chart Tools ribbon to manipulate items on the chart. 

Axes – Include labels on the horizontal and vertical axes. 

Axis Titles – Add titles to the horizontal and vertical axes; you can also customize items 
for the chart, such as the units used in the vertical axis. 

Chart Title – Add a title for the chart. 

Data Labels – Include data labels on the chart. 

Data Table – Display the chart data beneath the chart. 

Error Bars – Displays margins of error and standard deviations on the chart. 

Gridlines – Include gridlines on the chart. 

Legend – Include a legend and position it in relation to the chart. 

Exercise 10-5: Eco Cruises 
In this exercise, you will create a simple chart and add elements to the chart to make it more effective in 
determining if there is a pattern for cruise ship preferences. 

1. Open the Eco Cruises file, click Enable Editing, save it as Eco Cruises – Student and then click the 
Enable Content button. 

2. Select cells A1 to G7. Click the Insert tab, in the Charts group, click Insert Column or Bar Chart and 
then Clustered Column in the 2-D Column area. 

 Similar to working with pictures, there are handles that you can use to size the chart object; these are 
represented by small squares instead of circles. To move the chart object, position the cursor anywhere 
on a blank area of the border around the chart and when you see , you can then drag the chart to a 
different location on the worksheet. 

3. Position the mouse cursor on a blank area of the top border of the chart object and drag it to below the 
data table. 

4. Click the bottom right handle of the chart object and drag to resize it so it fits within the range A9:J27. 
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 Notice how as you resize the chart, more text appeared across the bottom of the chart, or the horizontal 

axis. As such, the bars are now too thin to view; you may also want to switch the data so the cruise ships 
appear across the horizontal axis instead. 

5. Under Chart Tools, on the Design tab, in the Data group, click Switch Row/Column. 

  
 The way you display the chart data will depend on what your focus is; in this case, the current layout 

represents the data in a more effective manner as we can quickly see which cruise liners seem to be 
doing the most business, as well as during which time frame. You can also modify the scale for the 
horizontal axis if you prefer the previous display. For this exercise, we will leave it with the cruise ships 
listed in the horizontal axis. 

6. At the top of the chart, click to select the Chart Title element and then drag to select the text. Type: June 
Bookings and then click anywhere else on the chart. 
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Let’s change the chart type to give the chart more impact. 

7. Under Chart Tools, on the Design tab, and in the Type group, click Change Chart Type. 

8. Click the Line chart type. Click OK. 

  
 The data is still in a chart format but now may not be as easy to interpret any trends or view comparisons 

as with the other chart type. This is an example of how you choose a chart type that best represents the 
data or trend you want others to see in the report. 

9. Repeats step 7 and 8 to try different chart types and decide which chart type best shows the data in this 
file.  

10. Save and close the workbook. 

Working with Lists and Databases 
Objective 2-3.4, 2-3.13 

Most often in Excel, data is arranged into lists. The word “list” is a term from the early days of Excel, and 
generally it refers to data that is arranged into a series of columns. The top row of the list includes headings 
or column titles (formatted in bold), and the rows below contain the data. Column titles are also called field 
names. 

In order for a list to be meaningful, each column within the list should contain the same type of data for each 
row of information. Consider the list shown in the following figure: 

 
Notice that column A contains movie titles for each row shown in the list, while column B contains genre 
information, and column C contains media type information. 

Arranging data into lists makes it easy to sort and filter the information.  
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Sorting Data 
One advantage of using Excel to store data is the option to sort and organize the data based on the values 
in the selected columns or rows. You can sort and re-sort data as many times as required, using different sort 
criteria each time. You can sort data by columns or rows; however, it is far more common to sort by columns.  

On the Home tab, in the Editing group, click Sort & Filter. 

Sort A to Z – Sort items in ascending order (for example, A to Z or 0 to 9). 

Sort Z to A – Sort items in descending order (for example, Z to A or 9 to 0). 

Custom Sort – Set up to 64 levels or priority on what items to sort by order (for example, 
Last Name, then by First Name, then by Purchases, then by Product, and so on. 

Filter – Search for specific items and show only those items that match. 

Clear – Clear the filter and show all items in the worksheet. 

Reapply – Apply the filter once more. 

Filtering Information 
Finding information in a large or unorganized worksheet can be simplified by sorting; however, you still have 
to look through all the rows to find what you want. Another way to locate information quickly is to use a filter 
to hide the rows you are not interested in. Filtering does not change the content of your worksheet or the 
sequence of the information, only what you see. 

The quickest and easiest way to filter data in Excel is to use the AutoFilter tool. When you activate this tool, 
Excel places AutoFilter icons on the right side of each column or field name. Use these icons to select the 
conditions for the records you want displayed. Initially all information is shown. 

The AutoFilter can find rows where a cell is equal to a specific value or set of values. Other selection criteria 
give you the flexibility to find almost anything you need, including values that are not equal, greater than, 
less than, greater than or equal to, less than or equal to, and between. Certain types of fields have additional 
selection criteria: 

 

 

To activate the Filter command, on the Data tab, in the Sort & Filter group, click Filter. 
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When the filter command is activated, Excel places arrows on each column heading that you can use to filter 
data in the worksheet. Use these arrows to filter the information and show only the data you want to view. 

You can choose to filter the data using one of the options in the top portion of the drop-down menu, clear 
or create a custom filter, or click to turn on or off an item in the list to display the items you want to see in 
the worksheet. 

To clear a filter, click the AutoFilter button for the filtered data and then click Clear Filter From. 

Exercise 10-6: Inventory Sort 
In this exercise, you will sort the inventory list by different criteria. 

1. Open the Inventory file and save as Inventory to Sort - Student. 

2. Click in cell A2. Then on the Home tab, in the Editing group, click Sort & Filter. 

3. Click Sort A to Z. 

   
Now let’s set up two different sort criteria. 

4. Click in cell B2. 

5. On the Home tab, in the Editing group, click Soft & Filter and then click Sort Z to A. 

 The inventory list is now sorted by genre. 
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6. Save the workbook. 

Now use the Filter feature to show only data you are interested in viewing. 

7. On the Home tab, in the Editing group, click Sort & Filter and then click Filter. 

 Arrows should appear at the bottom right of each column heading in the worksheet. 

8. Click the AutoFilter button for Genre. 

  
 Notice that Excel gives you the option to sort the data, as needed, in addition to setting conditions to 

find a specific piece of data using the Text Filters.  

9. Click Select All to turn off this option and then click Animation. Then click OK. 
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 You should now be able to see only the titles that are listed as Animation. Notice that the filter button 
changes to appear as  from . This is a visual indicator that a filter has been applied in the worksheet. 
Another indicator is the non-sequential row numbers which display in blue, and the 8 of 40 records found 
notification that displays in the status bar. 

10. On the Home tab, in the Editing group, click Sort & Filter and then click Clear. 

 You should now see the entire inventory list again. 

11. Click the AutoFilter arrow for Media Type. Deselect Select All, click Blu-ray and click OK. 

12. Click the AutoFilter arrow for Genre and deselect Select All. Click Action and Drama. Click OK. 

  
13. Click the filter button for Media Type and click Clear Filter from Media Type (DVD/Blu-ray). 

 Notice how the list now contains more information that matches the filter for Genre. 

14. Save and close the worksheet. 

Understanding Excel Databases 
Databases in Excel are really lists that adhere to a special set of requirements: 

• The first row of the database must contain field names (titles) at the top of each column.  

• Each column in the database must contain the same category of data in every row in the column. 

• Each row (record) in the database contains all of the fields of data.  

• The row containing the field names must be formatted differently from the rest of the list (for example, 
they should appear in bold, or italics). 

• There can be no blank rows in the list (there can be blank cells in a column, but an entire row cannot be 
empty) 

• Data in a column must be in the same format for every row in the column. That is, entry in a given column 
must be numbers, or every entry must be text, or every entry must be dates; you cannot mix and match 
within a column. 

Other data that you want to include in the worksheet that is not part of the database can be located outside 
the boundaries of the database. 

You can use Excel to create and maintain simple databases quite easily, and you can use sorting and filtering 
to find the data you want. 
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Working with Tables 
Objective 2-3.8 

Many worksheets consist of a rectangular block of data in which the rows of data have a common structure 
and format. Excel offers you the ability to define this block as a table. As a table, you can use a variety of 
tools such as selecting summary formulas, formatting, sorting, and filtering. These same features are available 
even without using tables but you would have to select the columns of data manually. However, by defining 
a range of cells as a table, you indicate to Excel that this group belongs together as a single unit. These same 
tools are then easier to apply because Excel now knows which cells to include.  

To create a table, the data you want to include must be contiguous. That is, there must not be any blank rows 
or columns in the range of cells. Also, the data must be arranged in row order, with a header at the top of 
each column and the data listed below. 

To convert a range of cells containing data to a table, use one of the following methods: 

• On the Insert tab, in the Tables group, click Table, or 

• on the Home tab, in the Styles group, click Format as Table, then click a table style. 

Once you create the table, Excel activates an AutoFilter icon next to each column title and applies the current 
active theme. The Table Tools Design tab is also added to the Ribbon: 

One of the table features is the ability to insert an automatic Total Row at the bottom of the table. 

Modifying Table Data 
After the table is created, you can add or delete rows and columns of data.  

• To add a new column of data at the far right of a table, simply enter this data into the first blank column. 
Excel will automatically extend the table to include this new column.  

• Similarly, Excel will extend the table to include a new row of data that you enter directly below a table, 
as long as the Total Row feature is not activated. If the Total Row is activated, you must click any cell in 
the bottom data row, then on the Home tab, in the Cells group, click the arrow next to Insert, and click 
Insert Table Row Below. 

Similarly, on the Home tab, in the Cells group, you can use the Delete button to delete rows or columns of 
data from the table. 

Formatting Table Data 
By default, the theme selected for the workbook is applied to all tables in that workbook. You can override it 
for specific tables by selecting a different style under Table Tools, on the Design tab, in the Table Styles 
group. 
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The table style colors option can also be removed, and re-applied later if needed again. If none of these 
predefined table styles are suitable, you can also create a customized one.  

The Table Tools Design tab also allows you to activate or de-activate other table formatting options including: 

• Highlighting the first or last column – or both – with the bold font option. By default, both options are 
turned off.  

• “Banding” rows by using different color shades for alternating rows. This feature often improves the 
readability of tables that are very wide because data in the same row have the same background color. 
By default, the Banded Rows option is turned on, but Banded Columns is turned off. 

Exercise 10-7: Monthly Call 
This exercise demonstrates how to create a table, assign a name of your choice to the table, and add a total 
row at the bottom. 

1. Open the Monthly Call Volume workbook and save as Monthly Call Volume – Student. 

Now convert the data to a table. 

Hint: When creating a table, leave at least one empty row and column on all sides of the table to separate 
it from any other data on the worksheet. 

2. Click any cell in the range A4:E15. On the Insert tab, in the Tables group, click Table. 

   
3. Confirm that My table has headers is turned on and then click OK. 

The data is now converted into a table. Change the table name to something that is more meaningful to you.  



Using Microsoft Excel Lesson 10 
 

 

7500-1 v1.00 © CCI Learning Solutions Inc.  345 

4. Under Table Tools, on the Design tab, in the Properties group, click in the Table Name field and replace 
the default name with: CallVolume (with no spaces between the words). 

  
5. Under Table Tools, on the Design tab, in the Table Style Options group, click Total Row to turn it on. 

  
6. Select cell B16, click the drop-down arrow that appears next to it, and click Average. 

7. Repeat step 7 for the Count, Max, and Min options for cell B16. 

8. Repeat step 7 for the Sum option for cell B16. 

9. Select each of the cells C16:D16 and select the Sum function. 

Note: You cannot copy the contents of a column total to other cells in a table. 

If you also want to display row totals (in a new column to the right of the table), you will have to insert them 
manually. Tables do not have the ability to create row totals automatically. Row totals show the sum total for 
each row of data.  

10. Click cell F4 and enter: Total. 

11. With cell F5 as the active cell, on the Home tab, in the Editing group, click AutoSum and press ENTER. 

  

Note: When you activate the 
Total row, Excel automatically 
moves any data below the table 
down by one row. 
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 Even though you only entered the row total for the first row, Excel has automatically inserted them for 
the rest of the rows, except the Total row. This demonstrates one of the advantages of identifying this 
range of cells as a table.  

12. Click cell F5. 

 You can see that the formula used for this sum total is specifically used for tables. 

  
Now insert the Total Row calculation for this new column. 

13. Select cell F16, click its drop-down arrow, and select Sum. 

14. Save the workbook. 

Now add a new row at the bottom of the table.  

15. Select cell F15 and press TAB. 

 Notice that Excel automatically shifts the Total row down by one row and that the formula in cell F15 is 
copied down to this new row. 

16. In cell A16, type: December 2016 as the new value and press TAB. Then enter the following values into 
the remaining cells of the row: 

B16 8969 
C16 7375 
D16 7 
E16 1 

 Notice also that the statistical formulas in row 17 (these were all Sum but you may have selected Average 
or other formulas instead) automatically updated even though the new data were added at the bottom 
of the list. 

Now add a new column between the Complaints and Total columns. 

17. Select cell F8, then on the Home tab, in the Cells group, click the arrow for Insert, and click Insert Table 
Columns to the Left. 

18. Click cell F4 and type: Other. Then enter the following values into the remaining cells of the column: 
F5 500 
F6 300 
F7 250 
F8 450 
F9 400 
F10 220 

F11 200 
F12 480 
F13 100 
F14 200 
F15 150 
F16 300 

19. Select cell F17, click the drop-down arrow and click Sum. 

 By adding a column to the table, you must ensure that the Total column at the far right includes this new 
column. 
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20.  Click cell G6, and note the formula in the Formula bar. Press F2, delete the table cell reference 
[Complaints], and replace it with: [Other]. Then press ENTER. 

  
 Notice how Excel automatically updates the total in G17 once you change the field headings that are 

included in the table. 

If no longer needed, a column (or row) can be easily removed from a table. 

21.  Click any cell in the range D4 to D17, then on the Home tab, in the Cells group, click the arrow for Delete, 
and click Delete Table Columns. 

  
Now try adding another row of data to the table using a different method. 

22. Enter the following values: 
A18 January 2017 
B18 7000 
C18 4000 
D18 20 
E18 200 

23. Ensure that cell F17 is not the active cell, then position the cursor at the bottom right corner of cell F17 
so that the cursor changes to a . 

24. Click and drag the resize handle down to row 18. 

Hint: If the Total row is not activated for this table, the new row would have been automatically added to 
the table. 
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 Because you had added the new data below the Total Row, Excel did not know if you intended to keep 
that data separate from the table. Therefore, you had to manually expand the table to include the January 
row.  

Convert the table back to a regular range of cells.  

25.  Ensure that the active cell is anywhere within the table, then under Table Tools, on the Design tab, in the 
Tools group, click Convert to Range. 

26. Click Yes. 

 The worksheet does not appear any different, except that the Table Tools Design tab no longer appears 
and the column titles no longer display the filter buttons.  

27. Click the drop-down button on the right side of the Name Box to display the list of any range names in 
the worksheet. 

 This indicates that the Convert to Range tool simply converts the data to a set of rows and columns with 
data. If you want to create range names, you must add them manually.  

28. Click on any cell in the worksheet to close the Name Box list. 

29. Save and close the workbook. 

Finalizing the Print Output 
Whenever you are ready to print a workbook, always take a moment to review it one last time, to ensure your 
data is correct and that the workbook does not contain spelling errors.  As you prepare for printing you may 
find that you need to change the orientation, scale the output, or adjust the margins or column widths to 
make the best use of the space on your pages. 

Printing the Worksheet 
To print a worksheet, click the File tab, and click Print. 

Excel displays both the print options and a preview of the worksheet with the existing print options applied. 
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The total number of pages in the printout displays at the bottom left of the preview. If the number of pages 
exceeds or falls short of what you expected, you may need to revisit and/or change the page setup before 
printing. 

A chart in the worksheet previews or prints based on where it is positioned in the worksheet. You can move 
the chart to a new worksheet, or insert a page break between the data and the chart. If you are using a 
monochrome printer, the chart will print in varying shades of gray; it will print in color only if you have a color 
printer. 

Once you have previewed the worksheet on the screen and made sure it is ready to print, you can select the 
Print command. 

By default, Excel prints only the current active worksheet in the workbook. You can also specify to print all 
worksheets in the workbook, a selected group of worksheets, or only a selected range of cells. 

Exercise 10-8: Stock Prices 
In this exercise you will preview a worksheet and take appropriate action to produce the best result when 
printing. 

1. Open the Stock Prices file. 

The file has the data in the first two columns but the rest of the file is a chart. 

2. To determine how the worksheet would print, click File and then click Print. 

 Because the chart is cut off at the right side, you need to change the layout of the report. 

3. Click the Normal Margins option and change this to Narrow Margins. 

4. Click the Portrait Orientation option and click Landscape Orientation. 

5. Click No Scaling and then click Fit Sheet on One Page. 

6. If you are connected to a printer, print the report. Otherwise, click the Back button to return to the 
worksheet. 

7. Save, then close the workbook. 

Lesson Summary 
This lesson taught you to how to use a spreadsheet application to create simple reports such as budgets, or cash 
flows. You should now be able to: 

 understand basic terminology or concepts for 
spreadsheets 

 create a new blank worksheet or use a template to 
create a new worksheet 

 enter or edit data in a worksheet 

 open, close or save workbooks 

 select cells for a variety of purposes 

 copy and move data 

 change the column width or row height 

 create simple formulas and use common built-in 
functions  

 format the data in a worksheet to enhance it 

 work with charts 

 sort or filter information in a worksheet 

 work with tables 

 preview and print a report 
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Review Questions 
1. What is the difference between a workbook and a worksheet? 

a. A workbook is the actual file that contains the worksheets, which turn contain the data. 
b. The worksheets contain the data and the workbook contains the tabs for each data type. 
c. A workbook is a section that contains the worksheet reports; both are contained in a spreadsheet. 
d. There is no difference other than which term you prefer to use for spreadsheets. 

2. Which new workbook option displays the title, Book1, when it is created? 
a. A blank workbook. 
b. A workbook created from a template. 

3. Why would you enter labels into the worksheet? 
a. Labels should be used when you need to enter text only. 
b. Labels are entered for report titles or column headings only. 
c. Labels identify the values and help outline the mathematical relationships. 
d. Labels identify where and how the values should appear. 

4. Which key can you press to activate the Go To command? 
a. F1 c. CTRL+H 
b. CTRL+G d. F6 

5. To select an entire row, where would you click? 
a. The cell in column A for that row. 
b. Click the row header for the row you want to select. 
c. Click the column header where your cell is in the row you want to select. 
d. Click the row number in the Name Box and press ENTER. 

6. What displays when you activate the Cut or Copy command? 
a. A dialog box appears prompting you to proceed with the command. 
b. A new worksheet appears for you to paste the cut or copied item. 
c. The selected cells for the Cut or Copy command appear in a different color. 
d. A marquee appears around the selected cells for the Cut or Copy command. 

7. Which is the best way to set a column to a specific width? 
a. On the Home tab, in the Cells group, click Format, click Column Width and enter the measurement. 
b. Press CTRL+W to specify the width for the column. 
c. Double-click the heading for the column to be adjusted. 
d. Press F5 and then enter the column width. 
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8. When you insert a row, where does Excel place it in relation to the cursor position? 
a. Above the current row. 
b. Below the current row. 
c. You must select the row before you can insert a new row. 

d. You must copy and paste any existing data down one row to have a blank row at the cursor 
position. 

9. Which character automatically indicates the contents of a cell are a formula? 
a. $  c. = 
b. ‘  d. “ 

10. How can data be aligned within a cell? 
a. Horizontally 
b. Vertically 
c. Horizontal and Vertical 
d. Horizontally, vertically, or rotated 

11. Why might you want to apply borders to a cell instead of just using the gridlines on the worksheet? 
a. Borders can help to separate and identify specific cells. 
b. You can highlight a row by clicking one button for outside borders. 
c. To emphasize specific cells in the gridline. 
d. To mark the print area of the worksheet. 

12. Why might you prefer to apply a background color to a cell instead of applying a pattern? 
a. There is a limited number of patterns to choose. 
b. Patterns can make it harder to read the data than using a solid color. 
c. You can choose a lighter color whereas all patterns are dark in design. 
d. Patterns should only be used with cells that have formulas. 

13. What do you notice about the chart in the following? 

  
a. Revenues are higher every month than expenses. 
b. Expenses are higher every month than revenues. 
c. Expenses appear to increase in the first three months. 
d. Revenue is higher during the last six months of the year. 
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14. What has to happen in order for column headings to display in the Sort fields? 
a. Column headers must be in row 1. 
b. Turn on the My data has headers option. 
c. The data has to start on row 1. 
d. Must copy the column headers into the Sort dialog box. 

15. Why might you choose to filter a list or table instead of simply sorting it? 
a. Filtering displays only those records that match the criteria you specify; other records are 

temporarily hidden. 
b. You can then copy out the matched data and paste into another spreadsheet. 
c. You can also manipulate the filtered data without affecting the rest of database. 
d. You have a large amount of data you need to separate into various categories. 

16. What does it mean that the data in a table must be contiguous? 
a. There must be a blank line between the column headers and the first row of data. 
b. There must be no blank rows or columns in the range of cells for the table. 
c. You must have existing data in the range of cells you set up for the table. 
d. The table cannot be longer than 100 rows at a time. 
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Key Applications 
 
 

Lesson 11: Database Concepts 
Lesson Objectives 
In this lesson, you will learn basic database concepts and learn how databases are used on the World Wide Web. 
Upon completion of this lesson, you should be able to: 

 describe the nature of data 

 understand the purpose and function of 
relational databases 

 describe database elements 

 understand database relationships 

 understand how to read a database schema 

 describe the uses of databases on the web 

What is Data? 
Objective 2-4.1 

Data are pieces of information. Data can be measured, collected, analyzed and reported.  

Data can exist in many forms – as a phone number scribbled on a scrap of paper, as a course listing in a 
catalog, or a list of test scores on a grade report.  

Data is distinct from the container in which it is stored. Data can be stored on a flash drive, or in a book, or 
in remote storage location on Google Drive. Data can also be stored in a spreadsheet or a database. But 
these containers are not data; their contents are data. 

What is a Database? 
Although many people become uncomfortable at the thought of working with a database, a database is really 
nothing more than an organized collection of information. The basic function of a database is to store data. 
If the database is well organized, retrieving the data you want is easy, and you can then generate reports, or 
lists, and analyze the data in ways that are meaningful. 

Spreadsheet Databases 
You can create simple databases in Excel: a database in Excel is a single table that cannot include any blank 
rows or columns. This type of database is sufficient for storing relatively small amounts of simple data; but 
even though you can perform complex calculations on the data in an Excel table, a single table cannot 
represent or handle complex data relationships.  
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Relational Database Management Systems (RDBMS) 
A database application, on the other hand, is designed to handle complex relationships between various 
items of data, and is correctly referred to as a relational database management system (RDBMS).   

Many relational database applications are available on the market. Oracle, SQL Server, MySQL, PostgreSQL, 
Sybase, IBM DB2, and Microsoft Access are just a few. These programs offer various features and interfaces, 
but all of them access stored data in a standard manner – through Structured Query Language (SQL). 

Structured Query Language (SQL) 
Structured Query Language (SQL) is the standard language used to create and work with databases. Once a 
database has been created, SQL is also used to retrieve and manipulate the data. Any interaction among a 
user, program and database takes place through the use of SQL.  

Even though various RDBMS applications provide their own user interface, SQL is used (often behind the 
scenes) to create and manage both the database elements themselves and their data.  

Connectivity Standards and APIs 
Generally speaking, a database is not portable from one RDBMS to another, but different RDBMS can inter-
operate using one of the following application programming interface standards: 

• Open Database Connectivity (ODBC) – a standard programming interface for accessing a number of 
different databases, including Access, DB2, SQL Server, and MySQL. 

• Java Database Connectivity (JDBC) – a standard programming interface for accessing Oracle 
databases, which run on the Java platform. 

An application programming interface (API) is a set of programming building blocks that specify how software 
components should interact. There are APIs for operating systems, applications, and web sites.  

These interfaces make it possible to connect databases to web pages. Web designers can then use server-
side programming languages to build web pages on the fly based on current database content. (You will 
learn more about this shortly.) 

Multiple, Related Tables 
Unlike spreadsheet databases which store all the information in a single table, relational databases store data 
in multiple tables which are related to one another.  

Let’s consider a database that tracks activities for a gardening supply company. There might be a table that 
contains customer information, a table that contains order information, a table that contains detail 
information for each order and a table that contains product information.  

Because the data stored in each table is related to data in the other tables of the database, a complete set of 
information can be retrieved. For example, you could retrieve the complete information for a particular order, 
as shown in the following figure. 
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This complete set of information is extracted from the Customers, Orders, OrderItems and InventoryItems 
tables, as shown in the following figure: 

 
The shaded rows in the figure show that Order #1 was placed by Helen Anderson (Customer #1012) on 
2/19/2015. The order includes three line items: one for a garden hose (item #5), one for some rosemary seed 
(item #17) and one for fieldstones for a garden path (item #40). 

Note that each table in the database stores data about a specific type of thing. For example, the Customers 
table stores information only about customers; it does not include information about orders or inventory. In 
database terms, the specific type of thing for which data is stored is called an entity. Usually, there is a table 
for each entity represented in the database. 
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Database Tables 
Objective 2-4.3, 2-4.4 

In a database, data is stored in tables. 

The data in a table is organized into a series of rows and columns. The following figure shows a portion of a 
typical Access database table containing product information for items sold by a garden supply shop. 

 
In a database: 

• Each row in a table can be referred to as a row or a record. In the table shown in the preceding figure, 
each record contains information about a different products sold by a garden supply shop.  

• Each column in a table can be referred to as a column,  a field, or an attribute. Each field contains a 
different type of information, such as item number, description, unit price and so on for each product.  

Table Metadata 
In a spreadsheet, you can create a table simply by opening a blank workbook and typing. In fact, you can 
enter any type of text or value into any cell at will. A database table, however, is a different animal. 

The structure of a database table must be explicitly defined before you can enter any data. A table’s structural 
definition includes items such as: 

• The name of the table – each table within a database must have a unique name 

• The name of each field (column) in the table 

• The data type of each field (column)  

– The data type determines what type of data the field can contain. Each field can contain only one 
type of data. If the field is designed to accept text data, only text can be added to the field. If you 
enter a number into a text field, that number is treated as text (which means that you cannot perform 
any calculations on such numbers.) If you define a field to accept numeric data, you cannot enter 
text into that field. 

  

Field 
Record 
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• The size of each field (column) 

– The size determines the range of numeric or date values that can be entered, or determines the 
maximum number of characters that can be entered in a text field. 

The following figure show two views of the same table in Microsoft Access – the left portion shows the 
defined structure of the table, and the right portion shows the data stored in the defined table structure. 

 
 

Without this clearly defined structure, the data itself is simply a collection of items presented out of context 
and without relation to other things. A database table’s defined structure helps the user to make sense out 
of the data, and to understand what the data is.  

Because the defined structure of the database table describes the data it holds, the structure is considered 
metadata. Metadata is simply data that describes other data.  

Note: You may have worked with metadata before. Computer files have metadata associated with them in 
the form of file properties, which you can use to locate a specific document, or a particular image, or a 
specific version of a program. If you have ever viewed a file’s properties in Windows, or added tags to an 
image on a social media site, you have worked with metadata.  

Table metadata (that is, table structure) can be represented by a simple layout called a 
table schema, which lists the name of the table and the names of each field in the table. 
Database designers create table schemas while they are planning a database.  

Once tables are created, many database products can render table 
schemas to give the database designer an overview of the tables in 
the database. The following schema is generated in Microsoft Access.  
 
 

Primary Key 
A primary key is a field (or a combination of fields) that uniquely identifies each record stored in a table. No 
two records in a table may be exact duplicates; however, two records may have identical data, other than the 
primary key. 

The primary key, therefore, must be unique and it cannot contain a null value. In a database, null is equivalent 
to "unknown." Null is not the same thing as zero (0). 
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Assigning a primary key prevents the entry of any record that contains duplicate or null values in the primary 
key field. When you add a record to a table for which a primary key has been assigned, the RDBMS checks 
to make sure you have included a value in the primary key field and that the value you entered does not 
already exist in the primary key field of any other record in the table. When you sketch a table schema, you 
can indicate the primary key by adding the notation “(PK)” to the right of the field name or by underlining 
the primary key field. Microsoft Access uses a key icon to the left of the field name to denote a primary key. 

Note: A primary key that is comprised of a combination of fields is called a composite key. 

The following figure shows schemas for two tables. The Products table has a single field primary key (the 
ItemID field), and the OrderItems table has a composite primary key (the OrderID field + the LineItem field).  

  

Selecting a Primary Key 
Selecting a primary key can be a challenge. Many times a simple numerical value that increments 
automatically (for example, an "ID" field) is added to a table to serve as the primary key. However, sometimes 
a table already includes a field that is a natural choice for use as a primary key. For example, in a table that 
tracked book sales, an ISBN field would be a good choice. 

A primary key should: 

• be a value that will never change 

• be a value that is extremely unlikely to be null 

Good choices for primary keys include unique identifiers issued by an organization (such as an Employee ID 
number or a Student ID number), or an ID field. 

Poor choices for primary keys include people's names (as these are likely to be duplicated, and they 
sometimes change), and Social Security numbers (not everyone has one, and businesses do not like to store 
them because of the potential liability if they are lost or stolen). 

Consider the table shown in the following figure: 

 
Notice that there are two entries for a person named Dennis Henderson. If you looked only at the Fname 
and Lname fields, the records appear to be duplicates. However, if you look at these fields and the Address 
field, you can see that the records are not duplicates. It would be possible to use the combination 
Fname+Lname+Address as a composite primary key.  
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It would also be possible to use the ZIP field as a primary key because right now each entry for a ZIP code is 
unique. 

Neither of these is really a good solution. If we used the ZIP field as a primary key, we would be unable to 
add a record for another person living in the same ZIP code as any person already listed in the table. Using 
the combination Fname+Lname+Address field is not a good solution either because people move, and the 
primary key for a person who relocates would change. 

A better solution for this table would be to add an ID field, as shown in the following figure: 

 
When you use an ID field as a primary key, you can manually enter the ID number, or you can elect to have 
the RDBMS create ID numbers automatically. In Microsoft Access you can create ID numbers automatically 
by setting the ID field’s data type property to AutoNumber. A field with an AutoNumber data type is 
automatically updated with a unique sequential number whenever a record is added to the table. The value 
in an AutoNumber field cannot be deleted or changed. 

Exercise 11-1: Selecting a Key 
In this exercise, you will examine table schemas and select an appropriate primary key for each table. 

1. What would be a good primary key for the Students table? _______________________________ 

 
2. What would be a good primary key for the Movies table?  _______________________________ 
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Table Relationships – Foreign Keys 
The data in a relational database is stored in multiple tables, so naturally, there needs to be a way to bring 
the data from those separate tables together in a meaningful way. This is accomplished through the defining 
of table relationships. 

Table relationships are defined through the creation and association of foreign keys. A foreign key is a column 
(or combination of columns) in a table that references the primary key in another table. For example, consider 
the simple scenario of customers and orders. Suppose we have a Customers table, and an Orders table as 
shown in the following figure: 

 

A one-to-many relationship exists naturally between customers and orders. One 
customer may place zero, one, or many orders; but an order can be placed by only 
one customer. 

The way the tables are configured right now, there is no way to keep track of which 
customer places an order. We want to be able to trace an order back to the 
customer who placed it. 

 

The best way to keep track of which customer places an 
order is to create a field that is common in both tables.  

In the Orders table, this common field will become a foreign 
key when we create a relationship between the tables.  

 

Here we see a revised design of the Orders table: it now includes a field named 
CustomerID. This is the common field – it exists in both tables. 

In the Customers table, the CustomerID field is the primary key (denoted by (PK) in 
the diagram. In the Orders table, the CustomerID field will become the foreign key 
when a relationship is created between the two tables. The foreign key is denoted 
by (fk) in the diagram.  

 

 

Once the common field is added to the Orders table, you can create a relationship 
between the two tables.  

In Access, you can open a special window called the Relationships window and 
drag the primary key field from the Customers table onto the common field in 
the Orders table and Access will create the relationship. 

Behind the scenes, SQL adds a constraint that will not allow you to add a record 
to the Orders table if the value in the foreign key field does not match a value in 
the primary key field of a record in the Customers table.   

It is as this point that 
the CustomerID field  
in the Orders table 
becomes a foreign 
key. 

That is, when you create a record for a new order, the 
value that you enter in the CustomerID field in the Orders 
table must reference a record that already exists in the 
Customers table. 

You cannot create an order for a customer who does not 
exist. 
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The following figure shows the data in the Customers table and the Orders table. In the Customers table, the 
CustomerID field is the primary key and it uniquely identifies each customer; however, in the Orders table, 
the CustomerID field is a foreign key and is used to refer to a specific customer in the Customers table. Note 
that the primary key to which a foreign key maps is also known as a parent key. 

 

The line drawn between the two tables represents the relationship between the two tables. Note that the line 
is drawn connecting the common fields. Often, the common fields have the same field name, but that is not 
a requirement. However, common fields must have the same data type. 

When you create relationships between tables, you can view and work with data stored in multiple tables. 
For example, you can view customer and order information contained in two different tables to see which 
customer placed a particular order. The related tables shown in the figure indicate that in order 1, customer 
number 1012, Helen Anderson, placed an order on February 19th. 

Relationship Types 
There are three types of relationships that can be established between tables: 

One-to-One A relationship in which each record in Table A can have only one matching record in Table 
B, and vice versa. This type of relationship is not very common. 

One-to-Many A relationship in which a record in Table A can have many matching records in Table B, 
but a record in Table B has only one matching record in Table A. The relationship is 
established between the primary key in Table A and the foreign key in Table B. 

Many-to-Many A relationship in which one record in Table A or Table B can be related to many matching 
records in the other table. For example, suppose a database contains data about students 
and classes. Each student can be enrolled in several classes, and each class can have many 
students. This is a many-to-many relationship. Relational databases cannot directly 
handle many-to-many relationships, and these must be replaced by multiple one-to-
many relationships. 

Primary Key 
(parent key) 

Foreign Key (child 
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Database Metadata (Database Schema) 
Earlier, you examined table metadata. However, there is also metadata for the entire database – the database 
schema.  

The database schema represents a logical view of the entire database. It defines how the data is organized 
and how the tables within the database are related to one another.  

You can represent relationships in a database schema by drawing lines between the key fields in the related 
tables. The primary key of each table should be denoted either by an underlined field name or a 
representative icon. 

You represent the “one” side of a one-to-many relationship by drawing a 1 beside the parent key, and you 
represent the “many” side of a one-to-many relationship by drawing an infinity symbol (∞) beside the foreign 
key. 

The following figure shows a schema (generated in Microsoft Access) for a database with four tables. 

 
The database schema in the preceding figure describes the following relationships: 

• There is a one-to-many relationship between the Publishers table and the Books table (based on the 
PublisherID field). 

• There is a one-to-many relationship between the Books table and the AuthorBooks table (based on the 
BookID field). 

• There is a one-to-many relationship between the Authors table and the AuthorBooks table (based on 
the AuthorID field). 

Notice that the AuthorBooks table is related to both the Books table and the Authors table. These two one-
to-many relationships support the many-to-many relationship between books and authors: one author can 
write many books, and a book can have many (that is, more than one) authors.  
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Exercise 11-2: Reading Schemas 
In this exercise, you will examine a database schema and answer a series of questions about the database it 
describes. 

Consider the following database schema: 

 
1. What type of relationship exists between the Customers table and the Orders table? 

 ____________________________________ 

2. What type of relationship exists between the Orders table and the Products table? 

 ____________________________________ 

3. What is the foreign key in the Products table?   

 ____________________________________ 

4. Which table has a composite primary key?  

 ____________________________________ 

5. What are the two foreign keys in the Orders table? _________________________ and _________________________ 

Database Queries 
Objective 2-4.3 

You use queries to view specific data in one or more database tables. A query asks a question of a table, such 
as “Which customers live in Arizona?” and selects records from the table which answer the question. The 
selected records are displayed in a result set.  
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Queries work by checking table fields for entries that meet the criteria that you specify. Criteria can be strings 
of text, dates, or a number or range of numbers that you enter. The query examines each record in the table 
to determine if particular values in the record match the query criteria. If a record meets the criteria, then it 
is displayed in the result set.  

The result set or dynaset (dynamic subset) is not a static snapshot of records, but a dynamic changing subset 
of records. As changes are made to a table, the results of a query will change accordingly to reflect the current 
content of that table. For example, suppose you ran a query on a table containing 100 records, generating 
results with 30 records. If you then added another 20 records to that table and then ran the query again, the 
results will also include any of the newly added records that meet the selection criteria specified in that query. 
If only two records of the additional 20 met the criteria, then the query would generate 32 records, even 
though the same query generated only 30 records a few minutes ago. 

If you are working in a database, you can use a query to answer a simple question; view only specific table 
fields; perform calculations; combine data from different tables; or to add, change or delete table data.  

Database Forms 
Objective 2-4.3 

Forms are tools that aid data entry and help users understand what they need to do. They are user-friendly 
interfaces designed to help users enter specific data without becoming distracted or confused by other data 
that may be stored in a table. You can think of a form as a window into the data. Instead of allowing (or 
forcing) users to view all the fields in a table, a form displays just the data that is necessary for performing a 
given task.  

  

Query:  Which customers live in Arizona? 

Table 

Query Result Set 
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Consider the following figures: 

• The first shows a data entry form created in Access. A user can enter data about an order using the form.  

• Transparent to the user, the data entered through the form is added to four database tables, which are 
shown in the second figure. 
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Where Are Databases Used? 
Objective 2-4.2 

After this little whirlwind tour, you may have already decided that you have had your fill of databases. They 
can seem cumbersome and confusing especially at first, and you may think you will never have a reason to 
use a database.  

However, chances are good that you interact with databases all the time and don’t even know it. 

In short, databases are used almost everywhere you look – medical records, flight reservations, legal 
pleadings, online orders, Pinterest, Twitter, Facebook and WordPress posts – are all stored in databases.  

Databases and Web Sites 
The Web is replete with databases because databases are extremely flexible and scalable – they can store 
millions and millions of records, and they can present data in almost any format you want or need.  

Online stores (think of Amazon!) display thousands and thousands of items and allow you to sort and filter 
the items on the page by price, or vendor, or size or color – the options are almost endless. All the data that 
populates that page of choices is stored in a database.  

But you never have to see the database itself. Why? Because it is an easy thing for a web designer to design 
a web page that connects to that database on the back end, where the web site visitor never sees it. Visitors 
simply enjoy a “normal” web experience, while interacting with databases all the while. 

Static and Dynamic Web Pages 
There are two basic types of web pages: 

• Static – these types of pages display content that does not change (unless the web page developer edits 
what is on the page). These are the “normal” web pages you build with HTML or XHTML. Anytime you 
visit a static web page, your computer sends a request to the server, and the server sends the web page 
to you over the Internet. The page is stored on the web server and served in the same condition every 
time a request is received, until the web developer edits it. 

• Dynamic – these pages change every time they are loaded in the browser window. They change their 
content based on user actions. For example, if you are viewing digital cameras on the Best Buy web site, 
and you apply a filter because you want to see only GoPro cameras, the page is automatically rebuilt (re-
generated) and resent to your browser. Often these pages are built using languages such as Active Server 
Pages, Java Server Pages, CGI, or Perl. 

Database Driven Web Pages 
Many dynamic web pages are database driven; the web page is connected to a database through 
programming, and it pulls information from the database and inserts that information into the web page 
each time the page is loaded. 

As information stored in the database changes, the web page connected to the database also changes 
(automatically) to reflect the new data.  

Banking web sites use database driven pages. You log in and view your account, and the web page connects 
to a database where all your account information is stored. The page always shows the most current 
information because it is connected to the data.  
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Consider the following image of a web site page featuring Martin guitars. 

 
As you scroll through and click options on the left side of the page you are specifying certain criteria 
conditions that you want the guitars to meet. For example, you may want to see only those guitars which fall 
into a certain price range.  

Each time you click a button or check a box on the left side of the page, your browser sends that information 
to the web server (along with a request for an updated web page). The server generates a new page (showing 
only the guitars you want to see) and sends it back to your browser. 

Have I Used Queries on the Web?  
It is likely that you use queries all the time while you are on the World Wide Web. Have you searched for a 
particular item in an online store? Have you searched to see if a particular check has cleared your account in 
your online banking web site? Have you searched for credit card charges in an online account? 
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Any time you click in a web site search box and specify an item to look for, you are specifying criteria for a 
query that is executed on a database. Any time you specify that you want to see a list of credit card purchases 
that were made during a specific time frame, you are specifying criteria for a database query.  

The results that you see on the web page are the results of the query. 

 

Have I Used Forms on the Web?  
You probably already guessed the answer – any time you set up a profile for an account, enter an email 
address for a newsletter, or enter payment information for an online purchase, you have likely used a web 
form which is linked to a database.  

 
Fields on the form are tied to fields in a table in a database on the back end. 
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Lesson Summary 
In this lesson, you learned basic database concepts and learned how databases are used on the World Wide Web. 
You should now be able to: 

 describe the nature of data 

 understand the purpose and function of 
relational databases 

 describe database elements 

 understand database relationships 

 understand how to read a database schema 

 describe the uses of databases on the web 

Review Questions 
1. Each table in a database must have:  

a. an ID field. 
b. at least one record. 
c. a unique name. 
d. at least five fields. 

2. A primary key: 
a. should be a value that is unlikely to change. 
b. should use Social Security numbers whenever possible. 
c. should be null whenever possible. 
d. cannot be a composite key. 

3. For a relationship between fields in two tables to be created, the fields must: 
a. have the same name. 
b. be stored in separate databases. 
c. have the same data type. 
d. have a numeric data type. 

4. Which of the following is an example of data? 
a. a spreadsheet. 
b. a serial number. 
c. a Sears catalog. 
d. OneDrive 

5. Which of the following guarantees record uniqueness? 
a. a primary key. 
b. a query. 
c. a database schema. 
d. a foreign key. 
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6. Which of the following makes it possible to connect a database to a web page? 
a. application programming interfaces (APIs). 
b. structured query language (SQL). 
c. hypertext markup language (HTML). 
d. foreign keys. 

7. Which of the following can be used to capture user information online? 
a. a database query. 
b. a web form. 
c. a foreign key. 
d. a many-to-many relationship. 
 



 

7500-1 v1.00 © CCI Learning Solutions Inc.  371 

Key Applications 
 
 

Lesson 12:  
Using Microsoft PowerPoint 
Lesson Objectives 
This lesson introduces you to how to use an application to create simple presentations, including adding slides, 
images, and adding effects such as animation. Upon completion of this lesson, you should be able to: 

 plan and design a presentation 

 create, save, close, open, and switch between 
presentation files 

 move around in a presentation 

 change view displays  

 insert, modify or delete slides 

 change the layout or order of slides 

 manipulate text or objects on slides 

 insert pictures or multimedia objects on slides 

 animate objects on the slides 

 apply transitions to slides 

 share presentations with others 

 publish slides 

What is PowerPoint? 
Objective 2-5.7 

PowerPoint is an application program that you can use to create, edit, and manipulate slides for on-screen 
presentations, send via email, or to promote products or services on a web page. These presentations can be 
delivered to live audiences, or viewed individually (self-directed) by others at their convenience. 

You can enter text, draw objects, create charts, or add graphics. You can choose to deliver a presentation to 
a live audience, or broadcast or share it over the Internet. 

What Does a Presentation Include?  
PowerPoint is used to build a presentation slide by slide. Those slides, shown in order, make up your 
presentation. Different slide types serve different functions. 

 
 

Title Slide 
The opening slide that introduces the subject of the presentation; it usually includes the title 
or topic, and a subtitle. The subtitle might be the presenter’s name or the presenting 
organization’s name, or it might be the date and location of the presentation. 

  

Title Slide 
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Agenda Slide 
This slide usually lists the titles of all the slides in your presentation; it is often the second 
slide and provides an overview of what will be covered, and can help the viewer grasp the 
flow of the presentation.  

 

 
 

Title and Content Slide 
The most frequently used layout that controls which placeholders appear on a slide. A title 
and content slide is commonly referred to as a bulleted-list slide because it includes a title 
and a bulleted list of the key points the speaker wants to discuss. Bullet points should be 
brief, concise, and clear. 

Support Content Slides 
Add various kinds of content to your presentation using different content layouts. Content 
can include text, design elements, diagrams, videos, tables, charts, sounds, animation, or 
special transitions from slide to slide. 

Summary Slide 
This is the last slide in the presentation and reviews your presentation, reinforces the key 
messages, and provides contact information for further details. 

Looking at the Edit Screen 
As with all Office applications, once you start PowerPoint, you see the Backstage view where you can create 
a new blank presentation, use a pre-designed template to create the new presentation, or open an existing 
presentation. A new blank presentation is shown in the following figure. 

 
Slide Thumbnails – Refer to the thumbnail or miniature of the slide in this area to quickly view the contents 
of slides or the flow of the slides in a presentation. You can also use this view to move quickly to a particular 
slide. 

Placeholder – Use these boxes on the slides for hints on the type of content you can insert onto the slide. 

Agenda Slide 

Slide 1 

Slide 
Thumbnails 

Split 
Bar 

Notes Pane 

Placeholder 

Slide 
Pane 

Summary 
Slide 

Slide 3 

Slide 2 
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Slide Pane – Use for entering or viewing the contents of the slide.  

Split Bar – Drag to increase or decrease the size of the Outline or Slides tab, or to increase or decrease the 
size of the Slide pane. 

Notes Pane – Type presentation notes such as speaker notes, reminders of actions, and so on here. These 
notes are for the presenter’s use and are not visible to the audience. 

You can show or hide this pane by clicking the  button on the status bar. 

Understanding Basic Terminology 
Each slide includes placeholders—a dashed-line box with a tip that tells you what you can use the box for. 
The blank slide layout, however, does not include placeholders. 

 
• You can click inside a placeholder to insert text or an object.  

• When you see a placeholder with various icons, point at an icon in the box to display a screen tip 
indicating the type of object to insert; click that icon to insert it on the slide. 

  
• To move from one placeholder to another on a slide to enter items, click in the placeholder or press 

CTRL+ENTER. 

Working with Presentations 
Objective 2-5.1, 2-5.3, 2-5.5, 2-5.6 

When PowerPoint starts, it opens in Backstage where you can choose to create a new presentation or open 
an existing presentation. 

Creating Presentations 
There are three common methods to create a presentation in PowerPoint: 

Blank Presentation – Provides a blank presentation with only a title slide (no colors or design elements).  
Add your own content and apply your own colors, backgrounds, images, and so on. 
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Templates – Use a pre-designed presentation with suggestions for text and application of colors, 
backgrounds, images, and so on. You can type the text and make design changes. 

Reuse Slides – Insert one or more slides from an existing presentation to the current presentation. You can 
also specify whether inserted slides retain their original formatting or use the formatting in the current 
presentation. 

To create a new blank presentation, click the File tab, click New, and then Blank Presentation. 

Key Fact: You can also press CTRL+N to create a new blank presentation. Use this keyboard shortcut to 
create a new blank document type in any Office application. 

To create a new presentation using a template, click the File tab, click New. 

 
You can click a template, enter criteria in the Search field, or use the categories to narrow the search to a 
specific type of presentation you would like to create. Each template, with the exception of Blank 
Presentation, has a set of pre-designed colors and styles drawn from commonly used elements in 
presentations. Some templates may also include slides with text as a guide to the type of information you 
might want to include. 

Before creating your presentation:  

• Plan your presentation in draft form. This can save you time and keep you on track. 

• Keep the text consistent in format and layout – too many variations can be distracting. Remember that 
text is generally read from left to right, top to bottom. 

• Keep the number of colors used to a minimum. Too many colors on one slide can be distracting and 
detract from the message. 

• Use contrast to emphasize a message, such as dark text on a light background. 

• Keep the number of bullet points per slide to a minimum; the standard maximum is six points per slide. 
Make your points brief as you want the audience to pay attention to what you’re saying, not what you’re 
displaying. 
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• Be consistent with special effects. 

• For graphs or charts, keep the information to a minimum or split the information onto several slides. 
Remember the rule: “If it takes you a long time to create the slide, it will take just as long for the audience 
to read and understand it.” 

• Add pictures or tables only when relevant or for emphasis. Too much information can be distracting and 
cause confusion. 

• Ensure that the presentation clearly identifies you to the audience. 

The appearance and delivery of the presentation can determine how successful you are in reaching and 
influencing your audience. 

Entering Text on a Slide  
Use the Slide pane to insert or modify items on slides. Placeholders clearly appear on the slides, and serve as 
a guide concerning where to enter text. You can add formatting to existing items on the slide, or simply add 
another item for the slide. 

Note that the Slide pane and the Slide Thumbnails pane are two different areas with different purposes. 

The Slide Thumbnails pane displays miniatures (also known as thumbnails) of your slides so you can see how 
the information flows or appears in different areas of the presentation. You cannot make changes directly to 
the slide in this view as this is an “instant preview” of the contents in the presentation only. 

The Slide pane is the default view for working with slide contents. 

Use the split bar between the Slide Thumbnails pane and Slide pane to show more or less of each pane. For 
example, to display more of the Slide pane, drag the split bar to the left to shrink the size of each slide 
thumbnail.  

 

Saving a Presentation 
It is important to save your presentations as you work to prevent having to recreate a presentation file in the 
case of a power or computer failure.  

To save a new presentation or to save changes to an existing presentation, click the File tab and then click 
Save. 

Slide Thumbnails Pane 

Vertical Split Bar 

Slide Pane 
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Key Fact: You can also, click the  (Save) button on the Quick Access toolbar, or press CTRL+S to quickly 
save a presentation. These methods can be used in any Office application. 

The first time you save a presentation, you will see the Save As tab of the Backstage view. PowerPoint displays 
the default folder (such as Documents), or a folder designated by your school or organization. 

 
Select a location in the left pane (we use This PC in the previous screen), and click to navigate to the specific 
folder as required. Once the path has been selected, click in the File name field and type the name of the 
presentation file. By default, PowerPoint saves all presentation files with the .pptx file format. 

To save an existing file with a different name, click the File tab and then Save As. 

If you need to save the file in another format, click the arrow for the Save as type field to select the appropriate 
file type:  

This option is very useful when you need to consider which file 
format may be compatible for other users who need to share this 
presentation. For instance, you may need to save the 
presentation in a file format for a previous version of PowerPoint, 
or you want to send the presentation in a PDF file format so no 
one can make changes directly to the presentation file. 

Closing a Presentation 
Once you have finished working with a presentation, save and 
close it to clear the screen. To close a presentation, click the File 
tab and then click Close. 

Key Fact: You can also press CTRL+W or CTRL+F4, or click the 
 Close button for the application. You can use these 

methods in any Office application. 

Up One Current 
Level Folder 

File name 

Save as type 

Drives or locations to 
store files and folders 

Folders or files Date created 
In current folder or modified 



Using Microsoft PowerPoint Lesson 12 
 

 

7500-1 v1.00 © CCI Learning Solutions Inc.  377 

Opening a Presentation 
You can open a presentation file using one of the following methods: 

• Click the File tab, click Open, and if the file is one you recently worked on, click the file from the list in 
the second pane that is organized by date; or 

• click the File tab, click Open, if the file is in another location than the default PowerPoint offers, click the 
arrow to navigate to the folder where the file is saved, select the file and then click Open. 

Hint: Whenever you click the displayed path above the list of files, the Open dialog box will open. 

Key Fact: You can also press CTRL+O to display the list of recent files, or to navigate to the location of the 
required file. This can be done in all Office programs. 

If the file was saved in a file format other than the default PowerPoint Presentation 
(.pptx) format, click the path to display the Open dialog box, and then click the All 
PowerPoint Presentations button to display the file formats available. 

If you open a file that was saved from an attachment in an email, Protected View 
will display an information bar requesting you to enable editing in the file before 
you can make changes to it (see below). The Protected View feature protects you 
from the possibility of opening a file that may contain a virus; always save and scan any attachments you 
receive via email before opening the file in the application program.  

 
Alternatively you can apply this feature when opening a presentation to prevent accidental changes being 
made to the file. 

 

Displaying Information in the Presentation 
To change the view of the presentation, on the View tab, in the Presentation Views group, click one of the 
following options: 

 Normal – Displays the Slide Thumbnails, Slide and Notes panes. 

 Slide Sorter – Shows multiple miniature slides on one screen in a linear manner for rearranging or 
sorting. 

 Reading View – View in full screen to show the contents of each slide similar to how your audience 
will see them. 

 Slide Show – Runs the slide show for your review or for you to present to your audience. 
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To change the magnification for the presentation, use one of the following: 

• On the far right of the status bar, click the button on either side of the zoom slider bar to zoom in or out 
by 10% at a time; or 

  

• click the  (Zoom Level) button to select a specific size or zoom percentage; or 

  
• click the  (Fit slide to current window) button to quickly maximize the size of the slide on the 

screen from its previous zoom percentage. 

Exercise 12-1: Travel 
In this exercise you will create new presentations, open existing presentations, make changes and then save 
the changes. 

1. Start Microsoft PowerPoint, if necessary. Then click Blank Presentation to create a new blank 
presentation. 

2. In the Slide pane, click in the first placeholder and type: Travel has no age! and then press CTRL+ENTER 
to move to the sub-title placeholder. 

 The text you just entered should appear in the placeholder for the main title of the presentation. 

3. In the sub-title placeholder, type: Lucy Lee for the text, and then click anywhere away from the 
placeholder. 

You will now enter text for the next few slides. 

4. On the Home tab, in the Slides group, click New Slide to insert a new Title and Content slide. 

5. Type: Agenda as the title of this slide. Press CTRL+ENTER and type the points for the agenda, as shown in 
the following: 

  
6. Press ENTER after the last bullet point and then press TAB to tell PowerPoint you want to enter text at a 

sub-level for the last bullet point entered. 

7. Type: Advantages and disadvantages and press ENTER. 

 PowerPoint keeps you at the same level as this sub-text. 
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8. Type: Cost differences and press ENTER. 

9. Press SHIFT+TAB to move up one level so the text for the upcoming bullet point is at the main level. 

10. Type: Preparing for the Trip. 

11. On the Quick Access toolbar, click  (Save). Click This PC as the location, navigate to the student data 
files location and then click the PowerPoint folder. Click in the file name field, type: Travel has no age 
- Student (insert your initials or name in place of “Student”) and click Save. 

Now create a new presentation using a template provided in PowerPoint.  

12. Click the File tab and then click New. In the search field, type: certificates and press ENTER. 

13. Click the Certificate, Employee of the month (blue chain design) and then click Create. 

 If this template is not available, choose a certificate from the choices available on your system. It isn’t 
important which certificate you use; the focus here is seeing how PowerPoint provides some pre-
designed templates you can use to enter data as required. 

  
 You are now ready to save the file with a new name and make changes to the presentation. 

14. Press CTRL+S to save the presentation. Click This PC as the location and then click or navigate to the 
PowerPoint folder. Type: Green Soles Certificate - Student as the new name and then click Save. 

15. In the Slide pane, select the Raffaella Bonaldi text and type: Irma Greenwood. 

16. Select the date and type in today’s date. Save the certificate again. 

Now look at the various ways you can close a presentation. 

17. Press CTRL+N to create a new blank presentation. 

18. Point at the PowerPoint icon on the Windows taskbar. 

 You should have at least three preview windows, one for each open presentation (the number of windows 
may vary depending on how many presentations you have open or created during this exercise). 

19. In the window with the blank presentation created in step 17, click the Close button. 
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20. Press CTRL+W to close the next presentation. 

21. Click File and then click Close to close the last presentation (repeat this step if you have more 
presentations open). 

Now that the PowerPoint application window is empty, open some presentations.  

22. Click File, click Open, and then in the Recent Presentations list, click the Travel has no age - Student 
presentation. 

23. Press CTRL+O, click This PC, and click the Alaska Hiking Tours file to open it. 

 You should now have two presentations open. 

24. Click File, click Open, click This PC, click the path for the location of the student data files to display the 
Open dialog box. Click the Green Soles 2015 Getting There is Half the Fun file to select it, then click 
the arrow for Open and click Open in Protected View. 

 Notice how you can access this file to open it but it appears with the Protected View feature active. 

25. Point at the PowerPoint icon in the taskbar and click the  for the Travel has no age and the Green 
Soles presentations, leaving the Alaska Hiking Tours presentation open. 

Now try changing the view of the slides for a presentation. 

26. Ensure the Alaska Hiking Tours presentation is active on the screen. In the Slide Thumbnails pane, click 
Slide 4 to view the contents of this slide. 

27. Click the  (Slide Sorter) button from the far right of the status bar. 

  
Note: The number and size of slides that appear in this view will vary based on the size of your monitor.  

 Slide Sorter view can be advantageous when you want to view the entire presentation and assess the 
flow of information. Slide Sorter view is designed to allow you to quickly rearrange the slides by dragging 
them to a new location. To view the contents of a slide you may want to change, double-click the slide. 

28. Scroll in the view and then double-click Slide 11 to return to Normal view. 
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29. Use the  and  buttons to move from slide to slide. 

30. Close this presentation file by pressing CTRL+W. 

Managing the Slides 
Objective 2-5.7 

As you begin to work with a presentation, it will likely evolve. For example, you may need to insert new slides, 
copy a particular slide and paste it into a new location, delete or hide a slide, or reorganize slides for better 
flow. 

Inserting New Slides 
Every new presentation begins with a title slide and PowerPoint will automatically insert a Title and Content 
layout as the second slide. You can change the layout of this slide as required. 

You can insert a new slide into your presentation at any time; the new slide will be inserted directly before 
the currently selected slide.  

To insert a new slide, use one of the following methods: 

• On the Home tab, in the Slides group, click New Slide to insert a slide with the same layout previously 
used; or 

• to insert a new slide with a specific layout, on the Home tab, in the Slides group, click the down arrow 
for New Slide, and then click the layout required. 

  
Notice you are presented with a variety of slide layouts and that the order in which they display follows the 
standard progression for a presentation; that is, start with a title slide, and then choose the appropriate 
content layouts based on the information you want to show. 

Hint: You can also press CTRL+M to quickly insert a new slide using the same slide layout previously used. 
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Changing the Slide Layout 
By default, a new presentation starts with a Title Slide layout and the next slide uses a Title and Content 
layout. You can change the layout of this or any slide at any time. 

To change the layout for a slide, on the Home tab, in the Slides group, click Layout. 

 
Click the layout that you want to use and it will be applied to the current slide. 

Changing the Slide Background 
You can add a background to the slide at any time; this can be a color, 
pattern, or picture. As with applying any formatting to a presentation, 
be careful of the colors and effects used to ensure the audience is not 
distracted from the message of the presentation. 

To add a background to a slide, click the Design tab and in the 
Customize group, click Format Background. 

When you select another option than color, different fields will appear 
to match that selection. For instance, if you choose to fill the 
background with a picture, two additional background options appear, 
giving you the opportunity to choose from three lists for the picture. 

You can also select to add the background to the current slide only, or 
to all slides. 

Deleting Slides 
When you no longer need a slide, in the Slide Thumbnails pane or Outline View, select the slide and press 
DELETE. 
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Rearranging the Slides 
As you work with a presentation, you may want to change the order of the slides to achieve better flow of 
information. 

To rearrange the order of the slides, in the Slide Sorter view, click and drag the slide to its new location. The 
slide will display with a red outline to show you where the slide will be inserted when you release the mouse 
button. 

 

Exercise 12-2: Tolano New Employee 
In this exercise you will open a presentation, add slides, enter text, and then change the layout and design 
for the entire presentation. 

1. Click File, click Open, click This PC and navigate to the student data files location. Click the Tolano New 
Employee Orientation file to open it. 

2. Click File, click Save As, and in the File name field, press the END key and type: - Student for the new 
file name. Click Save. 

3. In the Slide Thumbnails pane, click Slide 3. 

4. Click in the Slide pane, click at the end of the last bullet point, press ENTER, then type the following as 
the last bullet point on the slide: Offer travel adventures focused on leaving minimal carbon 
footprint. 

5. On the Home tab, in the Slides group, click New Slide to insert a new slide with the Title and Content 
layout. 

You will now change the slide layout. 

6. On the Home tab, in the Slides group, click Layout and then click Title Only. 

7. Type: Tolano Inc. as the title. 

8. In the Slide Thumbnails pane, click slide 5 and then on the Home tab, in the Slides group, click New 
Slide. 
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9. Add the following text to this slide: 

  
10. Save the presentation. 

Let’s now try adding a background fill to the slides. 

11. Click the Design tab and in the Customize group, click Format Background. 

12. Click Gradient fill and then click the arrow for Preset gradients. Click Top Spotlight – Accent 3. 

13. Ensure the Type is set to Radial. 

14. Click the arrow for Direction and click From Center.  

15. Click Apply to All and then close the Format Background pane. 

Now take a look at the presentation flow to see if the information flows logically from one slide to the next. 

16. On the bottom right of the Status bar, click the  (Slide Sorter) button. 

17. Review the slide content.  

 You should notice that Slide 6 seems out of place in its current location, and would make more sense if 
you reposition it before Slide 11 (Summary). 

18. Scroll the screen so you can see the rows that contain these two slides. Click Slide 6 to select it and then 
drag it between Slides 10 and 11. 
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19. When the slide appears between slides 10 and 11 (as shown in the figure), release the mouse to place 
the slide here. 

 The Other Resources slide should now be in the Slide 10 position. 

On further review of the presentation slides, you realize Slide 4 is no longer needed. 

20. Click Slide 4 and then press DELETE. 

21. Click the  (Normal) view button on the Status bar. 

22. Save and close the presentation file. 

Managing Slide Objects 
Objective 2-1.3, 2-1.6, 2-5.5, 2-7.1, 2-7.2 

An object is any shape, picture, media clip, chart, or text box inserted into a slide. To make changes to an 
object, first select or highlight it, then you can: 

• delete or replace the object 

• indent text 

• cut, copy or paste the item into another location 

• add formatting 

Using Select versus Edit Mode 
The circles that appear around a selected object are called handles; they verify that the object is selected and 
you can make changes to it. 

You can size the object using one of the following methods: 

• Click a handle on the horizontal or vertical sides and then drag to adjust the width or height; or 

• click a corner handle to size two adjacent sides of the object. 

When the border around a text box is a dashed line, you are in Edit mode and you can select specific areas 
of the text in the box for changes. 

  
• To select specific text within the placeholder, click and drag to select the text. When Edit mode is active, 

you can also select non-consecutive pieces of text by pressing the CTRL key as you select each piece of 
text you want. 
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When the border around a placeholder is a solid line, you are in Select mode and can affect the entire contents 
of the object. To activate Select mode quickly, position the mouse pointer on one of the borders of the 
placeholder, and then click when you see  (mouse pointer with four-headed arrow). 

  
• To select multiple placeholders, click the first placeholder and press SHIFT or CTRL as you click to select 

other placeholders. 

Manipulating Text 
PowerPoint provides many ways to manipulate or edit selected text or placeholders, including inserting 
additional text or deleting existing text. 

• To insert text, click in the placeholder to display the blinking insertion point and then move to where 
you want to enter the new text and start typing. 

• To delete text, use BACKSPACE or DELETE.  

Occasionally you may want to insert text into your presentation from another presentation, or from another 
location in the current presentation. Instead of retyping the information, you can use the Cut, Copy, and 
Paste commands. 

• To cut or move an item, select the item first and then on the Home tab, in the Clipboard group, click 
. 

• To copy an item, first select the item and then on the Home tab, in the Clipboard group, click . 

• To paste an item, first place the insertion point where you want to paste the item and then on the Home 
tab, in the Clipboard group, click Paste. 

Key Fact: You can also press CTRL+X to cut an item, CTRL+C to copy an item, or 
CTRL+V to paste the item. These keys are commonly used in other applications. 

PowerPoint uses the Clipboard to temporarily store any cut or copied items such 
as text or graphics, and you can paste wherever you choose. To display the 
Clipboard task pane, on the Home tab, in the Clipboard group, click the Clipboard 
dialog box launcher. 
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Checking the Spelling 
The Spelling feature in PowerPoint provides various options when checking for spelling errors, including 
custom dictionaries for special terms. 

The Spelling feature works in the background to check for spelling mistakes as you type. When PowerPoint 
detects a mistake, a wavy red line displays underneath the text. You can correct the mistakes immediately, or 
wait until you are finished creating the presentation. 

PowerPoint also displays proofing icons at the left on the status bar to indicate when PowerPoint detects no 
errors (  ) and when it detects a possible spelling error (  ).  

To perform a manual spell check on the entire presentation, press F7. 

Note: Remember that performing a spell check assures only the accuracy of the spelling in your slides; you 
should still proofread your presentation to ensure you are using the correct words. 

Formatting Text 
Formatting refers to the process of changing the appearance and position of objects on a slide. 

Font – Describes the typeface of characters on the screen and in print such as Courier New or Bradley. 

Font Size – Refers to the height of the characters (as characters get taller, they also grow wider.) 

Character Formatting – Refers to the special stylized variations applied to plain characters to make them 
stand out from other text. They include bold, italics, and various kinds of underlines. 

Effects – Apply special effects to the text, such as strikethrough, superscript or subscript, c h a r a c t e r  s p a c i n g , 
SMALL CAPS, and so on. 

The Font group in the Home tab enables quick, easy access to commonly used character formatting options 
directly from the Ribbon: 

 
The Mini toolbar provides similar access to commonly used formatting options, and provides a mixture of 
character and paragraph formatting buttons. This toolbar appears only when you select text; once you move 
the mouse pointer away from the selection, you will need to select the text again to display this toolbar. 

 

Aligning Text  
Each built-in slide layout aligns text according to defaults set for that layout. Occasionally, you may want to 
change text alignment. To change the alignment, on the Home tab, in the Paragraph group, click the 
appropriate alignment option. 

 

Align Left Align Right 

Center Justify 
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Inserting Pictures  
You can easily add pictures to any slide using the Pictures command. Pictures can come from a variety of 
sources, such as the Clip Organizer, saved picture files, scanned photographs, the Microsoft Office web site, 
and so on. 

To insert a picture file, use one of the following methods: 

• On the Insert tab, in the Images group, click Pictures; or 

• when creating or changing a slide layout, select one that contains a Content 
placeholder; then click Pictures to insert a picture from a saved location. 

In addition to choosing a picture saved on your computer/network, you can also search and then insert 
pictures from online sources such as Bing. Note that pictures obtained from online sources are often 
copyrighted and you should follow the rules for copyright and Fair Use principles. 

To insert a picture from the Internet, position the mouse pointer on the slide at approximately the location 
where you want to add the graphic, and then use one of the following methods:  

• When creating or changing a slide layout, select one that contains a Content 
placeholder. Then click the Online Pictures icon; or 

• on the Insert tab, in the Images group, click Online Pictures. 

  
You can enter the search criteria in the Bing Image Search field and press ENTER. Note that by default, the 
set of pictures shown are covered by the Creative Commons license; you can freely use these images in your 
documents without worry about copyright infringement. 
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If you require pictures other than the ones provided with these search results, click the arrow for the CC Only 
button and click All Images. 

Be careful that you are not violating someone’s copyright when you use images from the Internet. Image, 
sound, and video files can all be copyrighted. It is your responsibility to attribute proper credit for copyrighted 
images (or other files) that do not belong to you or your company. You can point at the bar across the bottom 
of an image (as shown in the following figures) to view information that may help you determine if you need 
to take steps to avoid copyright infringement.  

  

Manipulating the Pictures  
Manipulating pictures refers to sizing, moving, or otherwise modifying pictures. When you select a picture, 
the Picture Tools Format tab displays tools to help manipulate parts of the picture. 

Consider the following when working with pictures in PowerPoint: 

• You must select the picture, displaying its handles before you can make changes to it. 

• To increase or decrease the size of a picture, click and drag one of the handles. 

• To move a picture, position the mouse pointer anywhere inside the picture and, when you see , click 
and drag the picture. 

• To rotate the picture, click and drag the green handle to the angle required. 

• To insert a picture without using a picture placeholder, you may need to reapply an appropriate slide 
layout, or adjust the individual placeholders on that slide. 

• You cannot wrap text around a picture; you can either put the picture into a separate placeholder or 
manipulate the text so that it appears to wrap around the picture. 

• To reduce parts of a picture, you can crop the picture horizontally, vertically, or to a shape. 
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Inserting Media Objects 
One advantage of using presentations is the ability to include multimedia files such as videos, music, or links 
to Web pages that provide more information. To insert a media file, on the Insert tab, in the Media group, 
click Video or Audio. 

  
Hint: you can also click the Insert Video icon in a slide layout that contains icons for content. 

Once you insert the media file, a new ribbon (Video Tools or Audio Tools) appears with two tabs for you to 
manipulate the video or audio file. 

Exercise 12-3: Destress Your Day 
In this exercise, you will open a presentation to insert and modify some pictures on the slides. You will also 
apply some formatting options to the presentation. 

1. Open De-stress your Day from the data files location, and save it as De-stress your Day – Student. 

2. Click slide 2 in the Slide Thumbnails pane. 

3. Click the Insert tab and in the Images group, click Online Pictures. 

4. In the Bing search field, type: stress and press ENTER. 

5. Scroll through the list of pictures and then click one of your choice. 

6. Click Insert to add the picture to the slide. If a Design Ideas task pane appears at the right, close it. 

  
7. Point at one of the corner handles until you see the diagonal arrow, press SHIFT and then drag inwards 

to resize the picture to approximately 1.0” (2.5 cm) larger than its original size. (If your picture is big, drag 
inwards to make it a smaller.) 

8. Point anywhere in the picture and then drag the picture to the right of the bullet list points. 
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9. Make sure the picture is selected and on the Format tab, in the Size group, click the arrow for Crop and 

then click Crop to Shape. 

  
10.  In the Basic Shapes area, click Plaque. 

11. Click slide 4. On the Insert tab, in the Media group, click Audio and then click Audio on My PC. Navigate 
to the PowerPoint folder within the student data files and then insert the Slowed_Breathing file. 

  
12. Close the Design Ideas pane if necessary. Drag the sound icon to the end of the Take deep breaths … 

bullet point. Resize the icon so that it is approximately the same height as the text on this line. 

13. With the sound icon still selected, click the Format tab on the Audio Tools ribbon and click Color. Click 
Blue, Accent color 5 Dark so the icon is noticeable but not obvious. 

  
14. Save the presentation and then close it. 
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Animating Objects 
Objective 2-5.4 

You can animate objects and text to increase the effectiveness of your slide shows. You can also customize 
how the text, objects, and graphics enter (or become visible) when the slide displays, or how they exit 
(disappear from view). You can also use animation to emphasize objects on the slide. 

To add animation, on the Animations tab, in the Animation group, click More to display the Animation 
Gallery. After applying an animation, you can choose how the animation will make its entrance or exit, and 
you can add special effects to add emphasis.  

  
Once you choose an animation, you can set specific options for the animation using the Timing group: 

 
Try to be consistent in the number and style of animation schemes used on the slides. Consider your audience 
and choose the speed and effects accordingly. Too many variations can be distracting. Remember that you 
may want to keep some elements, such as titles, static during the show to provide a focal point for your 
audience. 
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Customizing the Animation 
You can adjust or customize how animation will occur during the presentation, as well as the speed and 
direction of animations, and the order in which text or objects appear on the slide. For instance, you may 
want the bullet points to appear one bullet at a time so your audience does not focus on the other text on 
your slide. You can also set an item to dim after it appears on the slide. 

To customize the animation, on the Animations tab, in the Advanced Animation group, click Animation 
Pane. As you select each element to be animated, PowerPoint provides options that control when or how 
the element will appear. 

 
Be sure to check the speed and timing of each animation, and play it to be sure it works well. 

 
As you apply animation to elements on a slide, PowerPoint places numbered boxes on the slide to indicate 
the order in which the items will appear; the Animation Pane will also list the animations in numeric order. 
You can rearrange the elements by using the  or  Re-Order arrows near the top of the pane; 
alternatively, you can drag an item to the required location. The numbers for the animations on the slide 
automatically reset themselves accordingly. 

You can customize animation using the Effect Options commands for each animation type. The number or 
types of effects vary with the Effect command chosen. Be sure to test each animation prior to setting up for 
final presentation. 
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When you no longer want or need an animation, remove it from the Animation Pane list. 

Animation options and effects vary from one animation to another. Use care when adding animation and 
effects; and always play or preview all the animations on your slides to be sure they appear in the proper 
order and that they remain visually appealing and are not overwhelming. Proper preview and preparation 
are important whether you animate all or only some of the elements on your slides.  

Applying Slide Transitions 
Slide transitions are special effects that you can apply as you move from one slide to the next during a slide 
show. Try to be consistent in the type of transitions you use between specific types of slides (such as bulleted 
lists or charts), as too much variation can distract your audience. 

To apply a slide transition, on the Transitions tab, in the Transition to This Slide group, click More to display 
all transition styles in the gallery. 
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You can then point at a transition to preview it for the current slide. You can customize the transitions by 
adding sound or changing the speed. You can apply a transition to one slide only or to all the slides in the 
presentation. 

You can use the options in the Timing group on the Transitions tab to apply the currently selected transition 
to all of the slides in the presentation.  

You can also use the options here to specify how your slides should 
advance. For example, will a speaker present the show and click to 
advance to each new slide, or will the slices advance automatically 
after displaying for a specific amount of time such as for self-paced 
training purposes, or to capture the interest of viewers as they walk by your exhibition booth at a trade show. 

Exercise 12-4: Exploring Seattle 
In this exercise you will add a variety of animations and transitions to slides and individual objects. 

1. Open the Exploring Seattle Proposal file and then save it as Exploring Seattle Proposal - Student. 

2. Go to slide 2 and review the contents on this slide. 

3. Click the border for the content placeholder. Then click the Animations tab, and in the Animation 
gallery, click Fly In as the animation style.  

4. Click the Effect Options button to the right of the gallery and click From Left. 

5. On the Animations tab, in the Advanced Animation group, click Animation Pane. 

6. In the Animation Pane, click the arrow for the Content Placeholder and click Effect Options. Click the 
Text Animation tab and then click the arrow for Group text. 

  
 This field determines how the bullet points appear on the slide and by which levels. We would like the 

bullet points to appear one line at a time, regardless of level so we need to choose the lowest level in 
the contents placeholder. 

7. Click By 4th Level Paragraphs and then click OK. 

 The preview should confirm each bullet point flying in from the left one at a time. 

8. On the slide, click the star graphic. On the Animations tab, in the Animation gallery, click Fly In. Click 
Effect Options and then click From Left. 

 The graphic should now fly in from the left during the preview. However, look at the numbers at the left 
of the contents placeholder. These numbers confirm the order the items will appear. 
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9. In the Animation Pane, click the expansion double arrow below the Contents Placeholder animation to 

expand the list of animations on the slide. 

  
10. Click the Picture 2 item (if not already selected) and then click the Up re-order arrow near the top of the 

Animation Pane until it appears after the bullet point starting with Very popular … 

  
 As you watch the preview play, you should notice the star appears for the line appropriately but it still 

appears before the text. You want to change this to occur at the same time as the text. 

11. In the Animation Pane, click the means popular text, then click the arrow for the means popular text and 
click Start: With Previous. Click item# 5 (Very popular …) and then click Play From to watch the preview. 
Now the star comes in with the text. 

Now change the entrance speed of the bulleted text content. 

12. In the Animation Pane, click the double arrow to hide the individual parts of the Content Placeholder. 
Then click the arrow for the Content Placeholder and click Timing. 

  
13. Click the arrow for Duration and then click 1 seconds (Fast). Click OK. 
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Note: Be sure to test the timing set for each slide; what you consider to be enough time may be too fast 
(or too slow) based on the amount of information on each slide. 

14. Go back to slide 1. Click the Transitions tab and then in the Transition to This Slide gallery, click different 
transition styles. Then click Push. Click Effect Options and then click From Top. 

15. Switch to Slide Sorter view. Click the star icon at the lower right corner below Slide 1 to view the transition 
applied to this slide.  

16. Click the star icon for Slide 2 to view the animation. 

You will now add transitions in Slide Sorter view. 

17. Click Slide 2, then on the Transitions tab, in the Transition to This Slide gallery, click Split. 

18. Click Slide 3, press and hold SHIFT, then click Slide 7 to select all the remaining slides in the presentation, 
click the Peel Off transition to apply it to all selected slides. Set the duration to 1.5 seconds 

19. Click Slide 4 and change the transition to Fracture. 

20. Double-click Slide 1 to return to Normal view. 

21. Close the Animation Pane. Then save and close the presentation when done. 

Setting up Slide Shows 
Objective 2-5.2 

You can set up options for how the presentation will appear before or after you create your presentation. To 
set up options for your slide show, on the Slide Show tab, in the Set Up group, click Set Up Slide Show. 

 
Use the options here to specify how you want to deliver your presentation, such as with a speaker, run on a 
computer at your booth, or in a window within a Web browser. You can also configure the presentation to 
support multiple monitors. 
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Viewing the Slide Show 
To start a slide show, click  (Slide Show) from the view buttons in the status bar. 

The slide show displays in full screen mode. By default, at the end of the slide show, PowerPoint displays a 
black screen with the message “End of slide show, click to exit” at the top, indicating that the slide show has 
ended. 

When running a slide show, you can set PowerPoint to advance the slides automatically at set time intervals, 
or you can advance the slides manually. To advance slides manually, click to move to the next slide or to 
display bullets points or objects on the slide. 

To present a slideshow on another monitor or on a projector, you must consider both hardware components 
and software settings.  

Hardware Considerations 
Video Cables Ensure you have the correct cable to connect from the video output port on your computer 

to the video input port on the second monitor or the projector or HD television. Most 
devices support VGA and either DVI or HDMI.  

If your devices do not have a port in common, or if both devices use the same technology 
but require different sized connectors be sure to bring an adapter so that you can adapt 
the video output to the receiving device. 

Audio Cables If your slide show includes embedded sound or video, you must ensure that the sound will 
be played back clearly and at a sufficient volume. If you are using an HDMI connection, and 
you are sending output to a projection device that includes speakers, such as an HD TV, 
then both picture and audio can be sent via the HDMI cable. 

If you are using a VGA cable, then you must send audio signals to the projection device 
separately using standard audio cables with connectors that will match the audio input 
ports on the projection device. 

If you are presenting your slide show on a projection device that does not include speakers, 
then you must ensure that your own device has sufficient sound output, or you can attach 
good quality speakers to your computer. 

If you will need to amplify your own voice as you deliver your presentation, you will need a 
microphone that can connect to an amplifier and speakers.  

The following figures show an HDMI cable, a standard-to-mini HDMI adapter, and a standard audio cable 
with 3.5 mm connectors. 

 
Note that when you connect your computer to an external display, the operating system will detect the 
additional hardware. You will need to specify to the operating system whether you want to mirror your 
desktop on the external display or extend your desktop across both displays. For details on configuring an 
external display, see Computing Fundamentals, Lesson 2, Connecting Peripherals. 
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Using Presenter View  
To display a slideshow on another monitor or projection device, do one of the following: 

• On the Slide Show tab, in the Set Up group, click Set Up Slide Show, then click the arrow for Slide show 
monitor and select the appropriate monitor, and click OK.  

• on the Slide Show tab, in the Monitors group, click the arrow for Monitor, and select the appropriate 
monitor. 

When you run the slide show, it will appear in full screen on another monitor (or projection device) while 
your primary monitor stays in PowerPoint mode.  

If you turn on Use Presenter View with your secondary monitor, your primary monitor will change from 
PowerPoint display mode to the view shown in the following figure when you run the slide show: 

 
Notice the icons below the slide that you can use as the presenter rather than trying to find the icon at the 
lower right of the monitor that the audience is viewing. This view is very useful as it shows you the contents 
of the current slide as well as the contents of the next slide so you can see the flow of the presentation, or 
make adjustments as questions from the audience arise. 

Another benefit of using this view is that you can see the speaker notes on the current slide and can adjust 
the font size of the notes using the buttons at the lower left. 

To stop the slide show at any point, press ESC. 

Exercise 12-5: Alaska Hiking 
In this exercise, you will run a presentation as a slide show, review content and animation flow.  

1. Open the Alaska Hiking Tours file and save it as Alaska Hiking Tours - Student. 

First, ensure that you are not using Presenter view. 

2. Click the Slide Show tab, then in the Monitors group, clear the Use Presenter View check box if 
necessary. 

3. Press F5 to go into Slide Show view and then click to view the contents of several slides. 
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4. Point at the lower left corner to see the navigation tools and click the arrow buttons to move from one 
slide to another. 

5. Click the  Pen button and choose a pen style. You can use this tool to annotate your slides while you 
are presenting a slide show. Try to write or highlight something on the current slide, or move to another 
slide to use the pen. 

6. When you are done viewing the slide show, press ESC to return to Normal view for PowerPoint. Note 
that you may need to press ESC twice and that you will be prompted to save or discard any screen 
annotations. Discard any annotations. 

The presentation was originally set up to be delivered by a speaker. Suppose you are now asked to set up 
this presentation on the company Web site and allow people to view it on their own. 

7. Click the Slide Show tab, and in the Set Up group, click Set Up Slide Show. 

8. In the Show type area, click Browsed by an individual (window) and then click OK. 

9. Press F5 to begin the slide show. 

10. Use the Previous and Next arrows at the lower right corner of the screen to move from one slide to 
another. Click anywhere on the slide to move from one slide to the next slide. 

11. Press ESC to exit the slide show view. 

12. Save and close the presentation. 

Sharing the Presentation 
Objective 2-5.1 

There are a number of ways to share a presentation, and the method you choose depends on what you want 
to share and who you want to share it with. Because sharing is a file management task, it is accomplished 
using either the Share tab or the Export tab in the Backstage view. 

Using the Share Tab 
Use the options on the Share tab to share your presentation as a whole. 
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From the Share tab, you can: 

• Save your presentation to a cloud location and then provide access to others. 

• Send your presentation as an email attachment.  
– You can attach your presentation as a presentation file, a PDF document, an XPS file (which can be 

viewed, but not edited, in an XPS viewer). 
– You can also elect to send the presentation as fax transmission over the Internet. 

• Present your presentation online in a video conference using Skype for Business. 
• Publish the presentation slides to your organization’s SharePoint site or slide library. 
• Send the presentation file as an attachment in an instant message. 

Using the Export Tab 
Use the options on the Export tab to generate presentation output in other file formats.  

 
From the Export tab, you can: 

• Create a PDF or XPS document. In contrast to simply dumping the output of the entire presentation into 
a PDF file that will be attached to an email (you do this on the Share tab), when you create a PDF/XPS 
from the Export tab, you can specify which slides to include, whether to include comments and ink 
markup, whether to include document properties, and whether to frame slides in the output. 

• Save the presentation as an MP4 video file that can be played back on a variety of personal devices. You 
can burn the video to a disc, upload it to a web site, or email it as an attachment.  

• Save the presentation and all the objects (fonts, videos, sounds, linked files) embedded within it into a 
package that can be burned onto a CD. A presentation package can be played back on most computers, 
even if PowerPoint is not installed. 

• Create handouts in Word. Handouts include pictures of slides and text notes which are exported to a 
Word document. You can control the layout of the output, and you can opt to generate an outline of 
the presentation using the Outline only option. 
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• Change the file type of your presentation. You can save the presentation as: 
– One of several presentation file types (PowerPoint 97-2003 Presentation, PowerPoint Template, 

PowerPoint Show, or PowerPoint Picture Presentation). 
– A series of image files (PNG or JPEG) suitable for printing or displaying on a web site. 

– Another file type. Selecting this option opens the Save As dialog box, from which you can select an 
option in the Save as type drop-down list.  

Note: Always remember to preview and proof your presentation before sharing. 

Create Handouts in Word 
Handouts are documents audience members can take with them after viewing 
a presentation. Because PowerPoint creates handouts in Word, you can edit and 
format them. To create handouts, click the File tab, click Export, and then click 
Create Handouts. 

 
Click Create Handouts to view the options for creating the Word document. 

You can select a layout, and specify how you want the slides inserted into the Word document. Select Paste 
to insert the slides themselves. If you select Paste link, then you would also need the original PowerPoint 
presentation in order to see the slides in the Word document. Once the handout document is created, the 
Word icon will flash in the Windows taskbar; you must save the Word file if you want to keep it. 

Publishing the Presentation 
If your organization or company uses SharePoint or another network storage system that provides a central 
location for employees or members to store and share files, you can publish your presentation slides. 

When you publish slides, PowerPoint saves each slide as an individual file. PowerPoint automatically names 
each slide file with the presentation file name and a number, such as Exploring Seattle Proposal_004. This can 
be helpful when you need to find a particular slide. You can change the file name in the File Name column 
of the Publish Slides dialog box. 

You can reuse published slides in multiple presentations; for example, you may want to reuse a slide with 
your company mission statement, organization structure, or contact information. 

To publish a presentation, on the File tab, click Share. In the Share panel, click Publish Slides and then click 
the Publish Slides button. 
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Within the Publish Slides dialog box, select the slides you want to publish and then specify a location for the 
slides to be stored. You can publish directly to a shared location, or publish to a local location and then move 
the published files to a shared location later. 

 

Printing the Slides 
You can print the slides in the presentation in various ways, such as one or more slides per page, as handouts, 
in a format that includes notes, grayscale, and so on. These methods can be selected using the print options. 

 



Lesson 12 Using Microsoft PowerPoint 
 

 

404  7500-1 v1.00 © CCI Learning Solutions Inc. 

Exercise 12-6: Exploring Seattle File Formats 
In this exercise you will create handouts for a presentation and you will publish slides for upload to the 
company intranet. You will also export the file to different formats. 

1. Open Exploring Seattle Proposal from the student data files. 

2. Click the File tab, click Export, and click Create PDF/XPS Document. Then click Create PDF/XPS. 

  
3. If necessary, click to turn on Open file after publishing. Ensure you are in the location of the student 

data files. Type: PDF - Student at the end of the file name and press ENTER. PowerPoint exports the 
presentation to a PDF and opens a PDF reader app on your system.  

4. Scroll in the window that displays the PDF version and then close the window. 

Now create an outline that can be used for a formal report. 

5. Click File, click Export, and click Create Handouts. Then click Create Handouts. 

6. Click Outline only and click OK. 

7. Click the flashing Word icon on the taskbar. 
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 Notice that although all the slide text is imported into the outline, the hierarchy of topics is not preserved. 
For example, Exploring Seattle and Expanding the Restaurants Tour are the title and sub-title text of the 
first slide, but there is no way to tell that in this version of the outline. Outlines exported to Word require 
some editing and formatting. 

8. Click  (Save) on the Quick Access toolbar. Click This PC and if necessary, navigate to the PowerPoint 
folder in the student data files location. Click in the file name and type: Exploring Seattle Proposal 
Outline - Student. Click Save. Then close Word. 

Now try sharing a document as a PowerPoint show. 

9. Click File, click Export, and click Change File Type. Click PowerPoint Show and then click Save As. 
Type: Show - Student at the end of the file name and press ENTER. 

10. Close the show and exit PowerPoint, and then use File Explorer to navigate to the student data files 
location, then double-click Exploring Seattle Proposal Show – Student to launch the show.  

 Notice that the show runs independently of PowerPoint.  

11. Click the mouse several times to move through the text on the first few slides, then press ESC to close 
the show. 

12. Close the File Explorer window, and restart PowerPoint. 

Now try creating a video of the presentation so the slide show can run on its own. 

13. Re-open the Exploring Seattle Proposal presentation file. 

14. Click File, click Export, click Create a Video. 

  
15. Change the number of seconds spent on each slide to 3. Then click Create Video. 

16. Navigate to the PowerPoint folder in the student data location. Type: Video - Student at the end of the 
file name and click Save. 

17. Once the video has been saved, start File Explorer and navigate to the student data location files for 
PowerPoint. Double-click Exploring Seattle Proposal Video – Student. When the video finishes, close 
the Movies & TV window. 
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Now try publishing the slides. 

18. Return to PowerPoint, click File, click Share, click Publish Slides, and then click Publish Slides. 

19. Click Select All and then click Browse. Navigate to the PowerPoint folder in the student data location 
and click Select. 

20. Click Publish. 

21. Minimize PowerPoint and use File Explorer to navigate to the PowerPoint folder in the student file 
location to view the various formats that you can use to share this presentation with others. 

  
22. Close File Explorer. 

Now look at various print options you can select to print a presentation file. 

23. Maximize PowerPoint to the screen and click slide 1. 

24. Click the Notes button on the status bar.  

  
25. In the Notes Pane, type the following: 

The Restaurant Tour introduced last year was very popular with the few local 
restaurants chosen for the pilot. Feedback from customers indicated an interest 
to include some of the places mentioned on the Food Network and getting “group” 
rates and especially, seating. 
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26. Click File and then click Print. 

  
27. Click the Color print option and then click Grayscale. 

  
28. Click the Full Page Slides option and then click Notes Pages. 
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 This print layout option is useful when you want to print a copy of the notes for review. In practical life, 

you would add more notes to the presentation than was required for this demonstration exercise. 

29. Click Print to print all the slides of the presentation using this format. 

30. Close the presentation without saving. 

Lesson Summary 
This lesson taught you how to use PowerPoint to create simple presentations, including adding slides, images, 
animation and transitions. You also learned how to share PowerPoint elements. You should now be able to: 

 plan and design a presentation 

 create, save, close, open, and switch between 
presentation files 

 move around in a presentation 

 change view displays  

 insert, modify or delete slides 

 change the layout or order of slides 

 manipulate text or objects on slides 

 insert pictures or multimedia objects on slides 

 animate objects on the slides 

 apply transitions to slides 

 share presentations with others 

 publish slides 
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Review Questions 
1. A typical presentation contains what type of content in the first and second slides? 

a. Title and Introduction  c. Title and Contacts 
b. Title and Agenda   d. Title and Summary 

2. Which view appears when you start PowerPoint? 

a. Backstage c. Read 
b. Edit  d. Normal 

3. When might you want to create a new presentation using a template? 
a. To use the slides in an existing presentation where you will simply change the text content where 

necessary. 
b. To use a predesigned presentation as a guide to what or how the content should be set up in the 

presentation. 
c. To save a copy of the colors and design used in a template that you can then use for your own 

requirements. 
d. To start a wizard that will guide you through the creation of a presentation one step at a time. 

4. Which view displays the slides in a linear or grid manner? 
a. Normal c. Slide Sorter 
b. Outline  d. Reading 

5. Which slide layout is automatically inserted after a title slide layout? 
a. Title Only   c. Two Content 
b. Title and Content   d. Comparison 

6. Which option would you use to change the layout of a slide? 
a. New Slide c. Layout 
b. Insert Slide d. Slide Layout 

7. Which view would you use to rearrange the order of slides? 
a. Normal c. Reading View 
b. Slide Sorter d. Slide Show 

8. If you see a dashed line as the border of a text placeholder, which mode are you using? 
a. Edit mode b. Select mode 

9. Which key can you press to activate the spell checker tool for every slide in the presentation? 
a. F1 c. F7 
b. F5 d. F10 

10. When searching for online pictures with Bing, what should you consider before clicking the All Images 
option? 

a. Whether to use actual photographs or clip art images if you are searching for a picture. 
b. The number of objects you can choose from a web search. 
c. Copyright, or who may own the object you want to use from the web search results. 
d. How fast your Internet connection is before activating any searches. 
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11. Before you can manipulate an image, what must you do first? 
a. You must have cited the source where you found this image. 
b. Ensure the image must be copyrighted to you or your company. 
c. Ensure the image must be a real photograph. 
d. You must select the picture. 

12. On which tab would you find the command to include a video or audio file on a slide? 
a. Insert c. Slide Show 
b. Design d. View 

13. What are the three types of animation effects you can apply to a slide object? 
a. Start, Continue, End 
b. Entrance, Emphasis, Exit 
c. Speed, Duration, Effect 
d. Speed, Timing, Effect 

14. Which pane would you use to change or customize the animation of a slide object? 
a. Slide Thumbnails 
b. Notes 
c. Animation 
d. Effects 

15. How do slide transitions differ from applying animations? 
a. Animations can be modified whereas transitions are preset features. 
b. Slide transitions affect the entire slide, regardless of the number of slide objects. 
c. You can only add three transitions on a slide but multiple animations for a slide object. 
d. There is no difference unless you use a theme in the presentation. 

16. You will be delivering a presentation where an HD television has been set up to project the slides. What 
type of cable are you likely to need to plug to your computer to show the slides on this television? 

a. HD c. HDMI 
b. Ethernet d. Parallel 

17. Which command would you use from the File tab if you wanted to turn the presentation into a video? 
a. Save As c. Export 
b. Share d. Publish 

18. Why might you want to publish a presentation? 
a. To reuse the slides for another presentation. 
b. To save these slides to OneDrive. 
c. To restrict others from making changes to the slides. 
d. To use the slides in a format that can be viewed from a web page. 
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Living Online 
 
 

Lesson 13: Looking at the 
Internet  
Lesson Objectives 
In this lesson, you will learn about the nature of the Internet, and about the role and function of web browsers. 
Upon completion of this lesson, you should be able to: 

 describe the nature of the Internet 

 describe packets and how they make their way 
across the Internet 

 differentiate between public and private networks 

 specify a network location in Windows 

 describe the function and characteristics of IP 
addresses 

 understand the Domain Name System (DNS) 

 describe domain types 

 identify parts of a URL 

 differentiate the Internet from the World Wide Web 

 describe the role of HTML, CSS, and hyperlinks 

 use a web browser 

 describe different browsers 

 work with browser settings 

 describe browser functions and features 

 use bookmarks/favorites 

 handle pop-ups, cookies, and the browser 
cache 

 understand browser extensions 

 describe web site/web page standards  

A Connected Community 
As you have been making your way through this course, hopefully you have noticed the repeated theme of 
connectedness. When personal computers were brand new, they were strictly stand-alone devices. But we 
knew that connecting computers could be useful – and so we created networks. And then on a grand scale, 
we created the Internet.  

At one time, data, phone and cellular networks were separate and distinct. But they are rapidly closing all the 
gaps and becoming one inter-connected network. Our personal devices – phones, tablets, TVs, and PCs – 
can connect from almost anywhere, and our world is becoming a connected community. 

In this module, you will examine some of the technology that connects us, and consider the advantages, 
pitfalls, and responsibilities that come with living in a connected world. 
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Introducing the Internet 
Objective 3-1.1 

You use the Internet all the time – doing research, playing games, watching videos, or chatting with friends. 
You type in an address, or click a link, and pages of text, color, images and embedded audio and video files 
appear on the screen. Where does all the information come from? And how does it reach your computer?  

The information you view in your browser comes to your computer through a series of networks. The Internet 
is a vast global network that functions in much the same way as your school or company network. 
Hierarchically, the Internet is comprised of many smaller networks which are connected together so that they 
can communicate and share information.  

Backbone 
At the core of the Internet is the backbone – a series of redundant, high-speed networks owned and operated 
by some of the largest long-distance voice carriers (for example, AT&T, Verizon, Sprint, or CenturyLink). 
Companies that operate networks on the backbone are called Tier 1 providers. Tier 1 provider networks 
connect with one another at Internet Exchange Points (IXPs) located along the backbone, and high-speed 
backbone routers keep network traffic moving.  

Anyone who wants to access the Internet must ultimately connect to a Tier 1 provider network. Typically, this 
connection is supplied by a local Internet Service Provider (ISP), such as a cable or DSL company. These local 
ISPs negotiate with Tier 1 providers for Internet access. Individual consumers and businesses subscribe to 
their local ISPs (which in turn are connected to Tier 1 providers).  

Hardware 
Physically, the Internet is a collection of hardware. It consists of wires, routers, switches, microwave links, 
servers, and communication protocols. The hardware you use in your home LAN or in your school or office 
LAN is not much different than the hardware that forms the core of the Internet itself. 

Packets  
In any network, data that is exchanged from one computer to another travels across the network in a unit 
called a packet. A packet is a package of information. It contains address information for both the source 
computing device (the one that sends the packet) and its intended target or destination device. The 
addressing information is what makes it possible to deliver a packet from its source to its destination.  

In addition to addressing information, a packet also contains a data payload. This data payload is the actual 
information that you want to send from one device to another. For example, a data payload may contain a 
request for a web page. If a packet is coming back to your computer from a web server, the data payload 
may contain part of the web page that you requested.  

All data that is sent over a network – images, document files, web pages, audio and video files – must be 
broken down into packets before they can be transported across the network. The larger the file, the longer 
the process will take. 
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Routers 
When you open a browser, type a URL in the Address bar, and press ENTER your computer breaks the request 
for a specific web page into packets and sends those packets out onto the network. Your home, school, or 
work router forwards those packets to your ISP, who forwards them onto the Internet. But how does your 
packet with the web page request travel across the Internet to get to the target web server?  

Routers along the Internet read the addressing information and forward your packet accordingly. That is, 
your data packet passes from router to router along the Internet (and passes through several interconnecting 
networks along the way) until it reaches the network where the target web server resides. At the destination, 
the packets are reassembled into the original data transmission. 

A router connects different networks to each other. A router also determines the best path for a transmission 
to take, and passes that transmission to the next router along the path. 

You may be familiar with residential broadband routers, or even enterprise-level routers used in a company 
or school LAN. Routers all perform the same functions. However, high-speed Internet backbone routers must 
be powerful enough to handle the enormous amounts of data streaming through the backbone at speeds 
of gigabits-per-second. 

Public Networks 
Arguably, the most important thing you should understand about the Internet is that it is a public network. 
In fact, it is often referred to as “the public network.” It is not centrally owned or controlled; it is available for 
anyone (with a valid IP address and an Internet connection) to access and use. For these reasons, no one can 
“police” the Internet to protect (or control, or monitor) the people who use it. 

Think about all the people around the world who connect to the Internet every day. Any time you connect 
to the Internet, you can, potentially, connect to anyone else who is connected.  

The great thing about the Internet is that any computer can exchange data, email, and programs with any 
other computer. And the bad thing about the Internet is that any computer can exchange data, email and 
programs (and also, unfortunately, viruses, Trojans and malware) with any other computer. Being connected 
can make any system vulnerable to unwanted activity such as eavesdropping or theft of personal information. 
For this reason, the Internet is also referred to as “the open network” or 
“the untrusted network.” 

In network diagrams, the Internet is represented by a cloud because its 
contents (and its participants) are unknown. 

Private Networks 
In contrast to the public, untrusted Internet, private networks are considered secure. All systems connected 
to a private network are trusted.  

When you log on to a system that is inside your home, school, or corporate LAN, you have access to the 
resources connected to the LAN. Depending on your rights and permissions, you can likely access printers, 
email servers, and documents stored on network file shares. One of the benefits of maintaining a LAN is the 
ability to share resources.  

 Internet 
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Many organizations maintain intranets that allow their employees, partners, or students to access LAN 
resources from outside the LAN. An intranet is a private web site; you access it with your browser and you 
must log in using a valid user name and password. Once you are logged in, you can navigate the intranet 
web site to access the LAN resources that have been made available. 

In Computing Fundamentals, you learned that you can gain access to a LAN from the outside using a Virtual 
Private Network (VPN) connection. An intranet and VPN serve the same general function – they allow access 
to the LAN from the outside for users with a valid user name and password.  

Once you make a connection (that is, once you are “inside”) your system is trusted just as if it were located 
physically within and connected directly to the LAN. 

Specifying a Network Connection Type  
The issue of trust becomes a serious one the moment you attach a network cable or join a WLAN. Network 
administrators use firewalls to keep potentially dangerous traffic out of the LAN. But who protects your 
system when you are connected to a public network at a public spot, such as at a hotel, or an airport, or a 
coffee shop? 

The Windows operating system includes built-in mechanisms to help protect your system while you are 
connected to various networks. When you make a network connection for the first time, Windows asks what 
type of network you are connecting to (and you can change this setting for a connection at any time). You 
can choose:  

Private – if you configure a connection as private, then your computer will automatically “discover” (that is, 
locate and identify) other computers, devices and content that is accessible on the network. More 
importantly, it also makes your PC discoverable and allows sharing of folders on your system. This is the 
appropriate setting for a connection to your or work (or school) network. 

Public – if you configure a connection as public, Windows will not allow your PC to be discovered by other 
systems on the network, and sharing will be disabled. Use this setting for connections to public hotspots. 

The connection type is displayed on the Network and Sharing Center page in the Control Panel. 

  

The connection type is tied to the discoverability of your PC, which you access through the Settings app.  

 



Looking at the Internet Lesson 13 
 

 

7500-1 v1.00 © CCI Learning Solutions Inc.  415 

To configure a network connection as private: 

1. Click Start, Settings, then click Network & Internet. 

2. In the left pane, click either Wi-Fi or Ethernet (as appropriate) to display the current active connection(s). 

3. Scroll down and click Advanced options. 

4. Set the Make this PC Discoverable setting on. 

Always choose the appropriate type of connection.  

Exercise 13-1: Examining your connection type 
In this exercise, you will examine your connection type settings.  

1. Right-click your network connection icon in the taskbar, then click Open Network and Sharing Center. 

2. Is your connection public or private? Is this setting what you expected? Why or why not? 

3. Close the Control Panel. 

Finding Computers on the Internet 
Objective 3-1.1 

In order for computers connected to a network to communicate with one another, they need to know how 
to locate each other. That is why each computer connected to a network must have a unique address.  

You learned in Computing Fundamentals that this unique network address is called an IP address. When your 
computer breaks a message into packets and adds addressing information, that addressing information is an 
IP address. 

IP Address Review 
In IPv4, an IP address is represented by a grouping of four numbers (each between 0 and 255) separated by 
periods (or dots). This type of notation is called “dotted quad” notation. 

For example, 66.235.120.127 is the IP address for the web server at Ask.com. 

Anytime you visit the Ask.com web site, your computer exchanges packets of information with the Ask.com 
web server. Your computer uses the Ask.com web server’s IP address in order to properly address the packets 
that it sends to the server. Once the addressed packets are sent out onto the Internet, routers guide the 
packets to the Ask.com web server. Because return address information (that is, your computer’s IP address) 
is included in the packets, the Ask.com web server knows how to properly address the packets that it will 
return to your computer. 

DNS 
Have you ever typed an IP address into the address bar of your browser? Chances are you haven't.  

Most people type a text-based web site address into the browser address bar. For example, you can visit the 
Ask.com web site by typing www.ask.com in the browser address bar. Your computer can discover the IP 
address of the Ask.com web server by querying (asking) a DNS server.  
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The Domain Name System (DNS) is a service that keeps track of the specific IP addresses of web servers 
around the Internet and maps those IP addresses to the text-based names we enter into the address bars of 
our browsers. These text-based names are called domain names.  

DNS resolves text-based domain names into their IP addresses. For example, you can access the Ask.com 
web server at IP address 66.235.120.127 by typing: www.ask.com in your browser's address bar. In other 
words: 66.235.120.127 = www.ask.com. 

Both the domain name and the IP address refer to the same resource, but the domain name is easier to 
remember. Without DNS, you would need to enter an IP address any time you wanted to access a resource 
on the Internet. 

These mappings are stored in records in a DNS database. Every domain consists of DNS records. A DNS 
record is an entry in a DNS database. The network administrator will create one address record that maps the 
IP address to the domain name, and usually creates several records for aliases or nicknames that point back 
to the address record. If you enter an alias as a URL, for example “ask.com” or simply “ask,” you can still 
navigate to the www.ask.com web server. 

DNS Servers  
The DNS service is made possible through DNS name servers, which are servers on the Internet whose sole 
function is to resolve domain names into their IP addresses. For example, when you enter a URL such as 
www.ccilearning.com into your browser's address bar, your computer contacts a domain name server to 
obtain the IP address related to this domain name. When your computer receives the IP address 
160.153.73.246 from the domain name server, it can correctly address a web page request and send it to the 
web server. When the server responds, the CCI Learning Solutions site displays on the screen. 

Note: If a DNS server is unreachable, you will not be able to navigate to a web site by entering its URL in 
the browser address bar. You can, however, still reach the site if you know its IP address. 

Understanding Domain Names  
Objective 3-1.1 

A typical domain name consists of three labels separated by periods or dots.  

 
Server Name Identifies the name of the web server. 

Registered Domain 
Name 

Identifies the organization that owns the domain name. Each domain name is unique 
and is registered with the Internet Corporation for Assigned Names and Numbers 
(ICANN). 

Top-level Domain Identifies the category of the registered domain name. 

Starting from the right, the domain name lists the most general category, then more specifically the company 
that owns the domain, and then the specific resource within the company that owns the domain. The domain 
name is like a road-map to a particular resource. 

www.ccilearning.com 

Registered 
Domain 
Name 

Server 
Name 

Top-level 
Domain 
Name 
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DNS Domain Levels 
DNS is arranged into a hierarchy that consists of three levels: 

• Root-level domain 

• Top-level domains 

• Second-level domains 

The root-level domain is the top of the hierarchy and contains entries for each top-level domain. 

Top-Level Domains (Generic Categories and Countries) 

Top-level domains are the highest level domain names of the Internet. Every domain name ends with a top-
level domain label. 

There are two main groups of top-level domains:  

• those that group domains into generic categories (commercial, educational, military, and so on), and  

• country code top-level domains which are based on two-character codes signifying country 
abbreviations.  

Generic Top-Level Domains 
You can generally determine what type of information a web site contains (or what it is meant to do) simply 
by reading the generic top-level domain. The original seven generic top-level domains are: 

.com Represents commercial or company sites. Most web sites in this domain sell a service or product, 
usually through an online store or web page from which you can purchase items directly. The 
.com domain is considered a generic top-level domain and can be registered by anyone. 

.net Another type of commercial web site. It is generally hosted on a network managed by an Internet 
Service Provider (ISP). 

.edu Represents an education site created to share information about an academic institution, its 
curriculum, and other activities. This category may also be associated with research organizations. 

.gov Refers to a site associated with a local, regional, or national government. (Depending on the 
country, there may be additional levels included in the URL to identify specific areas such as 
states, municipalities, townships). 

.int Refers to international organizations. 

.mil Refers to military organizations. 

.org Identifies a site dedicated to a non-profit organization that may promote a specific cause such 
as foundations for heart attack and stroke prevention, or cancer for example. 

Additional categories are added as the need arises. Examples include: .aero, .biz, .info, .jobs, .pro, and .travel.  
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Country Code Top-Level Domains 
Other top-level domain names use a two-letter abbreviation and are meant to identify the country in which 
the web site is hosted; examples include: 

au Australia fr France jp Japan 

br Brazil il Israel mx Mexico 

ca Canada in India tw Tawain 

cn China it Italy uk United Kingdom 

dk Denmark     

Second-Level Domains 
The second-level domains can be: 

• a domain name registered by the company that owns it. Amazon.com and Microsoft.com are examples 
of second-level domains. 

• categories of the top-level domain. For example, .co.uk indicates a commercial business within the United 
Kingdom, while .police.uk is used by UK police forces. 

Subdomains 
Additionally, second-level domains can be further divided into subdomains. For example, in the following 
URL: support.xbox.com  

• .com is the top-level domain 

• .xbox is the second-level domain 

• support is a subdomain within the xbox second-level domain.  

Understanding URLs  
Objective 3-1.1 

The text-based web site address you type into a browser address bar is called a Uniform Resource Locator 
(URL). A URL is the global address of a resource on the World Wide Web. A URL consists of two basic parts: 
a protocol identifier and a domain name. These parts are separated by a colon : and two forward slashes / /. 

 

Protocol Identifier 
Various protocols are used on the Internet to communicate with specific types of servers. The protocol used 
to request web pages from a web server is HyperText Transfer Protocol (HTTP). Web servers also use HTTP to 
send web pages to the computers that request them. 

Browsers assume that you want to use the http protocol when you enter a web site address. This allows you 
to simply type: "www.yahoo.com" instead of "http://www.yahoo.com." Some web browsers display the http:// 
protocol identifier in the address bar and others do not. 
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There’s more than HTTP 
Other protocols commonly used in URLs are: 
HTTP Secure (HTTPS) – is a protocol used for secure web transactions, such as making purchases over the 
Internet. The HTTPS protocol allows you to use HTTP over a secure connection. In the past, these connections 
were secured by a protocol called Secure Sockets Layer (SSL). Today, Transport Layer Security (TLS) is the 
protocol used to secure the connection. However, TLS is often still referred to as “SSL” and HTTPS is often 
still referred to as “HTTP over SSL.”  
File Transfer Protocol (FTP) – used to transfer large files between a user’s computer and a special type of 
server called an FTP server. If you want to use your web browser to access an FTP server to transfer a file, you 
must specify the ftp protocol in the URL; for example: ftp://aeneas.mit.edu. 

Path and Filenames in URLs 
Web servers (like any other PC) store files in directories on a hard drive. A URL can also include the path and 
filename of a specific document or web page stored on a server.  

Consider the following URL: http://www.opera.com/browser/tutorials/mail/setup/#account-setup  
• #account-setup is a web page 
• /browser/tutorials/mail/setup is the path to the folder on the web server where the page is stored 
• "www" is the name of the web server 
• opera.com is the registered domain name of the company that owns the web server 

• .com indicates that it is a commercial enterprise 

What is the World Wide Web? 
In our discussion of the Internet, we have made several references to the World Wide Web. While the Internet 
is a network comprised of hardware connections, the World Wide Web is a system of interlinked documents 
that are accessible on that network called the Internet.  

There are countless millions of documents hosted on web servers – and if you can access a document by 
typing its address into a web browser, or by clicking a link that takes you to it, that document is part of the 
World Wide Web. 

Documents hosted on web servers are generally referred to as web pages, and web pages usually contain 
links (called hyperlinks) to other pages located on web servers around the Internet. If you have ever visited a 
web site and clicked a link that took you to another web site (or to another page within the same web site), 
then you have used a hyperlink. These hyperlinks form the connections that make the World Wide Web 
possible – web pages around the world are connected to one another by hyperlinks. 

What Exactly is a Web Page? 
Objective 3-1.1 

A web page is a file created with hypertext markup language (HTML). HTML is a special language that web 
page authors use to add text, hyperlinks, applications, video clips, sound and animation to web pages. A 
collection of related web pages is called a web site. 

When web pages are designed properly, visitors can “point and click” to launch applications, navigate to 
specific areas of the web site, or visit related web sites – all within a web browser window. 
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HTML 
HTML (the common name for Hypertext Markup Language) is a standardized language used to create web 
pages. The language is built using HTML elements, which consist of tags enclosed in angle brackets, as used 
in the “Hello World” HTML document shown in the following figure: 

 
Most HTML tags are written in pairs, such as <head> and </head>. The first tag in the pair is called the 
opening tag, and the second is called the closing tag. (Some tags, called empty elements, are not paired.) 

Web browsers can read HTML files and render them into web pages. Browsers do not display the tags, but 
use them to determine how to represent the content of the page. You may have noticed from looking at the 
HTML example that the tags describe the structure of the page – there is a head section which can include 
styles or a web page title, and a body section that can include headings, bullet lists, and paragraphs of body 
text. 

When you view the “Hello World” document in a browser, it appears as shown in the following figure: 

 
HTML also allows images and objects to be embedded in web pages, and for pages to run scripts written in 
programming and scripting languages such as JavaScript and Perl.  

CSS 
Today’s standard for web page design separates content/structure from presentation. The content and 
structure are defined in the HTML. Presentational attributes (that is, properties such as font colors, 
background styles, element alignment, and so on) are defined in Cascading Style Sheets (CSS). 

CSS allows web page authors to move presentational styling information into the head section of the HTML 
document (this is called internal CSS), or to a separate style sheet document (this is called external CSS) that 
is linked to the HTML document. The web browser reads the HTML document for content and structure, and 
looks to the style sheet for presentational information. The browser applies the styles defined in the style 
sheet to the HTML content as it renders the page. 
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The following figure shows the “Hello Word” document with a CSS paragraph style added to the head section. 
The opening and closing tags for the style are <style> and </style>. 

 
When you view the modified “Hello World” document in a browser, it appears as shown in the following 
figure. Notice that the browser applies the style and renders the page accordingly. 

 

Hyperlinks 
The World Wide Web is based on a collection of documents which are connected to one another through 
hyperlinks. You can click a hyperlink in a web page to move to another (connected) web page or to a 
particular section within the current web page. A hyperlink is a reference to data that is located somewhere 
other than the present location. A hyperlink can point to a whole document or to a specific element within a 
document. 

Hyperlinks are HTML elements, and are embedded into web pages. Generally, a hyperlink consists of link text 
(which is the text or image that you click), and a target (which is the destination web page).  

In HTML, links are defined with the <a> (anchor) tag and take the following form: 
 <a href= “url”>link text</a> 

The <a> tag is used to create an anchor to link from. The href attribute contains the address (URL) of the 
document to link to, and the link text is the text that will be displayed as the hyperlink. A sample hyperlink 
tag is as follows:  
 <a href=“http://www.ccilearning.com”>Visit CCI Learning</a>.  

In the sample, “http://www.ccilearning.com” is the URL, and “Visit CCI Learning” is the link text. 
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Meet the Browser! 
Web browsers (or simply, browsers) are software applications that enable users to easily access, view and 
navigate web pages on the Internet. Browsers allow you to interact with web sites and to experience the 
amazing rich media that is available on the World Wide Web. 

You may be familiar with several browsers, such as Microsoft Edge, Microsoft Internet Explorer, Mozilla 
Firefox, Google Chrome, Apple Safari and Opera. 

While a browser’s primary function is to retrieve pages from a web server and display them on your screen, 
you should understand that browsers are complex software applications that provide a number of services, 
and they can be configured to suit your working style, and keep you safe while you are online.  

Getting Where You Want to Go – The Address Bar  
To visit a web page, you enter its URL into the browser address bar and press ENTER. The browser requests 
the page from the web server, and when it is received, the browser displays the page within the browser 
window. The address bar displays the URL of the page currently displayed in the browser window. If the web 
page includes a title, it is displayed in the window tab. 

 

You can visit any web page by typing its URL into the address bar and pressing ENTER. 

As you navigate to other pages within a web site (or as you visit pages on other web sites), the URL shown 
in the address field updates to show the address of the current page. Most browsers maintain a history of 
URLs that you can access from the address bar. Clicking a URL displayed in the address bar history list has 
the same effect as entering the URL directly into the address bar. 

In addition to displaying the URL, the address bar often includes several buttons. The Internet Explorer 
address bar is shown here: 

 
  

Browser window title bar 
Window tab 

Address bar 
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The Internet Explorer address bar includes the following buttons: 

Search You can search directly from the address bar, instead of first accessing a search engine 
page. Enter your search criteria in the address bar and then click the  (Search) button or 
press ENTER to view a list of web sites related to your search criteria. 

Show Address Click the  (Show Address) button to display a history of the URLs of previously visited 
web sites.  

Security report Click the  (Security report) button to view digital certificates and encryption information. 
This button displays only when you are viewing a page over a secure protocol, such as 
https. 

Refresh/Go Click the  (Refresh) button to re-display or refresh the contents of the current web page. 
The  (Go to) button displays in the address bar while you are typing in a web site address. 
You can click Go to instead of pressing ENTER to go to the site. 

Stop Click the  (Stop) button to halt the downloading of information for a web page. The Stop 
button appears only while a page is loading. 

Browser Scroll Bars 
Browser windows (like other windows you may be used to seeing on a computer screen) support horizontal 
and vertical scroll bars that display when a window is too small to display all the contents of a web page. The 
following figure shows a browser window with a vertical scroll bar.  

 

A scroll bar consists of three parts: an arrow button at each end of the bar, a scroll box, and the scroll area. 
The position of the scroll box within the scroll area provides an approximate gauge of where the information 
currently displayed in the window is in relation to the entire window’s contents.  

When you use a scroll bar to view different parts of the window, the action is called scrolling. Use one of the 
following methods to scroll a window: 

• Click in the lighter shaded area above or below the scroll box to scroll up or down. 

• Click the arrow at either end of the scroll bar to move up or down. 

• Click and hold the mouse button on the arrow at either end to scroll the screen continuously in that 
direction. 

• Drag the scroll box to a specific position in the scroll area to scroll to that location. 

Vertical 
scroll bar 
with Scroll 
box 



Lesson 13 Looking at the Internet 
 

 

424  7500-1 v1.00 © CCI Learning Solutions Inc. 

Studies have shown that most users do not mind scrolling vertically, but they have a strong dislike for scrolling 
horizontally. In response, web site designers create pages that use adjustable formats and layouts that 
respond automatically to changes in the size of the window. As a result, most web pages do not require 
horizontal scrolling, even though web browsers support horizontal scroll bars.  

Standard Windows Control Buttons 
Browser windows include the standard Minimize, Maximize/Restore and Close control buttons in the upper-
right corner. The control buttons change the way a currently open window displays, as follows: 

 (Minimize) Temporarily closes the window, replacing it as a button on the taskbar. Click the 
button on the taskbar to open or restore the window. 

 (Maximize)  Displays the window full screen. 

 (Restore Down)  Restores the window to the size it was before it was maximized. 

 (Close)  Closes the window. 

You can resize a browser window to any dimensions you as you would any other application window. 

Browser Windows (Tabs)  
Modern browsers allow for tabbed browsing. That is, you can view different web sites simultaneously – each 
in its own tab. Opening a new tab is the same as opening a new browser window. Browser tabs are similar to 
buttons in the Windows taskbar. You can open a separate web page in each tab, and switch between them 
by simply clicking on the tab. Only one tab can be the active tab at any given time. 

Working with multiple open tabs allows you to compare information from different web sites, or copy and 
paste information from one web page into another. 

To create a new tab, use one of the following methods: 

• Click the New tab button; or 

• press CTRL+T; or 

• right-click the active tab and then click New tab; or 

• if the Menu bar is displayed, click File and then click New tab. 

In most browsers, when you open a new tab, the browser displays thumbnails of the sites you visit most often 
and/or thumbnails of top sites and suggested sites:  

 
You can click a thumbnail to open that site in the active tab. 
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You can also right-click a tab and select Duplicate tab in the menu to open a new tab that displays the same 
web site. For example, if you are viewing the MSN web site, you could read one article in one tab, open a 
duplicate tab, and then click a link to view a different article on the MSN site in the other tab. 

To view a link on a web page in another tab without leaving the current web page, right-click the link and 
then click Open in new tab. You can then view the contents of two different pages for the same web site. 

To close a tab you no longer want to view, click the  (Close) button on that tab. If you have multiple tabs 
open, you can right-click the active tab and specify to close the tab, or to close all the other open tabs. 

Depending on the browser and how it has been configured, if you have multiple tabs open, and you click the 
Close button for the browser window, you may be prompted to specify whether you want to close only the 
current tab or close all the open tabs. 

Hyperlinks in the Browser 
In the web browser, hyperlinks often display as underlined or colored text. However, hyperlinks are not limited 
to text; pictures or icons or even specific areas on a graphic can be hyperlinks as well. When you view a web 
page in a web browser, hyperlinks behave in a specific manner. When you hover the mouse pointer over a 
hyperlink, the mouse pointer changes to a pointing hand  icon. When you click a hyperlink, you move to 
the web page that is designated as the target of that hyperlink. The web page may be part of the same web 
site, or may be a page on a different web site. 

Some web pages contain links that are not readily visible on the screen until you position the mouse pointer 
over them, but once you see a , you know that you have found a hyperlink. 

 
Sometimes hyperlinks are configured to open the target web page in the current browser window, while 
others open a new tab and then display the target web page within the new tab. Web developers also create 
hyperlinks that will download or copy files from a server onto your computer.  

If you return to the anchor page after clicking a hyperlink, the hyperlink often displays in a different color, 
indicating that it has already been followed. 

Popular Browsers 
There are a wide variety of browsers freely available. Microsoft Edge, Microsoft Internet Explorer, Google 
Chrome, Mozilla Firefox, Opera, and Apple Safari are some of the most popular ones. The following images 
show each of these browsers. Note that although the browsers function in much the same way, a web page 
may appear a little different in each browser. This is because a browser's coding determines how it interprets 
the HTML code used to define a web page.  
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Microsoft Edge 
Developed by Microsoft and released with Windows 10, Edge is Microsoft’s newest browser interface. More 
streamlined than its predecessor, Edge features a reading view and minimalist command buttons. Edge’s 
settings are tied in to the Windows 10 Settings app.  

 
Microsoft Internet Explorer 
Developed by Microsoft, Internet Explorer was one of the first graphical web browsers. It has been included 
with all versions of the Windows operating system since Windows 95. Microsoft Edge is configured as the 
default browser in Windows 10, but Internet Explorer is included as a Desktop app. 

 
Mozilla Firefox 
Firefox was originally developed by Mozilla Corporation and Mozilla Foundation in 2004. It is an open source 
web browser that is free to download. 

 
Google Chrome 
Chrome was developed and released as a stable product in 2008. It was originally available as freeware 
although a large portion of its code was released in 2008 as an open source project called Chromium; newer 
releases of Chrome are based on this version. Note that in Chrome documentation, the address bar is referred 
to as the “omnibox.” 
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Opera 
Opera Software released its web browser as an individual product for download or as part of an Internet suite 
of products. It is one of the original web browsers introduced in 1994 and now is available for a number of 
computing devices, including several mobile devices. 

 
Apple Safari 
This web browser was originally designed for Apple computers and is the most commonly used one for any 
Apple computing device. Safari is also available in a Windows version. 

 
Even though the appearance of each is slightly different from the others, all of them include the same features 
and capabilities. 

Browsers and Page Rendering 
A browser’s job is to read the HTML code, interpret it, and then render the page in your window accordingly. 
However, not all browsers interpret HTML (and CSS styles) in the same way. Sometimes a web page may 
appear differently from one browser to the next. Additionally, not all browsers are coded to handle the latest 
HTML tags. For this reason, certain web page features (for example, floating images or Java) may not function 
in a particular browser. If you have trouble accessing a particular web site feature, using a different browser 
may solve the problem.  

Additionally, keep in mind that browsers are updated fairly regularly and the default setting is to download 
and install updates automatically. Sometimes browser updates change the way certain tags are interpreted. 
You could be visiting a web site that you have used successfully many times in the past, and suddenly 
encounter a problem caused by a recent browser update. Web designers try to keep on top of issues such 
as these, and will often re-write certain areas of a web page to remedy a sudden issue. However, you can 
also try using a different browser. 
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Exercise 13-2: Using a web browser 
This exercise assumes that you have downloaded and installed the Google Chrome web browser, as directed 
in Lesson 5 of Computing Fundamentals. If you prefer to use a different browser, adjust the steps as 
necessary. In this exercise, you will open a web browser, enter URLs, follow links, and open and close browser 
tabs.  

1. Open the Google Chrome web browser. 

2. In the address bar (or omnibox) type: www.ccilearning.com and press ENTER. The browser displays the 
CCI Learning web site. 

3. Click in the address bar to select the current text, then type: www.yahoo.com and press ENTER. The browser 
displays the Yahoo.com web site. 

4. Click the scroll box in the vertical scroll bar, then drag down to scroll the page vertically. 

Now, open two more tabs. 

5. Click New tab to open a new browser tab. 

6. In the new tab, click in the address bar, type: www.tolanoadventures.com and press ENTER to visit the 
Tolano Adventures web site. 

7. Press CTRL+T to open another new tab and type: www.cnn.com in the address bar and press ENTER. 

8. Click the Yahoo tab. The Yahoo page is now the active tab. 

9. Click the Tolano Adventures tab to make it the active tab. 

10. Click the CNN tab and then click the Close button. You should now have only two tabs open: the Yahoo 
tab and the Tolano Adventures tab. 

11. Click the Yahoo tab to make it active. 

12. Scroll to the top of the page if necessary, then move the mouse cursor over the list of words that display 
along the left side of the window. The list begins with the words Mail, News, Sports, and so on.  

 Notice that when you hover the mouse cursor over each word, it displays with an underline and the 
mouse pointer changes to a pointing hand icon identifying the current word as a hyperlink. 

13. Click the link for News to open the Yahoo News page. Notice the links to various categories for news. 
There are also links to stories in the middle of the page.  

14. Click another link to view one of the stories. 

15. Click the Tolano Adventures tab to make it active. 

16. Take a few moments to move the mouse cursor around the screen to see if you can find links on the 
page. The only links on the page are the words –  Home, About Us, Services, and Contact Us – which 
provide navigation in the Tolano Adventures web site. Notice that these links do not appear with 
underlines, but the mouse pointer still changes when you hover over them. The appearance of links is 
left to the discretion of the web page author. 

17. Position the mouse pointer on the Services link, and then click the link. You are now viewing a list of 
services that Tolano Adventures provides. 
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18. Move your cursor to point at the Biking/Cycling Tours link in the list and then click the hyperlink to move 
to this page to view its contents. As you click each hyperlink, the browser navigates to the web page 
specified as the target for that link. 

19. Click the Close button to close the browser window, and specify to close all tabs if prompted. 

Browser Navigation Tools 
Browsers include navigation tools and features which make them easy to use. These include built-in 
navigation buttons, configurable settings, a home page, and various toolbars. 

Back, Forward, and Refresh Buttons 
Although web pages should provide their own navigation tools, every browser includes buttons that allow 
you to navigate among the sites you visit within any given browser session. 

• The Back button moves back one page. The back button becomes active once you click a link or visit a 
different page by typing a URL in the address bar. 

• The Forward button moves ahead one page. The forward button becomes active once you move back 
one page. 

• The Refresh button reloads or re-displays a page. You may want to refresh a page if the content changes 
continuously, or if part of the page failed to load correctly. 

The symbols used for these buttons are fairly universal. The following table illustrates how the buttons appear 
in various browsers. 

Button 
Internet 
Explorer 

Edge Firefox Chrome Opera Safari 

Back 
      

Forward 
      

Refresh 
      

If a menu bar is available in the web browser, it can usually be displayed by pressing the ALT key. You can 
then use the View menu to go to a specific page or to refresh the screen. In general, the menu bar is hidden 
by default because the buttons enable you to navigate or access options faster. 

Home Page and Start Page 
A browser's start page is the page that displays by default when you open the browser. Each browser is 
configured with a default start page, but you usually can specify to show a blank page, or to show the new 
tab page, or to show the tabs from your last browser session at startup instead of the default start page. You 
can also specify a particular web page as your startup page. 
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Additionally, you can configure a browser Home page. The Home page is the page that displays whenever 
you click the Home button on the browser toolbar. That is, you can click the Home button to quickly return 
to the home page, no matter how many other web sites you have visited or how “deep” into a particular web 
site you have navigated.  

In the not-too-distant past, most browsers displayed the Home button on the browser toolbar and 
automatically used the home page as the startup page. Today, it is less common to find a Home button 
displayed by default, although modern browsers still include one and allow you to configure a Home page 
and to configure the Home button to display. You can also specify to use your home page as your startup 
page. Some users consider a browser home page a “relic of the past,” while others could not imagine using 
a browser without one.  

The classic Home button generally looks like a house. The following figures show the Home button in 
Microsoft Edge, Microsoft Internet Explorer, Google Chrome, and Mozilla Firefox. 

 

Microsoft Edge 

 

Internet Explorer 

 

Google Chrome 

 

Mozilla Firefox 

Note: Microsoft Edge, and Google Chrome do not display the Home button by default.  

Settings 
A browser includes numerous configurable settings that control not only its appearance, but its behavior. For 
example, you can configure your browser to block particular types of content, or to reject web site cookies, 
or to open multiple home pages each time you launch it. 

In Microsoft Edge, you access the settings by clicking the  (More) button at the right end of the browser 
toolbar, and then clicking Settings in the menu. The Settings panel opens along the right side of the browser 
window. 

 

In Google Chrome, you access the settings by clicking the  (Customize and control Google Chrome) 
button at the right end of the browser toolbar, and then clicking Settings. The Chrome Settings page opens 
in a new browser tab. 
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In Internet Explorer, you access the settings by clicking the  (Tools) button, then clicking Internet options 
in the menu to open the Internet Options dialog box. You use the various tabs in the dialog box to configure 
Internet Explorer. 

Setting a Home Page in Internet Explorer 
To set your home page in Internet Explorer, click the Tools button, then click Internet options in the menu 
to open the Internet Options dialog box. Home page settings are located on the General tab. 

 
In the Home page section of the General tab, you can: 

• Click in the box and type the URL of the page you want to set as your home page, or 

• click the Use current button to set the currently displayed page as the browser home page, or 

• click the Use default button to reset the browser home page to its default setting, or 

• click Use new tab to display a blank page as the home page. 

Click the Apply button at the bottom of the dialog box to apply your settings, then click OK to close the 
dialog box. You can set multiple home pages by typing separate URLs on separate lines. When you set more 
than one page as the home page, each page opens in its own tab each time you open the browser, or click 
the Home button. 

Setting a Home Page in Microsoft Edge 
To set a home page in Microsoft Edge, click More, then click Settings. In the Open with section, click A 
specific page or pages to make the options available. By default, you can select MSN, Bing, or Custom. Click 
Custom to open a text box into which you can type the URL of the page you want to set as your home page. 
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Enter the URL, then click the  (Add) button to add the URL as a home page. Click outside the Settings 
panel to close it. 

Setting a Home Page in Google Chrome 
To set a home page in Google Chrome, click Customize and control Google Chrome, then click Settings. 
In the Appearance section, click the Show Home button check box to enable the home page settings. To 
specify a home page other than the New Tab page, click the Change link to open the Home page dialog box.  

 
Select Open this page, then type the URL of the page you want to set as your home page, and click OK. 

Exercise 13-3: Navigating in a browser 
In this exercise, you will use various navigation tools and you will configure browser settings.   

1. Open the Microsoft Edge web browser. 

2. Type: www.ccilearning.com and then press ENTER. 

3. Click in the address bar to select the current text, type: www.google.com and then press ENTER. 

4. Click the Back button to move back one page (to the CCI Learning page). 

5. Click the Forward button to move forward one page to the Google page. 

6. Close the Edge browser. 

7. Open the Internet Explorer browser. 
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8. Click in the address bar, type: www.wikipedia.org, then press ENTER to move the Wikipedia page. 

9. Click Tools, then click Internet options to open the Internet Options dialog box. 

10. On the General tab, in the Home page section, click Use current. The text in the list box changes to the 
current URL (https://www.wikipedia.org/). 

11. Click Apply, then click OK. 

12. Press CTRL+T to open a new tab.  

13. In the new tab, navigate to www.ccilearning.com.  

14. In the new tab, click the Home button at the right end of the browser toolbar. The new tab now displays 
the browser home page – the Wikipedia page.  

15. Click the Close button for the Internet Explorer window and click Close all tabs if prompted. 

16. Restart Internet Explorer. The browser opens to the Wikipedia page. 

17. Click Tools, Internet options, then in the Home page section, click Use default to return the browser 
to its original home page setting. 

18. Click Apply, then click OK. 

19. Click the Home button to navigate to the default home page. 

20. Close Internet Explorer. 

Set a home page in Chrome and make the Home button visible. 

21. Open the Google Chrome browser. 

22. Click Customize and control Google Chrome, then click Settings to view the Settings page. 

23. In the Appearance section, click the Show Home button check box, then click the Change link. 

24. In the Home page dialog box, click Open this page, click in the text box and type: www.w3schools.com. 
This specifies the W3 Schools web site as your browser home page. Click OK to close the dialog box and 
return to the Settings page. 

25. In the browser toolbar, click the Home button. The W3 Schools web site displays.  

26. Close the browser. 

Browser Functions and Features 
Objective 3-1.1 

Browsers perform several functions. In addition to retrieving and displaying web pages, and handling 
addressing to allow users to navigate around the World Wide Web, browsers can play media files, upload 
and download content, search for information and bookmark web pages. In the following section, you will 
examine a few of the basic functions of a browser. 

Uploading and Downloading 
The terms uploading and downloading refer to the process of sending information from your computer to a 
server (uploading), and the process of receiving information from a server (downloading). 

http://www.ccilearning.com/
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Many people think of downloading as the act of manually copying specific files, such as music files, 
application files, or document files, from a web site to their computers. While this is true, it is also true that 
every time you visit a web site, one or more pages from the web site are downloaded to your computer.  

Most web pages include several pictures, and these pictures are not part of the page itself, but are stored 
separately on the web server. The web page contains placeholders where the pictures will be inserted when 
they are downloaded from the server. If pictures are excessively large in file size, they may take longer to 
display than the surrounding text. The same is true for multimedia elements such as audio or video files. 

These elements are downloaded automatically, but separately, when your browser loads the web page, and 
these downloaded elements are stored on your hard drive in a special folder designed to hold temporary 
Internet files. Each browser includes a temporary Internet files folder for this purpose. 

File Size and Connection Speed Considerations 
In Computing Fundamentals, you learned that storage capacity and bandwidth (the speed of a network 
connection) are measured in thousands, millions, and billions of bits and bytes. The following tables are 
included for your review. 

File size and storage capacity are measured in bits and bytes: 

Measurement Abbreviation Equal to … 

Bit  A single binary digit 

Byte B Eight bits 

Kilobyte KB 1,024 bytes (a thousand bytes) 

Megabyte MB 1,024 KB (a million bytes) 

Gigabyte GB 1,024 MB (a billion bytes) 

Terabyte TB 1,024 GB (a trillion bytes) 

Petabyte PB 1,024 GB (a quadrillion bytes) 

Connection speed is measured in bits per second: 

Measurement Equal to … 

bps Bits per second 

Kbps Thousand bits per second 

Mbps Million bits per second 

Gbps Billion bits per second 

The speed of your Internet connection, and the file size of the elements on a web page directly affect your 
browsing experience. While image files can be large, audio files can be larger, and video files can be positively 
huge. Understanding relative file size and your connection speed enables you to formulate a realistic estimate 
of how long downloading a particular file may take.  
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The following table (from the Apple support page) compares estimated download times for downloading 
content from iTunes over a 5Mbps connection and a 1Mbps connection.   

File Approximate size 5Mbps 1Mbps 

4-minute song 4MB 4-5 seconds 20-30 seconds 

5-minute video 30MB 30-40 seconds About 3 minutes 

45-minute TV show 200MB 3-5 minutes 15-20 minutes 

45-minute HDTV show 600MB 10-15 minutes 45 minutes – 1 hour 

2-hour movie 1.0-1.5GB 18-24 minutes 1.5 – 2 hours 

2-hour HD movie 3.0-4.5GB 30-70 minutes 4.5-6 hours 

Advantages of Streaming 
In Computing Fundamentals, you learned that streaming is the process of having a file delivered to your 
device in a constant and steady stream. Although you cannot save streamed content, you can see how 
streaming might be preferable to downloading when you want to watch high-definition movies and 
television shows; if you download the content, you may have to wait several hours before you can start 
viewing it, whereas if you stream the content, you can begin watching it immediately. 

Searching from the Address Bar 
While there are several well-known search engine sites on the Internet (you will learn how to use a search 
engine site later in this module), many modern browsers include a search box in the address bar, which allows 
you to search for information without first having to navigate to a search engine site.  

Just click in the address bar and start typing. If you enter a complete URL, you will go directly to the web site. 
If you enter a search term or an incomplete address, a list of suggested search terms appears in a menu.  

The following figures show address bar/omnibox search suggestions presented in Edge and Chrome. 

 
 

Click a suggested search term in the suggestion list to launch a search using the currently selected search 
engine. 

Microsoft Edge, and Microsoft Internet Explorer, use Bing as the default search engine for searching from the 
address bar, while Google Chrome uses Google as its default search engine for searching from the omnibox. 
However, you can specify to use a different search engine. 
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To change the default search engine for address bar searches in Microsoft Edge: 

1. Click More, Settings, View advanced settings 
to access the Advanced settings panel. 

2. In the Search in the address bar with section, 
click Change to open the Change search engine 
panel.  

3. Click the search engine you want to use, then 
click Set as default. 

 

 
To change the default search engine for address bar searches in Google Chrome: 

1. Click Customize and control Google Chrome, 
then click Settings. 

2. In the Search section, click the drop-down arrow 
to the right of Google and select the search 
engine you want to use.  

Note: if you want to use a search engine that is 
not listed, click Manage search engines and 
enter the URL of the search engine you want to 
add to Chrome. 

 

Exercise 13-4: Searching from the address bar 
In this exercise, you will search for information from the browser address bar.  

1. Open the Microsoft Edge web browser. 

2. In the address bar type: weather. Does your local weather display in the list? Most browsers use your 
location information to bring you news and search results relevant to your location. 

3. Look at the results list. Is Bing the search provider?  

4. Delete the text in the address bar, then type: what’s for lunch? What type of results do you see now? 
Are there results that include specific locations? Are there results that show how to say “what’s for lunch” 
in other languages? 

5. Close the Edge browser. 

6. Open the Google Chrome web browser. 
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7. In the address bar type: weather. Do you see similar results to those you saw in Microsoft Edge? 

8. Delete the text in the address bar then type: what’s playing.  

9. Do you see results for nearby theaters/movie houses? 

10. Close the Chrome browser. 

Favorites/Bookmarks 
If you visit a site frequently, you can "bookmark" the site so that you can visit it without having to enter its 
URL. When you bookmark a site, you save the site’s URL in a folder created specifically for storing bookmarks. 
Various browsers give different names to their bookmark folders. Microsoft Edge and Internet Explorer call 
bookmarked sites “Favorites,” while Google Chrome refers to them as “Bookmarks.” 

In addition to storing these URLs in a folder, you can add bookmarked sites to a Favorites bar or Bookmarks 
bar which can be displayed in the main browser window. To access a bookmarked site from a Favorites bar 
or Bookmarks bar, simply click the site name on the bar. 

Microsoft Edge 
In Microsoft Edge, you access Favorites through the “Hub,” which provides access to Favorites, the Reading 
List, your browsing History, and the Downloads folder. To open the Hub, click  (Hub) in the browser 
toolbar. 

 
The number of folders or web sites displayed in the Favorites area in the Hub will vary, depending on built-
in bookmarks that came pre-configured with the browser, and on whether you or other users have already 
added bookmarks.  

Links stored in the Favorites Bar folder display as buttons when the Favorites Bar toolbar is turned on.  

 
Click a button in the Favorites Bar to access the site. 

To bookmark a site in Edge: 

1. Click  (Add to favorites or reading list). A panel opens, allowing you to name your bookmark (you 
can also accept the name suggested by Edge). 
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2. You can also specify where you want to save the bookmark. You can save it in the Favorites folder or in 

the Favorites bar. Click Save to save the bookmark. 

Google Chrome 
In Chrome, saved URLs are called bookmarks. Click  (Bookmark this page) to bookmark the currently 
displayed page. Bookmarks are added to the Bookmarks bar by default. To toggle the display of the 
Bookmarks bar click Customize and control Google Chrome, point to Bookmarks and then click Show 
bookmarks bar. 

 
To bookmark a site in Chrome: 

1. Click Bookmark this page. A panel opens, allowing you to name your bookmark (or to accept the name 
suggested by Chrome). 

 
2. You can also specify where you want to save the bookmark. You can save it to the Bookmarks bar, to the 

built-in Other bookmarks folder, or to any bookmarks folder you may have created. 

3. Click Done to save the bookmark. 

Internet Explorer 
In Internet Explorer, you access Favorites through the Favorites Center, which provides access to Favorites, 
the Newsfeed, and your browsing History. To open the Favorites Center, click  (View favorites, feeds, 
and history) or press ALT+C. 
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The number of folders or web sites displayed in the Favorites pane will vary, depending on built-in bookmarks 
that came pre-configured with the browser, and on whether you or other users have already added 
bookmarks.  

Links stored in the Favorites bar folder display as buttons when the Favorites bar toolbar is turned on.  

 
Click a button in the Favorites Bar to access the site. 

By default, new bookmarks are saved to the Favorites folder. You can also create your own folders for storing 
bookmark links to help keep your links organized. You can then organize your bookmarks into folders, move 
them, or delete them. 

To bookmark a site in Internet Explorer: 

• Click the View favorites, feeds or history button and then click Add to favorites, or 

• press ALT+Z, and then click Add to favorites 

  
Click the Add button in the Add a Favorite dialog box to add a bookmark for the current site to your Favorites. 
The dialog box provides options for specifying your own name for the bookmark link, for creating the link in 
a different folder (such as the Favorites bar folder), and for creating a new folder in which to save the link.  

Once you add a web site bookmark to the Favorites list, you can access the site by clicking its bookmark in 
the Favorites list or clicking the bookmark in the Favorites bar if you saved the link to the Favorites bar.  

Exercise 13-5: Adding Bookmarks/Favorites 
In this exercise, you will add bookmarks and Favorites.  

1. Open the Chrome web browser and navigate to www.ccilearning.com.  

2. In the browser toolbar, click the Bookmark this page button. In the panel, ensure that Bookmarks bar 
displays in the Folder list box, then click Done to add the bookmark. 

http://www.ccilearning.com/
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3. At the right end of the toolbar, click Customize and control Google Chrome, point to Bookmarks, then 
click Show bookmarks bar to turn on the display of the Bookmarks bar. Your new bookmark displays 
in the Bookmarks bar. 

4, Navigate to www.w3schools.com (you can click the Home button to navigate to this site).  

5. Click the Bookmark this page button, type: Web Lessons in the Name box, then click Done. 

6. Navigate to www.howstuffworks.com. 

7. Create a bookmark named How Stuff Works and add it to the Bookmarks bar. 

8. Navigate to www.kayak.com, create a bookmark named Travel and add it to the Bookmarks bar. 

9. Point at the bookmarks on the Bookmarks bar. Notice that as you point at each one, its name and URL 
display in a pop-up box. 

10. In the Bookmarks bar, click Web Lessons to return to the W3 Schools web site. 

11. In the Bookmarks bar, click CCI Learning to return to the CCI Learning web site. 

12. Close the Chrome browser. 

13. Open the Internet Explorer web browser. 

14. Right-click the window title bar for Internet Explorer, then click Favorites bar to display the Favorites 
bar in the window. 

15. Navigate to the sign in page for Microsoft at https://login.live.com.  

16. Press ALT+C to open the Favorites Center, then click the drop-down arrow on the Add to favorites 
button, and click Add to Favorites bar. The bookmark is added. 

17. In the toolbar, click the Home button to return to the browser home page. 

18. On the Favorites bar, click the Sign in to your Microsoft account bookmark. You are taken to the sign 
in page. 

19. Right-click the bookmark on the Favorites bar, then click Rename. 

20. In the New name box, type: Microsoft Sign-In and press ENTER. 

21. Close Internet Explorer. 

Managing Bookmarks 
Browsers include a management tool for working with bookmarks. In Internet Explorer, this is the Favorites 
Center; in Edge, it is the Hub; and in Chrome it is the Bookmarks Manager. These management centers allow 
you to create new bookmark folders, and to move and delete bookmarks. You can launch wizards that help 
you import bookmarks from other browsers. The Google Chrome Bookmark Manager is shown in the 
following figure: 

 

http://www.w3schools.com/
http://www.howstuffworks.com/
http://www.kayak.com/
https://login.live.com/
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Most bookmark management pages and panels work like the panes in File Explorer; you can drag and drop 
bookmarks, and right-click to open shortcut menus. 

Deleting Bookmarks/Favorites 
To remove a bookmark/Favorite, use one of the following methods: 

• Right-click the bookmark on the Bookmarks bar or Favorites bar, then click Delete from the shortcut 
menu; or 

• open a bookmark management page or panel, click a bookmark to select it, then press DELETE.  

Exercise 13-6: Working with Bookmarks/Favorites 
In this exercise, you will manage bookmarks and favorites.  

1. Open the Internet Explorer browser, click the View favorites, feeds, and history button, click the drop-
down arrow to the right of the Add to favorites button, then click Import and export. 

2. Ensure that Import from another browser is selected in the Import/Export Settings screen, then click 
Next. 

3. Select the check box for Chrome, click Import, then click Finish. Internet Explorer should now include 
the Microsoft Sign-In bookmark, and the four bookmarks you added to Chrome. 

4. Open the Favorites Center, expand the Favorites Bar folder if necessary, then click Travel to move to the 
Kayak site. You can click a favorite in the Favorites Center or on the Favorites bar. 

5. Minimize the Internet Explorer window. 

6. Open the Microsoft Edge browser, then click the Hub button, then click the Favorites settings link. 

7. Drag or click the Show the favorites bar slider to set it to the On position. 

8. In the Import favorites section, select the check box for Internet Explorer, then click Import. Your 
bookmarks have now been imported into Edge. 

9. Click outside the Hub to close it. 

10. Test a few of the bookmarks by clicking them on the Favorites bar. 

11. In the Edge browser, right-click the Travel bookmark in the Favorites bar, and click Delete to delete the 
bookmark. 

12. Close the Edge browser. 

13. Restore the Internet Explorer window, right-click How Stuff Works in the Favorites bar, then click Delete 
to delete the bookmark. 

14. Close Internet Explorer. 

15. Open the Google Chrome browser. 

16. Click the Customize and control Google Chrome button, point to Bookmarks, then click Bookmark 
manager to open the Chrome bookmark manager. 

17. If necessary, click the Bookmarks bar folder in the left pane. The four bookmarks display in the Organize 
pane on the right. 

18. Drag the CCI Learning bookmark from the right pane into the Other bookmarks folder in the left pane. 
Notice that the Other bookmarks folder now displays at the right end of the browser toolbar. 
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19. In the Organize pane, click the drop-down arrow to the right of Organize and examine the available 
options.  

20. In the Organize pane, right-click Travel, then click Delete to remove the bookmark. 

21. In the Bookmark bar, click Web Lessons to move to the W3 Schools site. 

22. In the Bookmark bar, click the Other bookmarks folder, then click CCI Learning to move to the CCI 
Learning web site. 

23. In the Bookmark bar, click the Other bookmarks folder, then right-click CCI Learning and click Delete 
to remove the bookmark. The Other bookmarks folder no longer displays.  

24. Close the Chrome browser. 

Synchronizing Bookmarks 
As you can probably imagine, your list of bookmarks/favorites builds up over time. The more you use 
bookmarks, the more you may come to rely on their convenience. You don’t have to remember URLs – you 
simply click a button or favorite link and get where you want to go. 

Suppose you do hours of research for a school project on your home computer, and plan to continue working 
on it during class time. Wouldn’t it be convenient if you had access to the bookmarks/favorites on your home 
computer on the computer you were using in class? 

Or suppose that you are doing research for your job on your office computer, and then come home and 
need to continue your work on your laptop. It would certainly be convenient to access the 
bookmarks/favorites you added to your work computer from your laptop. 

That’s where synchronizing bookmarks comes in handy. In fact, in most browsers, you can synchronize more 
than just your bookmarks – you can synchronize bookmarks, passwords, browser history, open tabs and 
more.  

Chrome, Firefox, Safari, and Opera all offer built-in bookmark synchronization through free online accounts. 
Firefox uses the Firefox Sync account; Safari uses the iCloud account. Opera uses the Opera Link account, and 
in Chrome, you sign in using your Gmail account. 

Once you have created an account, you sign in and specify which items you want to sync across your devices. 
When you use the browser on another device, simply sign in to your account, and all your bookmarks, history, 
and preferences, become available to you on that device. 

In Windows 8.1 and above, synching across devices is built-in. When you sign in with a Microsoft account, 
your PC is connected to Microsoft servers online. This means that your personal settings and preferences are 
stored in OneDrive, and are synced to any PC that you sign in to. 

• Your Start screen layout, chosen colors, themes, language preferences, browser history and favorites, 
and Windows Store app settings are synced between PCs. 

• You can get to and share your photos, documents, and other files from OneDrive, Facebook, Flickr, and 
other services on all your PCs without signing in to each one. 

You can specify which settings to sync, and you can turn off synching for specific settings. You can also turn 
off synching completely. 
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Browser Preferences and Settings 
Objective 3-1.1 

At the beginning of this lesson we spent some time discussing that the Internet is a public, and therefore, 
untrusted network. Accordingly, there are many tools at your disposal for keeping yourself protected while 
you are online. As you learned in Computing Fundamentals, firewalls protect a LAN from unwanted network 
traffic – such as hackers attempting to gain unauthorized access. Antivirus software protects your system 
from viruses, Trojans, and spyware. 

However, your online activity can expose you to other dangers such as identity theft or theft of 
private/sensitive information. The best protection is to keep yourself educated and aware of potential 
dangers and to engage in safe computing. Fortunately, your browser contains several configurable settings 
that can help keep your private information private. 

Handling Pop-ups 
A pop-up is a small browser window that suddenly opens in front of the page you are viewing. Pop-ups 
contain command buttons or options that must be selected before you can continue with the current task. 
Pop-ups can remind a visitor to log on or to enter required information, but they are also used extensively 
for advertising on the web, and many users find them annoying because they remain open until you click an 
option or manually close them. Pop-ups can also be used for phishing (tricking users into sharing sensitive 
information) or for infecting a computer with malware if the user clicks on the pop-up. 

To eliminate the need for interacting with pop-ups, browsers include built-in pop-up blockers. In most 
browsers, the pop-up blocker is enabled by default, and you can fine-tune the settings of the pop-up blocker 
so important messages (for example, log on screens, or session time-out warnings) are allowed to display. 

To access pop-up blocker settings in Internet Explorer: 

1. Click Tools, Internet options to open the Internet Options dialog box, then click the Privacy tab. 

2. In the Pop-up Blocker section, select or clear the Turn on Pop-up Blocker check box, or click the 
Settings button to open the Pop-up Blocker Settings dialog box.  
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Notice that you can add web sites to the Allowed sites list. Pop-up blocking is not enforced on these sites. 
That is, pop-ups are allowed on the sites that you add to the list. 

You can also specify a blocking level of High (which blocks all pop-ups), Medium (which blocks most pop-
ups), or Low (which allows pop-ups from secure sites). 

To access pop-up blocker settings in Google Chrome: 

1. Click Customize and control Google Chrome, Settings, then scroll down and click Show advanced 
settings. 

2. In the Privacy section, click Content settings, then scroll down to the Pop-ups section. 

3. You can select to allow all sites to show pop-ups, or to not allow any site to show pop-ups. You can also 
click Manage exceptions to create a pop-up exception list 

  

To turn the pop-up blocker on or off in Microsoft Edge, click More, Settings, View advanced settings. In 
the Block pop-ups section, drag, or click the slider to turn protection either on or off. 

Cookies 
Cookies are small text files placed on your computer when you visit a web site. Cookies are simple files that 
store information about your preferences. For example, a cookie might be used to store information about 
your actions, such as the options you clicked on the web page, or which browser you used when you accessed 
the site. Cookies can improve your browsing experience by letting sites remember your preferences or by 
allowing you to avoid having to sign in each time you visit certain sites. 

If you configure your browser to allow cookie downloads from web sites, then each time you revisit a site, 
your computer will send the cookie to the web server. Once a cookie is saved on a computer, only the web 
site that created the cookie can read it. 

Although cookies themselves are not dangerous, they can be used to store user names and passwords if you 
click "Yes" when your browser asks you if you want to store this information. Cookies can also track browser 
activities, such as sites you visit and options you select. They can, therefore, be considered a threat to your 
privacy because they can identify certain purchasing habits or interests and this information can be sold to 
vendors who can then market their products to you. 

There are various types of cookies, including: 

First-party cookies – come from the web site you are currently viewing. 

Third-party cookies – come from a web site other than the one you are currently viewing, such as from a 
web site that provides advertising content on the site you are currently viewing. 

Session cookies – are stored only in temporary memory and are erased when you close the web browser. 
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By default, browsers allow cookies. However, you can control how cookies are handled in each browser. 
Depending on security settings, the browser warns users before accepting a cookie, and allows users to view, 
restrict or disable cookies completely. 

Controlling Cookies 
You can control cookie handling in Internet Explorer from the Privacy tab of the Internet Options dialog box. 
In the Settings area at the top of the Privacy tab, click Sites to configure cookie-handling for specific web 
sites, or click Advanced to specify whether to accept, block or prompt when encountering cookies. 

 

 

To configure cookies handling in Microsoft Edge, click More, Settings, View advanced settings. In the 
Cookies section, display the drop-down list, then make a selection. 

 
In Chrome, click Customize and control Google Chrome, Settings, Show advanced settings, then in the 
Privacy section, click Content settings.  

 
Select the appropriate options. You can specify exceptions, and you can click All cookies and site data to 
view a list of all the cookies currently stored by Chrome.  
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AutoFill/AutoComplete 
AutoFill is a browser feature that can automatically fill out online forms with street addresses and credit card 
information. When a browser offers to remember your web site passwords, this is also part of the AutoFill 
feature. While it may be convenient, enabling AutoFill and storing sensitive information in any browser can 
put you at increased risk for identify theft if your system is compromised. 

In Chrome you can configure these settings on the Advanced settings page, under the Password and forms 
heading. In Internet Explorer and Edge, this feature is called AutoComplete. In Internet Explorer you can 
access the settings on the Content tab of the Internet Options dialog box.  

 
In Microsoft Edge, these settings can be accessed in the Advanced settings panel in the Privacy and services 
section. 

 

Browser Cache 
The browser cache is a folder on your hard drive that stores downloaded files (such as web pages, images, 
or fonts). The cache improves your browser’s performance because it allows you to view previously accessed 
web pages without having to request them from the server again. For example, if you click a hyperlink on a 
web page, then click the browser's Back button, the browser can pull the previously viewed page from the 
cache. 
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Note: If you are viewing a page that includes dynamic content, such as the current status of an airline 
flight, and you notice that the information has not changed since you last viewed the page, your browser 
may be showing a cached page. To update the content, click F5 (Refresh) to force the browser to request a 
new updated page from the server. 

When you enter a URL, your browser checks the cache to see if the page is already stored there. If the cache 
contains a recent version of the page, it will display the cached version instead of downloading the page 
from the web again. Loading cached pages is much faster than downloading them from a server. 

When you enter information (such as your name, or address) into forms on web sites, that information is also 
stored in the browser cache. It is convenient to keep this information stored on your PC (the browser can 
complete much of the information the next time you need to enter it), but there are times when you will want 
to delete some or all of your information. For example, if you are using a public computer, you don’t want to 
leave your personal information behind – this information is easily accessible to anyone who has physical 
access to the computer. To remove this information, you can clear the cache by deleting your browsing 
history. 

Browsing History  
Every browser includes a history function that stores the URLs of web sites you have visited in the browser's 
History folder.  

The History folder stores the URLs of sites you have accessed within a defined period of time, and provides 
a convenient way to revisit web sites, especially if you cannot remember the exact URL. The following figures 
show the History folder in Google Chrome, Internet Explorer, and Microsoft Edge. 

Google Chrome 

 

In Chrome, click Customize and control 
Google Chrome, point to History, then click 
History. 

To go to a site, click a link in the list. You can 
also select the check box for a site and then click 
Remove selected items to remove the item 
from the History. 

Internet Explorer 

 

In Internet Explorer, click View favorites, feeds, and history, then click 
the History tab. 

Click a date to expand it so that it displays the sites visited on that day. 
You can click a link to go to the site, expand a site to see the various 
pages you visited, or right-click a link and then click Delete to remove a 
given site from the History. 

You can also display the View By Date drop-down list and specify to 
display the links by site, or most visited, or by order visited today. 
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Microsoft Edge 

 

In Microsoft Edge, click Hub, then click  (History). 

Click the arrow beside a date to expand the list.  

Click the x beside a date to delete the history for that date. 

In an expanded list, click a site to visit it. To remove a site from 
an expanded list, point to the site to display an x, then click the 
x to remove the site from the History. 

Deleting the Browsing History 
If you use the web for a lot of tasks, the History folder can become unmanageably large. A large History 
folder can be difficult to use, takes up considerable disk space, and can slow the browser speed. You can, 
however, clear some of the data, or empty the folder completely. 

Deleting your browsing history also helps protect your privacy, especially if you are using a shared or public 
PC. In most browsers, when you delete your browsing history you can also delete temporary Internet files, 
cookies and web site data, form data and stored passwords.  

To delete your browsing history in Chrome, click Customize and control Google Chrome, Settings, Show 
advanced settings, then in the Privacy section, click Clear browsing data.  

 
Notice that you can specify what to remove, and for which time frame. Time frame options in Chrome are: 
the past hour, the past day, the past week, the last 4 weeks, the beginning of time. 

Configure the options as desired, then click Clear browsing data once more. 
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In Internet Explorer, click the Tools button, point to Safety, then click Delete browsing history.  

 
Each option is described in the Delete Browsing History dialog box. Select the options you want, then click 
Delete to remove the specified links and files. 

Private Browsing  
Browsers provide private browsing options that allow you to surf the web without saving any information 
about your browsing. That is, your actions are not captured in the browsing history, and no cookies, form 
data or search history is recorded during a private browsing session. 

Private browsing sessions in Google Chrome take place on “incognito” tabs.  

• Click Customize and control Google Chrome, then click New incognito window.  

• On a mobile device running the Chrome browser, click the Menu button, then click New incognito tab. 

Private browsing sessions in Internet Explorer and Microsoft Edge take place in “InPrivate” tabs. 

• In Microsoft Edge, click the More button, then click New InPrivate window. 

• In Internet Explorer, click the Tools button, point to Safety, then click InPrivate Browsing to open an 
InPrivate tab. 

To stop browsing privately, close any open private browsing tabs. 
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Extending Browser Functionality 
Objective 3-1.1 

When the Internet was new, most web sites featured text and not much more. Over time, as technology, 
infrastructure and local processing power has increased, the World Wide Web has exploded into an arena 
filled with pictures, animations, audio, video, social and interactive activities.  

When browsers were first designed, their focus was to help you read the text on web sites. Because web sites 
have changed and improved over time, special applications have been developed to help you extend the 
functionality of your browser so that you can enjoy the latest online features. 

These browser extending technologies come in the form of plug-ins/add-ons, and in-browser apps. 

Plug-ins/Add-ons 
In order to present the interactive multimedia so abundant on the web, a browser may require applications 
that extend its usability. These applications are called plug-ins or add-ons. The terms plug-in and add-on are 
generally used loosely and mean essentially the same thing – they refer to applications that extend the 
abilities of the browser. These extension applications could be made by the company that made the browser, 
or by other companies or individuals. 

In some circles, plug-in is the term to use when referring to third-party applications that will work on most 
popular browsers. Generally, these are full software applications that run in their own windows. Adobe Flash 
Player, Windows Media Player, Microsoft Silverlight, and Real Networks RealPlayer are examples of popular 
plug-ins. When you visit a web site and your browser encounters a file type that it cannot natively support, 
you may be prompted to download and install a plug-in/add-on so you can properly experience everything 
on the web page. 

Plug-ins generally have a particular file type associated with them. For example, Windows Media Player can 
be used to play files that include the .wma (Windows media audio) and .wmv (Windows media video) file 
name extensions. The player also supports several video and audio file formats (such as .avi, .mpeg, .midi, 
.wav). 

Add-on is the term to use when referring to browser-specific applications that generally modify the browser 
interface. For example, a Google Search toolbar, or a Firefox theme are examples of add-ons. Add-ons 
designed for use in a particular browser cannot be used in another browser; however, most are available in 
various versions. For example, there is a Google toolbar add-on for Firefox and for Internet Explorer. 

Remember that the terms are used loosely and often interchangeably. To make things a little more confusing, 
within the various browsers themselves the terms add-ons, extensions, plug-ins and apps are all used to refer 
to these applications. 

In-browser Apps 
An in-browser app is a web-based type of browser extension – it is designed to extend the functionality of a 
browser by linking it to a web service. For example, the Pocket app (https://getpocket.com) is an app/service 
for managing a reading list of articles from the Internet. It is available for Firefox, Chrome, Internet Explorer, 
and Edge. 

https://getpocket.com/
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Sometimes we surf the web and find articles that spark our interest, but time constraints may prevent us from 
reading these articles immediately. If you have added Pocket to your browser, you can simply click the Add 
to Pocket button to save the article. You can even add tags. 

Later, when you have time to read your saved articles, you can open your Pocket list and select the article(s) 
you want to view. 

 

Web Standards 
Objective 3-1.1, 3-2.1 

In order to make web sites easy to use and navigate, and to provide a uniform surfing experience, web site 
designers and authors follow basic standard conventions that make the user comfortable when visiting a new 
site. These conventions include items such as a navigation bar, breadcrumbs, and standardized use of the 
mouse. 

Additionally, most sites are structured in a standard fashion so that users know what to expect before they 
even visit. 

Site Home Page 
Typically, the first page you see when you access a web site is the top level page, called the home page or 
index page. The home page serves as the "starting point" for a web site. Usually, a home page contains links 
to all the other pages on the web site – allowing you to navigate to different areas. In a well-designed web 
site, each lower-level page includes a "home" link that will return you to the web site's home page with a 
single click. In many web sites, you can click the company logo to return to the site Home page.  

Keep in mind that a web site home page is not the same as a browser home page. The browser home page 
is the web site that the browser displays automatically when you begin your browsing session. Each web site 
you visit has its own home page. 
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Regardless of whether you are on a site’s home page, or on a page buried deep within the site’s structure, 
you will find that most pages contain many common elements. Some of the most common are pointed out 
in the following figure: 

 
Common elements include: 

Logo – Well-designed web sites feature the company logo on all the site pages. Usually it is located in the 
upper-left corner, and usually all instances of the logo are hyperlinks to the site Home page. 

Images/Videos – Web pages often contain graphics or photographs that may be static (unchanging) or 
dynamic (a slide show of several pictures displays in the given location). Some web page designers also 
embed videos that run directly in the web page. Pictures can also be used as links to other web pages. 

Buttons – A button is an interactive graphic that performs an action when you click it. In the web page shown 
in the preceding figure, the Click to Learn More button is a hyperlink to another page on the web site. 

Navigation Bar – The navigation bar provides the primary means for moving around the web site and major 
areas of the web site are usually represented on it.  

Menus – Navigation bars often feature pull-down menus that allow a user to navigate directly to a specific 
page. For example, in the preceding figure, there are three pages in the About Us area of the web site: 
Contact, Careers, and Blog. 

Pull-down menu 

Navigation Bar 

Logo 

Image/Video 

Buttons 
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Navigation Bar 
Well-designed web pages include a navigation bar (usually down the left side or across the top of the page) 
that provides links to various areas of the web site. A navigation bar is similar to a table of contents for the 
site; it shows users what is on the site and provides a way to get them there.  

A well-designed navigation bar should always be the primary means of navigation for a web site. The web 
page shown in the preceding image includes a navigation bar across the top. 

Breadcrumbs 
A “breadcrumb” (or “breadcrumb trail”) is a type of secondary navigation scheme that shows the user’s 
location in a website. The term comes from the Hansel and Gretel fairy tale in which a brother and sister drop 
breadcrumbs on their trek into the forest in order to form a trail back to their home. Just like in the fairy tale, 
breadcrumbs offer users a way to trace the path back to their original landing point. 

Breadcrumbs are useful in websites that have a large amount of content that is organized hierarchically. 
Usually, they display as text links separated by “greater than” symbols (>) or slashes (/); these separate the 
levels and indicate the level of a particular page relative to the page links beside it. The following figure (from 
the Newegg web site) shows that the current page displays chassis designed for servers. In order to get there, 
the user had to visit the computer hardware page, and then the servers and workstations page, and finally 
the server chassis page. 

 
The user can easily return to the computer hardware page in one click by clicking “Computer Hardware” in 
the breadcrumb trail. Note that the breadcrumb trail displays on the web page itself; it does not display in 
the browser address bar. 

The CCI Learning online store site uses slashes in its breadcrumb trail. The breadcrumb trail shown in the 
following figure indicates that the user is currently on the Excel 2013 Expert page. In order to get there, the 
user had to visit the Microsoft page, then the Microsoft Office Specialist page, then the Office 2013 page, 
and finally the Microsoft Excel 2013 Expert page.  

 
Not all web sites include breadcrumbs because not all sites are arranged in hierarchical levels. Breadcrumbs 
do not make sense on web sites with a simple structure. 

Widgets 
Some web sites include web widgets (or widgets for short). A widget is a small self-contained program that 
a web designer can add to a web page. The widget runs inside a container, and the content for the widget 
comes from an outside source, but is displayed within its container on the web page. 

Widgets display live, dynamic content and they are used to provide additional functionality to a web page. 
There are widgets for weather forecasts, news feeds, headlines, stock prices, clocks, event count-downs, flight 
information and so on.  

If you have a personalized web page, such as a page on a social media site or a blog, you can add widgets 
to your web page.  
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When you add a widget that pulls content from other sites (such as a stock ticker, or RSS feed widget), you 
should understand that you do not have control over the content, and you cannot modify the source of the 
content. The content is pre-determined and pre-published by the publisher/author/service provider of the 
widget. 

“Standard” Pages 
The layout and design of a web site is in the control of the web designer; however, there are a few standard 
pages that you may expect to see when you visit most commercial web sites. These include: 

About Us  This page gives information about the company that owns the web site. Often this page 
includes contact information, links to social media pages, employment opportunities, and 
perhaps information about the company philosophy and its owners/directors. 

Privacy Policy  Any site that collects personal information should provide a description of how they use 
your personal information.  

Login page  Sites that allow access to secure areas (such as for the purpose of shopping online) usually 
provide a page for signing in to your account.  

Online store  Sites that allow you to make purchases over the Internet host online stores. These may be 
subsections of the main web site, or may be entirely separate sites that you can access 
from the main site. 

Using a Mouse on the Web 
Most web sites treat mouse movements and clicks uniformly so that the user does not have to “learn” how 
to interact with each individual web site. The HTML5 standard makes it easy for web developers to capture 
and respond to various mouse events. 

The following table describes how mouse actions are generally used in web pages: 

Single click Use a single click to follow a link, or click a button to perform an action.  

Double-click Many users double-click links even though a single click is all that is necessary. If you 
double-click within the web page text, you can select a word. Sometimes double-clicking 
can cause difficulty when using an online store – for example, double-clicking a “Place 
Order” button may result in a double order, depending on how the web page handles 
double-click events. In some online store web sites, a place order button is temporarily 
disabled immediately after a user clicks it; this allows time for the transaction to take place 
and to supply visual feedback to the user. 

Delayed click  
or long press 

Holding down the left mouse button on a link or clickable button generally has no result 
until you release the mouse button. On a touch screen device, however, a long press may 
open a shortcut menu, or it may select text and offer to copy the selection to the clipboard. 

Pointing When you hold the mouse pointer over some web elements (such as links in a navigation 
bar) you may be able to view the contents of a pull-down menu or the target of a hyperlink. 

Mouse Over A mouse over is a special effect that displays when you pass or point your mouse over a 
specific object on the screen. Popular mouse over effects are to change the appearance of 
a button or link, or to display a drop-down menu. 
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Drag and Drop HTML5 supports drag and drop. That is, you can drag an object from one place on a web 
page and drop it into another location. This is useful for games, or online testing situations 
where you might need to match a phrase with its definition. 

  

Exercise 13-7: Exploring a web site 
In this exercise, you will explore the Nestlé company global web site.  

1. Open the browser of your choice and navigate to www.nestle.com. If a message box appears suggesting 
that you visit the web site for Nestlé in your country to find coupons, recipes, and promotions, click Close 
to stay on the global site. If necessary, close the About cookies on this site message box. 

2. In the navigation bar across the top of the home page, click About us to go to the About us page. Notice 
the left side navigation panel with links to various pages within the About us section of the web site. 

3. In the left side navigation panel, click the Quality and safety link.  

4. In the sub-menu that opens in the navigation panel, click How we ensure food safety. Notice the 
breadcrumb trail that displays just below the top navigation bar and just above the social media links. 

5. In the breadcrumb trail (Home>About us>Quality and safety>How we ensure food safety), click About 
us to return to the About us page. 

6. Near the top of the About us page, point at each of the social media icons. Notice that the URLs for 
Nestlé’s social media pages display in screen tips near the bottom of the browser window. 

7. Slowly drag your mouse across the links in the navigation bar. What effect is used to make the navigation 
links seem interactive? 

8. Drag your mouse over the elongated rectangle buttons on the right side of the page. Are special effects 
added to these elements as well? 

9. In the search box at the top of the page, type: cocoa processing then press ENTER. Notice that by default 
the search results page lists results only from this site, but that you can also search all Nestlé corporate 
sites. 

10. In the search results page, click Nestlé launches The Cocoa Plan to view an article contained in the 
media section of the web site. 

11. At the top of the page, click the Nestlé logo to return to the home page, and close the message box if 
necessary. 

12. Scroll to the bottom of the home page, then click Privacy to open the privacy policy page. Scroll the 
page and take note of the three videos that answer different questions about the company privacy policy. 

13. At the far right, click the Feedback button to open a form that you can fill out and submit. Companies 
often welcome feedback through their web sites. 

14. Click the Close button (x) at the upper right corner of the feedback form. 

15. Scroll to the bottom of the page, then click Cookies to open an informative page on how the web site 
uses cookies and other tracking technology. 

16. In the navigation buttons at the right, click the Contact Us button to access the Contact Us page. Notice 
the links for job search, FAQs, consumer services and more.  

17. Close your browser. 

http://www.nestle.com/
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Lesson Summary 
In this lesson, you learned about the nature of the Internet and about the role and function of web browsers. You 
should now be able to: 

 describe the nature of the Internet 

 describe packets and how they make their way across 
the Internet 

 differentiate between public and private networks 

 specify a network location in Windows 

 describe the function and characteristics of IP 
addresses 

 understand the Domain Name System (DNS) 

 describe domain types 

 identify parts of a URL 

 differentiate the Internet from the World Wide Web 

 describe the role of HTML, CSS, and hyperlinks 

 use a web browser 

 describe different web browsers 

 work with browser settings 

 describe browser functions and features 

 use bookmarks/favorites 

 handle pop-ups, cookies, and he browser 
cache 

 understand browser extensions 

 describe web site/web page standards 

Review Questions 
1. Your computer wants to send a request for a web page to the web server at CCI Learning.com. Which 

address information will your computer include in those packets? 
a. The web server’s IP address. 
b. The web server’s name. 
c. The street address where the web server is housed. 
d. The web server’s domain name. 

2. Which service enables users to access web sites by domain name instead of by IP address? 
a. DHCP c. DSL 
b. DNS d. CSS 

3. Consider the following domain name:  www.ccilearning.com. Which of the following is the top-level 
domain? 
a. www c. com 
b. ccilearning d. The entire name is the top-level domain. 

4. What can you surmise from the following URL: https://bountifulbaskets.com.  
a. A user may be paying for a purchase. 
b. A user may be uploading a large file. 
c. A user may be downloading a large file. 
d. A user may be streaming a video. 
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5. Which of the following statements is accurate? 
a. HTML may be external or internal. 
b. CSS styling information should be added to the foot section of an HTML document. 
c. HTML and CSS allows web page designers to separate content/structure from presentation. 
d. All of these statements are true. 

6. Which keyboard combination will open a new browser tab? 
a. CTRL+N c. CTRL+W 
b. CTRL+T d. CTRL+X 

7. Which of the following is a web browser? 
a. Gmail c. Google Docs 
b. Google Drive d. Google Chrome 

8. Which of the following data transfer speeds is the fastest? 
a. 30,000,000 bps c. 300 Kbps 
b. 700 Mbps  d. 0.5 Gbps 

9. Which of the following items would take the longest to download? 
a. A 50,000KB video. c. A 0.5 GB video. 
b. A 60MB video. d. There is no way to tell. 

10. Ann visited a site last Tuesday which contained a meatloaf recipe that she really wants to try, but now 
she can't remember the URL. What should she do? 
a. Conduct a new search for meatloaf recipes and hope that she can find this one recipe again. 
b. Click the browser's Back button until she gets back to the page she wants. 
c. Click the browser's Refresh button. 
d. Look for the URL in the History folder. 

11. Kevin was paying bills in his online banking site when he was timed out without warning. What might he 
need to do to prevent this from happening in the future? 
a. Adjust his pop-up blocker settings. 
b. Upgrade his browser. 
c. Switch to a different bank. 
d. Adjust the way his browser handles cookies. 

12. Cookies are: 
a. text files  c. Trojans 
b. an example of malware d. viruses 

13. What is the purpose of a browser cache? 
a. To store keys that are used for encrypted transmissions. 
b. To improve browser performance. 
c. To store sensitive information. 
d. To upload information to a server. 
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14. What is the purpose of browser plug-ins and add-ons? 
a. To improve browser security. 
b. To encrypt wireless transmissions. 
c. To extend the functionality of a browser. 
d. To upload information to a server. 

15. Which action is usually used to select an option in a web site menu? 
a. Single click c. Mouse over 
b. Right-click d. Double-click 

 



 
7500-1 v1.00 © CCI Learning Solutions Inc.  459 

Living Online 
 
 

Lesson 14: 
Managing Media Literacy 
Lesson Objectives 
This lesson teaches you how to use the information you may find online in a respectful and legal manner. Upon 
completion of this lesson, you should be able to: 
 search for items on a specific web site 
 search for items using search engines 
 use tools to narrow the search criteria 
 evaluate the validity of the information 

 understand what copyright and fair use includes 
 understand what intellectual property is 
 recognize censorship or filtering 
 understand what plagiarism is 

Searching for Information 
Objective 3-1.1 

Millions of web servers worldwide are connected via the Internet. On average, each server hosts one thousand 
or more web pages. 

No organization monitors the information on the Internet, which means you will find both good and 
questionable information there. Use your own discretion to determine what is appropriate viewing or what 
information is valid. 

One of the main purposes of creating a web site is to share information with others. The design of the pages 
on a site will vary depending on the organization and the purpose of the business or service. Many sites 
include a search field somewhere along the top or along the left side of their web pages. You can use this 
search field to search the web site for specific information. Using the search field on a web page searches 
only that web site to which the page belongs; this is different from searching the entire Internet for 
information on a specific topic. 

Additionally, different types of sites contain different types of information: 
 Business web sites usually include pages that describe the company and its products or services, as well 

as areas for feedback or online purchases.  
 Government web sites tend to include pages for each department, and additional pages with links to 

files or forms that you can download.  
 Social networking sites such as Facebook or Twitter enable subscribers to share photographs, games 

and videos, chat online, or post simple messages.  
 Blogs allow individuals to enter and share comments, experiences or information on pages devoted to 

specific topics.  
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 Wiki sites are used as sources of information and provide tools that enable individuals to add, edit or 
rearrange information on the site.  

 Other sites allow individuals to upload multimedia items such as photographs, video, audio and 
podcasts. For example, YouTube includes both professional and amateur created videos.  

 YouTube also welcomes uploads in the form of podcasts (audio files made available on the Internet for 
downloading. Often they are set up as discussions that can become episodic based on feedback). Anyone 
with an appropriate multimedia program can record audio, video, or both and save the files in a format 
that will be recognized as a podcast.  

 News-related sites syndicate their breaking stories as RSS feeds, making current news available as it 
occurs (rather than at set times as on television, radio, or in print). Users can subscribe to one or more 
newsfeeds at no cost to get current news delivered to their desktop or mobile devices. RSS content can 
be  viewed via a newsreader or RSS app.   

 Sites designed to provide reference links can be found on individual web sites or set up as part of a 
search engine web site.  

 Education web sites are available on the Internet; sites with an .edu domain are generally associated with 
an accredited school such as a university, high school, or college. These sites contain a wealth of 
information pertaining to curriculum planning, lesson plans, and may contain examples of reports or 
exams in addition to a list of resources for particular course types.  

When searching for information, also consider using traditional sources such as the public library or a local 
university. Traditional sources like these still offer a wide variety of information in the form of periodicals, 
microfiche, reference books, and other types of publications that may not be available online. 

All these methods to search for information are designed to provide you with alternatives when researching 
or acquiring knowledge on a specific topic. As you will see in forthcoming portions, you can search for items 
on a global basis or you can narrow the search to target a specific subject, in a specific context.  

It is recommended that you compare the information you find on various sites to determine its accuracy 
before using the information in a report or project. In fact, in some cases, you may want to verify the 
information you find online with information you find in a more traditional source such as an encyclopedia 
or journal, especially if the topic is fact-based and easily verifiable. 

One of the fastest ways to search for information is to use a search engine or search field on a particular web 
site. Any criteria you enter in a particular web site’s search field will provide results from this web site only. 
This can make it much easier to search for information on a specific topic, service or item that is sold or 
provided by this company. The location of the search field will vary from site to site, although it is generally 
located near the top of the web page. For example, you can go to Microsoft’s web site to find the information 
you want about the pricing structure and the applications included at each pricing level of Office 365. 

Using Search Engine Technology  
Objective 3-1.1 

The purpose of any search engine is to provide links to information stored on other web sites. You come to 
a search engine site to pose a question; the search engine responds by displaying links with possible answers.   
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An Internet search engine has three basic tasks it can perform: 
 search the Internet for pages that contain words relevant to the search criteria you enter 
 build and maintain an index of key words 
 display links to information that match the search criteria 
A search engine web site specializes in making it easy to find information on any topic, located anywhere on 
the Internet. Some commonly used search engines at the time of this writing are Google, bing, Ask and 
Yahoo!. 

Although the services provided by these companies vary, they all use similar technology. The search engine 
maintains a database of Internet URLs; each record in the database includes the URL, a short description, a 
title, keywords, and other site information. Users access the URL database via the search engine company’s 
web site, 

A search field on the search engine company’s web site works in the same way as a search field on an 
organization’s web site. The difference is that the search engine company’s web site searches its database, 
compiles a list of records matching the keywords, and returns a list formatted as a web page. 

Using Search Engines 
To start a search, start your web browser, click in the Search field and enter your search criteria or keywords. 
The Search field may appear on the search engine’s home page, or the web browser’s home page. 

Depending on the web browser, the options selected, and whether the keywords you enter are similar to any 
you have entered previously, a list of suggested search terms may appear as you begin to enter text in the 
search field.  

 
If one of these items matches what you want to find, you can: 
 Click the item in the list, or 
 use the DOWN or UP key to move to select the item, then press ENTER to accept the selection. 

You can also simply finish typing your criteria and press ENTER or click the button to the right of the search 
field to begin the search. Sometimes, as you type your criteria, the search engine will insert suggested text 
into the search field as you type. You can press ENTER to accept the suggestion or continue typing. These 
features are part of a browser’s AutoComplete option; a web browser can be set to remember all entries until 
and unless they are deleted. 

When you click the Search button or press ENTER the search engine checks its database and displays the 
results. 
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Most search engines rank the URLs they retrieve by how closely the information associated with that URL 
matches the keywords entered in the search field. Those that rank the highest are listed at the top of the 
search results.  

Note: Sometimes web sites are written to include hidden keywords or tags simply for the purpose of 
making the site appear in a search results page. For this reason, some sites will appear in a list of results 
even though they do not seem to be related at all to the keywords or search criteria entered.  
Typically, results number in the hundreds of thousands, or even millions. 

Sometimes a search results page will include an area for related searches (as shown in the previous figure), 
and sometimes a search results page may feature excerpts from a particular web site in a panel on the right 
(as shown in the following figure).  

 

Web Site 

Description 

Title and Link 
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Narrowing the Search Results 
Chances are, you will not want to take the time to read through 100,000 results, much less click the links and 
check out the pages. Fortunately, you can use several methods to narrow your search results. 

One easy way to narrow your search results is to indicate that you want the results to include only specific 
file types such as images, newsfeeds, or videos. For example, you could narrow the search to videos if you 
were looking for videos on how to fix a cell phone; or you could limit the results to image files if you want to 
find pictures of a famous 17th century painting, and so on. 

You can do this by entering the search criteria and then clicking the link for the type of results you want to 
see. For instance, the following image shows a request for any videos on how to fix a cell phone: 

 

Using Boolean Operators 
If you type in only one or two keywords, the search engine will look for all matches of either word, and that 
will return tens of thousands of matches, most of which may not be relevant! Being specific with your search 
criteria is highly useful. 

 Choose more specific keywords; for example, typing satellite images of great wall of china is an effective 
way to narrow a search and produce better results than just typing great wall of china. 

 Use keywords to find a specific item; for example, entering lemon dessert recipes will bring results for this 
topic, whereas lemon recipes will bring results for any type of recipe that uses lemons. 

You can also use Boolean operators in your search criteria to narrow the search results. These operators 
include: 
AND – Connect keywords with “AND” when you are searching for multiple terms in a single document; your 
search will include only documents that contain all your search terms. An example of this would be a search 
for pastries recipes AND lemon would display results for any pastry recipes that include lemon as part of the 
recipe. 
OR – Search for documents that include one or another of your search terms, such as soccer leagues national 
OR international will produce a list of either national or international soccer leagues. 
NOT – Use in conjunction with “AND” if you want to exclude certain results from your search; for instance, 
dwarf planets NOT Pluto would show results for information on dwarf planets that does not include Pluto.  
NEAR – Use to look for terms in the same document that are within ten words of each other.  
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Using HTML Objects 
Since most information searched comes in the form of web pages using HTML, it is possible to use some of 
the HTML objects in searches. Some examples would include: 
anchor – tours anchor:craters will find any pages with hyperlinks to any tours featuring craters. 
host – hockey  host:rogers.com will find pages about anything to do with hockey with the phrase 
“rogers.com” in the host name of the web server. 
image – craters image:siberia will find web pages containing images for the craters in Siberia. 
link – surface link:microsoft.com displays any pages about the Surface tablet with links to the Microsoft 
web page. 
site – gs5 site:ccilearning.com displays any pages about the GS5 certification from CCI Learning’s web site. 

Advanced Search Pages 
Another method to narrow the search for information is to use a search engine's advanced features. For 
instance, the following figure shows the advanced search features for the Google search engine, accessed 
through the Settings button at the far right of a results page. Notice the various fields you can use to find 
specific information: 

 
Most search engines allow you to specify search criteria such as file format, domains, text characters, web 
sites, or file size. Note the number or type of fields you can use to narrow the search will vary from one search 
engine to another. 

Searching Social Media Sites 
Objective 3-1.1 
Social media sites are web sites where users can share information, pictures, ideas, or opinions about anything 
with others who are also registered with the same social media site. These sites are created using specialized 
software applications that enable users and organizations to exchange information.  

Some of the most popular social media sites include Facebook, Twitter, LinkedIn, Instagram, and YouTube. 
One of the reasons that social media sites are so popular is that they make it easy for you to share pictures 
and video (not only on your PC but on your mobile devices as well) with your friends and followers. 
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If you work a lot with social media, you may want to find ways to find items quickly, such as topics that may 
be popular or “trending”, use the hashtag to search through the most popular social media sites to find 
postings to review. You may also want to check if a hashtag exists already to ensure you are not inadvertently 
using a hashtag that is not relevant to your post. 

Hashtags 
On social media platforms, hashtags label and indicate the subject matter of certain conversations that are 
taking place. A hashtag is a word or phrase preceded by a number sign or hash symbol (#). For example, 
#BreakingBad, #OrganicFoods, and #ComicCon2016 are examples of hashtags. Notice that a hashtag can 
include letters and numbers, but cannot include spaces or punctuation.  
The minute you turn a word or phrase into a hashtag, you turn that word or phrase into a searchable link. 
Hashtags are used to index keywords or topics and allows you to organize content and track discussion 
topics based on those keywords.  
Hashtags make it easy to follow topics you are interested in because you can click a hashtag to see all 
tweets/posts that mention the subject. For example, the popular hashtag #ThrowbackThursday is used to 
label posts of old photos uploaded to social media sites on Thursdays. If you label your post with the 
#ThrowbackThursday hashtag, anyone who clicks on the hashtag will see your post in the list of searchable 
results. 
Hashtags that become very popular appear in your Twitter feed as Trending Topics. Hashtags are supported 
on Twitter, Facebook, Instagram, Vine, Google+, Tumblr and Pinterest. 
As the use of social media has extended into business and marketing, hashtags can be used for several 
purposes. 
 Hashtags can be created for the purpose of generating interest for a specific topic or market. For 

example, #edchat was created with teachers in mind, and has become an area for discussions and 
opinions on issues and trends happening in education.  

 Hashtags can be created to advertise upcoming special events. People can follow the event hashtag to 
get the latest news and information, or to find out whether certain questions or topics were discussed at 
that event.  

 Hashtags can use used to create “shout-outs.” For example, the hashtag #greathaircut #moz would tell 
others that you are posting about the great haircut you received at a hair salon called MOZ. 

When you create a Twitter account, you must create a handle (that is, a user name) by which you will be 
recognized on Twitter. People will interact with you and include you in conversations using your handle. Any 
references to a Twitter handle begin with @. 
 A handle typically reflects the profile name used, such as @ccilearning for CCI Learning Solutions, @CBS 

for CBS News, @RealGeorgeEads, and so on.  
 Since you can create Twitter handles for your business, they are often used as a method of branding and 

marketing or to generate interest in particular names, such as @Barbie, @BillGates, @ForceAwakens, or 
@StarWarsEvents. 

A number of hashtag tools already exist based on popular topics or people; as such you may want to find a 
list of hashtags to see what has already been created, or to create your own. Some of these sites include: 
 Hashtags.org 
 Hashtagify.me 
 Topsy.com 

 RiteTag.com 
 Hootsuite.com 
 TweetCaster.com 
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Use these sites to help you market yourself or your products/services by searching for popular hashtags that 
may exist in your location or culture. For instance, you may want to search for hashtags that include popular 
trends for a specific aged consumer group. Once you have your list, you can begin to generate marketing 
tweets that will generate more interest to your target audience. 

Exercise 14-1: Searching the Internet  
In this exercise you will search for information on specific web sites, and on an Internet search engine, and 
compare the type of results you receive. 
1. Start the web browser and in the address bar, type: www.ccilearning.com and press ENTER. 

 You should now be at the main page for CCI Learning. 

Suppose you want to see if there was any training material for Excel 2013. 

2. Click the Shop Online button on the right side of the page to access the online store and view the 
available products. Notice the Search For Products search box in the upper right region of the page. 

3. In the Search text field, type: Excel 2013 and press ENTER. 

4. Click any item to see the information for this search. Click Back to return to the results page. 

Now try searching on a different web site to see how search results display there. 

5. Close the browser tab for the online store, then select the current URL in the Address Bar and, type: 
www.microsoft.com and press ENTER. 

 Notice that on the Microsoft.com page, the search field is closer to the top for quick access.  

6. In the search field, type: Excel 2013 and press ENTER. 

  
Note: The appearance of your results page may vary from what is displayed here as Microsoft updates their 
web pages on a constant basis. As well, the pages may vary depending on your location. 
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 The search results don’t seem to be very helpful, do they? Because Microsoft is so large, they use a 
number of linked web sites and web pages to manage the products and services they offer. We entered 
our search criteria on the “front page” of the Microsoft site. The results we see are portals into other 
areas of the site. To search for “Excel 2013” effectively on a site this large, we would first have to navigate 
to a page devoted to Office products.  

Now try using a search engine to find other information on a web browser. 

7. Select the URL in the address bar, then type: www.yahoo.com and press ENTER. 

 Notice the directory listing of categories of general interest topics, as well as the location of the Search 
field.  

8. Click News in the left panel or the top navigation bar.  

 Yahoo! now displays a web page that lists the most recent news headlines. As with other web sites and 
web pages, you need only click the link you are interested in viewing. 

9. Click the Back button to return to the Yahoo! home page. 

Try viewing the contents of one of the other categories. 

10. From the Yahoo! sites area, click Movies. 

 You should now be viewing a page of movies that are currently playing in theatres or coming soon.  

11. Click Home to return to the main Yahoo! page. In the search field near the top of the screen, type: dwarf 
planets. 

 Notice some of the options that appear below the search field to help you narrow the search. 

  
12. Click dwarf planets in our solar system. 

 A page with a list of results should now display. By entering specific search text, you are asking the search 
engine to focus on a specific topic instead of displaying a list of all web sites that contain the words, 
dwarf planet. 

13. Scroll the page to see the list of results. 

14. Click the Images link. 

 Yahoo! now displays a page of pictures only. These results are different from the previous results page 
because you narrowed the results to include only pictures matching the search criteria, not text. 

Now try searching the same criteria in a different search engine to see what options are available. 
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15. Press CTRL+T to open a new tab in the web browser. Then in the address bar, type: www.google.com and 
press ENTER. 

16. In the Search field, type: dwarf planets in our solar system and click Search (or press ENTER). 

 Notice the number of results in the list. Suppose you want to see the images instead. 

17. Click the Images link. 

 Notice that many of the images are similar to those found with the Yahoo! search engine. Differences 
between search engines are often found in the tools they offer to narrow down search results. 

18. Click the Search tools button and review these links, listed just below the search field.  

  
 Use these links to help you narrow the search based on a specific requirement, such as the size of the 

image. 

19. Click the arrow for Size and then click Medium to show those pictures of this size. 

Note: The number of images that appear will vary based on when you perform this exercise. 

20. Click any image on the page to enlarge it and read the information that displays about the image so you 
can decide whether you want to use it.  

One thing you may have noticed is the Safe Search button near the top of the links list. In this case, it has 
been turned on (default) to prevent inappropriate images from appearing as part of the search results. When 
you turn this feature off, you will be asked to accept a set of terms indicating you are at least of legal age 
and also agree to the terms of service. Each web browser has an option similar to this to prevent inappropriate 
information from being displayed when a search is performed. 

21. Press the HOME key to move quickly to the top of the page. Then click the Safe Search button (far top 
right of the screen) above the images. 

  
 Depending on what you were searching for, this option could help eliminate pictures that include 

obscene words, pornographic images, and so on. 

Now try searching a different topic and then refining the results. 

22. Click All to return to the initial results page. Then in the search field, replace the text with: crater tours 
and press ENTER. 

 Notice the number of results that display on your screen. You should be able to see a number near the 
top of the results list that tells you how many matches Google found for this criterion. 

23. In the search field, click at the end of the existing text, press SPACEBAR and type: siberia OR australia. 
Press ENTER to begin the search. 
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 The results page should include a fewer number of results than the first search, and should include only 
results related to crater tours in either Siberia or Australia.  

Now try performing an advanced search using keywords. 

24. Delete the current text in the search field, then type: Caravaggio site:louvre.fr and press ENTER to 
begin a search of any collections by Caravaggio that may be displayed in the Louvre Museum of France. 

 Notice the list of results is quite manageable and matches the specifics you included in your criteria. 

25. Click the Images link at the top of the screen. 

26. Click Search tools to display a new bar of options to help narrow the search. 

27. Click Size, click Larger than, and then click 1024x768. 

 Did the list of images change? The more criteria you add in the search, the narrower the list of results 
can become. 

28. Press CTRL+T to open a new tab and type: bing.com in the address bar for the new tab. 

29. In the search field, type: craters anchor:Siberia and press ENTER. 

 The list of results should contain only those matches where craters were found in Siberia. 

30. Click one of the items from the Related searches list. 

 Notice how bing navigates to a modified search results page and provides other related searches in the 
list, in addition to a new list of results at the left. 

31. Delete the current search criteria, and in the search field, type: windows 10 site:microsoft.com and press 
ENTER. 

 You should now have a list of various pages on the Microsoft.com web site that contain information 
about Windows 10. 

32. In the search field, type: #disneycruise and press ENTER. 

 You should have a list of results for Disney Cruises including vacation packages and the web site 
dedicated to this topic. As you scroll through the list, you should notice there are results from social 
media sites such as Twitter. The number and variety will vary at the time you perform this exercise. 

33. Close the web browser and specify to close all tabs if prompted. 

Researching Information  
Objective 3-1.1 

With web design software becoming easier to use, it is now possible for virtually anyone to quickly create 
and publish information on a web site. However, with no international body to apply quality control to this 
information, it is up to you to evaluate the quality of any information you find on the web. 

Web sites owned and maintained by well-known organizations usually present accurate information as their 
reputation is at stake. However, it is important to be alert to bias via omission of opposing views. Web sites 
of lesser-known organizations or individuals can sometimes present novel ideas or perspectives, but 
problems with accuracy and (to an even greater extent) bias must be considered. 
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When researching information on the Internet, do some “comparison shopping”; always visit a variety of web 
sites and compare the different information they provide on similar subjects.  

After researching and finding certain facts repeated on several web sites that seem reliable, you may want to 
go to the local library to find documents, sources, journals, or reference materials to validate your Internet 
research. In general, consider the web an excellent place to begin, and think of printed materials as providing 
support for what you’ve learned online. 

So how can we evaluate the quality of information found on the Internet? As part of your evaluation, include 
factors such as accuracy, authenticity, objectivity, currency (how up to date is the information) and coverage, 
or AAOCC. 

Exercise 14-2: Researching  
In this exercise you will take a look at how different search results can display a variety of information that 
may or may not be relevant to the topic you are researching. 

1. Open a web browser, if necessary. In the address bar, type: www.bing.com and press ENTER. 

2. In the search field, type: ninth planet and press ENTER. 

 A list should appear with a variety of results, ranging from information about the possibility of a ninth 
planet in our solar system along with pictures for the discovered new planet.  

3. Click the link that will take you to the Wikipedia site and then read some of the information there. 

 Wikipedia is an example of a site where information and reference links can be found but the contributors 
of the information are individuals who want to share information on a topic. As a result, there is no 
guarantee that the information is current or totally accurate. For example, if you were to search for a 
famous person on Wikipedia, most of the information there will be accurate but there may also be some 
misinformation based on unverified events in that person’s life, for example, alleged illegal actions by 
the military during World War I. 

Let’s now take a look at how Wikipedia could have helped you research the term “ninth planet”. 

4. In the search field in Wikipedia, type: ninth planet, but do not press ENTER. 

  
 Wikipedia displays a list of suggestions in a similar manner to a search engine. Wikipedia is an example 

of an online encyclopedia and may be an excellent place to begin researching a topic.  

To demonstrate how different domains can display different types of information, try navigating to a different 
web site and researching the same topic. Suppose you had come across a site when researching but wanted 
to read the information in the wiki site first; now you are ready to view the information on the alternate site. 

5. In the address bar, type: www.encyclopedia.com and press ENTER. Then in the Search field, type: ninth 
planet and press ENTER. 

6. Scroll through the page to see the contents and compare it to what you saw in Wikipedia. 
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 What do you think of the information you presented here? Is there solid information that you can use or 
does this site show mostly advertising? Which site do you think would provide more accurate 
information? 

Now let’s try entering search criteria for another topic. 

7. Navigate to: www.bing.com and type: superheroes around the world as the search criteria. Press ENTER. 

8. Take a moment to review the results and try to determine which ones might contain accurate information 
and which ones might be based on opinions or judgments of society. 

9. Click Images at the top of the screen to narrow the results to show only image files. 

 Even when viewing images, some of these may seem to be have a different agenda than what was being 
searched. Remember that the results are based on your keywords and on the entries in the search engine 
database; you may see images that don’t seem to fit the search criteria because some web designers 
“stuff” popular keywords into their web pages so that they will be included in search result pages. 

10. Click Videos to take a look at the video files that meet the search criteria. 

 Notice how you can narrow the search by using an option above the videos (such as video length, or 
source). At first glance, how accurate do these videos appear in relation to the search criteria? 

11. Click Web once more and click one of the result links. Then look at some of the links above the article 
(or elsewhere on the page) to see what or who they might reference. 

 When researching information, it is important to look at all the different sources available to you so that 
you can compile a fair and accurate report. You may find that viewing some of the videos may reveal a 
different perspective on the topic and open other areas you may want to investigate. This is an example 
of why you want to ensure you have as many resources as possible to help you evaluate information for 
its validity, reliability, and credibility. 

Try another web site where information has been contributed by users. 

12. In the address bar, type: www.wikihow.com and press ENTER. 

 Notice the difference in display from this wiki site to the previous site. This does not make this site better 
to use or easier to navigate; however, it does illustrate how attractive a site can be with pictures and easy 
to identify links. You would, of course, need to evaluate the information presented on this site using the 
same criteria as you would use to evaluate information found on any other site.  

13. Click one of the tiles with a title you find interesting. Scroll up and down on the page, noting items on 
the screens such as the advertisements, navigation bar, and social media links. 

14. Close the web browser. 

Validating Resources 
Objective 3-1.1 

As you visit various sites to conduct research, consider the validity of each site. 

 Look for obvious errors in facts, statistics, grammar, spelling, or language use.  
– For instance, if a company web site contains numerous spelling errors you might conclude that not 

much effort has gone into creating the web site, which may lead you to question the effort that has 
been put in providing the information. 
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 How current is the web site?  
– Check when the site was last updated. It may be fine that a web site for a company that sells seasonal 

items hasn’t been updated recently, but a reputable news site or travel agency should be updating 
their information at least daily. If they are not, you have reason to question the reliability or relevance 
of the information. 

 If a web page offers facts and statistics, one way to determine their accuracy is by checking the author’s 
and publisher’s qualifications.  
– Who published this author’s work and what is the relationship between the author and publisher?  
– Visit the About Us, Mission, Philosophy, Corporate Profile, and Background pages of the web site. 
– Follow any links to review additional information that assists in authenticating the author’s 

credentials and the material presented. Links that are broken or lead to pages that are no longer 
available may call into question how up to date the information is.  

– Other links that appear legitimate may actually take you to a page or site that contains offensive 
content or sells another product or service. The webmaster or person in charge of the web site 
should be checking links occasionally to maintain the company’s credibility and reliability. 

 Use the URL as an indicator of whether the web site is affiliated with a recognized organization or 
institution as opposed to a group or individual without established credibility. 
– If a reputable organization reproduces information from other sources, it is more likely to ensure 

the information is faithful to the original than to be found altering material, either out of carelessness 
or a desire to support a certain viewpoint.  

 The presence or absence of source references can help you assess the authenticity of material on the 
web. If a web site “quotes” information on a subject without providing the source of the information so 
you can check up on it, you have to wonder if the content has been altered or if it is being quoted out 
of context and without the original author’s permission.  
– Be sure to research any articles listed to determine if they are factual; articles can be written for a 

variety of reasons, and are not necessarily based on facts.  
– A trustworthy article will also be referenced by other people or organizations on their web sites. 

 If a site claims to offer technical expertise, check the source references if available.  
– Specific articles or reference papers do not need to be cited; but including a link to the source lends 

credibility to the web site. 
 If you are viewing blog or wiki content, remember that authors need no qualifications to contribute.  

– Even though wiki content is reviewed by members of the public for accuracy, it is always wise to 
“comparison shop” and try to verify the information on more than one blog or wiki, as well as on 
related web sites. 

 It is unlikely that you will come across information from any source that contains no bias of any type. 
However, reliable authors and web sites strive to inform their audience with accurate facts and statistics.  
– A bibliography or source list with links to other sites is a good indicator of the openness and 

objectivity of the information. Be sure to check a few of these links, even if available only in traditional 
paper format, and read the full articles to determine if the information here is fact or fiction.  

 Look for depth of coverage of the topic,  supported by other types of information.  
– Is the web site or author associated with other reputable organizations?  
– Do these organizations have credentials that support their ability to provide unbiased information?  
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– What types of sponsored advertisements or links appear on the site?  
– Who owns the products or services being advertised on this web site? 

 Many organizations offer accurate information on their web sites, but their agendas are well known to 
be biased and the information they provide is unbalanced. There is nothing wrong with stating an 
opinion as long as it is represented as such.  
– Any arguments should be supported with documentation; if the topic is controversial the 

presentation should provide viewpoints on both sides of the issue.  
– Check if the site offers an area called a forum where people can leave messages or posts. Read some 

of the posts to see if there is a balance of positive and negative comments, people offering facts 
versus opinions.  

– In general people sign up on forums that are of interest to them; however, it doesn’t guarantee that 
everyone who posts is an expert in that field, having both factual experience and education to back 
up their comments. 

 Check the tone of the message. Is the page factual and informative or does it seem more persuasive? If 
humor is used, do you find it effective or does the tone seem sarcastic or exaggerated? 

 Is there advertising on the page, and if so how much? Do the ads seem independent of the content or 
are they selling similar or complementary products or services? Is this really a site that provides objective 
information, or is there a commercial bias?  
– Ads are usually an indicator that a vendor wants to attract your interest in their products, which 

means they have paid the organization in order to be able to advertise on this site. In some cases 
this may not influence you but it may also cause you to be more discriminating about doing business 
with this organization. 

 How did you find the site? If a site has a good ranking in many search engines, this may indicate effort 
invested in the design and maintenance of the web site.  
– This is not necessarily a reliable indicator of information quality as some organizations pay to get 

good rankings. 
 If you have any questions or doubts about the content on a web site, check to see if the author or 

publisher can be reached by phone, mail, or email and contact them directly with your concerns. 

Exercise 14-3: Validating resources  
In this exercise you will compare information on various sites and try to determine what information to 
include in a research project. 
1. Open a web browser, if necessary. 
2. In the search field, type: how good are tannins and then press ENTER. 
 As you review the results, you should notice that the majority of results relate to specific food products 

while others may refer to reports about tannins in general. 
3. Click one of the results for tannins in tea, and then take a few moments to review the contents on that 

page. 
 What do you see on the page that may convince you of the article’s accuracy? Or do you see things that 

make you doubtful? Can you tell when the page was written or last updated? Are there citations for 
photos, charts, or other images? Are there ads? 
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4. Go back to the main results page and click one of the Wikipedia links. 
5. Take a few moments to review the contents and if possible, compare what you see here to what you saw 

on the previous site. Do you think one is more accurate than the other? Does one site give you more of 
the type of information you might be interested in? Which site would you consider to have more accurate 
facts? 

 There is no easy answer for determining which site might be more accurate or be more factual; this is 
where further research becomes important. In this particular case, the sites likely present similar facts 
and determining which is “better” is not an issue. But what would you do if one site says one thing, and 
another site says the opposite? Before finalizing any report where your Internet research has turned up 
conflicting “facts,” always turn to a trusted resource such as a published book for more information and 
draw your conclusions after consulting the trusted resource.  

Understanding Copyrights Issues 
Objective 3-1.1 

Information on the Internet is freely available for you to read, listen to, or otherwise enjoy. People create web 
sites for many reasons – to advertise, to educate, to entertain, to intellectually challenge. However, simply 
because information is presented on a web site which you can access freely, that does not imply that 
information is free for you to copy, use, distribute or present as your own. 

Intellectual Property 
Any created work or invention is considered to be the intellectual property of the person (or organization) 
who created it. Essentially, anything created by an individual or group on their own behalf is owned by that 
individual or group; anything created by an individual or group under contract to an organization belongs 
to the organization that paid the “fee for service.”  

Estimating the true value of intellectual property is not an easy or straight-forward task. For example, suppose 
ABC Company develops a training course on repairing an automobile device that converts voice to a text 
messages. How much is this intellectual property worth? Is it worth the cost of one book? The cost of enough 
books for an average Service department? The cost of conducting the training class itself? The cost of three 
years of classes? How do you factor in the time and money spent on creating ABC Company's particular style 
and method of instruction? Has the style and method evolved over several years of improving previous 
works? 

As another example, consider that Peter has spent 10 years writing a musical. How do we calculate the value 
of this creative work? Do we factor in the software he used? Do we factor in years of musical training seminars 
that helped him refine his approach? Do we factor in the number of people who ask if they may stage and 
perform the opera? 

The point is intellectual property is highly valuable, and it is often equally difficult to calculate the degree of 
loss or damage incurred by the individual or organization whose property was stolen. While it may seem like 
a small thing to "borrow" all or part of someone else's intellectual property, misusing it amounts to theft or 
piracy, and in some cases even industrial espionage. 
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Copyright 
Copyright laws were created to protect intellectual property. Copyright refers to the protection of any 
material, published or unpublished, created by an individual or organization. This applies to books, music, 
videos, essays, white papers, pictures, software programs, web sites, and so on. 

A copyright gives you ownership of your intellectual property. It can cover anything that you create – a 
painting, a photograph, a song or a book – if you created it, you own it. Copyright law grants you, and you 
alone, specific rights over your intellectual property. For example, you have the right to make and distribute 
copies of your work, perform or display your work publicly, or create additional works based on the original. 

These are your rights alone. No one can make a copy of your painting, use your web site code on their web 
page, or perform a song written by you, unless you give your specific consent. 

A copyright also gives you the exclusive right to sell your work. While it is difficult to determine the value of 
a work, the copyright guarantees that you and you alone have the opportunity to sell, lease or otherwise use 
your work in exchange for compensation. 

As soon as an original work is fixed in a material form (a picture is painted, or a poem is printed, or a piece 
of code is saved to a disk), the work is protected by copyright. Generally, copyright protection begins from 
the date the work is created, applies for the entire lifetime of the author, and extends fifty years after the 
author's death. 

When you have created an original work, it is advisable to put a copyright notice at the bottom. The notice 
includes the copyright symbol ©, followed by the date of creation, followed by your name. For example: 
Copyright © 2016 Nick Klassen. This is sufficient for asserting a copyright claim if someone violates your 
rights. For instance, if someone posts your song on their web site without your permission, you can make a 
claim and they will be forced to remove it. 

However, if you want to be able to sue an offending party for monetary damages, then you should register 
your copyright with the copyright office in your region. For instance, to register a work with the U.S. Copyright 
Office, submit a completed application form, a nonrefundable filing fee, and a nonreturnable copy or copies 
of the work to be registered.  

Copyrighted Material on Web Sites 
Material presented on a web site is subject to the same copyright rules as information in any other media. 
As a rule, information is copyright-protected. 

You can use copyrighted material only if the creator grants you the right to use it. Depending on the material, 
this could mean paying a royalty, or it could mean acknowledging the creator when you reproduce that 
content in your own work. It is your responsibility to determine what is required before using any part of an 
original work. 

Fair Use 
You are permitted to view the information published on a web site but restrictions apply to the way you use 
it. That is, you are limited to “fair use,” which means that you can use portions of copyrighted information for 
the purpose of criticism or comment without seeking permission from the rights-holders. For example, if you 
are writing an essay on the results of a particular court case and want to comment on the judge’s report, you 
can copy and paste the report from the web site with quotes and a reference. It does not matter whether 
your comments are positive or negative; the fair use principle protects you. 
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Copyright implicitly belongs to the owner of the web site or published material, even if no copyright symbol 
(©) or text appears on the product. The originator may have a patent on the product or technology, meaning 
that person has exclusive rights to make, use, or sell this product or technology. They may choose to license 
or grant you specific rights, but you cannot advertise the product or technology as your own. An example of 
this would be the Macintosh computer where Apple owns the patent for this computer and licenses 
information for the computer to programmers who want to create software for it. 

If you wish to use information but are unsure about the copyright situation, send the web site owner an email 
asking for permission to use the information and describe how you intend to use it. 

Some web sites allow you to use the information they provide as long as you quote it accurately and give 
them credit. However, you must be careful about this as the web site owner may not be the original creator 
of the information, and therefore does not have the legal right to grant permission. 

The following is a list of sources you can research for more information on copyright or trademark laws, and 
what is applicable in your location: 
 http://whatiscopyright.org  
 http://www.copyright.gov (United States Copyright Office)  
 http://www.copyright.com (Copyright Clearance Center, Inc.)  
 http://www.tmexpress.com (Trademark Express)  
 http://fairuse.stanford.edu (Copyright and Fair Use at Stanford University Libraries)  
 http://strategis.gc.ca/sc_mrksv/cipo (Canadian Intellectual Property Office)  
 http://www.iipi.org (International Intellectual Property Institute) 
 http://www.wipo.int (World Intellectual Property Organization) 

Legal Ramifications of Copyright Infringement 
If you are found to be in violation of a copyright, you will receive a letter from legal sources asking you to 
remove the content if it is on your web site, or delete any files that you downloaded such as songs, movies, 
television shows, and so on. You may also find that the ISP has terminated all services for your account, and 
there is the possibility you may be sued for any damages and have to pay a monetary settlement to the 
copyright owner. 

Licensing 
Licensing occurs when you are given permission to use a particular product or service from a vendor. For 
example, Microsoft incorporates items considered to be part of a Creative Commons license with a note 
indicating your responsibility to respect the rights of others when you use an item from the Internet. The 
license agreement states that you will not resell these files or claim these as your own works. 
When you purchase a software program, you are purchasing a license to install and use that program. 
Licenses come in a variety of forms, based on the number of computers that require this software to be 
installed.  
Note: For more information on how to obtain or install software, please refer to Computing Fundamentals, 
Lesson 5. 
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Single Seat 
 When you purchase a software program, you are purchasing a license to install and use that program on 

one computer only. The traditional method of purchasing software is to obtain the program on DVD 
with a booklet with instructions on how to install and use the program. 

 You can also purchase and download software online. In such cases, you pay for the program, usually 
with a credit card, and then receive separate emails from the vendor confirming the purchase and 
providing a license number, often called the product code or key code. 

Volume or Network 
 An organization or company with a large number of users for a software program at various locations 

will usually purchase this type of license instead of individual copies.  
 The number of systems onto which the software can be installed is determined by the terms of the 

volume license. This option is cost-effective as buying licenses “in bulk” is less expensive than purchasing 
individual licenses.  

 This option is also cost-effective in reducing the amount of time a network administrator must spend 
installing the software on company systems because most volume licensed software can be installed 
from a central network location to remote computers throughout an organization. Network-based 
installation also eliminates the need to carry the software media around, thereby reducing the possibility 
of damage or loss. 

Site  
 This grants the purchaser permission to use the software on a network at a single location (site), with an 

unlimited number of end users. A site license usually allows you to copy and use the software on multiple 
computers at a single site.  

 It is more expensive than purchasing a single copy but less expensive than purchasing a copy for each 
computer at the site. There may be a maximum specified number of simultaneous users. 

Software as a Service (SaaS) or Application Service Provider (ASP) 
 Software is sold as a service that enables you to access and use a software program from your system 

via a network, the organization intranet, or the Internet. You are required to log on to the appropriate 
network using a valid ID and password before you can access the software. 

 Once a SaaS contract expires, you can no longer access that software until you renew the license. 
Managing the licenses is usually handled by a network administrator in an organization or by an ASP. 

Shareware  
 Shareware programs are usually available for you to try out for free for a limited amount of time. After 

the trial period, you can pay a nominal fee and continue using the program. In some instances, the trial 
version has limited capability, and once you pay the small fee, the restrictions are removed and you can 
access all the program features.   

Freeware  
 Freeware programs are available without charge and may also be shared with others at no charge. A 

potential drawback to using Shareware or Freeware is that support is often limited or non-existent and 
you are not automatically entitled to updates. 

Bundling  
 Software can also be “bundled” with a computer purchase. Some of these programs may require you to 

purchase a full version of the program or to register online before you have access to the program, while 
others may include the full version and require no further action on your part.  
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Open Source  
 Programming code is made available to anyone; you can modify the program to suit your needs and 

also share your version with others; however, you are not permitted to charge anyone for it. The feature 
that distinguishes Open Source programs is that, by sharing the programming code as well as the 
program itself, users who like certain programs can build in new functions and also make them available 
to others. 

Whichever way you obtain software, it is your responsibility to ensure you are observing the licensing rules. 
When you purchase licensed software, you will be notified by the vendor of any updates and you will be able 
to obtain them at no additional cost. If you use software without a valid license, you are violating the vendor’s 
copyright and could be subject to legal action. A network administrator is aware of this responsibility and 
should take the necessary steps to ensure there are enough licenses for each computer in the organization. 
By accepting the End User License Agreement (EULA) at the time of installation, you further agree to abide by 
the rules for using the software on the computing device. 

Piracy 
Piracy is the unauthorized use or reproduction of someone else’s work.  

 If your friend buys and installs a software application and then gives the installation disk to you and you 
install it and use it on your computer that is piracy. 

 If you download a song from a “sharing site” instead of purchasing it from the record label’s online store, 
that is also piracy. The same is true for movies. 

Piracy is considered a federal crime and can carry a penalty of up to ten years in prison. 

Censorship and Filtering 
As the Internet does not have a governing body that oversees the content placed online, there are many gray 
areas concerning what is considered good or bad material. This gives rise to debates over whether 
information should be censored or filtered with the intent to protect users from what may be considered 
offensive or dangerous information (such as how to make a bomb). Accordingly, many ISPs and organizations 
make use of different tools to help reduce certain types of information from being accessed. 

 Blockers and filters - Software that enables you to control the type or amount of content that can be 
viewed; these are often used in academic or corporate organizations to limit or block access to specific 
information.  

 Blacklisting – this is the act of putting a person (or a web site or domain) on a list that will deny them 
specific privileges or service. A network administrator can add certain sites or domains to a black list and 
any traffic from these sites will be blocked from entering the network; you can create a black list for your 
browser that blocks traffic from specific sites or domains. On a larger scale, ISPs can block traffic to and 
from specific sites and domains. They can also deny services to users who are blacklisted. 

Arguably, the use of filters and blockers can be called censorship; however, one must also consider that an 
institution or organization has the right to enforce whatever guidelines it deems suitable concerning the use 
of their equipment and services. For instance, a company may filter Internet content coming into the network 
to prevent users from downloading software that has not been authorized; or a company can block access 
to Facebook to prevent employees from using Facebook while they are at work.  
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It is legal and appropriate for an organization to restrict access to specific sites to protect the reputation of 
the organization and avoid offending any customers or visitors to the organization’s site. If you are using a 
computer that is owned by an organization, you are required to respect and adhere to the organization’s 
computing policies, regardless of your personal preferences. Any questions or concerns about these policies 
can be directed to the network administrator. 

While filters and blockers can prevent specific types of information from coming into a network (that is, these 
tools effect the people within the organization), these tools have no effect on the people outside the 
organization who share content that is considered questionable. 

There is much disagreement concerning who should decide what constitutes offensive, dangerous, or 
exploitive information. For example, some web sites support a particular race or lifestyle and are often 
considered to be controversial or to promote “hate.” The owners of these web sites are choosing to express 
their views through a medium that is available to anyone with Internet access, and in many countries, they 
are exercising their right of free expression. Unless a web site is deemed to have promoted an illegal action, 
the owners of the web site cannot be forced to shut down the site or to change their message. 

The world consists of people from various cultures, beliefs, and lifestyles; what one person considers 
inappropriate or offensive may not be recognized in the same manner by another person. For example, some 
countries block their users from accessing any web sites outside their country because they feel this is best 
for their residents while other countries consider this an extreme form of censorship. Note that a governing 
body that has censored content for the entire country usually has control over all the Internet-connected 
computers in that country. 

Another shortcoming associated with the use of filters and blocks is that sometimes users are able to hack 
into the blocker or filter software and change the configuration. Vendors of the filtering software must, 
therefore, constantly upgrade their product to protect against hacking. 

Plagiarism  
Plagiarism occurs when you use information created by another person and present it as if it were your own 
work, either word for word or with minor changes. 

 The concept of plagiarism also applies to images. Many images that you find on the Internet are 
copyrighted. That means, the person who created the image (or took the photo) is its lawful owner, and 
you must obtain the owner’s permission if you want to use the image in your own work. 

 It is easy to find information on the Internet to use in your document, and just as easy for someone else 
to find it and recognize your use of it as plagiarism. There is also a wide availability of plagiarism 
detection tools that can be used to review files. Plagiarism is the same thing as theft. It does not matter 
that it is only a paragraph of text or a single picture; it is still stealing the original work of someone else. 

 When using information from the Internet, always use it in its original form and cite the source material. 
This means, give credit to the person who wrote it. There are numerous places where you can find 
information on how to correctly insert citations or reference material in a document. 

Failure to recognize and adhere to the laws surrounding plagiarism can lead to consequences such as a 
failure mark for a course, suspension or expulsion from the school, ruined academic reputation, or in the case 
of a business, legal action.  
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Exercise 14-4: Avoiding plagiarism  
In this exercise you will examine information that should be cited. 

Suppose you had to write a report based on a particular novel, Lord of the Flies. You need to also include 
reviews on the book made by publishers, users, and then your own opinion of the book. 

1. Open a browser if necessary, and in the address bar, navigate to www.barnesandnoble.com and press 
ENTER. 

2. In the search field, type: lord of the flies and press ENTER. 

3. Click the version that has the cover of a large fly in golden tones, and a pair of glasses between the book 
title and the author name. 

  
4. Scroll down the page until you see the Overview heading. 

 Notice in this area you can read information about the plot of the book, as well as read rated reviews by 
others who have read the book (usually located below the description of the book). This information is 
very valuable as it meets the criteria for the report. However, do not take your information from only one 
source. Additionally, if you use one of the reviews from this web page, make sure you give credit to 
Barnes and Noble. Even though the review is by an individual, it is located on the Barnes and Noble web 
site. Fair Use allows you to include the review in your report, as long as you give credit to the store and 
cite the web site as the source of the information. 

5. Navigate to www.amazon.com, type: lord of the flies in the search field there, and press ENTER. 

6. From the results list, click the same edition of the book that you used previously. 

7. Scroll down to see the reviews listed on this site. 

 Again, if you were going to use any of these reviews, remember to give appropriate credit by indicating 
where you found the information.  

8. Navigate to www.bing.com, in the search field type: review of the lord of the flies book and press 
ENTER. 
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 You should now have a long list of various sites that contain reviews of this book. Accordingly, there are 
a number of sources available to you on the Internet to use when researching an item. Be careful of how 
you use the sources and ensure you do not copy a review word-for-word without providing credit to the 
author or web site; otherwise you have just plagiarized someone else’s work. 

Lesson Summary 
This lesson taught you to you how to use the information you may find online in a respectful and legal manner. 
You should now be able to: 
 search for items on a specific web site 
 search for items using search engines 
 use tools to narrow the search criteria 
 evaluate the validity of the information 

 understand what copyright and fair use includes 
 understand what intellectual property is 
 recognize censorship or filtering 
 understand what plagiarism is 

Review Questions 
1. What kind of sites would contain comments or information on pages devoted to specific topics? 

a. Social networking  c. Wikis 
b. Blogs   d. News feeds 

2. What is one of the fastest ways to search for an item on a specific web site? 
a. Use a search engine such as Google.com or Bing.com. 
b. Use the web browser search field. 
c. Use the search field on that specific web site.  
d. Use the search field from the Start menu. 

3. What does the search engine maintain? 
a. Database of Internet URLs.  
b. Database with all the web pages in your country. 
c. Database with all the web pages on the Internet. 
d. Database of all the music files on the Internet. 

4. How would you select an item that appears in a drop-down list while you are typing items into the search 
field? 
a. Press the F2 key to move to the item. 
b. Press the PGUP or PGDN key to move to the item. 
c. Double-click in the search field. 
d. Click the item in the list. 
e. Any of the previous. 

5. Which Boolean statement would display results that will list golf courses where playoff tournaments 
occur but not include those played in Europe? 
a. golf courses OR playoffs NOT europe 
b. golf courses OR playoffs AND europe 
c. golf courses AND playoffs NOT europe 
d. golf courses AND playoffs OR europe 



Lesson 14 Managing Media Literacy 
 

 
482  7500-1 v1.00 © CCI Learning Solutions Inc. 

6. Which HTML object will help you find results for links to museums in Paris? 
a. museums image:paris 
b. museums anchor:paris 
c. paris anchor:museums 
d. museums links:paris 

7. What is the benefit of using a hashtag to search for an item? 
a. Results will include postings made on social media sites. 
b. You limit the search to social media sites only. 
c. You can enter any text for the hashtag to find existing postings. 
d. The hashtag limits the search to items posted during the last week only. 

8. Why should you compare different sites when researching information? 
a. To enable you to place the copyright © symbol at the bottom of your report. 
b. Comparing facts presented on different sites helps you determine their accuracy and validity. 
c. You need to show at least five resource locations in the bibliography. 
d. To check that each site was created in the same location. 

9. Which of the following would not be considered as intellectual property and could be used by anyone 
without permission? 
a. Company logo 
b. Corporate Mission (print and online) 
c. Picture of a device created by a company 
d. Product created by a company 
e. Grocery list on a sticky note 

10. If a company has numerous branches across the country as well as offices in other countries, what type 
of licensing should be obtained for the company computers? 
a. Site    c. Premium 
b. Network or volume   d. Open Source 

11. What does blacklisting refer to? 
a. The act of deleting someone from your list of contacts. 
b. The act of adding a sender to your trash folder so you no longer see their messages. 
c. The act of putting someone on a list that will deny them specific privileges or service.  
d. The act of adding someone to your Safe Senders list.   

12. When does plagiarism occur? 
a. When you log into a web site using someone else’s account. 
b. When you copy someone else’s work as your own and take credit for the work. 
c. When you sell your own work to someone else to use. 
d. When you sell your login ID and password to someone else. 
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Living Online 
 
 

Lesson 15: Digital 
Communication 
Lesson Objectives 
In this lesson, you will learn about various digital communications technologies. Upon completion of this lesson, 
you should be able to: 

 explain the difference between real-time and 
delayed communications 

 describe email and texting 

 select the best communications tool for a given 
situation 

 describe various phone calling technologies 

 manage status and profile settings in Skype  

 conduct group conversations in Skype 

 describe how to conduct group conversations in 
Google Hangouts 

 describe the benefits and function of online 
conferencing tools 

 describe benefits and function of business 
collaboration tools 

 describe distance learning technologies 

 describe audio, video, and live streaming 

Digital Communication Technologies 
The Internet and widely available high speed broadband connections have made communicating with others 
quick, efficient, and affordable. As the traditional boundaries between the telephone network, cellular 
networks, and data networks are disappearing, we find that we have a wide variety of choices regarding the 
technologies and the devices we want to use in order to communicate. 

In this lesson, we will examine various technologies for digital communication. You will notice that many of 
them overlap; different platforms and different applications are developed as the Internet evolves and as the 
required infrastructure is continuously put into place.  

Real-Time (Synchronous) and Delayed (Asynchronous) 
Communications 

Communication refers to any process that enables you to interact with others. Electronic communication is 
simply communication that involves using an electronic method such as email, instant/text messaging or 
electronic voice and video conferencing.  
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There are two essential time frames for communication: real-time and delayed. In real-time communication, 
information is sent and received instantly. A face-to-face conversation is an example of real-time 
communication. If Kelly and Marcie are having a face-to-face talk, then as soon as Kelly says something, 
Marcie hears it. Additionally, Marcie can respond immediately. And as soon as Marcie says something in 
reply, Kelly hears her reply. In digital communications, real-time exchanges are referred to as synchronous. 

In delayed communication, there is a time delay between the sending and receiving of information. A mailed 
letter is an example of delayed communication. Kelly writes Marcie a letter. She puts the letter in an envelope, 
addresses and stamps the envelope and drops it off at the post office. In a few days, a letter carrier delivers 
Kelly’s letter to Marcie’s mailbox. When Marcie comes home from work, she checks the mail, brings it inside, 
and then opens and reads Kelly’s letter. In digital communications, delayed exchanges are referred to as 
asynchronous. 

Asynchronous Communications Tools 
Objective 3-6.1, 3-6.2 

The digital tools we will examine that provide asynchronous communications are email and text messaging. 
These tools are considered asynchronous because a delay is acceptable. That is, you can send a 
communication to your intended recipient regardless of your recipient’s availability. 

Electronic Mail (Email) 
You have already spent some time sending and receiving email messages and sending files as email 
attachments. Email is a standard and popular method for exchanging business communications and personal 
messages when a response is not urgent. 

You may spend your work day sitting at your desk sending and replying to email messages. You may also 
respond to messages as soon as they arrive, and you may receive replies as soon as you send messages out. 
In such a scenario, email correspondence occurs in real time; however, email is considered a delayed 
communication because a delay does not affect your ability to send or receive an email message. 

Kelly can send an email message to Marcie whenever she likes. Marcie may be sitting at her desk, or Marcie 
may be at lunch, or Marcie may be on vacation in Europe. These factors do not affect Kelly’s ability to send 
an email message to Marcie. And once Marcie becomes available, and she logs in to her email account, the 
messages that Kelly sent to her will be waiting in her Inbox.  

It is convenient when Marcie is sitting at her desk waiting to receive and reply to Kelly’s message; but it is 
not a requirement.  

SMS Text Messages 
You learned in Computing Fundamentals that SMS text messages are short messages (around 160 characters) 
sent over a cellular provider’s network using the Short Message Service protocol. Text messaging is also 
considered a delayed communication. Kelly can text Marcie whether Marcie’s phone is on or off. If Marcie’s 
phone is turned off when Kelly sends her a text message, Marcie will receive the text message the next time 
she powers on her phone. 
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Using Text Messaging Effectively 
Texting can be a good communications tool if you use it wisely. 

Remember that even though texting “looks like” instant messaging, it is not necessarily real-time 
communication. You can send a text to a contact at any time; you have no way of knowing whether he or she 
is available when you send your text message. Your intended recipient may be unable to respond (perhaps 
they are driving, or in attendance at a meeting or a performance), or may be unaware that you have sent a 
text message. For example, the recipient’s phone may be turned off, or the recipient may not have heard the 
alert sound of an incoming text, or may not have noticed the new text message icon on the cell phone. 

You may receive an immediate response to a text message, but that is not guaranteed. If you require an 
immediate response, it may be better to place a phone call. 

Always remember that if a situation is best resolved by speaking to someone directly, use the telephone or 
seek a face-to-face meeting. 

When is a Text Appropriate? 
If you can convey your message or question in relatively few words, a text is probably appropriate. If, on the 
other hand, it would require several screens of text to get your message across, email might be a better 
choice. Remember that several minutes of back and forth texting can be very disruptive for people who are 
trying to get their work done.  

Remember also that, depending on the cell plan/data plan, people may be charged a fee for sending and 
receiving text messages, especially if they exceed a specific quota. Be considerate; ask about your recipient’s 
preferred method of communication. 

Audience consideration, however, is arguably the strongest determining factor: 

• If your intended recipient is often away from the office, and seldom responds to email messages, text is 
probably appropriate. Some people who are negligent at answering email respond almost immediately 
to text messages. 

• If your intended recipient is relatively inexperienced with technology, a phone call may be a better choice. 
Just because Grandmother owns a cell phone does not mean that she likes (or knows how) to text.  

• If your intended recipient is visually impaired, or has trouble using his or her hands, a phone call might 
be much easier. 

• On the other hand, if you need to communicate with someone who has a hard time hearing, a text might 
be the perfect solution to avoiding a frustrating conversation during which you might have to repeat 
yourself often, or speak at a volume louder than is normal or is comfortable for you. 

To Text or Not to Text? 
It is not always easy to determine when and when not to use text messaging. Here are a few guidelines: 

• Use text if you must communicate, but are in a place or situation where speaking out loud would be 
inconsiderate or indiscreet.  

• Avoid texting while driving. It is dangerous and against the law in many regions to text while driving. If 
you know that your intended recipient is on the road, refrain from sending SMS messages. Use email 
instead. 
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• Avoid sending and responding to texts if you are in a social setting, such as at the dinner table or involved 
in a conversation. Your “live” audience deserves your full attention. It is rude to ignore the people around 
you in order to engage in texting. 

• Avoid sending text messages late at night. Many people react to a late-night text the same way they 
react to a late-night phone call; they fear it might be bad news. Think twice before sending – can your 
message wait until business hours tomorrow morning? 

• Do not attempt send text messages while you are in an airplane that is taxiing, taking off, or landing. 

Etiquette 
Etiquette is a customary code of polite behavior (good manners) in society or among members of a particular 
profession or group. In matters relating to the Internet and electronic communication, etiquette is often 
referred to as netiquette. To observe netiquette, keep the following points in mind: 

• If you are involved in text conversation with a group of people, consider the frequency of your messages. 
Do all members of the group need to receive all your texts? If not, start a new text to reply to an individual 
within the group instead of replying to the entire group. 

• Remember that electronic modes of communication tend to be open to misinterpretation. Always 
remember that the recipient cannot see your face, and that it is very difficult to convey tone in a written 
message. For example, a sarcastic remark meant as a joke can easily hurt someone's feelings. Try to treat 
others in the same manner that you want to be treated, online or in person. 

• Refrain from using all uppercase letters in your message as this is considered “shouting”. Use shouting 
with utmost discretion. 

• Do not use texting as a way of bullying or harassing someone in any manner. 

• Refrain from using abbreviations and acronyms in business or school texts. Not everyone is familiar with 
these, and it can lead to misinterpretation or confusion. 

• Refrain from using emoticons, which are symbols that attempt to convey to the recipient the sender’s 
emotion, in business or school communications. They are considered unprofessional. 

• Always try to respond to messages in a timely manner. Not all messages require an immediate response, 
but when a message contains a question or requires further action, be sure to send an appropriate reply. 

• Always follow the rules and guidelines established by your school or organization (and local, regional 
and national laws if appropriate) regarding electronic communications. 

Real-Time Communication Technologies 
Objective 3-6.1 

While asynchronous communication methods such as text and email provide you with a “history” of 
conversation threads and “proof” that certain communications were sent and received, sometimes there is 
just no substitute for real-time communications. 
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Remember that real-time communication is a live conversation. When you are engaged in a face-to-face 
conversation with another person, it is easy observe body language, facial expressions, and tone of voice. 
Each party can ask and answer questions as they arise. You can clarify points as you go, and “read” the other 
party to assess how well they understand what you are saying. You can also see whether they agree with you 
or not and adjust your communications as necessary to meet a need or bring the other person around to 
your point of view. 

Technologies that provide real-time (or synchronous) communications include phone calls/conference calls, 
online meetings/video conferences (WebEx), and instant messaging.  

Phone Calls 
Phone calls are perhaps the finest example of a real-time communication technology at work. One of the 
better-known telephone company advertising slogans from the not-too-distant past was “Long Distance: the 
Next Best Thing to Being There.” Another was “Reach Out and Touch Someone.” 

Phone calls are personal and give each participant the other party’s full attention (or at least we hope so). 
Phone calls can be almost as effective and empowering as face-to-face communications. There are many 
situations in business and personal relations that require real-time, personal contact. Consider the following 
scenarios in which a phone call is probably the best means of communication to use (when a face to face 
meeting is not possible): 

• You are communicating with someone whom you do not know. It can be intimidating to “converse” 
via email with someone whom you have never met.  

• You must convey a complicated idea. Many people have a difficult time organizing complex concepts 
and ideas in writing. Sometimes you can compose a well-organized and coherent message, but the 
message becomes quite lengthy. Many people are immediately discouraged when they see large blocks 
of text staring at them, and they skim the message instead of reading it. This can lead to 
misunderstanding and frustration on both sides. If issues require further clarification, then messages 
must be sent back and forth perhaps several times. The possible added delay of email can make 
communications seem long and drawn out, and can make the entire process tiring and tedious. 

• You must discuss a sensitive topic. Some matters are just not handled well through writing. Email and 
text can seem impersonal and cold. Voice, on the other hand, can convey a wealth of emotion – including 
support and understanding – when appropriate. Additionally, phone calls are private, while email, text, 
and chat could be seen or intercepted by people not involved in the discussion.  

• You require an immediate response. Sometimes you need an answer right away. You can send an 
email and ask for an immediate reply, but how do you know whether the other party got your message? 
What if your recipient is on vacation or out sick? You have no way of knowing whether your 
inquiry/request is on anyone’s “radar” so to speak. 

• You need to get a message to someone immediately. Sometimes you need to send an urgent 
message and you need to be sure the other party has received it. For example, if you are on your way to 
a job interview and have to stop to fix a flat tire or to wait for an accident on the freeway to be cleared, 
it is a much better idea to call the person who is waiting to interview you than it is to send that person 
an email.  
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Phone Call Technologies 
There are three basic technologies you can use to make phone calls. You can use: 

Landline phones – when you place a call using a landline phone, voice signals are sent over the copper wires 
of the public switched telephone network. Incoming calls are free, but long-distance calling can become 
expensive. 

Mobile phones – when you place a call using a mobile phone, voice signals are sent wirelessly over your 
cellular carrier’s network. Most cellular plans offer unlimited calling, including long-distance calling, for a set 
monthly rate (international calls often incurs an extra charge). 

VoIP phones – when you place a call using a VoIP phone, voice signals are sent as packets across the Internet.  

Internet Phone Calls (VoIP) 
Voice over Internet Protocol (VoIP) is a technology that allows you to make voice calls using a broadband 
Internet connection instead of a traditional telephone line. VoIP converts voice signals into small packets of 
digital data, adds addressing information to each packet, and then sends the packets across the Internet. This 
process should sound familiar to you – it is the same process used when your computer communicates with 
web servers or other computers over the Internet.  

Because VoIP calls bypass the telephone network and use the Internet, VoIP calls are free (except for the fee 
you pay for Internet service). Many businesses use VoIP services because they are much less expensive than 
traditional telephone services, especially for long-distance calling.  

Best of all, you can call landline phones and cell phones from your VoIP phone, and these types of phones 
can call you. Cellular networks, IP networks, and the telephone network connect to one another through 
specialized gateways. (A gateway is a network point that acts as an entrance into another network.) 

Residential consumers can purchase VoIP phone service through their ISP (if the services are offered), or 
through a third party service provider such as Vonage. The provider will usually supply the required 
equipment. 

Businesses may also purchase VoIP phone service through an Internet provider, or they may choose to 
implement their own VoIP solutions by modifying their existing data networks to support phone services.  

Disadvantages  
A disadvantage of using VoIP for phone calls is that calls are very sensitive to delay. If packets containing 
voice information take too long to traverse the Internet, the result is a conversation that sounds choppy or 
“broken.” VoIP communications are also highly susceptible to echo and feedback, especially if one or more 
participants is using a speakerphone or laptop speakers as opposed to a headset. 

Another major drawback to using VoIP is that it is dependent upon an Internet connection. If your Internet 
connection is not reliable, or is too slow, calls will have poor sound quality and may be dropped (that is, the 
connection can be lost). If your Internet connection goes down, you have no phone service. 

Unlike landline phones, which will still function in the event of a power outage, VoIP service cannot function 
without electrical power. Even if your VoIP phone has a battery, your modem/router is dependent upon AC 
power. If your modem or router cannot function, your Internet connection goes down. 
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Conference Calling 
A conference call is simply a call that involves three or more parties. Many business phones include a 
Conference button. Most consumer phones include a Flash button which you can use to create a conference 
call if a conference calling service is included in your phone plan. 

Modern conference calling is not limited to audio only; almost all technologies that provide video calling 
support video conference calling. 

You can participate in conference calls on landline, mobile, and VoIP phones. 

WebEx 
WebEx is a hosted service that you can use to conduct online meetings with anyone who has an Internet 
connection – including mobile users. Although only WebEx is described in this section, most online meetings 
occur in a similar fashion, regardless of the platform used to host the meeting.  

An online meeting (sometimes called a web conference) is a meeting in which multiple participants can not 
only speak to each other, but also share visuals such as presentation files, documents, whiteboards, and even 
video. Within a meeting, different participants can “take control” and share files or progress through a 
presentation. 

Participants can access an online meeting by clicking a link that they receive in an emailed meeting invitation. 
You can also be invited to an online meeting through an instant messaging application. WebEx software is 
delivered over the web as you need it; the first time you attend a meeting, the software will automatically 
install itself on your computer. 

When you join an online meeting (depending on the platform being used to host the meeting) you have 
options on how to connect to audio. You can use your landline phone or a mobile phone (phone numbers 
for connecting are provided) or you can use VoIP via a headset connected to your computer.  

Online meetings are often called video conferences because participants have the option to share the image 
and/or video via webcam. With WebEx you can speak with other participants and the image shown on your 
screen will change to show who is currently speaking.  

WebEx also allows you to record online meetings, and to share or publish the recordings so that others can 
see what transpired during the meeting even if they were unable to attend. 

WebEx services are provided by Cisco through various subscription or pay-per-use plans. You must have a 
subscription in order to host WebEx meetings, but anyone with a computer (or smart device) and an Internet 
connection can attend a meeting.  

Web-conferencing equipment is expensive, demands high bandwidth and requires skilled IT staff. The 
advantages of using a hosted web-conferencing service include simple and easy administration, relatively 
low cost, and dedicated, professional support. 

  



Lesson 15 Digital Communication 
 

 

490  7500-1 v1.00 © CCI Learning Solutions Inc. 

Skype – More than Just IM 

Objective 3-6.1, 3-6.3 

In Computing Fundamentals, you were introduced to Skype; you created a Skype account, downloaded and 
installed the Skype client, added a contact, exchanged messages with your contact, and shared files through 
Skype.  

In this lesson, you will work with some of the group features of Skype, and you will examine aspects of Skype 
that communicate information about you – such as your profile information, your status, and your personal 
note. To begin, we will take a detailed look at the Skype interface. The following figure shows a sample instant 
messaging session in the Skype Desktop app.  

 
Note: Bots are applications that perform automated tasks using artificial intelligence. You can add Skype 
bots to your Contacts that will chat with you. Some assist with tasks and others provide entertainment. 

A – Your Account The account name you are using displays in the title bar. You can sign into Skype 
using a Skype name, a Microsoft account, or your Facebook sign-in details. 

B – Menu Bar  Provides access to commands, including those for configuring settings. 

C – Status Bar Displays your screen name and current status (for example, Online, Away, Do Not 
Disturb, and so on). You can also add a personal note that your contacts can see. 

D – Toolbar Provides access to features such as Skype Home, an on-screen dial pad, a window 
for creating group conversations, and link to Skype bots which you can add to your 
Contacts. 

E – Contacts List Displays your contacts and an indicator of their current status. 

A 
B 

C 

D 

E 

F 

G 

H 

I 
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F – Recent List Lists recent conversations you have had. 

G – Contact 
Summary 

Displays the name, status, and note of the currently selected contact. Also provides 
buttons for turning an IM conversation into a video call or an audio call, and for 
creating a group conversation.  

H – Conversation 
window 

Displays the instant messaging conversation you are having. 

I – Conversation box Type your messages in the box, then press ENTER. 

Because the consumer version of Skype is free, it may display advertising banners.  

Adjusting Your Status 
In Skype, your current status is indicated by a colored circle at the lower-right of your profile picture (or 
picture icon if you have not added a profile picture). Each of your contacts also has a status indicator next to 
their names in your contacts list.  

By reading the status indicator of any contact, you can determine the best way to communicate with that 
contact. For example, if you see that your contact Kelly is offline, you can send an instant message to her 
with the knowledge that she will not see the message until the next time she signs in. If you really need to 
contact Kelly immediately, a phone call might be a better way to go. 

If you roll your mouse over a contact’s status icon, you can see extra information about their status. For 
example, if a contact is offline, you can see how long he or she has been offline, 
and whether the contact has set up call forwarding. 

By default, Skype indicates that you are Online whenever you sign in. However, 
you can change your status at any time. In the menu bar, click Skype, point to 
Online Status, then click an option in the menu. 

Online This is your default status when you sign in. Your contacts can reach you via instant message or 
calling. 

Away Your contacts can see that you are signed in, but not necessarily at your computer. Instant 
messages are delivered immediately, and your contacts can still try to call you. You can configure 
Skype to automatically change your status to Away after you have been idle for a specified period 
of time. 

Do Not 
Disturb 

Your contacts can see that you are online, but that you do not want to be disturbed. They can 
still send you instant messages and call you, but you will not be alerted with sound notifications. 

Invisible You will appear to be offline, but you can still use Skype as usual. This is a good way to keep 
using Skype without “advertising” to your contacts that you are available.  

Offline Your status is automatically set to Offline when you are not signed into Skype. If you manually 
select this status, you cannot send instant messages or make or receive calls. 

At the bottom of the Online Status menu, is the Set up Call forwarding option. You can set up call forwarding 
to forward Skype calls to a landline phone or a mobile phone. You must purchase Skype credit in order to 
set up call forwarding. 

Once you set up call forwarding, you can set your status to Calls forwarded. 
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Managing Your Skype Profile 
Your Skype profile, like any online profile, tells other people something about you.  

Certain aspects of your Skype profile are public, some are visible only to you and your contacts, and some 
are private (not visible to anyone). For example, your email address is private; that means it is never displayed. 
However, people who already know your email address can use it to search for you. 

The following figure shows the fields that comprise a Skype profile. 

 
You can set the field below your picture in your Skype profile to: 
Public – everyone on Skype can see it. 
Contacts only – only your contacts can see it. 

Private – no one can see it. 
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You cannot change the setting for any of the fields that are grayed out. 

Your contacts can view the profile information you have set to Public and the information you have set to 
Contacts. You may choose to share a lot of information, like Fred: 

 
Or you may choose to share very little, like Carolyn. 

 
Or you may choose something in between. 

Mood Messages 
In Skype, your mood message can share a general idea, or can be customized to give a little more information 
on your current status. For example, perhaps you need to run to the post office. You can set your status to 
Away, and you can set your mood message to “Be back in 20 minutes” to let your contacts know that you do 
not anticipate being away for very long. 

 

Exercise 15-1: Managing your online status and profile 
This exercise assumes that you created a Skype account, downloaded and installed the Skype Desktop client, 
and added at least one contact as directed in Computing Fundamentals, Lesson 5, Exercises 5-9 and 5-10. If 
you have not, please do so at this time. 

In this exercise, you will work with your online status and your profile. 

1. Start Skype and sign in. 
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2. Team up with a person sitting near you and decide who will be Student A and who will be Student B. 

3. If necessary, add your teammate to your Skype contacts. (Refer to Lesson 5, Exercise 5-10 for step-by-
step instructions, if you need to.) 

Note that in order to demonstrate how alert sounds are affected by your status, you will be asked to click 
outside the Skype window many times during this exercise. 

4. Student A: Click Student B in your Contacts list, then click in the message area, type a short message 
and press ENTER to send the instant message to Student B. 

5. Student B: You should hear an alert when the message arrives. Click the Recent tab to see the new 
conversation with Student A.  

6. Student B: Click the conversation in the Recent tab to open the conversation window with the message 
from Student A. 

7. Student B: Click in the message area and type and send a response. Student A should not hear an alert 
because the Skype conversation window is open and active on his or her system. 

8. Student B: Click Skype, Online Status, Away to change your status. Then click outside the Skype 
application window. (Restore the window if necessary so that you can click outside of it.) 

9. Student A: Send another message to Student B. 

10. Student B: Did you hear an alert when Student A sent you a message? Even if your status is set to Away, 
you will hear an alert if Skype is not the active window. 

11. Student B: Change your status to Do Not Disturb. Skype displays a message box warning that you will 
not receive notifications. 

 
12. Student B: Click OK to close the message box, then click outside the Skype window. 

13. Student A: Send another message to Student B. 

14. Student B: You did not hear an alert, but did you receive Student A’s message? Messages still come 
through when your status is set to Do Not Disturb, but you will not hear notifications. 

15. Student B: Set your status back to Online. 

16. Student A: Click Skype, Online Status, Invisible, then click outside the Skype window. 

17. Student B: Send a message to Student A. 

18. Student A: Did you hear an alert when Student B sent you a message? Being invisible is like “lurking” 
online – you can “see and hear” everything, but no one can see you. 
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19. Student A: Set your status to Offline. 

20. Student B: Send another message to Student A. 

21. Student A: Did you receive Student B’s message? When your status is set to offline, you will not receive 
messages that are sent to you.  

22. Student A: Send a message to Student B. 

23. Student B: Did you receive the message from Student A? Because Student A’s status is set to Offline, he 
or she cannot send messages. 

24. Student A: Set your status back to Online. Now you should receive the last message that Student B sent. 

25. Student B: Now that Student A is back online, you should receive the message that Student A sent while 
he or she was offline. 

Now, make some changes to your profile. 

26. Click Skype, point to Profile, then click Edit Your Profile to open the profile management page. 

27. Click the Show full profile link to expand the options displayed on the page. Notice that for most of 
these, you cannot change who sees the information. If you do not want everyone to see the information 
that would be listed in a Public field, do not enter information into that field.  

28. Click the Enter mood message link to open the Mood field. Type a short phrase that summarizes your 
mood, then click the check mark that displays to the right of the field to accept the entry. Your teammate 
should be able to see your mood message almost immediately. 

29. Click the Home button on the Skype toolbar. 

Group Conversations 
When you conduct a group conversation in Skype, anything you type and send is received by everyone in 
the group. Sometimes you may be having a conversation with a contact, and realize that you need to loop 
in another person. Other times, you may know that you need to converse with two or more people and you 
can start out as a group conversation. 

 

To add a contact to a conversation already in progress, click the  (Create new group) button to open a 
window for adding contacts and turning your conversation into a group conversation. 
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Click the contact you want to add to the conversation. The name of contacts who will be added to the 
conversation appears in the box at the top of the window. 

 
When you are finished adding contacts, click Create group to open a new group conversation window. 
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Notice that a group avatar  now displays at the upper-left corner of the conversation window. Notice also 
that the previous portion of the conversation is not included in the new group conversation window.  

Because you are now in a group conversation, the button at the far right  is now named Add people. You 
can click Add people to add more people into your group conversation. 

If you want to save a group as a contact, right-click the group avatar, and click Save Group in Your Contacts.  

 
Type a name for the group contact, then click OK. 

To create a brand new group conversation to which you can add anyone you like, click  (Create a new 
conversation) to open the window for adding contacts. Click the contacts you want to add to the group, 
then click the Add button to open a conversation window for the new group.  

If you want to leave a group conversation, right-click the group avatar, then click Leave Conversation.  

 
Click Leave to confirm. When a participant has left a conversation, the other participants are notified. 

 

Exercise 15-2: Conducting group conversations 
In this exercise, you will participate in group conversations in Skype. Your teacher should divide the class into 
teams of four. Decide who will be Student A, Student B, Student C, and Student D. 

Begin by clearing out your conversation history. This will make it easier to distinguish one conversation from 
another. 

1. Click Tools, then click Options to open the Skype Options page. 
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2. In the panel at the left, click Privacy to access the Privacy settings. 

3. In the Allow IMs from section, click the Clear history button, then click Delete to confirm. Skype clears 
past conversations from your account. 

4. Click Save to close the Skype Options page. 

5. Ensure that everyone on your team is in your Contacts list. If not, add them now. 

Start a conversation. 

6. Student A: Send a message to Student B. 

7. Student B: Click the Recent tab to see the new conversation, then click the conversation to open the 
conversation window. 

8. Student B: Click in the message area and send a reply to Student A. 

Change the conversation to a group conversation. 

9. Student A: Click the Create new group icon at the upper right area of the conversation window, click 
Student C and Student D in the list of Contacts, then click Create group. 

10. Student A: Click in the message area for the new group conversation window and send a message to 
everyone. 

11. Student B: You should see a new group conversation listed in your Recent tab. The group conversation 
shows a group avatar instead of a contact icon or profile picture. 

12. Students C and D: Click the Recent tab to see the new group conversation. 

13. Students B, C, and D: Click the group conversation to open the conversation window. 

14. Everyone: Take a few minutes to send messages to one another in the group conversation window. 

Save the group as a contact. 

15. Student B: Right-click the group avatar, click Save Group in Your Contacts, type: MyClassTeam, then 
press ENTER. Everyone should see a notification that Student B renamed the conversation to 
“MyClassTeam.” Additionally, the new name should appear in the Recent tab. 

16. Student B: Click the Contacts tab and scroll to the bottom of your Contacts to ensure that MyClassTeam 
has been saved as a contact. Group contacts appear at the bottom of the Contacts list. The group contact 
will be saved only in Student B’s contacts list. 

17. Student D: Right-click the group avatar, click Leave Conversation, then click Leave to confirm. A 
notification that Student D has left the conversation should appear in everyone’s conversation window. 
Note that because Student D left the conversation, Student D is no longer saved in the MyClassTeam 
contact. 

18. Everyone: Right-click the group avatar, click Hide conversation, and then click OK to hide the old 
conversation and keep the Skype interface uncluttered. (If you want to view hidden conversations, click 
View in the menu bar, then click Show Hidden Conversations.) 
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Checking Out Google Hangouts 
In Computing Fundamentals, you used the Gmail chat feature from your Gmail Inbox. What you might not 
have realized is that Gmail chat is powered by Google Hangouts.  

Google Hangouts is a communications platform that supports SMS, IM, group chat, VoIP calling, and video 
conferencing. Hangouts allows conversations between 2 or more users and can be accessed online through 
Gmail or the Hangouts website, through the Hangouts app, or through mobile apps for Android and iOS.  

You can open a browser and navigate to https://hangouts.google.com and click the Sign in link, or you can 
sign into Gmail, then click the Google apps button, click More, and then click Hangouts. The Hangouts page 
is shown in the following figure. 

 
Note: You can add an extension for the Chrome browser that lets you use Hangouts outside the browser 
window. 

Your Gmail contacts are integrated into Hangouts and display in your Hangouts contact list. A green dot 
displays at the lower right of the contact icon for contacts who are currently signed in to Gmail. Click the 
icons in the vertical menu on the left to display contacts (the default view), conversations or phone calls. You 
can also click the Menu button (three horizontal lines) to open a menu of Hangouts options. 

To start a conversation on Hangouts, click a contact to open a 
conversation window, type your message then press ENTER.  

Notice the  (Video call) icon at the upper left corner of the 
conversation window. You can turn a conversation into a video call with a 
click. 

To add another participant, click  (Create a group Hangout) to open 
a window of contacts you can add to the conversation. Select the contact 
to you want to add, then click Create group. A new conversation window 
opens, and any messages you send here will be sent to everyone in the 
group hangout.  

 

https://hangouts.google.com/
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It is possible to add contacts who are not currently signed in 
to Gmail; however, they won’t see the group conversation 
until they sign in. 

To leave a group conversation, click the  (Options) 
button, click Leave, then confirm that you want to 
leave the conversation. 

 

Online Conferencing 

Objective 3-7.1 

Because online conferencing uses the Internet to transfer voice and video signals, and because the Internet 
is a data network, online conferencing is well suited for exchanging digital files, sending instant messages, 
and sharing screens. For example, in an online conference call, you can pull up a YouTube video and play it 
in your browser and share your screen (and your audio) with everyone else on the call. You can even send 
the URL to everyone in an instant message while the video is playing.  

Just about anything you can do on your computer or on the Internet on your own, you can do with others 
through online conferencing. 

VoIP Conferencing 
VoIP phone calls use the Internet to transfer voice packets between the phones used in a call or conference 
call. Any of the “phones” themselves can be a telephone handset, a conference room speaker box, a computer 
headset or PC speakers and a microphone.  

The point is, you can use a computer to place and receive VoIP calls, including conference calls. In these 
scenarios, the computer is considered a software phone or “soft phone.” You can use one of several 
applications – such as Skype or Google Hangouts – as an interface for your soft phone. 

A powerful advantage to using your computer as a soft phone is the ability to transfer files and share screens 
during a call. 
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Using Skype for VoIP Calls 
To begin an audio call on Skype, click the contact you want to call in the contacts pane, then click the  
(Call) button. Skype displays the profile picture of the other party on your screen for the duration of the call. 

 

You can click the  (Show contacts) button to open the Contacts panel on the left side of the Skype call 

window. You can click the  (Show IM) button to open the Conversation window on the right side of the 
Skype call window, allowing you to send instant messages or files during a call. 

You can use the buttons at the bottom of the screen to make adjustments and take actions during the call: 

• Click  (Turn on video) to toggle your video camera on or off.  

• Click  (Mute your microphone) to mute or unmute your microphone. 

• Click  (Add participants, send files and more) to open a menu of options. You can send files on the 
call, send contact cards, share screens, add people to the call, or show the dial pad. When you send files 
or contact info, these are sent through the IM panel. The Show IM button on your recipient’s screen will 
glow, indicating that there is information available. 

• Click  (End call) to leave the call.  

Conference Calls 
To conduct a conference call using Skype you can: 

• Create a group conversation and then click the Call button; or 

• add additional participants to a call that is already in progress.  
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To add participants to a call that is already in 
progress, click Add participants, send files and 
more to open a menu of options. 

 

Click Add people to this call. 

 

Click the participant you want to add, then click the Add to call button. The added participant’s phone rings. 
If he or she answers, they are added to the call.  

 

Screen Sharing 
Screen sharing has many useful functions, including the ability to: 

• deliver a presentation to the participants on your call, 

• show a specific section of a document for which you need ideas or clarification, 

• demonstrate how to accomplish a particular task on the computer, or within a specific application, 

• demonstrate a problem or show an error message that you are receiving. 
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To share a screen during a Skype call, click Add participants, send files and more, then click Share screens.  

 
You can specify to share your entire screen (using the Share your screen option), or just the content that 
appears in a particular window (using the Share a window option). Make your selection using the drop-down 
arrow if necessary, then click Start to begin sharing.  

Whatever displays on your screen (or in your selected window) appears in the other participants’ Skype 
window. For example, if Fred decides to share a document in his Word application window, the other 
participants will see his Word document in their Skype windows, as shown in the following figure. 

 
On your system (if you are the one sharing) all content that is visible to other participants appears inside a 
red border. The following figure shows Fred’s Desktop. He has shared a window, and that shared window 
displays a red border. 
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Notice the floating Skype call window in the previous figure. Fred can click Stop sharing in the floating 
window to stop sharing, or he can restore his own Skype window, click Add participants, send files and 
more, and then click Stop sharing. 

Participants in a conference call can leave the call at any time by clicking the End call button. Leaving a 
conference call does not affect other participants who are still on the call. However, if the originator of a 
conference call ends the call, the call ends for everyone.  

Exercise 15-3: Conferencing in Skype 
A headset with a microphone is required for each student for this exercise. Each student should plug in his 
or her headset before beginning. You will work with your team from the previous exercise. 

In this exercise, you will participate in a Skype phone conference. First, you will call one contact. 

1. Student A: Click Student B in your Contacts list and click the Call button. If Student B has added any 
phone numbers to his or her profile, you will see a list of options. Click Call Skype. 

 

2. Student B: Click the green  (Answer) button to answer the call. Carry on a conversation for a moment 
or two. 

3. Student B: Click End call to end the phone call. 
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Make a group call. 

4. Student B: In your Contacts list, click the MyClassTeam contact, then in the message window click the 
 (Call group) button. Skype rings for Student A and Student C. 

5. Students A and C: Click Answer to join the call. 

6. Student B: Click Add participants, send files and more, then click Add people to this call. In the list 
of contacts that opens, click Student D, then click Add to call.  

7. Student D: Answer to join the call. 

8. Everyone: Converse for a few minutes.  

9. Student C: Click outside the Skype window, navigate to the 7500 Student Files/Digital Communication 
folder, and open the Castle Tour presentation by double-clicking it. 

10. Student C: Click the Skype button in the taskbar then click inside the Skype window.  

11. Student C: Move your mouse in the Call window to make the controls appear, click Add participants, 
send files and more, then click Share screens. When the Share your screen box appears, click Start. 
You should now see your presentation on the screen, and a floating Skype call window. Everyone else 
should see your presentation in the call window. 

12. Student C: Click a few of the slides in your presentation and get confirmation from your teammates that 
they can see each slide as you click it. 

13. Student C: In the floating Skype call window, click Stop sharing. Everyone should now see the call 
window with icons for each of their teammates participating in the call. 

14. Student D: Click Add participants, send files and more, then click Send files. Navigate to the 7500 
Student Files/Digital Communication folder, then double-click Office on Demand to send the file to your 
teammates. 

15. Students A, B, and C: The Show IM icon in the lower-right corner of the call window should change 
color, indicating that an instant message has been received. 

16. Students A, B, and C: Click the Show IM icon to open the IM pane and see the shared file. 

17. Students A, B, and C: Click the document icon in the IM pane to download the file. If you are prompted 
to confirm that you want to accept the file, click Accept. The Save dialog box opens.  

18. Students A, B, and C: In the Save dialog box, navigate to the Desktop, then click Save. 

19. Student B: Click End call to terminate the conference call. 

Video Conferencing 
A video conference is a conference call that includes video. Aside from the obvious personal consumer 
appeal, video conferencing has many applications in business settings. Video conferences: 

• Can make employees from different locations feel more cohesive as a group: When you recognize 
the faces of your colleagues, and can match those faces with voices, you feel as if you know them on a 
more personal level. 

• Can make everyone feel included: If you and a small group of colleagues work in a satellite office, while 
the rest of the company works at headquarters, video conferencing for celebrations or recognition 
ceremonies can make everyone feel that they are part of the team. 
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• Are ideal for demonstrating procedures: A picture is worth a thousand words, but a live demonstration 
is even better. You can use video to demonstrate how to perform CPR, or how to reset a circuit in a 
breaker box, or how to use a particular option on a smart phone. 

• Bring a face-to-face quality to communications: You are already familiar with the advantages of face-
to-face communications, such as being able to read body language and facial expressions. Consider how 
advantageous it might be to interview prospective employees using video instead of flying them in for 
first-round interviews. 

You can easily conduct videoconferences in Skype, Google Hangouts, and FaceTime. 

Skype Video Conferencing  
In Skype, you start a video conference by opening a conversation window and then clicking the Video call 
button. You can also turn an audio conference call into a video call by clicking the Turn on video button in 
the call window. 

In a video conference, each participant’s video displays in the call window. If a participant does not have a 
camera or elects not to turn on his or her camera, that participant’s profile picture will display in the call 
window instead (just as it does in an audio call). The following figure shows a Skype video conference. 

 

Video Conferencing in Google Hangouts 
The first time you make a video call in Hangouts you may be prompted to allow Hangouts to use your 
computer’s camera and microphone, and you must accept. Note that if you are using Internet Explorer, 
Firefox or Safari, (or if you are using an account that does not end in @gmail.com) you will need to download 
and install the latest version of the Hangouts plug-in before making video calls.  

To make a video call from the Hangouts web page, click VIDEO CALL to start your video and open an 
invitation. 

 
Type in the email address of the person you want to call. When Google recognizes the address as a valid 
email address, it displays it below the green line. 
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Click the address to add it to the top of the Invite people dialog box.  

The INVITE button becomes available. You can enter additional addresses as required. A video conference 
on Hangouts will support up to 10 users (including you). Click INVITE when you are ready to send the 
invitation(s).  

If you receive an invitation, you can decline or answer in the panel on your Hangouts page, or in the chat 
roster in your Gmail page. (Hangouts is automatically turned on in Gmail.) 

   
You can add people to a video call by clicking  in the video window to open an invitation. You can also 
click Copy link to share to copy a link to your clipboard. You can then paste the link into an email or chat 
window to share the video call information. Anyone in the Hangout can add more people after the video call 
starts, and anyone with a Google account can join a video call.  

To share your screen during a Hangout video call, click the  (Options) button in the video window, click 
Share screen, specify to share your entire Desktop or your browser window, then click Share. To stop sharing, 
click Stop in the banner at the top of the screen, or click Options, Stop Screenshare. 

To leave a Hangouts call, point to the bottom of the call window, then click the  (End call) icon.  

Video Conferencing in FaceTime 
FaceTime is a video chat application developed by Apple. FaceTime is supported on iPhone 4 or later, iPad 2 
or later, iPad mini, and iPod touch 4th generation or later. It is also supported on Mac OS X 10.6.6 and later. 
The following image from the Apple Support web site (https://support.apple.com) shows a FaceTime video 
call in El Capitan: 

 FaceTime call options 

https://support.apple.com/
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In order to make a FaceTime call, all participants must be connected to the Internet. To make a video call: 

1. Sign in to FaceTime. 

2. In the field at the top of the FaceTime window, enter the recipient’s email address or phone number. 
(You can also enter the name of anyone in Contacts, or click the  (Contacts) button to see all of your 
contacts.) 

  
3. Click the  (Video) button to start the call. 

When you are signed in to FaceTime, you can accept or decline calls, even if FaceTime is not open. When you 
receive a call, you will see a notification. Click Accept to accept the call, or Decline to decline it. 

When you make or receive a FaceTime call, it will ring on all your Mac devices. This makes you reachable 
wherever you are (even if you don’t really want to be). You can, however, turn this feature off in your FaceTime 
preferences settings. 

Collaboration Tools 
Objective 3-6.4 

While Skype and Google Hangouts provide good tools for sharing screens and conducting both audio and 
video conference calls, the maximum number of users who can participate in a call is ten. However, there are 
business versions of these applications which allow for a greater number of participants.  

Additionally, there are collaboration tools designed specifically for use in corporate environments. These 
tools allow employees, both local and remote, to communicate, collaborate, and access and share 
documents. 

Office 365 
Office 365 is a bundled package of cloud solutions designed to be a one-stop all encompassing solution, 
providing the tools needed for productivity, collaboration, centralization, and communication. Business 
versions include: 

Outlook Web App (OWA) – an email, calendar, contacts and task management application. OWA is 
designed to integrate seamlessly with your local installation of Microsoft Outlook; however, you can use it 
even if Outlook is not installed. 

SharePoint – a web site creation and management platform. In Office 365, SharePoint supports the creation 
of personal sites for each user (blogs and social networking features are found here), and team sites for 
storing company documents and lists. These sites are internal and private. SharePoint can also be used to 
create and maintain a public-facing web site for your company or organization. 

Enter a name, phone number  
or email address 

Make a video call 

Make an audio call 
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Office Online – a free online office suite offered by Microsoft, which allows users to create and edit files 
using lightweight, web browser-based versions of Microsoft Office applications: Word, Excel, PowerPoint and 
OneNote.  

OneDrive for Business – cloud storage specifically for your business files, tied to your SharePoint Online 
account. The OneDrive for Business folder is accessible through SharePoint Online, and through a local folder 
on your system (you can use File Explorer to access it). Users can sync files stored online to files in their local 
folders. OneDrive for Business is separate and distinct from a personal OneDrive cloud storage account. 

Skype for Business – a real-time communication application that provides presence information, instant 
messaging, PC-to-PC audio/video calling and online meetings. This is the business version of Skype. 

Office Suite – a subscription-based version of the Office application suite, delivered as a service (as opposed 
to being installed from a single user license DVD). You can install the Office application suite on up to five 
computers and five mobile devices. Not all subscription plans include the Office suite. 

SharePoint 
SharePoint is a browser-based collaboration and document management platform provided by Microsoft. It 
provides a central location where employees can find and share documents, and collaborate with their co-
workers. Because the main user interface is a web browser, SharePoint locations are referred to as “sites.” 

The following figure shows the home page of the SharePoint site for Tolano Adventures (a company that 
promotes environmentally friendly vacation spots). The site is organized into a hierarchy: there is a page for 
the Seattle office, and sites for various departments and projects. 

 
It is common for various departments within a company to have their own team sites within the main 
SharePoint site.  

Built-in Content Management 
SharePoint provides more than just a centralized storage location. SharePoint is by design a content 
management system. The data you store on SharePoint is kept in lists and libraries, and you can configure 
these lists and libraries to restrict access, require check-out/check-in procedures, maintain major and minor 
versions, or alert you when changes are made to the data. 
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Co-authoring Documents in SharePoint 
Co-authoring is the simultaneous editing of a document by multiple authors. You can co-author documents 
in a SharePoint document library in Word, Excel, PowerPoint and OneNote, or in their online counterparts. 
For each product, the co-authoring functionality is very similar.  

The following figure shows two co-workers, Carolyn Stevens and Philip Henderson, co-authoring an Excel 
workbook using Excel Online.  

 
Notice that Carolyn can see precisely where Philip is editing the document. The blue border around cell A6 
shows an icon with his name. Philip’s name also appears beneath Carolyn’s user name in the upper-right 
corner of the window. 

If co-authors are signed in to Skype for Business at the time they are editing, they can communicate with one 
another. The following figure shows Carolyn co-editing a Word document with Philip. Carolyn is editing in 
her desktop version of Word, and Philip is using Word Online. Carolyn can click the share icon  to see 
who is editing. She can also click Philip’s name to open an instant message window to send him an IM. 

 
Co-authoring is enabled in SharePoint libraries by default.  

Skype for Business  
In the workplace, Skype for Business is a communications and collaboration center; from here you can see 
which of your colleagues are available for communications, and you can launch into a communications 
session with one or more colleagues with one or two clicks.  

From the Contacts panel you can you can start conversations with your co-workers, conduct online meetings, 
share screens, and more. The following figure shows the Contacts panel in the main Skype for Business 
window, and a conversation in a separate window. 
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You can use the buttons at the bottom of the conversation window to send messages, attach files, insert 
emoticons, start a video call, start an audio call, share your screen, present files, or create and share a 
whiteboard or online poll that all participants can update. 

Scheduling Online Meetings 
Because Skype for Business is integrated with Microsoft Outlook, you can schedule and send invitations to 
online meetings from your Outlook Inbox. When it is time for the meeting, participants can click a link in the 
meeting invitation to join the online conference call.  

One person organizes the meeting, and can designate particular people as presenters. During an online 
meeting, a presenter can share content and perform actions that control the flow of information.  

Taking Control 
Skype for Business allows participants to request and take control of a screen sharing session, allowing 
different people to present different portions of the meeting agenda, or various sections of a PowerPoint 
presentation. The ability to give or take control is also very helpful if you are having a computer issue and 
need help configuring your computer because you can give control to a member of the IT staff, who can 
configure your settings while you observe – even if that staff member is hundreds of miles away.  

Recording Online Meetings 
In addition to sharing content, presenters can capture the audio, video, instant messaging, application 
sharing, PowerPoint presentations, whiteboards and polling portions of an online meeting or group 
conversation.  

Recordings can be published and made available for other people to view. 
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Distance Learning Technologies 
Objective 3-6.4 

The wide variety of digital communications technologies had made distance learning practical, affordable, 
and even fun. Lectures, assignments, assessments, communications and grades are managed through 
Learning Management Systems (LMS), and students “attend” class by logging in using a web browser. 

Online classes can be asynchronous or synchronous in nature. In an asynchronous class, instructors provide 
material lists, lectures, tests, and assignments that can be accessed at any time (during an allotted time frame) 
that is convenient for the student. An “old-time” equivalent would be a mail correspondence course, where 
students mail their assignments to an instructor, and receive feedback in the mail. 

Asynchronous classes are ideal for people who like to learn at their own pace, or for those who must juggle 
school with work and family obligations. Commonly-used features in asynchronous classes are: 

Virtual libraries – these are repositories of documents, presentations, graphics, and audio and video files 
that you would have access to in order to read your assignments or perform research. 

Email – this is how you interact with the teacher and with your peers in the class. You would receive materials, 
updates, reminders and assignments and assessments via email. 

Discussion boards – you can post and respond to questions and share ideas, documents and links with your 
classmates. 

Social networking – many LMS have social networking features such as blogs, wikis, and Facebook, Twitter, 
and YouTube integration built in.  

Synchronous online classes occur in real time, and require students and instructors to be online at the same 
time. Lectures, discussions and presentations occur at a specific hour and all students must be online at that 
specific hour in order to participate.  

Synchronous classes may be preferable for students who need to feel involved with their classmates. 
Commonly-used features in synchronous classes are: 

Chat – synchronous chat rooms allow students to log in and interact with each other. 

VoIP conference calls – you can dial in to a toll free number or log in to a website to participate in live 
lectures and discussions with your class. VoIP conferencing would be especially beneficial if you are learning 
to speak another language. 

Video conferencing – you may join a video conference for occasions where you need to see demonstrations 
or need to observe certain happenings. 

Live streaming – you may be able to stream live broadcasts of political speeches or concerts or live theater. 

Streaming 
Objective 3-8.1 

Have you ever streamed audio from Audible, Pandora, or Spotify? Have you streamed video from Hulu, 
Netflix, or YouTube?  

Streaming is included in this lesson about digital communication because businesses and individuals can 
create video or audio recordings of presentations, marketing pieces, product demonstrations, and so on, and 
make these recordings available as streaming media. 



Digital Communication Lesson 15 
 

 

7500-1 v1.00 © CCI Learning Solutions Inc.  513 

Throughout this course you have read about streaming and downloading. As you know, downloading a file 
requires time and storage space, while streaming a file allows you to listen/watch the content as soon as you 
begin the streaming process. The content is delivered to your device in a steady, consistent flow of data 
called a stream. Audio streaming involves audio only; video streaming can be video only or video with 
embedded audio.  

When you stream audio or video media from a web site, a media server streams the content to you, and the 
content is played in a client media player application. If multiple people want to stream the same content, 
the media server sends a stream to each client. When you stream pre-recorded files such as these, you can 
pause, rewind, or fast-forward.  

Some of the more popular websites that provide streaming services are Hulu, YouTube, Netflix, Pandora and 
Spotify.  

You can also stream live content.  

Live streaming is a little bit different than streaming pre-recorded files. Live streaming is the process of 
broadcasting real-time live audio/video footage as a video feed to an audience that accesses the stream over 
the Internet.  

In live streaming, one file is sent out over the Internet, and multiple people can connect to the live feed and 
stream it to their devices. This makes it possible for people all over the world to view live events such as the 
World Cup, the Olympics, or a concert.  

Connecting to a live stream is similar to tuning in to a television or radio broadcast, except that you connect 
to the Internet to receive the feed instead of using a television or radio antenna to receive the signals.  

Business Applications 
You can access an amazing array of content via live stream – sporting events, concerts, worship services, 
award ceremonies, debates and local town council meetings are just the tip of the iceberg. Low-cost services 
platforms like Livestream and no-cost services such as Google Hangouts on Air make it easy for businesses 
all over the world to stream live content, such as meetings, forums, and presentations. 

Hangouts on Air is the video-recording/live streaming/.broadcasting tool that is free to anyone with a Google 
account. You can use Hangouts on Air to publicly broadcast Hangouts and stream them live on Google Plus 
and YouTube. The Hangout is automatically recorded and saved to your YouTube channel. From there you 
can edit it and share it even after it has been broadcast. 

You can make a live streaming event private or public. A public event is search discoverable and is viewable 
by anyone. However, participants (those who can speak or present during the event) must be invited by the 
host. If you make your live streaming event private, you need to send the URL to people you want to invite 
as viewers.  

A business or an individual can broadcast live video content using a camera and a computer. Viewers can 
play the content in a web browser, on an iOS or Android device, or through Roku or Apple TV. 

Using chat, Twitter, or voice calls, viewers can interact with the broadcast host or with an assembled “panel” 
taking part in the broadcast, or with other viewers. In this respect, live streaming can perform the same 
functions as a video conference. 
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Lesson Summary 
In this lesson, you learned about various digital communications technologies. You should now be able to: 

 explain the difference between real-time and 
delayed communications 

 describe email and texting 

 select the best communications tool for a given 
situation 

 describe various phone calling technologies 

 manage status and profile settings in Skype  

 conduct group conversations in Skype 

 describe how to conduct group conversations in 
Google Hangouts 

 describe the benefits and function of online 
conferencing tools 

 describe benefits and function of business 
collaboration tools 

 describe distance learning technologies 

 describe audio, video, and live streaming 

Review Questions 
1. Which of the following is an example of asynchronous communication? 

a. A VoIP phone call. 
b. An email message. 
c. A landline phone call. 
d. A video conference. 

2. Text messaging uses which protocol? 
a. Short Message Service 
b. Transmission Control Protocol 
c. Internet Protocol 
d. Dynamic Host Configuration Protocol 

3. Which is an example of netiquette when sending a text message? 
a. Sending text at any time so others can be informed. 
b. Using emoticons in text to add interest to the message. 
c. Trying to respond to text messages on a timely basis. 
d. Using uppercase letters in the text message to express emotions. 

4. Which of the following is an example of synchronous communication? 
a. A phone call. 
b. A blog post. 
c. A text message. 
d. A post on a discussion board. 

5. Which of the following is true of VoIP phone calls? 
a. They require a mobile phone. 
b. They require a landline phone. 
c. They require an Internet connection. 
d. They use a cellular provider’s network. 



Digital Communication Lesson 15 
 

 

7500-1 v1.00 © CCI Learning Solutions Inc.  515 

6. A conference call:  

a. requires a specialized handset. 
b. is limited to audio only. 
c. involves three or more parties. 
d. can be placed only on a landline phone. 

7. Which of the following provides hosted WebEx service? 

a. Cisco c. Skype 
b. Google d. Chrome 

8. Which Skype status makes you appear offline but allows you to use Skype as usual? 

a. Offline c. Invisible 
b. Away d. Do Not Disturb 

9. Which of the following tasks can you perform while on a VoIP conference call? 

a. Share your screen with other users. 
b. Send files to other users. 
c. Add other participants to a call already in progress. 
d. You can perform all of these tasks while on a VoIP call. 

10. Which of the following is true of video conferences? 

a. They can make remote employees feel included in company functions. 
b. They can make remote employees feel more cohesive as a group. 
c. They are a good tool for sharing visual demonstrations. 
d. All of these statements are true of video conferences. 

11. Which of the following tools can you use to conduct video conferences? 

a. Skype 
b. Google Hangouts 
c. FaceTime 
d. You can use all of these tools to conduct video conferences. 

12. Which of the following Office 365 tools provides for content management and co-authoring of 
documents? 

a. Outlook Web App (OWA)  c. Office Online 
b. SharePoint   d. Skype 

13. Which of the following broadcasts live audio/video footage over the Internet? 

a. Downloading   c. Uploading 
b. Live streaming   d. Asynchronous communications 
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Living Online 
 
 

Lesson 16: 
Understanding Email, 
Contacts, and Calendaring 
Lesson Objectives 
This lesson teaches you what email programs are available and how email plays an important role in 
communicating with others. You will also learn to manage contacts and work with a calendar. Upon completion 
of this lesson, you should be able to: 

 recognize various email programs 

 understand how an email address is structured 

 understand email etiquette  

 create and send a new message to one or more 
recipients 

 understand how to attach items to a message 

 recognize when to reply, reply to all, or forward a 
message 

 understand how to create a signature  

 understand how to deal with spam or junk mail 

 manage mail for deletion or archiving 

 understand how to manage contacts 

 understand how to create single and recurring 
events or appointments 

 manage and share calendars 

Working with Email 
Objective 3-3.1 

Before you can use email, you must have an email account. An email account can be provided by your ISP, 
provided by your school or organization, or provided by a web-based email provider such as Gmail, Live, 
Hotmail, iCloud, Zoho, or Yahoo!  

You can choose a desktop application such as Outlook 2013 or Thunderbird 17. This means installing the 
application to the local drive on the computing device and configuring the account correctly so that you can 
send and receive messages. Desktop email clients are generally used with email accounts hosted by an ISP 
(although many ISPs offer a web-based interface for working with your email). 

If your email account is from a web-based provider, you will log in to a web-based interface for working with 
your email account. All you need is a browser and an Internet connection. Updates to the email program for 
the browser environment are handled by the vendor and generally do not require any maintenance from 
you, whereas if you use a desktop application, you will be notified when updates are available and you will 
have to update your email client manually.  
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An email address is structured as follows: 

 
Mailbox Name  

• Identifies a particular mailbox on an email server, and is based on company or ISP standards for email 
addresses.  

• Some providers, especially web-based providers, allow you to create your own mailbox name, providing 
it is unique.  

• The mailbox name is also considered the user name for the given account. 

Name of Organization  
• The middle part of an email address identifies the organization that owns the email server.  

• This part of the address could be the full formal name of the organization, a shorter version of the 
company name, or a unique combination of words. 

Domain Category  
• Identifies the type of domain; for example, .com refers to a commercial organization while .uk refers to 

a country and the organization type, such as uk.co or uk.edu. 

The jsmith@ccilearning.com address indicates that the address belongs to someone at a commercial 
company called CCI Learning. A fairly common company standard for mailbox names is to use your first initial 
followed by your last name. In the example email address, the user's first name begins with "J" and the user's 
last name is “Smith.”  

The j.smith909@myisp.uk.co email address suggests this address belongs to someone with the same first 
initial and last name as many other people; the number “909” helps to make this address unique. The account 
is with a company called My ISP, which is located in the United Kingdom. 

Using an Email Program 
Objective 3-3.1, 3-3.5,  

Note: There are many email programs currently available; however, you will use only the web-based 
interface for Gmail in this lesson. Remember that the concepts remain the same regardless of the email 
program; the differences lie in where the commands and features are located in each program. 

A popular web-based email program is Gmail, available through Google. No installation is required; all you 
need to do is create a Gmail account. You can quickly access Gmail by navigating to the Google web site and 
then clicking the Gmail link, usually shown on the top right corner. 

A typical Gmail Inbox is shown in the following figure. 

 

jsmith@ccilearning.com  j.smith.909@myisp.uk.co 

Mailbox 
Name 

Name of 
Organization 

Domain 
Category 

Mailbox 
Name 

Name of 
Organization 

Domain 
Category 
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Account/App Options 

• At the far right of the Google search field, you will see the account currently logged in, the Google Apps 
icon, a bell icon indicating any notifications, and an icon to change your profile or switch to another 
account. 

• The Google Apps icon displays a menu of other apps you can use, such as Calendar or Hangouts. 

Navigation Tools 

• This bar contains buttons to help you navigate or select items on the screen. 

• The three buttons at the left pertain to the Inbox tab contents. 

  
• The buttons at the right will help you move between messages. 

  
Settings 

• Click the button with the gears icon to make changes to default settings in Gmail such as the adjusting 
the display mode, applying themes, or accessing account settings. 

  

Communication Options 

Settings 

Labels Navigation Tools Inbox Tabs Account/App Options 

Inbox Tab Contents 
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Labels 

• Folders you can use to organize your messages to find on a later date. To see more, click the More labels 
command. 

Inbox Tabs 

• The Gmail Inbox is organized into three tabs called Primary, Social, and Promotions. Use these tabs to 
help organize your messages. Messages can be managed in the same manner regardless of which tab 
they appear on. 

  
• Each tab displays the items you receive via email. Google attempts to categorize incoming messages for 

you. 

Communication Options 

• Use these icons when you want to communicate with someone else through Google Hangouts, either 
via phone or chat. 

• Contacts will appear in the left panel below the labels and your login. 

• Click the magnifying glass to view more details about a contact. 

Creating New Messages 
Sending an email message is similar to mailing a traditional letter. You write the body of the message, add 
address information and then send it. You must have an active email account before you can send or receive 
mail. To send mail, you must know the email address of each intended recipient. To send a message, follow 
these steps: 

1. Create a new mail message. 

2. Address the message to the recipient. Enter the email address for a Bcc or Cc recipient, as applicable. 

3. Type the text for the subject, and then type the message, applying any formatting as required, such as 
bold text or indented paragraphs. If you need to email someone a file, attach it to the mail message. 

4. Use the spell checker and proofread your message to eliminate spelling or grammatical errors. 

5. Send the message. 

Once you click the Send button, the message is sent to the email server for delivery. Gmail does not display 
an Outbox folder on a computing device such as a notebook; if you are using Gmail on an Android device, 
you will see an Outbox folder. Gmail will display a brief message confirming the action below the navigation 
bar. If there is a problem with delivering the message, Gmail will send an email indicating the error. 

To create a new message in Gmail, in the left panel, click Compose. 
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Once the new message window appears, type in the email addresses for the intended recipients or choose 
names from the list of contacts stored on your system. Regardless of the email program, the components of 
an email message are the same. 

An email message includes: 

• Recipient of New Message 

– You must enter at least one email address for an intended recipient.  

– You may send a message to several recipients by specifying more than one address.  

– The addressing lines are very important as they identify who will receive the email message: 

To – identifies the primary recipient(s) of the email.  

Cc or “carbon copy” – lists individuals who will also receive a copy of this email; when you list 
recipients in the Cc field, it is an indication that you are sending a copy of the message to them for 
information purposes only. That is, you do not expect a response from them. 

Bcc or “blind carbon copy” – lists individuals who will also receive a copy of this email. However, 
listing recipients in this field prevents anyone from seeing the email addresses. That is, no one else 
will know that the message was also sent to someone listed in the Bcc field.  

• Subject line 

– A summarized single line of text to let the recipient know what the message is about.  

– Always enter something in the Subject line or the message could be flagged as junk by the mail 
server. 

• Message pane 

– This is where you will enter the main text or body of the email message. 

– Most programs provide basic formatting options such as applying bold or italics, changing the font 
or the font size, and so on.  

   
  

Message 
 

Recipient(s) of 
New Message 

Formatting 
Toolbar 

 Attach Items 

Topic of Message 

Signature 
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• Signature 

– This is an optional block of text that includes your name, title, and possibly your contact information. 
A signature is usually added to the end of an email message. A signature is not required, but it is 
good business practice to include an email signature. 

• Attachment Items 

– This toolbar contains buttons for various files that you send along with an email message. 
Attachments can include pictures, videos, or documents. Attachments are optional, and can greatly 
increase the size of an email message. 

   

Using the Contacts List/Address Book 
An email address book (or Contacts list) is a directory of contact information. Most entries include at least a 
name and email address. Using the address book is a fast and accurate way to insert email addresses into an 
email message. To access the list of contacts from the new message window, click the To, Cc or Bcc buttons.  

Click the contact(s) you want to add to the address field, then click the Select button to insert their addresses 
into the appropriate address field in the New Message window. If you change your mind about a recipient, 
you can remove a recipient from the address field in the New Message window by clicking the x that appears 
to the right of the recipient’s name.  

Proofing Your Message 
Always try to maintain a professional tone in your 
messages, even with people you know very well. 
This reflects well on you and your company, as well 
as on any products or services you provide. 

Spell checking is now automatically included with 
any web-based email program. This means the spell 
check feature will try to correct any words it thinks 
are errors; however spell checkers are not perfect, 
and they may flag certain industry-specific terms as 
misspelled when in fact they are spelled correctly. 
Keep in mind that the spell check option is designed 
to find common errors but it does not look for 
capitalization, punctuation, or grammar errors. This 
then places an extra onus on you to proofread your 
message to ensure the message is grammatically 
correct. Of course, it is also up to you to ensure that 
any information in the message is accurate and 
clear. 

Sending the Message 
Once the information for the message has been entered into the Address and Subject lines, and the body of 
the message, click Send. 
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Exercise 16-1: Creating Messages  
In this exercise you will create new email messages. If you do not have an account with Gmail, please refer 
to Exercise 4-13: Using Gmail to email attachments in Lesson 4 and create an account before proceeding. 

1. Open the Google Chrome browser and navigate to www.gmail.com. Sign in with your account name and 
password. 

2. Click Compose near the top left corner of the screen. 

3. Click in the To field and type the email address of the person to your right. 

4. Click the Cc link at the far right of this field and type the email address for your teacher, as applicable. 

5. Click in the Subject field and type: My First Message in Gmail. 

6. Click in the message body area and type the following: 
This is my first email that I am sending using Gmail in this lesson. It is 
amazing how easy it is to send a message to someone. 

7. Double-click the word easy, and in the Formatting toolbar at the bottom of the New Message window, 
click Bold. If the Formatting toolbar is not visible, click the Formatting options button to the right of 
the Send button.  

8. Double-click the word Gmail in the message and on the Formatting toolbar, click Text Color and then 
in the Text color palette, click the blue color RGB, (0, 0, 255).  

9. With the word still selected, click Bold on the Formatting toolbar. 

10. Click the Send button at the bottom left of the New Message window to send your message. 

11. Click Compose to create another new message. 

12. Address this message to the person at your left and include a Bcc to the person at your right. 

13. Type: Birthday Surprise for the subject title. 

14. Click in the message body and type the following: 
We are meeting at the restaurant at 6:30pm, a half hour before Andrew arrives. Sandy 
has made the arrangements for a private room, as well as for the decorations and the 
special cake. 

15. Send the message. 

Receiving and Replying to Messages 
Most email programs will automatically check for new messages as soon as you log into the program. One 
of the benefits of using email is that a message can be sent to you at any time, even when you are not logged 
into the email program. All new messages addressed to you stay on the mail server until you log in to retrieve 
them into your Inbox. 

http://www.gmail.com/
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When you log into your Gmail account, any messages you receive are listed in the Inbox folder until you 
choose to move or delete them. New messages appear in one of three areas, as seen in the following image: 

 
To view a message (new or previously read), click it to open it on the screen.  

To return to the Inbox to view another message, click the  (Back to Inbox) button from the row of 
buttons above the message. 

Notice the box that appears below the message with response options: Reply or Forward. If this message 
had been sent to multiple people, you would also see the Reply to all option. 

 
You can click one of these links to make the appropriate response. Alternatively, you can click the Reply 
button at the right of the message data, or click the arrow to display a list of other actions you can take. 

 
Reply – Send a reply to the sender of the message only. 
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Reply to all – Send a reply to everyone listed in the To field and the Cc field. Use this option with discretion. 
Often it is not necessary to send a response to everyone, such as the people who received a copy of the 
message for reference only. 

  
Forward – Send a copy of this message to someone else (not listed as a recipient of the original message). 
This is like sending a new message that already includes content. 

  
As you begin to respond to messages and receive replies to messages, a conversation is formed. Gmail 
automatically groups messages into conversations. You can open (or expand) a conversation to the flow (or 
thread) of the messages. 

Looking at Message Headers 
As email users, we concern ourselves with the From and To addresses in a message. However, quite a lot of 
additional information is included in each message in an area called the header. The header includes data 
about the origination point, the destination point, and the path that the message took to get from one to 
the other. You might want to examine the header if you suspect an email message might be a phishing 
exploit or if you do not think the message came from the person listed as the sender. 
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To display the header detail, open a message, click the down arrow for the Reply button at the far right of 
the open message, and in the drop-down menu, click Show original. The header information is listed in 
reverse chronological order; the data at the top is the most recent event, so if you want to trace the message 
from the sender, start at the bottom. 

 

Organizing Messages 
As you use your email account, your Inbox will begin to fill with messages and not all of them have the same 
urgency. Some messages require immediate response, some can wait, some require follow-up later, and 
some might just contain general information.  

Selecting Message 

Every message has a checkbox at the left that you can use to select that message for another action. To select 
multiple messages, click each message to which you want to apply an action. To select all messages, click the 
Select button above the Primary tab. You can also click the arrow for this button to display various types of 
messages to select. 

Creating Folders 

To keep yourself organized, you can set up folders and sub-folders for storing your messages. 

To create a new folder, in the Folders List, click More labels and then click Create new label.  
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Enter the name for the new label and then press ENTER. The new label will then be listed near the bottom of 
the List. 

If you want this new label to be nested below another label, click Nest label under and choose the label 
from the drop-down field below the command. Your new label is now a sub-label. 

You can create as many new labels or nested labels as you need to manage your messages. You can also 
delete labels at any time.  

Moving Messages 
Once you have your labels in place, you can organize your messages by moving them under the appropriate 
label. To move messages, first select them, then use one of the following methods: 

• Click the Move to button to move selected messages to the designated label; or. 

  
• drag the selected messages over the label where you want to move the messages. 

  

Using Signatures 
A signature is a block of text that is automatically added to the end of your messages whenever you create 
a new message. This saves you from having to enter your name and information or a product slogan each 
time you send a message. You can create as many signatures as required, but only one can be designated as 
the default signature. Enter text as appropriate for the purpose of the particular email account; for instance, 
if this is a business account, ensure your name, title, company name, and contact information are included 
so business customers know who you are and who you represent If this is a personal email account, you 
could use the nickname that most people know you by – that is, you can be informal in the signature. 

To create a signature, from the top navigation bar, click the Settings button and then click Settings. Scroll 
down until you see the Signature area: 
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Click in the box and enter the text you want to use as your signature. Notice you can apply formatting and 
that you can specify to insert the signature before quoted text in reply messages.  

Once you have entered the signature, scroll to the bottom of the setting options and click Save Changes. 

To turn off the signature click the Settings button, click Settings and in the Signature area, click No 
Signature. Click Save Changes. 

Working with Attachments 
Sending attachments with your email enables you to share information. However, consider the following 
points regarding attachments: 
• Keep the attachment file size as small as possible. The size of an email message includes the size of any 

attachments.  
• If your attachment can be viewed online, consider including a hyperlink or a URL link in the body of your 

email instead of sending a large file as an attachment.  
• Consider the nature of the attachment and whether email is the best way to send it. The more secure or 

confidential a document is, the more you may want to use traditional methods (such as postal mail or 
courier delivery) to send the document. 

• Consider the file type and whether the recipient has a program that will recognize and open it. In an 
effort to screen out junk mail and minimize security risks, some organizations or schools configure their 
mail servers to block email messages with certain types of attachments. 

• Some email servers are configured to block messages that include graphics or URLs. If you send a 
message containing these elements and do not hear back within the expected period of time, consider 
sending a follow-up email inquiring whether the first message was received. Alternatively, contact the 
person by telephone for an immediate response. 

• Attachments are notorious sources of viruses and other malware. Always set your antivirus program to 
automatically scan and check all incoming and outgoing mail to prevent any viruses from entering your 
network, or being sent from your computer to others. 

To attach or insert a file in an email message, from the toolbar across the bottom of the window, click Attach 
files. You will need to navigate to where the file can be found, select it and then click Open. Repeat the steps 
as necessary to add more attachments from different locations. 

 
You can attach other items as required to your messages. For instance, you may want to send a couple of 
pictures from your last vacation to a friend, or send pictures from a work site to a colleague along with an 
inspection form saved on Drive.  

 Attach Insert Insert 
 Files Photo Emoticon 

 Insert files Insert 
 using Drive link 
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Be mindful of the number and size of the attachments you include with a message. Web-based email 
programs impose a maximum file size limit of 20-25MB. In Outlook, the maximum size is 20MB. In general, 
if you send a message with a large attachment, the email program will notify you that the size is too big to 
be sent. 

If you decide not to send (or no longer want) the attachment, in the message click the X at the right of the 
file name. 

  

Viewing Attachments 
When you receive a message with an attachment, Gmail displays a horizontal paper clip at the right of the 
Subject title. When you open the message, you will be able to see the message as well as preview the contents 
of the attachment; the attachment icon (paper clip) appears at the top of the message to remind you that a 
file is attached. 

 
Point at the preview to activate the options for handling the attachment: 

 
You can choose to download the attachment, save the file to your Drive location, or edit the file using Google 
Docs. Once an attachment has been saved, it can be treated in the same manner as any other file; that is, you 
can move it to another location, copy it to multiple locations, insert it into a document, delete it, and so on. 

One habit you may want to adopt is to scan any files you download to your computer before you open them. 
Use an antivirus program to scan incoming messages.  
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Exercise 16-2: Working with messages 
In this exercise, you will respond to some messages and organize messages in your Inbox. 

1. Click Compose and address the message to the person at your right. 

2. Type: Events List as the subject, and then type the following for the message body: 

Attached is the list of upcoming events for the rest of the year that we were 
interested in attending. Of course, we cannot attend all of the events so I need 
you to highlight the ones you most want to attend, and if possible, prioritize 
the events. 

That way, we can work on trying to get those tickets as soon as possible. 

Thanks! 

3. Bold the word, prioritize and also change the color to red RGB (255, 0, 0).  

4. On the toolbar to the right of the Send button, click the Attach files button. 

5. Navigate to the location where the student data files are located for this course. Then select the Events 
List document and click Open to attach it to the email message. 

  
6. Send the message. 

7. In your Inbox message list, click the My First Message email message to open it. 

8. Click the Reply link and type: Yes, I agree. Gmail seems very easy to use, and I look forward to 
working in the Calendar. Send the message. 

9. Click the Back to Inbox button, or click Inbox in the labels on the left 

10. Click the Birthday Surprise message and then click Forward. 

11. Type: nklassen@tolano.com in the To field. He will be the recipient of this message. 

12. Type: For your information only as the body text and press ENTER. Then send the message. 

13. Return to the Inbox and then open the Events List message. 
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14. Point at the preview of the attached file, then click Download. 

 When you download files in the Chrome browser, a button with the downloaded file’s name displays at 
the bottom of the bowser window when the download is complete. You can click the button to open the 
downloaded file. In other browsers, you may or may not be able to open the file from within the browser 
window. You can, however, access the file using File Explorer. The default location for downloaded files 
in Windows 10 is the Downloads folder (C:\Users\<user name>\Downloads). 

15. Click the Events List.docx button to open and view the document. 

16. Close Microsoft Word and then return to the Inbox. 

17. Click More labels and then click Create new label. 

18. Type: Personal and press ENTER. 

 This label now appears at the left below the Drafts label. 

19. Click Create new label once more, type: Miscellaneous, click Nest label under. Click the arrow to select 
Personal. Click Create. 

 Notice the Personal label at the left now displays an arrow at the left of the label. 

20. Click the arrow to display the contents of this label. 

  
21. Click the checkbox at the left of the Events List and the Birthday Surprise messages. 

22. Drag these messages over to Miscellaneous. 

 Gmail should now display a message near the top of the window confirming that you have moved the 
messages. 

Managing Spam 
Spam refers to unsolicited mail; often spam messages promote products and services, or convey specific 
political/religious views. Spam mail is the same as junk mail. People or companies who send these types of 
messages are called spammers. 

Spammers buy email address lists from companies that specialize in email marketing. It is natural for 
companies to want to market their products and “keep you informed.” Reputable companies will ask for your 
email address and ask for permission to give your address to other companies who sell associated products 
and services. Companies must make their privacy policy available for viewing; the privacy policy must describe 
how your personal information may be used or shared. If you are visiting a web site and you are asked to 
create an account or sign up to receive a newsletter, check the privacy policy to see how your information 
may be used or shared. Creating an account, or providing your contact information is the same as giving 
your consent to share that information as outlined in the policy.  

Most email programs include a filtering feature to block spam or other junk email. Many ISPs also run active 
spam filters on their mail servers to block the most common types of spam mail before they reach your email 
Inbox. You can also download and install a variety of programs to help block any spam messages that sneak 
by your ISP. 
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Following are some ways to avoid being placed on a list that results in your receiving spam messages: 
• Do not allow your email address to be added to any marketing address lists. When you visit a web site 

that asks for your email address, be sure to read the company’s privacy policy. Provide your email address 
only if you are sure the company will not sell it or share it. 

• Set up an additional email account, separate from your main personal/business account, with a web-
based email service that you can use for these types of requests. This separates the email you want from 
the email you don’t want; when you check your secondary account, you can delete all the junk messages 
at once. 

• Do not reply to any email that you consider to be junk even if the message says that your name will be 
removed from their list if you respond as indicated. In all likelihood you are simply confirming that your 
email address is valid, which can then result in you receiving even more spam mail. 

• Avoid putting your name and email address on any public lists, such as adding your name to a mailing 
list at a seminar or signing an online petition. 

• Avoid disclosing your email address in any online forums or newsgroups, as they commonly exchange 
information. If you must provide an email address in one of these online areas, try to use an alias, or 
disguise the address by changing the structure with extra text. For example, you might type out j_smith 
at Gmail dot com or j-smith-nomorespam@Gmail.com. 

• To prevent your messages from being flagged as spam by email servers, follow the general guidelines 
for sending email. Always include appropriate text in the Subject line. Many spam filters search for 
Subject lines that include Hi, Re: Re: Your Order, and so on. 

• You can also receive junk mail through other electronic communication devices such as cellular phones 
and PDAs. With text messages you may be able to stop receiving spam by sending a text message with 
the word “STOP” to the originator. 

Dealing with Junk Mail 
Gmail provides the  (Report Spam) button you can click to report a specific message as being spam 
or junk mail. This will also add the sender to the list of email addresses that are blocked. You need only select 
the message and click this button to move the message into the Spam folder. Gmail also displays the 
following image in case you need to undo the action: 

 
To view those addresses that have been blocked, click the Settings button, click Settings, and then click the 
Filters and Blocked Addresses link across the top: 

 
Notice that you can unblock someone from the list, as applicable. 

If you are not sure a message should be reported and therefore blocked in future, you can always use the 
Move command to place this message in the Spam label (folder) at the left. 
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Archiving Messages 
To keep all your messages but also keep items organized in your Inbox, you can archive your old messages. 
Archived messages are moved from the Inbox and stored in a separate folder.  

To archive messages, select the messages you want to archive and then click the  (Archive) button. 

Archived messages are placed in the All Mail label for further action, as required. For instance, you could 
create nested labels here to further organize messages. 

There is no limit to the number of messages you can archive. Even if you reach your maximum storage 
capacity for your Gmail account, the archived messages remain in the All Mail label – nothing is automatically 
deleted.  

Before you decide to archive every message, consider how valuable the message is and whether it should be 
moved to a label for future reference, or simply deleted as it is unlikely you would refer to it again. 

Deleting Messages 
To delete a message, select it and then click the  (Trash) button. You can view messages in the Trash 
label at any time by clicking that label. Messages remain in the Trash label for 30 days, and are then 
automatically deleted. 

To delete a message permanently, select the message in the Trash label and then click Delete forever. 

To delete all messages from the Trash label, click the Empty Trash now link. 

Using Contacts 
Your contacts are the people you exchange communications with. In Gmail, you work with your contacts 
through a view called Contacts Preview. To get to Contacts Preview, click the Gmail link and then click 
Contacts. 

Hint: You can also click the Google apps button, click More and then click Contacts. 

 

People 
you have 
added to 
Contacts  

People you 
exchange 
messages 
with 
frequently 



Lesson 16 Understanding Email, Contacts, and Calendaring 
 

 

534  7500-1 v1.00 © CCI Learning Solutions Inc. 

Note: If your screen shows the older Contact Manager interface, click the Try Contacts preview link. 

Your “All contacts” list displays by default and includes two sets of people: 

Frequently contacted – a list of everyone who has written to you or received a message from you 

All contacts – a list of contacts that you added or edited yourself. This list is also updated when you sync 
your mobile device with the computer. 

To add a contact manually: 

1. Click the  (Add new contact) button. This opens a window for entering a contact name. 

 
2. Type a name for the contact, then click Create. This opens the Edit contact window, which you can use 

to add contact information. 

3. Enter the pertinent information, then click Save. 

You can also add an email address to your Contacts list from an open message. Point at the email address 
and in the pop-up window that opens, click the Add to contacts link at the bottom left of the window 

 
To search for a contact, enter the name in the Search for anyone field above the contacts. 

Address Books  
Although many people use the terms Contacts list and address book interchangeably, for purposes of 
distinction we will say that an address book is a central location where contact information for an entire 
organization is stored. Many businesses which use Microsoft Exchange, Exchange Online, or other locally 
managed email servers, provide a global address book that all employees may access. Address books such 
as these are created and maintained by the network administrator. The address book may include company-
defined distribution groups as well as individual contact entries. In addition to using the global address book, 
employees can still maintain their own contact lists.  

Organizations that use web-based email programs do not provide an address book for their employees; 
however, each employee can manage his or her own contact lists, and can share contact information with 
other users.  

Most Desktop email programs also allow you to import contact lists created in programs. Generally, you 
would export your contacts from the original program to a .CSV or a vCard file, and then import the generated 
file into the new program. Some web-based programs include links for importing contacts from other web-
based accounts. 

In Gmail, you can import contacts from an exported file or from other web-based programs. 
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To import a contact list into your Gmail account, on the panel at the left, click More and then click Import. 
Make your selection, then follow the on-screen prompts. 

 

Exercise 16-3: Working with contacts 
In this exercise you will work with the Contacts feature and add a new contact. 

1. Click the Gmail link and then click Contacts. 

 Because you have already used your Gmail account to send and receive messages, there are probably a 
few contacts that already appear in your frequently contacted list. 

2. In the Frequently contacted area, click the email address (or name) of the person sitting at the right to 
open the Contact card. 

3. Review the information on the contact. Then click the  (Edit contact) icon to edit information for the 
contact. 

4. Click the Add notes link to open the field, and type: Gmail contact. 

5. Click Save. 

 The information now appears below the contact email address in the Contact card. 

6. Click the Back arrow to return to the contacts list. 

7. Click the Add new contact button at the lower right corner of the screen. 

8. Type your name and click Create. 

9. Click Add an email to open the field, and enter a personal email address. 

10. Click Add note and type: new contact for practice. Then click Save. 

11. Click Back to return to the contacts list. 

 There should now be a contact in the All contacts list with your name. 

12. Click the checkbox to the left of your name and a new toolbar will appear across the top of the screen. 

13. Click the  button to indicate you want to delete this contact. 
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 You can choose to simply delete the contact information at which point you could “restore” this 
information from the Trash folder. You can also choose to remove it from the contacts list. 

14. Click Remove from the “All contacts” list option. 

15. Ensure your contact is still selected, click  and then click Delete. 

 The contact no longer exists in the contacts lists. 

Using the Gmail Calendar 
Objective 3-4.1, 3-4.2, 3-4.3, 3-4.4 

You can schedule various types of events such as appointments and meetings in the Calendar.  

• An appointment is an activity that usually only involves you – such as a lunch date, a dental appointment, 
or a personal engagement. An appointment blocks the time in your calendar.  

• A meeting is an appointment to which others are invited and may involve reserving resources such as 
rooms or audio-visual equipment.  

Events that last an entire day or longer, such as an out of town conference or a birthday or anniversary do 
not block out time in your calendar. 

When you schedule appointments, meetings or other activities which take less than a full day, the time in 
your calendar can be marked as free, tentative, busy or out of office. This is a very useful feature, especially 
if you want others to be able to see your availability. A colored bar indicating your availability will be displayed 
in your calendar. 

To access the calendar in Gmail, click the Google apps icon at the top right corner of the screen, and then 
click Calendar. 

 

Date Navigator  Navigation Bar View Mode Google Apps 
 

Current Day 

Current Time 

Time 
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Creating an Appointment 
There are three methods you can use to enter an appointment, depending on how many details you want to 
enter when you create the appointment: 

• To quickly create an appointment, click the arrow for the Create button to activate the Quick Add option: 

   
• The second quick method is to click at the starting time for the appointment on the day of the 

appointment. Gmail then displays a window for you to fill in: 

  
• To enter details when you create an appointment, click Create to see the New Message details screen 

(this is also the Edit screen), which allows you to name the appointment, select a date and time, enter 
notes, configure notifications, attach items, or even change the appointment into a meeting by adding 
guests. This is the same view you will see if you click an appointment on your calendar and click Edit 
event. 
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You can enter further details for the appointment as needed. Not all the options shown here are required for 
every appointment; in some cases, features such as attaching a file as reference for an appointment can be 
helpful. 

Creating Recurring Appointments  
If you have appointments that occur on a regular basis – say monthly or bi-weekly – you can set up a recurring 
appointment. Gmail will add additional occurrences of the appointment to your calendar on the appropriate 
dates. To create a recurring appointment, click the Repeat link in the Edit screen and Gmail will then display 
the dialog box shown in the following figure: 

 
Once you have configured the settings for the recurring appointment and click Done, Gmail automatically 
adds the recurring appointment to your calendar. If you open any occurrence of a recurring appointment, 
Gmail displays the details for modification, as needed:  

 
You can specify to save your changes to the open occurrence only (for example, you might need to change 
the meeting time for this one date only) or to all occurrences (for example, the location of the meeting is 
permanently changed).   

You can also use the Delete button to delete a recurring event when it is no longer needed: 

 
Notice how you can choose to delete this one instance of the meeting, delete all occurrences of this meeting 
from now on, or delete all occurrences (past, present, and future) of the meeting from the calendar.  
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Inviting Others to a Meeting 
When you invite others to an appointment, the appointment becomes a meeting. To do this, open the Edit 
screen, click in the Add guests box, type the email address of an invitee and click Add. Repeat for each person 
you want to invite to the meeting. 

Note that as you begin typing an email address, Google may show an address suggestion based on your 
contacts. If the suggested address is the correct one, you can click the suggested address to automatically 
add that person as an invitee. 

Working with Multiple Calendars 
In addition to updating your own calendar, you can share your calendar with others and request to view 
other people’s calendars as well. 

To share a calendar with someone, expand the My Calendars list and click the arrow to the right of your name 
to see a menu of options.  

 
Click Share this Calendar. 
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You can choose to make your calendar public. When you select this option, your calendar is saved to the 
Internet. You can send people the URL of the calendar, or you can embed it in a web page. If you were a 
soccer coach, for example, you could publish a calendar that lists the dates and locations for your team’s 
upcoming games. Public calendars can also appear in search results pages.  

You can also elect to share your calendar only with specific people. In the Share with specific people area, 
you can enter the email addresses of people with whom you want to share your calendar.  

Regardless of how you share your calendar, you can select the type of permissions you want others to have 
with your calendar: 

 
Notice how you can restrict the type of information others can see on your calendar – you do not necessarily 
have to share everything. Once you make the appropriate selection in this area, click Save at the bottom of 
the screen to keep the settings. 

Adding Another User’s Calendar  
If another user (let’s call him a colleague) decides to share his calendar with you, you will receive an email 
notification that a calendar has been shared with you. 

 
Google automatically adds the shared calendar to your Google Calendar account.  

Click the View Your Calendar link in the email message to see the name of your colleague’s shared calendar 
in the Other calendars area: 

 
Notice the colleague’s shared calendar appears in a different color than yours. Any appointments on your 
colleague’s calendar will also appear in this color; this helps you differentiate between your appointments 
and those of your colleague.  
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The amount of appointment detail you can see and your ability to make changes to your colleague’s calendar 
will depend on the permissions given to you at the time the calendar was shared. 

If you decide you do not want to show someone’s calendar but do not want to remove it, click the arrow for 
the person’s calendar and then click Hide this calendar from the list. 

Subscribing to a Calendar 
There are various calendars on the Internet that you can subscribe to, similar to the way you would subscribe 
to a newsletter. For example, you could subscribe to the Holidays in Australia calendar. If there is a web site 
for a product or service that you like and they offer the opportunity to subscribe to their calendar, you can 
follow the instructions they provide for subscribing. 

Depending on where you are geographically located, the Calendar provides a few options; for instance, when 
you click the down arrow for My Calendars, and then click Settings, you can access a link that will let you 
subscribe to other calendars. 

 
To view a list of calendars to which you can subscribe, click the Browse interesting calendars link. 

You can subscribe to one or more holiday calendars on the first tab, or you can subscribe to the calendar of 
your favorite sports team by clicking the Sports tab and expanding the list to find the calendar for your team: 
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To subscribe to one of these calendars, you need only select the appropriate calendar from the list. You can 
click Preview to see how the calendar appears:  

 
You can click Subscribe to automatically update your calendar. 

In the More Tools area at the right of the screen, click a link to set up a different calendar: 

 
Add a friend’s calendar 

• If you want to view or subscribe to a friend’s calendar, you can send a request to that person; you will 
not gain access to the calendar until they have accepted your request. 

  
Add by URL 

• If you know the web site address for a particular calendar, you can also enter it directly into this screen 
in order to view to the events on that calendar in your own calendar. 
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Import calendar 

• If you have access to a calendar in another format that is compatible with the Google Calendar, use this 
option to select the file and import the events into your calendar. 

  
The Create a calendar and Manage calendars options on this screen are similar to the options for creating 
and managing calendar settings on the main calendar screen. 

Exercise 16-4: Working with Calendar 
In this exercise you will create some appointments in the calendar and then share the calendar with others 
in your class. 

1. Click the Google apps icon and then click Calendar. 

2. At the far right of the navigation bar, click the Week button if necessary to change the display of the 
calendar. Click Month to see how the view changes.  

3. Click Day to see how this view appears. 

 Notice how the views change to reflect the number of days you want to see; in fact, as you show fewer 
days on the screen, Calendar shows more details for each day, such as a bar with time intervals (an hour) 
to assist you in setting up new appointments. 

4. Switch to the Week view again. 

5. Click once in the time slot starting at 3:30pm for the first Monday after today. 

6. Type: Dental Cleaning as the subject name and then click Edit event. 

7. Click in the Description area and type: Dr. Manuela Contigua, 206-999-8765. 

8. Click Save to save this appointment 

9. Click Create and in the appointment window, enter the following: 
 Title: Status updates 
 Start date: Next Thursday 
 Start time: 9:30am 
 End time: 11:00am 
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10. Click the Repeat option and ensure that Weekly is selected in the Repeats drop-down list. Set this 
appointment to repeat every 2 weeks on Thursday and it should never end. 

11. Click Done to save the recurrence settings.  

12. Type: 3rd Floor Boardroom for the location, and in the Description field, type: Bi-weekly status updates 
for ongoing projects. 

13. Click in the field for Add guests and type the email address for the person at the right. Click Add. Also 
invite the person to the left. 

14. Click Save. Then click Send to send the invitations to the guest. 

 You have just created a recurring meeting and invited other people to attend the same meeting. 

Now try sharing your calendar with someone else in the class. Check with your teacher as to who you will 
share the calendar with; alternatively, choose the person to your left. 

15. Point at your calendar name under the My calendars heading, and click the arrow at the right. Click Share 
this Calendar. 

16. Click the checkbox for Make this calendar public. Also click the Share only my free/busy information 
(Hide details) option. Then click Save. 

 Your calendar is now available to anyone who may enter your name in the search field. 

17. To reverse this, click the arrow at the right of your calendar name, click Share this Calendar and then 
uncheck the two options from step 13. 

18. In the field below Person, in the Share with specific people section, enter the email address for your 
teacher, as applicable. 

19. At the right of this field, click the arrow for the Permission Settings field and click See only free/busy 
(hide details). Click Add Person.  

 The person with whom you are sharing your calendar appears below your name. Only this person shares 
your calendar. Notice the trash can icon at the far right; you can click the trash can icon when you no 
longer want to share your calendar with this person. 

20. Click Save to save your settings. 

Ask a colleague to share his or her calendar. 

21. In the main calendar screen, click in the field below Other Calendar, type the email address for the person 
at your right and press ENTER. 

22. Leave the defaults as is and click Send Invite. 

 You have just sent a request to your friend to share his/her calendar with you. Once your friend has 
accepted your request, their calendar appears in the Other calendars area. Any events in your friend’s 
calendar will be visible in your calendar, but they will display in the same color as appears to the left of 
their calendar name.  
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Lesson Summary 
This lesson taught you what email programs are available and how email plays an important role in 
communicating with others. You also learned to manage contacts and how to work with a calendar. You should 
now be able to: 
 recognize various email programs 
 understand how an email address is structured 
 understand email etiquette 
 create and send a new message to one or more 

recipients 
 understand how to attach items in a message 
 recognize when to reply, reply to all, or forward a 

message 

 understand how to set up a signature  
 understand how to deal with spam or junk mail 
 manage mail for deletion or archiving 
 understand how to manage contacts 
 understand how to create single and recurring 

events or appointments 
 manage and share calendars 

Review Questions 
1. In the following email address, which part is the name of the organization? 
  bv_thorpe@mycable.com 

a. by_thorpe c. .com 
b. mycable d. mycable.com 

2. From the main gmail.com window, how can you open an application such as the Calendar or Hangouts? 
a. Type the name of the application in the Search field. 
b. Click the Google Apps icon. 
c. Click the Google link at the top left. 
d. Click the Settings icon. 

3. What is the purpose of the second toolbar in the New Message window? 
a. To help you format or enhance the look of selected text. 
b. To change where the message body will begin in the Message Pane. 
c. To enable you to attach items such as files or pictures with the message. 
d. To recognize when you are using the Cc or Bcc fields. 

4. How can you use the Contacts List or Address Book when creating a new message? 
a. To identify whether your recipient is online. 
b. To insert the address of a contact as a recipient of the message. 
c. To blacklist a specific individual. 
d. To switch to the Contacts application to add new people. 

5. Why should you always proof read your message even after completing a spell check? 
a. To find any errors where you might have used the wrong word (for example, their instead of there, 

or brakes instead of breaks). 
b. To ensure you are using the appropriate tone. 
c. To ensure that your message is clear. 
d. All of these are reasons for proofreading after running a spell check. 
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6. Why might you want to forward a message instead of simply replying to it? 
a. You want to move this message to another folder. 
b. You want to include this message in the calendar. 
c. Someone else could handle the request in the message better than you can. 
d. There is no difference between using forward versus replying to a message. 

7. What is one criteria you should always consider when sending attachments? 
a. The size of your Sent Items folder. 
b. The size of your Inbox. 
c. The size of the attachment.  
d. The distance from your mail server to the recipient’s mail server. 

8. What can you do to reduce the possibility of receiving junk mail? 
a. Sign up for newsletters you are interested in from a web site. 
b. Refrain from replying to any messages you consider to be junk email. 
c. Use a business email when signing up for information from web sites. 
d. Have all email sent to your cellular phone as the central location for email. 

9. What is an advantage of archiving your messages? 
a. It allows you to keep all your messages, but keeps your Inbox organized. 
b. It saves time by deleting all your messages at once.  
c. It moves older messages to another drive, such as a network drive. 
d. It copies all of your messages and stores the copies as threads.  

10. If you want to invite someone to a meeting, where would you enter the recipient’s name? 
a. In the Quick Add field 
b. In the New Message details screen  
c. In the field that opens when you right-click My calendar 
d. In the field that opens when you click Other calendars 

11. How can you create a recurring appointment? 
a. Click Edit details for the appointment and then click Recurring. 
b. Click Edit event and then press CTRL+F to set the frequency pattern. 
c. Click Edit event for the appointment and then click Repeat. 
d. Copy the appointment and paste it every month in the calendar area. 

12. How can you show or hide a shared calendar? 
a. Click the arrow for the person’s calendar and then click the Hide option. 
b. The calendar automatically opens once you accept the request for sharing. 
c. Click Settings and then click to turn on or off the required calendar option. 
d. You cannot hide a shared calendar. 

13. Which option would you use if you want to subscribe to a specific sports calendar? 
a. Add a friend’s calendar 
b. Add a URL 
c. Browse interesting calendars 
d. Import calendar 
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Living Online 
 
 

Lesson 17: Your Life Online 
Lesson Objectives 
In this lesson, you will learn about your online identity and how to protect it. You will also learn about the adverse 
effects prolonged computing can have on your health. Upon completion of this lesson, you should be able to: 

 describe the purpose of blogs, forums, and wikis 

 understand the function of social media 
networks and how they work 

 understand the difference between open and 
closed social networks 

 describe how to use LinkedIn 

 describe what constitutes your digital identity 

 understand the importance of maintaining a good 
digital identity 

 explain how to avoid cyber bullying 

 understand the health risks that arise from 
prolonged computing 

We Are Social Beings 
By nature, humans are social beings – we need to share our ideas, express our opinions, and make 
connections with other people. 

Some people are content with asking questions while others are happy to share what they know and to be 
recognized as a reliable source of information or advice. Before the digital age, you had to be published in a 
newspaper, magazine, or book to disseminate your knowledge, or opinions, or creative talents to the masses; 
but today there are numerous ways to share what you know with the public at large. (It is, of course, up to 
the public to decide whether to avail themselves of what you have shared.) 

How Do We Share Information? 
Objective 3-5.3 

Almost as soon as personal computers became available, personal computer experts became available too. 
The 1980s and 1990s brought us scads of new software for the booming PC market, but not nearly as much 
software documentation or user manuals. Frustrated users had few places to turn to for help, and so they 
relied on other users – those who had a little more experience, or who (through trial and error) had discovered 
ways to make their new software programs do what they wanted them to do. 

In those early days, you might have had to speak to someone in person or over the phone to get the guidance 
you needed. But when the Internet was emerging, computer bulletin board systems (BBS) made their 
entrance onto the scene. These were electronic message boards; users could log in and type messages to 
one another or post messages for public discussion. These were primitive, text-based communications over 
the Internet; but their popularity and their usefulness did not diminish. They simply evolved into the methods 
we use today for asking, sharing, and disseminating information. 
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Blogs 
Blogs are online journals that include a communications element. Generally, the blog creator publishes or 
"posts" an article about a specific topic, and others can then post comments in response. Blogs can also 
include links to other peoples' blogs.  

Blogs are a way of publishing your own work, and like any published author, the more readers you have, the 
more successful your blog is considered to be. 

If you create and regularly update a blog, and if you can generate and maintain sufficient “traffic” (that is, 
people keep coming to read your posts), you can become recognized as an authority on your particular 
subject. If you include links to other peoples’ blogs and they include links back to your blog (these links are 
called trackbacks), you further validate yourself as an authority on your subject matter. 

To create a blog, you simply navigate to a blog site and create an account. Most sites include templates that 
enable you to start posting articles immediately. To post an article to your blog, you must sign in using the 
username and password you select when you create the account. You can also send a link to your blog to 
other users. 

Below are several blog sites you can visit to create your own blog: 
• Blogger  www.blogger.com  
• WordPress wordpress.com  
• Tumblr  www.tumblr.com  
• Xanga  www.xanga.com  
• Weebly   www.weebly.com 

Blogs can contain a lot of reliable information on a variety of subjects, and they are searchable.  

Forums 
Forums are online discussion sites (also called discussion boards) laid out in a question-and-answer format. 
People on a forum hold conversations in the form of posted messages. A forum is organized into categories, 
and each forum category is divided into topics or threads.  

 
Under the topics, each discussion in a specific forum is listed. Click a category to view the topics, then click a 
topic to view the discussions.  

  

http://www.blogger.com/
http://www.tumblr.com/
http://www.xanga.com/
http://www.weebly.com/
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If you join a forum, you can post a question and wait for knowledgeable users to respond.  

Popular forums include: 
• answers.microsoft.com – discussions about Microsoft products and Windows software. 
• www.cnet.com/forums – forums on hardware, software, mobile devices and more. 
• www.techrepublic.com/forums – a community of IT experts answer questions and share their knowledge. 
• www.pctechbytes.com/forums – computer repair tips and instructions. 
• www.w7forums.com – discussions, news and articles on installation, drivers, hardware and 

troubleshooting Windows 7. 

Wikis 
A wiki is a reference resource that is developed through the collaborative efforts of anyone who wants to 
contribute.  

Wiki pages are hosted on a web server, and managed through wiki software which allows users to freely 
create and edit web page content using a web browser. The pages in a wiki are hyperlinked to one another. 

Wikis are powerful because multiple people can – and usually do – collaborate on a single piece of content 
(let’s call it an article). A single article could have one author or many authors. A wiki pools together the 
knowledge from its contributors to create the best possible collection of information.   

Because wikis are hosted online, you use a search box to find information, and because the pages are linked, 
you can jump from any one article to several other articles. Editing and content creation occurs continuously, 
making it possible to find information on current topics. The efforts of the wiki community at large tends to 
ensure that articles are accurate (if there are points in question, these will often be marked on the page as 
needing citations or supporting evidence).   

There are wikis devoted to entertainment, games, health, reference articles, travel, and more. There are even 
fandom wikis (created and maintained by the fan base of particular movies and television shows) and there 
are wikis about wikis. You can find information about almost any topic in a wiki article somewhere on the 
Web. 

Social Media Networks 
Objective 3-5.1 

A social media network is a dedicated web site that enables users to communicate with one another. Users 
can post information, comment on other people’s posts, upload pictures and videos, play games, send email 
messages or engage in online chat with one another. 

You join a social media site to connect with people. Facebook, Twitter, LinkedIn, Pinterest, Tumblr, Instagram, 
Flickr and Vine are just a few examples of popular social media sites. The following figure shows pages from 
Facebook, Twitter and Tumblr. 

http://www.cnet.com/forums
http://www.techrepublic.com/forums
http://www.w7forums.com/
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You must create an account on a social media site before you can use it. Users who are under the age of 
thirteen may need a parent’s permission to create an account. 

When you join a site, you create a profile. A profile is a collection of information about you. It usually includes 
your name, your picture, a list of your interests and hobbies, and perhaps general information about where 
you live. Once you create a profile on a social media site, the site creates a page for you. You can then post 
pictures, video, or text about yourself on your page.  

Building the Network 
Once your page has been created, you then go about the task of inviting other people to connect with you 
(on your page) on this social media platform. Depending on the site you are using, these people may be 
called friends, or contacts, or connections; the terminology is not important. The important point is, these 
are the people who constitute your social network. A social network is a network of people – people you 
know, and people who know people that you know. 

The power of a social networking is that your current friends can lead you to new friends. 

Friends and Friend Requests 
You invite people you know to be your “friends” on the site. Friends can see your page and your information. 
Anything you post on your page can be seen by all your friends, unless you take extra steps to share certain 
items with only selected friends. 

You will probably also receive friend requests from other people who have their own pages on the site. A 
friend request is an invitation to become online friends. When you accept a friend request, you can then visit 
your friends’ pages. And while you are there, you can see all of their friends, and send friend requests to 
these people as well.  

Note: As a matter of personal safety, you should accept friend requests only from people you know. On 
some sites, you might consider asking a friend to introduce you to someone with whom you want to 
connect. 
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Why Do People Join Social Networks? 
People join social media networks for a variety of reasons – to find old friends, or keep in touch with current 
friends, or to find new friends too. Some people join professional social media sites to expand their list of 
business contacts, to promote themselves, to advertise their particular skill sets, to look for job leads or to 
find people to fill open positions. Companies often create social media pages as a means of advertising 
upcoming events, to post job openings, and to promote brand awareness. 

Often, social networks include blog, photo, message and chat features, and some people use social 
networking platforms as a way to collaborate with others. 

Popular Social Media Networks 
There are several types of social networks geared for specific purposes and for sharing different types of 
content. A few of the most popular are listed here: 
• Facebook – designed to help people connect and stay connected, Facebook is perhaps the most popular 

social networking site in the world. The site is available in 17 languages and includes public features such 
as a classified ads board, groups, events, and personal web pages for each member. 

• LinkedIn – a social network for professionals to post information about their job skills, interests, 
education and work history. Users can search for jobs, search for people with specific skills, and join 
groups devoted to specific professions. 

• Twitter – an online microblogging network that allows members to broadcast short posts called 
“tweets.” Registered users can post and read, while unregistered users can only read. To share a tweet 
that you like, you can re-tweet (repost) it to share with your followers. 

• Instagram – a network for sharing photos and short (up to 60 seconds) videos. Users can also apply 
digital filters to their images. 

• Snapchat – a mobile app that allows you to send pictures and videos called “snaps” to friends. However, 
the pictures and videos last for only a brief time, and then disappear shortly after being viewed. You can 
add snaps to your “story,” which is a collection of your photos and videos which will last for 24 hours. 
You can also add captions, doodles, or a lens graphic over the top of a snap. 

• YouTube – a video sharing network. Users can upload, view, rate, share and comment on videos. You 
can find video clips, TV clips, music videos, movie trailers and video blogs on YouTube. Most of the 
content is uploaded by individuals, but advertisers and media corporations also upload material there. 
Unregistered users can watch videos, and registered users can create their own channels and upload 
videos to those channels. Users can also subscribe to channels and receive notifications when new 
content has been added.  

• Vine – a video sharing network that allows you to record and share videos that are up to 6 seconds long. 
Other users can like, comment or re-vine (which means they add someone else’s video to their own 
timeline for their followers to see. 

Open vs Closed Social Media Networks 
Objective 3-5.2 

The social media networks you are probably best acquainted with are open networks. That is, they are open 
to the general public; you simply need to create an account. Most require only a valid email address for sign-
up and there is generally a minimum age requirement (for example, you must be 13 or older to open a 
Facebook account). 
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Enterprises and organizations, however, which often enforce policies that discourage the use of open social 
media networks while employees are at work, can benefit from implementing closed social networks.  

A closed social network is a social network that is private and internal to a company or organization; in order 
to participate on a closed social network, you must have an account that is associated with your organization 
– usually you use your work email address to sign in. 

Closed social networking services can be used for private communication and collaboration within a school 
or organization. 

Advantages of Closed Networks  
Closed social media networks allow businesses to harness and leverage the power of social networking. They 
include message boards, news feeds, shared file locations, search capability and more. They provide a central 
location for discussions, announcements, wikis, and file storage. Instead of emailing file attachments to each 
other, employees can access documents in a secure, central location for collaborative efforts. 

Perhaps even more importantly, closed networks provide an opportunity and a platform for all employees to 
participate in company “happenings” and conversations. Previously, this privilege was limited to managers 
and executives. But now, long-time employees and new hires alike can immerse themselves in the culture of 
an organization, find documents and information on their own, and stay tuned in to what is going on 
company-wide. 

The benefits to very large corporations can be profound. Pearson Education, for example, teamed with Jive 
Software to create Neo – a closed social network that connects over 30,000 employees in over 60 countries.  

Yammer (which is integrated with Office 365) is a closed social network that provides a dedicated site where 
employees can share documents, collaborate on documents, follow colleagues/projects, and follow 
company-specific news feeds. Yammer also allows for the creation of groups, which allows you to join and 
participate in specific project teams or department teams. Mobile apps for Yammer allow you to stay 
connected wherever you are, and you can set up Desktop notifications so that you never miss an update. For 
file storage, Yammer is integrated with OneDrive for Business and SharePoint. 

Slack is another widely used closed social media network. It is a cloud-based team collaboration tool that is 
designed to replace email as the preferred method of intra-company communication. Slack provides 
messaging, notification, and announcement services, supports team collaboration and integrated file storage 
with Google Drive. Closed social media networking allows employees to stay informed about things that are 
happening within the company, makes it very easy to disseminate information, and reduces Inbox clutter – 
instead of having to send an email announcement to all your employees, you can post an announcement to 
Yammer or Slack and everyone is notified. This makes users and IT departments happy. 

Note: Facebook began as a closed network; its membership was originally limited to Harvard University 
students. Membership was later expanded first to other colleges in the Boston area, then to schools in the 
Ivy League, then to most universities in Canada and the United States, then to corporations, and then finally 
to the public. 

  



Your Life Online Lesson 17 
 

 

7500-1 v1.00 © CCI Learning Solutions Inc.  553 

Taking a Look at LinkedIn 
Objective 3-5.1 

LinkedIn is a social network of professional connections. You might think of it as an online resume or a job 
board, but it is so much more. The purpose of LinkedIn is to be visible, searchable, and findable. It is a 
platform on which you can get your name, talents, and abilities in front of people who are looking to hire or 
to contract. 

On LinkedIn, people in your network are called connections. When your connections look at your profile, they 
can see your information, they can see how they are connected to you, and they can see whether you have 
any connections or other characteristics in common. 

Your network is made up of 1st degree, 2nd degree, and 3rd degree connections, and members of any 
LinkedIn groups that you have joined.  
• 1st degree – these are people you're directly connected to either because you have accepted their 

invitation to connect, or because they have accepted your invitation. You can contact them by sending 
a message on LinkedIn. 

• 2nd degree – these are people who are connected to your 1st degree connections. You can send them 
an invitation to connect. 

• 3rd degree – these are people who are connected to your 2nd degree connections.  

Each person’s degree of connectedness to you is represented by an icon that displays next to their name in 
search results pages and on their profiles. To see your 2nd degree connections, you can access one of your 
1st degree connection’s profiles, then view their contacts.  

 
When you click the name of a 2nd degree connection, LinkedIn will show how you are connected.  

 
You can also use an Advanced LinkedIn search and specify to show 2nd and 3rd degree connections. 
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Creating a LinkedIn Account 
To create an account on LinkedIn, go to www.linkedin.com and click the Join now link. 

Enter your first and last name, email address and desired 
password, then click the Join now button. The email address 
that you specify will be your LinkedIn sign in. 

A wizard walks you through setting up your account. The first 
three pages are about you, your job and your job field. You will 
have an opportunity to import your contacts from your email 
account, upload a photo of yourself to add to your profile, and 
select various channels to follow. Channels are newsfeeds on 
specific topics that you can subscribe to. You can add a phone 
number to receive text messages and you are encouraged to 
download the mobile app.  

You will receive an email asking you to confirm your email 
address – this is important because your LinkedIn profile is tied to your email address. Click the link in the 
email message to conform your address and your account will be set up. 

Creating Your LinkedIn Profile 
As soon as your account is created, you can start building your profile. By default, your profile page shows 
your name and your current job title. 

 
Tip boxes may display on the screen to point out various tools and sections.  

  

http://www.linkedin.com/
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To upload a photo to your LinkedIn profile click Add a photo to open the Edit Photo dialog box.  

 
In the Edit photo dialog box, click Choose File to open the Open dialog box. Navigate to a saved photo and 
double-click it to upload it. You can then preview how the photo will appear.  

 
Drag the yellow square to change the position and size of your photo. The arrows below your picture allow 
you to rotate the picture right or left. When you are satisfied with the appearance of your picture, click Save. 
The photo is saved to your profile.  

When you build your profile you structure it like a highly detailed resume. There are sections for work 
experience, education, volunteer work, certifications, courses, volunteer experiences, awards, and other work-
related information.  

As you point the mouse cursor over various fields, they will display an  (Edit) icon. Click the Edit icon to 
open the field for editing. Enter the relevant information, then click Save. 
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The top section of your profile contains at-a-glance information about you. 

 

Editable fields in the top section of your profile include: 
• Photo – point the mouse pointer over your photo and then click Change photo to edit or delete the 

current photo.  
• Name – you can edit your first, last, and former names  
• Headline – this information defaults to your current job title, but you can change it. If your headline is 

the same as your current position, the current position won’t display in the top section of your profile. 
• Location – open the field for editing and enter your postal code. 
• Industry – open the field for editing and click the drop-down arrow to select from a list of industries. 
• Current employer – clicking the Edit icon will take you to the Experience section of your profile, where 

you can edit company name, job title, description, and dates of employment.  
• Previous employer – clicking the Edit icon will take you to the Experience section of your profile, where 

you can edit company name, job title, description, and dates of employment. 
• Public Profile URL – this is the URL for your LinkedIn page. You can add this URL to your email signature 

and to your business cards and web site to make it easy for people to connect with you on LinkedIn. You 
can customize the last section of the URL (which usually consists of your name followed by a series of 
numbers) by clicking the Settings icon to access your public profile, then click the Edit icon next to your 
URL. Type the last part of your new custom URL, and then click Save. 

• Contact Info – click the Contact Info link to access contact information fields. You can change your 
email address, add an IM name/address, a phone number, a street address, your Twitter handle and your 
web site URL. 

Exercise 17-1: Creating a LinkedIn account 
In this exercise, you will create a LinkedIn account and set up your profile. When prompted, use one of the 
web-based email addresses you created in the Computing Fundamentals module. If you already have a 
LinkedIn account, please simply read along.  

1. Open a web browser and navigate to www.linkedin.com.  

2. If the Get started form does not display, click the Join now link. 

3. In the Get started form, fill in the fields for your first name, last name, email address and preferred 
password, then click Join now. 

Professional Headline 

Location | Industry 

Public Profile URL 

Photo 

http://www.linkedin.com/
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4. Follow the wizard steps. If you are a student, click Yes at the top of the form that asks for your job title. 
When you get to the screen for importing your contacts, click Skip and click Yes to confirm that you 
want to skip over importing your contacts.  

5. When you reach the screen that asks you to confirm your email, open another browser tab and access 
the email account for the address you specified as your LinkedIn sign-in. 

6. Check your Inbox for a message from LinkedIn Messages. If you do not see one, return to the LinkedIn 
tab and click Send another email.  

7. In your email Inbox, click the message from LinkedIn Messages, then click the Confirm your email 
address button in the body of the message.  

8. If you are again prompted to import your contacts, click Skip, then click Yes to move past this screen of 
the wizard. 

9. Click Skip or Next as required to move past the remaining screens in the wizard. When you finally arrive 
at the web page for your account, you will be prompted again to import your contacts.   

10. In the menu bar at the top of the windows, click Home to view your LinkedIn home page. Notice that 
you can add information, import contacts, and read current stories. 

11. In the menu bar, click Profile, then click Edit Profile to arrive at your profile page. 

12. If a Tip box displays on your screen, read the tip and click Next as required to take a short tour of the 
profile page interface, then click Done. 

Now, start building the top portion of your profile. 

13. If you have a photo of yourself saved on the computer and wish to add it to your profile, click Add a 
photo, navigate to your saved photo and double-click it. Otherwise, skip to Step 14.  

14. Move your mouse cursor over the fields in the top part of your profile to see the field markers and Edit 
buttons, then click the Edit button for your professional headline (this is the line that displays below your 
name). This line currently displays information that you entered when you created your account. 

15. For this exercise, delete the existing text, and enter your dream job title, then click Save.  

16. Hover your mouse cursor over your public profile URL (this appears below the photo placeholder) until 
the Settings button becomes visible. Click the Settings button to access your public profile page. 

17. On the right side of the page, note your public profile URL. From this page, you can select it and copy it 
to the clipboard and later paste it into your email signature block. You can also customize it by clicking 
the Edit icon. 

18. Ensure that Make my public profile visible to everyone is selected. 

19. In the menu bar, click Profile, Edit Profile to return to your profile page. 

20. In the top portion of your profile, click the Edit button to the right of your current position. LinkedIn 
moves you to the Experience section of your profile. Here you can specify dates, location, and job duties. 
Notice that you can also attach documents, links, and other types of media, to highlight your 
accomplishments in this particular job position. 

21. If time permits, spend some time exploring the different areas of LinkedIn. 
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Now sign out. 

22. Position your mouse cursor over the  (photo icon) in the top right area of the window, then click Sign 
Out in the menu. 

23. Close the LinkedIn browser tab, then sign out of your email account and close your browser.  

Inviting Connections 
When you are first starting to build your LinkedIn network, LinkedIn may suggest people you want to connect 
with based on the company and school information you add to your profile. LinkedIn will suggest your co-
workers, for example, or alumni from your university. Suggestions display on the People You May Know page. 
Click the Connect button that appears under a person’s name to send a connection invitation. 

To invite specific people for whom you have an email address, click My Network, then click Add contacts. 
On the Add contacts page, click the Invite by email button to open an invitation profile. Type in the 
addresses of people you want to invite, then click Send Invitations.  

 
Additionally, you can invite people to connect from: 

• A member’s profile – click the Connect button on his or her profile page (if one displays) 

 
• Search results – click Connect to the right of the person’s information. 
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Managing Your Digital Identity 
Objective 3-5.1, 3-9.3, 3-9.4 

Have you ever typed your name into the Google search engine to see what you can find? 

Any information you see in the results page is part of your digital identify. A digital identity is a collection of 
data about you that is available online.  

In most cases, your digital identity is a combination of your online profile (or profiles) and all your postings, 
and all your uploads, and all your images, and all your “likes,” and all of the people you follow – in other 
words, it includes a history of all your digital activity. If you have published books, or web site content, that 
will also be included.  

Digital Footprints 
Any time you perform an action online, such as posting to your blog, or tweeting about a great new sandwich 
shop, or liking a friend’s post on Facebook, you leave a trace of information about yourself – about your 
personality, about your character. 

These traces of information are digital footprints – they are a permanent record of the “steps” you have taken 
throughout your online life. Because they are online, they are searchable; other people can find and follow 
your digital footprints. 

Social media and the modern Internet enable us to communicate in ways that were previously unimaginable. 
Using just a smart phone, you can broadcast when something happens and even upload a video. You can 
publish to a worldwide audience with a single tap on a touchscreen.  

However, this ability is a double-edged sword. 

Online is Forever 
It is important to keep in mind that once you make an online post, or upload a picture or video, or even send 
an email or a text, you are no longer in control of that information. Anyone who can see your post or picture 
or video can download it (and keep it) or share it. 

For the most part, this is a good thing – it is what gives social media its power – information is shared and 
the number of people who see it grows exponentially. But this same power gives permanence to postings – 
both the ones that you are proud of and the ones that you might prefer to forget.  

Suppose, for example, you post a picture of yourself getting drunk at a fraternity party on your Facebook 
page. Everyone laughs and all is well. After college, you have a job interview with a prestigious company and 
realize that photo might not reflect well on you if someone at the company were to visit your page. So you 
go to your Facebook page and remove that photo. But what happens if a few of your frat buddies shared the 
photo on their own pages? And suppose they tagged you in that photo that they shared on their pages? 
Those photos of you are still “out there” tagged with your name, and potentially anyone can find them. 

Consider another scenario: You send me a confidential email message (meant for my eyes only) complaining 
about your boss because he is treating you unfairly. It made you feel better to rant a little bit, and I send you 
back a message of encouragement. Then the situation improves and you and your boss become friends. All 
is good. However, there is really nothing stopping me from sharing that email message with other people – 
or even with your boss – at some later time, especially if our friendship ends for some reason. The control of 
the message is out of your hands. 
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Even if I remained a good friend, what would happen if someone hacked my email account and found your 
message? Now, the message is out of your hands and out of my hands, and the hacker can do with it what 
he likes. Maybe he will post it online for a laugh. 

You should understand that anything you put into digital format and then send (or otherwise make available) 
to other people is out of your control forever. If it is something that might reflect poorly on your character, 
it could potentially be used as a weapon against you. 

Be mindful of this whenever you send (or post) digital information. 

Why Is Your Digital Identity Important? 
Any time you post something online you are disseminating your message to the world – and, by extension – 
you are promoting your personal brand. Your personal brand distinguishes you from other people and 
creates an impression in the minds of potential customers or employers or admissions board panelists. It is 
a matter of perception.  

Your girlfriend’s parents may be Googling your name right now – and they are not the only ones.  

Potential employers and school admissions boards also go online to see what they can find about potential 
employees or enrollees. They may have your resume (or transcript and application) and a long list of 
references in hand, but they will go online to get a fuller picture of who you are and whether you might be 
a good fit for their organization or university. In fact, current employers also keep an eye on the social media 
accounts of their employees. Be careful what you share. 

Yes, they will check LinkedIn. But they will also check Facebook, Twitter, 
Google+, Instagram, YouTube and so on. These accounts can give them an 
idea of who you are as a person. What will they find? Will they find 
intelligent tweets about relief organizations and conservation efforts? Or 
will they find rantings against your college dean on your personal blog and 
a video of you tossing a lighted firecracker into your neighbor’s mailbox 
on your YouTube channel?  

What do you share on Facebook – thought-provoking articles or sexist jokes? 

People will also look at which groups you participate in, and who you follow on Instagram and Twitter and 
the like. Do you follow volunteer organizations or political extremists? The people and groups you follow can 
speak volumes about your interests and beliefs. 

Creating a Positive Online Identity 
To ensure that Google shows people the information that you want them to see you need to put good 
information “out there” and refrain from sharing things that might reflect poorly on your character. To begin, 
you can take the following steps: 

• Create and manage your LinkedIn account. Take the time to create a well-written professional profile.  

• Manage your Facebook profile and remove any photos that do not show you in a professional light. It is 
fine to share information about your personal life on Facebook; but don’t post anything that might be 
off-putting to a recruiter or potential employer. 

• Create a Twitter account and use it to share information that others may find valuable, such as articles 
related to your business or industry, or upcoming volunteer events in your community. 
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• Create and post to a blog that shares positive and professional ideas. 

• Before indiscriminately posting the first thing that pops into your mind, ask yourself these questions: 

– What am I sharing? Will it reflect positively or negatively on me? 

– How secure is it? 

– With whom am I sharing? 

– What kind of footprint does it leave behind? 

• Never post (or send a communication) in anger. You may be justifiably angry, but consider whether you 
really want your digital “legacy” to include angry, hurtful communications. If necessary, write and send 
and angry email to yourself only. Look it over the next day, and then decide whether you still want to 
send it.  

Personal Identity and Professional Identity 
Some people prefer to maintain separate online identities – one for their personal pursuits and one that 
represents them professionally – while others believe a blended identity gives a better, fuller, more honest 
picture of the “real you.” 

Whichever way you decide to proceed, be mindful of the impression your online activities can leave in the 
minds of others.  

Aliases  
People who prefer to maintain both a personal and a professional online identity often use their real name 
for one identify and an alias for the other. For example, Carolyn Stevens who works for a fictitious company 
that specializes in adventure vacations might use might use “carolynstevens” for her personal profiles and 
“AdventurerCarolyn” for her professional ones.  

In some profiles, such as gaming profiles, you are encouraged or even required to use an alias so that you 
are not personally identifiable by your gaming name.  

People with common names – like John smith – are often forced to use aliases because all variations of their 
first and last names (john.smith, johnsmith, jsmith, j-smith, and so on) are already being used by someone 
else. 

Managing Your Online Identity  
It has been said that the best defense is a good offense. Take a proactive role in creating and maintaining a 
positive online identity. Be careful about what you share, and take the time to create and share material that 
shows you are intelligent, thoughtful, responsible.  

Take the time to find articles about issues you care about and comment on them, and share them with others. 
If you have a personal blog, post to it regularly and keep your posts positive in nature. If your blog is about 
your profession, post articles that show others how to accomplish their goals or streamline a process. Share 
videos that show you participating in volunteer or community projects. 

If you have fallen victim to bad judgment in the past, and there are videos, comments, or posts out there in 
cyberspace that attest to this bad judgment, remove what you can. Then put your efforts into filling 
cyberspace with positive contributions. The more “good stuff” you put out there, the deeper others will have 
to dig to find the bad stuff. 
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There are also a number of companies such as Reputation.com and BrandYourself, that provide services for 
cleaning up a poor online identity, and helping you create a positive and favorable identity in its place. There 
are also numerous articles you can find on the Web for do-it-yourself tips on creating and maintaining an 
online identity you can be proud of. 

Online Behavior 
Objective 3-5.4 

Who do you know online? If you create social media, chat, email and gaming accounts, your first online 
friends are usually family members, people you know from work and neighborhood friends.  

Then, after you spend some time online you make other acquaintances – people who you know only online. 
Think for a minute about how much you really know about them. Chances are, you don’t know much except 
for their online names and how they act when they are online. 

The truth about online identities is that they can be anonymous. 

For many people, this anonymity makes them feel free to behave in ways they normally wouldn’t in face to 
face communications.  

Some people are less shy online than they are in face to face situations. Others more readily express their 
anger, or feel free to be rude to others. The idea that no one knows who you really are can be a powerful 
thing. 

No matter how anonymous you may feel while you are online, remember that each of us has a moral and 
ethical responsibility to treat others with respect. 

Cyber Bullying 
Remember that there is a flesh-and-blood person behind each online identity; a real person who can feel as 
hurt, threatened or picked on online as he or she would in a face to face encounter. 

In the past, a bully had to physically confront a victim in order to target him or her. Today, our connected 
online world has given bullies a whole new arena for targeting victims. Online or “cyber” bullying can take 
place around the clock through email, social media, instant messaging, text messaging and so on. 

Cell phones and social media are the most commonly-used mediums in which cyber bullying occurs, and 
because so many people are connected, bullying now occurs where potentially millions of others can “see” 
it. 

Cyber bullying includes: 

• Making online threats 
• Using hate speech in social media or cell phone messages 
• Spreading rumors 
• Making mean, hurtful comments 
• Taking embarrassing photographs without the knowledge or consent of the victim, and then posting 

them  
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Bullying is not a harmless electronic action aimed at no one in particular; 
bullying is targeted at real people, and can cause real damage.  

Victims of cyber bullying are more likely to suffer from low self-esteem 
and to consider suicide. Cyber bullying can have serious consequences. 

What Should You Do? 
What should you do if you are a victim of cyber bullying? 

• Remember that it is not your fault. 
• Ignore it if you can, especially if the bullying is limited to teasing and minor name calling. Bullies are 

often encouraged by seeing a reaction. 
• End all communications with a bully, if possible. For example, you may be able to block his or her number 

so that you no longer receive calls or threats. Facebook and Facebook Messenger allow you to block 
other users so that they can no longer interact with you. 

• Keep a hard copy record of bullying messages you receive. You may need these if things escalate and 
you need to prove that you did not cause trouble. 

• Confide in a trusted adult (if you are a minor) or mentor or supervisor. Together you may decide to 
report incidents to school or university officials or to the police. 

What NOT to Do 
Avoid taking the following actions if you are the victim of cyber bullying: 

• Do not respond in kind. Sending mean or threatening messages back to your attacker can cause a bad 
situation to escalate and can even lead to physical confrontation and violence. 

• Do not forward bullying content or messages. If someone sends you a bullying message, and you forward 
it to a friend, you cannot know for sure how far the email chain will go. Although you have not responded 
in kind, you may inadvertently encourage other people to turn to violence on your behalf. 

• Do not believe the bully; do not allow anyone to destroy your self-esteem.  

Computers and Your Health 
Objective 3-9.1, 3-9.2 

For some people, computers are indispensable tools for leading a productive and entertainment-filled life. 
For others, however, they can cause a great deal of stress. They are “new” technology to people who are used 
to “old world” ways. We use computers way more than we used to. And even when we are not at our 
computers, some people are still connected and engaged. 

Coping with Change 
It is important to understand that as technology advances, the world changes. It does not change all at once, 
but it does change. For example, on June 12, 2009, full-power broadcasting of analog television signals in 
the United States ceased, and all full-power stations transmitted only digital TV signals from then on. The 
switch-over had been announced and advertised for well over a year before it happened, and consumers 
were encouraged to purchase digital television adapters for their analog TV sets. The federal government 
also sponsored a DTV Converter Box Coupon Program to help consumers through the conversion. 
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However, many people simply refused to buy a converter, and emergency legislation was drafted to allow 
some stations to continue broadcasting analog signals until September 1, 2015. The point is, if you refuse to 
change, you may be left behind.  

We live in an exciting time of ground-breaking advancements, and it is important to approach new 
technology as a new opportunity rather than as an obstacle. Achieving digital literacy is important for 
everyone. 

Audience Consideration 
Even though new technology is available, not everyone is eager (or able) to jump onboard. This is important 
to remember if you market items to demographic groups that either cannot afford new technology or that 
include members who might be resistant to new technology.  

In other words, consider your audience. If you want to market walk-in bathtubs or pre-paid funeral plans to 
people aged seventy and older, you should make sure that you advertise on the radio and on television and 
in printed media as well as advertising online. Additionally, make sure that you staff your company with live 
operators to receive incoming calls; it would be ill-advised to expect people in this age group to “apply 
online.” 

If you want to advertise up-coming community events or special services, it is fine to advertise on your web 
site or on Twitter. However, be sure to mail (or hand out) flyers to the community too, or you might pass 
over quite a few people who would have been interested. Just because the community theater director is a 
genius at advertising on social media, that does not mean the community at large will be trawling the Internet 
looking for announcements. Some people still need to see a flyer and hang it on their refrigerators! 

Disengaging 
While connectedness makes our world smaller and allows us to be aware of what is happening anywhere at 
almost any time, human beings also require time away from external stimuli. We need some time alone to 
simply “be” and to focus inward for a bit. That is, we require “down time” in order to maintain good mental 
health. It is unhealthy to be engaged 24/7.  

Internet Addiction 
Internet addiction is thought to be an impulse control disorder, similar to pathological gambling. While it is 
common for people to enjoy using the Internet to meet, socialize, and exchange ideas through chat rooms, 
social networking sites and online communities, some form an intense attachment to these activities and 
cannot pull themselves away. Some users spend endless hours online at the cost of damaging interpersonal 
relationships with the people in their lives.  

The warning signs of internet addiction are:  

• Thinking continually about previous online activity or anticipating the next online session. 

• Using the Internet in increasing amounts of time in order to achieve satisfaction. 

• Losing interest in other hobbies or pastimes. 

• Being unsuccessful in trying to control, cut back or stop Internet use. 

• Feeling restless, moody, depressed or irritable when attempting to cut down on Internet use. 

• Spending more time online than originally intended. 

• Suffering fatigue or experiencing a change in sleep habits. 
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• Risking significant relationships, job, educational or career opportunities because of Internet use. 

• Lying to family members, therapists, or others about how much time you spend on the Internet. 

• Using the Internet as a way to escape from problems or to relieve feelings of hopelessness, guilt, anxiety, 
or depression. 

Physical symptoms can include: backache, headaches, weight gain or weight loss, disturbances in sleep, carpal 
tunnel syndrome and blurred or strained vision. 

Internet addiction, like any other addiction, can cause personal, family, academic, financial and occupational 
problems. Family members feel cheated and even insignificant when you would rather spend time online 
with strangers than with them. If you lie about how much time you really spend online, then distrust enters 
your relationships. 

In more extreme cases, Internet addicts may create online personas through which they pretend to be people 
other than themselves. Those at highest risk for creating these “secret lives” are those who suffer from low 
self-esteem or feelings of inadequacy. Inability to deal with these problems in “real life” lead to clinical 
problems of depression and anxiety. 

Ergonomic Best Practices 
Repetitive stress injuries (RSIs) become commonplace as users begin to work on their computers for long 
periods of time. RSIs are conditions that occur gradually over time and are caused by too many uninterrupted 
repetitions of an activity or motion, particularly if the activity or motion is unnatural or awkward. RSIs for 
computer users usually affect the hands, wrists and arms, but can also affect other joints such as the elbow 
or neck.  

To combat RSIs, users can use ergonomically designed furniture and proper techniques for safely using the 
computer. Ergonomics is the science of designing equipment that maximizes safety and minimizes 
discomfort. Measures you can take to prevent RSIs when using your computer include: 
• Sit in a chair that provides lower back support, armrests and adjustable height. 

• Use an ergonomic keyboard, which allows your hands to rest in a more natural position when you type 
than a standard keyboard does. 

• Tilt the monitor up about 10 degrees to prevent neck strain.  

• Use a padded wrist support to support your wrists when you are not typing. 

To prevent eyestrain or headaches, you can: 
• Position your monitor from 24 to 30 inches away from your eyes. 

• Adjust the monitor resolution so text and icons are large enough to see clearly. 

• Ensure that the monitor does not flicker. The refresh rate should be at least 72 Hz. 

• Avoid staring at the display screen for long periods of time. 

If you work at a computer for several hours a day, keep ergonomics in mind. First and foremost, never work 
at the computer without taking regular breaks. Get up once every hour, stretch, and walk about to get the 
circulation going and to rest your eyes. The following are some other points to keep in mind when 
considering how to create and use a computer workstation. 
• The work surface should be stable; everything on the work surface should be resting flat. 

• The monitor and keyboard should be directly in front of you, not at an angle.  
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• The top of the monitor should be about 2 to 3 inches above your eyes. You should not need to tilt or 
crane your neck to view the contents of the screen. 

• There should be no glare or reflection on the screen. Where possible, ensure you have natural light with 
blinds that enable you to reduce or block any glare or reflection. Alternatively, have a lamp with 
appropriate wattage that enables you to identify images clearly in a darker room. 

• Ensure there is appropriate lighting to read the screen clearly at any time of day. There should be a light 
source directly above the monitor, whether it is fluorescent lighting or a desk lamp. Where possible, try 
to pick a light source that simulates natural light. 

• Place any documents that you will be looking at as you type in a document holder in line with the 
monitor. 

• When seated comfortably, position your arms so that your wrists are straight and flat, and your arms are 
close to your body.  

• Keep your feet flat on the floor and your thighs and forearms parallel to the floor. If your feet do not 
reach the floor, use a foot rest. This will help with blood circulation as you sit for a period of time. 

• The keyboard should be in a comfortable position so your arms are not straining to reach up or down 
to hit particular keys. This is also true for the mouse. Many users prefer to place the keyboard and mouse 
on a lower level than the level of the desk. Ensure the keyboard and mouse are close to you so you are 
not straining to reach them. 

• When typing, try not to bend the wrists. Your wrists should be relatively parallel to the keyboard and if 
possible, use the entire arm to help with typing rather than just the fingers or the hand. 

• If you feel strain on the wrist, arm or fingers when using the traditional mouse, try switching to a trackball, 
a larger mouse, or consider using a device that uses touch technology. 

These guidelines also apply to notebook users, although an advantage of a notebook is the ability to take it 
with you anywhere, including the beach or in a vehicle. If you plan to put the notebook on your lap, ensure 
you are sitting appropriately as described in the guidelines, and where possible, use a tray or something 
sturdy to place the notebook on as you work. This will ensure a flat surface for the notebook as well as reduce 
the amount of heat generated by the notebook on your lap. 

It is to your advantage to consider ergonomics when you work with a computing device for long stretches 
of time. Even with a portable device, think of how you are sitting and using the device as well as getting up 
periodically to stretch your muscles. Strains on your body can lead to more than just physical pain, but also 
lead to a reduction in mental alertness, low productivity, errors in your work, or absences from work or school 
from physical ailments. 

Exercise 17-2: Assessing ergonomics 
In this exercise, you will assess how you are positioned in front of the computer, and what you may want to 
correct in order to reduce the chance of personal injury. 

1. Stand up and stretch your body, reaching high with your arms to stretch your back. 

2. Take a look at the chair you were sitting in and note where the handles or levers are located. Find the 
one that adjusts the height of the chair and make the appropriate adjustments for yourself. 

3. Look straight at the monitor and determine if it is at eye level. If possible, tilt the monitor so you can see 
it better without having to strain your neck. 
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4. Pull the keyboard close enough to you so you are not stretching your arms or back to reach the keys. 

5. Repeat step 4 with the pointing device for your computer. 

6. Now work with someone in the class to review how you are positioned in front of the computer and 
determine whether there are things that could be adjusted to provide a better working environment. 

Lesson Summary 
In this lesson, you learned about your online identity and how to protect it. You also learned about the adverse 
effects prolonged computing can have on your health. You should now be able to: 

 describe the purpose of blogs, forums, and wikis 

 understand the function of social media 
networks and how they work 

 understand the difference between open and 
closed social networks 

 describe how to use LinkedIn 

 describe what constitutes your digital identity 

 understand the importance of maintaining a good 
digital identity 

 explain how to avoid cyber bullying 

 understand the health risks that arise from 
prolonged computing 

Review Questions 
1. Shaun regularly writes articles on database theory and instructional pieces about using Microsoft SQL 

Server. Where does he most likely publish these? 
a. On his blog. c. On Vine. 
b. On Snapchat. d. On YouTube. 

2. Which social network features pictures and videos that disappear after they have been viewed? 
a. Vine c. YouTube 
b. Snapchat d. Facebook 

3. Which of the following is an example of a closed social media network? 
a. Facebook c. Yammer 
b. LinkedIn d. Twitter 

4. Which of the following social networks was created specifically for making and maintaining professional 
business connections? 
a. Facebook c. Instagram 
b. LinkedIn d. Twitter 

5. The collection of data about you that is available online is your: 
a. Profile c. Blog 
b. Digital identity d. Facebook post history 
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6. Helen posted a picture to Facebook and a week later she wanted to remove it. How can she be sure that 
it has been removed from the Internet? 
a. Deleting her post is sufficient; any posted picture can be removed from the Internet at any time. 
b. If she deletes the picture within one month of posting it, it will be permanently removed. 
c. She cannot be sure because reposts and sharing could keep it online indefinitely. 
d. She can call her ISP and request that the picture be removed. 

7. Which is a good reason for using an alias online? 
a. To keep your personal and business identities separate. 
b. To remain anonymous while making rude comments on a co-worker’s posts. 
c. To bully someone and keep them guessing about who it is. 
d. To enter a sweepstakes multiple times. 

8. Which of the following is a good way to create a positive online identity? 
a. Share stories or articles about volunteer opportunities on social media. 
b. Comment intelligently and thoughtfully on other people’s posts. 
c. Create a blog and post positive articles that reflect your character. 
d. All of these are good ways to create a positive online identity. 

9. Which of the following is an example of cyber bullying? 
a. Sending a derogatory email to someone. 
b. Posting a compromising picture of someone on Facebook. 
c. Making unkind remarks about someone on social media. 
d. All of these. 

10. Marissa tweeted for a week to advertise a mentoring project at the public library in which senior citizens 
were encouraged to mentor youth in specific job skills such as accounting, bookkeeping and filing. She 
also put this information on the library Facebook page. Although there is a large population of senior 
citizens within five blocks of the library, the turnout was disappointing. Which is a probable reason for 
the poor turnout? 
a. Senior citizens do not care about youth in their community. 
b. Seniors probably did not have transportation to the library. 
c. Seniors are not particularly active on Twitter and Facebook. 
d. All of these. 

11. Which of the following is a sign of Internet addiction? 
a. Lying about how much time you spend online. 
b. Having a Facebook and a Twitter and an Instagram and a Vine account. 
c. Using an alias in one or more of your online accounts. 
d. Configuring your phone to alert you when someone messages you on Facebook. 
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Courseware Mapping 
Computing Fundamentals 

Objective Domain Lesson 

1 Mobile devices  

  1.1   Understand cellular phone concepts 3 

  1.2 Be familiar with cellular-enabled tablets 3 

  1.3 Be familiar with smart phone 2, 3, 5 

 1.4 Understand the use of hard-wired phones 3 

 1.5 Use of instant messaging 5 

 1.6 Know how to configure notifications 6 

2 Hardware devices  

 2.1  Types of Devices 2 

 2.2 Know the impact of memory and storage on usage 2 

 2.3 Know how to connect to different peripherals. Define types of connections; for 
example, 3.5 mil connections for an audio cable, VGA, HDMI, USB for most other 
things. Microphone port, Printers – wireless as well as USB, Cameras or audio can 
connect through Bluetooth or infrared connections. 

2 

 2.4 Understand the use of Ethernet ports. 2, 3 

 2.5 Connect a device wireless network (Wi-Fi), Connecting a wireless printer, How to 
get a device onto Wi-Fi, How to enter password or passkey 

3 

 2.6 Understand power management and power settings, How to save battery time 
when using a laptop, Locate power settings and use them, Differentiate between 
sleep and hibernate. 

1, 2 

 2.7 Understand driver concepts as well as their device compatibility. 2 

 2.8 Know platform implications and considerations, for example Mac, PC, Linux, iOS, 
Android, Firmware; define and describe SaaS applications that are delivered online. 

2, 5 

 2.9 Know platform compatibility, device limitations. 3, 4 

 2.10 Know the difference between cellular, Wi-Fi, and wired networks; Define, in 
general, the difference among these types of networks; Implications of sending 
large files on cellular or streaming; Wi-Fi limitations by locations, wired networks 
you cannot move; Difference between an ISP provider and a cellular provider. 

3 

 2.11 Understand concepts regarding connecting to the internet; Organizations typically 
have both wired and wireless connections; For home use, one must purchase 
bandwidth and speed from an ISP that is non-cellular. 

3 

  2.12 Understand common hardware configurations; Laptop with multiple monitors, 
docking stations, CPU with a video card or some laptops have integrated video; 
Wireless keyboards, devices connected to a desktop and laptop. 

2 

  2.13 Implications for document usage. 2 
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Objective Domain Lesson 

 2.14 Understand the pros and cons of touch screens vs non-touch screen devices; 
Limitations of input using a touch keyboard; Limitations of input using touch vs 
keyboard and mouse, such as fine selection points, efficiency of input, having 
multiple tabs open. 

2 

3  Computer software and concepts  

 3.1 Understand operating system versioning and update awareness; Implications of 
updates, understanding benefits and features of new updates. 

1 

 3.2 Know concepts surrounding applications vs. operating system vs. global settings; 
Global settings common to all operating systems; for example, password 
protection, power management configurations, screen resolution. 

1 

 3.3 Have a general understanding of operating systems and software settings. 1, 4 

 3.4 Set software preferences; Understand basic software settings that a user can set; 
for example, changing frequency of AutoSave, changing a print setting, and 
changing settings in Microsoft Office using File/Options. 

5 

 3.5 Users and profiles; Basic concepts of users and profiles; for example, on a Windows 
PC, a family could use a computer and each user has a distinct account with a user 
profiles and own login and credentials; Understand that profiles are customizable. 

1 

 3.6 Know file structures and file/folder management. 4 

 3.7 Document Management. 4 

 3.8 Menu navigation. 1, 4 

 3.9 Searching for files; Know where to go for files, use search options to find files; Use 
file search techniques such as WIN KEY and start typing; on a Mac Command + 
Spacebar; Understand that downloaded files go the Downloads folder. 

4 

  3.10 Rights and permissions (administrative rights); Understand that Admin-level rights 
exist and that you may not have permission to access all files in an organization; 
Describe why permissions are valuable in an organization. 

4 

 3.11 Define an IP address. 3 

 3.12 Know how to install, uninstall, update, repair software; Software purchased on 
media might need to be reinstalled from the Internet. 

5 

  3.13 Troubleshooting. 7 

4  Backup and Restore  

 4.1 Understand backing up concepts. 7 

 4.2 Know how to back up and restore. 7 

 4.3 Know how to complete a full system restore on a personal device; complete a full 
system restore/reset on a tablet and phone; define factory default setting; if a laptop, 
reformat a hard drive. 

7 

5 File Sharing  

 5.1 Understand file transfer options and characteristics. 4, 6 

   



Appendix A Courseware Mapping 
 

 

A 4  7500-1 v1.00 © CCI Learning Solutions Inc. 

Objective Domain Lesson 

6 Cloud Computing  

 6.1 Understand “cloud” concepts; Understand cloud storage vs. cloud access concepts; 
Define cloud storage and cloud access; Must have Internet access to get to cloud; 
Describe cloud storage of photos for different systems, such as iCloud. 

6 

 6.2 Know the benefits of using cloud storage; Safe storage, convenience. 6 

 6.3 Access and use of the cloud. 6 

 6.4 Web apps vs. local apps. 6 

 6.5 Understand web app types. 5, 6 

7 Security  

 7.1 Know credential management best practices 7 

 7.2 Know the basic threats to security of computers, data, and identity 7 

 7.3 Understand the implications of monitoring software (surveillance) 7 

 7.4 Understand connecting to secured vs. unsecured network (wired and wireless) 7 

 7.5 Know the use of and importance of anti-virus software 7 

 7.6 Know the use of firewalls and basic settings 7 

 7.7 Know e-commerce interactions and best practices 7 

 7.8 Understand the basic definition and use of Virtual Private Networks (VPNs)  7 

Key Applications 
Objective Domain Lesson 

1 Common Application Features 

  1.1 Know copy, cut, and paste keyboard equivalents 9, 10 

  1.2 Understand the difference between plain text and HTML (text with markup) 9 

  1.3 Know how to use spelling check 9, 12 

 1.4 Know how to use reviewing features 9 

 1.5 Know the find/replace feature 9 

 1.6 Be able to select text or cells 9, 10, 12 

 1.7 Be able to redo and undo 9, 10,  

 1.8 Be able to drag and drop 9 

 1.9 Know the read-only view 9 

 1.10 Understand what a protected mode means 9 

 1.11 Be able to use the zoom feature 9 
2 Word Processing Activities  

  2.1 Perform basic formatting skills 9 

 2.2 Adjust margins, page sizes, and page orientation 9 

 2.3 Alter text and font styles 9 
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Objective Domain Lesson 

 2.4 Create and save files 9 

 2.5 Know page layout concepts 9 

 2.6 Know how to print a word processing document 9 

 2.7 Use and configure print views 9 

 2.8 Use reviewing options within a word processing document 9 

 2.9 Be able to use tables 9 

 2.10 Understand which file types are compatible or editable with word processors 9 

 2.11 Use word processing templates to increase productivity 9 
3  Spreadsheet Activities  

 3.1 Understand common spreadsheet terms 10 

 3.2 Be able to insert/delete rows and columns 10 

 3.3 Be able to modify cell sizes 10 

 3.4 Be able to filter and sort data 10 

 3.5 Understand functions, formulas, and operators 10 

 3.6 Be able to enter data in a spreadsheet 10 

 3.7 Use and create spreadsheet charts 10 

 3.8 Create spreadsheet tables 10 

 3.9 Manipulate data within a spreadsheet 10 

 3.10 Format data within spreadsheets 10 

 3.11 Understand compatible spreadsheet file types. Examples include Csv, Xlsx, Tab 
delimited, etc. 

10 

  3.12 Be able to use spreadsheet templates to increase productivity 10 

 3.13 Understand how a spreadsheet can be used as a simple database 10 

4  Databases  

  4.1 Understand what data is 11 

 4.2 Understand how websites utilize databases 11 

  4.3 Know basic concepts of a relational database 11 

  4.4 Know what metadata is 11 
 5 Presentations  

 5.1 Understand file types compatible with presentation software 12 

 5.2 Understand how to connect to external/extended monitors to display 
presentation 

12 

 5.3 Be able to us presentation views and modes 12 

 5.4 Know how to add animations, effects, and slide transitions 12 

 5.5 Know how to create and organize slides 12 

 5.6 Know how to design slides 12 
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Objective Domain Lesson 

 5.7 Identify presentation software options 12 
6 App Culture  

 6.1 Understand how to obtain apps   8 

 6.2 Identify different app genres  8 

 6.3 Understand strengths and limits of apps and applications 8 
7 Graphic Modification  

 7.1 Be able to import and insert images into documents 9, 12 

 7.2 Understand how to crop images 9, 12 
 

Living Online 
Objective Domain Lesson 

1 Internet (Navigation)  

  1.1 Understand what the Internet is 13, 14 
2 Common Functionality  

  2.1 Understand how to use common website navigation conventions  13 
3  Email Clients  

  3.1 Identify email applications 16 

 3.2 Understand contact management 16 
4  Calendaring  

 4.1 Know how to create events and appointments 16 

 4.2 Know how to share calendars 16 

  4.3 Know how to view multiple calendars; Multiple calendars can be connected in 
one view; show up in different colors in same user interface 

16 

  4.4 Understand how to subscribe to calendars; A public calendar (like a municipal 
calendar) vs sharing your own calendar 

16 

5 Social Media  

  5.1 Understand what a digital identity is (identity on social media); Concept of once 
you do something, it cannot be undone 

17 

 5.2 Recognize the difference of internal (school/business) vs. open media sites; 
There are business and school social media sites, such as Neo and Yammer and 
Slack; Difference between an open social media site and a closed site; for 
example, Facebook started as a closed site (for students at a specific college), 
but is now an open site available to anyone who signs up for an account 

17 

 5.3 Know what blogs, wikis, and forums are and how they are used 17 

 5.4 Know what cyber bullying is 17 
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Objective Domain Lesson 

6 Communications  

 6.1 Know the best tool for the various situations and scenarios; Describe how 
different communication technologies (email, phone, text message) are suited 
for differing circumstances; for example, if you needed to get an urgent 
message to your boss, what technology is best? Describe which technology is 
likely to get the fastest and slowest response from the recipient 

15 

 6.2 Know how to use SMS texting; Describe appropriate use of SMS; for example, 
when communicating with your boss, maybe use text only if he or she is out of 
the office 

15 

 6.3 Know how to use chat platforms; Describe and demonstrate the use of Skype as 
a chat platform in business 

15 

 6.4 Understand options for and how to use distant/remote/individual learning 
technologies 

15 

7 Online Conferencing  

 7.1 Understand and identify online conference offerings 15 

8 Streaming  

 8.1 Understand what streaming is and how it works with devices; Differentiate 
between streaming and downloading; Define live audio; Describe how you 
could stream the video of a live recording 

15 

9 Digital Principles/Ethics/Skills/Citizenship  

 9.1 Understand the necessity of coping with change in technology 17 

 9.2 Understand Digital Wellness basics 17 

 9.3 Understand an online identity management 17 

 9.4 Know the difference between personal vs. professional identity 17 
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Glossary of Terms 
AAOCC – acronym for: authentic, accuracy, objectivity, currency, 
and coverage, or the guidelines you can use to help evaluate 
information you find on the Internet. 
Address – In a worksheet, a reference to a specific cell; in a 
network, a reference to a specific computer; on the World Wide 
Web, a reference to a specific web site.  
Address Bar – In File Explorer, a field in which you can enter a 
path to a file or folder; in a browser it is the field in which you 
type a URL.  
Address Book – Central location where contact information for 
an entire organization is stored. 
Adware – Software that automatically displays or downloads 
advertisements. 
Alias – An alternate (or false) name. 
Alignment – The positioning of text or the contents of a cell; for 
example, left, right, or centered. 
Antivirus Software – use to scan your computer for known 
viruses, and to eliminate any viruses that are discovered. 
App Store – Digital platform for distributing software; different 
platforms utilize different app stores. 
Apps – Small, light-weight programs you obtain from an app 
store; apps are generally designed to perform a single function. 
Archive – A collection of files. Can refer to folders that have been 
compressed using a “zip” program, or to a collection of 
messages stored by an email program in an area separate from 
your Inbox. 
Argument – A value that a function uses in order to perform a 
calculation. 
Attachments – Files you include with a communication such as 
an email or a text message. 
Authentication – The process of confirming the identity of a 
user or computer system. 
AutoComplete – A feature that automatically completes a word 
you are typing. 
Backup – A duplicate copy of a program, a disk, or data, made 
either for archiving purposes or for safeguarding files from loss 
if the active copy is damaged or destroyed. 
Bandwidth – A measurement, expressed in bits per second 
(bps), of a network’s capacity to move data from one location to 
another. 
Bcc – Blind carbon copy; a field in the header of an email 
message. Other recipients of the message will not see who was 
named in the Bcc field. 
Binary Digit (bit) – The smallest unit of data a computer can 
understand, represented by a zero (0) or a one (1). 
Blacklisting – The act of putting a person (or a web site or 
domain) on a list that will deny them specific privileges or service. 
Blockers/Filters – Special software that can be installed to 
control the type or amount of content that can be viewed on a 
computer. 
Blog – An online journal that includes a communications 
element 

Bluetooth – A wireless technology used to allow devices (such 
as computers and phones) to work with Bluetooth-enabled 
accessories. 
Bookmark – a marked and stored location of an item such as a 
help topic or a particular web page on the Internet. You can click 
a bookmark to navigate directly to page on the Internet. Also 
known as Favorites. 
Boolean Operators – Words or symbols you can use to narrow 
the results returned by a search 
Breadcrumbs – In a website, a type of secondary navigation 
scheme that shows the user’s current location; in File Explorer, 
the file path to the current location wherein each piece of text in 
the Address Bar is an active control. 
Browser – A software application used to browse the World 
Wide Web. 
Browser Home Page – Web page that displays whenever you 
click the Home button in the browser toolbar. 
Byte – A group of eight bits used to represent one alphanumeric 
character. 
Cache – Folders on a hard drive used by browsers to store 
downloaded files. 
Cascading Style Sheets – Section of a web page (or a separate 
sheet attached to a web page) where presentational attributes 
(such as font colors, background styles, element alignment, and 
so on) are defined. 
Cc – Carbon copy; a field in the header of any email message. 
Other recipients of the message will see who was named in this 
field. 
Cell – Geographic area defined for communications services on 
a cellular network; also the intersection of a row and a column in 
a spreadsheet. 
Censorship – The act of disallowing access to specific content 
through tools such as filters, blockers, or blacklists. 
Check Box – An option in a dialog box used for selecting or 
activating items or features. If checked, the feature is activated. 
If unchecked, the feature has been turned off. 
Closed Social Network – Social media network that is private 
and internal to a company or organization; you must use an 
account that is associated with your organization in order to 
participate. 
Cloud Computing – Technology in which computing resources 
are delivered as a service over the Internet. 
Columns – A feature that enables you to format the layout of 
your document into one, two, or three columns of text. 
Conference Call – A call that involves three or more parties. 
Contact – An entry in an email program containing information 
about a person or organization, including the name, address, 
telephone numbers, or other relevant information such as a 
picture, email address, IM address. 
Contextual Tabs – Tabs that appear on the Ribbon only when 
appropriate 
Control Panel – Area in Windows where you can access features 
to customize settings for devices on your system. 
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Cookie – A small text file placed on your computer by a Web 
site. Cookies store information about your preferences. 
Copyright –Law that awards ownership of original works to the 
author or creator, whether the work is published or unpublished. 
Criteria – Text or values you specify when conducting a search 
or query. 
CRM – Customer Relationship Management; the practice of 
managing and analyzing interactions with customers in order to 
improve business relationships and increase customer retention. 
Cyber Bullying – Bullying that utilizes online tools and 
environments; making online threats or posting hurtful 
comments are examples of cyber bullying. 
Delete – To remove a selected item 
Desktop – The screen background for Windows where windows, 
icons, and dialog boxes appear. 
Device Driver – A program that enables the operating system 
to communicate with and control an installed hardware device. 
Digital Footprints – A permanent record of the activities you 
have performed throughout your online life. 
Digital/Online Identify – The collection of data about you that 
is available online; it includes your profile and your online 
activities (such as posts, shared pictures, uploaded videos, and 
so on). 
Directory – The organization of files and folders on a disk. 
Domain Name System (DNS) – A service that maps unique 
domain names to specific IP addresses. 
Double-Click – The process of clicking the left (or primary) 
mouse button twice quickly. 
Downloading – the process of copying a file (any type of file) 
from a server on the Internet to your device. 
Drag – To point the mouse pointer at one corner of an area to 
select, and press and hold the left mouse button as you move or 
the mouse pointer to the opposite corner; when you release the 
mouse button the area is selected. 
Drag and Drop – To move a selected item by pressing and 
holding the left mouse button as you move the mouse pointer 
to another location; when you release the mouse button, the 
selected item is deposited in the new location.  
Email Address – The address assigned to you electronic Inbox; 
an email address includes your mailbox name followed by the @ 
symbol, followed by the name of the domain that hosts your 
account. A typical email address might be 
user@yourcompany.com 
Encryption – the process of converting data into an unreadable 
form of text which then requires decryption key in order to be 
read. Files, folders or email messages can be encrypted so that 
unauthorized people cannot view or use the information. 
Ergonomics – The science studying humans in a workplace 
environment and of designing equipment that maximizes safety, 
minimizes discomfort, and prevents workplace injuries 
Ethernet – A network cabling protocol for transmitting data 
across a LAN; a wired connection to a LAN is called an Ethernet 
connection. 
EULA – End User License Agreement; a license agreement you 
accept and agree to abide by when you install software.  
Field – A data entry unit for holding a single piece of information; 
a category of information in a database table. 

File Name Extension – A suffix added to the base name of a 
computer file; used to specify the format of a file and to identify 
which program(s) created and can open the file. 
File Permissions – Rules that determine whether you can access 
a file and what you can do with it. 
Firewall – A security barrier that filters and controls the flow of 
information coming into and out of a private network. 
Firmware – Built-in programmable logic (software) that is 
embedded in a piece of hardware and controls how the device 
functions. 
Floating Object – An object that can be placed in any position 
in a document because it “floats” above the text. 
Folder – A container that stores files and other folders; also 
known as a directory or subdirectory. 
Foreign Key – A column (or combination of columns) in a table 
the references the primary key in another table. 
Formula – An expression which calculates a value; can be 
composed of values, cell references, arithmetic operators and 
functions. 
Forum – An online discussion site where users post questions 
and answers to create conversations also called discussion 
boards. 
Function – A pre-defined formula. 
GUI – An acronym for Graphical User Interface; it provides menus 
and clickable buttons or icons to perform computing tasks. 
Windows is a GUI. 
Hacker – A person who tries to gain unauthorized access to a 
computer system. 
Handle – In social media accounts such as Twitter, a handle is 
the name by which you are recognized in the social network. 
Handles – Small circles or squares that appear around the 
perimeter of a selected object. 
Handouts – Documents that audience members can take with 
them after viewing a presentation. 
Hardware – Physical components that comprise a computer or 
computing device.  
Hashtag – A word or phrase preceded by a number sign or hash 
symbol (#); when you turn a word or phrase into a hashtag, it 
becomes a searchable link. 
Header – Text or graphics that repeat at the top of every page. 
A header may include page numbers. 
Hibernate – Power mode available only on laptops that stores 
open files and programs to disk and turns off the system. This 
mode draws no power. 
Highlighted – Indicates that an object or text is selected and will 
be affected by the next action or command. 
History – A function that stores and lists the URLs of web sites 
you visited.  
Home Page – Top-level page of a web site (also called an Index 
page or a landing page). 
Hosted Service – A service that is provided by a server located 
outside your own network. 
HTTP – Hypertext Transfer Protocol; the protocol used to 
request and send web pages over the Internet. 
Hyperlink – A reference to data that is located somewhere other 
than the present location; you click a hyperlink to jump to the 
targeted location.  
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Internet – A global network of computers. It is a large non-
administered collection of computers that no one person or 
organization owns or is responsible for. 
In-browser App – A web-based browser extension by linking to 
a web service. 
Infrastructure – The underlying physical framework needed for 
the operation of a service or an enterprise; in networking, 
infrastructure is the hardware that supports high-speed 
communications and data transfer. 
Inline Object – An object that acts as a text character in a 
paragraph. 
Instant Messaging – A type of electronic communication that 
allows two or more participants to converse in real time by 
typing messages to one another 
Intellectual Property – A work or invention that is the result of 
the creative effort of a company or individual; the creator has 
rights that restrict the use of his intellectual property by others 
Interface – A point where two systems (or people, or networks, 
or devices) meet and exchange information. 
Intranet – A private web site on your company’s network; you 
must log in using a valid user name and password.  
IP Address – Unique address that distinguishes one computer 
from another on a network; formatted as a series of four decimal 
numbers separated by periods (IPv4) or eight hexadecimal 
separated by colons (IPv6)  
ISP – Internet Service Provider; a company that provides a 
connection to the Internet for a monthly fee 
Keywords – Words that you enter in a search field as criteria for 
a search. 
LAN – Local Area Network; a private network usually confined to 
one geographic location. 
Legend – A box on a chart that explains the meaning of each 
line in a line chart, or bar in a bar chart. 
Live Streaming – The process of broadcasting real-time live 
audio/video footage as a video feed to an audience that accesses 
the stream over the Internet. 
LMS – Learning Management Systems; a software application 
designed to deliver electronic training courses, track student 
progress, and generate performance reports; an engine that 
powers eLearning. 
Lock Screen – Screen that displays until the user performs the 
required gesture, or enters the correct information; a feature 
designed to keep unauthorized users from accessing your 
device. 
Malware – Software that can harm a computer; usually refers 
specifically to spyware and adware  
Margin – The white space or area from the edge of the paper to 
the text. 
Microprocessor – Silicon chip that performs calculations and 
logical operations in the computer; also referred to as the Central 
Processing Unit (CPU) or simply as the processor. 
Mini Toolbar – A contextual toolbar that appears only when you 
select text. As you move the mouse pointer over the toolbar, it 
becomes a functioning toolbar with commonly used text 
formatting options. 
MMS – Multimedia Messaging Service; similar to SMS but 
provides a standard way to send messages that include 
multimedia content from one mobile device to another. 

Mouse Pointer – An icon (usually an arrow) that follows the 
movement of the mouse (or other pointing device) on the screen 
Name Box – This box displays the cell address of the active cell. 
It is located on the left below the toolbar. 
Navigation Bar – A series of links (usually down the left side or 
across the top of the page) that provides access to various areas 
of a web site. 
Netiquette – A customary code of good practices relating to 
electronic communications. 
Network – A system for moving objects or information from one 
location to another.  
Network Interface Card (NIC) – Hardware that must be 
installed on your computer before you can send or receive data 
between your computer and the network. 
Network Share – A location on a server that is available over a 
network; used within the confines of a LAN. 
OCR – Optical Character Recognition; functionality which allows 
a scanner to convert a scanned image into editable electronic 
text and save that editable text as a document. 
Office Clipboard – A place to store data temporarily, pending 
retrieval. 
Online Meeting – A meeting in which multiple participants can 
speak, share visuals, send files, and request and take control of 
material being presented. 
Online Profile – A collection of information about you, including 
your user name, a picture, your hobbies and interests and so on. 
Open-Source Software – Software for which the code base if 
freely available and modifiable; usually the software is 
distributed without charge. 
Orientation – The direction of the paper for text flow; Portrait 
takes advantage of the length of the paper vertically whereas 
Landscape uses the length of the paper horizontally. 
Packets – Small units of data that are transferred across a 
network; each packet includes address information for the 
source and destination device and a data payload. 
Page Break – The division between two pages. 
Password – A unique string of characters that must be provided 
before a logon or access is authorized.  
Paste – The editing function of placing cut or copied data into a 
new location. 
Path – The route you must follow to get to the location of a file 
on a disk. 
Peripherals – Devices connected to a computer system by a 
cable or by using wireless technology. 
Permissions – Rules associated with objects on a computer, such 
as files, folders and settings. Permissions – Determine whether 
you can access an object and what you can do with it. 
Phishing – A the process of trying to gather sensitive 
information such as a password, or credit card details from an 
unsuspecting victim by pretending to be a trustworthy entity. 
Piracy – the act of sharing or selling a copyrighted item without 
the owner’s permission 
Plagiarism – The act of passing off someone else’s work or idea 
as your own without crediting the source. 
Platform – Interface between an application (or app) and the 
operating system; the environment within which an application 
runs. 
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Plug-ins – Also known as Add-ons; small applications that 
extend the capabilities of web browsers. 
Podcast – An audio or video file you can upload to play or 
broadcast from a media player or a Web site. Podcasts can also 
be broadcast in real time from your computer with a Webcam. 
Pop-up Blocker – A utility in a browser that suppresses the 
display of pop-up windows. 
Port – Socket into which you can connect peripheral devices to 
a computer. 
Power Plan – A collection of hardware and system settings that 
manages how a computer utilizes power. 
Primary Key – A field (or combination of fields) that uniquely 
identifies each record stored in a database table. 
Private Browsing – An option that allows you to surf the web 
without saving any information about your browsing. 
Program – A sequence of instructions that guides the computer 
through the performance of a specific task or sequence of tasks. 
Proprietary Software – Software that is owned by an individual 
or a company, and sold as an executable file along with a license.  
Protocol – A set of rules that enable devices to communicate 
with one another in an agreed-upon manner  
Quick Access Toolbar – Located above the File tab and contains 
popular commands such as Save, Undo, and Redo. This toolbar 
can be customized for those commands you use frequently. 
Radio Button – A selection that appears in a dialog box that 
allows a user to choose one item from a group of choices. 
Range – A selection of cells in a worksheet. 
Record – Information about a single item in a database table. A 
record contains fields (or columns) and each field contains a 
different piece of information about the item. 
Recycle Bin – A temporary storage area for deleted files. Deleted 
files remain in the Recycle Bin until the deleted files are restored 
or the Recycle Bin is emptied. 
Restore Point – A saved snapshot of your computer’s Windows 
system files, program files, and Windows registry settings at a 
specific point in time. 
Root Directory – The highest level of any directory on a disk; 
represented by the drive letter and a colon, followed by a 
backslash. 
Row – A record in a database table or a numbered row 
(horizontal sequence of cells) in a worksheet. 
Ruler – Located below the Ribbon in Word or PowerPoint;  the 
ruler displays icons that allow you to perform functions such as 
changing margins, tabs and indents quickly. 
SaaS – Software as a Service; a subscription service where you 
pay a monthly rate for access to software that is delivered over a 
network.  
Save – The process of storing or copying the information stored 
in the memory to a disk.  
Scanner – Device that converts a printed page or image into an 
electronic format 
Screen Resolution – Refers to the degree of clarity with which 
text and images appear on screen. 
Scroll Bars – Scroll bars automatically appear in a window if the 
contents are not entirely visible. A vertical or horizontal scroll bar 
may appear. 

Search Box – A field in which you can enter criteria to search for 
help topics or file names that match what you type. 
Search Engine – A service that maintains a database of Internet 
URLs and an index of key words; you use a search engine to find 
pages that contain information on text you specify as a criteria 
Server – A computer designed to support other computers for 
business purposes; servers provide files and services to other 
systems on a network 
Settings App – A Windows 10 app you can use to configure 
several system settings. 
Sharing Link – A hyperlink you can send in the body of an email 
message that provides access to a file or folder stored in a cloud 
location. 
Shortcut Keys – The commands activated by pressing the CTRL 
key with another key to perform a specific task, such as pressing 
CTRL+P will display the Print menu. 
Shortcut Menu – The menu that appears when you click the 
right mouse button. 
Signature – A block of text that appears at the bottom of an 
email that includes contact information on who sent the 
message. 
Sleep – Power mode that leaves the computer on but puts it into 
a state that consumes less power. The display turns off, the fan 
stops, and work is put into memory.  
Slide Layout – A blueprint or boiler plate for slides; each layout 
contains placeholders for various types of content  
Slide Sorter – The view that displays multiple miniature slides 
on one screen; use this view to rearrange or sort your slides. 
Smart Phones – Hand-held devices that combine the features 
of a standard cell phone with those of a personal computer. 
SMS – Short Message Service; a protocol used by cellular 
providers to enable text messages to be sent from one mobile 
device to another. 
Social Engineering – The practice of tricking users into giving 
out passwords or other types of access information. 
Social Media Site – Web site where registered users connect 
with each other to build a social network in which they can share 
information, pictures, ideas, and opinions. 
Software – Refers to any program that makes a computer run – 
including operating systems and application programs. 
Spacing – Refers to the amount of white space between 
individual characters, words, lines or columns of text or objects. 
Spam – Unsolicited electronic communications; often spam 
messages promote products and services, or convey specific 
political/religious views. 
Speaker Notes – A PowerPoint feature that allows you to create 
notes on each slide in the presentation and then print these for 
your reference during the presentation. 
Spelling & Grammar – A feature that checks the spelling and 
grammar in a document and usually provides a list of corrections 
for any error it finds. 
Spyware – Software that is secretly placed on your system and 
gathers personal or private information without your consent or 
knowledge. 
Status Bar – Located at the bottom of the screen. The status bar 
displays messages, cursor location, page number, section 
number, and whether specific features are active. 
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Streaming – The process of having a file delivered to your device 
in a constant and steady stream; the file is not stored on your 
computer. 
Subfolder – A folder contained within another folder. 
Symbol – A character that can be inserted into a document, 
either as a text character or for a bullet or numbering style. 
System Image – An exact image of a hard drive; it includes 
Windows and the system settings, programs, and files. You can 
use a system image to restore the contents of your computer to 
the state it was in when you created the image. 
Tab – Depending on the context used, it may refer to the TAB 
key on the keyboard, a page of options in a dialog box, a menu 
command on the Office 2016 Ribbon, or an option to display 
another page for further actions.  
Table – A feature that enables you to create a grid layout for 
content consisting of columns and rows, similar to how a 
worksheet appears. 
Task Pane – A window displayed at the side of the screen that 
appears when specific commands are activated such as the 
Office Clipboard 
Taskbar – The area at the bottom of the screen that runs 
horizontally and contains the Start menu and other frequently 
used programs, folders or files. 
Theme – A collection of coordinated appearance settings saved 
under a name; themes include font settings, color settings and 
text, border, and fill styles. 
Touch Screen – An interface that allows you to touch or tap a 
screen to perform specific actions instead of using a mouse and 
keyboard. 
Transition – Special effects that you can apply as you move from 
one slide to the next during a slide show 
Trojan – A program designed to allow a hacker remote access 
to a target computer system. 
Troubleshooting – A systematic approach to solving a problem; 
generally, the process of determining what may be causing an 
issue on the computer and then finding a resolution for the issue. 
Undo – The feature that enables you to reverse the last action 
performed. 
Upload – The process of sending data from your computer to a 
server 
URL – Uniform Resource Locator; a global (text) address of a 
resource that is located on the World Wide Web. It consists of a 
protocol identifier and a domain name. Each URL is associated 
with a specific IP address. You enter a URL into a browser address 
bar to visit a web page. 

User Name – A unique name associated with a particular 
computer or software account 
User Profile – A collection of settings that make the computer 
look and function in a particular manner. 
Video Conference – An online meeting in which participants 
share video via web cam. 
Virtual – Term that refers to device that does not physically exist, 
but is made to appear and act as if it exists by software. 
Virtual Personal Assistants – Voice-activated services that 
answer questions, make recommendations and perform actions 
on a device. 
Virtual Private Network (VPN) – An encrypted connection 
between two computers that allows secure, private 
communications over long distances using the Internet. 
Virus – A malicious program designed to take control of system 
operations, and damage or destroy data.  
Voice Mail – A centralized system used in businesses for 
sending, storing, and retrieving audio messages. 
VoIP – Voice over Internet Protocol; a technology that allows you 
to make voice calls using a broadband Internet connection 
instead of a traditional telephone line. 
Web Apps – Applications that run on the World Wide Web 
instead of running directly on a device. 
Web Servers – Servers that host or store a company’s or an 
individual's web site. 
WebEx – Hosted service that you can use to conduct online 
meetings with anyone who has an Internet connection. 
Wide Area Network – A network that connects computers in 
multiple locations using communication lines owned by a public 
carrier; a WAN is a public network. 
Widget – A small self-contained program you can add to a web 
site, blog or personalized web page. A widget brings external 
content into the web page. 
Wireless Network (Wi-Fi) – A network that includes a wireless 
access point which supports wireless connections using one of 
802.11 Wi-Fi standards 
Word Wrap – A feature that moves text from the end of a line 
to the beginning of a new line as you type. 
World Wide Web (WWW) – System of interlinked documents 
accessible on the Internet. 
WYSIWYG – Refers to “What You See Is What You Get”, a display 
mode that shows the document exactly as it will appear when 
you print it or when you view it in a web browser. 



Index Appendix C 
 

 

7500-1 v1.00 © CCI Learning Solutions Inc.  A 13 

Index 
= 
=AVERAGE, 325 
=COUNT, 325 
=MAX, 325 
=SUM, 325 

2 
2-in-1s, 50 

A 
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Add-ons, 450 
Address Bar, 422 

Searching, 435 
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Ad-hoc, 85 
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Android, 28 
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Antivirus Software, 220 
API, 354 
App Store 

Browsing, 251 
App Stores, 159, 250 
Apple Safari, 427 
Application Programs, 2, 12 
Application Service Provider, 477 
Applications, 241 

Desktop publishing programs, 243 
Graphic design programs, 244 
Image editingprograms, 244 
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Productivity progarms, 242 
Programs, 242 
Spreadsheet programs, 244 
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Recurring, 538 

Appointments, 537 
Inviting others, 539 
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Content, 253 
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Limitations, 260 
Local, 250 
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Recovering deleted, 164, 259 
Settings, 17 
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Stores, 250 
Video, 255 
Web, 247 

Archiving, 533 
Articles, 472 
Asynchronous, 483 

Classes, 512 
Communications tools, 484 
Email, 484 
SMS text messages, 484 

Attachments, 137, 528 
Opening, 529 

Audio Apps, 254 
Audio Ports, 62 
Authentication, 226 
AutoComplete, 446, 461 
AutoFill, 446 
AutoFilter, 339 
Automatic Updating, 33 

Benefits and drawbacks, 35 
Windows 10, 34 

Axes, 336 
Axis titles, 336 

B 
Backbone, 412 

Tier 1 providers, 412 
Backstage, 265, 372 
Backstage view, 265 
Backup, 226 

File History, 227 
Mobile data, 233 
PC system files and settings, 231 
Personal files, 226 
Refresh and Reset, 234 
Repair disc, 232 
Restoring personal files, 229 
Secure, 230 

System image, 232 
System restore points, 231 
Using factor reset options, 234 
Windows Backup and Restore, 228 

Bandwidth, 40 
Basic Cell Phone, 95 
BlackBerry 10, 28 
Blockers, 443, 478 
Blogs, 548 
Bluetooth, 66 
Bookmarks, 437 

Deleting, 441 
Managing, 440 
Synchronizing, 442 

Boolean Operators, 463 
Borders, 330 
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DSL, 75 
Fiber optic, 75 
Modems, 78 
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Satellite Internet, 75 
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Broadband Cable, 75 
Browser Features, 433 
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Plug-ins, 450 

Browser Functions, 433 
Browser History 

Deleting, 448 
Browser History, 447 
Browser Navigation Tools, 429 
Browser Preferences, 443 
Browser Settings, 430 
Browser Tabs, 424 
Browsers, 422 

Address bar, 422 
Apple Safari, 427 
Apps, 450 
AutoComplete, 446 
AutoFill, 446 
Bookmarks, 437 
Cache, 446 
Downloading, 433 
Extending functionality, 450 
Features, 433 
Functions, 433 
Google Chrome, 426 
History folder, 447 
Hyperlinks, 425 
Microsoft Edge, 426 
Microsoft Internet Explorer, 426 
Mozilla Firefox, 426 
Opera, 427 
Page rendering, 427 
Popular, 425 
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Private browsing, 449 
Scroll bars, 423 
Setting a home page, 431 
Streaming, 435 
Uploading, 433 
Using a mouse, 454 
Windows Control Buttons, 424 

Bullying, 562 
Bundling, 477 
Business Applications, 513 
Byte, 39 

C 
C2R Installer, 150 
Cache, 446 
Caches, 218 
Calendar, 536 

Appointments, 537 
Recurring appointment, 538 

Calendars 
Adding, 540 
Multiple, 539 
Subscribing, 541 

Cascading Styles Sheets, 420 
CD, 43 
Cell, 313 
Cell Address, 313 
Cell Addresses 

Absolute, 326 
Relative, 326 

Cell Services, 92 
Contracts, 92 
Obtaining, 92 

Cells, 90 
Deleting, 323 
Inserting, 323 
Network hub, 90 

Cellular Carriers, 91 
Types, 91 

Cellular Devices, 94 
Basic cell phone, 95 
Cellular-enabled tablets, 95 
Enabling Wi-Fi, 96 
Mobile data, 96 
Smart Phones, 95 
Turning off data, 97 

Cellular Generations, 91 
Cellular Networks, 90 

Carriers, 91 
Generations, 91 

Cellular Service 
Different from Internet Service, 92 

Cellular Services 
Plan add-ons, 94 
Plans, 94 
Pre-paid, 93 

Cellular-Enabled Tablets, 95 
Censorship, 478 
Central Processing Unit, 39 
Certificate Authority, 225 
Changing the view, 377 

Character Formatting, 285, 387 
Chart 

Types, 334 
Chart Layout, 336 
Chart titles, 336 
Chart Tools Ribbon, 334 
Chart Types, 334 
Charts, 333 

Axes, 336 
Axis titles, 336 
Chart layouts, 336 
Data labels, 336 
Data table, 336 
Error Bars, 336 
Gridlines, 336 
Legend, 336 
Titles, 336 

Chat, 167 
Gmail, 167 

Chromebooks, 49 
Click-to-Run, 150 
Client Systems, 179 
Close 

Documents, 273 
Workbooks, 318 

Close Button, 424 
Cloud Accounts, 181 

Managing, 182 
Cloud Computing, 179 

Accounts, 181 
Applications, 206 
Benefits, 180 
Hosted service, 179 

Cloud Storage 
Dropbox, 204 
iCloud, 202 
Microsoft OneDrive, 192 
Sharing, 189 

Cloud-Based Applications, 206 
Customer relationship management 

software, 207 
Learning management system, 206 

Co-authoring Documents, 510 
Code, 1 
Collaboration Tools, 508 

Office 365, 508 
Colors, 331 
Column Headings, 312 
Column Width, 305 
Column Widths, 322 
Columns, 292 

Breaking, 292 
Deleting, 323 
Inserting, 323 

Common OS Features 
Account Options, 6 
Account Types, 5 
Built-in power off procedures, 7 
User accounts, 5 
User profiles, 6 

Communication Apps, 252 

Communications 
Friend requests, 550 
Friends, 550 

Compiling, 1 
Compressing, 139 
Computer Types, 44 

2-in-1s, 50 
Chromebooks, 49 
Desktop, 45 
Laptops, 47 
Notebooks, 47 
Servers, 44 
Smart phones, 50 
Tablets, 49 

Computers and Your Health, 563 
Audience consideration, 564 
Coping with change, 563 
Disengaging, 564 

Computing Device 
Inside components, 40 

Conference Calling, 489 
Conference Calls, 501 
Conferencing 

Calls, 501 
Online, 500 
VoIP, 500 

Configuring, 156 
Customizing toolbars, 156 

Connectedness, 181 
Connecting “Smart” Devices, 105 
Connecting to the Internet 

Private address, 79 
Connection Speed, 434 
Connections 

Keyboards, 52 
Troubleshooting, 237 

Connectors, 59 
Audio, 62 
Infrared, 67 
Network, 62 
USB, 63 
Video, 59 

Contacts, 522, 533 
Content Apps, 253 
Content Management, 509 
Contract Services, 92 
Control Panel, 18 

Categories, 19 
Desktop display, 23 
Password protection, 22 
Power management, 22 
Power plan settings, 56 
Profile-specific settings, 23 
Screen resolution, 21 

Conversation, 525 
Cookie, 216 
cookies, 444 
Cookies 

Controlling, 445 
Copyright, 475 

Fair Use, 475 
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Licensing, 476 
Sources of information, 476 
Web sites, 475 

Copyright Infringement, 388, 476 
Copyrights, 474 
Cortana, 12, 128 
CPU. See Central Processing Unit 
Cropping, 302 
CSS, 420 
Customer Relationship Management, 

207 
Customizing Toolbars, 156 
Cut, Copy or Paste, 321 
Cyber Bullying 

What not to do, 563 
What to do, 563 

Cyberbullying, 562 

D 
Data, 353 
Data Cap, 77 
Data Labels, 336 
Data Payload, 412 
Data Table, 336 
database, 353 
Database 

Attribute, 356 
Column, 356 
Composite primary keys, 358 
Driven web pages, 366 
Dynamic web pages, 366 
Dynaset, 364 
Field, 356 
Foreign keys, 360 
Forms, 364 
Forms on the web, 368 
Metadata, 362 
Primary key, 357 
Queries, 363 
Queries on the web, 367 
Record, 356 
Relationship types, 361 
Static pages, 366 
Table metadata, 356 
Table relationships, 360 
Tables, 356 
Web sites, 366 
Where used, 366 

Database Tables, 356 
Databases 

APIs, 354 
Connectivity standards, 354 
Data, 353 
Multiple, related tables, 354 
Relational database management 

systems, 354 
Spreadsheet, 353 
Structured Query Language, 354 

Default Locations, 132 
Defaults, 157 
Delayed Communications, 484 

Asynchronous, 484 
Text messaging, 484 

Deleting Apps, 164, 258 
Desktop, 3 

Cortana, 12 
Customizing, 25 
Navigating, 10 
Search box, 12 
Virtual, 14 

Desktop apps, 12 
Desktop Computers, 45 

Common configurations, 46 
Disadvantages, 46 
Mac, 45 
PC, 45 
Used by, 46 

Desktop Display, 23 
Desktop Publishing, 243 
Desktops 

Virtual, 13 
Device Drivers, 37 
Dialog box launcher, 267 
Dialog Boxes, 20 
Digital Cameras, 66 
Digital Certificate, 225 
Digital Communication, 483 
Digital Communications 

Asynchronous, 484 
Delayed, 484 
Distance learning, 512 
Real-time, 484 
Streaming, 512 
Synchronous, 484 

Digital Footprints, 559 
Digital Identify 

Aliases, 561 
Creating a positive online identify, 

560 
Important to remember, 560 
Managing, 561 
Online behavior, 562 
Posting items, 559 

Digital Identity, 559 
Footprints, 559 
Personal vs professional, 561 

Digital Rights Management, 134 
Digital Subscriber Line. See DSL 
Directory, 105 

File and folders, 112 
Root, 105 

Directory Structure, 103 
Connected storage devices, 104 
Drive letters, 103 
Internal storage devices, 104 
Mapped network locations, 104 

Discussion Boards, 548 
Disengaging, 564 
Distance Learning, 512 
DNS 

Domain levels, 417 
Second-level domains, 418 

Top-level domains, 417 
DNS Records, 416 
DNS Servers, 416 
Docking Station, 48 
Domain Category, 518 
Domain Levels, 417 
Domain Name System, 416 

DNS records, 416 
Domain Name Systems 

DNS servers, 416 
Domain Names, 416 
Downloading, 71, 76, 186, 433 
Downloads Folder, 132 
Downstream, 76 
Draft, 281 
Drag and Drop, 283 
Drive Letters, 103 
DRM. See Digital Rights Management 
Dropbox, 204 
DSL, 75 
DVD, 43 
Dynaset, 364 

E 
E-Commerce, 224 

Be selective, 224 
Exercise skepticism, 224 
https, 224 
Safe transactions, 224 
Secured transactions, 224 

Edit Mode, 385 
Effects, 285, 387 
Ehternet 

Cables, 81 
Electronic Mail, 484 
Electronic Media, 134 
Elevation Prompts, 151 
Email, 484, 517 

Address book, 522 
Address structure, 518 
Archiving, 533 
Attachments, 528 
Contacts, 522 
Desktop application, 517 
Domain category, 518 
Gmail, 518 
Junk, 532 
Mailbox Name, 518 
Organization Name, 518 
Proofing, 522 
Sending messages, 522 
Signatures, 527 
Spam, 531 
Using, 518 

Email Address, 518 
Email Attachments, 137 

Limitations, 138 
Enabling Wi-Fi, 96 
Encryption, 226 
End User License Agreement, 3, 152, 478 
Entering Data, 313 
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Dates, 314 
Numbers, 314 
Text, 313 

Ergonomics, 565 
Eyestrain, 565 
Repetitive stress injuries, 565 

Error Bars, 336 
Ethernet, 62, 72, 78, 80 

Network interface card, 81 
Standards, 81 
When to use, 82 

Ethical Issues 
Censhorship, 478 
Copyright, 475 
Fair use, 475 
Intellectual Property, 474 
Piracy, 478 
Plagiarism, 479 

Etiquette, 486 
EULA. See End User License Agreement, 

See End User License Agreement 
Evaluating Information 

Accuracy, 472 
Advertising, 473 
Affiliations, 472 
Articles, 472 
Bias, 472 
Currentness, 472 
Depth of coverage, 472 
Forums, 473 
Rankings, 473 
Source references, 472 
Sponsored links, 473 
Tone, 473 

Evaulating Information, 469 
Excel 

Absolute or Relative addresses, 326 
Active cell, 312, 313 
AutoFilter, 339 
Basic terminology, 312 
Cell, 313 
Cell address, 313 
Changing data, 320 
Chart tools ribbon, 334 
Chart types, 334 
Charts, 333 
Closing workbooks, 318 
Column headings, 312 
Column widths, 322 
Common functions, 325 
Creating a new blank workbook, 314 
Creating a workbook from a 

template, 315 
Cut, copy or paste, 321 
Deleting rows, columns or cells, 323 
Entering data, 313 
Filtering data, 339 
Formatting, 329 
Formula Bar, 312 
Formulas, 313, 325 
Insert Function, 312 

Inserting rows, columns or cells, 323 
Labels, 313 
Moving around, 314 
Name Box, 312 
Office Clipboard, 322 
Opening workbooks, 317 
Previewing or printing workbooks, 

348 
Range of cells, 320 
Row headings, 312 
Row height, 323 
Saving workbooks, 316 
Scroll bars, 312 
Sheet tab, 312 
Tab scrolling, 312 
Undo or Redo, 321 
Values, 313 
Workbook, 312 
Worksheet, 313 

External Drives, 43 
Eyestrain, 565 

F 
Facebook, 551 
Factory Reset Options, 234 
Fair Use, 475 
Favorites. See Bookmarks 

Favorites center, 438 
Favorites Center, 438 
Fiber Optic, 75 
Fiber Optic Service, 75 
File 

Permissions, 106 
File Explorer, 107 

Searching, 128 
File History, 227 
File Name Extensions, 119 
File Size, 434 
File Tab, 265 
File Transfer Protocol, 419 
File Types, 119 

PowerPoint, 376 
Files 

Archived/compressed, 122 
Audio, 119 
Closing, 273 
Compressing, 139 
Copying, 125 
Deleting, 130 
Document, 120 
Executable, 121 
Extensions, 119 
Graphics, 120 
Identifying, 112 
Moving, 126 
Renaming, 127 
Restoring, 130 
Saving in Word, 269 
Searching, 128 
Selecting, 123 
Types, 119 

Video, 120 
Windows 10, 122 

Files Name Extensions 
Viewing, 123 
Windows 10, 122 

Filtering, 339 
AutoFilter, 339 

Filters, 478 
Finding 

Computers on the Internet, 415 
Finding Items, 295 
FiOS, 75 
Firewalls, 222 

Challenges, 223 
Desktop, 223 

Firmware, 38 
Flash Drives, 43 
Flash Memory, 43 
Folder 

Permissions, 106 
Folders, 103, 105 

Changing the view, 116 
Copying, 125 
Creating, 112 
Deleting, 130 
Downloads, 132 
Identifying, 112 
Moving, 126 
Options, 116 
Pictures, 132, 133 
Public, 135 
Renaming, 113 
Restoring, 130 
Selecting, 123 
Shared, 136 
Shortcuts, 113 
Subfolders, 105 

Font, 285, 387 
Font Size, 285, 387 
Fonts, 330 
Foreign Keys, 360 
Formatting, 285, 329, 387 

Aligning, 286 
Aligning text, 387 
Borders, 330 
Cell Alignment, 330 
Characters, 285, 387 
Colors, 331 
Decimal Digits, 330 
Effects, 285, 387 
Excel, 329 
Font, 285, 387 
Font Size, 285, 387 
Fonts, 330 
Keyboard shortcuts, 286 
Numbers, 330 
Patterns, 331 
Sizes, 330 
Tables, 304 
Text, 387 
Text characters, 285 
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Forms, 364, 368 
Formula Bar, 312 
Formulas, 325 

Creating, 325 
Mathematical operators, 325 

Forum, 473 
Forums, 548 
Freeware, 477 
Friend Requests, 550 
FTP, 419 
Functions, 325 

=AVERAGE, 325 
=COUNT, 325 
=MAX, 325 
=SUM, 325 

G 
Gateways, 78 
Global Settings, 17, 21 
Gmail, 518 

Address books, 534 
Calendar, 536 
Contacts, 533 

Gmail Chat, 167 
Gmail Screen, 518 
Google Chrome, 426 
Google Drive, 248 

Apps, 187 
Cloud storage, 183 
Content, 184, 193 
Mobile apps, 192 

Google Hangouts, 499 
Google Hangouts on Air, 513 
Graphic Design, 244 
Graphical User Interface, 2 
Gridlines, 336 
GUI. See Graphical User Interface 

H 
Hackers, 213 
Handheld Device, 88 
Handles, 300 
Handouts, 402 
Hard Disks, 42 
Hardware, 1, 37, 412 

Device drivers, 37 
Firmware, 38 
Network infrastructure, 70 
Packets, 412 
Platform, 38 
Smart phone, 54 
Troubleshooting, 236 

hashtag, 465 
HDMI. See High-Definition Multimedia 

Interface 
High-Definition Multimedia Interface, 59 
Home Page, 429 

Setting, 431 
Site, 451 

Home Screen, 30 

App folder, 31 
App screen, 31 
App-shortcuts, 31 
Dock, 31 
Home screen indicator, 31 
Notification icons, 31 
Status bar, 31 
Status icons, 31 
Widget, 31 

Host, 83 
Hosted Service, 179 
How much do I need? 

RAM, 41 
Storage, 42 

HTML, 420, See hypertext markup 
language 
Hyperlinks, 421 
Tags, 420 

HTTP. See Hypertext Transfer Protocol 
HTTP Secure (HTTPS), 419 

https. See Hypertext Transfer Protocol 
Secure 

Hyperlinks, 421 
Pointing hand, 425 

HyperText Markup Language, 419 
HyperText Transfer Protocol, 418 
Hypertext Transfer Protocol Secure, 224 

I 
iCloud, 202 
Illustrations 

Handles, 300 
IM. See Instant Messaging 
Image Editing, 244 
In-Apps Purchases, 258 
Index Page, 451 
Infrastructure, 69, 86 
Input Devices, 51 

Keyboards, 51 
Insert Function, 312 
Inserting 

Cells, 323 
Columns, 323 
Rows, 323 
Tables in Word, 303 

Inserting Cells, 304 
Inserting Columns, 304 
Inserting Rows, 304 
Instagram, 551 
Installing, 150 
Instant Messaging, 170 

Skype, 170 
Intellectual Property, 474 
Interface, 2 
internet 

Routers, 413 
Internet 

Backbone, 412 
Finding computers, 415 
Hardware, 412 
Home page, 451 

HyperText Markup Language, 419 
Researching, 469 
Search engines, 460 
Searching, 459 
URL, 418 
Using a mouse, 454 
Web pages, 419 
Web standards, 451 
World Wide Web, 419 

Internet Addiction, 564 
Internet Connections, 70 

LAN, 78 
Internet Protocol, 72 

Versions, 72 
Internet Service, 74 

Choosing, 75 
Choosing a provider, 77 
Different from cellular service, 92 
Providers, 74 
Testing the connection speed, 77 
Upload or download speeds, 76 

Internet Service Provider, 412, See ISP 
Internetwork, 69 
Intranet, 414 
iOS, 28 
IP. See Intellectual Property 
IP Address, 415 
IP Addresses, 72 

Connecting or finding, 72 
Important points, 80 
Public or Private, 79 
Unique, 79 

IP Addressing 
DNS servers, 416 

ISP, 74 

J 
Junk Mail, 532 

K 
Keyboard, 10 
Keyboard / Dial Pad, 55 
Keyboards, 51 

Connections, 52 
Virtual, 49, 51 

Keywords, 461 

L 
Labels, 526 
LAN, 71, 78 

Add shared printer, 83 
Wireless, 86 

Landlines 
Advantages and Disadvantages, 98 

Laptop Computers, 47 
Common configurations, 48 
Disadvantages, 47 

Learning Management System, 206 
Learning Management Systems, 512 
Legend, 336 
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License 
Open source, 3 
Proprietary software, 2 

Licenses, 476 
Licensing, 476 

ASP, 477 
EULA, 478 
SAAS, 477 
Single seat, 477 
Site, 477 
Volume or Network, 477 

Limitations of Apps, 260 
Line Spacing, 286 
LinkedIn, 551, 553 

Connections, 553 
Creating an account, 554 
Creating your profile, 554 
Inviting connections, 558 

LinkedIn Profile, 554 
Linux, 4 
Livestream, 513 
LMS. See Learning Management 

Systems, See Learning Management 
System 

Local Apps, 250 
Local Area Networks. See LAN 
Local Location, 107 
Lock Screen, 29 
Locking, 215 
Long Term Evolution. See LTE 
Looking at the Screen 

View buttons, 266 
LTE, 91 

M 
Mac OS, 4 
Mailbox Full, 100 
Mailbox Name, 518 
Malware, 216 
Mapping, 104 
Margins, 289 

Boundaries, 290 
Setting, 290 

Mathematical Operators, 325 
Maximize Button, 424 
Measuring 

Bandwidth, 40 
Capacity, 39 
Frequency, 39 

Media, 390 
Memory, 41 

Random Access Memory, 41 
Merging Cells, 305 
Message Headers, 525 
Messages 

Address book, 522 
Archiving, 533 
Attachments, 528 
Conversation, 525 
Creating, 520 
Deleting, 533 

Filtering, 531 
Forward, 525 
Headers, 525 
Junk mail, 532 
Labels, 526 
Moving, 527 
Proofing, 522 
Reply, 524 
Reply to all, 525 
Sending, 520, 522 
Signatures, 527 
Spam, 531 
Stop junk text, 532 

Messaging 
Instant, 170 
Text, 166 

Messaging Applications, 165 
Metadata, 356, 362 
Microphones, 62 
Microprocessor, 39 
Microsoft Account, 160 
Microsoft Edge, 426 
Microsoft Internet Explorer, 426 
Microsoft Office 

Backstage, 265 
Microsoft OneDrive, 192 
Mini toolbar, 286 
Mini Toolbar, 387 
Minimize Button, 424 
MMS. See Multimedia Message Service 
Mobile 

Home screen, 30 
Lock screen, 29 
Power on / off, 29 
Resetting devices, 234 
Settings app, 32 
Virtual personal assistants, 32 

Mobile Apps 
Google Drive, 192 
OneDrive, 202 

Mobile Data, 96 
Backup, 233 
Enabling Wi-Fi, 96 
Turning off, 97 

Mobile Notifications, 208 
Mobile Operating Systems, 28 

Android, 28 
Blackberry, 28 
iOS, 28 
Touch screen, 28 
Windows Mobile, 28 

Mobile Settings App, 32 
Modems, 78 
Monitoring, 223 
Monitors, 60 

Second display device, 60 
More Button, 267 
Moving, 301 
Moving Around 

Worksheets, 314 
Mozilla Firefox, 426 

Multimedia Messaging Service, 166 
Multiple Calendars, 539 
Multiple Displays, 61 
Multiple, Related Tables, 354 

N 
Name Box, 312 
Narrowing the Search 

AND, 463 
Boolean Operators, 463 
Hashtags, 464 
HTML Objects, 464 
NEAR, 463 
NOT, 463 
OR, 463 

NAT. See Network Address Translation 
Navigating 

Keyboard, 10 
Pointing device, 10 
Touch screen, 11 

Navigation Bar, 453 
Breadcrumbs, 453 

Netiquette, 486 
Network 

Connecting to a network printer, 90 
Network Address Translation, 80 
Network Connection, 414 
Network Connections, 217 

Mitigating risks, 217 
Wired, 217 
Wireless, 217 

Network Coverage, 92 
Network Hub, 90 
Network Interface Card, 81 
Network Printer, 89 

Connecting to, 90 
Networks, 69 

Benefits, 70 
Cellular, 90 
Connections, 217 
Coverage, 92 
Ethernet, 80 
Infrastructure, 69 
Internetwork, 69 
IP addresses, 72 
LAN, 71 
NIC, 81 
Packets, 71 
Shared Printer, 83 
Sharing the Internet connection, 70 
Social Media, 549 
TCP/IP, 71 
Technology, 71 
WAN, 72 
Wireless LAN, 87 

New 
Appointments, 537 
Documents, 272 
Messages, 520 
Presentations, 373 
Workbook from templates, 315 
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Workbooks, 314 
New desktop, 14 
NIC. See Network Interface Card 
Non-SMS Messaging Apps, 167 
Notebooks, 47 
Notes Pane, 373 
Notifications 

Configuring, 208 
Mobile, 208 

O 
Objects, 388 

Animating, 392 
Media, 390 
Online pictures, 388 
Pictures, 388 

Obtaining Apps, 163, 256 
OCR. See Optical Character Recognition 
Office 365, 508 
Office Clipboard, 283, 322 
Office Online, 509 
Office Suite, 509 
OneDrive 

Mobile apps, 202 
OneDrive for Business, 509 
Online Behavior, 562 
Online Conferencing, 500 
Online Meeting, 489 
Online Meetings, 511 
Open 

Workbooks, 317 
Open Source, 478 
Opening 

Word documents, 273 
Open-Source Software, 3 
Opera, 427 
Operating System, 1 

Automatic updating, 33 
Common features, 5 
Desktop, 3 
Linux, 4 
Mac OS, 4 
UNIX, 5 
Update categories, 33 
Updates, 33 
Versions or editions, 3 
Windows, 4 

Operating Systems 
Desktop, 3 
Evolution, 2 
Mobile, 28 
Open Source, 2 
Proprietary, 2 
Purpose, 2 

Optical Character Recognition, 132 
Optical Discs and Drives, 43 

CDs, 43 
DVDs, 43 

Orientation, 289 
Landscape, 289 
Portrait, 289 

OS. See Operating System 
Outline, 281 
Outlook Web App (OWA), 508 
Output Devices 

Peripherals, 59 

P 
Packets, 71, 412 

Data payload, 412 
Page Numbers, 291 
Page Rendering, 427 
Page Setup, 289 

Margins, 289 
Orientation, 289 
Paper size, 289 

Paper Size, 289 
Paragraph Spacing, 287 
Password Protection, 22 
Passwords, 213 

Changing, 214 
Paths, 105 
Patterns, 331 
Paying for Apps, 257 
PBX, 98 
Peripherals, 59 

Digital Cameras, 66 
Microphones, 62 
Monitors, 60 
Network, 62 
Ports, 59 
Printers, 64 
Speakers, 63 
USB, 63 
USB Flash Drives, 64 

Permissions, 6, 106 
Local location, 107 
Network access, 106 
Remote location, 107 
Shared files or folders, 136 

Personal Identity, 561 
Phishing, 219 
Phone Calls, 487 

Conference calling, 489 
Technologies, 488 
VoIP, 488 
WebEx, 489 

Pictures, 298, 388 
Cropping, 302 
Manipulate, 389 
Manipulating, 300 
Moving, 301 
Sizing, 301 
Smart Phones, 133 
Wrapping Text, 301 

Pictures Folder, 132, 133 
Piracy, 478 
Placeholder, 372 
Placeholders, 373 

Edit mode, 385 
Select mode, 386 

Plagiarism, 479 

Platform, 38 
Platforms, 148 
Plug-ins, 450 
Pointing Device, 10 
Pointing Devices, 52 

Mouse, 52 
Stylus, 53 
Touch screens, 53 
Touchpad, 53 

Pointing Hand, 425 
Pop-up Blocker, 443 
Pop-ups, 443 
Ports, 59 

Audio, 59, 62 
Network, 59, 62 
USB, 59 
Video, 59 

Power Management, 22 
Power Off Procedures, 7 

Powering off a Windows computer, 7 
Starting a Windows computer, 7 

Power On / Off, 29 
Power Options, 8 

Hibernate, 8 
Restart, 8 
Shut down, 8 
Sleep, 8 

Power Plan 
Settings, 56 

Power Plans, 56 
Powering Off a Windows Computer, 7 
PowerPoint, 371 

Align text, 387 
Animation, 392 
Basic terminology, 373 
Closing a presentation, 376 
Customizing animation, 393 
Delete a slide, 382 
Edit screen, 372 
Entering Text, 375 
File formats, 376 
Format text, 387 
Handouts, 402 
Insert media, 390 
Insert online pictures, 388 
Insert pictures, 388 
Insert slides, 381 
Manipulate pictures, 389 
New presentations, 373 
Notes pane, 373 
Open a presentation, 377 
Placeholder, 372 
Placeholders, 373 
Planning your presentation, 374 
Presentation structure, 371 
Presenter view, 399 
Protected View, 377 
Publishing presentations, 402 
Rearrange slides, 383 
Saving a presentation, 375 
Select vs Edit mode, 385 
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Setting the slide show up, 397 
Slide layouts, 382 
Slide pane, 373 
Slide thumbnails, 375 
Slide transitions, 394 
Slides tab, 372 
Spell Checking, 387 
Split bar, 373 
Text objects, 386 

Pre-Paid Services, 93 
Presentation Structure, 371 
Presentations, 246 
Previewing, 348 
Primary Key, 357 

Selecting, 358 
Primary Keys 

Composite, 358 
Print Layout, 281 
Printing, 348 

Documents, 296 
Print options, 348 

Private Branch Exchange. See PBX 
Private Browsing, 449 
Private IP Address, 79 
Private Networks, 413 
Productivity Apps, 252 
Productivity Progra XE 

"Applications:Productivity progarms" 
ms, 242 

Profile, 6 
Profile Settings, 17 
Profile-Specific Settings, 23 
Programs, 1 

Application, 2 
Apps, 12 
Code, 1 
Compiling, 1 
Operating system, 1 

Proofing, 522 
Proprietary Software, 2 
Protected View, 274, 377 
Protecting Yourself, 220 

Antivirus software, 220 
Authentication, 226 
Avoiding viruses, 221 
Encryption, 226 
Firewalls, 222 
Removing viruses, 222 

Protocol 
https, 224 

Protocol Identifier, 418 
Protocols, 71 

Identifier, 418 
Providers 

Cellular, 90 
Public Computers, 217 
Public IP Address, 79 

Viewing, 80 
Publishing Presentations, 402 

Q 
Queries, 363, 367 

Criteria, 364 
On the web, 367 

Quick Access Toolbar, 265, 266 

R 
RAM. See Random Access Memory 
Random Access Memory, 41 

How much do I need?, 41 
Range, 320 
RDBMS. See Relational Database 

Management Systems 
Read Mode, 281 
Read-only, 274 
Real-Time Communication 

Technologies, 486 
Real-time Communications, 484 

Classes, 512 
Phone calls, 487 
Synchronous, 484 

Recovering Apps, 164, 259 
Recurring Appointments, 538 
Recycle Bin, 130 
Recyle Bin 

Emptying, 131 
Redo, 321 
Refresh and Reset, 234 
Registration, 152 
Reinstalling, 155 
Relationship Types, 361 
Relative Addresses, 326 
Remote Location, 107 
Removable Media, 135 
Repair Disc, 232 
Repairing Software, 154 
Repeat, 282 
Repetitive Stress Injuries, 565 
Replacing Items, 295 
Researching, 469 
Resetting Mobile Devices, 234 
Restore, 226, 229 
Restore Down Button, 424 
Ribbon, 265, 266 

Chart Tools, 334 
Displaying dialog boxes or task 

panes, 267 
Gallery lists, 267 
Groups, 267 
More button, 267 
Table Tools, 303 
Tabs, 267 

Risks, 215 
Adware, 216 
Cookies, 216 
Malware, 216 
Network connections, 217 
Public computers, 217 
Social engineering, 218 
Spyware, 216 

Viruses, 215 
Worms, 215 

Root Directory, 105 
Routers, 78, 413 
Row Headings, 312 
Row Height, 305, 323 
Rows 

Deleting, 323 
Inserting, 323 

S 
Satellite Internet, 75 
Save 

Workbooks, 316 
Saving 

Documents, 269 
Presentations, 375 

Scanners, 132 
Schemas, 362 

Database, 362 
Screen Elements 

Accessing commands and features, 
266 

File tab, 265 
Quick Access toolbar, 265 
Ribbon, 265 
Ribbon, 266 
ScreenTips, 266 
Status Bar, 266 
Title Bar, 265 
Zoom Slider, 266 

Screen Resolution, 21 
Screen Sharing, 502 
ScreenTips, 266 
Scroll Bars, 312, 423 
SD Cards. See Secure Digital Cards 
Search Box, 12 
Search Engine Technology, 460 
Search Engines, 460 

Boolean Operators, 463 
HTML Objects, 464 
Keywords, 461 
Technology, 460 

Searching, 128, 459 
AAOCC, 470 
AutoComplete, 461 
Boolean Operators, 463 
Cortana, 128 
File Explorer, 128 
HTML Objects, 464 
Purpose or type, 459 
Researching information, 469 
Social media, 464 
Traditional sources, 460 
Windows search box, 128 

Searching in a Browser, 435 
Second Display Device, 60 
Secure Digital Cards, 43 
Secured Transactions, 224 
Security, 213 

Keeping your account safe, 214 
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Locking the system, 215 
Passwords, 213 
Risks, 215 
Virtual private networks, 225 

Select Mode, 385, 386 
Selecting, 269, 320 

Cells, 320 
Consecutive text, 269 

Server Systems, 179 
Servers, 44 

Common configurations, 45 
Used by, 45 

Service Providers, 74 
Settings 

Control Panel, 18 
Global, 17 
Profile, 17 

Settings App, 17 
Shared Printer, 83 

Connecting to, 85 
Disconnecting, 85 

SharePoint, 508, 509 
Co-authoring documents, 510 
Content management, 509 

Shareware, 477 
Sharing 

Cloud files, 189 
Electronic media, 134 
On a network, 137 
Pictures, 134 
Via email, 137 

Sharing Files, 135 
Pictures, 133 

Sharing Information, 547 
Blogs, 548 
Forums, 548 
Tracking changes, 307 
Wikis, 549 

Sheet Tab, 312 
Short Message Service, 166 
Sidebar 

Action Center, 14 
Signatures, 527 
SIM. See Subscriber Identity Module 
Single Seat License, 477 
Site Home Page, 451 
Site License, 477 
Sizes, 330 
Sizing, 301 
Skype, 170, 490 

Adding contacts, 173 
Group conversations, 495 
Instant messaging, 174 
Mood messages, 493 
Profile, 492 
Screen sharing, 502 
Status, 491 
VoIP calls, 501 

Skype for Business, 509, 510 
Recording online meetings, 511 
Scheduling online meetings, 511 

Taking control, 511 
Skype for VoIP Calls, 501 
Slack, 552 
Slide Layout, 382 
Slide Pane, 373 
Slide Show 

Running, 398 
Setting up, 397 
Viewing, 398 

Slide Sorter, 383 
Slide Thumbnails, 375 
Slide Transitions, 394 
Slides 

Animating objects, 392 
Deleting, 382 
Inserting new, 381 
Rearranging, 383 
Transitions, 394 

Slides Tab, 372 
Smart Phone Hardware, 54 

SIM card, 55 
Smart Phones, 50, 95 

Keyboard / Dial pad, 55 
Pictures, 133 
Touch screen capability, 50 

SMS. See Short Message Service 
SMS Text Messages, 484 
Snapchat, 551 
Social Engineering, 218 

Reducing risks, 218 
Social Media, 464, 549 

Friends and friend requests, 550 
Hashtag, 465 
Hashtags, 464 
Networks, 549 
Why join, 551 

Social Media Apps, 254 
Social Media Network 

Building the network, 550 
Social Media Networks, 549 

Popular, 551 
Social Media Neworks 

Advantages of closed network, 552 
Open vs closed, 551 

Software, 1, 147 
Application Service Provider, 477 
Bundling, 477 
Cloud based, 147 
Configuring, 156 
EULA. See End User License 

Agreement 
Freeware, 477 
Installing, 150 
Licenses, 476 
Locally installed, 147 
Managing, 149 
Monitoring, 223 
Obtaining, 148 
Open Source, 478 
Open-Source, 3 
Platform considerations, 148 

Program defaults, 157 
Programs, 1 
Proprietary, 2 
Registration. See End User License 

Agreement 
Repairing, 154, 155 
Shareware, 477 
Software as a Service, 477 
System Requirements, 148 
Troubleshooting, 236 
Uninstalling, 153 
Updating, 156 
Windows Registry, 154 

Software as a Service, 247, 477 
Software Threats 

Cookies, 444 
Spam, 531 
Spammers, 531 
Speakers, 63 
Speed and Storage 

Capacity, 38 
Measuring bandwidth, 40 
Measuring capacity, 39 
Measuring frequency, 39 

Spelling, 293, 387 
Split Bar, 373 
Splitting Cells, 305 
Sponsored Links, 473 
Spreadsheets, 244 
Spyware, 216 
SQL. See Structured Query Language 
Standard Pages, 454 
Start Button, 11 
Start Menu, 11 
Start Page, 429 
Starting a Windows Computer, 7 
Status Bar, 266 
Storage, 41, 42 

Commonly-used devices, 42 
External disks, 43 
External location, 42 
Flash drives, 43 
Hard disks, 42 
How much do I need?, 42 
Internal location, 42 
Optical disks or drives, 43 
SD cards, 43 
Tablets or Phones, 43 

Streaming, 71, 435, 512 
Structured Query Language, 354 
Stylus, 53 
Subfolders, 105 
Subscriber Identity Module, 55 
Subscribing to a Calendar, 541 
Synchronous, 483 
System Image, 232 
System Requirements, 148 
System Restore Points, 231 

T 
Tab Scrolling, 312 
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Tab Selector Box, 288 
Table Relationships, 360 
Table Selector, 303 
Table Tools, 303 
Tables, 303, 343 

Adjusting the width or height, 305 
Foreign keys, 360 
Formatting, 343 
Inserting, 303 
Inserting rows, columns or cells, 304 
Merging or splitting cells, 305 
Metadata, 356 
Modifying data, 343 
Relationship types, 361 
Relationships, 360 

Tablets, 49 
Operating system, 49 
Touch screen capability, 49 

Tags, 420 
Taking Control, 511 
Task View, 13 
Taskbar, 13 

Action Center, 14 
Buttons, 14 
New desktop, 14 
Task view, 13 

TCP/IP, 71 
Telephone Network 

Business telephones, 98 
PBX, 98 

Template, 315 
Templates, 374 
Text Messaging, 166, 485 

Etiquette, 486 
When is appropriate?, 485 

Text Objects, 386 
Tier 1 Providers, 412 
Title Bar, 265 
Toolbars 

Mini, 286 
Quick Access, 265 

Total Row, 343 
Touch Screen, 11, 53 

Limitations, 54 
Smart phones, 50 
Tablets, 49 

Touch Screen Navigation, 28 
Touchpad, 53 
Trackbacks, 548 
Tracking Changes, 307 
Transitions 

Timing, 395 
Transmission Control Protocol/Internet 

Protocol. See TCP/IP 
Troubleshooting, 235 

Connection issues, 237 
Hardware, 236 
Software, 236 

Twitter, 551 

U 
UAC. See User Account Control 
Undo, 282, 321 
Uniform Resource Locator, 418 
Uninstalling, 153 
Universal Serial Bus, 63 
UNIX, 5 
Update Categories, 33 
Updates, 33 

Categories, 33 
Manually checking, 34 
Mobile operating system, 35 

Updating, 156 
Uploading, 76, 433 
Upstream, 76 
URL, 72, 418, See Uniform Resource 

Locator  
USB. See Universal Serial Bus 
USB Flash Drives, 64 
USB Ports, 63 
User Account Control, 151 

Elevation prompts, 151 
User Accounts, 5 
User Names, 213 
User Profiles, 6 

V 
Validating Resources, 471 
Video Apps, 255 
Video Conferences, 489 
Video Editing, 246 
Video Ports, 59 
View Buttons, 266 
Views 

PowerPoint, 377 
Presenter view, 399 
Read Mode, 281 
Slide Show, 398 
Word, 281 

Vine, 551 
Virtual, 14 
Virtual Personal Assistants, 32 
Virtual Private Network, 414 
Virtual Private Networks, 225 
Viruses, 215 

Avoiding, 221 
Removing, 222 
Worms, 215 

Vitual 
Keyboards, 51 

Voice Mail, 99 
Configuring, 99 
Leaving a clear message, 100 
Mobile phone, 100 
Retrieving messages, 99 
Retrieving messages from mobile 

phone, 100 
VoIP, 488 

Conferencing, 500 
Disadvantages, 488 

Using VoIP, 501 
Volume or Network License, 477 
VPN. See Virtual Private Networks 

W 
WAN, 72 
Web Apps, 247 

Google, 248 
Web Browser 

Searching, 459 
Settings, 430 
Tabs, 424 

Web Browsers, 422 
Address bar, 422 
Boolean Operators, 463 
HTML Objects, 464 
HyperText Markup Language, 419 
Page rendering, 427 
Popular, 425 
Search engines, 460 

Web Development, 245 
Web Layout, 281 
Web Pages, 419 

CSS, 420 
Database driven, 366 
Dynamic, 366 
HTML, 419, 420 
Hyperlinks, 421 
Static, 366 
Using a mouse, 454 

Web Site, 419 
Web Sites 

Blogs, 459 
Business, 459 
Copyright, 475 
Education, 460 
Evaluating information, 469 
Government, 459 
Index page, 451 
Media, 460 
News feed, 460 
Podcasts, 460 
Reference links, 460 
Social networking, 459 
Types, 459 
Validating information, 471 
Wiki, 460 

Web Standards, 451 
Navigation bar, 453 
Standard pages, 454 
Widgets, 453 

WebEx, 489 
Wide Area Networks. See WAN 
Widgets, 453 
Wi-Fi, 72 

Handheld device, 88 
Infrastructure, 86 

WI-FI 
Ad-hoc, 85 

Wi-Fi Protected Setup. See WPS 
Wikis, 549 
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Window 
Moving, 110 
Scroll bars, 111 
Sizing, 110 

Windows, 4 
Windows 10 Mobile, 28 
Windows Apps, 159 
Windows Backup and Restore, 228 
Windows Desktop, 9 
Windows Registry, 154 
Windows Store, 159 

Finding an app, 162 
Microsoft Account, 160 
Siging in, 160 
Signing out, 165 

Windows Updates, 33 
Manually checking, 34 

Wire Connections 
Advantages, 82 
Disadvantages, 82 

Wired Connection 
Shared Printer, 83 
When to use, 82 

Wired Connections 
Ethernet, 80 

Wireless, 66 
Bluetooth, 66 
Compatibility, 67 
LAN, 86 
Modems, 78 
Routers, 79 

Wireless Connections, 85 
When to use, 87 

Wireless Fidelity. See Wi-Fi 
WLAN 

Connect on Mac, 88 
Connecting, 87 
Handheld device, 88 
Network printer, 89 

Word 
Align text, 286 
Column break, 292 
Columns, 292 
Contextual errors, 294 
Create from a template, 273 
Creating a new blank document, 272 
Cropping pictures, 302 
Customizing views, 281 
Cut, copy or paste, 282 
Drag and drop, 283 
Find and replace, 295 
Formatting text, 285 
Grammatical errors, 295 
Line spacing, 286 
Manipulating pictures, 300 
Margins, 289 
Office Clipboard, 283 
Opening documents, 273 
Orientation, 289 
Page numbers, 291 
Page setup, 289 
Paragraph spacing, 287 
Pictures, 298 
Preview and print, 296 
Print Settings, 297 
Repeat, 282 
Selecting text, 269 
Sizing pictures, 301 
Spelling errors, 293 
Table Selector, 303 
Table Tools ribbon, 303 
Tables, 303 
Tracking changes, 307 
Undo, 282 
Wrapping text around pictures, 301 

Word Processing, 242 
Workbook, 312 
Workbooks, 314 

Close, 318 
Creating new blank, 314 
Opening, 317 
Previewing, 348 
Printing, 348 
Saving, 316 
Template, 315 

Worksheet, 313 
Entering data, 313 

Worksheets 
Moving around, 314 

World Wide Web, 419 
Internet, 419 
Web pages, 419 

Worms, 215 
WPS, 89 

Y 
Yammer, 552 
YouTube, 551 

Z 
Zoom, 378 
Zoom Slider, 266 
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